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zasobów pomocy, aby zapewnić informacje potrzebne do tworzenia rysunków w 
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2 C H A P T E R 1 

 

O ALCAD i innym oprogramowaniu CADNiniejszy podręcznik jest podzielony na 

rozdziały, które odzwierciedlają sposób pracy w ALCAD, zgodnie z zadaniami, które 

możesz wykonać. Zadania są podzielone i zorganizowane w następujące rozdziały: 

Wprowadzenie: Rozdział 1 Przegląd kluczowych funkcji programu ALCAD oraz 

podstawowe koncepcje projektowania wspomaganego komputerowo (CAD) w 

odniesieniu do programu ALCAD. 

Pierwsze kroki: Rozdział 2 Instalacja ALCAD, uruchamianie i wychodzenie 

z ALCAD, praca z paskami narzędzi i wybieranie poleceń. 

Praca z rysunkami: Rozdział 3 Otwieranie i zapisywanie istniejącego rysunku oraz 

rozpoczynanie nowego rysunku. Korzystanie z ustawień rysunku w celu określenia 

rozmiaru papieru, współczynników skali i wysokości tekstu. Praca z kolorami na 

rysunkach. Korzystanie z pomocy rysunkowych, takich jak przyciąganie jednostek i 

tryb ortogonalny, w celu dokładnego rysowania. 

Tworzenie obiektów: Rozdziały 4-5 Praca z prostymi bytami, takimi jak linie, okręgi i 

łuki, oraz ze złożonymi bytami, takimi jak wielokąty, krzywe splajnowe, 

płaszczyzny, wytarcia, kreskowania granic i inne. 

Wyświetlanie rysunku: Rozdział 6 Poruszanie się po rysunku, zmiana jego powiększenia, 

tworzenie wielu widoków i zapisywanie układów okien rysunku. 

Praca ze współrzędnymi: Rozdział 7 Praca z kartezjańskimi układami 

współrzędnych, określanie dwuwymiarowych i trójwymiarowych współrzędnych 

oraz definiowanie własnych układów współrzędnych użytkownika. 

Praca z Eksploratorem ALCAD: Rozdział 8 Używanie Eksploratora ALCAD do 

zarządzania rysunkami: kontrolowanie warstw, typów linii, stylów tekstu, układów 

współrzędnych, widoków i bloków oraz kopiowanie informacji między rysunkami. 

Uzyskiwanie informacji o rysunku: Rozdział 9 Praca z dodatkowymi informacjami 

w rysunkach ALCAD, obliczanie obszarów i odległości oraz wyświetlanie innych 

informacji rysunkowych. 

Modyfikowanie jednostek: Rozdział 10 Wybieranie, kopiowanie, zmiana układu, 

zmiana rozmiaru i edycja jednostek. 

Dodawanie adnotacji i wymiarowanie rysunku: Rozdziały 11-12 Używanie tekstu do 

dodawania adnotacji do rysunków; używanie wymiarów do dodawania adnotacji do 

pomiarów jednostek. 

Praca z blokami, atrybutami i odwołaniami zewnętrznymi: Rozdział 13 Używanie 

bloków i odwołań zewnętrznych do łączenia encji i danych w celu ich ponownego 

wykorzystania; tworzenie informacji o atrybutach w celu ich wyodrębnienia do 

wykorzystania w innych programach. 

Formatowanie i drukowanie rysunków: Rozdział 14 Łączenie rysunków w gotowe 

układy, dostosowywanie opcji drukowania i drukowanie kopii. 

Rysowanie w trzech wymiarach: Rozdział 15 Tworzenie i edycja elementów trójwymiarowych. 

I wizualizowanie ich za pomocą usuwania ukrytych linii, cieniowania i 

fotorealistycznego renderowania. 

Praca z innymi programami: Rozdział 16 Udostępnianie rysunków i danych innym 

użytkownikom, dokumentom i programom. 
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Dostosowywanie ALCAD: Rozdział 17 Dostosowywanie wyglądu i działania 

programu do własnych potrzeb. 

Zrozumienie kompatybilności z AutoCAD: Dodatek Opisuje podobieństwa i różnice 

między programami ALCAD i AutoCAD. 

Ta sekcja przedstawia program ALCAD®, jego funkcje i wszechstronne możliwości 

tworzenia rysunków różnych typów. 

 

 
 

Informacje o ALCAD i innym oprogramowaniu CAD 
 

ALCAD jest przeznaczony dla każdego, kto potrzebuje szybkiego i wydajnego 

programu CAD z całą mocą i wszechstronnością standardowych programów, takich 

jak AutoCAD® firmy Autodesk®, Inc. lub MicroStation® firmy Bentley Systems, Inc. w 

przystępnej cenie. Wykorzystując dzisiejszą zaawansowaną technologię, ALCAD 

integruje interfejs Microsoft® Windows® z potężnym silnikiem CAD. 

ALCAD zapewnia niezrównaną kompatybilność z AutoCAD, wykorzystując 

większość tych samych formatów plików, w tym te dla rysunków (pliki .dwg), 

poleceń, typów linii, wzorów kreskowania i stylów tekstu. Można również korzystać 

z plików menu AutoCAD i uruchamiać programy Autodesk® AutoLISP®. Jeśli napisałeś 

własne programy ADS (Autodesk® AutoCAD Development System®), po prostu 

przekompiluj je, aby połączyć je z bibliotekami ALCAD. Wiele programów ADS 

innych firm obsługuje już ALCAD. Jeśli masz program, który nie jest jeszcze 

obsługiwany, poproś dostawcę oprogramowania o dostarczenie wersji programu 

kompatybilnej z ALCAD. 

ALCAD jest bardziej kompatybilny z programem AutoCAD niż jakikolwiek inny 

produkt CAD, dostarcza dodatkowe narzędzia z zaawansowanymi funkcjami CAD i 

posiada płynną integrację z systemem Microsoft® Windows. Ten potężny program 

zapewnia doskonałą kombinację funkcji dla użytkowników CAD, takich jak 

architekci, inżynierowie i projektanci. 

ALCAD zawiera standardowe funkcje spotykane w innych programach CAD, a 

także funkcje i możliwości, których nie znajdziesz nigdzie indziej. Interfejs wielu 

dokumentów (MDI) umożliwia otwieranie i pracę z kilkoma rysunkami w tym 

samym czasie. Możesz łatwo kopiować elementy rysunku między rysunkami. 

Ponadto potężny ALCAD Explorer pozwala zarządzać informacjami i ustawieniami 

oraz szybko kopiować warstwy, typy linii i inne informacje między rysunkami. 

 

Korzystanie ze starszych rysunków AutoCAD 

ALCAD w pełni obsługuje starsze rysunki AutoCAD. ALCAD odczytuje i zapisuje 

.dwg w ich natywnym formacie bez utraty danych, od AutoCAD 2007 do wersji 11, 

w tym AutoCAD LT®. Ponieważ ALCAD używa formatu jako 

natywnego formatu pliku, nie jest wymagane tłumaczenie. 
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ALCAD zapewnia odpowiednie narzędzia dla twojego poziomu doświadczenia - 

niezależnie od tego, czy jesteś początkującym, średnio zaawansowanym czy 

zaawansowanym użytkownikiem CAD. Jeśli dopiero zaczynasz pracę z CAD, 

możesz skorzystać z poziomu początkującego, który zapewnia paski narzędzi 

zawierające podstawowe narzędzia, takie jak linie, łuki i okręgi. W miarę 

zdobywania doświadczenia można przejść na poziom średniozaawansowany, a 

następnie zaawansowany, który zapewnia dostęp do ponad 300 poleceń za pośrednictwem 

pasków narzędzi, menu i wpisów na klawiaturze. Poziom doświadczenia można 

zmienić w oknie dialogowym Opcje w menu Narzędzia. 

ALCAD obsługuje trójwymiarowe szkielety i powierzchnie. Trójwymiarowe 

rysunki mogą być wyświetlane w szkielecie, widoku ukrytej linii i cieniowaniu 

powierzchni. Niektóre wersje ALCAD obsługują również tworzenie i edycję brył 

3D; wszystkie wersje wyświetlają bryły 3D wraz z ograniczonymi funkcjami 

edycji. 

Niektóre wersje programu ALCAD obsługują wyświetlanie i pracę z obrazami 

rastrowymi na rysunkach. ALCAD nie wyświetla jednak obrazów znajdujących się 

wewnątrz bloków i rysunków z odniesieniami zewnętrznymi (xref). Po załadowaniu 

do programu ALCAD rysunku zawierającego jednostki proxy wyświetlany jest 

komunikat informujący, że niektóre jednostki nie będą wyświetlane, jednak 

jednostki te pojawią się ponownie po otwarciu rysunku później w programie 

AutoCAD. 

Dostosowanie programu ALCAD jest bardzo proste. Możesz modyfikować menu i 

paski narzędzi, tworzyć niestandardowe menu, okna dialogowe, aliasy poleceń i 

skrypty oraz dodawać niestandardowe programy napisane w dowolnym z kilku 

języków programowania, w tym DRX (język programu kompatybilny z Autodesk® 

ARX), LISP (język programu kompatybilny z Autodesk AutoLISP) i SDS™ 

(Solutions Development System™, język programu kompatybilny z Autodesk 

ADS). Istnieje również Microsoft® Visual Basic for Applications (VBA). 

Istniejące aplikacje Autodesk® AutoLISP można uruchamiać w programie ALCAD z 

niewielkimi modyfikacjami lub bez nich. ALCAD używa polecenia Appload, 

dzięki czemu można łatwo ładować programy LISP. ALCAD odczytuje również 

pliki zawierające stany języka sterowania dialogami (DCL), dzięki czemu ALCAD 

jest kompatybilny z oknami dialogowymi utworzonymi dla AutoCAD. 

 

Używanie poleceń AutoCAD z ALCAD 

Ponieważ ALCAD obsługuje setki poleceń AutoCAD, używasz poleceń, które już 

znasz. Na przykład, aby narysować okrąg, użyj polecenia Okrąg. Aby skopiować 

okrąg, użyj polecenia Kopiuj. 

Naciśnięcie klawisza Enter lub spacji aktywuje polecenie - tak jak w programie 

AutoCAD. ALCAD akceptuje znaki specjalne używane przez AutoCAD, takie jak 

wypełniacze punktów (na przykład .xy), współrzędne względne (symbol @) i 

apostrof (przedrostek ') dla przezroczystych poleceń. Klawisze funkcyjne ALCAD 

są również podobne do tych używanych w AutoCAD. 

Ponieważ nie musisz uczyć się nowego zestawu poleceń, od razu jesteś pro- 

duktywny z ALCAD. 



 

Porównanie ALCAD i CAD z kreśleniem 
ręcznym 
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ALCAD znacznie skraca czas i wysiłek potrzebny do tworzenia i poprawiania 

rysunków. Nie tylko można szybciej tworzyć dokładne rysunki, ale także ponownie 

wykorzystywać informacje zawarte w rysunkach. Są to główne powody przejścia 

na CAD z tradycyjnego, ręcznego kreślenia na papierze. 

Jednak jak w przypadku każdego narzędzia, aby efektywnie z niego korzystać, 

należy zapoznać się z niektórymi specjalnymi cechami, funkcjami i koncepcjami 

CAD. Jeśli jesteś zaznajomiony z ręcznym kreśleniem, znajdziesz pewne 

podobieństwa koncepcyjne w CAD, a także pewne różnice. 

 

Rysunek w skali 

W tradycyjnym, ręcznym kreśleniu zazwyczaj określa się skalę rysunku jeszcze 

przed rozpoczęciem rysowania, ponieważ pracuje się z arkuszem papieru o stałym 

rozmiarze. Konieczne może być zmniejszenie lub powiększenie rysowanej 

jednostki, aby zmieściła się w granicach papieru. 

Kiedy tworzysz rysunek w ALCAD, rysujesz wszystko w pełnym rozmiarze. 

Określasz typ jednostek, w których mierzony jest rysunek. Jeśli rysujesz budynek, 1 

jednostka rysunkowa może wynosić 1 cal. Jeśli rysujesz mapę, 1 jednostka 

rysunkowa może być równa 1 mili. Środowisko rysowania i sam plik rysunku CAD 

nie są ograniczone do rozmiaru konkretnego arkusza papieru. 

 
 

1 jednostka rysunkowa równa się 1 cal.  1 jednostka rysunkowa równa się 1 stopa. 

Podczas rysowania można używać poleceń, takich jak Przesuń i Powiększ, aby 

pracować nad różnymi częściami rysunku i powiększać wyświetlanie rysunku, aby 

zobaczyć małe szczegóły. Polecenia te nie mają wpływu na rzeczywisty rozmiar 

jednostek na rysunku; wpływają jedynie na sposób wyświetlania rysunku na 

ekranie. Tylko podczas drukowania lub kreślenia rysunku należy ustawić skalę, aby 

wydrukowany rysunek pasował do określonego rozmiaru papieru. 
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Korzystanie z narzędzi 

Podczas rysowania ręcznego używane są narzędzia, takie jak ołówki, linijki, 

trójniki, szablony, gumki itp. Podczas tworzenia rysunku w programie ALCAD 

zamiast ołówka używana jest mysz, która służy do wybierania innych narzędzi - 

poleceń wybieranych z menu lub paska narzędzi. 

Niektóre narzędzia służą do tworzenia podstawowych jednostek, takich jak linie, okręgi i 

łuki, a inne do modyfikowania istniejących jednostek (na przykład do kopiowania 

lub przenoszenia ich lub do zmiany właściwości, takich jak kolor i typ linii). 

 

Organizowanie informacji 

W tradycyjnym kreśleniu często oddziela się elementy takie jak ściany, wymiary, 

stalowe elementy konstrukcyjne i plany elektryczne na oddzielnych, 

półprzezroczystych nakładkach. Aby wydrukować rysunki robocze, można utworzyć 

kilka różnych rysunków, łącząc różne nakładki. 

Gdy tworzysz rysunek w ALCAD, używasz warstw do organizowania elementów w 

podobny sposób. Jednak funkcja warstw w programie CAD oferuje wiele zalet w 

porównaniu z fizycznymi foliami. Liczba nakładek, które można połączyć w celu 

wydrukowania ręcznie sporządzonego rysunku, jest ograniczona przez proces 

drukowania. W CAD nie ma takich ograniczeń. W ALCAD można zdefiniować 

nieograniczoną liczbę warstw, z których każda może być widoczna lub niewidoczna 

w dowolnym momencie. Każdej warstwie można nadać nazwę i przypisać jej 

własny kolor, typ linii, grubość linii i styl wydruku. Możesz także zablokować 

poszczególne warstwy, aby zapewnić, że informacje na tych warstwach nie zostaną 

przypadkowo zmienione. 

 
 

Użyj warstw, aby uporządkować informacje o rysunku. 
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Dokładne rysowanie 

Podczas ręcznego tworzenia rysunku zapewnienie dokładności wymaga zazwyczaj 

wielu ręcznych obliczeń i ponownego sprawdzania. Natomiast ALCAD oferuje 

szereg pomocy rysunkowych, które zapewniają dokładność od samego początku. Na 

przykład, tworzysz i modyfikujesz jednostki w oparciu o bazowy kartezjański układ 

współrzędnych. Każda lokalizacja na rysunku ma własne współrzędne x,y,z. Można 

również wyświetlić siatkę jako wizualne odniesienie do układu współrzędnych. 
 

Każda lokalizacja na rysunku ma własne współrzędne x,y,z w bazowym kartezjańskim układzie 
współrzędnych. Punkt 5,2,0 znajduje się 5 jednostek w prawo (wzdłuż osi x), 2 jednostki w górę (wzdłuż 
osi y) i 0 jednostek (wzdłuż osi z) od początku (punkt 0,0,0). 

 

Ustawienia takie jak przyciąganie i przyciąganie encji umożliwiają dokładne 

rysowanie bez określania współrzędnych. Ustawienie przyciągania wymusza 

przyleganie wybranych punktów do przyrostu siatki lub dowolnego innego 

ustawionego przyrostu. Przyciąganie jednostek umożliwia przyciąganie do 

precyzyjnych punktów geometrycznych istniejących jednostek - na przykład punktu 

końcowego linii lub środka okręgu. Inne ustawienie, ortogonalne, ogranicza linie tak, 

aby były rysowane równolegle do osi pionowej i poziomej. 
 

Rysunkom na papierze brakuje wysokiego stopnia dokładności możliwego przy użyciu CAD. Linie często nachodzą 
na siebie lub nie stykają się z sąsiednimi liniami. 
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Przyciąganie i przyciąganie elementów umożliwia przyleganie kursora do określonego przyrostu lub do 
kluczowych punktów geometrycznych na istniejących elementach. Linie można także ograniczać do 
osi pionowych i poziomych. 

 

Wydajne rysowanie 

W przypadku ręcznego kreślenia na papierze często trzeba przerysowywać ten sam 

obiekt kilka razy w różnych skalach lub z różnych punktów widzenia. Konieczne 

może być również przerysowanie obramowania i bloku tytułu na każdym nowym 

arkuszu. 

Jedną z najpotężniejszych funkcji ALCAD jest to, że podczas tworzenia rysunku można 

ponownie używać poszczególnych elementów, obramowań i bloków tytułowych tak 

często, jak chcesz. Musisz narysować jednostkę tylko raz; ostateczny wydrukowany 

rysunek może pokazywać jednostkę w kilku różnych skalach i punktach widzenia. 

Zazwyczaj rysowanie rozpoczyna się w przestrzeni modelu na karcie Model, tworząc 

rysunek (plan piętra, mapę lub trójwymiarową część) bez względu na ostateczny 

układ na papierze. Gdy rysunek jest gotowy do wydrukowania, można przełączyć się 

do przestrzeni papieru na karcie Układ, gdzie rysunek jest układany tak, jak ma 

wyglądać na kartce papieru. Można na przykład wstawić plik rysunku zawierający 

standardowe obramowanie i blok tytułu. Można zdefiniować i rozmieścić wiele 

widoków rysunku w odpowiednich skalach i z określonymi częściami widocznymi 

lub niewidocznymi - ponownie, bez konieczności ponownego rysowania 

obramowania i bloku tytułu dla każdego widoku. 
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Podstawowy rysunek tworzony jest w przestrzeni modelu na karcie Model. 

 

 
Gdy rysunek jest gotowy do wydrukowania lub wykreślenia, można przełączyć się do przestrzeni papieru na 
karcie Układ, gdzie można określić układ rysunku, jaki ma być wyświetlany na arkuszu papieru. 
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Ponowne wykorzystanie rysunków CAD i jednostek 

Podczas ręcznego tworzenia rysunku na papierze można rysować powtarzające się 

symbole, śledząc plastikowy szablon. Po narysowaniu symbolu w programie 

ALCAD można go ponownie użyć bez konieczności ponownego rysowania. 

Wystarczy zapisać symbol jako blok. Następnie można wstawić kopie tego bloku w 

dowolnym miejscu rysunku. Symbol można również zapisać jako osobny rysunek do 

wykorzystania w innych rysunkach. 
 

Możesz narysować symbol jeden raz, zapisać go jako blok, a następnie wstawić wiele kopii tego 
symbolu w dowolnym miejscu rysunku. 

 

Ponadto można ponownie wykorzystywać całe rysunki i wstawiać pojedyncze 

rysunki do innych rysunków. Można również użyć odniesienia zewnętrznego, które 

działa jako wskaźnik do innego rysunku, a nie kopia całego rysunku. Korzystanie z 

odniesienia zewnętrznego ma dodatkową zaletę: po zaktualizowaniu rysunku z 

odniesieniem zewnętrznym każdy rysunek, który się do niego odwołuje, może 

zostać automatycznie zaktualizowany. 
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Wprowadzanie zmian 

Aby wprowadzić zmiany w rysunku papierowym, należy go wymazać, a następnie 

przerysować. W programie ALCAD do modyfikowania elementów na rysunku 

używa się poleceń. Możesz przesuwać, obracać, rozciągać lub zmieniać skalę 

elementów. Jeśli chcesz usunąć jednostkę, możesz ją usunąć jednym kliknięciem 

myszy. Jeśli popełnisz błąd podczas tworzenia lub modyfikowania rysunku, możesz 

łatwo cofnąć swoje działania. 
 

Można łatwo zmienić jednostkę za pomocą poleceń, takich jak przesuń, obróć, rozciągnij i skaluj, 
zamiast przerysowywać jednostkę. 

 
Praca z innymi danymi i programami 

Tradycyjne rysunki na papierze służą jedynie jako środek przekazywania informacji 

między osobą, która stworzyła rysunek, a osobą oglądającą rysunek. Rysunki nie 

zawierają więcej informacji niż to, co jest wizualnie przekazywane przez twórcę i 

widziane przez odbiorcę. 

ALCAD oferuje bogate możliwości analizy rysunków i dołączania do nich 

dodatkowych danych. Na przykład, chociaż liczenie elementów na złożonym 

rysunku papierowym może być niepraktyczne, zadanie to jest proste w programie 

CAD. ALCAD może obliczyć liczbę jednostek na rysunku oraz obliczyć obszar i 

odległość. 

Rysunki CAD mogą również zawierać informacje oprócz widocznych elementów. Do 

widocznych elementów rysunku można dołączyć niewidoczne informacje z bazy 

danych i wyodrębnić je do analizy w bazie danych lub arkuszu kalkulacyjnym. (Praca 

z informacjami w bazie danych wymaga programu od zewnętrznego dostawcy lub 

można utworzyć własne środki eksportowania danych w LISP lub SDS. Można też 

użyć języka VBA). 

ALCAD zapewnia edycję w miejscu obiektów Microsoft®, takich jak te utworzone w 

programach Microsoft® Word i Microsoft® Excel. Edycja w miejscu ułatwia udostępnianie 

danych innym użytkownikom i programom. Na przykład rysunki ALCAD można 

dołączyć do plików utworzonych za pomocą programu Microsoft® Word, a pliki 

utworzone za pomocą programu Microsoft® Word można wstawić do rysunków ALCAD. 
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Korzystanie z zaawansowanych funkcji CAD 
 

Oprócz kompatybilności z AutoCAD, ALCAD idzie o kilka kroków dalej, 

zapewniając innowacyjne funkcje zwiększające produktywność. 
 

Korzystanie z Eksploratora ALCAD 

Eksplorator ALCAD ma interfejs podobny do Eksploratora Windows, umożliwiając 

przeglądanie i zarządzanie elementami wielu otwartych rysunków, takich jak 

warstwy, bloki, typy linii, widoki, układy współrzędnych użytkownika, materiały, 

style tekstu i inne. 
 

Jednoczesna edycja wielu dokumentów 

W programie ALCAD można otwierać i edytować wiele rysunków jednocześnie. 

Możesz także kopiować i wklejać elementy między otwartymi rysunkami. 
 

Edycja wielu podmiotów 

ALCAD umożliwia zmianę większości właściwości wszystkich wybranych 

podmiotów za pomocą pojedynczego okna dialogowego z zakładkami. 
 

Korzystanie z okna dialogowego CUI 

ALCAD posiada pojedyncze okno dialogowe do zmiany zakładek wstążki (jeśli 

twoja wersja ALCAD je obsługuje), pasków narzędzi, menu, skrótów 

klawiaturowych i aliasów poleceń. Możesz także użyć metody przeciągania i upuszczania, 

aby dostosować te elementy interfejsu użytkownika. Proste działanie typu "wskaż i 

kliknij" umożliwia łatwe tworzenie nowych elementów i skrótów klawiaturowych - 

bez konieczności programowania lub ręcznej edycji tekstu. 
 

Wykonywanie nieograniczonej liczby cofnięć i ponowień 

ALCAD zwiększa Twoją moc dzięki nieograniczonemu cofaniu i ponawianiu czynności 

edycyjnych. 



 

Więcej informacji 
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Oprócz dokumentacji ALCAD, znaczna część pomocy potrzebnej podczas 

korzystania z ALCAD jest specyficzna dla poleceń, z którymi pracujesz na ekranie. 

Aby uzyskać natychmiastowe informacje podczas pracy, skorzystaj z tych 

dodatkowych źródeł informacji: 

• Podpowiedzi - aby dowiedzieć się, co robi określone narzędzie na pasku 

narzędzi, zatrzymaj nad nim kursor na chwilę. Na ekranie pojawi się 

podpowiedź. 

• Pasek stanu - aby uzyskać bardziej szczegółowe informacje o narzędziu po 

zatrzymaniu nad nim kursora, należy spojrzeć na pasek stanu u dołu ekranu. 

• Pomoc online - Pomoc online ALCAD jest dostępna na ekranie po naciśnięciu 

klawisza F1, wybraniu polecenia z menu Pomoc lub kliknięciu znaku zapytania 

w oknie dialogowym. Pomoc online zawiera również informacje, które nie 

pojawiają się w tym podręczniku, w tym odniesienie do programowania, które 

opisuje sposób programowania w TX/IRX, LISP, DCL, SDS i DIESEL. 

Odniesienie do programowania opisuje również programowanie w VSTA i 

VBA. 

 

 
 

Praca z przykładowymi rysunkami 
 

Za pomocą programu ALCAD można tworzyć różnorodne rysunki, w tym 

dwuwymiarowe rysunki architektoniczne, schematy elektryczne i rysunki 

mechaniczne. Przeglądanie i praca z przykładowymi plikami może być łatwym 

sposobem na szybkie nauczenie się korzystania z różnych funkcji ALCAD. 
 

Aby uzyskać dostęp do przykładowych plików 

• Wybierz Plik > Otwórz, a następnie otwórz folder Próbki. 
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Nowości w ALCAD 2021 
 

Wydajność 

• Łatwe przełączanie między urządzeniami graficznymi, w tym OpenGL ES, w 

celu poprawy jakości i wydajności wyświetlania. Kliknij Przełącz urządzenie 

graficzne na pasku stanu lub kliknij prawym przyciskiem myszy i wybierz 

Ustawienia, aby uzyskać więcej opcji. 

• Nowy wysokowydajny wskaźnik postępu wyświetla złożone zadania, których 

ukończenie może zająć więcej czasu. 
 

Praca z plikami 

• Importuj pliki Wavefront Technologies Object (.obj) i Stereolithography 

(.stl). 

• Eksportuj pliki stereolitografii (.stl). 

• Dla wersji ALCAD obsługujących pracę z plikami BIM: 

• Narysuj dachy i belki. 

• Tworzenie połączeń ściętych dla belek. 

• Polecenie BIM Explode służy do rozbijania dołączonych podkładów 

BIM na siatki polifazowe i polilinie, które można edytować. 

• Nowe opcje dla linii przekroju i linii elewacji. 

Interfejs użytkownika 

• Migruj dostosowania interfejsu użytkownika z poprzednich wersji ALCAD do 

bieżącej wersji za pomocą polecenia MIGRATE. 

• Importuj i eksportuj pliki .cui bezpośrednio za pomocą nowych 

poleceń CUIIMPORT i CUIEXPORT. 

• Otwórz paletę narzędzi bezpośrednio za pomocą polecenia TPNAVIGATE. 

• Określenie, czy kółko myszy może być używane do przewijania zakładek wstążki. 

• Polecenie CLEANSCREENOPTIONS służy do określenia, które elementy 

interfejsu użytkownika są ukrywane podczas korzystania z funkcji 

CLEANSCREENON. 

• Strona startowa zawiera nową sekcję Nauka z filmami instruktażowymi i 

zasobami online. 

• Klikalne słowa kluczowe są teraz dostępne dla wszystkich poleceń. Umożliwiają 

one szybki wybór opcji podczas uruchamiania polecenia. 

• Przeprojektowano ikony paska stanu, w tym zwiększono ich rozmiar o 50%. 

• Ulepszenia pod kątem użyteczności sekcji 508, a także 4K i większych wyświetlaczy. 
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Rysowanie, wybieranie i modyfikowanie jednostek 

• Dynamiczne wprowadzanie danych obejmuje podpowiedzi poleceń i 

przewodniki pomiarowe wyświetlane na ekranie podczas rysowania i 

edytowania rysunków. Wprowadzanie dynamiczne jest domyślnie włączone. 

Aby zmienić ustawienia, użyj opcji Przełącz dynamiczne wprowadzanie na 

pasku stanu. 

• Panel właściwości zawiera obsługę wielu nowych typów jednostek i właściwości. 

Tekst wielowierszowy 

• Łączenie wielu akapitów tekstu wielowierszowego w jeden akapit. 

• Wyczyść formatowanie znaków i akapitów. 

• Wklejanie tekstu bez formatowania. 

Przeglądanie rysunków 

• Przeprojektowany Menedżer widoków ma znacznie więcej opcji, w tym 

możliwość dynamicznego ustawiania tła widoku, perspektywy, długości 

obiektywu, przycinania i nie tylko. 

• Wyświetlaj rysunki przy użyciu dodatkowych stylów wizualnych, w tym 

Shaded, Sketchy, X-ray i innych. 

• Obrazy tła. 

• Materiały ekspozycyjne i oświetlenie. 

• Poprawiona jakość przezroczystości. 

Odkrywca 

• Nowe polecenie Eksploruj materiały umożliwia importowanie materiałów, które 

można przypisywać do elementów i warstw oraz wyświetlać na rysunku w stylu 

Realistyczny. 

• Zmień kolejność filtrów warstw, przeciągając i upuszczając je na liście, lub 

posortuj je alfabetycznie. 

• Przypisz materiały według warstwy w Eksploruj warstwy. 

Drukowanie i publikowanie 

• Pliki .pc3 można dostosować za pomocą wielu innych opcji, w tym marginesów 

i plików .pmp. Kliknij przycisk Właściwości dla pliku .pc3 w oknie 

dialogowym Drukuj. 

• Podczas publikowania rysunków należy wybrać stan układu dla każdego arkusza. 

Interfejsy API 

• ODA SDK w wersji 2020 Update 2. 

Więcej funkcji 

• Konwertuj jednostki zamknięte na bryły za pomocą polecenia Konwertuj na bryłę. 

• Wyeksportuj układ do przestrzeni modelu nowego rysunku za pomocą 

polecenia Eksportuj układ. 

• Importowanie i eksportowanie ustawień zmiennych systemowych przy 

użyciu nowych poleceń SVIMPORT i SVEXPORT. 
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• Polecenie Purge obsługuje materiały. 

• Polecenie eTransmit może zawierać obrazy tła i bitmapy materiałów. 

Nowe i zmienione zmienne systemowe 

• BIMUNITS, BLOCKEDITNAME, DEFAULTLIGHTINGINTENSITY, 

DGNWORKSPACE, DWGWORKSPACE, DYNDIGRIP, DYNDIVIS, 

DYNMODE, DYNPICOORDS, DYNPIDISPMODEBOX, DYNPIFORMAT, 

DYNPIVIS, DYNPROMPT, DYNSHOWDEFAULT, 

DYNTOOLTIPCOLORLAYOUTBKG, 

DYNTOOLTIPCOLORLAYOUTTEXT, DYNTOOLTIPCOLORMODELBKG, 

DYNTOOLTIPCOLORMODELTEXT, DYNUSEANGBASE, 

EMPTYWORKSPACE, EXPLSTMAT, GRDRAWPACKAGESIZE, 

GSMSAA, GSUSEDDEVICEMODE, LENGTHENOLDCOMPAT, 

LINESMOOTHING, MATERIALLIBPATH, 

PRESERVEDDOCUMENTWORKSPACE, PSPACEBKGCOLOR, 

RIBBONMOUSEWHEEL, SELECTIONCYCLING, 

SELECTIONCYCLINGMODE, VSBACKGROUNDS, VSEDGEJITTER, 

VSEDGES, VSEDGESMOOTH, VSFACEHIGHLIGHT, VSFACEOPACITY, 

VSFACESTYLE, VSHALOGAP, VSISOONTOP, VSMATERIALMODE, 

VSSILHEDGES, VSSILHWIDTH. 

• Nazwa SHOWTABS została zmieniona na LAYOUTAB. 

• Nazwa WNDLSTAT została zmieniona na STATUSBAR. 



 

 

 

 

 

 

 

 

 

 

 

 

 

Ta sekcja pomaga rozpocząć korzystanie z oprogramowania ALCAD, wyjaśniając, 

jak je zainstalować i dostarczając podstawowych informacji o tym, jak z niego 

korzystać. 

 

Niniejsza instrukcja zakłada, że użytkownik posiada praktyczną wiedzę na temat 

programów opartych na systemie Windows. W razie potrzeby należy zapoznać się z 

dokumentacją dostarczoną z systemem operacyjnym, aby uzyskać informacje na 

temat terminologii i technik systemu Windows. 
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Wymagania systemowe 
 

Do zainstalowania i uruchomienia ALCAD potrzebne jest następujące oprogramowanie i sprzęt: 

• Microsoft® Windows® 10, Windows 8, Windows 7, Windows Vista®, w tym 

32-bitowy i 64-bitowy 

• W przypadku 32-bitowych systemów operacyjnych należy zainstalować 32-bitową wersję 

programu ALCAD. 

• W przypadku 64-bitowych systemów operacyjnych należy zainstalować 32-

bitową lub 64-bitową wersję programu ALCAD. 64-bitowa wersja ALCAD 

działa nieco szybciej i może wykorzystywać całą dostępną pamięć 

systemową do obsługi dużych plików rysunkowych. ALCAD 32-bit może 

uzyskać dostęp do 3 GB pamięci RAM w 32-bitowych systemach 

operacyjnych i do 4 GB pamięci RAM w 64-bitowych systemach 

operacyjnych. 

 
Wersje ALCAD współpracujące z plikami BIM wymagają 64-bitowych systemów 

operacyjnych. 

• Intel® Pentium® 4 lub porównywalny, zalecany szybszy procesor 

• Minimum 1 gigabajt (GB) pamięci RAM dla 32-bitowego i minimum 2 gigabajty 

(GB) pamięci RAM dla 64-bitowego systemu Windows 10, Windows 8 i 

Windows 7, minimum 1 gigabajt (GB) pamięci RAM dla systemu Windows 

Vista. 

• 1,6 GB) wolnego miejsca na dysku twardym zalecanego dla typowej instalacji 

• Rozdzielczość 1024 x 768 VGA lub wyższa, karta wideo i monitor 

• Karta graficzna kompatybilna z OpenGL w wersji 1.4 lub wyższej 

• Klawiatura i mysz lub inne urządzenie wskazujące 

• Napęd CD-ROM lub DVD do instalacji, w przypadku instalacji z płyty CD lub DVD 

• Dostęp do Internetu, w przypadku pobierania i instalowania z Internetu 

W przypadku tabletów ALCAD wymaga zainstalowania 32-bitowego lub 64-

bitowego sterownika zgodnego z Wintab. 



 

Instalacja ALCAD 
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Program instalacyjny prowadzi użytkownika przez proces instalacji ALCAD. 

Program przenosi pliki do folderu, który tworzy na dysku twardym. Program tworzy 

również pozycję menu w menu Start. 

Instalacja rozpoczyna się automatycznie po włożeniu płyty kompaktowej 

ALCAD do napędu CD-ROM. Jeśli instalacja nie rozpocznie się, możesz 

zainstalować ALCAD, korzystając z poniższej procedury. 
 

Aby zainstalować ALCAD z płyty kompaktowej 

1 Włóż płytę kompaktową ALCAD do napędu CD-ROM. 

2 Wykonaj jedną z poniższych czynności: 

• Poczekaj na uruchomienie funkcji automatycznego uruchamiania. 

• Wybierz Start > Uruchom i w polu Otwórz wpisz d:\setup, gdzie d to litera 

przypisana do napędu CD-ROM. Kliknij OK. 

3 Postępuj zgodnie z instrukcjami wyświetlanymi na ekranie. 

 

Niektóre wersje ALCAD mogą nie być dostarczane z płytą kompaktową. 

Na przykład, jeśli pobrałeś program z Internetu, postępuj zgodnie z instrukcjami 

dołączonymi do programu. 
 

 

 

Uruchamianie ALCAD 
 

Aby uruchomić ALCAD, wybierz Start > Wszystkie programy > ITC > ALCAD 

(może się różnić w zależności od systemu operacyjnego). 

Przy każdym uruchomieniu programu ALCAD na ekranie wyświetlana jest strona 

startowa (chyba że opcja ta została wyłączona). Strona startowa służy do szybkiego 

otwierania rysunków, tworzenia nowych rysunków i wysyłania opinii o programie. 

W wersjach ALCAD, które nie mają strony startowej, program otwiera nowy, pusty 

rysunek oparty na domyślnym szablonie icad.dwt. Używanie szablonu jako 

podstawy dla nowego rysunku ma kilka zalet: 

• Możesz użyć wcześniej określonych jednostek miary, ustawień siatki, wysokości 

tekstu i innych ustawień odpowiednich dla typu tworzonego rysunku. 

• Można wstępnie zdefiniować warstwy specjalne. 

• Można wstępnie zdefiniować typ tabeli stylów wydruku. 

• Możesz dołączyć predefiniowane bloki tytułowe i obramowania. 
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Praca w programie ALCAD 
 

Z oknem ALCAD i jego elementami można pracować na wiele sposobów. Na 

przykład można wyświetlać i zmieniać układ palet narzędzi, pasków narzędzi, 

wyświetlać pasek poleceń i włączać pasek stanu. Paski narzędzi i pasek poleceń 

można również przesuwać w dowolne miejsce na ekranie lub zadokować do 

krawędzi głównego okna ALCAD. 

 

Użyj skrótu, aby włączyć lub wyłączyć wszystkie elementy okna jednocześnie. 

Gdy włączonych jest wiele elementów okna, rozmiar okna rysowania jest 

zmniejszony, co może ograniczyć ilość wyświetlanych danych rysowania. Jeśli 

chcesz, aby więcej miejsca na ekranie było przeznaczone na rysowanie, po prostu 

wybierz opcję Przełącz czysty ekran na pasku stanu. Elementy okna zostaną ukryte 

do momentu ponownego wybrania przełącznika. 
 

 
Wyświetlanie kart plików dla rysunków 

Jednocześnie może być otwartych wiele rysunków. Domyślnie każdy rysunek 

wyświetla własną kartę. Wybierz kartę, aby przełączyć aktywny rysunek. 
 

Aby przełączyć wyświetlanie zakładek plików dla rysunków 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Widok > Karty plików (na ekranie) 

• W menu wybierz Widok > Karty plików. 

• Wpisz filetab lub filetabclose, a następnie naciśnij Enter. 
 

Otwarte rysunki mogą być również ułożone obok siebie. 

Więcej informacji na temat wyświetlania rysunków można znaleźć w sekcji "Praca z 

wieloma rysunkami" na stronie 210. 

 
Wyświetlanie poleceń w menu skrótów 

Menu skrótów zapewnia szybki dostęp do określonych poleceń. Menu skrótów jest 

wyświetlane po kliknięciu prawym przyciskiem myszy elementu, paska narzędzi, 

paska stanu, nazwy karty Model lub nazwy karty Układ. Wybory prezentowane w 

menu skrótów zależą od tego, co zostało kliknięte prawym przyciskiem myszy. 

Po kliknięciu rysunku prawym przyciskiem myszy można wybierać spośród 

szerokiej gamy poleceń, w tym ostatnio używanych poleceń. Po kliknięciu prawym 

przyciskiem myszy paska narzędzi program wyświetla menu skrótów, które umożliwia włączanie i 

wyłączanie paska poleceń, paska stanu i różnych pasków narzędzi. Jeśli zaznaczysz 

jeden lub więcej elementów, a następnie klikniesz prawym przyciskiem myszy, 

program wyświetli menu skrótów, z którego możesz wybrać polecenie modyfikujące 

wybrane elementy. Aby wyświetlić menu skrótów, z którego można wybrać 

przyciąganie encji, naciśnij i przytrzymaj klawisz Shift, a następnie kliknij prawym 

przyciskiem myszy w dowolnym miejscu w oknie rysunku. 
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Wyświetlanie i ukrywanie wstążki 

Wstążka zawiera kilka obszarów, z których można wybierać polecenia: 

• Przycisk aplikacji - przycisk aplikacji w lewym górnym rogu zawiera 

polecenia związane z plikami, takie jak Nowy, Otwórz, Importuj, Eksportuj i 

inne. 

• Pasek narzędzi Szybki dostęp - zawiera często używane polecenia. Kliknij 

strzałkę w dół paska narzędzi szybkiego dostępu, aby wybrać wyświetlane 

polecenia i dostosować różne elementy wizualne okna rysowania. 

• Karty - zawierają powiązane polecenia zgrupowane razem, na przykład na 

kartach o nazwach Home, Edit, Draw itd. 

• Panele - zawierają podkategorie poleceń na karcie, na przykład Rysuj, 

Modyfikuj i Warstwy na karcie Narzędzia główne. 

 

A 
G 

F 

E 

B 

D 

 
 

C 
 

A Kliknij przyciskAplikacja, aby wyświetlić i 
wybrać polecenia związane z plikami. 

B Wyświetla grupy poleceń w panelach. 

C Kliknij, aby zablokować rozwinięty panel. 

D Kliknij, aby rozwinąć panel i wyświetlić 
pod nim dodatkowe polecenia. 

Aby dostosować pasek narzędzi 
szybkiego dostępu 

E Kliknij, aby rozwinąć panel i wyświetlić 
powiązane polecenia poniżej. 

F Kliknij kartę, aby wyświetlić różne polecenia. 

G Kliknij narzędzie na pasku narzędzi 
szybkiego dostępu. Możesz także kliknąć 
strzałkę po prawej stronie, aby wybrać 
dodatkowe opcje. 

 

1 Aby dodać polecenie do paska narzędzi Szybki dostęp, kliknij je prawym 

przyciskiem myszy na wstążce, a następnie wybierz polecenie Dodaj do paska 

narzędzi Szybki dostęp. 

2 Aby usunąć polecenie z paska narzędzi Szybki dostęp, kliknij prawym 

przyciskiem myszy polecenie do usunięcia, a następnie wybierz polecenie Usuń z 

paska narzędzi Szybki dostęp. 
 

Aby dostosować kartę na wstążce 

1 Kliknij prawym przyciskiem myszy w dowolnym miejscu na karcie wstążki, którą chcesz 

dostosować. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz opcję Pokaż kartę, a następnie wybierz karty, które chcesz wyświetlić lub ukryć. 

• Wybierz opcję Pokaż panel, a następnie wybierz obszary, które chcesz 

wyświetlić lub ukryć dla tej karty. 
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Wstążkę można dostosować na inne sposoby. 

Można użyć polecenia Customize UI lub ręcznie edytować plik .cui dla wstążki. 

Więcej informacji można znaleźć w sekcji "Dostosowywanie wstążki" na stronie 

738. Zobacz także "Praca z plikami dostosowywania interfejsu użytkownika" na 

stronie 766. 
 

 
Aby zminimalizować taśmę 

1 Kliknij strzałkę w dół na pasku narzędzi Szybki dostęp. 

2 Wybierz opcję Minimalizuj wstążkę. 
 

Aby wyświetlić jednocześnie wstążkę i menu 

1 Kliknij prawym przyciskiem myszy w dowolnym miejscu wstążki. 

2 Wybierz Pasek menu. 
 

Aby ukryć wstążkę 

1 Wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy w dowolnym miejscu menu lub wstążki, a 

następnie wybierz polecenie Przełącz na pasek menu. Spowoduje to ukrycie 

wstążki i wyświetlenie menu. 

• Wpisz ribbonclose i naciśnij Enter, aby ukryć tylko wstążkę. 

Aby wyświetlić wstążkę 

1 Wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy menu lub dowolny pasek narzędzi, a następnie 

wybierz polecenie Przełącz na wstążkę. 

• Wpisz ribbon i naciśnij Enter. 
 

Podczas korzystania ze wstążki można przełączać się między rysunkami za pomocą 

kart plików lub paska stanu. Kliknij kartę pliku rysunku, aby wyświetlić rysunek. 

Jeśli karty plików nie są widoczne, wpisz filetab i naciśnij Enter. Można również 

przełączać się między rysunkami za pomocą menu Pokaż okno na pasku stanu. 
 

 
Przestrzenie robocze mogą również kontrolować wstążkę. 

Obszar roboczy ALCAD Classic pokazuje paski narzędzi, a obszar roboczy 

Drafting and Annotation pokazuje wstążkę. Aby uzyskać więcej informacji na temat 

obszarów roboczych, patrz "Korzystanie z obszarów roboczych" na stronie 30 w 

tym rozdziale. 
 

 

Na wyświetlanie wstążki można również wpływać za pomocą opcji Włącz/wyłącz 

Czysty ekran na pasku stanu. Aby kontrolować, czy wstążka jest dołączana po 

kliknięciu przycisku Włącz/wyłącz Czysty ekran na pasku stanu, kliknij prawym 

przyciskiem myszy ikonę i zaznacz lub odznacz Wstążkę. 
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Wyświetlanie i ukrywanie panelu Palety narzędzi 

Panel palety narzędzi wyświetla grupy zorganizowanych poleceń i bloków w celu 

łatwego wyboru. 

Panel palety narzędzi może być zadokowany lub pływający. Pływający panel ma pole 

Zamknij i opcje po prawej stronie, może znajdować się w dowolnym miejscu na 

ekranie i można zmieniać jego rozmiar. Zadokowany panel ma pasek tytułu, przycisk 

Zamknij w prawym górnym rogu tylko wtedy, gdy kursor przesunie się nad nim, nie 

można zmienić jego rozmiaru i jest przymocowany wzdłuż jednej z krawędzi okna 

rysunku. 

 
H 

A G 
F 

 
 
 
 

 
E 

 
 

D 

C 

 
 
 

 
B 

 

A Kliknij paletę, aby wyświetlić jej polecenia. Kliknij 
prawym przyciskiem myszy, aby uzyskać więcej 
opcji. 

B Kliknij dwukrotnie, aby wybrać opcję. 
Kliknij prawym przyciskiem myszy, aby 
uzyskać więcej opcji. 

C Kliknij i przeciągnij, aby przenieść panel 
w nowe miejsce. Kliknij prawym 
przyciskiem myszy, aby uzyskać więcej 
opcji. 

D Kliknij przycisk , aby przewinąć listę 
poleceń. Kliknij prawym przyciskiem myszy, 
aby uzyskać więcej opcji. 

E Kliknij narzędzie, aby uruchomić jego 
polecenie. Kliknij prawym przyciskiem 
myszy, aby uzyskać więcej opcji. 

F Kliknij, aby wyświetlić menu opcji: 
zamknij, dokuj, przymocuj do lewej, 
przymocuj do prawej, ukryj automatycznie 
i przezroczystość. 

G Kliknij, aby automatycznie ukryć panel. 

H Kliknij, aby zamknąć panel. 

 

 
Aby wyświetlić panel Palety narzędzi 

1 Wykonaj jedną z poniższych czynności: 

- Na wstążce wybierz polecenie Widok > Palety narzędzi (na ekranie). 

- W menu wybierz Widok > Wyświetlanie > Palety narzędzi. 

- Kliknij prawym przyciskiem myszy kartę wstążki (jeśli Twoja wersja ma 

wstążkę), pasek narzędzi lub menu i wybierz Palety narzędzi. 

- Wpisz toolpalettes i naciśnij Enter. 
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Aby zamknąć panel Palety narzędzi 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Palety narzędzi (na ekranie). 

• W menu wybierz Widok > Wyświetlanie > Palety narzędzi. 

• W panelu Palety narzędzi, gdy jest on odblokowany, kliknij (  ) w 

prawym górnym rogu. 

• Kliknij prawym przyciskiem myszy kartę wstążki (jeśli Twoja wersja ma 

wstążkę), pasek narzędzi lub menu i wybierz Palety narzędzi. 

• Wpisz toolpalettesclose i naciśnij Enter. 
 

Na wyświetlanie palet narzędzi można również wpływać poprzez 

włączenie/wyłączenie czystego ekranu na pasku stanu. 

Aby kontrolować, czy palety narzędzi są dołączane po kliknięciu przycisku Przełącz czysty 
ekran 

Na pasku stanu kliknij prawym przyciskiem myszy ikonę i zaznacz lub odznacz Palety narzędzi. 
 

 
Aby automatycznie ukryć panel palet narzędzi 

1 Wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy pasek tytułu panelu Palety narzędzi i wybierz opcję 

Automatyczne ukrywanie. 

• W panelu Palety narzędzi, gdy jest on odblokowany, kliknij opcję Ukryj automatycznie ( 

).  

• W panelu Palety narzędzi, gdy jest on odblokowany, kliknij menu (  ) i 

wybierz opcję Automatyczne ukrywanie. 
 

Aby przenieść panel Palety narzędzi 

• Kliknij i przeciągnij pasek tytułu panelu Palety narzędzi do żądanej lokalizacji w 

oknie rysunku. 
 

Aby zadokować lub oddokować panel Palety narzędzi 

1 W panelu palety narzędzi, gdy jest ona odblokowana, kliknij menu (  ) i 

wybierz opcję Dockable, jeśli jest odznaczona. 

2 Wykonaj jedną z poniższych czynności: 

• Kliknij dwukrotnie pasek tytułu panelu Palety narzędzi, aby go zadokować lub 

oddokować. 

• Przeciągnij pasek tytułowy panelu Palety narzędzi na prawą lub lewą stronę 

okna rysunku, aby go zadokować, lub przeciągnij go na inny obszar okna 

rysunku, aby go oddokować. 

• W panelu Palety narzędzi, gdy jest on odłączony, kliknij menu (  ) i 

wybierz opcję Przymocuj do lewej, aby zadokować paletę po lewej stronie okna 

rysunku, lub wybierz opcję Przymocuj do prawej, aby zadokować paletę po 

prawej stronie. 
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Palety narzędzi są konfigurowalne. 

Można zmieniać przezroczystość panelu palet narzędzi, dodawać, usuwać i 

zmieniać zakres palet narzędzi, a także dodawać nowe niestandardowe polecenia 

i bloki. Więcej informacji można znaleźć w sekcji "Dostosowywanie palet 

narzędzi" na stronie 723. 
 

 
Wyświetlanie i ukrywanie menu 

Powiązane polecenia są zgrupowane w menu. Menu można używać ze wstążką 

lub bez niej. 
 

Aby dostosować wyświetlanie menu 

1 Kliknij prawym przyciskiem myszy w dowolnym miejscu menu lub wstążki. 

2 Wybierz opcję Pokaż menu, a następnie wybierz menu, które chcesz wyświetlić lub ukryć. 
 

Istnieje więcej sposobów dostosowywania menu. 

Można użyć polecenia Customize UI lub ręcznie edytować plik .mnu dla 

menu. Więcej informacji można znaleźć w sekcji "Dostosowywanie menu" na 

stronie 728. Zobacz także "Praca z plikami dostosowywania interfejsu 

użytkownika" na stronie 766. 
 

 
Aby wyświetlić lub ukryć menu podczas korzystania ze wstążki 

Dla wersji ALCAD, które mają wstążkę. 

1 Kliknij prawym przyciskiem myszy w dowolnym miejscu menu lub wstążki. 

2 Wybierz Pasek menu. 

 

Na wyświetlanie menu może mieć również wpływ opcja Włącz/wyłącz Czysty ekran 

na pasku stanu. Aby kontrolować, czy menu są uwzględniane po kliknięciu 

przycisku Włącz/wyłącz Czysty ekran na pasku stanu, kliknij prawym przyciskiem 

myszy ikonę i zaznacz lub usuń zaznaczenie paska menu. 
 

 
Wyświetlanie i ukrywanie pasków narzędzi 

Przy pierwszym uruchomieniu programu ALCAD wyświetlanych jest wiele 

pasków narzędzi. ALCAD zapewnia kilkanaście pasków narzędzi, które można 

dostosować, dodając i usuwając narzędzia. Możesz także przenosić i zmieniać 

rozmiar pasków narzędzi, a także tworzyć nowe paski narzędzi. Za pomocą menu 

skrótów można wyświetlać lub ukrywać paski narzędzi. 

Można również wybrać, czy paski narzędzi mają być wyświetlane jako duże czy 

małe oraz w kolorze. Można wybrać wyświetlanie lub ukrywanie podpowiedzi ToolTips, 

zawierających opisy narzędzi, które są wyświetlane po zatrzymaniu nad nimi kursora. Aby 

dokonać tych wyborów, wybierz kolejno opcje Widok > Paski narzędzi. 

Paski narzędzi są zadokowane lub pływające. Pływający pasek narzędzi ma pasek 

tytułu i pole Zamknij, może znajdować się w dowolnym miejscu na ekranie i można 

zmieniać jego rozmiar. Zadokowany pasek narzędzi nie wyświetla tytułu ani pola 

Zamknij, nie można zmienić jego rozmiaru i jest przymocowany wzdłuż jednej z 



krawędzi okna rysunku. 
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• Aby zadokować pasek narzędzi, przeciągnij go do obwodu rysunku; aby go 

cofnąć, przeciągnij go z dala od obwodu. 

• Aby umieścić pasek narzędzi w obszarze dokowania bez jego dokowania, 

naciśnij klawisz Ctrl podczas jego przeciągania. 

• Aby przenieść pasek narzędzi, przeciągnij go w nowe miejsce. 

• Aby zmienić rozmiar paska narzędzi, przesuń kursor do krawędzi, aż zmieni się 

w strzałkę zmiany rozmiaru, a następnie przeciągnij. 
 

Aby wybrać, które paski narzędzi mają być wyświetlane 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Widok > Paski narzędzi (na ekranie) 

• W menu wybierz Widok > Paski narzędzi. 

• Kliknij prawym przyciskiem myszy w dowolnym miejscu na pasku narzędzi 

(zadokowanym, niezadokowanym lub w obszarze paska narzędzi w górnej 

części okna), aby wyświetlić menu skrótów paska narzędzi, a następnie 

wybierz Paski narzędzi. Możesz także wybrać paski narzędzi, które mają być 

wyświetlane bezpośrednio w menu skrótów. 

• Wpisz tbconfig i naciśnij Enter. 

2 W oknie dialogowym Wybierz paski narzędzi wybierz paski narzędzi, które 

chcesz wyświetlić, a następnie kliknij przycisk OK. 
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A I 

H 

B G 

 

F 

 
 
 
 
 

C 
D 
E 

 

 
A Wybierz pasek narzędzi, który chcesz 
zmodyfikować. 

B Zaznacz, aby wyświetlić pasek narzędzi; 
wyczyść, aby ukryć pasek narzędzi. 

C Wybierz, aby wyświetlić duże narzędzia; 
wyczyść, aby wyświetlić małe narzędzia. 

D Wybierz, aby wyświetlić narzędzia kolorowe; 
wyczyść, aby wyświetlić narzędzia czarno-
białe. 

E Wybierz, aby wyświetlać ToolTips po 
najechaniu kursorem na narzędzia na 
pasku narzędzi; wyczyść, aby nie 
wyświetlać ToolTips. 

F Podświetl nazwę paska narzędzi, której nazwę 
chcesz zmienić lub usunąć. 

G Kliknij, aby otworzyć okno dialogowe Dostosuj i 
dostosować paski narzędzi. 

H Kliknij, aby usunąć wybrany pasek narzędzi (nie 
usuwa wszystkich zaznaczonych pasków 
narzędzi). 

I Kliknij, aby wpisać nową nazwę dla wybranego 
paska narzędzi (nie zmienia nazwy 
wszystkich zaznaczonych pasków narzędzi). 

 

 
 

Na wyświetlanie pasków narzędzi można również wpływać za pomocą opcji 

Włącz/wyłącz Czysty ekran na pasku stanu. Aby kontrolować, czy wszystkie 

wybrane paski narzędzi są uwzględniane po kliknięciu Włącz/Wyłącz Czyszczenie 

Ekranu na pasku stanu, kliknij prawym przyciskiem myszy ikonę i zaznacz lub 

odznacz Paski narzędzi. 

 
Korzystanie z paska poleceń 

Pasek poleceń to dokowane okno, w którym można wpisywać polecenia ALCAD i 

wyświetlać monity i inne komunikaty programu. Domyślnie pasek poleceń 

wyświetla trzy ostatnie wiersze podpowiedzi, ale można rozszerzyć okno, aby 

wyświetlić więcej wierszy. Pasek poleceń można przesuwać lub zmieniać jego 

rozmiar, przeciągając go. 
 

Aby wyświetlić lub ukryć pasek poleceń 

• Na wstążce wybierz Widok > Pasek poleceń (na ekranie). 

• W menu wybierz Widok > Wyświetlacz > Pasek poleceń. 



• Wpisz cmdbar, a następnie wybierz Toggle. 

• Naciśnij klawisze Ctrl+9. 
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Na wyświetlanie paska poleceń można również wpływać za pomocą opcji Toggle 

Clean Screen On/Off na pasku stanu. 

Aby kontrolować, czy pasek poleceń jest dołączany po kliknięciu przycisku Przełącz czysty 
ekran 

Włącz/Wyłącz na pasku stanu, kliknij prawym przyciskiem myszy ikonę i zaznacz lub usuń 

zaznaczenie paska poleceń. 
 

Gdy pasek poleceń jest zadokowany lub pływający, można przeciągnąć górną lub 

dolną część okna, aby zmienić liczbę wyświetlanych wierszy tekstu. Pasek poleceń 

można zadokować w górnej, dolnej, lewej lub prawej części rysunku. Pasek poleceń 

można automatycznie ukrywać i usuwać w jego bieżącej lokalizacji, klikając 

przycisk pinezki. 

Podczas wpisywania w pasku poleceń ALCAD sugeruje nazwy pasujących poleceń. 

Sugerowane nazwy pojawiają się w oknie Autouzupełniania. Wystarczy wybrać żądane 

polecenie z listy. Oprócz nazw poleceń, sugestie mogą zawierać nazwy poleceń 

zewnętrznych, zmiennych systemowych, aliasów i funkcji LISP. 
 

Aby włączyć autouzupełnianie dla wpisywania na pasku poleceń 

1 Wykonaj jedną z poniższych czynności: 

• W menu wybierz Widok > Wyświetlanie > Autouzupełnianie. 

• Kliknij prawym przyciskiem myszy pasek poleceń, a następnie wybierz opcję 

Autouzupełnianie. 

• Wpisz autouzupełnianie, naciśnij Enter, a następnie wybierz opcję Autouzupełnianie. 

• Wybierz Narzędzia > Opcje, kliknij kartę Wyświetlanie, a 

następnie zaznacz Włącz autouzupełnianie. 

Po włączeniu funkcja Autouzupełnianie jest automatycznie wyświetlana podczas 

pisania na pasku poleceń, a następnie automatycznie zamykana po aktywowaniu 

polecenia. 

Więcej informacji na temat dostosowywania ustawień okna Autouzupełniania można 

znaleźć w sekcji "Dostosowywanie sposobu wyświetlania sugestii na pasku poleceń" 

na stronie 695. 

 

Korzystanie z paska stanu 

Jeśli nie chcesz korzystać z paska poleceń, na pasku stanu wyświetlane są 

informacje o wybranym poleceniu lub narzędziu. Wyświetlane są również bieżące 

współrzędne kursora, nazwa bieżącej warstwy, ustawienia trybu i inne informacje o 

bieżących ustawieniach. 

Oprócz wyświetlania informacji, pasek stanu umożliwia szybki dostęp do wielu 

funkcji. Możesz klikać elementy paska stanu, aby wprowadzać zmiany, a także 

klikać elementy prawym przyciskiem myszy, aby wyświetlić menu skrótów, które 

umożliwiają większy wybór. 
 

Aby zmienić elementy wyświetlane na pasku stanu 

1 Kliknij prawym przyciskiem myszy pusty obszar paska stanu. 

2 Wybierz element, aby go dodać lub usunąć. 



P R Z E D S I Ę B I O R S T W O P R Z E D S I Ę B 

I O R S T W E M 29 

 
 

Aby zmienić ustawienie elementu na pasku stanu 

1 Wykonaj jedną z poniższych czynności: 

• Kliknij dwukrotnie element paska stanu. 

• Kliknij prawym przyciskiem myszy element paska stanu, który chcesz 

zmienić, a następnie wybierz żądane ustawienie. 
 

Aby wyświetlić lub ukryć pasek stanu 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Pasek stanu (na ekranie). 

• W menu wybierz Widok > Wyświetlacz > Pasek stanu. 

• Wpisz statbar i naciśnij Enter. 

 

Korzystanie z pól zachęty 

Polecenia ALCAD często zawierają kilka opcji. Opcje te pojawiają się na pasku 

stanu lub pasku poleceń i mogą również opcjonalnie pojawiać się w oknie zachęty 

(zwanym menu kontekstowym w programie AutoCAD) początkowo wyświetlanym 

w prawym górnym rogu ekranu. 

Pole zachęty można przenieść, przeciągając je; przyszłe pola zachęty pojawią się w 

miejscu, w którym ostatnio je umieszczono. Opcje są wyświetlane jako opcje menu. 

Wybierz odpowiednią opcję, zaznaczając ją w polu monitu. Aby zamknąć pole 

monitu, kliknij pole Zamknij. 
 

Opcje poleceń są wyświetlane w oknie zachęty. 

Pole monitu jest domyślnie ukryte. Aby włączyć wyświetlanie okien podpowiedzi, 

wybierz Narzędzia > Opcje, kliknij kartę Wyświetlanie, a następnie kliknij pole 

wyboru Wyświetlaj okna podpowiedzi. 
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Korzystanie z obszarów roboczych 

Obszary robocze to wygodny sposób na dostosowanie wyświetlania poleceń w oknie 

głównym ALCAD. Każdy obszar roboczy przechowuje ustawienia widoczności dla 

następujących elementów: 

• Menu - ustawienia widoczności są zapisywane dla każdego menu najwyższego 

poziomu (np. menu Rysuj) i każdego menu zagnieżdżonego (np. podmenu Rysuj 

> Łuk). 

• Paski narzędzi - ustawienia widoczności są zapisywane dla każdego paska 

narzędzi, jego orientacji na górze, na dole, po lewej, po prawej lub pływającej, 

liczby rzędów przycisków, współrzędnej x i współrzędnej y. 

• Wstążka - W przypadku wersji ALCAD, które mają wstążkę, ustawienia 

widoczności są zapisywane dla tego, czy sama wstążka jest wyświetlana, wraz z 

ustawieniami widoczności dla każdej zakładki wstążki (na przykład zakładki 

Strona główna) i każdego panelu (na przykład Strona główna > Modyfikuj). 

 

Użyj skrótu, aby zrobić więcej miejsca na rysowanie w głównym oknie ALCAD. 

Kliknięcie przycisku Toggle Clean Screen On/Off na pasku stanu pozwala ukryć 

wiele elementów interfejsu użytkownika w tym samym czasie. Aby dostosować to, co 

jest ukrywane (lub wyświetlane), kliknij ikonę prawym przyciskiem myszy i dokonaj 

wyboru przy następnym kliknięciu ikony. 
 

 
Aby utworzyć obszar roboczy 

1 Zorganizuj menu, paski narzędzi i wstążkę tak, jak chcesz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz przestrzeń roboczą ( ):  

• Na wstążce wybierz Narzędzia > Zapisz przestrzeń roboczą (w Zarządzaj). 

• W menu wybierz Narzędzia > Zapisz przestrzeń roboczą. 

• Na pasku stanu kliknij przycisk Przełącz między obszarami roboczymi, a 

następnie wybierz opcję Zapisz bieżący jako. 

• Wpisz wssave i naciśnij Enter. 

• Wpisz workspace, naciśnij Enter, a następnie wybierz SaveAs. 

3 Wprowadź nazwę nowego obszaru roboczego. 

4 Kliknij przycisk OK. 
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Aby zapisać bieżące ustawienia widoczności w istniejącym obszarze roboczym 

1 Zorganizuj menu, paski narzędzi i wstążkę tak, jak chcesz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz przestrzeń roboczą ( ):  

• Na wstążce wybierz Narzędzia > Zapisz przestrzeń roboczą (w Zarządzaj). 

• W menu wybierz Narzędzia > Zapisz przestrzeń roboczą. 

• Na pasku stanu kliknij przycisk Przełącz między obszarami roboczymi, a 

następnie wybierz opcję Zapisz bieżący jako. 

• Wpisz wssave i naciśnij Enter. 

• Wpisz workspace, naciśnij Enter, a następnie wybierz SaveAs. 

3 Wybierz istniejącą nazwę obszaru roboczego z listy. 

4 Kliknij przycisk OK. 
 

Aby przełączyć na obszar roboczy 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz żądany obszar roboczy z listy obszarów roboczych ( ).  

• Na pasku stanu kliknij przycisk Przełącz między obszarami roboczymi (

 ), a następnie wybierz żądany obszar roboczy. 

• Na pasku narzędzi Przestrzenie robocze wybierz żądaną przestrzeń roboczą. 

• Wpisz workspace, naciśnij Enter, wybierz Set Current, a następnie 

wprowadź nazwę żądanego obszaru roboczego. 
 

Narzędzie Mój obszar roboczy (pasek narzędzi Obszary robocze) ładuje określony obszar 
roboczy. 

Kliknij narzędzie Moja przestrzeń robocza (  ), aby przełączyć się na 

preferowaną przestrzeń roboczą. Aby ustawić ładowanie przestrzeni roboczej 

po kliknięciu narzędzia Moja przestrzeń robocza, kliknij (  ) na pasku stanu, 

wybierz Ustawienia przestrzeni roboczej, a następnie wybierz przestrzeń 

roboczą w Mojej przestrzeni roboczej. 
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Wybieranie poleceń 
 

Polecenia można wybierać przy użyciu dowolnej z tych metod: 

• Wybierz polecenie ze wstążki. 

• Wybierz polecenie z menu. 

• Kliknij narzędzie w panelu Palety narzędzi. 

• Kliknij narzędzie na pasku narzędzi. 

• Wpisz polecenie na pasku poleceń. 

Niektóre polecenia pozostają aktywne do momentu ich zakończenia, dzięki czemu 

można powtórzyć czynność bez konieczności wielokrotnego wybierania polecenia. 

Polecenie można zakończyć, naciskając klawisz Esc. 

 

Używanie poleceń 

Większości poleceń można używać, gdy aktywne jest inne polecenie. Na przykład 

podczas rysowania linii można użyć polecenia Przesuń, aby przesunąć rysunek po 

ekranie w celu wybrania punktu końcowego linii. Można również zmieniać 

ustawienia narzędzi do rysowania, takich jak przyciąganie lub siatka, gdy aktywne są 

inne polecenia. 

Po uruchomieniu wiele poleceń ma opcje, które można wybrać na pasku poleceń, 

pasku stanu lub w oknie zachęty. 

 

Uruchamianie poleceń za pomocą wstążki 

Aby uruchomić polecenie ze wstążki, wybierz je z listy dostępnych opcji. Jeśli polecenie 

ma strzałkę, kliknij ją, aby wyświetlić powiązane polecenia. Na przykład wybierz 

opcję Strona główna, a następnie kliknij strzałkę dla opcji Szyk (w obszarze 

Modyfikuj), aby wybrać polecenie Szyk 3D. 

 

Uruchamianie poleceń przy użyciu palet narzędzi 

Aby uruchomić polecenie z palety narzędzi, kliknij narzędzie i reaguj na monity. 

Jeśli paleta zawiera kilka narzędzi, może być konieczne użycie pasków 

przewijania, aby zobaczyć pełną listę dostępnych narzędzi dla tej palety. 

 

Uruchamianie poleceń za pomocą pasków narzędzi 

Aby uruchomić polecenie z paska narzędzi, kliknij narzędzie i reaguj na monity. 

 

Dostępne paski narzędzi zależą od ustawionego poziomu doświadczenia. 

Aby zmienić bieżący poziom doświadczenia, wybierz Narzędzia > Opcje, a 

następnie kliknij kartę Ogólne. 
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Niektóre narzędzia, takie jak Linia lub Łuk, zawierają wysuwane elementy, które są 

opcjami umożliwiającymi korzystanie z podstawowego narzędzia przy użyciu 

różnych metod lub zawierają inne, powiązane narzędzia. Wyloty są oznaczone 

małym trójkątem w prawym dolnym rogu narzędzia. Aby wyświetlić wysuwane 

okno, kliknij narzędzie i przytrzymaj przycisk myszy. Aby wybrać narzędzie z 

wysuwanego menu, wskaż żądane narzędzie, a następnie zwolnij przycisk myszy. 

Narzędzie wybrane na wysuwanym panelu stanie się domyślnym narzędziem na 

pasku narzędzi. 

 

Uruchamianie poleceń za pomocą menu 

Aby uruchomić polecenie z menu, należy wybrać je z listy dostępnych opcji menu. 

Dostępne opcje menu zależą od ustawionego poziomu doświadczenia. Aby zmienić 

aktualny poziom doświadczenia, wybierz Narzędzia > Opcje, a następnie kliknij 

kartę Ogólne. 

 

Uruchamianie poleceń za pomocą paska poleceń 

Wpisz polecenie, a następnie naciśnij klawisz Enter. Jeśli pasek poleceń zostanie 

wyświetlony, pojawi się na nim wpisane polecenie. Jeśli pasek poleceń nie jest 

wyświetlany, wpisane polecenie pojawi się na pasku stanu. 

 

Szybkie uruchamianie poleceń za pomocą paska poleceń poprzez kopiowanie, 

wycinanie i wklejanie tekstu. Na pasku poleceń lub w oknie historii wiersza 

polecenia kliknij prawym przyciskiem myszy, aby wybrać różne polecenia 

wycinania, kopiowania i wklejania. 
 

 
Powtarzanie polecenia 

Można powtórzyć poprzednio używane polecenie bez konieczności jego ponownego 

wybierania. 
 

Aby powtórzyć właśnie użyte polecenie 

1 Wykonaj jedną z poniższych czynności: 

• Naciśnij spację. 

• Naciśnij Enter. 

• Kliknij prawym przyciskiem myszy na rysunku. 

Aby powtórzyć poprzednio używane polecenia 

1 Wykonaj jedną z poniższych czynności: 

• Na pasku poleceń lub w oknie historii wiersza polecenia naciśnij klawisz Ctrl 

i kliknij dwukrotnie poprzedni tekst polecenia. 

• Na pasku poleceń lub w oknie historii wiersza polecenia kliknij prawym 

przyciskiem myszy, wybierz Ostatnie polecenia, a następnie wybierz 

żądane polecenie. 

• Naciśnij klawisze Ctrl + K, powtarzaj tę czynność do momentu powrotu do 

żądanego polecenia, a następnie naciśnij klawisz Enter. Naciśnij Ctrl + L, aby 

przejść do żądanego polecenia, a następnie naciśnij Enter. 



• Strzałki w górę i w dół służą do wyświetlania poprzednio używanych poleceń, 

jeśli w menu Narzędzia > Opcje wybrano opcję Użyj strzałek w górę/w dół do 

nawigacji po historii poleceń. 
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Wielokrotne uruchamianie polecenia za pomocą paska poleceń. 

W przypadku korzystania z paska poleceń do wpisywania poleceń, przed 

uruchomieniem niektórych poleceń (na przykład Okrąg, Łuk i Prostokąt) można 

wpisać wielokrotność, aby powtarzać polecenie w nieskończoność. Po zakończeniu 

wpisywania polecenia naciśnij klawisz Esc. 
 

 
Zagnieżdżanie poleceń 

Jeśli pracujesz na pasku poleceń, możesz użyć innego polecenia wewnątrz polecenia, 

zwanego zagnieżdżaniem. Aby użyć polecenia wewnątrz aktywnego polecenia, wpisz 

apostrof przed wpisaniem polecenia, takiego jak "okrąg", "linia" lub "piramida". W 

ALCAD można zagnieżdżać polecenia w nieskończoność. Wiele makr menu i paska 

narzędzi działa w ten sposób domyślnie; na przykład wybierz kolor, siatkę 

odniesienia, powiększenie i przyciąganie. Po zakończeniu zagnieżdżonego polecenia, 

oryginalne polecenie jest wznawiane. 

 

Modyfikowanie polecenia 

Jeśli pracujesz na pasku poleceń, istnieją specjalne sposoby modyfikowania 

polecenia podczas pracy. Aktywne polecenie można zmodyfikować przy użyciu 

dowolnej z poniższych opcji: 

• Przyciągnięcia jednostek - Wpisz polecenie przyciągnięcia jednostki, takie 

jak najbliższy lub punkt środkowy, aby włączyć jednorazowe przyciągnięcie 

jednostki dla pojedynczego zaznaczenia. Można również użyć jednorazowego 

przyciągnięcia jednostki, aby zastąpić działające przyciągnięcie jednostki. 

• Przyciąganie rozszerzeń - Wpisz int po wybraniu polecenia, takiego jak Linia 

lub Okrąg, aby włączyć jednorazowe przyciąganie do logicznej lokalizacji, w 

której dwie jednostki przecinałyby się, gdyby miały nieskończoną długość. Wpisz 

app, aby włączyć podobne jednorazowe przyciąganie, jeśli rozszerzenia nie 

przecinałyby się w przestrzeni trójwymiarowej, ale przecinałyby się w bieżącym 

widoku. 

• Przyciąganie do punktu środkowego - wpisz m2p lub mtp, aby włączyć 

jednorazowe przyciąganie do punktu środkowego dwóch określonych punktów. 

 
Korzystanie z okna Historia monitów 

Okno Prompt History wyświetla historię poleceń i monitów wydanych od momentu 

uruchomienia bieżącej sesji ALCAD. Domyślnie program śledzi do 256 linii 

poleceń. Nie ma ograniczeń co do liczby linii poleceń, które można śledzić, ale 

wydajność programu może ulec pogorszeniu, jeśli zdecydujesz się śledzić zbyt dużą 

liczbę linii. 
 

Aby wyświetlić lub zamknąć okno Historia monitów 

• Naciśnij klawisz F2. 



 ShortcutAction 
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Aby wyświetlić wpisy w oknie Historia monitów 

1 Wykonaj jedną z poniższych czynności: 

• Użyj pasków przewijania. 

• Naciśnij Ctrl + K, aby przeglądać wstecz; naciśnij Ctrl + L, aby przeglądać do przodu. 

• Strzałki w górę i w dół służą do wyświetlania poprzednio używanych poleceń, 

jeśli w menu Narzędzia > Opcje wybrano opcję Użyj strzałek w górę/w dół do 

nawigacji po historii poleceń. 
 

Aby skopiować lub wkleić tekst w oknie Historia komunikatów 

1 W przypadku kopiowania tekstu wykonaj jedną z poniższych czynności: 

• Podświetl tekst za pomocą myszy. 

• Naciśnij Ctrl + Shift + klawisze strzałek, aby podświetlić tekst. 

2 Kliknij prawym przyciskiem myszy i wybierz kopiowanie lub wklejanie. 
 

Można również skopiować całą historię poleceń lub ostatnią linię poleceń. 

Wybierz Kopiuj historię lub Kopiuj ostatni wiersz. 
 

 
Aby zmienić liczbę śledzonych wierszy poleceń 

1 Wykonaj jedną z poniższych czynności: 

• Wybierz Narzędzia > Opcje, a następnie kliknij kartę Wyświetlanie. 

• Wpisz opcje, a następnie naciśnij klawisz Enter. Kliknij kartę Wyświetlanie. 

2 W polu Command Lines To Track wpisz liczbę wierszy poleceń, które 

chcesz wyświetlić, a następnie kliknij OK. 

 

Używanie skrótów myszy 

Do uruchamiania poleceń i wykonywania innych czynności można używać myszy, 

często w połączeniu z klawiaturą. 

 
Skróty myszy 

 

Ctrl + Przytrzymaj i przeciągnij lewym przyciskiem myszy Kopiowanie i 

przenoszenie wybranych elementów Ctrl + Przytrzymaj i przeciągnij prawym 

przyciskiem myszy Polecenie  Ograniczona orbita Z 

Ctrl + kliknięcie lewym przyciskiem myszyCykl  wyboru jednostek znajdujących się pod 

kursorem Ctrl+Shift +Hold i przeciągnięcie lewym przyciskiem myszy Polecenie 

powiększenia w czasie rzeczywistym 

Ctrl +Shift +Hold i przeciągnij środkowy przycisk 
myszy (kółko) 

Alt + Shift + Przytrzymaj i przeciągnij środkowy 
przycisk myszy lub 
Shift + Przytrzymaj i przeciągnij środkowy 
przycisk myszy 

Polecenie orbity 

swobodnej Polecenie 

orbity ograniczonej 

 
 



 

Shift + kliknięcie lewym przyciskiem myszy Odznaczanie podmiotów 

Shift + kliknięcie prawym przyciskiem myszy Menu skrótów przyciągania jednostek 



 ShortcutAction 
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Skróty myszy 
 

Przytrzymanie i przeciągnięcie lewym przyciskiem myszy Przenoszenie wybranych podmiotów 

Kliknięcie prawym przyciskiem myszy Wyświetlenie menu skrótów dla wybranej jednostki 

Obracanie  kółka myszy Polecenia 

powiększania i pomniejszania  

Przytrzymaj kółko myszy,  a następnie poruszaj myszą 

Polecenie pancommand w czasie rzeczywistym 

Ctrl + Obrót kółka myszy, gdy pasek poleceń 
jest aktywny 

Powiększanie i pomniejszanie paska poleceń 

 
 

 

Korzystanie ze skrótów klawiaturowych 

Poniższe skróty klawiaturowe uruchamiają często używane polecenia ALCAD. Aby 

dostosować klawisze funkcyjne, wybierz Narzędzia > Klawisze funkcyjne lub 

wybierz Narzędzia > Dostosuj i kliknij zakładkę Klawiatura. 
 

Skróty klawiaturowe 

 

Czysty ekran CLEANSCREENON i 
CLEANSCREENOFF 

Ctrl+0 (zero) Wyświetla lub ukrywa elementy interfejsu użytkownika na ekranie. 

 

Pasek  poleceńCMDBAR Ctrl+9 Wyświetla lub ukrywa pasek poleceń. 

Koordynat WSPÓŁRZĘDNE F6, Ctrl+D, Ctrl+I Przełącza wyświetlanie współrzędnych między Włącz, Wyłącz i Kąt/ 
Odległość. 

Kopiowanie do schowka COPYCLIP Ctrl+C Kopiuje wybrane elementy do schowka systemu Windows. 

  

   Kopiowanie z punktem bazowym  

COPY BASE Ctrl+Shift+C Kopiuje zaznaczone elementy do schowka systemu Windows. 
z punktem bazowym. 

CuttoClipboard CUTCLIP Ctrl+X Wycina wybrane elementy z aktywnego rysunku i kopiuje je 
do schowka systemu Windows. 

Usuń  DELETEDel Usuwa wybrane jednostki. Entity 

Snap ESNAP F3, Ctrl+F Włącza i wyłącza przyciąganie  

jednostek. 

Śledzenie przyciągania jednostek    ENTTRACK F11 Włącza i wyłącza śledzenie  

   przyciągnięcia jednostki  

Wyjście EXIT Alt+F4, Ctrl+Q Zamyka wszystkie rysunki i wychodzi z 

ALCAD. 

Siatka GRID F7, Ctrl+G Włącza i wyłącza siatkę odniesienia. 

Pomoc  HELPF1 Uruchamia pomoc online. 

Hiperłącze HYPERLINK Crl+K Dołącza hiperłącza do elementów rysunku. 

Płaszczyzna izometryczna ISOPLANE F5, Ctrl+E Przełącza płaszczyznę izometryczną między górną, prawą i 
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lewą. Nowy rysunek NOWY Ctrl+N Tworzy nowy, pusty rysunek. 

Rysunek otwarty OTWÓRZ Ctrl+O Wyświetla okno dialogowe Otwórz rysunek, w którym można 
otworzyć 

kolejny rysunek. 

Ortogonalny ORTHOGONAL F8, Ctrl+L Włącza lub wyłącza tryb ortogonalny. 
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Skróty klawiaturowe 

Pan  PANdown Strzałka w dół Przesuwa widok okna rysunku w dół o jedną  

    jednostkę.  

 PAN w lewo Strzałka w lewo Przesuwa widok okna rysowania w lewo o  

    jedną jednostkę. 

PAN PGDown Strona w dół, 
Shift+strzałka w 
dół 

Przesuwa widok okna rysunku w dół o jeden ekran. 

PANPGLeft Shift+strzałka w lewo    Przesuwa widok okna rysunku w lewo o jeden  

  ekran.  

PAN PGRight Shift+strzałka w  prawoPrzesuwa widok okna rysunku w prawo o  

  jeden ekran. 

PANPGUp Strona w górę, 
Shift+strzałka w 
górę 

Przesuwa widok okna rysunku o jeden ekran w górę.

 
 

PANRight Strzałka w prawo Przesuwa widok okna rysunku w prawo o jedną  

                        jednostkę.  

Strzałka w górę Strzałka w górę Przesuwa widok okna rysunku w górę o jedną    

jednostkę. 

Wklejanie ze schowka PASTECLIP Ctrl+V Wkleja zawartość schowka systemu Windows do pliku 
aktywny rysunek. 

Wklej jako blok PASTEBLOCK Ctrl+Shift+V Wkleja zawartość schowka Windows do bloku 
aktywny rysunek jako blok. 

Polar Tracking POLARTRACK F10, Ctrl+U Włącza i wyłącza śledzenie biegunowe 

Okno historii komunikatów  PMTHISTF2 Włącza i wyłącza okno historii monitów. 

Właściwości WŁAŚCIWOŚCI Ctrl+1 Wyświetla lub ukrywa panel 

Właściwości. 

Drukuj PRINT Ctrl+P Drukuje aktywny rysunek. 
Szybkie  zapisywanieQSAVE Ctrl+S Zapisuje aktywny rysunek. 
Redo REDO Ctrl+Y Cofa działanie ostatniego cofnięcia. 
Powtórz 
poprzednie 
polecenie 

            NIE DOTYCZY Ctrl+J, Ctrl+M Powtarza poprzednie polecenie. 

 
Zapisz  jakoSAVEAS Ctrl+Shift+S Zapisuje aktywny rysunek z opcją zapisania go z rozszerzeniem 

nowa nazwa lub format pliku. 
Wybierz  AllSELGRIPS Ctrl+A Zaznacza wszystkie jednostki na rysunku. 
Selection Cycling SELECTIONCYCLING Ctrl+W Włącza i wyłącza pomoce wizualne związane z cyklicznym 
zaznaczaniem. 
Snap SNAP F9 

Ctrl+B 
Włącza i wyłącza ustawienia przyciągania. 

 
Strona startowa GOTOSTART Ctrl+Home Przełącza z bieżącego rysunku na stronę początkową. 
Palety narzędzi TOOLPALETTES i 

TOOLPALETTESCLOSE 
Ctrl+3 Wyświetla lub ukrywa panel palet narzędzi. 

 
 Cofnij Ctrl+Z Cofa ostatnią akcję polecenia. 
VBA EditorVBA Alt+F11 Otwiera edytor Visual Basic for Applications, dzięki czemu można 
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może utworzyć lub zmodyfikować  

makro VBA.   

Zamykanie okna WCLOS ECtrl+F4 Zamyka aktywne okno rysowania. 
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Używanie skryptów 

Rejestrator skryptów ALCAD przechwytuje i zapisuje wiele twoich działań, abyś 

mógł je odtworzyć. Po włączeniu rejestratora skryptów wszystkie polecenia i opcje 

wpisywane na pasku poleceń są rejestrowane do momentu wpisania polecenia 

zatrzymującego nagrywanie. Po uruchomieniu skryptu program wykonuje kolejno 

nagrane polecenia. 

 

 
 

Poprawianie błędów 
 

ALCAD śledzi używane polecenia i wprowadzane zmiany. Jeśli zmienisz zdanie lub 

popełnisz błąd, możesz cofnąć lub odwrócić ostatnią akcję lub kilka poprzednich 

akcji. Możesz także powtórzyć wszystkie czynności, które zostały cofnięte. 

 
 AB 

  
 

A Kliknij Cofnij, aby cofnąć ostatnią akcję. 

B Kliknij przycisk Cofnij, aby cofnąć poprzednie cofnięcia. 

Możesz cofnąć i ponowić wiele akcji, wybierając Cofnij i Ponów z paska narzędzi 

Szybki dostęp na wstążce, aby wyświetlić i wybrać zakres akcji. Możesz także 

wpisać Cofnij, a następnie określić liczbę akcji do cofnięcia. 

 

 
 

Dostosowywanie ALCAD 
 

Wiele aspektów programu ALCAD można dostosować do własnych potrzeb. Na 

przykład można łatwo tworzyć i modyfikować menu za pomocą polecenia Customize 

User Interface (cui) lub tworzyć i modyfikować paski narzędzi, po prostu 

przeciągając i upuszczając ikony. 

ALCAD przechowuje niestandardowe ustawienia w pliku .cui; można je również 

przechowywać w profilu. 

ALCAD obsługuje najważniejsze pliki dostosowywania AutoCAD, w tym typy 

linii, wzory kreskowania, czcionki tekstowe, plik konwersji jednostek, menu, paski 

narzędzi i aliasy. Ponadto ALCAD ujednolica wiele funkcji dostosowywania 

AutoCAD za pomocą jednego polecenia cui: aliasy poleceń, menu, paski narzędzi, 

skróty klawiaturowe i akcje dwukrotnego kliknięcia. W przypadku wersji programu 

ALCAD ze wstążką lista poleceń cui obejmuje również wstążki, paski narzędzi 

szybkiego dostępu, przyciski aplikacji i menu kontekstowe. Więcej szczegółów na 

temat dostosowywania można znaleźć w rozdziale 17, "Dostosowywanie programu 

ALCAD". 
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Można również dodawać niestandardowe programy napisane w dowolnym z kilku 

języków programowania, w tym następujących: 

• ODA SDK i IRX (podobny do języka Autodesk® ARX) 

• LISP (język programu kompatybilny z Autodesk® AutoLISP) 

• SDS (podobny do języka Autodesk® ADS) 

• DCL (Dialog Control Language) 

• DIESEL 

• Microsoft® Visual Basic for Applications (VBA) 

• .NET 

Aby uzyskać więcej informacji na temat programów niestandardowych, patrz "Programowanie 

ALCAD" na stronie 789. 

 
Migracja dostosowań z poprzedniej wersji ALCAD Dostosowania 

wprowadzone w poprzedniej wersji ALCAD można łatwo przenieść do bieżącej 

wersji ALCAD. Możesz scalić lub zastąpić niestandardowe 

ustawienia dokonane w obszarach roboczych i plikach personalizacji (pliki .cui), w tym w 
menu, plikach 

wstążki, jeśli dana wersja je obsługuje, paski narzędzi, skróty klawiaturowe, aliasy 

i akcje podwójnego kliknięcia. 
 

Aby zmigrować dostosowania z poprzedniej wersji ALCAD 

1 Użyj jednej z poniższych metod, aby wybrać Migrate UI (  ): 

• Na wstążce wybierz Narzędzia > Migruj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Migruj interfejs użytkownika. 

• Wpisz migrate, a następnie naciśnij Enter. 

2 Wprowadź ścieżkę i nazwę pliku .cui, który zawiera dostosowanie, które chcesz 

zmigrować do bieżącej wersji ALCAD. W razie potrzeby wpisz ? i naciśnij 

Enter, aby wyświetlić listę dostępnych plików .cui. 

3 Wybierz jedną z poniższych opcji: 

• Zastąp podanym - całkowicie zastępuje bieżące dostosowanie 

dostosowaniem z wybranego pliku .cui. 

• Scal preferowane - scala dostosowania z preferencją do poprzedniej instalacji, jeśli 

wystąpią konflikty. 

• Scal preferencje bieżącej instalacji - scala dostosowania z preferencjami 

bieżącej instalacji, jeśli wystąpią konflikty. 
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Uzyskiwanie pomocy online 
 

ALCAD zawiera pomoc online, która zawiera tematy zorientowane na zadania, 

odniesienie do poleceń, odniesienie do zmiennych systemowych i odniesienie do 

języka programowania. 

Pomoc online (  ) można wyświetlić na jeden z poniższych sposobów: 

• Na wstążce wybierz opcję Pomoc, a następnie wybierz polecenie. 

• Na pasku narzędzi Standard kliknij opcję Pomoc. 

• Naciśnij F1. 

• Wybierz polecenie z menu Pomoc. 

• Kliknij znak zapytania w oknie dialogowym. 

• Wpisz help na pasku poleceń. 

 

 
Zapisywanie rysunku 

 
Rysunek można zapisać w dowolnym momencie. 

Użyj jednej z poniższych metod, aby wybrać opcję Zapisz (  ): 

• Na pasku narzędzi Szybki dostęp na wstążce kliknij przycisk Zapisz. 

• Na wstążce Przycisk aplikacji wybierz opcję Zapisz. 

• Na pasku narzędzi Standard kliknij przycisk Zapisz. 

• W menu wybierz Plik > Zapisz. 

• Wpisz save i naciśnij Enter. 

Przy pierwszym zapisywaniu rysunku program wyświetla okno dialogowe Zapisz 

rysunek jako, w którym można wybrać katalog i wpisać nazwę rysunku. Aby 

zapisać rysunek później przy użyciu innej nazwy, wykonaj następujące czynności: 

• Wybierz Plik > Zapisz jako i wpisz nową nazwę. 

 

 

Wyjście z ALCAD 
 

Po zakończeniu pracy w programie ALCAD: 

• Na wstążce Przycisk aplikacji wybierz Wyjdź. 

• W menu wybierz Plik > Wyjdź. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 
Rysunki CAD pomagają organizować informacje w celu zwiększenia wydajności. 

Dzięki Intelli-CAD możesz rysować jednostki reprezentujące różne typy informacji 

na różnych warstwach i używać tych warstw do kontrolowania koloru, rodzaju linii 

i widoczności. ALCAD zawiera również pomoce do rysowania, które pomagają w 

dokładnym rysowaniu. 

W tej sekcji wyjaśniono konfigurowanie rysunków i korzystanie z wbudowanych 

pomocy rysunkowych, w tym sposoby ich tworzenia: 

• Tworzenie nowych rysunków, otwieranie istniejących rysunków i zapisywanie zmian w 

rysunkach. 

• Korzystaj z pomocy, takich jak siatka, przyciąganie i ustawienia ortogonalne, aby rysować 

dokładnie. 
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Tworzenie nowego rysunku 
 

Po uruchomieniu programu ALCAD, program automatycznie tworzy nowy rysunek 

na podstawie szablonu rysunku, icad.dwt. Szablon ten zawiera predefiniowane 

ustawienia, takie jak jednostki rysunkowe, rozmiar tekstu, styl wydruku, typ tabeli i 

obszar rysowania. Możesz użyć tych ustawień lub zmienić je zgodnie z własnymi 

potrzebami. Nie ma nic wyjątkowego w szablonie rysunku. Można użyć dowolnego 

rysunku jako szablonu dla przyszłych rysunków. 

Możesz zaoszczędzić wiele kroków, opierając nowy rysunek na istniejącym 

szablonie (plik .dwt). W ten sposób nowy rysunek będzie zawierał wszystkie 

potrzebne ustawienia i jednostki. Po otwarciu nowego rysunku z niestandardowego 

szablonu można zmodyfikować istniejące ustawienia i usunąć niepotrzebne 

elementy. Zapisanie rysunku utworzonego przy użyciu szablonu nie powoduje 

zmiany szablonu. 
 

Aby utworzyć nowy rysunek 

1 Wykonaj jedną z poniższych czynności: 

• Na pasku narzędzi Szybki dostęp wstążki kliknij narzędzie Nowy. 

• Wpisz qnew i naciśnij Enter. 

Aby utworzyć nowy rysunek na podstawie szablonu 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce przycisku Aplikacja wybierz opcję Nowa. 

• W menu wybierz Plik > Nowy. 

• Wpisz new lub newwiz, a następnie naciśnij Enter. 

2 Kliknij opcję Użyj szablonu rysunku, a następnie kliknij przycisk Dalej. 

3 Aby wyświetlić okno dialogowe Otwórz szablon, kliknij przycisk Przeglądaj. 

4 Wybierz żądany plik szablonu (.dwt), a następnie kliknij przycisk 

Otwórz. Możesz także wybrać dowolny plik rysunku (.dwg) do 

użycia jako szablon. 

5 Kliknij przycisk Zakończ. 



 

Otwieranie 
rysunku 
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Można otwierać pliki rysunków (.dwg), pliki Drawing Exchange Format (.dxf), 

pliki Design Web (.dwf) i pliki szablonów rysunków (.dwt). 

Możesz także otworzyć i sprawdzić rysunki, co do których podejrzewasz, że są uszkodzone. 

 

Otwieranie istniejącego rysunku 

Możesz otworzyć dowolny z tych plików rysunkowych: 

• Standardowe pliki rysunkowe z rozszerzeniem .dwg. 

Oprócz własnych plików rysunkowych można otworzyć i użyć jednego z 

przykładowych rysunków dołączonych do ALCAD. 

• Pliki w formacie Drawing Exchange Format z rozszerzeniem .dxf. 

• Pliki Design Web Format z rozszerzeniem .dwf. 

• Szablony rysunkowe z rozszerzeniem pliku .dwt. 

Aby otworzyć istniejący rysunek 

1 Użyj jednej z poniższych metod, aby wybrać opcję Otwórz (  ): 

• Na pasku narzędzi Szybki dostęp na wstążce kliknij narzędzie Otwórz. 

• W menu wybierz Plik > Otwórz. 

• Na pasku narzędzi Standard kliknij narzędzie Otwórz. 

• Wpisz open i naciśnij Enter. 

2 W polu Pliki typu wybierz typ pliku, który chcesz otworzyć. 

3 Wybierz folder zawierający żądany plik. 

4 Wykonaj jedną z poniższych czynności: 

• Wybierz rysunek, który chcesz otworzyć, a następnie kliknij Otwórz. 

• Kliknij dwukrotnie rysunek, który chcesz otworzyć. 

Jeśli rysunek wymaga hasła, wprowadź hasło, kliknij OK, aby zweryfikować 

hasło, a następnie kliknij Otwórz ponownie. 

 

Rysunki można również otwierać podczas przeglądania plików na komputerze. 

Wystarczy dwukrotnie kliknąć plik lub przeciągnąć go do obszaru rysowania w 

programie ALCAD. Korzystając z programów dostarczonych z systemem 

operacyjnym, takich jak Eksplorator plików Windows lub Mój komputer, można 

znaleźć żądany rysunek, przeglądając miniatury plików rysunków podczas ich 

przeglądania. W razie potrzeby wybierz Narzędzia > Opcje i na karcie Ogólne kliknij 

Ustaw skojarzenie plików, aby określić, które typy plików są powiązane z programem 

ALCAD. 
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A Jeśli w wybranym rysunku znajduje się miniatura, obraz rysunku 

zostanie wyświetlony przed jego otwarciem. 

B Włącza lub wyłącza podgląd rysunku. 

C Niedostępne podczas otwierania rysunków; dostępne tylko 
podczas zapisywania rysunków. 

D Otwiera rysunek jako tylko do odczytu, aby zapobiec 
wprowadzaniu zmian w pliku. 

E Wyświetla opis rozmiaru pliku, datę utworzenia i inne informacje o 
rysunku. 

F Kliknij, aby wyświetlić więcej opcji pracy z plikami. 

G Określa sposób wyświetlania rysunków na liście, w tym szczegóły pliku 
i miniatury obrazów. 

 
 
 

 

Ostatnio otwierane rysunki są śledzone w menu Plik, co ułatwia ich otwieranie. 

Wybierz Plik > nazwa pliku, aby szybko otworzyć ostatnio używany plik rysunku. 
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Otwieranie uszkodzonego rysunku 

Pliki mogą ulec uszkodzeniu z wielu powodów. Na przykład, jeśli pracujesz nad 

rysunkiem podczas przerwy w dostawie prądu, awarii systemu lub awarii sprzętu, 

plik rysunku może zostać uszkodzony. ALCAD umożliwia otwieranie i 

sprawdzanie uszkodzonych plików w celu ich odzyskania. 

Odzyskiwanie pliku próbuje otworzyć jeden z następujących typów plików: 

• Standardowe pliki rysunkowe z rozszerzeniem .dwg. 

• Pliki w formacie Drawing Exchange Format z rozszerzeniem .dxf. 

• Pliki Design Web Format z rozszerzeniem .dwf. 

• Szablony rysunkowe z rozszerzeniem pliku .dwt. 

Możesz także przeprowadzić audyt dowolnego otwartego pliku, aby sprawdzić go 

pod kątem błędów. Określasz, czy chcesz, aby ALCAD automatycznie naprawiał 

wszelkie znalezione błędy. ALCAD naprawia jak najwięcej błędów, a wszelkie 

błędy, których nie można naprawić, są zgłaszane jako "Ignorowane" w oknie Prompt 

History. 
 

Aby otworzyć uszkodzony plik 

1 Użyj jednej z poniższych metod: 

• Na wstążce Przycisk aplikacji wybierz Narzędzia do rysowania > Odzyskaj. 

• W menu wybierz Plik > Odzyskaj. 

• Wpisz recover i naciśnij Enter. 

2 W sekcji Pliki typu wybierz typ pliku, który chcesz odzyskać. 

3 Wybierz katalog zawierający uszkodzony plik. 

4 Wybierz uszkodzony plik, który chcesz odzyskać. 

5 Kliknij przycisk Otwórz. 
 

Jeśli chcesz automatycznie sprawdzać wszystkie rysunki pod kątem błędów 

podczas ich otwierania, wybierz Narzędzia > Opcje > zakładkę Ogólne i zaznacz 

pole wyboru Otwórz rysunki przy użyciu funkcji odzyskiwania. 
 

Aby sprawdzić plik rysunku pod kątem błędów 

1 Po otwarciu rysunku, który chcesz sprawdzić, wykonaj jedną z poniższych czynności: 

• Na wstążce Przycisk aplikacji wybierz Narzędzia do rysowania > Audyt. 

• W menu wybierz Plik > Audyt. 

• Wpisz audit i naciśnij Enter. 

2 Wybierz, czy chcesz, aby ALCAD automatycznie naprawiał znalezione 

błędy, a następnie naciśnij Enter. 
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Plik ASCII zawiera opis audytu. 

Jeśli zmienna systemowa AUDITCTL jest ustawiona na On i podczas odzyskiwania 

pliku lub audytu zostaną znalezione błędy, tworzony jest plik ASCII opisujący audyt. 

Plik ASCII jest zapisywany w tym samym folderze co audytowany rysunek i ma taką 

samą nazwę jak plik rysunku, ale z rozszerzeniem .adt. 
 

 

 

 

Konfigurowanie rysunku 
 

Poszczególne ustawienia można określić podczas tworzenia nowego rysunku lub 

modyfikowania ustawień w rysunku utworzonym na podstawie szablonu. 

 

Ustawianie bieżącej warstwy 

Warstwy przypominają nakładki używane w kreśleniu ręcznym. Warstwy służą do 

porządkowania różnych typów informacji rysunkowych. Każdy rysunek ma co 

najmniej jedną warstwę, warstwę domyślną o nazwie "0". Rysunek może również 

zawierać nieograniczoną liczbę dodatkowych warstw. Podczas tworzenia elementu 

jest on tworzony na bieżącej warstwie. 
 

Aby ustawić bieżącą warstwę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Warstwy (w obszarze Warstwy). 

• W menu wybierz Format > Eksploruj warstwy. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj warstwy . 

• Wpisz explayers i naciśnij Enter. 

• Wpisz la i naciśnij Enter. 

2 Kliknij dwukrotnie nazwę warstwy, która ma zostać zaktualizowana. 

 

Użyj skrótu na pasku stanu. 

Na pasku stanu kliknij prawym przyciskiem myszy kontrolkę bieżącej warstwy i z 

listy wybierz warstwę, którą chcesz uczynić bieżącą. 
 

 

Użyj warstwy wybranej jednostki, aby ustawić bieżącą warstwę. 

Wpisz LAYBYENT na pasku poleceń, wybierz Set i wybierz jednostkę z warstwą, która ma 

być aktualna. 
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Ustawienie bieżącego koloru jednostki 

Kolor jednostki określa sposób jej wyświetlania, a w przypadku korzystania z 

kolorowej drukarki - sposób drukowania. Jednostki są tworzone w bieżącym kolorze. 

Po otwarciu nowego rysunku elementy są tworzone w kolorze BYLAYER, który 

przyjmuje kolor bieżącej warstwy. Początkowo warstwa 0 jest zarówno jedyną, 

jak i bieżącą warstwą. Jej domyślnym kolorem jest biały, więc elementy są 

wyświetlane jako białe. 

Istnieją kolory indeksu, które zawierają dwie dodatkowe właściwości kolorów, które 

są często określane jako kolory, prawdziwe kolory i kolory książki kolorów. Te 

dwie dodatkowe właściwości kolorów to BYLAYER i BYBLOCK. Te właściwości 

kolorów powodują, że jednostka przyjmuje kolor warstwy lub bloku, w którym się 

znajduje. 
 

Aby ustawić bieżący kolor jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 Kliknij przycisk Wybierz kolor. 

4 W oknie dialogowym Kolor kliknij jedną z poniższych kart i wybierz kolor: 

• Kolor indeksu - kliknij BYBLOCK, BYLAYER lub jeden z 255 kolorów 

indeksu. Możesz także wpisać numer koloru w polu Indeks. 

• True Color - kliknij kolor podstawowy, kliknij kolor w palecie kolorów, 

wprowadź wartości odcienia, nasycenia i luminancji (HSL) lub wprowadź 

wartości czerwonego, zielonego i niebieskiego (RGB). Do wyboru jest ponad 

16 milionów prawdziwych kolorów. 

• Kolorniki - wybierz kolornik z listy, a następnie kliknij kolor. Można wybrać 

opcję Pokaż tylko kolory z książki kolorów użyte w rysunku, aby ograniczyć 

wybór tylko do tych kolorów z książki kolorów, które są używane w 

bieżącym rysunku. 

5 Kliknij przycisk OK. 

6 Kliknij ponownie przycisk OK. 

 

Użyj skrótu na pasku stanu. 

Na pasku stanu kliknij prawym przyciskiem myszy bieżący kolor i wybierz z listy 

kolor, którego chcesz użyć dla nowych jednostek. Możesz także kliknąć Wybierz 

kolor, aby wybrać dodatkowe kolory. 
 

Więcej informacji na temat używania kolorów w wielu aspektach rysunku można 

znaleźć w sekcji "Praca z kolorami" na stronie 63 w tym rozdziale. 
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Ustawianie bieżącego typu linii 

Typy linii pomagają w przekazywaniu informacji. Używasz różnych typów linii, 

aby odróżnić cel jednej linii od drugiej. Typ linii składa się z powtarzającego się 

wzoru kropek, kresek lub pustych przestrzeni. Typy linii określają wygląd 

elementów zarówno na ekranie, jak i po wydrukowaniu. Domyślnie każdy rysunek 

ma co najmniej trzy rodzaje linii: CON- TINUOUS, BYLAYER i BYBLOCK. 

Rysunek może również zawierać nieograniczoną liczbę dodatkowych typów linii. 

Podczas tworzenia encji jest ona tworzona przy użyciu bieżącego typu linii. 

Domyślnie bieżącym typem linii jest BYLAYER. ALCAD wskazuje, że typ linii 

encji jest określany przez typ linii bieżącej warstwy poprzez przypisanie właściwości 

BYLAYER jako domyślnego ustawienia typu linii. Po przypisaniu BYLAYER 

zmiana typu linii warstwy zmienia typ linii wszystkich encji przypisanych do tej 

warstwy (jeśli zostały utworzone przy użyciu typu linii BYLAYER). 

Można również wybrać określony typ linii jako bieżący typ linii, który zastępuje 

ustawienie typu linii warstwy. Podmioty są następnie tworzone przy użyciu tego typu 

linii, a zmiana typu linii warstwy nie ma na nie wpływu. 

Jako trzeciej opcji można użyć właściwości linetype BYBLOCK, w którym to 

przypadku nowe jednostki są rysowane przy użyciu linetype CONTINUOUS do 

momentu zgrupowania ich w blok. Następnie jednostki dziedziczą ustawienie typu 

linii bloku po wstawieniu bloku do rysunku. 
 

Aby ustawić bieżący typ linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 Z listy Linetype wybierz typ linii, który chcesz ustawić jako aktualny. 

4 Kliknij przycisk OK. 

 

Użyj skrótu na pasku stanu. 

Na pasku stanu kliknij prawym przyciskiem myszy słowo BYLAYER dla bieżącego 

rodzaju linii, kliknij opcję Właściwości, a następnie wybierz rodzaj linii, który chcesz 

uczynić aktualnym. 
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Ustawianie skali typu linii 

Można określić skalę wzoru linii. Im mniejsza skala, tym więcej powtórzeń wzoru 

linii jest generowanych na jednostkę rysunkową. Na przykład wzór typu linii jest 

zdefiniowany jako sekwencja przerywanych linii i otwartych przestrzeni, każda o 

długości 0,25 jednostki. Skala typu linii wykorzystuje współczynnik skali rysunku do 

określenia długości. Współczynnik skali 0,5 zmniejszy długość każdej linii i odstępu 

do 0,125 jednostki; współczynnik skali 2 zwiększy długość każdej z nich do 0,5 

jednostki. 

Należy pamiętać, że ustawienie zbyt dużej lub zbyt małej skali typu linii może 

spowodować, że wzór linii będzie wyglądał jak linia ciągła, w zależności od tego, 

jaki jest widok skali lub w jakiej skali rysunek jest drukowany. 

Można kontrolować indywidualny współczynnik skalowania linii nowego elementu, 

a także ogólny lub globalny współczynnik skalowania stosowany do wszystkich 

elementów na rysunku. W przypadku korzystania ze skalowania adnotacji dla 

jednostek, takich jak tekst i wymiary, można również skonfigurować skalowanie 

typu linii, aby skoordynować je z różnymi scenariuszami skalowania adnotacji. 
 

Aby ustawić bieżącą indywidualną skalę typu linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 W polu Skala typu linii wpisz lub wybierz skalę typu linii, która ma być 

aktualna. 

4 Kliknij przycisk OK. 
 

Aby zmienić globalną skalę typu linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 W polu Globalna skala linetype wpisz lub wybierz globalną skalę linetype, 

którą chcesz zmienić. 

4 Kliknij przycisk OK. 
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Aby skonfigurować skalowanie typu linii tak, aby było takie samo w przestrzeni 
modelu i przestrzeni papieru 

1 Ustaw globalną skalę typu linii (wspomnianą wcześniej) na skalę rysunku. 

Na przykład, wprowadź .25 dla współczynnika skali 1/4" - 1". 

2 Wpisz PSLTSCALE i naciśnij Enter, a następnie wpisz 0, aby wyłączyć tę 

zmienną systemową. Niestandardowe skalowanie typu linii specyficzne dla 

przestrzeni papieru zostanie wyłączone. 

3 Wpisz MSLTSCALE i naciśnij Enter, a następnie wpisz 0, aby wyłączyć tę 

zmienną systemową. Niestandardowe skalowanie typu linii specyficzne dla 

przestrzeni modelu zostanie wyłączone. 

Aby skonfigurować skalowanie typu linii tak, aby było różne w przestrzeni modelu i 
przestrzeni papieru 

1 Ustaw globalną skalę linetype (wspomnianą wcześniej) na 1. Ustawia to 

domyślny współczynnik skali linetype na taki sam jak skala rysunku. 

2 Wpisz PSLTSCALE i naciśnij Enter, a następnie wprowadź 1, aby włączyć tę 

zmienną systemową. Niestandardowe skalowanie typu linii specyficzne dla 

przestrzeni papieru zostanie wyłączone. 

3 Wpisz MSLTSCALE i naciśnij Enter, a następnie wpisz 1, aby włączyć tę 

zmienną systemową. Niestandardowe skalowanie typu linii specyficzne dla 

przestrzeni modelu zostanie wyłączone. 

4 W przypadku rysunków wykorzystujących skalowanie adnotacji należy wykonać 

następujące czynności: 

• Na pasku stanu kliknij prawym przyciskiem myszy Annotations Scales List. 

• Wybierz bieżącą skalę adnotacji, na przykład 1/4" - 1". Spowoduje to 

ustawienie skali typu linii na skalę adnotacji. 
 

Typy linii będą takie same dla wszystkich rzutni, które mają tę samą skalę 

adnotacji. Ustawienie skalowania typów linii tak, aby było różne w przestrzeni 

modelu i przestrzeni papieru, jest preferowaną metodą dla rysunków ze 

szczegółami, profilami lub widokami planu, które nie zawsze mają tę samą skalę. 

Rzutnie w przestrzeni papierowej będą wyglądać i drukować zgodnie z 

przeznaczeniem, a skalę adnotacji w przestrzeni modelu można dostosować tak, 

aby pasowała do wyświetlania w przestrzeni papierowej. Więcej informacji na 

temat skalowania adnotacji można znaleźć w sekcji "Zrozumienie współczynników 

skali" na stronie 56 w tym rozdziale. 
 

 
Ustawianie bieżącej wagi linii 

Odstępy między wierszami pomagają odróżnić cel jednej linii od drugiej. 

Grubości linii określają, jak grube lub cienkie elementy pojawiają się zarówno na 

ekranie, jak i po wydrukowaniu. Każdy rysunek ma te grubości linii: 

DEFAULT, BYLAYER, BYBLOCK i wiele dodatkowych grubości linii w 

milimetrach (można też użyć cali). 

Podczas tworzenia encji jest ona tworzona przy użyciu bieżącej grubości linii. 

Domyślnie bieżąca waga linii dla nowej encji to BYLAYER. Oznacza to, że waga 

linii encji jest określana przez bieżącą warstwę. Po przypisaniu BYLAYER, zmiana 

grubości linii warstwy zmienia grubość linii wszystkich encji przypisanych do tej 



warstwy (jeśli zostały one utworzone przy użyciu grubości linii BYLAYER). 
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Można również wybrać określoną grubość linii (lub domyślną) jako bieżącą grubość 

linii, która zastępuje ustawienie grubości linii warstwy. Jednostki są następnie 

tworzone przy użyciu tej grubości linii (lub domyślnej grubości linii), a zmiana 

grubości linii warstwy nie ma na nie wpływu. 

Trzecią opcją jest użycie właściwości lineweight BYBLOCK, w którym to 

przypadku nowe jednostki są rysowane przy użyciu domyślnej grubości linii, dopóki 

nie zostaną zgrupowane w blok. Następnie jednostki dziedziczą ustawienie grubości 

linii bloku po wstawieniu bloku do rysunku. 

W przypadku wybrania grubości linii mniejszej niż 0,025 milimetra, podczas 

tworzenia rysunku będzie on wyświetlany jako jeden piksel. Podczas drukowania 

rysunek zostanie wydrukowany z najmniejszą grubością linii dostępną dla danej 

drukarki. 

Nie można przypisywać grubości linii do płaszczyzn, punktów, czcionek TrueType 

lub obrazów rastrowych (jeśli są obsługiwane w danej wersji programu ALCAD). 
 

Aby ustawić bieżącą wagę linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania lub Narzędzia > Odstępy między 

liniami. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 Z listy Lineweight wybierz wagę linii, którą chcesz ustawić jako aktualną. 

4 Kliknij przycisk OK. 

 

Użyj skrótu na pasku stanu. 

Na pasku stanu kliknij prawym przyciskiem myszy słowo BYLAYER dla bieżącej 

grubości linii, a następnie wybierz bieżącą grubość linii. Możesz także kliknąć 

dwukrotnie słowo LWT, aby włączyć lub wyłączyć wyświetlanie grubości linii. 
 

 

Aby wskaźniki linii były widoczne, muszą być włączone. 

Aby zobaczyć podziałki linii na rysunku, konieczne może być włączenie ich 

widoczności. Szczegółowe informacje można znaleźć w sekcji "Wyświetlanie 

podziałek linii" na stronie 214. 
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Ustawianie bieżącego stylu drukowania 

Style wydruku służą do zmiany wyglądu elementu podczas drukowania, bez 

faktycznej zmiany elementu na rysunku. 

Jeśli rysunek korzysta z nazwanych tabel stylów wydruku, można określić styl 

wydruku dla dowolnej jednostki. Nazwane tabele stylów wydruku zawierają 

skonfigurowane style wydruku. Jeśli rysunek korzysta z tabel stylów wydruku 

zależnych od koloru, stylem wydruku jest BYCOLOR, którego nie można zmienić. 

Tego typu tabele stylów wydruku określają wymagania dotyczące drukowania na 

podstawie koloru przypisanego do elementu lub warstwy. Aby uzyskać 

szczegółowe informacje na temat konwersji rysunku, który wykorzystuje tabele 

stylów wydruku zależne od koloru, na nazwane tabele stylów wydruku, patrz 

"Zmiana typu tabeli stylów wydruku rysunku" na stronie 555. 

Podczas tworzenia encji na rysunku, który używa nazwanych tabel stylów wydruku, 

encja jest tworzona przy użyciu bieżącego stylu wydruku. Domyślnie bieżącym 

stylem wydruku jest BYLAYER. Po przypisaniu BYLAYER, zmiana stylu wydruku 

warstwy zmienia styl wydruku wszystkich elementów przypisanych do tej warstwy, 

jeśli zostały one utworzone przy użyciu stylu wydruku BYLAYER. 

Można również wybrać określony styl wydruku jako bieżący styl wydruku, który 

zastępuje ustawienia stylu wydruku warstwy. Jednostki są wówczas tworzone przy 

użyciu tego stylu wydruku, a zmiana stylu wydruku warstwy nie ma na nie wpływu. 

Trzecią opcją jest użycie stylu wydruku BYBLOCK, w którym to przypadku nowe 

jednostki używają stylu wydruku Normal do momentu zgrupowania ich w blok. 

Następnie jednostki dziedziczą ustawienia stylu wydruku bloku po wstawieniu 

bloku do rysunku. 
 

Aby ustawić bieżący styl wydruku na rysunku korzystającym z nazwanych tabel 
stylów wydruku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 Z listy Styl drukowania wybierz styl drukowania, który chcesz ustawić jako 

bieżący. W razie potrzeby wybierz opcję Inne, a następnie wybierz styl 

drukowania. 

4 Kliknij przycisk OK. 

 

Użyj paska stanu lub skrótu na pasku poleceń. 

Na pasku stanu kliknij prawym przyciskiem myszy słowo BYLAYER dla bieżącego 

stylu drukowania, kliknij opcję Inne, a następnie wybierz styl drukowania, który 

chcesz uczynić bieżącym. Lub, 

wpisz printstyle, aby wybrać bieżący styl drukowania. 
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Ustawianie jednostek rysowania 

W programie ALCAD zazwyczaj rysujesz w pełnym rozmiarze (skala 1:1), a 

następnie ustawiasz współczynnik skali podczas drukowania lub kreślenia rysunku. 

Przed rozpoczęciem rysowania należy jednak określić związek między jednostkami 

rysunkowymi a jednostkami rzeczywistymi. 

Można na przykład zdecydować, czy jedna liniowa jednostka rysunkowa 

reprezentuje cal, stopę, metr czy milę. Ponadto można określić sposób, w jaki 

program mierzy kąty. Zarówno dla jednostek liniowych, jak i kątowych, można 

również ustawić stopień precyzji wyświetlania, taki jak liczba miejsc dziesiętnych 

lub najmniejszy mianownik używany podczas wyświetlania ułamków. Ustawienia 

precyzji wpływają tylko na wyświetlanie odległości, kątów i współrzędnych. 

ALCAD zawsze przechowuje odległości, kąty i współrzędne z dokładnością 

zmiennoprzecinkową. 
 

Aby ustawić liniowe jednostki rysowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania ( ):  

• Na wstążce wybierz Przycisk aplikacji > Narzędzia do rysowania; 

Przycisk aplikacji > Narzędzia do rysowania > Jednostki rysowania; 

Strona główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Jednostki rysunku. 

3 Kliknij kartę Jednostki liniowe. 

4 W sekcji Typy jednostek wybierz typ jednostki. 

5 W sekcji Precyzja wyświetlania wpisz precyzję wyświetlania zgodnie z 

żądaną liczbą miejsc dziesiętnych lub kliknij strzałki, aby ją wybrać. 

Pole powyżej tego ustawienia pokazuje przykład typu jednostki liniowej przy 

bieżącej precyzji. 

6 Kliknij przycisk OK. 
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A 

 
 
 
 

B 

 

 
C 

 
 
 
 
 

A Określa rodzaj kontrolowanych jednostek. 

B Wybierz typ jednostek liniowych. 

 
C Wybierz precyzję wyświetlania dla jednostek liniowych. 

 
 

Aby ustawić kątowe jednostki rysowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Jednostki rysunku. 

3 Kliknij kartę Jednostki kątowe. 

4 W sekcji Typy jednostek wybierz typ jednostki. 

5 W sekcji Precyzja wyświetlania wpisz precyzję wyświetlania zgodnie z 

żądaną liczbą miejsc dziesiętnych lub kliknij strzałki, aby ją wybrać. 

Pole powyżej tego ustawienia pokazuje przykład typu jednostki kątowej przy 

bieżącej precyzji. 
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6 W obszarze Kierunek kąta wybierz kierunek zwiększania kątów po 

określeniu dodatniej wartości kąta. 

7 W sekcji Podstawa kąta określ lokalizację kompasu dla kąta zerowego. 

Na przykład domyślnie kąt 0 znajduje się w pozycji "godzina trzecia" lub 

"wschód". Sąsiednia ikona pokazuje bieżącą lokalizację podstawy kąta. 

8 Kliknij przycisk OK. 

 

 

 

 

 

 
A 

 
 

 
E 

 

B 

 

 
C 

D 

 
 

 
A Określa rodzaj kontrolowanych jednostek. 

B Wybierz typ jednostek kątowych. 

C Wybierz precyzję wyświetlania jednostek 
kątowych. 

D Wybierz podstawę kąta, kierunek kąta 
zerowego. 

E Wybierz kierunek zwiększania kątów. 
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Zrozumienie czynników skali 

Zamiast rysować w określonej skali, rysujesz wszystko w programie w pełnym 

rozmiarze. Chociaż warto pamiętać o współczynniku skali podczas konfigurowania 

rysunku, nie trzeba ustawiać skali, dopóki go nie wydrukujesz. Na przykład, gdy 

rysujesz część mechaniczną o długości 40 cali za pomocą ALCAD, faktycznie 

rysujesz ją jako 40 cali, zamiast stosować współczynnik skali podczas rysowania. 

Podczas drukowania rysunku można przypisać skalę, w której rysunek ma zostać 

wydrukowany. 

Skala wpływa jednak na sposób, w jaki kilka elementów, takich jak tekst, strzałki lub 

typy linii, jest drukowanych lub wykreślanych, a nawet wyświetlanych na rysunku. Można 

skonfigurować skalowanie adnotacji, aby kontrolować skalę jednostek, takich jak 

tekst, strzałki i typy linii, lub można dokonać ręcznych dostosowań podczas 

pierwszego konfigurowania rysunku, aby adnotacje były drukowane i wyświetlane 

we właściwym rozmiarze. Na przykład podczas rysowania tekstu należy określić 

rozmiar tekstu, aby podczas późniejszego drukowania w określonej skali wysokość 

tekstu była prawidłowa. 

Po określeniu ostatecznej skali gotowego rysunku można obliczyć współczynnik 

skali dla rysunku jako stosunek jednej jednostki rysunkowej do rzeczywistej 

jednostki skali reprezentowanej przez każdą jednostkę rysunkową. Na przykład, jeśli 

planujesz wydrukować rysunek w skali 1/8" = 1'-0", współczynnik skali wynosi 1:96 

(1/8" = 12" to tyle samo, co 1 = 96). Jeśli skala wydruku ma wynosić 1 cal = 100 

stóp, współczynnik skali wynosi 1:1200. 

Poniższa tabela przedstawia niektóre standardowe współczynniki skali 

architektonicznej i inżynieryjnej oraz równoważne wysokości tekstu wymagane do 

utworzenia tekstu o wysokości 1/8 cala podczas drukowania rysunku w określonej 

skali. 

 
Standardowe proporcje skali i równoważne wysokości tekstu 

 

Skala Współczynnik 
skali 

Wysokość 
tekstu 

1/16" = 1'-0" 192 24" 

1/8" = 1'-0" 96 12" 

3/16" = 1'-0" 64 8" 

1/4" = 1'-0" 48 6" 

3/8" = 1'-0" 32 4" 

1/2" = 1'-0" 24 3" 

3/4" = 1'-0" 16 2" 

1" = 1'-0" 12 1.5" 

1 1/2" = 1'-0" 8 1" 

3" = 1'-0" 4 0.5" 

1" = 10' 120 15" 

1" = 20' 240 30" 

1" = 30' 360 45" 

1" = 40' 480 60" 
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Standardowe proporcje skali i równoważne wysokości tekstu 
 

Skala Współczynnik 
skali 

Wysokość 
tekstu 

1" = 50' 600 75" 

1" = 60' 720 90" 

1" = 100' 1200 150" 

 
Za pomocą tych współczynników skali można wstępnie określić rozmiar rysunku, 

aby upewnić się, że zmieści się on na papierze o określonym rozmiarze podczas 

drukowania. Rozmiar rysunku można kontrolować za pomocą limitów rysowania. 

Aby obliczyć limity rysunku pasujące do rozmiaru papieru, należy pomnożyć 

wymiary rozmiaru papieru przez współczynnik skali. 

Na przykład, jeśli papier używany do drukowania ma wymiary 36 cali x 24 cale, a 

rysunek jest drukowany w skali 1/8" = 1'-0" (innymi słowy, przy użyciu 

współczynnika skali 96), rozmiar rysunku mierzony w jednostkach rysunkowych 

wynosi 36 x 96 (lub 3456 jednostek) szerokości i 24 x 96 (lub 2304 jednostek) 

wysokości. 

Należy pamiętać, że gotowy rysunek można wydrukować w dowolnej skali, 

niezależnie od obliczonego współczynnika skali. Można również drukować na 

papierze o innym rozmiarze i używać kart Układ do tworzenia różnych widoków 

rysunku oraz do umieszczania i skalowania tych widoków w różny sposób. 

Współczynnik skalowania nie jest związany z rozmiarem rysowanych elementów; 

stanowi on po prostu wstępną wskazówkę, która pomaga ustalić wysokość tekstu i 

granice rysowania podczas rozpoczynania rysowania. Wysokość tekstu i limity 

rysowania można zmienić w dowolnym momencie. 

 

Konfigurowanie skalowania adnotacji 

Skalowanie adnotacji pozwala kontrolować poszczególne jednostki, aby ich rozmiar 

był spójnie wyświetlany, gdy rysunek jest wyświetlany lub drukowany w różnych 

skalach. Nie trzeba używać skalowania adnotacji, ale jest to wygodny sposób 

kontrolowania skalowania następujących elementów: tekstu, tolerancji, wymiarów, 

linii pomocniczych, linii pomocniczych wielokrotnych, atrybutów, kreskowania i 

bloków. 

Te indywidualne jednostki mogą być opatrzone adnotacjami, podobnie jak style 

tekstu, style wymiarów i style multileadera; tekst, wymiary lub multileadery 

przypisane do stylu adnotacji będą miały domyślnie włączone skalowanie adnotacji. 

ALCAD jest gotowy do użycia skalowania adnotacji, jednak możesz chcieć 

dostosować niektóre ustawienia do swoich potrzeb. 

 
Dostosowywanie listy wag 
Lista skal definiuje wszystkie skale, które są dostępne do przypisania do jednostek 

adnotacji. Na przykład, aby przypisać skalę adnotacji do jednostki tekstowej, należy 

wybrać ją z listy skal. Lista skal jest wyświetlana po wykonaniu dowolnej z 

poniższych czynności: 

• Ustawianie bieżącej skali adnotacji - Na pasku stanu kliknij prawym 

przyciskiem myszy opcję Lista skal adnotacji. 

• Przypisywanie skali adnotacji do jednostki - Wybierz jednostkę i użyj polecenia 



Właściwości lub Skala jednostki. 
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• Drukuj - wybierz polecenie Drukuj. 

Po skonfigurowaniu listy skal możesz utworzyć szablon rysunku z domyślnymi 

skalami lub wyeksportować listę skal, aby móc ją łatwo zaimportować do innych 

rysunków. 
 

Aby dostosować listę wag 

1 Wykonaj jedną z poniższych czynności, aby wybrać Scale List (  ): 

• Na wstążce wybierz polecenie Adnotacje > Lista skalowania (w obszarze Skalowanie 

adnotacji). 

• W menu wybierz Format > Lista skal. 

• Na pasku stanu kliknij opcję Lista skal adnotacji. 

• Wpisz scalelistedit i naciśnij Enter. 

2 Aby dodać wagę do listy, wykonaj następujące czynności: 

• Kliknij przycisk Dodaj. 

• Wprowadź nazwę wagi, która pojawi się na liście. 

• Wprowadź stosunek jednostek papieru do jednostek rysunku. 

• Kliknij przycisk OK. 

3 Wykonaj dowolną z poniższych czynności, aby jeszcze bardziej dostosować listę: 

• Wybierz skalę i kliknij przycisk Modyfikuj, aby zmienić nazwę lub współczynnik skali. 

• Wybierz wagę i kliknij przycisk Usuń, aby usunąć ją z listy. 

• Wybierz skalę i kliknij przycisk Przenieś w górę lub Przenieś w dół, aby zmienić jej 

położenie na liście. 

4 Opcjonalnie kliknij Eksportuj, aby zapisać listę wag w pliku, który można łatwo 

zaimportować do innych rysunków. 

5 Kliknij przycisk OK. 
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A Wyświetla skale dostępne dla jednostek 

adnotacji. 

B Kliknij, aby zapisać listę wag w pliku. 

C Kliknij, aby otworzyć i załadować listę wag z 

pliku. D Kliknij, aby usunąć wszystkie 

nieużywane wagi z listy. E Kliknij, aby usunąć 

wybraną wagę. 

 
F Kliknij, aby przesunąć wybraną wagę w 

dół o jedną pozycję na liście. 

G Kliknij, aby przesunąć telectedscale o jedną 
pozycję w górę na liście. 

H Kliknij, aby zmodyfikować wybraną skalę. 

I Kliknij, aby utworzyć nową wagę i dodać ją do listy. 

 
 

 

Usuwanie nieużywanych skal adnotacji może zwiększyć wydajność. 

Starsze rysunki z innych programów CAD mogą czasami zawierać tysiące 

nieużywanych skal adnotacji. Kliknij przycisk Purge w oknie dialogowym Edit 

Drawing Scales, aby usunąć nieużywane skale adnotacji i zwiększyć wydajność. 
 

 
Dostosowywanie stylów do adnotacji 
Style tekstu i style wymiarów określają, czy jednostki tekstu i wymiarów, którym 

przypisano te style, są domyślnie adnotacyjne. Style multileadera mogą być również 

adnotacyjne, ale ALCAD obsługuje tylko wyświetlanie multileaderów, a nie 

tworzenie multileaderów lub stylów multileadera. 

Informacje na temat stylów tekstu można znaleźć w sekcji "Praca ze stylami tekstu" na stronie 

404. 

Aby uzyskać informacje na temat stylów wymiarów, patrz "Kontrolowanie dopasowania 

wymiarów" na stronie 454. 
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Konfigurowanie automatycznego skalowania adnotacji 
Automatyczne skalowanie adnotacji automatycznie przypisuje bieżącą skalę 

adnotacji do jednostek adnotacji, które mają włączone skalowanie adnotacji. 
 

Aby ustawić automatyczne skalowanie adnotacji i bieżącą skalę adnotacji 

1 Na pasku stanu kliknij opcję Automatyczna adnotacja wł. 

2 Na pasku stanu kliknij opcję Lista wag adnotacji. 

3 Wybór bieżącej skali adnotacji. 

 
Ustawianie wysokości tekstu 

Ustawienie wysokości tekstu kontroluje wysokość tekstu mierzoną w jednostkach 

rysunkowych. Ustaw tę wartość początkowo tak, aby tekst używany do 

najczęstszych adnotacji, po przeskalowaniu do rozmiaru, w którym zostanie 

wydrukowany rysunek, miał wysokość 1/8 cala na wydrukowanym rysunku. 

Na przykład, jeśli planujesz wydrukować rysunek w rozmiarze 1/8" = 1'-0" i chcesz, 

aby tekst miał wysokość 1/8 cala na ostatecznym rysunku, utwórz tekst o wysokości 1 

stopy (w rzeczywistych jednostkach rysunkowych), aby po wydrukowaniu miał 

wysokość 1/8 cala na papierze. Musisz utworzyć tekst o wysokości 4 stóp, który 

chcesz wydrukować z wysokością 1/2 cala. 
 

Aby ustawić wysokość tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Tworzenie podmiotu. 

3 Kliknij kartę Tekst. W razie potrzeby kliknij strzałkę w prawo, aby przewinąć 

karty w poziomie w celu wyświetlenia karty Tekst. 

4 W polu Domyślna wysokość tekstu wybierz wysokość tekstu lub wpisz żądaną 

wartość wysokości tekstu. Jeśli wybrano styl tekstu adnotacji, wprowadzana jest 

wysokość tekstu na papierze. 

5 Kliknij przycisk OK. 
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A Wybierz opcję Tekst. B Określ wysokość tekstu w jednostkach rysunkowych. 

 

Domyślna wysokość tekstu ma zastosowanie tylko wtedy, gdy bieżąca wysokość stylu tekstu 
wynosi 0,0. 

W przeciwnym razie pierwszeństwo ma wysokość tekstu dla bieżącego stylu. 
 

 
Ustawianie limitów rysowania 

Można określić limity rysowania, które tworzą niewidoczną granicę wokół rysunku. 

Za pomocą limitów rysowania można upewnić się, że nie zostanie utworzony 

rysunek większy niż może zmieścić się na określonym arkuszu papieru po 

wydrukowaniu w określonej skali. 

Na przykład, jeśli planujesz wydrukować rysunek w skali 1/8" = 1'-0" (innymi słowy, 

używając współczynnika skali 96) na arkuszu papieru o wymiarach 36 cali x 24 cale, 

możesz ustawić limity rysowania na 3 264 jednostek szerokości (czyli 34 x 96) i 2 

112 jednostek wysokości (22 x 96), co pozwala na 1-calowy margines wokół 

krawędzi drukowanego obrazu. 
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Aby ustawić limity rysowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych lub kartę Wyświetlanie. 

3 Kliknij kartę Limity. 

4 Określ współrzędną x i współrzędną y prawego górnego limitu rysowania i 

lewego dolnego limitu rysowania. 

Możesz także kliknąć Wybierz, aby określić granice rysunku, wybierając 

punkty na rysunku. 

5 Aby ograniczyć rysunek do tych limitów rysowania, kliknij pole wyboru 

Disallow Input Beyond Limits. 

6 Kliknij przycisk OK. 
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A Wybierz limity. 

B Określa współrzędną x i współrzędną y prawego 
górnego limitu rysowania. 

C Określa współrzędną x i współrzędną y lewego 
dolnego limitu rysowania. 

D Po wybraniu tej opcji program uniemożliwia 
rysowanie poza granicami rysunku. 

E Określ granice rysunku, wybierając punkty 
na rysunku. 



 

Praca z kolorami 
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Kolor elementu określa sposób jego wyświetlania, a w przypadku korzystania z 

kolorowej drukarki - sposób drukowania. Jednostki są tworzone w bieżącym 

kolorze określonym dla rysunku. 

Warstwy mogą również kontrolować kolor elementów. Po otwarciu nowego 

rysunku elementy są tworzone w kolorze BYLAYER, który przyjmuje kolor 

bieżącej warstwy. Początkowo warstwa 0 jest zarówno jedyną, jak i bieżącą 

warstwą. Jej domyślnym kolorem jest biały, więc elementy są wyświetlane jako 

białe. 

Dla jednostek i warstw w ALCAD istnieją trzy różne rodzaje kolorów: 

• Kolory indeksu 

• Prawdziwe kolory 

• Kolory książki kolorów 

 

Prawdziwe kolory i książki kolorów są niedostępne w niektórych przypadkach. 

Na przykład dla jednostek wymiaru i wyświetlania kursora. 
 

Kolory można wybierać, zaznaczając je w oknie dialogowym Kolor. Na pasku 

poleceń lub w niektórych oknach dialogowych można określić kolor za pomocą 

nazwy lub numeru. 

 

Używanie kolorów indeksu 

Istnieje 255 standardowych kolorów indeksu i dwie dodatkowe właściwości 

kolorów, które są często określane jako kolory (BYLAYER i BYBLOCK). Można 

użyć siedmiu z 255 standardowych kolorów indeksu według nazwy: czerwony, 

żółty, zielony, cyjan, niebieski, magenta i biały. (Numery osiem i dziewięć nie są 

nazwane.) Każdy kolor indeksu ma unikalny numer od 1 do 255. Dwie dodatkowe 

właściwości kolorów to BYLAYER i BYBLOCK. Te właściwości koloru powodują, 

że jednostka przyjmuje kolor warstwy lub bloku, którego jest członkiem. 

BYLAYER to kolor o numerze 256, a BYBLOCK to kolor o numerze 0. We 

wszystkich poleceniach, w których używany jest kolor, można wskazać BYLAYER 

i BYBLOCK, a także odpowiednio liczby 256 i 0. 
 

Aby wybrać kolor indeksu 

1 Kliknij Wybierz kolor w wybranym oknie dialogowym, takim jak Warstwy, 

Ustawienia rysunku, Właściwości lub Tekst wielowierszowy. 

Zostanie otwarte okno dialogowe Kolor. 

2 Kliknij kartę Kolor indeksu. 

3 Wykonaj jedną z poniższych czynności: 

• Kliknij przycisk BYBLOCK. 

• Kliknij przycisk BYLAYER. 

• Kliknij wybrany kolor lub wpisz numer koloru w polu Bieżący. 

4 Kliknij przycisk OK. 
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A Kliknij, aby wybrać jeden ze 
standardowych kolorów. 

B Kliknij, aby wybrać jeden z odcieni 
szarości. 

 
D E 

D Wskazuje bieżący kolor. 

E Wyświetla numer koloru lub umożliwia wprowadzenie koloru 

 

C Kliknij, aby wybrać jeden z dostępnych 
kolorów indeksu. 

 

 

Używanie prawdziwych 
kolorów 

numer. 

F Kliknij, aby ustawić kolor na BYLAYER. 

G Kliknij, aby ustawić kolor na BYBLOCK. 

 

Do wyboru jest ponad 16 milionów prawdziwych kolorów. Prawdziwe kolory są 

definiowane przy użyciu 24-bitowego koloru. 

Nawet przy tak wielu dostępnych kolorach można szybko wybrać kolor z 

wyświetlacza kolorów podstawowych lub klikając paletę kolorów. Alternatywnie, 

jeśli znasz wartości używane do zdefiniowania żądanego koloru, możesz 

wprowadzić wartości odcienia, nasycenia i luminancji (HSL) lub wartości 

czerwonego, zielonego i niebieskiego (RGB). 
 

Aby wybrać prawdziwy kolor 

1 Kliknij Wybierz kolor w wybranym oknie dialogowym, takim jak Warstwy, 

Ustawienia rysunku, Właściwości lub Tekst wielowierszowy. 

Zostanie otwarte okno dialogowe Kolor. 

2 Kliknij kartę True Color. 
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3 Wykonaj jedną z poniższych czynności: 

• Kliknij podstawowy prawdziwy kolor. 

• Kliknij prawdziwy kolor w palecie kolorów. 

• Wprowadź wartości HSL dla żądanego koloru rzeczywistego. 

• Wprowadź wartości RGB dla żądanego koloru rzeczywistego. 

4 Kliknij przycisk OK. 
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A Kliknij, aby wybrać jeden z podstawowych 
kolorów rzeczywistych. 

B Kliknij, aby wybrać jeden z 
niestandardowych kolorów rzeczywistych, 
jeśli są one zdefiniowane. 

C Kliknij, aby dodać wybrany kolor do 
obszaru kolorów niestandardowych. 

D Wprowadź (lub wyświetl) ilość czerwonego, 
zielonego i niebieskiego koloru 
rzeczywistego. 

E Wprowadź (lub wyświetl) wartość odcienia, 
nasycenia i luminancji żądanego koloru 
rzeczywistego. 

F Przesuń lub kliknij, aby dostosować luminancję kolorów. 

G Kliknij, aby wybrać prawdziwy kolor z palety kolorów. 
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Korzystanie z kolorowych książek 

ALCAD wykorzystuje książki kolorów do przechowywania kolekcji kolorów. Na 

przykład można przechowywać unikalny schemat kolorów dla klienta w książce 

kolorów, a następnie używać kolorów tylko z tej książki kolorów dla rysunków 

klienta. 

 

Wybór koloru książki kolorów 

Aby wybrać kolor książki kolorów 

1 Kliknij Wybierz kolor w wybranym oknie dialogowym, takim jak Warstwy, 

Ustawienia rysunku, Właściwości lub Tekst wielowierszowy. 

Zostanie otwarte okno dialogowe Kolor. 

2 Kliknij kartę Kolorowe książki. 

3 Wybierz kolorową książkę z listy. 

4 Jeśli chcesz zawęzić wyszukiwanie kolorów, wykonaj jedną z poniższych czynności: 

• Na liście kolorów wybierz stronę książki kolorów, jeśli jest dostępna. Strony 

są szczególnie pomocne w dużych książkach kolorów - pomagają 

pogrupować kolory, dzięki czemu można je szybko znaleźć. 

• Wybierz opcję Pokaż tylko kolory z książki kolorów użyte w rysunku. Na 

liście zostaną wyświetlone tylko te kolory z książki kolorów, które są 

używane w bieżącym rysunku. 

5 Wybierz żądany kolor. 

6 Kliknij przycisk OK. 
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A Wybierz kolorową książkę. 

B Kliknij, aby wybrać kolor książki kolorów. 

C Wybierz z listy tylko te kolory książki kolorów, 
które są używane w bieżącym rysunku. 

 

Tworzenie kolorowych książek 

D Kliknij, aby tworzyć i modyfikować książki kolorów. 

E Wyświetla wybrany kolor i jego wartości RGB. 

 

Możesz mieć książkę kolorów dostarczoną przez klienta, opracowaną przez stronę 

trzecią lub możesz stworzyć własną. Każda książka kolorów ma rozszerzenie .acb 

i jest zapisywana automatycznie w formacie Extensible Markup Language (XML). 
 

Aby utworzyć kolorową książkę 

1 Kliknij Wybierz kolor w wybranym oknie dialogowym, takim jak Warstwy, 

Ustawienia rysunku, Właściwości lub Tekst wielowierszowy. 

Zostanie otwarte okno dialogowe Kolor. 

2 Kliknij kartę Kolorowe książki. 

3 Kliknij przycisk Color Book Editor. 

4 W oknie dialogowym Color Book Editor kliknij narzędzie Nowy (  ). 

5 W polu Nazwa książki kolorów wprowadź nazwę książki kolorów. Nazwa ta 

pojawi się na liście książek kolorów na karcie Książki kolorów w oknie 

dialogowym Kolor. 
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6 Wykonaj następujące czynności, aby zdefiniować strony organizacyjne w kolorowej książce: 

• W zawartości książki kolorów kliknij istniejącą stronę lub kolor, do którego 

chcesz dodać stronę. 

• Zdefiniuj kolor w palecie. 

• Wprowadź nazwę strony, a następnie kliknij przycisk Dodaj stronę. 

7 Wykonaj następujące czynności, aby zdefiniować kolory w książce kolorów: 

• W zawartości książki kolorów kliknij istniejącą stronę lub kolor, do którego 

chcesz dodać kolor. 

• Zdefiniuj kolor w palecie. 

• Wprowadź nazwę koloru, a następnie kliknij przycisk Dodaj kolor. 

8 Wykonaj dowolną z poniższych czynności, aby zmienić istniejące strony i kolory w książce 

kolorów: 

• Modyfikowanie stron i kolorów - wybierz stronę lub kolor w książce 

kolorów, określ jego nowe ustawienia kolorów w palecie, wprowadź zmiany 

w nazwie, a następnie kliknij przycisk Modyfikuj. 

• Usuwanie stron i kolorów - Wybierz stronę lub kolor w książce kolorów, a 

następnie kliknij przycisk Usuń. 

• Zmiana kolejności stron i kolorów - Wybierz stronę lub kolor w książce 

kolorów, a następnie kliknij strzałkę w górę (  ) lub strzałkę w dół (  ). 

9 W oknie dialogowym Color Book Editor kliknij narzędzie Zapisz (  ). 

10 Wprowadź nazwę pliku książki kolorów, a następnie kliknij przycisk Zapisz. 

Domyślnie plik jest zapisywany w domyślnym folderze, w którym ALCAD 

wyszukuje książki kolorów. 
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A Kliknij przycisk New (Nowy), aby utworzyć 
książkę kolorów; kliknij przycisk Open 
(Otwórz), aby otworzyć książkę kolorów; kliknij 
przycisk Save (Zapisz), aby zapisać książkę 
kolorów; kliknij przycisk Save As (Zapisz 
jako), aby zapisać książkę kolorów z nową 
nazwą pliku. 

B Wybierz stronę lub kolor, aby je 
zmodyfikować, usunąć, zmienić ich 
kolejność lub wyświetlić ich ustawienia. 

C Kliknij, aby utworzyć nową stronę w 
książce kolorów przy użyciu bieżących 
ustawień kolorów. 

D Kliknij, aby utworzyć nowy kolor w 
książce kolorów przy użyciu bieżących 
ustawień kolorów. 

E Kliknij, aby usunąć wybraną stronę lub kolor 
z książki kolorów. 

F Kliknij, aby ponownie zdefiniować wybraną 
stronę lub kolor w celu użycia bieżących 
ustawień kolorów. 

G Kliknij, aby przesunąć wybraną stronę lub 
kolor w górę lub w dół o jedną pozycję w 
książce kolorów. 

H Wprowadź nazwę strony lub koloru, która ma 
być wyświetlana w książce kolorów. 

I Wprowadź (lub wyświetl) ilość czerwonego, 
zielonego i niebieskiego koloru. 

J Wprowadź (lub wyświetl) wartość odcienia, 
nasycenia i luminancji żądanego koloru. 

K Przesuń lub kliknij, aby dostosować luminancję kolorów. 

L Kliknij, aby wybrać kolor. 

M Wprowadź nazwę książki kolorów. 
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Modyfikowanie kolorowych książek 
Można modyfikować własne książki kolorów i książki kolorów dostarczone z Intelli-

CAD. W przypadku modyfikacji książki kolorów dostarczonej z ALCAD zaleca się 

zapisanie jej najpierw z nową nazwą pliku, aby oryginalna książka kolorów nie 

została nadpisana. 
 

Aby zmodyfikować książkę kolorów 

1 Kliknij Wybierz kolor w wybranym oknie dialogowym, takim jak Warstwy, 

Ustawienia rysunku, Właściwości lub Tekst wielowierszowy. 

Zostanie otwarte okno dialogowe Kolor. 

2 Kliknij kartę Kolorowe książki. 

3 Wybierz książkę kolorów, którą chcesz zmodyfikować. 

4 Kliknij przycisk Color Book Editor. 

5 W polu Nazwa książki kolorów wprowadź wszelkie zmiany nazwy książki 

kolorów. Nazwa ta jest wyświetlana na liście książek kolorów na karcie Książki 

kolorów w oknie dialogowym Kolor. 

6 Wykonaj dowolną z poniższych czynności, aby zmodyfikować strony lub kolory w książce 

kolorów: 

• Dodawanie stron - w zawartości książki kolorów kliknij istniejącą stronę lub 

kolor, do którego chcesz dodać stronę. Określ kolor w palecie, wprowadź nazwę 

strony, a następnie kliknij przycisk Dodaj. 

• Dodawanie kolorów - w zawartości książki kolorów kliknij istniejącą stronę 

lub kolor, do którego chcesz dodać kolor. Zdefiniuj kolor w palecie, wprowadź 

jego nazwę, a następnie kliknij przycisk Dodaj. 

• Modyfikowanie stron i kolorów - wybierz stronę lub kolor w książce 

kolorów, określ jego nowe ustawienia kolorów w palecie, wprowadź zmiany 

w nazwie, a następnie kliknij przycisk Modyfikuj. 

• Usuwanie stron i kolorów - Wybierz stronę lub kolor w książce kolorów, a 

następnie kliknij przycisk Usuń. 

• Zmiana kolejności stron i kolorów - Wybierz stronę lub kolor w książce 

kolorów, a następnie kliknij strzałkę w górę (  ) lub strzałkę w dół (  ). 

7 Wykonaj jedną z poniższych czynności, aby zapisać książkę kolorów: 

• Aby zapisać książkę kolorów z tą samą nazwą pliku, kliknij narzędzie Zapisz 
(  ) w edytorze książki kolorów. 

• Aby zapisać książkę kolorów z nową nazwą pliku lub w nowej 

lokalizacji, kliknij narzędzie Zapisz jako ( ) w edytorze książki kolorów. 
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Ładowanie kolorowych książek 

Jeśli masz książkę kolorów dostarczoną przez klienta lub opracowaną przez stronę 

trzecią, po prostu zapisz ją na swoim komputerze w folderze, w którym ALCAD 

może ją znaleźć. Domyślnie książki kolorów są przechowywane w następującym 

folderze: \Documents and Settings \YourName \My Documents \Color Books. 
 

Aby załadować kolorową książkę 

1 Zapisz książkę kolorów w folderze, w którym ALCAD wyszukuje książki kolorów. 

Aby zweryfikować lokalizację folderu, wybierz Narzędzia > Opcje, kliknij kartę 

Ścieżki/Pliki i znajdź folder Color Book na liście Ścieżki. 

2 W oknie dialogowym Kolor kliknij kartę Książki kolorów. 

Poprzednio załadowana książka kolorowa zostanie wyświetlona na liście książek 

kolorowych. 

 

 
 

Korzystanie z siatki, przyciągania, ograniczania kursora i dynamicznego 
wprowadzania danych 

 
Ustawienia siatki i przyciągania są skutecznymi narzędziami, których można używać 

podczas rysowania w celu zapewnienia dokładności. Chociaż wielu użytkowników 

uważa za wygodne dopasowanie punktów siatki do ustawień przyciągania, są one od 

siebie niezależne i nie należy ich mylić. Punkty siatki służą wyłącznie do celów 

wizualnych; nie mają one wpływu na rysunek i nie są drukowane. Punkty 

przyciągania są same w sobie niewidoczne, jednak po ustawieniu ograniczają 

tworzenie nowych jednostek. 

Ponadto, kursor może być ograniczony do poruszania się tylko ortogonalnie lub 

prowadnice mogą być wyświetlane na ekranie automatycznie w określonych przyrostach 

kąta biegunowego. 

 

Ustawianie siatki odniesienia 

Siatka odniesienia jest wyświetlana jako wzór regularnie rozmieszczonych kropek 

lub linii. Siatkę można włączać i wyłączać, a także określać odstępy między 

kropkami lub liniami. 

Domyślnie siatka odniesienia wyświetlana jest jako linie, co zapewnia znacznie 

lepszą wydajność wyświetlania niż siatka wyświetlana jako punkty (kropki) i jest 

adaptacyjna (proporcjonalnie skaluje się zgodnie ze współczynnikiem powiększenia), 

pomagając w wyrównaniu jednostek i wizualizacji odległości między jednostkami. 

W razie potrzeby siatkę można ograniczyć do wyświetlania tylko w granicach 

rysunku. 
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Aby włączyć lub wyłączyć siatkę i ustawić odstępy między siatkami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Przyciąganie i siatka. 

4 Kliknij pole wyboru Siatka włączona, aby włączyć lub wyłączyć siatkę. 

5 W sekcji Odstępy siatki w polu X wybierz poziomy odstęp siatki. 

6 W sekcji Odstęp siatki w polu Y wybierz pionowy odstęp siatki. 

7 Kliknij przycisk OK. 

 

Skróty klawiszowe służą do włączania i wyłączania wyświetlania siatki. 

Kliknij dwukrotnie ustawienie GRID na pasku stanu, kliknij narzędzie Siatka odniesienia (  ) 
na pasku narzędzi Ustawienia lub naciśnij klawisz F7. 
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A Kliknij, aby włączyć tryb ortogonalny. 

B Kliknij, aby włączyć blokowanie krzyżyka na 
najbliższym punkcie przyciągania. 

C Kliknij, aby włączyć tryb przyciągania. 

D Określa odstępy przyciągania x i y. 

E Określ polarny odstęp przyciągania (dostępny, jeśli 
opcja Snap Type jest ustawiona na Polar). 

F Wybierz, czy ma być używane standardowe 
przyciąganie do siatki (Siatka), czy 
przyciąganie biegunowe (Biegun). 

G Kliknij, aby użyć przyciągania prostokątnego 
lub izometrycznego. W przypadku izometrii 
wybierz początkową izopłaszczyznę: górną, 
lewą (domyślnie) lub prawą. 

H Określa współrzędne x i y początku 
przyciągania. 

I Określ kąt obrotu migawki. Siatka 
zostanie wyświetlona obrócona w celu 
dopasowania do ustawienia migawki. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

J Kliknij, aby wyświetlić siatkę z kropkami dla 
arkuszy i układów (zakładki Układ); w 
przeciwnym razie wyświetlona zostanie 
siatka z kropkami. 

K Kliknij, aby wyświetlić siatkę kropkowaną 
dla przestrzeni modelu (zakładka Model); 
w przeciwnym razie wyświetlana jest 
siatka liniowa. 

L Kliknij, aby wyświetlić siatkę poza obszarem limitów. 

M Kliknij, aby podzielić siatkę, jeśli poziom 
powiększenia jest mniejszy niż jednostka siatki 
(dostępne, jeśli włączona jest siatka 
adaptacyjna). 

N Kliknij, aby włączyć siatkę adaptacyjną, 
która skaluje się proporcjonalnie do 
współczynnika powiększenia. 

O Wprowadź liczbę pomniejszych linii siatki, 
które mają być wyświetlane dla każdej 
głównej linii siatki. 

P Określa odstępy siatki x i y. 

Q Kliknij, aby wyświetlić siatkę odniesienia. 

A 

B 

 
C 

D 

E 

Q 

P 

O 

F 
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N 
M 
L 

H 
  K 

I      

J 
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Ustawianie odstępów między zatrzaskami 

Innym sposobem zapewnienia dokładności rysowania jest włączenie i ustawienie 

odstępów przyciągania. Gdy przyciąganie jest włączone, program ogranicza punkty 

wyboru do wcześniej określonych odstępów przyciągania. Chociaż często pomocne 

jest dopasowanie odstępu przyciągania do pewnego przedziału odstępu siatki lub 

innego powiązanego ustawienia, ustawienia nie muszą się zgadzać. 
 

Aby włączyć ustawienia przyciągania i ustawić odstępy między przyciąganiami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Przyciąganie i siatka. 

4 Kliknij pole wyboru Przyciąganie włączone, aby włączyć przyciąganie. 

5 W sekcji Odstęp przyciągania w polu X wybierz poziomy odstęp przyciągania. 

6 W sekcji Odstęp przyciągania w polu Y wybierz pionowy odstęp przyciągania. 

7 Kliknij przycisk OK. 

 

Skróty klawiszowe służą do włączania i wyłączania ustawień przyciągania. 

Kliknij dwukrotnie ustawienie SNAP na pasku stanu lub naciśnij klawisz F9. 
 

Oprócz ustawienia odstępów przyciągania można zmienić orientację przyciągania i 

siatki. Można również obrócić wyrównanie siatki lub ustawić ją tak, aby tworzyła 

rysunki izometryczne. 
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Zmiana kąta przyciągania i siatki oraz punktu bazowego 

Przyciąganie i siatka są zwykle oparte na początku rysunku, współrzędnej 0,0 w 

światowym układzie współrzędnych (WCS). Można jednak przenieść początek 

przyciągania i siatki, aby ułatwić rysowanie obiektów w odniesieniu do innej 

lokalizacji. Można również obrócić siatkę do innego kąta, aby wyrównać krzyżyk do 

nowego kąta siatki. Jeśli siatka jest włączona, a odstęp siatki wynosi 0,0, wówczas 

siatka domyślnie odpowiada odstępowi przyciągania. 
 

Aby zmienić kąt przyciągania i punkt bazowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Przyciąganie i siatka. 

4 Kliknij pole wyboru Przyciąganie włączone, aby włączyć przyciąganie. 

5 Kliknij pole wyboru Siatka włączona, aby włączyć siatkę. 

6 W polu Punkt bazowy przyciągania wpisz współrzędną x i współrzędną y nowego punktu 

początkowego przyciągania. 

7 W polu Obrót wpisz kąt obrotu przyciągania, który zmienia również sposób 

wyświetlania siatki. 

8 Kliknij przycisk OK. 

 
 

Domyślna siatka i wyrównanie przyciągania. Obrócona siatka i wyrównanie przyciągania. 
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Korzystanie z przyciągania izometrycznego i siatki 

Opcja Izometryczne przyciąganie i siatka umożliwia tworzenie dwuwymiarowych 

rysunków izometrycznych. Opcja izometrii oznacza po prostu rysowanie 

symulowanego trójwymiarowego widoku na dwuwymiarowej płaszczyźnie, 

podobnie jak w przypadku rysowania na kartce papieru. Nie należy mylić rysunków izometrycznych z rysunkami 

trójwymiarowymi. Trójwymiarowe rysunki tworzy się w trójwymiarowej 

przestrzeni. 

Opcja izometryczna zawsze wykorzystuje trzy wstępnie ustawione płaszczyzny, 

które są oznaczone jako lewa, prawa i górna. Nie można zmienić układu tych 

płaszczyzn. Jeśli kąt przyciągania wynosi 0, trzy osie izometryczne to 30 stopni, 90 

stopni i 150 stopni. 

Po użyciu opcji przyciągania izometrycznego i wybraniu płaszczyzny izometrycznej, 

elementy przyciągania, siatka i krzyżyk zostaną wyrównane do bieżącej płaszczyzny. 

Siatka jest zawsze wyświetlana jako izometryczna i wykorzystuje współrzędne y do 

obliczania odstępów między siatkami. Jeśli klikniesz pole wyboru Rysuj 

ortogonalnie, program ograniczy rysowanie obiektów do bieżącej płaszczyzny 

izometrycznej. 

 

Użyj skrótu, aby przełączać się między płaszczyznami izometrycznymi. 

Naciśnij klawisz F5. 
 

 
Aby włączyć opcję Przyciąganie izometryczne i siatka 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Przyciąganie i siatka. 

4 Kliknij pole wyboru Przyciąganie włączone, aby włączyć przyciąganie. 

5 Kliknij pole wyboru Siatka włączona, aby włączyć siatkę. 

6 W obszarze Typ przyciągania wybierz opcję Izometryczny, a następnie wybierz 

żądaną początkową płaszczyznę izometryczną (Górna, Lewa lub Prawa). 

7 Kliknij przycisk OK. 
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Płaszczyzny izometryczne lewa (A), prawa (B), górna (C). 

 

Korzystanie z blokady ortogonalnej 

Można ograniczyć ruch kursora do bieżącej osi poziomej i pionowej, aby rysować 

pod kątem prostym lub ortogonalnie. Na przykład, przy domyślnej orientacji 0 stopni 

(kąt 0 w pozycji "godzina trzecia" lub "wschód"), gdy włączona jest opcja Rysuj 

ortogonalnie, linie są ograniczone do 0 stopni, 90 stopni, 180 stopni lub 270 stopni. 

Podczas rysowania linii linia gumki podąża za osią poziomą lub pionową, w 

zależności od tego, która oś znajduje się najdalej od kursora. Po włączeniu 

przyciągania izometrycznego i siatki ruch kursora jest ograniczony do ortogonalnych 

odpowiedników w bieżącej płaszczyźnie izometrycznej. 

 

Czasami blokada ortogonalna nie jest używana, nawet jeśli jest włączona. 

ALCAD ignoruje blokowanie ortogonalne podczas wpisywania współrzędnych na 

pasku poleceń lub podczas korzystania z zatrzasków encji. Dodatkowo, blokada 

ortogonalna i śledzenie biegunowe nie mogą być używane w tym samym czasie - 

włączenie jednej opcji powoduje wyłączenie drugiej. 

 

Aby włączyć blokadę ortogonalną 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij pole wyboru Rysuj ortogonalne. 

4 Kliknij przycisk OK. 

 

Włączanie i wyłączanie blokady ortogonalnej. 

 

Na pasku stanu kliknij przycisk Toggle Orthogonal On/Off ( ) lub naciśnij 
klawisz F8. Można również 

kliknij narzędzie Rysuj ortogonalne ( ) na pasku narzędzi Ustawienia. 
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Korzystanie ze śledzenia biegunowego 

Gdy funkcja śledzenia biegunowego jest włączona, linie pomocnicze są wyświetlane 

na ekranie automatycznie z określonym przyrostem kąta biegunowego. Na przykład, 

jeśli narysujesz linię z włączonym śledzeniem biegunowym pod kątem 45 stopni, 

linia gumki będzie wyświetlana z przyrostem kąta 45 stopni. 

Śledzenie biegunowe i blokada ortogonalna nie mogą być używane jednocześnie - 

włączenie jednej opcji powoduje wyłączenie drugiej. 
 

Aby włączyć śledzenie biegunowe i określić przyrost kąta biegunowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Śledzenie biegunów. 

4 Kliknij pole wyboru Śledzenie biegunów. 

5 Wykonaj jedną z poniższych czynności, aby określić przyrosty kąta biegunowego: 

• W polu Increment (Przyrost) wybierz kąt. 

• Zaznacz pole wyboru Dodatkowe kąty i kliknij przycisk Nowy, aby 

zdefiniować niestandardowy przyrost kąta. 

6 Kliknij przycisk OK. 

 

Włączanie i wyłączanie śledzenia biegunowego. 

Kliknij Toggle Polar Tracking On/Off na pasku stanu, wpisz POLARTRACK w 

wierszu poleceń, naciśnij F10 lub naciśnij Ctrl+U. 
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A Wybierz opcję Śledzenie biegunowe. 

B Wybierz, aby wyświetlić na ekranie 
prowadnice śledzenia biegunów. 

C Wybierz kąt, pod jakim mają być 
wyświetlane prowadnice. 

D Wybierz, aby określić przyrosty kąta, które 
nie zostały zdefiniowane na liście Przyrost 
kąta. 

E Kliknij, aby dodać nowy przyrost kąta. 

F Kliknij , aby usunąć aktualnie wybrany kąt z 
listy Dodatkowe kąty. 
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Korzystanie z dynamicznego wejścia 

Gdy funkcja dynamicznego wprowadzania danych jest włączona, prowadnice są 

wyświetlane na ekranie automatycznie podczas rysowania i edytowania rysunku. 

Dynamiczne dane wejściowe mogą być wyświetlane po wyświetleniu monitu o punkt, 

monitu o wymiary, takie jak odległości i kąty, a także monitu o wprowadzenie 

poleceń, które zwykle wprowadza się w wierszu poleceń. Można określić wiele 

ustawień dotyczących sposobu wyświetlania dynamicznego wprowadzania danych, a 

nawet sposobu wyświetlania podpowiedzi na ekranie. 
 

Aby włączyć wejście dynamiczne 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie dynamiczne. 

3 Wybierz, które części dynamicznego wejścia chcesz włączyć: 

• Enable pointer input Pole w pobliżu kursora, które wyświetla i akceptuje 

wartości współrzędnych, gdy polecenie prosi o podanie punktu. 

• Pole w pobliżu kursora, które wyświetla i akceptuje wartości odległości i 

kąta, gdy polecenie wyświetla monit o podanie drugiego punktu lub 

odległości. 

• Pokaż monit o polecenie i wprowadzanie poleceń w krzyżyku Aprompt w 

pobliżu kursora, który umożliwia wprowadzanie poleceń. 

4 Kliknij przycisk OK. 
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A Zaznacz pole, aby włączyć wprowadzanie 
wskaźnika. 

B Kliknij, aby określić różne opcje 
wprowadzania wskaźnika. 

C Marktodisplaycommandprompts andallow 
commandinput indynamic input tooltips. 

D Kliknij, aby wybrać ustawienia wyglądu podpowiedzi. 

E Kliknij, aby określić różne opcje 
wprowadzania wymiarów. 

F Zaznacz, aby włączyć wprowadzanie wymiarów. 

 
 

 

Włączanie i wyłączanie wejścia dynamicznego. 

Na pasku stanu kliknij przycisk Toggle Dynamic Input On/Off, aby włączyć lub 

wyłączyć jednocześnie wprowadzanie wskaźnika, wprowadzanie wymiarów i 

wyświetlanie poleceń. 
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Aby dostosować ustawienia wejścia wskaźnika 

1 W oknie dialogowym Ustawienia rysowania kliknij kartę Wprowadzanie dynamiczne. 

2 W obszarze Wprowadzanie wskaźnika kliknij Ustawienia. 

3 Wybierz, czy chcesz, aby dane wejściowe wskaźnika miały domyślnie format 

biegunowy czy kartezjański dla domyślnego drugiego i następnego punktu. 

4 Wybierz, czy chcesz, aby wprowadzanie wskaźnika było domyślnie ustawione 

na współrzędne względne czy bezwzględne dla drugiego i następnego punktu. 

5 Wybierz, kiedy mają być wyświetlane podpowiedzi wprowadzania wskaźnika: 

• Po rozpoczęciu wpisywania danych współrzędnych podpowiedzi 

wprowadzania wskaźnika pojawiają się tylko po rozpoczęciu wpisywania 

danych współrzędnych. 

• Gdy polecenie wyświetla monit o wskazanie punktu, automatycznie 

wyświetlane są podpowiedzi. 

• Zawsze - podpowiedzi wyświetlane są zawsze, nawet jeśli nie znajdują się we 

wskaźniku poleceń. 

6 Jeśli chcesz zawsze wyświetlać symbol wskazujący format punktu, zaznacz 

opcję Pokaż "@" lub "#" przed współrzędnymi. 

7 Kliknij przycisk OK. 
 

Aby dostosować ustawienia wprowadzania wymiarów 

1 W oknie dialogowym Ustawienia rysowania kliknij kartę Wprowadzanie dynamiczne. 

2 W sekcji Wprowadzanie wymiarów kliknij Ustawienia. 

3 Wybierz jedną z poniższych opcji, aby określić, kiedy dane wejściowe wymiaru 

będą wyświetlane podczas edycji uchwytu: 

• Tylko jedno pole wprowadzania wymiaru Wyświetla jedno pole 

wprowadzania wymiaru, które może się różnić w zależności od wybranej 

jednostki. 

• Pola wprowadzania dwóch wymiarów Wyświetla dwa pola 

wprowadzania wymiarów, które mogą się różnić w zależności od wybranej 

jednostki. 

• Dowolna kombinacja pól wprowadzania wymiarów Wyświetla wszystkie 

włączone pola wprowadzania wymiarów, które zostały wybrane: 

wynikowy znacznik wymiaru, znacznik zmiany długości, bezwzględny 

znacznik kąta, znacznik zmiany kąta i znacznik promienia łuku. 

4 Jeśli chcesz użyć zmiennej systemowej ANGBASE podczas określania 

kierunku północnego względem bieżącego UCS, zaznacz opcję Użyj kąta 

ANGBASE. Jeśli opcja ta nie zostanie zaznaczona, zmienna ANGBASE będzie 

ignorowana, co w niektórych przypadkach może prowadzić do 

nieprzewidywalnych wyników. 

5 Kliknij przycisk OK. 
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Aby dostosować wygląd dynamicznych podpowiedzi wejściowych 

1 W oknie dialogowym Ustawienia rysowania kliknij kartę Wprowadzanie dynamiczne. 

2 Kliknij opcję Wygląd podpowiedzi. 

3 W obszarze Kolory przestrzeni modelu wybierz kolor tekstu i tła 

dynamicznych podpowiedzi wejściowych wyświetlanych w przestrzeni 

modelu. 

4 W obszarze Kolory przestrzeni papieru wybierz kolor tekstu i tła dynamicznych 

podpowiedzi wejściowych wyświetlanych w przestrzeni papieru. 

5 W polu Rozmiar przesuń suwak, aby określić rozmiar dynamicznych podpowiedzi i tekstu. 

6 W obszarze Przezroczystość przesuń suwak, aby określić przezroczystość 

dynamicznych podpowiedzi i tekstu. 

7 Kliknij przycisk OK. 

 

 
 

Korzystanie z zatrzasków jednostek 
 

Migawki jednostek umożliwiają szybkie wybieranie dokładnych punktów 

geometrycznych na istniejących jednostkach bez konieczności znajomości 

dokładnych współrzędnych tych punktów. Za pomocą przyciągania jednostek można 

wybrać punkt końcowy linii lub łuku, punkt środkowy okręgu, punkt przecięcia 

dowolnych dwóch jednostek lub dowolną inną pozycję o znaczeniu geometrycznym. 

Można również użyć przyciągania jednostek do rysowania jednostek, które są 

styczne lub prostopadłe do istniejącej jednostki. 

Punktów przyciągania jednostek można używać za każdym razem, gdy program 

wyświetli monit o określenie punktu - na przykład podczas rysowania linii lub innej 

jednostki. Z przyciąganiem encji można pracować na dwa sposoby: 

• Włącz przyciągnięcie jednostki, które pozostanie aktywne do momentu jego 

wyłączenia, wybierając przyciągnięcie jednostki, gdy żadne inne polecenie nie 

jest aktywne. 

• Jednorazowe przyciągnięcie encji można włączyć dla pojedynczego wyboru, 

wybierając przyciągnięcie encji, gdy aktywne jest inne polecenie. Można również 

użyć jednorazowego przyciągnięcia encji, aby nadpisać działające przyciągnięcie 

encji. 

 

Jeśli wpiszesz nazwę entity snaps, nie musisz wpisywać całej nazwy. 

Wpisz tylko trzy pierwsze litery nazwy przyciągania. 
 

Podczas korzystania z przyciągania do elementów program rozpoznaje tylko 

widoczne elementy lub widoczne części elementów. Nie można przyciągać do 

elementów na warstwach, które zostały wyłączone, ani do pustych części linii 

przerywanych. 

Po określeniu co najmniej jednego przyciągania jednostek do krzyżyka zostanie 

dodane pole docelowe przyciągania jednostek. Ponadto obok krzyżyka pojawia się 

ikona wskazująca aktywne przyciąganie jednostki. Po wybraniu jednostki program 

przyciąga ją do punktu przyciągania znajdującego się najbliżej środka pola 



docelowego. 



84 C H A P T E R 3 

 

Ustawianie zatrzasków jednostek 

Zatrzaski jednostek można ustawić przy użyciu dowolnej z poniższych metod: 

• Na wstążce wybierz Rysuj, a następnie w obszarze Przyciąganie encji wybierz 

przyciąganie encji, które chcesz ustawić. 

• Wybierz Narzędzia > Przyciągnięcie jednostki i wybierz przyciągnięcie jednostki, które 

chcesz ustawić. 

• Na pasku narzędzi przyciągania jednostek kliknij jedno z narzędzi przyciągania jednostek. 

• Na pasku poleceń wpisz polecenie przyciągania jednostki. 

• Na pasku stanu kliknij dwukrotnie ESNAP. 

• Naciśnij i przytrzymaj klawisz Shift, klikając prawym przyciskiem myszy w 

dowolnym miejscu okna rysowania, aby wyświetlić menu skrótów przyciągania 

jednostek, a następnie wybierz przyciąganie jednostki, które chcesz ustawić. 

Można również ustawić przyciąganie jednostek za pomocą okna dialogowego 

Ustawienia rysunku. W tym celu wybierz polecenie Narzędzia > Przyciąganie 

jednostek > Ustawienia przyciągania jednostek. Okno dialogowe Ustawienia 

rysunku zostanie wyświetlone z aktywną kartą Wprowadzanie współrzędnych. Na 

liście Tryby przyciągania jednostek kliknij pole wyboru dla każdego z przyciągania 

jednostek, które chcesz ustawić. 

 

Istnieje kilka wskaźników, jeśli przyciągnięcie jednostki jest aktywne. 

Po wybraniu przyciągania encji, obok przyciągania encji w menu pojawi się 

znacznik wyboru, powiązane narzędzie, jeśli pasek narzędzi przyciągania encji jest 

aktywny, a odpowiednie pole zostanie zaznaczone na karcie Współrzędne w oknie 

dialogowym Ustawienia rysunku. 
 

 
Aby zmienić rozmiar pola docelowego przyciągnięcia jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Wybór podmiotu. 

4 W sekcji Przysłona przyciągania jednostki zmień wartość w polu Przysłona. 

5 Kliknij przycisk OK. 
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A Wybierz opcję Entity Selection. B Wpisz lub wybierz rozmiar przysłony przyciągania jednostki. 

 

Najbliższe narzędzie Snap 

Narzędzie Najbliższe przyciąganie służy do przyciągania do najbliższego punktu 

innej jednostki. Można przyciągnąć do najbliższego punktu na łuku, okręgu, elipsie, 

łuku eliptycznym, linii, punkcie, segmencie polilinii, półprostej, splajnie, linii 

nieskończonej lub wzorze kreskowania, który jest wizualnie najbliżej kursora. 
 

Aby ustawić najbliższe przyciąganie 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Nearest Snap (  ): 

• Na wstążce wybierz polecenie Rysuj > Najbliższe przyciąganie (w obszarze Przyciąganie 

jednostek). 

• W menu wybierz kolejno Narzędzia > Przyciąganie jednostek > Najbliższe przyciąganie. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Nearest Snap. 

• Wpisz nearest i naciśnij Enter. 

Narzędzie Endpoint Snap 

Narzędzie przyciągania do punktu końcowego służy do przyciągania do punktu 

końcowego innej jednostki. Można przyciągnąć do najbliższego punktu końcowego 

łuku, linii, segmentu polilinii, półprostej, wzoru kreskowania, płaszczyzny lub 

trójwymiarowej powierzchni. Jeśli jednostka ma grubość, przyciąganie do punktu 

końcowego przyciąga również do punktów końcowych krawędzi jednostki. 

Aby ustawić przyciąganie punktu końcowego 

Wykonaj jedną z poniższych czynności, aby wybrać Endpoint Snap (  ): 

• Na wstążce wybierz polecenie Draw > Endpoint Snap (w Entity Snaps). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie punktów końcowych. 
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• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Endpoint Snap. 

• Wpisz endpoint i naciśnij Enter. 
 

Aby przyciągnąć do punktu końcowego, wybierz dowolne miejsce na jednostce w pobliżu jej punktu końcowego 
(A). 

 
 

Narzędzie przyciągania punktu środkowego 

Narzędzie przyciągania do punktu środkowego służy do przyciągania do punktu 

środkowego innej jednostki. Można przyciągnąć do punktu środkowego łuku, elipsy, 

linii, segmentu polilinii, płaszczyzny, linii nieskończonej, splajnu lub wzoru 

kreskowania. W przypadku linii nieskończonych punkt środkowy jest przyciągany 

do pierwszego zdefiniowanego punktu. Jeśli jednostka ma grubość, przyciąganie 

jednostki punktu środkowego również przyciąga do punktu środkowego krawędzi 

jednostki. 

 

Wpisz m2p lub mtp, aby włączyć jednorazowe przyciąganie do środka dwóch punktów. 

Użytkownik określa punkty, takie jak dwa punkty wybrane za pomocą przyciągania jednostek. 
 

 
Aby ustawić przyciąganie punktu środkowego 

Wykonaj jedną z poniższych czynności, aby wybrać Midpoint Snap (  ): 

• Na wstążce wybierz polecenie Draw > Midpoint Snap (w Entity Snaps). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie punktu środkowego. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Midpoint Snap. 

• Wpisz midpoint i naciśnij Enter. 
 

Aby przyciągnąć do punktu środkowego, wybierz dowolne miejsce na jednostce w pobliżu jej punktu środkowego 
(A). 

 
Narzędzie Center Snap 

Narzędzie przyciągania do środka służy do przyciągania do punktu środkowego 

innej jednostki. Można przyciągać do środka łuku, okręgu, wielokąta, elipsy lub łuku 

eliptycznego. Aby przyciągnąć do środka, należy zaznaczyć widoczną część 

jednostki. 
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Aby ustawić Center Snap 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Center Snap (  ): 

• Na wstążce wybierz polecenie Draw > Center Snap (w Entity Snaps). 

• Z menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie do środka. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Center Snap. 

• Wpisz center i naciśnij Enter. 
 

Aby przyciągnąć do środka, wybierz dowolne miejsce na widocznej części jednostki (A). 

 
Prostopadłe narzędzie Snap 

Narzędzie przyciągania prostopadłego służy do przyciągania do prostopadłego 

punktu innej jednostki. Można przyciągnąć do łuku, okręgu, elipsy, linii, polilinii, 

linii nieskończonej, półprostej, splajnu, wzoru kreskowania lub krawędzi 

płaszczyzny, aby utworzyć prostopadłe wyrównanie z tą jednostką lub z 

wyimaginowanym przedłużeniem tej jednostki. 
 

Aby ustawić przyciąganie prostopadłe 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Snap prostopadły (  ): 

• Na wstążce wybierz polecenie Draw > Perpendicular Snap (w Entity Snaps). 

• W menu wybierz kolejno Narzędzia > Przyciągnięcie jednostki > Przyciągnięcie 

prostopadłe. 

• Na pasku narzędzi przyciągania jednostek kliknij narzędzie Ustaw przyciąganie prostopadłe. 

• Wpisz perpendicular i naciśnij Enter. 

 

Aby utworzyć kąt prostopadły (A) do jednostki (B), wybierz 
dowolne miejsce na jednostce. 

 
Narzędzie Snap styczny 

Narzędzie przyciągania stycznego służy do przyciągania do punktu stycznego innej 

jednostki. Można przyciągnąć do punktu na łuku, elipsie, splajnie lub okręgu, który 

po połączeniu z poprzednim punktem tworzy linię styczną do tej jednostki. 
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Aby ustawić przyciąganie styczne 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Tangent Snap (  ): 

• Na wstążce wybierz polecenie Rysuj > Przyciąganie styczne (w obszarze Przyciąganie 

jednostek). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie styczne. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Tangent Snap. 

• Wpisz tangens i naciśnij Enter. 

 

Aby przyciągnąć do stycznej, wybierz jednostkę w pobliżu punktu stycznego (A). 

 
Narzędzie Quadrant Snap 

Narzędzie przyciągania do ćwiartki służy do przyciągania do punktu ćwiartki innej 

jednostki. Można przyciągnąć do najbliższej ćwiartki łuku, okręgu, elipsy lub łuku 

eliptycznego. 
 

Aby ustawić Quadrant Snap 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Quadrant Snap (  ): 

• Na wstążce wybierz polecenie Draw > Quadrant Snap (w Entity Snaps). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie kwadrantów. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Quadrant Snap. 

• Wpisz quadrant i naciśnij Enter. 

 

Aby przyciągnąć do kwadrantu, wybierz jednostkę w pobliżu punktu kwadrantu (A). 
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Narzędzie przyciągania punktu wstawiania 

Narzędzie przyciągania do punktu wstawienia służy do przyciągania do punktu 

wstawienia atrybutu, bloku lub jednostki tekstowej. 
 

Aby ustawić przyciąganie punktu wstawiania 

Wykonaj jedną z poniższych czynności (  ): 

• Na wstążce wybierz polecenie Draw > Insertion Point Snap (w Entity Snaps). 

• Z menu wybierz polecenie Narzędzia > Przyciągnięcie jednostki > Przyciągnięcie punktu 

wstawienia. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Insertion Point Snap. 

• Wpisz insertion i naciśnij Enter. 
 

Aby przyciągnąć do punktu wstawienia, wybierz dowolne miejsce na jednostce (A). 
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Narzędzie Node Snap 

Użyj narzędzia przyciągania węzłów, aby przyciągnąć do jednostki punktowej. 
 

Aby ustawić Node Snap 

Wykonaj jedną z poniższych czynności, aby wybrać Node Snap ( ): 

• Na wstążce wybierz polecenie Draw > Node Snap (w Entity Snaps). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie węzłów. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Set Node Snap. 

• Wpisz node, a następnie naciśnij Enter. 

 

Aby przyciągnąć do jednostki punktowej, wybierz tę jednostkę (A). 

 
Narzędzie Parallel Snap 

Narzędzie przyciągania równoległego służy do wyświetlania równoległych linii 

pomocniczych podczas wybierania drugich i kolejnych punktów nowych 

jednostek. Prowadnice są wyświetlane równolegle do punktów wskazanych na 

innych liniach, liniach nieskończonych, promieniach lub liniowych segmentach 

polilinii. 

 

Wyłącz ORTHO przed użyciem przyciągania równoległego 

Jeśli jest włączona, kliknij dwukrotnie przycisk ORTHO na pasku stanu, aby ją wyłączyć. 
 

 
Aby ustawić Parallel Snap 

Wykonaj jedną z poniższych czynności (  ): 

• Na wstążce wybierz polecenie Rysuj > Przyciąganie równoległe (w obszarze Przyciąganie 

jednostek). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie równoległe. 

• Na pasku narzędzi przyciągania jednostek kliknij narzędzie Ustaw przyciąganie równoległe. 

• Wpisz parallel i naciśnij Enter. 

 

Wybierz pierwszy punkt jednostki (A), najedź kursorem na żądaną 
równoległą jednostkę (B), a następnie przesuń kursor z powrotem do 
nowej jednostki, aby wyświetlić przewodnik. 
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Aby przyciągnąć do punktu równoległego 

1 Wybierz polecenie, na przykład line. 

2 Wybierz pierwszy punkt podmiotu. 

3 Wpisz par i naciśnij Enter. 

4 Przesuń kursor nad żądaną jednostkę równoległą. Mały znak "x" oznacza 

pozycję na równoległej jednostce. 

5 W razie potrzeby wybierz dodatkowe jednostki równoległe. Możesz także 

odznaczyć równoległą jednostkę, przesuwając kursor na odpowiadający jej 

"x". 

6 Przesuń kursor z powrotem do tworzonej jednostki i użyj prowadnicy 

równoległej, aby wybrać następny punkt jednostki. 

 

Narzędzie przyciągania pozornego przecięcia 

Narzędzie przyciągania pozornego przecięcia powoduje przyciąganie do przecięcia 

dwóch elementów, które nie przecinają się w przestrzeni trójwymiarowej, ale wydają 

się przecinać w bieżącym widoku. Można przyciągać do dowolnych dwóch obiektów w 

kombinacji łuku, okręgu, linii, linii nieskończonej, polilinii, półprostej, elipsy, łuku 

eliptycznego, splajnu, wzoru kreskowania, siatki wielokąta lub siatki poliface. 

Można również przyciągnąć do punktu przecięcia w obrębie pojedynczej jednostki, 

w tym polilinii lub splajnu. 

Opcja przyciągania rozszerzonego pozornego przecięcia powoduje przyciąganie do 

logicznej lokalizacji, w której dwa elementy (linie, łuki lub segmenty eliptyczne) 

przecinałyby się, gdyby miały nieskończoną długość. ALCAD automatycznie 

używa opcji rozszerzenia tylko wtedy, gdy wpiszesz app na pasku poleceń (a nie 

pełną nazwę widocznego polecenia) po wybraniu elementu, takiego jak Linia lub 

Okrąg. Kreskowane linie przedłużające są rysowane, aby pomóc pokazać 

rozszerzone pozorne przecięcie. 

 

Istnieją dwa rodzaje zatrzasków skrzyżowań. 

Można ustawić pozorne przyciąganie do przecięcia lub przyciąganie do przecięcia, 

ale nie można używać obu jednocześnie. 
 

 
Aby ustawić przyciąganie pozornego przecięcia 

Wykonaj jedną z poniższych czynności, aby wybrać opcję pozornego przecięcia (  ): 

• Na wstążce wybierz polecenie Rysuj > Pozorne przyciąganie przecięcia (w obszarze 

Przyciąganie jednostek). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Przyciąganie widocznego 

przecięcia. 

• Na pasku narzędzi przyciągania jednostek kliknij narzędzie przyciągania widocznego 

przecięcia. 

• Wpisz apparent i naciśnij Enter. 
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Aby przyciągnąć do skrzyżowania, wybierz widoczne skrzyżowanie (A). 

Aby przyciągnąć do rozszerzonego pozornego punktu przecięcia 

1 Wybierz polecenie, na przykład line. 

2 Wpisz app i naciśnij Enter. 

3 Wybierz rozszerzony pozorny punkt przecięcia. 
 

Funkcja Extended Apparent Intersection Snap wyłącza się automatycznie po 

wybraniu punktu. 

 

Polecenie Quick Snap 

Zazwyczaj przyciąganie encji przeszukuje wszystkie encje przecinające cel i wybiera 

tę, która znajduje się najbliżej środka celu. Użyj polecenia Quick Snap, aby 

zmodyfikować bieżące przyciąganie encji, tak aby program przestał szukać punktu 

przyciągania, gdy tylko znajdzie jedną encję z co najmniej jednym punktem 

bieżącego typu encji. 
 

Aby ustawić Quick Snap 

• Wpisz quick i naciśnij Enter. 

 
Narzędzie Clear Entity Snaps 

Narzędzie Wyczyść przyciąganie jednostek służy do wyłączania wszystkich ustawień 

przyciągania jednostek, niezależnie od tego, w jaki sposób zostały one ustawione: za 

pomocą menu, narzędzia, polecenia lub w oknie dialogowym Ustawienia rysowania. 
 

Aby ustawić Clear Entity Snaps 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Clear Entity Snaps (  ): 

• Na wstążce wybierz polecenie Draw > Clear Entity Snaps (w obszarze Entity Snaps). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Wyczyść przyciąganie jednostek. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Clear Entity Snaps. 

• Wpisz none i naciśnij Enter. 
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Z narzędzia Point 

Narzędzie From Point służy do ustawiania tymczasowego punktu bazowego, od 

którego ma zostać przesunięty wybór punktu. Narzędzie From Point może być 

używane tylko wtedy, gdy inne aktywne polecenie żąda punktu. 
 

Aby ustawić tymczasowy punkt przesunięcia 

1 Wybierz polecenie, na przykład line lub move. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Od punktu (  ): 

• Na wstążce wybierz polecenie Rysuj > Od punktu (w Przyciąganie jednostek). 

• W menu wybierz Narzędzia > Przyciąganie jednostek > Od punktu. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie From Point. 

• Wpisz from, a następnie naciśnij Enter. 

3 Wybierz miejsce umieszczenia tymczasowego punktu bazowego. 

4 Wprowadź odległość przesunięcia od punktu bazowego, na przykład (@8.5,0), 

gdzie chcesz zlokalizować następny punkt. Należy pamiętać, że wprowadzenie 

(8.5,0) umieszcza punkt bezwzględny od początku UCS, a nie punkt względny 

od punktu bazowego. 

5 Kontynuuj wykonywanie oryginalnego polecenia. 

 
Narzędzie tymczasowego punktu śledzenia 

Narzędzie Tymczasowy punkt śledzenia służy do ustawiania tymczasowego punktu 

śledzenia podczas korzystania z polecenia. Narzędzie Tymczasowy punkt śledzenia 

może być używane tylko wtedy, gdy inne aktywne polecenie żąda punktu. 
 

Aby ustawić tymczasowy punkt śledzenia 

1 Wybierz polecenie, na przykład line lub move. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Tymczasowy punkt śledzenia (

 ): 

• Na wstążce wybierz polecenie Rysuj > Tymczasowy punkt śledzenia (w przyciąganiach 

jednostek). 

• Z menu wybierz Narzędzia > Przyciąganie jednostek > Tymczasowy punkt śledzenia. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Temporary Tracking Point. 

• Wpisz TT, a następnie naciśnij Enter. 

3 Wybierz punkt, aby oznaczyć tymczasowy punkt śledzenia. 

4 Kontynuuj wykonywanie oryginalnego polecenia. 



 MarkerEntity snap 

Parallel Snap 
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Narzędzie Mid Between 2 Points 

Narzędzie Mid Between 2 Points służy do ustawiania tymczasowego punktu 

środkowego między dwoma punktami. Narzędzie Mid Between 2 Points może być 

używane tylko wtedy, gdy inne aktywne polecenie żąda punktu. 
 

Aby ustawić tymczasowy punkt środkowy między dwoma punktami 

1 Wybierz polecenie, na przykład line lub move. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Mid Between 2 Points (  ): 

• Na wstążce wybierz polecenie Draw > Mid Between 2 Points (w Entity Snaps). 

• W menu wybierz kolejno Narzędzia > Przyciąganie jednostek > Środek między 2 

punktami. 

• Na pasku narzędzi Entity Snaps kliknij narzędzie Mid Between 2 Points. 

• Wpisz m2p (lub mtp), a następnie naciśnij Enter. 

3 Wybierz pierwszy punkt. 

4 Wybierz drugi punkt. Punkt środkowy zostanie obliczony automatycznie. 

5 Kontynuuj wykonywanie oryginalnego polecenia. 

 
Korzystanie z przyciągania przelotowego 

Przyciąganie przelotowe to pomoc wizualna, która pomaga zobaczyć i efektywniej 

wykorzystywać przyciąganie encji. Gdy przyciąganie przelotowe jest włączone, 

ALCAD wyświetla kolorowy znacznik odpowiadający punktom przyciągania encji 

podczas przesuwania krzyżyka po rysunku. 

 

Wyświetlanie znaczników przelotu 
Każdy snap jednostki ma swój własny znacznik. 

 
Przelotowe znaczniki zatrzaskowe 

 

Punkt końcowy 

Przyciągnięcie 

Najbliższe 

Przyciągnięcie 

Punkt 

środkowy 

Przyciągnięcie 

             Center Snap 

              Snap prostopadły

 Snap styczny 

             Kwadrantowy 

zatrzask 

wsuwany 
 



 MarkerEntity snap 
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Przelotowe znaczniki zatrzaskowe 
 

Przyciąganie 

punktu 

Przyciąganie 

przecięcia 

 
 

Konfigurowanie migawki przelotowej 
Gdy włączone jest przyciąganie przelotowe i włączone jest przyciąganie wielu 

jednostek, można nacisnąć klawisz Tab, aby przełączać się między dostępnymi 

punktami przyciągania jednostek objętych polem przysłony. Na przykład, gdy włączone są 

punkty końcowe i środkowe, a pole przysłony znajduje się na linii, naciśnij klawisz Tab, 

aby przełączać się między najbliższym punktem końcowym i środkowym linii. 

 
Aby ustawić opcje przyciągania przelotowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania lub wybierz Narzędzia > 

Przyciąganie jednostek 

> Ustawienia przyciągania jednostek. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Entity Snaps. 

4 Kliknij przycisk Opcje wyświetlania. Otworzy się okno dialogowe Opcje z zakładką 

Przyciąganie. 

5 Zaznacz Enable Fly-Over Snapping, aby włączyć przyciąganie do przelotu. 

6 Ustaw opcje przelotu, w tym kolor, rozmiar i grubość znacznika 

przyciągania. 

Pozorne przyciąganie do 
skrzyżowania 



7 Kliknij przycisk OK. 
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8 Kliknij ponownie przycisk OK. 
 

Aby uzyskać szczegółowe informacje na temat różnych opcji przyciągania w locie, 

patrz "Zmiana opcji na karcie Przyciąganie" na stronie 719. 

 

Korzystanie ze śledzenia przyciągnięć jednostek 

Gdy włączone jest śledzenie przyciągania jednostek, prowadnice są wyświetlane pod 

określonymi kątami na zewnątrz od tymczasowych punktów śledzenia. Może to 

pomóc w rysowaniu i modyfikowaniu jednostek przy użyciu względnej pozycji 

istniejących jednostek, na przykład wstawianie bloku o tej samej współrzędnej y 

istniejącej linii. 

Tymczasowe punkty śledzenia są oznaczone czerwonym znakiem plus i mogą być 

umieszczone w dowolnym miejscu na rysunku. Aby wybrać miejsce wyświetlania 

punktów śledzenia, najpierw aktywuj polecenie żądające punktu, a następnie: 

• Przesuń kursor i najedź na punkt przyciągania jednostki, aby dodać punkt śledzenia. 

• Wybierz polecenie Tymczasowy punkt śledzenia, a następnie zaznacz 

dowolne miejsce na rysunku, w którym ma znajdować się punkt śledzenia. 

• Przesuń kursor i najedź na istniejący punkt śledzenia, aby go usunąć. 

Można skonfigurować śledzenie przyciągania jednostek, aby wyświetlać linie 

pomocnicze z przyrostem 90 stopni lub dodatkowymi przyrostami, które są 

zdefiniowane dla śledzenia biegunowego. Można również skonfigurować śledzenie 

przyciągania do obiektów, aby wyświetlać linie pomocnicze względem bieżącego 

układu UCS lub względem ostatniego narysowanego segmentu. 

Aby korzystać ze śledzenia przyciągnięć encji, co najmniej jedno przyciągnięcie 

encji musi być włączone, a działające przyciągnięcia nie mogą być wyłączone. 

Śledzenie biegunowe nie musi być włączone, aby korzystać ze śledzenia 

przyciągnięć encji. 
 

Aby włączyć lub wyłączyć śledzenie przyciągnięć jednostek 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Entity Snaps. 

4 Kliknij pole wyboru Śledzenie przyciągnięcia jednostki. 
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Włączanie i wyłączanie śledzenia przyciągnięć jednostek. 

Kliknij dwukrotnie ustawienie ETRACK na pasku stanu, wpisz ENTTRACK lub naciśnij klawisz 

F11. 
 

 

Uruchom polecenie, najedź kursorem na jeden lub więcej punktów 
przyciągania jednostek, aby oznaczyć je punktem śledzenia (Athen B), a 
następnie przesuń kursor, aby wyświetlić prowadnice (C). W tym przykładzie 
przyciąganie punktu środkowego jest włączone, a śledzenie przyciągania 
jednostek jest wyświetlane w odstępach co 90 stopni. 

 
Aby określić ustawienia śledzenia przyciągnięć jednostek 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wprowadzanie współrzędnych. 

3 Kliknij kartę Śledzenie biegunów. 

4 Wybierz jedną z poniższych opcji, aby określić ustawienia śledzenia jednostek: 

• Ortogonalne Tylko 90-stopniowe przyrosty kąta są używane do śledzenia 

przyciągania jednostek, niezależnie od ustawień śledzenia biegunowego. 

• Użyj wszystkich kątów śledzenia biegunowego Wszystkie zdefiniowane kąty 

śledzenia biegunowego, w tym kąty inne niż 90 stopni, są używane do 

śledzenia przyciągania jednostek. 

5 Wybierz jedną z poniższych opcji, aby określić sposób obliczania kątów 

prowadnic na potrzeby śledzenia przyciągania jednostek: 

• Prowadnice bezwzględne są wyświetlane pod kątem względem bieżącego układu UCS. 

• Względem ostatniego segmentu Prowadnice są wyświetlane pod kątem 

względem ostatniego narysowanego segmentu, jeśli tworzone są jednostki z 

wieloma segmentami (w przeciwnym razie prowadnice są wyświetlane pod 

kątem bezwzględnym). 

6 Kliknij przycisk OK. 
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A Wybierz, aby użyć kątów przyrostu 90 stopni lub 
wszystkich kątów określonych w Kąt przyrostu 
i Dodatkowe kąty do śledzenia biegunowego. 

B Wybierz, czy kąty dla prowadnic są obliczane 
względem bieżącego UCS, czy względem 
ostatniego poprzednio narysowanego segmentu 
podczas rysowania elementów z więcej niż 
jednym segmentem. 



 

Zapisywanie 
rysunku 
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Po zapisaniu rysunku praca jest zapisywana w pliku rysunku (.dwg). 

Po zapisaniu rysunku po raz pierwszy można zapisać go pod nową nazwą. Oprócz 

plików rysunków (.dwg), można również zapisać rysunek w pliku Drawing 

Exchange Format (.dxf) lub szablonie rysunku (.dwt). 

Jeśli rysunek został utworzony przy użyciu szablonu, zapisanie rysunku nie 

spowoduje zmiany oryginalnego szablonu. 

Jeśli potrzebujesz dodatkowego poziomu bezpieczeństwa dla plików rysunków, 

możesz zapisać rysunek z hasłem, dzięki czemu tylko Ty i osoby znające hasło 

mogą otworzyć rysunek. 

 

Zapisywanie rysunku 

Aby zapisać rysunek, wybierz dowolną z poniższych metod, aby wybrać opcję Zapisz (  ): 

• Na wstążkowym pasku narzędzi Szybki dostęp kliknij przycisk Zapisz lub na 

wstążkowym pasku narzędzi Aplikacja wybierz polecenie Zapisz. 

• W menu wybierz Plik > Zapisz. 

• Na pasku narzędzi Standard kliknij przycisk Zapisz. 

• Wpisz save, a następnie naciśnij Enter. 

• Wpisz qsave i naciśnij Enter. 

Przy pierwszym zapisywaniu rysunku program wyświetla okno dialogowe Zapisz 

rysunek jako, w którym można wybrać katalog i wpisać nazwę rysunku. Podczas 

pierwszego zapisywania rysunku można użyć dowolnej nazwy. 
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A 
E 

 

B 

C 

D 
 

A Wyświetla opis rozmiaru pliku, datę 
utworzenia i inne informacje o rysunku. 

B Niedostępne podczas zapisywania 
r y s u n k ó w ; dostępne tylko podczas 
otwierania rysunków. 

 

C Włącza lub wyłącza podgląd rysunku. 

D Zapisuje rysunek z hasłem. 

E Wyświetla obraz rysunku przed jego 
zapisaniem. 

 

Zapisywanie rysunku z nową nazwą lub formatem pliku 

Rysunek można zapisać pod nową nazwą i w dowolnym z poniższych formatów plików: 

• Standardowe pliki rysunkowe z rozszerzeniem .dwg. Możesz wybrać format 

pliku .dwg, który jest kompatybilny z różnymi wersjami programu AutoCAD. 

• Drawing Exchange Format pliki z rozszerzeniem .dxf. Możesz wybrać format 

pliku .dxf, który jest kompatybilny z różnymi wersjami programu AutoCAD. 

• Szablony rysunków z rozszerzeniem pliku .dwt. Szablony rysunków umożliwiają 

łatwe tworzenie nowych rysunków, które ponownie wykorzystują ustawienia 

rysunku i jednostki. 
 

Aby zapisać rysunek z nową nazwą lub formatem pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz jako: 

• Na pasku narzędzi Szybki dostęp na wstążce kliknij Zapisz jako lub na 

przycisku Aplikacja na wstążce wybierz Zapisz jako. 

• W menu wybierz Plik > Zapisz jako. 

• Wpisz saveas i naciśnij Enter. 

2 W oknie dialogowym Zapisz rysunek jako w sekcji Zapisz jako typ wybierz format pliku. 

3 Podaj nazwę pliku, który chcesz utworzyć. 

4 Kliknij przycisk Zapisz. 
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Rysunki mogą być również zapisywane poprzez eksport do różnych formatów plików. 

Więcej informacji można znaleźć w sekcji "Eksportowanie rysunków" na stronie 665. 
 

 
Zapisywanie rysunku z hasłem 

Czasami rysunki mogą zawierać poufne informacje i należy kontrolować, kto ma 

do nich dostęp. Jeśli potrzebujesz dodatkowego poziomu bezpieczeństwa, możesz 

zapisać rysunek z hasłem, dzięki czemu tylko Ty i osoby znające hasło mogą otworzyć 

rysunek. 

Aby zapisać rysunek z hasłem, należy zapisać go jako plik .dwg dla programu 

AutoCAD w wersji 2004 lub nowszej. 

 

Zapisuj hasła lub używaj znanych słów. 

Jeśli zapomnisz hasła do rysunku, nie będzie można go otworzyć ani odzyskać. Warto 

przechowywać wszystkie hasła w bezpiecznym miejscu. 
 

 
Aby zapisać rysunek z hasłem 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz jako: 

• Na pasku narzędzi Szybki dostęp na wstążce kliknij Zapisz jako lub na 

przycisku Aplikacja na wstążce wybierz Zapisz jako. 

• W menu wybierz Plik > Zapisz jako. 

• Wpisz saveas i naciśnij Enter. 

2 W oknie dialogowym Zapisz rysunek jako, w sekcji Zapisz jako typ wybierz 

plik .dwg dla programu AutoCAD w wersji 2004 lub nowszej. 

3 Kliknij opcję Ochrona hasłem. 

4 Wybierz folder, w którym chcesz zapisać rysunek. 

5 W polu File Name określ nazwę pliku, który chcesz utworzyć. 

6 Kliknij przycisk Zapisz. 

7 W oknie dialogowym Hasło wprowadź hasło. 

8 W razie potrzeby należy zapisać i przechowywać hasło w bezpiecznym 

miejscu. Jeśli zapomnisz hasła do rysunku, nie będzie można go otworzyć ani 

odzyskać. 

9 Kliknij przycisk OK. 
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Proste encje obejmują linie (zarówno skończone, jak i nieskończone), okręgi, łuki, 

elipsy, łuki eliptyczne, punkty i promienie. Ponadto ALCAD zawiera narzędzie do 

szkicowania odręcznego, które może być używane do tworzenia prostych elementów. 

W tej sekcji wyjaśniono kilka metod tworzenia prostych jednostek, w tym jak to zrobić: 

• Użyj poleceń menu w menu Rysuj. 

• Użyj narzędzi na pasku narzędzi Rysuj. 

• Wpisz polecenia na pasku poleceń. 

W niektórych przypadkach istnieje wiele różnych sposobów na utworzenie 

podmiotu. W większości przypadków w tym przewodniku podano jeden lub dwa z nich. 

Aby dowiedzieć się, jak tworzyć podmioty przy użyciu innych metod, zapoznaj się 

z odniesieniem do poleceń w pomocy online. 

Podczas korzystania z narzędzia lub polecenia rysowania program wyświetla monit 

o wprowadzenie punktów współrzędnych, takich jak punkty końcowe lub punkty 

wstawiania. Punkty lub odległości można wprowadzać za pomocą myszy lub 

wpisując wartości współrzędnych na pasku poleceń. Podczas rysowania ALCAD 

wyświetla również kontekstowe okno zachęty z odpowiednimi dodatkowymi 

opcjami dla typu rysowanej jednostki. 

Po utworzeniu jednostek można je modyfikować za pomocą narzędzi do modyfikacji jednostek. 

 

 

 
Tematy w tym rozdziale 

Rysowanie linii ................................................................................................. 104 

Rysowanie okręgów  ........................................................................................ 105 

Rysowanie łuków  ............................................................................................ 109 

Rysowanie elips ............................................................................................... 113 

Rysowanie łuków eliptycznych  ........................................................................ 114 

Podmioty punktu rysowania  ............................................................................ 115 

Rysowanie promieni  ....................................................................................... 117 

Rysowanie nieskończonych linii  ...................................................................... 118 

Rysowanie linii konstrukcyjnych  ...................................................................... 120 

Rysowanie odręcznych szkiców  ...................................................................... 127 
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Rysowanie linii 
 

Linia składa się z dwóch punktów: punktu początkowego i punktu końcowego. 

Można połączyć serię linii, ale każdy segment linii jest traktowany jako oddzielna 

jednostka linii. 
 

Aby narysować linię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Linia lub Rysuj > Linia. 

• W menu wybierz polecenie Rysuj > Linia. 

• Na pasku narzędzi Rysuj kliknij narzędzie Linia. 

• Wpisz line i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ punkt końcowy. 

4 W oknie zachęty wybierz Gotowe, aby zakończyć polecenie. 

 
 

Punkt początkowy (A) i punkt końcowy (B). 

Okno podpowiedzi udostępnia kilka opcji podczas rysowania. Na przykład podczas 

rysowania pierwszego segmentu linii można określić jego długość lub kąt orientacji. 

Po narysowaniu co najmniej jednego segmentu linii można kliknąć przycisk Cofnij, 

aby usunąć poprzedni segment linii. Możesz kliknąć przycisk Gotowe, aby 

zakończyć polecenie linii. Po narysowaniu dwóch lub więcej segmentów linii 

można kliknąć przycisk Zamknij, aby zakończyć polecenie linii poprzez 

narysowanie segmentu linii, który łączy się z punktem początkowym pierwszego 

narysowanego segmentu linii. 

Jeśli ostatnim narysowanym elementem był łuk, można również narysować linię 

styczną do punktu końcowego łuku i rozpoczynającą się od niego. 
 

Aby narysować linię jako kontynuację od końca łuku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Linia lub Rysuj > Linia. 

• W menu wybierz polecenie Rysuj > Linia. 

• Na pasku narzędzi Rysuj kliknij narzędzie Linia. 

• Wpisz line i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Podążaj. 

3 Określ długość linii. 
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Punkt końcowy poprzedniego łuku (A) i długość linii (B). 

 

 

Rysowanie okręgów 
 

Domyślną metodą rysowania okręgu jest określenie punktu środkowego i 

promienia. Okręgi można rysować przy użyciu dowolnej z poniższych metod: 

• Center-Radius ( ) 

• Średnica środkowa ( ) 

• 2 punkty ( ) 

• 3 punkty ( ) 

• Promień-styczna (  ) 

• Tan-Tan-Tan  

• Konwersja łuku na okrąg (  ) 

Aby narysować okrąg, określając jego środek i promień 

1 Wykonaj jedną z poniższych czynności, aby wybrać Circle Center-Radius (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Promień środka 

okręgu lub Rysuj > Promień środka okręgu. 

• W menu wybierz polecenie Rysuj > Okrąg > Promień środka okręgu. 

• Na pasku narzędzi Rysuj kliknij narzędzie Promień okręgu. 

• Wpisz circle i naciśnij Enter. 

2 Określ punkt środkowy. 

3 Określ promień okręgu. 

 
 

Punkt środkowy (A) i promień (B). 
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Aby narysować okrąg, określając jego środek i średnicę 

1 Wykonaj jedną z poniższych czynności, aby wybrać średnicę okręgu (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Środek okręgu lub 

Rysuj > Środek okręgu. Pomiń krok 3. 

• W menu wybierz polecenie Rysuj > Okrąg > Środek okręgu - średnica. Pomiń krok 3. 

• Na pasku narzędzi Rysuj kliknij narzędzie Okrąg. 

• Wpisz circle i naciśnij Enter. 

2 Określ punkt środkowy. 

3 W oknie dialogowym wybierz opcję Diameter. 

4 Określ drugi punkt wskazujący średnicę okręgu. 

 
 

Punkt środkowy (A) i średnica (B). 

Aby narysować okrąg, określając dwa punkty końcowe średnicy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Circle 2-Points (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Okrąg 2-punktowy 

lub Rysuj > Okrąg 2-punktowy. Przejdź do kroku 3. 

• W menu wybierz kolejno opcje Rysuj > Okrąg > Okrąg 2-punktowy. Przejdź do kroku 3. 

• Na pasku narzędzi Rysuj kliknij narzędzie Okrąg. 

• Wpisz circle i naciśnij Enter. 

2 W oknie dialogowym wybierz 2 punkty. 

3 Określa pierwszy punkt końcowy średnicy okręgu. 

4 Określa drugi punkt końcowy średnicy okręgu. 

 
 

Pierwszy punkt końcowy (A) i drugi punkt końcowy (B). 
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Aby narysować okrąg, określając trzy punkty na jego obwodzie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Circle 3-Points (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Okrąg 3-punktowy 

lub Rysuj > Okrąg 3-punktowy. Przejdź do kroku 3. 

• W menu wybierz kolejno opcje Rysuj > Okrąg > Okrąg 3-punktowy. Przejdź do kroku 3. 

• Na pasku narzędzi Rysuj kliknij narzędzie Okrąg. 

• Wpisz circle i naciśnij Enter. 

2 W oknie dialogowym wybierz 3 punkty. 

3 Określa pierwszy punkt na obwodzie okręgu. 

4 Określ drugi punkt na obwodzie okręgu. 

5 Określ trzeci punkt na obwodzie okręgu. 

 
 

Pierwszy punkt (A), drugi punkt (B), trzeci punkt (C). 

Aby narysować okrąg, określając jego promień i dwa punkty styczne 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Promień okręgu - styczne (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Styczne po okręgu lub 

Rysuj > Styczne po okręgu. Przejdź do kroku 3. 

• W menu wybierz polecenie Rysuj > Okrąg > Promień okręgu - styczne. Przejdź do kroku 

3. 

• Na pasku narzędzi Rysuj kliknij narzędzie Okrąg. 

• Wpisz circle i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Tangent-Tangent-Radius. 

3 Wybierz pierwszą jednostkę, której ma dotykać okrąg 

4 Wybierz drugą jednostkę, której ma dotykać okrąg. 

5 Określ promień okręgu. 
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Linie styczne (A) i (B) oraz promień okręgu (C). 

Aby narysować okrąg styczny do trzech elementów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Tan-Tan-Tan (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Okrąg Tan-Tan-Tan lub 

Rysuj > Okrąg Tan-Tan-Tan. Przejdź do kroku 3. 

• W menu wybierz opcję Rysuj > Okrąg > Tan-Tan-Tan. Przejdź do kroku 3. 

• Na pasku narzędzi Rysuj kliknij narzędzie Okrąg. 

• Wpisz circle i naciśnij Enter. 

2 W oknie podpowiedzi wybierz opcję Tangent-Tangent-Tangent. 

3 Wybierz pierwszą jednostkę, której ma dotykać okrąg 

4 Wybierz drugą jednostkę, której ma dotykać okrąg. 

5 Wybierz trzecią jednostkę, której ma dotykać okrąg. 

 
 

Pierwsza styczna jednostka (A), druga styczna 
jednostka (B) i trzecia styczna jednostka (C). 

 

Aby przekształcić łuk w okrąg 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Konwertuj łuk na okrąg (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Konwertuj łuk na 

okrąg lub Rysuj > Konwertuj łuk na okrąg. 

• W menu wybierz Rysuj > Okrąg > Konwertuj łuk na okrąg. 

• Na pasku narzędzi Rysuj kliknij narzędzie Konwertuj łuk 

na okrąg. Przejdź do kroku 3. 

• Wpisz circle i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Zamień łuk w okrąg. 

3 Wybierz łuk, który chcesz przekształcić w okrąg. 
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Wybierz łuk (A), aby przekształcić go w okrąg. 

 

 

Rysowanie łuków 
 

Łuk jest częścią okręgu. Domyślną metodą rysowania łuku jest określenie trzech 

punktów - punktu początkowego, drugiego punktu i punktu końcowego. Łuki 

można rysować przy użyciu dowolnej z poniższych metod: 

• Trzy punkty na łuku (  ). 

• Punkt początkowy-centrum-punkt końcowy (  ), lub Punkt początkowy-punkt 

końcowy-centrum (  ), lub Centrum-punkt początkowy-punkt końcowy (  ). 

• Punkt początkowy-środek-włączony kąt (  ), lub Punkt początkowy-

włączony kąt-środek (  ), lub Środek-punkt początkowy-włączony kąt (

 ). 

• Punkt początkowy-centrum-długość akordu ( ) lub Centrum-punkt początkowy-długość 

akordu (  ). 

• Punkt początkowy-punkt końcowy-promień ( ) lub Punkt początkowy-promień-punkt 

końcowy (  ). 

• Punkt początkowy-punkt końcowy-włączony kąt (  ) lub Punkt początkowy-

włączony kąt-punkt końcowy (  ). 

• Punkt początkowy-punkt końcowy-kierunek początkowy (  ) lub Punkt 

początkowy-punkt końcowy-kierunek początkowy (  ). 

• Punkt początkowy-promień-kąt (  ). 

• Jako styczna kontynuacja poprzedniego łuku lub linii ( ). 
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Aby narysować łuk, określając trzy punkty 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję 3-Point Arc (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Łuk 3-punktowy (w 

aplikacji Draw) lub Rysuj > Łuk 3-punktowy (w aplikacji Draw). 

• W menu wybierz polecenie Rysuj > Łuk > Łuk 3-punktowy. 

• Na pasku narzędzi Rysuj kliknij narzędzie Łuk 3-punktowy. 

• Wpisz arc i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ drugi punkt. 

4 Określ punkt końcowy. 

 
 

Punkt początkowy (A), drugi punkt (B) i punkt końcowy (C). 

Okno podpowiedzi zawiera dodatkowe opcje rysowania łuków. Na przykład po określeniu 

punktu początkowego łuku można wybrać opcję Kąt, Środek, Kierunek, Punkt 

końcowy lub Promień. Opcje można również wybierać w innej kolejności. Można 

na przykład narysować łuk, określając jego punkt początkowy, punkt końcowy i 

promień lub określić punkt początkowy, promień, a następnie punkt końcowy. 
 

Aby narysować łuk, określając jego punkt początkowy, punkt środkowy i punkt 
końcowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Arc Start-Center-End (  ): 

• Na wstążce wybierz Home > Arc Start-Center-End (w Draw) lub wybierz Draw 

> Początek-środek-koniec łuku (w Draw). 

• W menu wybierz polecenie Rysuj > Łuk > Łuk początek-środek-koniec. 

• Na pasku narzędzi Rysuj kliknij narzędzie Łuk Początek - Środek - Koniec. 

• Wpisz arc i naciśnij Enter. 

2 Określ punkt początkowy. 

3 W oknie dialogowym wybierz opcję Centrum. 

4 Określ punkt środkowy. 

5 Określ punkt końcowy. 
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Punkt początkowy (A), punkt środkowy (B) i punkt końcowy (C). 

Aby narysować łuk poprzez określenie dwóch punktów i kąta 

1 Wykonaj jedną z poniższych czynności, aby wybrać Arc Start-End-Angle (  ): 

• Na wstążce wybierz kolejno Home > Arc Start-End-Angle (w Draw) lub Draw 

> Kąt początkowy i końcowy łuku (w Draw). 

• W menu wybierz polecenie Rysuj > Łuk > Kąt początkowy i końcowy łuku. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kąt początkowy i końcowy łuku. 

• Wpisz arc i naciśnij Enter. 

2 Określ punkt początkowy. 

3 W oknie dialogowym wybierz opcję Kąt lub wpisz kąt. 

4 Aby narysować łuk w kierunku przeciwnym do ruchu wskazówek zegara, 

wprowadź dodatnią wartość kąta. 

Aby narysować łuk w kierunku zgodnym z ruchem wskazówek zegara, 

wprowadź ujemną wartość kąta. 

5 Określ punkt końcowy. 
 

Punkt początkowy (A), punkt końcowy (B) i uwzględniony kąt (C). 

Jeśli ostatnią narysowaną jednostką był łuk lub linia, można również narysować łuk 

styczny do punktu końcowego łuku lub linii i rozpoczynający się od niego. 
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Aby narysować łuk styczny do łuku lub linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać łuk styczny (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Łuk styczny (w 

aplikacji Draw) lub Rysuj > Łuk styczny (w aplikacji Draw). 

• W menu wybierz polecenie Rysuj > Łuk > Łuk styczny. 

• Na pasku narzędzi Rysuj kliknij narzędzie Łuk styczny. Przejdź do kroku 3. 

• Wpisz arc i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Podążaj. 

3 Określ punkt końcowy. 

 
 

Punkt końcowy (A). 
 

Łuki mogą być konwertowane na okręgi 

 
Na pasku narzędzi Rysuj kliknij wysuwane narzędzie Konwertuj łuk na okrąg (
 ). 



 

Rysowanie elips 
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Domyślną metodą rysowania elipsy jest określenie punktów końcowych jednej osi 

elipsy, a następnie określenie odległości reprezentującej połowę długości drugiej osi. 

Punkty końcowe pierwszej osi określają orientację elipsy. Dłuższa oś elipsy nazywana jest osią 

główną, a krótsza osią pomocniczą. Kolejność definiowania osi nie ma znaczenia. 

Program określa oś główną i pomocniczą na podstawie ich względnych długości. 

Elipsy można rysować przy użyciu dowolnej z poniższych metod: 

• Axis-Axis ( ) 

• Axis-Rotation (  ) 

• Center-Axes ( ) 

• Center-Rotation (  ) 

Aby narysować elipsę, określając punkty końcowe osi 

1 Wykonaj jedną z poniższych czynności, aby wybrać oś elipsy (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Oś elipsy lub Rysuj 

> Oś elipsy. 

• W menu wybierz polecenie Rysuj > Elipsa > Oś-oś elipsy. 

• Na pasku narzędzi Rysuj kliknij narzędzie Oś elipsy. 

• Wpisz ellipse i naciśnij Enter. 

2 Określ pierwszy punkt końcowy. 

3 Określ drugi punkt końcowy. 

4 Określ połowę długości drugiej osi. 

 

Punkt końcowy pierwszej osi (A), punkt końcowy drugiej osi (B) i połowa długości drugiej osi (C). 
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Rysowanie łuków eliptycznych 
 

Łuk eliptyczny jest częścią elipsy. Domyślną metodą rysowania łuku eliptycznego 

jest określenie punktów końcowych jednej osi elipsy, a następnie określenie 

odległości stanowiącej połowę długości drugiej osi. Następnie należy określić kąty 

początkowy i końcowy łuku, mierzone od środka elipsy w stosunku do jej głównej 

osi. Łuki eliptyczne można rysować przy użyciu dowolnej z poniższych metod: 

• Axis-Axis ( ) 

• Axis-Rotation (  ) 

• Center-Axes ( ) 

• Center-Rotation (  ) 

Aby narysować łuk eliptyczny, określając punkty końcowe osi 

1 Wykonaj jedną z poniższych czynności, aby wybrać oś łuku eliptycznego (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Oś łuku eliptycznego 

lub Rysuj > Oś łuku eliptycznego. 

• W menu wybierz Rysuj > Łuk eliptyczny > Oś łuku eliptycznego. 

• Na pasku narzędzi Rysuj kliknij narzędzie Oś łuku eliptycznego. 

• Wpisz elipsa i naciśnij Enter, a następnie wpisz a (dla łuku) i naciśnij Enter. 

2 Określ pierwszy punkt końcowy. 

3 Określ drugi punkt końcowy. 

4 Określ połowę długości drugiej osi. 

5 Określa kąt początkowy łuku. 

6 Określ kąt końcowy. 

 

ALCAD rysuje eliptyczne łuki w określonym kierunku. 

Przejdź do Narzędzia > Ustawienia rysowania > zakładka Jednostki rysowania. 

Kliknij kartę Jednostki kątowe. Domyślnym ustawieniem jest przeciwnie do ruchu 

wskazówek zegara. 
 

 
 

Punkt końcowy pierwszej osi (A), punkt końcowy drugiej osi (B), połowa długości drugiej osi (C), kąt 
początkowy łuku (D) i kąt końcowy (E). 



 

Jednostki punktów 
rysowania 

K R E A T Y W N O Ś C I S P O Ł E C Z N E 115 

 

Jednostka punktowa to pojedyncza lokalizacja o współrzędnych x,y,z sformatowana 

jako pojedyncza kropka lub jako jeden z 19 innych możliwych stylów wyświetlania. 

 

Punkty losowania 

Punkty można rysować pojedynczo lub po kilka naraz. 
 

Aby narysować punkt 

1 Wykonaj jedną z poniższych czynności, aby wybrać Point ( ): 

• Na wstążce wybierz polecenie Rysuj > Punkt. 

• W menu wybierz polecenie Rysuj > Punkt. 

• Na pasku narzędzi Rysuj kliknij narzędzie Punkt. 

• Wpisz point i naciśnij Enter. 

2 Określ lokalizację punktu. 
 

Aby narysować kilka punktów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Point ( ): 

• Na wstążce wybierz polecenie Rysuj > Punkt. 

• W menu wybierz polecenie Rysuj > Punkt. 

• Na pasku narzędzi Rysuj kliknij narzędzie Punkt. 

• Wpisz point i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Wiele punktów. 

3 Określ lokalizację każdego punktu. 

4 W oknie zachęty wybierz Gotowe, aby zakończyć polecenie. 

 
Zmiana rozmiaru i wyglądu jednostek punktowych 

Zmiana rozmiaru i wyglądu jednostek punktów ma wpływ na wszystkie jednostki 

punktów znajdujące się już na rysunku, a także na wszystkie punkty rysowane później. Wartości 

dodatnie reprezentują bezwzględny rozmiar jednostki punktu mierzony w 

jednostkach rysunkowych. Wartości ujemne reprezentują wartość procentową w 

stosunku do ekranu rysowania, dzięki czemu punkty zachowują swój rozmiar 

wizualny po użyciu polecenia Zoom w celu zmiany powiększenia rysunku. 
 

Aby zmienić rozmiar i wygląd jednostek punktowych 

1 Wykonaj jedną z poniższych czynności: 

• Wybierz Format > Styl punktowy. 

• Wpisz ddptype, a następnie naciśnij Enter. 

2 W sekcji Typ wyświetlania punktu wybierz żądany styl. 

3 W sekcji Rozmiar punktu wybierz rozmiar punktu lub wybierz jedną z opcji. 
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4 Kliknij OK. 
 

Po ponownym utworzeniu rysunku wszystkie jednostki punktów zmieniają się, aby 

odzwierciedlić nowy rozmiar i ustawienia wyglądu. 

 

 

 

 

 

 

 

 

 

A 

 
 

B 

 
 
 

C 

 

 
A Aby zwiększyć lub zmniejszyć rozmiar 

punktu, wpisz lub wybierz wartość. 

B Aby użyć jednej ze wstępnie ustawionych 
opcji rozmiaru punktu, kliknij żądaną opcję. 

C Wybierz przycisk odpowiedniego typu 
wyświetlania punktów. 



 

Rysowanie 
promieni 
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Promień to linia w przestrzeni trójwymiarowej, która zaczyna się w punkcie i 

rozciąga się do nieskończoności. Ponieważ promienie rozciągają się do 

nieskończoności, nie są one obliczane jako część zakresów rysowania. Domyślną 

metodą rysowania półprostej jest wybranie punktu początkowego półprostej, a 

następnie określenie jej kierunku. Promień można narysować na jeden z poniższych 

sposobów: 

• Pozioma rysuje promień równolegle do osi x bieżącego układu współrzędnych 

użytkownika (UCS). 

• Vertical rysuje promień równolegle do osi y bieżącego układu UCS. 

• Angle rysuje półprostą równoległą do określonego kąta. 

• Bisect rysuje promień prostopadły do istniejącej jednostki. 

• Parallel rysuje promień równolegle do istniejącej jednostki. 

Aby narysować promień 

1 Wykonaj jedną z poniższych czynności, aby wybrać Raya (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Promień lub Rysuj > Promień. 

• W menu wybierz Rysuj > Promień. 

• Na pasku narzędzi Rysuj kliknij narzędzie Promień. 

• Wpisz ray i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ kierunek. 

4 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
 

Punkt początkowy (A) i kierunek (B). 
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Rysowanie nieskończonych linii 
 

Linia nieskończona to linia przechodząca przez dany punkt, zorientowana pod 

określonym kątem w przestrzeni trójwymiarowej i rozciągająca się do 

nieskończoności w obu kierunkach. Ponieważ linie nieskończone rozciągają się do 

nieskończoności, nie są one obliczane jako część obszarów rysunku. 

Domyślną metodą rysowania nieskończonej linii jest wybranie punktu wzdłuż linii, 

a następnie określenie kierunku linii. Linię nieskończoną można narysować na 

jeden z poniższych sposobów: 

• Pozioma rysuje nieskończoną linię równoległą do osi x bieżącego UCS. 

• Vertical rysuje nieskończoną linię równoległą do osi y bieżącego UCS. 

• Angle rysuje nieskończoną linię równoległą do określonego kąta. 

• Bisect rysuje nieskończoną linię prostopadłą do istniejącej jednostki. 

• Parallel rysuje nieskończoną linię równoległą do istniejącej jednostki. 

Aby narysować nieskończoną linię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Infinite Line (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Linia nieskończona lub Rysuj > Linia 

nieskończona. 

• W menu wybierz polecenie Rysuj > Linia nieskończona. 

• Na pasku narzędzi Rysuj kliknij narzędzie Linia nieskończona. 

• Wpisz infline, a następnie naciśnij Enter. 

2 Określ punkt wzdłuż linii. 

3 Określ kierunek. 

4 Aby zakończyć polecenie, naciśnij klawisz Enter. 
. 

 

Wskaż wzdłuż nieskończonej linii (A) i kierunek (B). 

Można również rysować nieskończone linie pod określonym kątem lub pod kątem 

względem istniejącego elementu. 
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Aby narysować nieskończoną linię pod określonym kątem względem innej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Infinite Line (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Linia nieskończona lub Rysuj > Linia 

nieskończona. 

• W menu wybierz polecenie Rysuj > Linia nieskończona. 

• Na pasku narzędzi Rysuj kliknij narzędzie Linia nieskończona. 

• Wpisz infline, a następnie naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Kąt. 

3 W oknie dialogowym wybierz opcję Odniesienie. 

4 Wybierz podmiot referencyjny. 

5 Określa kąt nieskończonej linii w stosunku do wybranej jednostki. 

6 Określ lokalizację linii nieskończonej. 

7 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
 

Podmiot odniesienia (A) i kąt w stosunku do podmiotu (B). 
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Rysowanie linii konstrukcyjnych 
 

Linia konstrukcyjna to specjalny rodzaj linii nieskończonej, która jest zwykle 

używana, gdy wymagane są szybkie techniki kreślenia, na przykład do tworzenia 

rzutów widoków z przodu i z boku. 

Podobnie jak linia nieskończona, linia konstrukcyjna jest linią przechodzącą przez 

dany punkt, zorientowaną pod określonym kątem w przestrzeni trójwymiarowej i 

rozciągającą się do nieskończoności w obu kierunkach. Ponieważ linie konstrukcyjne 

rozciągają się do nieskończoności, nie są one obliczane jako część obszarów rysunku. 

Linie konstrukcyjne są rysowane automatycznie na własnej warstwie, która 

domyślnie nosi nazwę CLINE. Ułatwia to zmianę wyglądu linii konstrukcyjnych; 

wystarczy zmienić właściwości warstwy, takie jak jej kolor, przezroczystość itp. 

Dodatkowo można określić inną warstwę do lokalizowania linii konstrukcyjnych 

za pomocą zmiennej systemowej CLINELAYER. 

Linie konstrukcyjne można łatwo narysować na jeden z poniższych sposobów: 

• Wybierz punkt wzdłuż linii konstrukcyjnej, a następnie określ kierunek linii 

(domyślna metoda rysowania). 

• Poziomo, pionowo lub w obu kierunkach. 

• Poprzez przecięcie istniejącego punktu, jednostki lub dwóch jednostek. 

• Zgodnie z określonym kątem. 

• Równolegle do istniejącej jednostki lub nad nią. 
 

Linie konstrukcyjne są narysowane tak, aby pasowały do bieżącego UCS. 

Możesz szybko obrócić UCS za pomocą Rysuj > Linia konstrukcyjna > Obróć UCS 

Z i Obróć UCS World (dostępne również na pasku narzędzi Linie konstrukcyjne). 
 

 
Rysowanie linii konstrukcyjnych poprzez określenie punktu bazowego 

Istnieje wiele szybkich sposobów rysowania linii konstrukcyjnych, ale domyślną 

metodą jest określenie punktu bazowego wzdłuż linii konstrukcyjnej, a następnie 

jej kierunku. Za pomocą tej metody można szybko narysować szereg linii 

konstrukcyjnych. 
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Aby narysować linię konstrukcyjną poprzez określenie punktu bazowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Construction Line 

> Array from Basepoint (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Szyk od punktu bazowego. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Szyk od punktu bazowego. 

• Na pasku narzędzi Construction Line kliknij narzędzie Array from Basepoint. 

• Wpisz cline, a następnie naciśnij Enter. 

2 Określ punkt wzdłuż linii. 

3 Określ kierunek. 

4 Aby zakończyć polecenie, naciśnij klawisz Enter. 
. 

 

Wskaż wzdłuż linii konstrukcyjnej (A) i kierunek (B). 
 

Rysowanie linii konstrukcyjnych za pomocą dwusiecznej kąta lub 

elementu Dwusieczna to szybki sposób rysowania linii konstrukcyjnych. Można 

przeciąć dwusieczną określonego kąta lub przeciąć dwusieczną jednej lub dwóch 

linii, łuków lub segmentów polilinii. 

Aby narysować linię konstrukcyjną przez dwusieczną kąta 

1 Wykonaj jedną z następujących czynności, aby wybrać opcję Linia konstrukcyjna > 

Dwusieczna kąta (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Dwusieczna kąta. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Dwusieczna kąta. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Dwusieczna kąta. 

• Wpisz cline, naciśnij Enter, a następnie wybierz Bisect w oknie dialogowym. 

2 Wybierz istniejący punkt wierzchołka, od którego ma zostać odniesiony kąt. 

3 Określa pierwszy punkt kąta przecięcia. 

4 Określa drugi punkt kąta przecięcia. 

5 Aby zakończyć polecenie, naciśnij klawisz Enter. 
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. 

 

Punkt do przecięcia (A), początek kąta przecięcia (B) i 
koniec kąta przecięcia (C). 

Aby narysować linię konstrukcyjną przez przecięcie linii, łuku lub segmentu polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Construction Line > Bisect Entity 

(  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Dwusieczna jednostki. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Dwusieczna jednostki. 

• Na pasku narzędzi Construction Line kliknij narzędzie Bisect Entity. 

• Wpisz cline, naciśnij Enter, wybierz Bisect w oknie podpowiedzi, a następnie 

wybierz Entity w oknie podpowiedzi. 

2 Wybierz linię, łuk lub segment polilinii do przecięcia. 
 

Aby narysować linię konstrukcyjną poprzez przecięcie dwóch linii, łuków lub 
segmentów polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > Dwusieczna 

dwóch obiektów (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Dwusieczna dwóch 

obiektów. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Dwusieczna dwóch obiektów. 

• Na pasku narzędzi Construction Line kliknij narzędzie Bisect Two Entities. 

• Wpisz cline, naciśnij Enter, wybierz Bisect w oknie podpowiedzi, a 

następnie wybierz Two Entities w oknie podpowiedzi. 

2 Wybierz segment linii, łuku lub polilinii. 

3 Wybierz drugi segment linii, łuku lub polilinii. 

 
Rysowanie linii konstrukcyjnych poziomo i pionowo Linie 

konstrukcyjne mogą być rysowane równolegle do osi x bieżącego UCS (poziomo), 

równolegle do osi y bieżącego UCS (pionowo) lub równolegle zarówno do osi x, jak 

i y. 

bieżącego UCS (zarówno poziomego, jak i pionowego). 
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Aby narysować poziomą linię konstrukcyjną 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > Pozioma (

 ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Pozioma. 

• W menu wybierz polecenie Rysuj > Linia konstrukcyjna > Pozioma. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Pozioma. 

• Wpisz cline i naciśnij Enter. 

2 Określ punkt wzdłuż linii. 

3 Aby zakończyć polecenie, naciśnij klawisz Enter. 
. 

 

 

Punkt, przez który ma przechodzić pozioma linia 
konstrukcyjna (A). 

Aby narysować pionową linię konstrukcyjną 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > Pionowa (  

): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Pionowa. 

• W menu wybierz polecenie Rysuj > Linia konstrukcyjna > Pionowa. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Pionowa. 

• Wpisz cline i naciśnij Enter. 

2 Określ punkt wzdłuż linii. 

3 Aby zakończyć polecenie, naciśnij klawisz Enter. 
. 

 

Punkt, przez który ma przechodzić pionowa linia 
konstrukcyjna (A). 
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Rysowanie poziomych i pionowych linii konstrukcyjnych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > 

Pozioma i pionowa (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Poziomo 

i pionowo. 

• W menu wybierz polecenie Rysuj > Linia konstrukcyjna > Poziomo i pionowo. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Zarówno w poziomie, jak i w 

pionie. 

• Wpisz cline i naciśnij Enter. 

2 Określ punkt, w którym przecinają się obie linie konstrukcyjne. 

3 Aby zakończyć polecenie, naciśnij klawisz Enter. 
 

Poziome i pionowe linie konstrukcyjne mogą być również rysowane automatycznie. 

Wybierz polecenie Rysuj > Linia konstrukcyjna > Automatycznie poziomo, 

Automatycznie pionowo lub Automatycznie obie, a następnie zaznacz elementy, 

wokół których chcesz narysować linie konstrukcyjne. Linie konstrukcyjne są 

rysowane automatycznie bez tworzenia duplikatów nakładających się wierzchołków 

lub jednostek. 
 

 
Rysowanie linii konstrukcyjnych poprzez określenie kąta 

Można również rysować linie konstrukcyjne pod określonym kątem lub pod kątem 

względem istniejącej jednostki. 
 

Aby narysować linię konstrukcyjną pod określonym kątem względem innej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > Pod kątem 

(  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Pod kątem. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Pod kątem. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Kąt. 

• Wpisz cline, wybierz Angle, a następnie naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Odniesienie. 

3 Wybierz podmiot referencyjny. 

4 Określa kąt linii konstrukcyjnej w stosunku do wybranej jednostki. 

5 Określ lokalizację linii konstrukcyjnej. 

6 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
 

Podmiot odniesienia (A) i kąt w stosunku do podmiotu (B). 
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Rysowanie linii konstrukcyjnych równoległych do innych podmiotów 

Istnieją dwie opcje rysowania linii konstrukcyjnych, które są równoległe do istniejących 

podmiotów: 

• Przesunięcie Rysuje linię konstrukcyjną równolegle do istniejącej jednostki o 

określoną odległość przesunięcia. 

• Dopasowanie Rysuje linię konstrukcyjną nad istniejącą jednostką. 

Aby narysować linię konstrukcyjną równoległą do innej jednostki i określić 

odległość przesunięcia 

1 Wykonaj jedną z następujących czynności, aby wybrać opcję Linia konstrukcyjna > 

Przesunięcie (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Przesunięcie. 

• W menu wybierz polecenie Rysuj > Linia konstrukcyjna > Przesunięcie. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Przesunięcie. 

• Wpisz cline, wybierz Offset, a następnie naciśnij Enter. 

2 Wprowadź odległość, w jakiej linia konstrukcyjna ma zostać narysowana od jednostki. 

3 Wybierz jednostkę, do której ma być równoległa linia konstrukcyjna. 

4 Wybierz stronę jednostki, na której chcesz narysować linię konstrukcyjną. 

5 Aby zakończyć polecenie, naciśnij klawisz Enter. 
. 

 

Podmiot, który ma być równoległy (A) i bok linii 
konstrukcyjnej (B). 

Aby narysować linię konstrukcyjną równoległą do innej jednostki i określić 

punkt przelotowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linia konstrukcyjna > 

Przesunięcie (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Przesunięcie. 

• W menu wybierz polecenie Rysuj > Linia konstrukcyjna > Przesunięcie. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Przesunięcie. 

• Wpisz cline, wybierz Offset, a następnie naciśnij Enter. 

2 Wybierz Przez punkt. 

3 Wybierz jednostkę, do której ma być równoległa linia konstrukcyjna. 

4 Określ punkt, przez który ma przechodzić linia konstrukcyjna. 

5 Aby zakończyć polecenie, naciśnij klawisz Enter. 
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. 

 

Podmiot, który ma być równoległy (A) i punkt, przez 
który ma przechodzić linia konstrukcyjna (B). 

Aby narysować linię konstrukcyjną równoległą do innej jednostki i odpowiadającą jej 
lokalizacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać Construction Line > On Entity (  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Na jednostce. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Na jednostce. 

• Na pasku narzędzi Construction Line kliknij narzędzie On Entity. 

• Wpisz cline, wybierz Match, a następnie naciśnij Enter. 

2 Wybierz jednostkę, do której ma pasować linia konstrukcyjna. 

3 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
Wymazywanie linii konstrukcyjnych 

Linie konstrukcyjne można usuwać tak samo, jak każdą inną jednostkę, ale istnieją 

dwa narzędzia zaprojektowane w celu ułatwienia ich automatycznego filtrowania 

podczas wybierania ich do usunięcia. 
 

Aby usunąć jedną lub więcej linii konstrukcyjnych 

1 Wykonaj jedną z następujących czynności, aby wybrać opcję Linia konstrukcyjna > Wymaż 

(  ): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Wymaż. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Wymaż. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Wymazywanie. 

• Wpisz cline, wybierz Erase, a następnie naciśnij Enter. 

2 Wybierz jedną lub więcej linii konstrukcyjnych do usunięcia. 

3 Aby zakończyć polecenie, naciśnij klawisz Enter. 
 

Aby usunąć wszystkie linie konstrukcyjne z rysunku 

1 Wykonaj jedną z następujących czynności, aby wybrać kolejno Construction Line > Clear (  

): 

• Na wstążce wybierz polecenie Rysuj > Linia konstrukcyjna > Wyczyść. 

• W menu wybierz Rysuj > Linia konstrukcyjna > Wyczyść. 

• Na pasku narzędzi Linia konstrukcyjna kliknij narzędzie Wyczyść. 

• Wpisz cline, wybierz Clear, a następnie naciśnij Enter. 



 

Rysowanie odręcznych 
szkiców 
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Szkic odręczny składa się z wielu segmentów linii prostych, utworzonych jako 

pojedyncze jednostki linii lub jako polilinia. 

 

Tworzenie szkiców odręcznych 

Przed rozpoczęciem tworzenia szkicu odręcznego należy ustawić długość lub 

przyrost każdego segmentu. Im mniejsze segmenty, tym dokładniejszy szkic, ale zbyt 

małe segmenty mogą znacznie zwiększyć rozmiar pliku 

Po określeniu długości segmentów szkicu krzyżyk zmienia się w narzędzie Ołówek. 

Szkic odręczny nie jest dodawany do rysunku, dopóki nie zostanie "zapisany" w 

rysunku. Oznacza to tymczasowe zapisanie narysowanego segmentu i jego długości 

oraz możliwość kontynuowania szkicowania. 
 

Aby utworzyć szkic odręczny 

1 Wykonaj jedną z poniższych czynności, aby wybrać Freehand (  ): 

• Na wstążce wybierz polecenie Rysuj > Odręcznie. 

• W menu wybierz Rysuj > Odręcznie. 

• Na pasku narzędzi Rysowanie kliknij narzędzie Odręczne. 

• Wpisz odręcznie, a następnie naciśnij Enter. 

2 Określ długość segmentów szkicu. 

3 Kliknij przycisk myszy, aby umieścić narzędzie Ołówek (  ) na rysunku w 

celu rozpoczęcia szkicowania. 

4 Przesuń obraz ołówka, aby narysować tymczasowy szkic odręczny. 

5 Kliknij przycisk myszy, aby podnieść ołówek i zatrzymać szkicowanie. 

6 W oknie zachęty wybierz opcję Zapisz, a następnie wznów, aby zapisać 

tymczasowy szkic odręczny na rysunku. 

7 Kliknij przycisk myszy, aby odłożyć ołówek i wznowić szkicowanie. 

8 Kliknij ponownie przycisk myszy, aby podnieść ołówek i zatrzymać szkicowanie. 

9 W oknie zachęty wybierz Gotowe, aby zapisać tymczasowy szkic odręczny na 

rysunku i zakończyć polecenie. 

 

Szkic odręczny składa się z pojedynczych elementów liniowych lub polilinii. 
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Wymazywanie linii szkicu odręcznego 

Tymczasowe linie szkicu odręcznego, które nie zostały jeszcze naniesione na 

rysunek, można usunąć, wybierając opcję Usuń po wyświetleniu monitu. Ołówek 

zmieni się w narzędzie Gumka. Przesuwając gumkę nad tymczasową linią szkicu 

odręcznego bez klikania przyciskiem myszy, można wymazać fragmenty linii. 
 

Aby usunąć linie szkicu odręcznego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Freehand (  ): 

• Na wstążce wybierz polecenie Rysuj > Odręcznie. 

• W menu wybierz Rysuj > Odręcznie. 

• Na pasku narzędzi Rysowanie kliknij narzędzie Odręczne. 

• Wpisz odręcznie, a następnie naciśnij Enter. 

2 Określ długość segmentów szkicu. 

3 Wybierz punkt na rysunku, aby wyświetlić narzędzie Ołówek i rozpocząć szkicowanie. 

4 Kliknij przycisk myszy, aby podnieść ołówek i zatrzymać szkicowanie. 

5 W oknie dialogowym wybierz opcję Usuń włączone. 

6 Przesuń narzędzie Gumka (  ) na początek lub koniec narysowanej odręcznie 

linii szkicu, a następnie przesuń je wzdłuż linii tak daleko, jak chcesz ją 

wymazać. 

7 Kliknij przycisk myszy, aby odłożyć narzędzie Ołówek i wznowić szkicowanie. 

 
Ustawianie metody szkicowania i dokładności 

Używanie polilinii do szkiców odręcznych ułatwia powrót i edycję szkiców. W 

oknie dialogowym Ustawienia rysowania można określić, czy szkice odręczne mają 

być tworzone przy użyciu segmentów linii czy polilinii. W tym oknie dialogowym 

można również kontrolować długość segmentów szkicu. 
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Aby określić linie lub polilinie podczas szkicowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Wybierz zakładkę Tworzenie podmiotu. 

3 Kliknij kartę Szkice odręczne. 

4 W sekcji Metody szkicowania odręcznego kliknij opcję Polecenie odręczne 

tworzy linie lub Polecenie odręczne tworzy polilinię. 

5 Kliknij przycisk OK. 

 

 

 

 

 

 

 

 

 

 

 

A 

 
 
 

B 

 
 
 
 

A Wybierz metodę szkicowania. B Określ domyślną długość segmentów szkicu. 
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Złożone obiekty obejmują polilinie (w tym prostokąty, kwadraty i wielokąty), 

krzywe splajnowe, pączki i płaszczyzny. Ponadto ALCAD zawiera narzędzia do 

dodawania wymazań, chmur rewizyjnych, linii pomocniczych, kreskowania i 

gradientów do rysunków. 

W niektórych przypadkach istnieje wiele różnych sposobów na utworzenie 

podmiotu. W większości przypadków w tym przewodniku podano jeden lub dwa z nich. 

Aby dowiedzieć się, jak tworzyć podmioty przy użyciu innych metod, zapoznaj się 

z odniesieniem do poleceń w pomocy online. 

Po wpisaniu polecenia rysowania lub wybraniu narzędzia program wyświetla monit 

o wprowadzenie punktów współrzędnych, takich jak punkty końcowe lub punkty 

wstawienia. Podczas rysowania program wyświetla kontekstowe okno zachęty z 

odpowiednimi dodatkowymi opcjami dla typu rysowanej jednostki. 

Po utworzeniu złożonych jednostek można je modyfikować za pomocą narzędzi do 

modyfikacji jednostek. Kilka z tych typów jednostek wymaga specjalnych poleceń 

edycji. 
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Rysowanie prostokątów i kwadratów 
 

Prostokąty to zamknięte polilinie o czterech bokach, a kwadrat to prostokąt o 

czterech równych bokach. 

Prostokąt rysuje się poprzez określenie jego przeciwległych narożników. Prostokąt 

jest zwykle wyrównany równolegle do bieżącego przyciągania i wyrównania siatki, ale 

można użyć opcji Obrócony, aby wyrównać prostokąt pod dowolnym kątem. 

Kwadrat rysuje się za pomocą opcji Kwadrat polecenia Prostokąt. Kwadrat jest 

zwykle wyrównany równolegle do bieżącego przyciągania i wyrównania siatki, ale 

można użyć opcji Obrócony, aby wyrównać kwadrat pod dowolnym kątem. 
 

Aby narysować prostokąt 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Prostokąt (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Prostokąt lub Rysuj > Prostokąt. 

• W menu wybierz polecenie Rysuj > Prostokąt. 

• Na pasku narzędzi Rysuj kliknij narzędzie Prostokąt. 

• Wpisz rectangle i naciśnij Enter. 

2 Określ jeden róg prostokąta. 

3 Określ przeciwległy narożnik prostokąta. 

 

Przeciwległe rogi (A i B) i powstały prostokąt. 

Każdy bok prostokąta można edytować indywidualnie za pomocą narzędzia Edytuj 

polilinię (  ) na pasku narzędzi Modyfikuj. Boki można przekształcić w pojedyncze 

elementy liniowe za pomocą narzędzia Rozbij (  ) na pasku narzędzi Modyfikuj. 

Możesz kontrolować, czy szerokie linie prostokąta są wyświetlane jako wypełnione, 

czy jako kontury za pomocą narzędzia Wypełnienie (  ) na pasku narzędzi 
Ustawienia. 

Do narysowania kwadratu można również użyć narzędzia Prostokąt. Zamiast 

określać przeciwległe narożniki, należy określić długość jednego boku i wyrównanie 

kwadratu. 
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Aby narysować kwadrat 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Prostokąt (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Prostokąt lub Rysuj > Prostokąt. 

• W menu wybierz polecenie Rysuj > Prostokąt. 

• Na pasku narzędzi Rysuj kliknij narzędzie Prostokąt. 

• Wpisz rectangle i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Kwadrat. 

3 Określ jeden róg kwadratu. 

4 Określ długość jednego boku kwadratu, wybierając jego drugi koniec. 

Określony punkt określa zarówno rozmiar, jak i wyrównanie kwadratu. 

 

 

 
 

B  

 
 

Punkty końcowe jednego boku kwadratu (A i B) i wynikowy kwadrat. 
 

Można kontrolować szerokość linii prostokątów. 

Wybierz opcję Szerokość linii w oknie podpowiedzi. Po zmianie szerokości linii, nowe 

ustawienie szerokości będzie obowiązywać dla kolejnych prostokątów, aż do 

ponownej zmiany. 
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Rysowanie wielokątów 
 

Wielokąty to zamknięte polilinie składające się z minimum trzech i maksimum 1024 

boków o równej długości. Domyślną metodą rysowania wielokąta jest określenie 

środka wielokąta i odległości od środka do każdego wierzchołka. Wielokąt można 

narysować przy użyciu dowolnej z poniższych metod: 

• Center-Vertex ( ) 

• Strona środkowa ( ) 

• Edge (  ) 

 

Rysowanie wielokątów według wierzchołków 

Można utworzyć wielokąt o równych bokach zdefiniowany przez jego punkt 

środkowy i odległość do jego wierzchołków. Najpierw należy określić liczbę boków, 

następnie punkt środkowy, a następnie położenie jednego wierzchołka, który określa 

zarówno rozmiar, jak i orientację wielokąta. 
 

Aby narysować wielokąt według wierzchołków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polygon Center-Vertex (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Wierzchołek 

środkowy wielokąta lub Rysuj > Wierzchołek środkowy wielokąta. 

• W menu wybierz polecenie Draw > Polygon > Polygon Center-Vertex. 

• Na pasku narzędzi Rysuj kliknij narzędzie Wielokąt Środek-Wierzchołek. 

• Wpisz polygon i naciśnij Enter. 

2 Wpisz 5, aby określić pięć boków wielokąta. 

3 Określa środek wielokąta. 

4 Określa wierzchołek wielokąta. 

 
 

Środek (A) i wierzchołek (B) oraz wynikowy wielokąt. 
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Rysowanie wielokątów obok siebie 

Można utworzyć wielokąt o bokach równej długości zdefiniowanych przez punkt 

środkowy i odległość do punktu środkowego boku. Najpierw należy określić liczbę 

boków, następnie punkt środkowy, a następnie położenie punktu środkowego 

jednego z boków, co określa zarówno rozmiar, jak i orientację wielokąta. 
 

Aby narysować wielokąt obok siebie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polygon Center-Side (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Środek boku wielokąta 

lub Rysuj > Środek boku wielokąta. 

• W menu wybierz polecenie Rysuj > Wielokąt > Środek boku wielokąta. 

• Na pasku narzędzi Rysuj kliknij narzędzie Środek boku wielokąta. 

• Wpisz polygon i naciśnij Enter. 

2 Wpisz 3, aby określić trzy boki wielokąta. 

3 Określa środek wielokąta. 

4 Określ punkt środkowy boku. 

 
 

Środek (A) i punkt środkowy jednego boku (B) oraz wynikowy wielokąt. 
 

Rysowanie wielokątów poprzez określenie długości krawędzi 

Można utworzyć wielokąt o bokach równej długości zdefiniowanych przez długość 

jednej z krawędzi wielokąta. Najpierw określ liczbę boków, następnie punkt 

początkowy krawędzi, a następnie punkt końcowy krawędzi, który określa zarówno 

rozmiar, jak i orientację wielokąta. 
 

Aby narysować wielokąt, określając długość krawędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Polygon Edge (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Krawędź wielokąta lub Rysuj > 

Krawędź wielokąta. 

• W menu wybierz Rysuj > Wielokąt > Krawędź wielokąta. 

• Na pasku narzędzi Rysuj kliknij narzędzie Krawędź wielokąta. 

• Wpisz polygon i naciśnij Enter. 

2 Wpisz 5, aby określić trzy boki wielokąta. 

3 Określa pierwszy punkt krawędzi wielokąta. 

4 Określa drugi punkt krawędzi wielokąta. 
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Rysowanie 
polilinii 

Punkt początkowy boku (A) i punkt końcowy boku (B) oraz wynikowy wielokąt. 

Każdy bok wielokąta można edytować indywidualnie za pomocą narzędzia Edytuj 
polilinię (  ) na pasku narzędzi Modyfikuj. Boki można przekształcić w pojedyncze 

elementy liniowe za pomocą narzędzia Rozbij (  ) na pasku narzędzi Modyfikuj. 
Możesz kontrolować, czy szerokie linie wielokąta są wyświetlane jako wypełnione, 
czy jako kontury za pomocą narzędzia Wypełnienie (  ) na pasku narzędzi 

Ustawienia. 

 

 

 

 

 
 

Polilinia to połączona sekwencja łuków i linii, która jest traktowana jako pojedynczy 

element. Polilinię można narysować przy użyciu dowolnego typu linii i szerokości, 

która pozostaje stała lub zwęża się na długości dowolnego segmentu. Podczas edycji 

polilinii można modyfikować całą polilinię lub zmieniać poszczególne segmenty. 
 

Zakrzywiona polilinia o zwężającej się szerokości, polilinia z prostymi segmentami i zamknięta polilinia. 
 

Możesz edytować całe polilinie i pojedyncze segmenty za pomocą narzędzia 

Edytuj polilinię (  ) na pasku narzędzi Modyfikuj. Polilinie można przekształcać 

w jednostki łukowe i liniowe za pomocą narzędzia Rozbij (  ) na pasku narzędzi 

Modyfikuj. Możesz kontrolować, czy szerokie polilinie są wyświetlane jako 

wypełnione, czy jako kontury za pomocą narzędzia Wypełnienie (  ) na pasku 
narzędzi Ustawienia. 

 

Rysowanie polilinii z segmentami prostymi 

Po określeniu punktu początkowego polilinii, okno zachęty udostępnia kilka opcji 

podczas rysowania, takich jak Odległość, Połowa szerokości i Szerokość. Można 

określić różne szerokości początkowe i końcowe, aby utworzyć zwężający się 

segment polilinii. 

Po narysowaniu co najmniej jednego segmentu polilinii można użyć narzędzia Cofnij 

(  ), aby usunąć poprzedni segment. Po narysowaniu dwóch lub więcej segmentów 

polilinii, możesz użyć opcji Zamknij, aby zakończyć polecenie poprzez narysowanie 

segmentu, który kończy się w punkcie początkowym pierwszego narysowanego 

segmentu polilinii. Wybierz opcję Gotowe, aby zakończyć polecenie bez zamykania 

polilinii. 
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Aby narysować polilinię z prostymi segmentami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polilinię (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Polilinia lub Rysuj > Polilinia. 

• W menu wybierz polecenie Rysuj > Polilinia. 

• Na pasku narzędzi Rysuj kliknij narzędzie Polilinia. 

• Wpisz polyline i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ punkt końcowy każdego segmentu. 

4 Aby zakończyć polecenie, wybierz Zamknij lub Gotowe. 

 
 

Punkt początkowy polilinii (A) i punkty końcowe segmentów (B). 
 

Rysowanie polilinii z segmentami łuku 

Opcja Rysuj łuki umożliwia ciągłe rysowanie segmentów łukowych do momentu 

wybrania opcji Rysuj linie w celu powrotu do rysowania segmentów liniowych. 

Podczas rysowania segmentów łukowych pierwszy punkt łuku jest punktem 

końcowym poprzedniego segmentu. Domyślnie segmenty łuku rysowane są poprzez 

określenie punktu końcowego każdego segmentu. Każdy kolejny segment łuku jest 

rysowany jako styczny do poprzedniego segmentu łuku lub linii. W przypadku 

wybrania opcji Zamknij podczas rysowania łuków, segment zamykający jest 

tworzony jako łuk. 
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Łuk można również określić przy użyciu jednej z poniższych metod: 

• Punkt początkowy, uwzględniony kąt, punkt środkowy 

• Punkt początkowy, uwzględniony kąt, promień 

• Punkt początkowy, punkt środkowy, punkt końcowy 

• Punkt początkowy, kąt włączenia, punkt końcowy 

• Punkt początkowy, punkt środkowy, uwzględniony kąt 

• Punkt początkowy, punkt środkowy, długość cięciwy 

• Punkt początkowy, kierunek, punkt końcowy 

• Punkt początkowy, promień, uwzględniony kąt 

• Punkt początkowy, drugi punkt, punkt końcowy 

Aby narysować segment linii, po którym następuje segment polilinii łukowej 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polilinię (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Polilinia lub Rysuj > Polilinia. 

• W menu wybierz polecenie Rysuj > Polilinia. 

• Na pasku narzędzi Rysuj kliknij narzędzie Polilinia. 

• Wpisz polyline i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ punkt końcowy. 

4 W oknie dialogowym wybierz opcję Rysuj łuki. 

5 Określa punkt końcowy segmentu łuku. 

6 Aby zakończyć polecenie, wybierz Gotowe. 

 

Punkt początkowy polilinii (A), punkt końcowy linii/ punkt początkowy łuku (B) i punkt końcowy łuku (C). 



 

Rysowanie 
multilinii 
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Linia wielokrotna składa się z wielu równoległych linii (domyślnie dwie linie), które 

składają się z połączonych ze sobą segmentów liniowych. Koniec bieżącego 

segmentu jest początkiem następnego segmentu. Końce segmentów są 

wierzchołkami multilinii. 

 

Rysowanie linii wielowierszowej 

Aby narysować linię wielowierszową 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multiline (  ): 

• Na wstążce wybierz polecenie Rysuj > Wielowiersz. 

• W menu wybierz polecenie Draw > Multiline. 

• Na pasku narzędzi Rysuj kliknij narzędzie Multilinia. 

• Wpisz mline i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ dodatkowe wierzchołki. 

4 Po określeniu ostatniego punktu końcowego wybierz Gotowe lub naciśnij Enter. 

 
 

Wieloliniowy punkt początkowy (A), wierzchołki (B) i punkt końcowy (C). 

 

Określanie uzasadnienia i skali 

Podczas rysowania linii wieloliniowej określa się wierzchołki jednej z linii 

tworzących linię wieloliniową - dodatkowe linie równoległe są rysowane w położeniu 

zgodnym z uzasadnieniem. Wierzchołki można określić na górze, w środku lub na 

dole multilinii, zgodnie z wybranym uzasadnieniem. 

Można również określić ogólną szerokość multilinii, która wpływa na odległość 

między równoległymi liniami, dostosowując skalę multilinii. 

 

UWAGA W przypadku zmiany skali wielowierszowej może być konieczne 

wprowadzenie równoważnych zmian w skali typu linii, aby zapobiec 

nieproporcjonalnemu rozmiarowi kropek lub kresek. 
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Aby narysować multilinię z innym justowaniem lub skalą 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multiline (  ): 

• Na wstążce wybierz polecenie Rysuj > Wielowiersz. 

• W menu wybierz polecenie Draw > Multiline. 

• Na pasku narzędzi Rysuj kliknij narzędzie Multilinia. 

• Wpisz mline i naciśnij Enter. 

2 Wybierz uzasadnienie i wybierz jedną z poniższych opcji: 

• Top Określone wierzchołki definiują górną linię; dodatkowe równoległe 

linie są rysowane poniżej określonych wierzchołków. 

• Zero Określone wierzchołki definiują środek multilinii. 

• Bottom Określone wierzchołki definiują dolną linię; dodatkowe równoległe 

linie są rysowane powyżej określonych wierzchołków. 

3 Wybierz Scale (Skala) i wprowadź nową wartość skali zgodnie z poniższymi wskazówkami: 

• Większa niż 1 - Wielolinie są szersze. 

• Mniej niż 1 - linie wielokrotne są węższe. 

• Równa 1 - wiele linii zwija się w jedną linię. 

• Wartość ujemna - odwraca justowanie podczas rysowania wielu linii i 

zmienia skalę zgodnie z ustawioną wartością. 

4 Określa punkt początkowy multilinii. 

5 Określ dodatkowe wierzchołki. 

6 Po określeniu punktu końcowego wybierz Gotowe lub naciśnij Enter. 
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Praca ze stylami wielowierszowymi 

Po utworzeniu linii wieloliniowej program rysuje ją na bieżącej warstwie przy użyciu 

bieżącego stylu linii wieloliniowej. Każda linia wielokrotna ma odpowiedni styl linii 

wielokrotnej, który kontroluje wygląd linii wielokrotnej, taki jak liczba równoległych 

linii, odstępy między każdą linią oraz kolor i typ linii każdej linii, inicjały i 

zakończenia itp. 

Nazwane style wielowierszowe można tworzyć, zapisywać, modyfikować i usuwać. 

Można również ustawić dowolny styl wielowierszowy jako bieżący, który jest przypisywany do 

nowych wielowierszy podczas dodawania ich do rysunku. Style wielowierszowe 

można eksportować i importować jako pliki .mln, co ułatwia ich udostępnianie 

między komputerami. 

 

Tworzenie lub modyfikowanie stylu wielowierszowego 
Style wielowierszowe umożliwiają zmianę różnych ustawień kontrolujących 

wygląd wielowierszy. Ustawienia te można następnie zapisać do ponownego 

wykorzystania. Jeśli nie zdefiniujesz stylu wielowierszowego przed utworzeniem wielowierszy, 

program użyje standardowego stylu wielowierszowego, który przechowuje 

domyślne ustawienia wielowierszowe. 

Jeśli zmodyfikujesz styl wielowierszowy, wszystkie jednostki wielowierszowe, które 

mają przypisany ten styl, zostaną zaktualizowane. 
 

Aby utworzyć styl wielowierszowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 Kliknij przycisk Nowy. 

3 W polu Nazwa stylu wpisz nazwę nowego stylu wielowierszowego. 

4 W polu Rozpocznij od wybierz istniejący styl wielowierszowy, na którym 

zostanie oparty nowy styl wielowierszowy. 

5 Kliknij przycisk Kontynuuj. 

6 W oknie dialogowym Utwórz nowy styl wielowierszowy dokonaj odpowiednich 

wyborów dla stylu wielowierszowego. 

7 Po zakończeniu kliknij przycisk OK. 
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Aby zmodyfikować styl wielowierszowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 Wybierz styl wielowierszowy, który chcesz zmodyfikować, a następnie kliknij przycisk 

Modyfikuj. 

3 W oknie dialogowym Modyfikuj styl wielowierszowy dokonaj odpowiednich 

wyborów dla stylu wielowierszowego. 

4 When finished, click OK. 

 

 

 
A 

 
 

B 
M

 

C 
D 

E L 
K 
J 

F 
I 

G H 

 
 
 

A Wprowadź opis stylu wielowierszowego. 

B Wybierz, czy ma być dołączana linia 
ograniczająca początek lub koniec multilinii 
przypisanych do tego stylu. 

C Wybierz, czy dołączyć łuk dla linii 
zewnętrznych, aby zamknąć początek lub 
koniec wielu linii przypisanych do tego stylu. 

D Wybierz, czy dołączyć łuk dla linii 
wewnętrznych, aby zamknąć początek lub 
koniec wielu linii przypisanych do tego stylu. 

E Wybierz, czy ma być dodawana linia ukośna 
na początku lub na końcu linii 
wielowierszowych przypisanych do tego 
stylu. 

F Wybierz wypełnienie kolorem dla wielu linii 
przypisanych do tego stylu. 

G Określa, czy w połączeniach multilinii 
przypisanych do tego stylu ma być 
dołączana linia. Jeśli opcja ta jest włączona, 
linia jest rysowana od dwóch zewnętrznych 
wierzchołków połączenia multilinii. 

H Kliknij, aby wybrać typ linii dla elementu. 

I Wybierz kolor linii dla elementu. 

J Wprowadź odległość przesunięcia elementu 
lub linii od poprzedniego elementu. 

K Kliknij, aby dodać nowy element zgodnie 
z bieżącymi ustawieniami przesunięcia, koloru 
i rodzaju linii. 

L Kliknij, aby usunąć wybrany element. 

M Wyświetla listę kombinacji przesunięcia, koloru 
i typu linii przypisanych do każdego elementu lub 
linii. 



K R E A T Y W N O Ś C I K O M P L E K S O W E 143 

 
 

Ustawienie bieżącego stylu wielowierszowego 
Podczas tworzenia linii wielowierszowej jest jej automatycznie przypisywany styl 

linii wielowierszowej ustawiony jako bieżący. Domyślnie program używa 

standardowego stylu wielowierszowego, który przechowuje domyślne ustawienia 

wielowierszowe. Można też wybrać inny styl wielowierszowy jako bieżący. 

W przypadku wybrania innego stylu multilinii jako bieżącego, styl ten zostanie 

przypisany do multilinii tworzonych w przyszłości, a nie do istniejących multilinii. 
 

Aby ustawić styl wielowierszowy jako bieżący 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wielowierszowych wybierz styl wielowierszowy z 

listy. 

3 Kliknij przycisk Ustaw bieżący. 

4 Kliknij przycisk OK. 

 
Przypisywanie stylu do tekstu wielowierszowego 

W dowolnym momencie można przypisać inny styl multilinii do multilinii. 
 

Aby przypisać styl do tekstu wielowierszowego 

1 Wybierz linię wielokrotną na rysunku. 

2 Wykonaj jedną z poniższych czynności: 

• Na pasku narzędzi Style wybierz styl z listy Styl wielowierszowy. 

• Kliknij prawym przyciskiem myszy multilinię, wybierz Właściwości, a następnie w 

obszarze Styl wybierz styl. 

 
Zmiana nazwy stylu wielowierszowego 

Do zmiany nazwy stylu wielowierszowego służy okno dialogowe Menedżer stylów 

wielowierszowych. Należy pamiętać, że nie można zmienić nazwy standardowego 

stylu wielowierszowego. 
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Aby zmienić nazwę stylu wielowierszowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wielowierszowych wybierz styl wielowierszowy, 

którego nazwę chcesz zmienić. 

3 Kliknij przycisk Zmień nazwę. 

4 Wpisz nową nazwę, a następnie kliknij przycisk OK. 

5 Kliknij przycisk OK. 

 
Usuwanie stylu wielowierszowego 
Aby usunąć styl wielowierszowy, należy użyć okna dialogowego Menedżer stylów 

wielowierszowych. Należy pamiętać, że nie można usunąć standardowego stylu 

wielowierszowego, a także używanych stylów wielowierszowych. 
 

Aby usunąć nazwany styl wielowierszowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wielowierszowych wybierz styl wielowierszowy do 

usunięcia. 

3 Kliknij przycisk Usuń. 

4 Aby potwierdzić usunięcie, kliknij OK. 

5 Kliknij przycisk OK. 

 
Importowanie i eksportowanie plików stylów wielowierszowych 

Style wielowierszowe można importować i eksportować jako pliki .mln, co 

ułatwia przenoszenie stylów wielowierszowych między komputerami. 
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Aby wyeksportować plik stylu wielowierszowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wielowierszowych wybierz styl wielowierszowy do 

wyeksportowania. 

3 Kliknij przycisk Eksportuj. 

4 Określ nazwę i lokalizację pliku .mln, a następnie kliknij przycisk Zapisz. 

5 Kliknij przycisk OK. 
 

Aby zaimportować plik stylu wielowierszowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multiline Styles Manager (  ): 

• Na wstążce wybierz kolejno Express Tools > Multiline Styles Manager (w menu Tools). 

• W menu wybierz Format > Menedżer stylów wielowierszowych lub 

wybierz Express Tools > Narzędzia > Menedżer stylów wielowierszowych. 

• Na pasku narzędzi Style kliknij narzędzie Menedżer stylów wielowierszowych. 

• Wpisz mlstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wielowierszowych kliknij przycisk Importuj. 

Okno dialogowe Importuj styl wielowierszowy z pliku wyświetla listę stylów 

wielowierszowych, które zostały już załadowane. 

3 Kliknij Plik. 

4 Przejdź do pliku .mln i wybierz go do zaimportowania, a następnie kliknij przycisk Otwórz. 

5 Kliknij przycisk OK. 
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Rysowanie śladów 
 

Za pomocą polecenia Trace można narysować dwuwymiarową linię ciągłą o 

określonej szerokości. Polecenie Trace nie jest powszechnie używane - 

większość użytkowników korzysta z polecenia Polyline. 
 

Aby narysować ślad 

1 Wpisz trace i naciśnij Enter. Lub na wstążce wybierz polecenie Rysuj > Śledź. 

2 Określa szerokość śladu. 

3 Określ punkt początkowy. 

4 Określ dodatkowe wierzchołki. 

5 Po określeniu ostatniego punktu końcowego wybierz Gotowe lub naciśnij Enter. 

 
 

Punkt początkowy śledzenia (A), wierzchołki (B) i punkt końcowy (C). 



 

Rysowanie 
splajnów 
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Splajn to gładka krzywa zdefiniowana przez zestaw punktów. Za pomocą splajnów 

można tworzyć rzeźbione kształty, takie jak przekrój łopatki turbiny lub skrzydła 

samolotu. 
 

Aby narysować splajn 

1 Wykonaj jedną z poniższych czynności, aby wybrać Spline (  ): 

• Na wstążce wybierz polecenie Rysuj > Splajn. 

• W menu wybierz polecenie Rysuj > Splajn. 

• Na pasku narzędzi Rysuj kliknij narzędzie Splajn. 

• Wpisz spline i naciśnij Enter. 

2 Określa pierwszy punkt splajnu. 

3 Określa drugi punkt splajnu. 

4 Podaj dowolną liczbę dodatkowych punktów. 

5 Po zakończeniu naciśnij klawisz Enter. 
 

Do splajnu można dodać styczne, czyli linie nadające mu kształt. 
 

Aby dodać styczne do splajnu 

1 Określa początkowy punkt styczny. 

2 Określ końcowy punkt styczny. 

 
 

Początkowy splajn i wynikowy splajn z początkowym punktem stycznym (A) i końcowym punktem stycznym 
(B). 

 

Określanie tolerancji dopasowania 

Domyślnie splajn przechodzi przez wszystkie punkty kontrolne. Podczas rysowania 

splajnu można to zmienić, określając tolerancję dopasowania. Wartość tolerancji 

dopasowania określa stopień dopasowania splajnu do określonego zestawu punktów. Na 

przykład wartość tolerancji dopasowania splajnu równa 0 powoduje, że splajn 

przechodzi przez punkty kontrolne. Wartość 0,01 tworzy splajn, który przechodzi przez 

punkt początkowy i końcowy oraz w odległości 0,01 jednostki od pośrednich 

punktów kontrolnych. 
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Aby określić tolerancję dopasowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Spline (  ): 

• Na wstążce wybierz polecenie Rysuj > Splajn. 

• W menu wybierz polecenie Rysuj > Splajn. 

• Na pasku narzędzi Rysuj kliknij narzędzie Splajn. 

• Wpisz spline i naciśnij Enter. 

2 Określa pierwszy punkt splajnu. 

3 Określa drugi punkt splajnu. 

4 W oknie dialogowym wybierz opcję Tolerancja dopasowania. 

5 Aby zaakceptować domyślną wartość 0.0000, naciśnij Enter. 

Aby określić inną tolerancję dopasowania, wpisz liczbę, a następnie naciśnij klawisz Enter. 

6 Określ dodatkowe punkty potrzebne do narysowania splajnu lub zamkniętego 

splajnu. 

 
Rysowanie zamkniętego splajnu 

Można narysować splajn zamknięty, czyli splajn, dla którego punkt początkowy i 

końcowy są takie same. Ponieważ splajn jest zamknięty, można określić tylko jedną 

styczną. 
 

Aby narysować zamknięty splajn 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Spline (  ): 

• Na wstążce wybierz polecenie Rysuj > Splajn. 

• W menu wybierz polecenie Rysuj > Splajn. 

• Na pasku narzędzi Rysuj kliknij narzędzie Splajn. 

• Wpisz spline i naciśnij Enter. 

2 Określa pierwszy punkt splajnu. 

3 Określa drugi punkt splajnu. 

4 Podaj dowolną liczbę dodatkowych punktów. 

5 Po zakończeniu w oknie zachęty wybierz opcję Zamknij. 

6 Aby zakończyć polecenie, określ punkt styczny. 

 
 

Punkt początkowy i punkt końcowy (A) zamkniętego splajnu. 



 

Rysowanie 
heliksów 
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Spirala to trójwymiarowa spirala, która jest otwarta na obu końcach. Podstawa i 

wierzchołek mogą mieć równe wartości, podobnie jak w przypadku cewki lub 

sprężyny, lub mogą mieć różne wartości, podobnie jak w przypadku stożka. 

 

Helice są często używane do tworzenia innych jednostek. 

W szczególności polecenia Sweep, Loft i Revolve mogą być używane ze spiralami w 

bardziej złożonych rysunkach do tworzenia spiralnych schodów, spiralnych części i 

nie tylko. 
 

 
Aby narysować helisę 

1 Wykonaj jedną z poniższych czynności, aby wybrać Helix (  ): 

• Na wstążce wybierz polecenie Rysuj > Spirala. 

• W menu wybierz polecenie Draw > Helix. 

• Na pasku narzędzi Rysuj kliknij narzędzie Spirala. 

• Wpisz helix i naciśnij Enter. 

2 Określ punkt środkowy helisy. 

3 Określa promień (lub średnicę) dolnej części spirali. 

4 Określa promień (lub średnicę) górnej części spirali. 

5 Opcjonalnie można ustawić jedną z poniższych opcji: 

• Turns Określa liczbę pełnych obrotów. Domyślna liczba obrotów to trzy. 

Maksymalna liczba to 500. 

• Wysokość obrotu Określa wysokość jednego pełnego obrotu, która 

automatycznie aktualizuje liczbę obrotów. Ta opcja jest dostępna tylko 

wtedy, gdy nie określono liczby obrotów. 

• Twist Określ kierunek obrotów spirali: zgodnie z ruchem wskazówek zegara 

(CW) lub przeciwnie do ruchu wskazówek zegara (CCW). 

6 Określ wysokość i położenie helisy, wybierając jedną z poniższych opcji: 

• Wybierz Punkt końcowy osi i określ punkt końcowy spirali, który określa 

położenie i kierunek spirali. 

• Określa wysokość spirali. Jeśli wysokość wynosi zero, spirala będzie 

dwuwymiarowa, ale jeśli promień początkowy i końcowy są takie same, 

będzie wyglądać jak okrąg. 
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Punkt środkowy spirali (A), promień dolny (B), promień górny (C) i wysokość (D). 

 

 

Rysowanie pączków 
 

Pączki to pełne, wypełnione okręgi lub pierścienie tworzone jako zamknięte, 

szerokie polilinie. Bączek można narysować przy użyciu jednej z kilku metod. 

Domyślną metodą jest określenie wewnętrznej i zewnętrznej średnicy bączka, a 

następnie określenie jego środka. Następnie można utworzyć wiele kopii tego 

samego bączka, określając różne punkty środkowe, aż do naciśnięcia klawisza 

Enter w celu zakończenia polecenia. 
 

Aby narysować pączka 

1 Wykonaj jedną z poniższych czynności, aby wybrać Donut (  ): 

• Na wstążce wybierz polecenie Draw > Donut. 

• W menu wybierz Rysuj > Pączek. 

• Na pasku narzędzi Rysuj kliknij narzędzie Pączek. 

• Wpisz donut i naciśnij Enter. 

2 Określ średnicę wewnętrzną pączka. 

3 Określ zewnętrzną średnicę pączka. 

4 Określ środek pączka. 

5 Określ punkt środkowy, aby narysować kolejny pączek, lub wybierz Gotowe, 

aby zakończyć polecenie. 
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Średnica wewnętrzna (A) i zewnętrzna (B). 

Pole zachęty zawiera dodatkowe opcje rysowania bączków. Można na przykład 

określić szerokość pączka i dwa punkty na średnicy pączka lub określić szerokość i 

trzy punkty na pączku. Można również narysować pączek w sposób oplatający 

istniejące obiekty. 

 

Pączek może być całkowicie wypełnionym okręgiem. 

Pączki są całkowicie wypełnione, jeśli ich średnica wewnętrzna wynosi zero. 
 

 
Aby narysować pączek styczny do istniejących jednostek 

1 Wykonaj jedną z poniższych czynności, aby wybrać Donut (  ): 

• Na wstążce wybierz polecenie Draw > Donut. 

• W menu wybierz Rysuj > Pączek. 

• Na pasku narzędzi Rysuj kliknij narzędzie Pączek. 

• Wpisz donut i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Styczna promienia. 

3 Określ szerokość pączka. 

4 Określ średnicę pączka. 

5 Wybierz pierwszą styczną jednostkę, do której ma zostać narysowany pączek. 

6 Wybierz drugą styczną jednostkę, do której ma zostać narysowany pączek. 

 
 

Szerokość (A) i średnica (B) pączka oraz jednostki styczne (C). 
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Pączki można edytować za pomocą narzędzia Edytuj polilinię (  ) na pasku 
narzędzi Modyfikuj. Pączki można przekształcać w elementy łukowe za pomocą 

narzędzia Rozbij (  ) na pasku narzędzi Modyfikuj. Za pomocą narzędzia 

Wypełnienie (  ) na pasku narzędzi Ustawienia można kontrolować, czy pączki są 
wyświetlane jako wypełnione, czy jako kontury. 

 

Można kontrolować domyślną średnicę zewnętrzną i wewnętrzną pączków. 

Wybierz Narzędzia > Ustawienia rysowania, kliknij zakładkę Tworzenie jednostek i 

wybierz odpowiednie opcje. 
 

 

 

Tworzenie płaszczyzn 
 

Narzędzie Płaszczyzna umożliwia rysowanie prostokątnych, trójkątnych lub 

czworokątnych obszarów wypełnionych jednolitym kolorem. Domyślną metodą jest 

określenie narożników płaszczyzny. Po określeniu pierwszych dwóch narożników 

płaszczyzna jest wyświetlana w miarę określania pozostałych narożników. Punkty 

narożne należy określić w sposób trójkątny. Program wyświetli monit o podanie 

trzeciego, a następnie czwartego punktu. Jeśli będziesz kontynuować określanie 

punktów, monity o trzeci i czwarty punkt będą się przełączać do momentu 

naciśnięcia klawisza Enter w celu zakończenia polecenia. 

Tworzenie płaszczyzn w ALCAD jest podobne do polecenia Solid w AutoCAD. 
 

Aby narysować czworokąt na płaszczyźnie 

1 Wykonaj jedną z poniższych czynności, aby wybrać płaszczyznę (  ): 

• Na wstążce wybierz polecenie Rysuj > Płaszczyzna. 

• W menu wybierz Rysuj > Płaszczyzna. 

• Na pasku narzędzi Rysuj kliknij narzędzie Płaszczyzna. 

• Wpisz plane i naciśnij Enter. 

2 Określ pierwszy punkt. 

3 Określ drugi punkt. 

4 Określ trzeci punkt. 

5 Określ czwarty punkt. 

6 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
 

Po wybraniu pierwszych dwóch punktów (A) i (B), kolejność wyboru trzeciego (C) i 
czwartego (D) punktu określa kształt wynikowej płaszczyzny czworokąta. 
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Okno podpowiedzi zawiera dodatkowe opcje rysowania płaszczyzn. Można na 

przykład rysować płaszczyzny prostokątne, kwadratowe lub trójkątne. 

 

Aby narysować prostokątną płaszczyznę 

1 Wykonaj jedną z poniższych czynności, aby wybrać płaszczyznę (  ): 

• Na wstążce wybierz polecenie Rysuj > Płaszczyzna. 

• W menu wybierz Rysuj > Płaszczyzna. 

• Na pasku narzędzi Rysuj kliknij narzędzie Płaszczyzna. 

• Wpisz plane i naciśnij Enter. 

2 Wybierz opcję Prostokąt. 

3 Określ pierwszy punkt. 

4 Określ przeciwległy narożnik. 

5 Określa kąt obrotu. 

6 Aby zakończyć polecenie, wskaż przeciwległy narożnik w celu narysowania 

kolejnego prostokąta lub naciśnij klawisz Enter. 

 
 

Przeciwległe narożniki (A i B) i kąt obrotu (C) oraz wynikowa płaszczyzna. 

Za pomocą narzędzia Wypełnienie można kontrolować, czy płaszczyzny są wyświetlane jako 

wypełnione, czy jako kontury 

(  ) na pasku narzędzi Ustawienia. Płaszczyzny można konwertować na 
pojedyncze elementy liniowe odpowiadające obrysowi płaszczyzny za pomocą 
narzędzia Rozbij (  ) na pasku narzędzi Modyfikuj. 

 

 

Wymazywanie rysunków 
 

Wymazania są unikalnymi elementami, które mogą pomóc ukryć obszary rysunku. 

Nie grają one z bieżącym kolorem tła, więc szczegóły za wymazaniem nie są odtwarzane 

ani drukowane. 

Wipeouty są podobne do innych jednostek - można je kopiować, tworzyć ich 

lustrzane odbicia, układać, wymazywać, obracać i skalować, a także używać ich 

zarówno w przestrzeni modelu, jak i w przestrzeni papieru. 
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Jeśli chcesz wydrukować elementy wymazywania znajdujące się na rysunku, musisz 

wydrukować je na drukarce obsługującej rasę. Należy pamiętać, że w niektórych 

przypadkach drukowanie rysunków zawierających elementy wymazywania może 

przynieść nieoczekiwane rezultaty, na przykład w przypadku drukowania na 

kolorowym papierze. 

Wipeouty są tworzone przy użyciu istniejących wielokątów, zamkniętych polilinii 

o zerowej szerokości składających się wyłącznie z segmentów linii lub nowych 

polilinii narysowanych podczas korzystania z polecenia Wipeout. 

 

Wyświetlanie wymazań różni się w zależności od wersji programu ALCAD. 

Jeśli wersja programu ALCAD nie zawiera funkcji obrazu rastrowego, wyświetlane 

są jednostki wymazania, ale wyświetlane są również szczegóły za wymazaniami. 
 

 
Rysunek wymazania 

Aby narysować wymazanie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Wipeout (  ): 

• Na wstążce wybierz polecenie Adnotacje > Wymaż (w obszarze Znaczniki). 

• W menu wybierz Draw > Wipeout. 

• Na pasku narzędzi Rysuj kliknij narzędzie Wipeout. 

• Wpisz wipeout i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Określ punkt końcowy każdego segmentu. 

4 Po określeniu ostatniego punktu końcowego wybierz Gotowe lub naciśnij Enter. 

 
 

Istniejący rysunek. Rysunek z wymazaniem. 
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Tworzenie wymazania przy użyciu istniejących wielokątów i polilinii 

Aby utworzyć wymazanie przy użyciu istniejącego wielokąta lub polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Wipeout (  ): 

• Na wstążce wybierz polecenie Adnotacje > Wymaż (w obszarze Znaczniki). 

• W menu wybierz Draw > Wipeout. 

• Na pasku narzędzi Rysuj kliknij narzędzie Wipeout. 

• Wpisz wipeout i naciśnij Enter. 

2 Wybierz Polilinia. 

3 Wybierz zamkniętą polilinię, która ma zostać użyta do wymazania. 

4 Wybierz jedną z poniższych opcji: 

• Tak - tworzy wymazanie i usuwa polilinię użytą do jego utworzenia. 

• Nie - tworzy wymazanie i zachowuje polilinię użytą do jego utworzenia. 

 

Włączanie lub wyłączanie ramek wymazywania 

Każde wymazanie ma ramkę wzdłuż swojej granicy. Ramki wycierania można 

włączyć lub wyłączyć dla dowolnego rysunku. Gdy ramki wycierania są włączone, 

można wybierać i modyfikować wycierania. Ramki wycierania mogą być 

wyłączone, gdy nadejdzie czas drukowania. 
 

Aby włączyć lub wyłączyć ramki wymazywania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Wipeout (  ): 

• Na wstążce wybierz polecenie Adnotacje > Wymaż (w obszarze Znaczniki). 

• W menu wybierz Draw > Wipeout. 

• Na pasku narzędzi Rysuj kliknij narzędzie Wipeout. 

• Wpisz wipeout i naciśnij Enter. 

2 Wybierz Ramki. 

3 Wybierz Włączone lub Wyłączone. 

 

Ramki  Wipeout włączone.Ramki  Wipeout wyłączone. 
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Rysowanie chmur rewizyjnych 
 

Chmury poprawek to kształty chmur, które oznaczają obszary rysunku wymagające 

dalszej uwagi. Są one szczególnie pomocne podczas poprawiania rysunku; dodaj 

chmurkę poprawek do każdego zmodyfikowanego obszaru, aby recenzenci mogli 

łatwo znaleźć zmiany. 

Chmury rewizji są poliliniami, więc można z nimi pracować i modyfikować je w taki 

sam sposób, jak polilinie: przesuwać, kopiować, odbijać i skalować całą chmurę 

rewizji lub wybierać i przesuwać poszczególne wierzchołki, aby dostosować łuki 

tworzące chmurę rewizji. 

 

Rysowanie chmury wersji 

Rysowanie chmury rewizji jest proste: wystarczy wybrać punkt początkowy i przesunąć mysz. 
 

Aby narysować chmurę wersji 

1 Wykonaj jedną z poniższych czynności, aby wybrać Revision Cloud (  ): 

• Na wstążce wybierz polecenie Adnotacje > Chmura wersji (w sekcji Znaczniki). 

• W menu wybierz Rysuj > Chmura wersji. 

• Na pasku narzędzi Rysuj kliknij narzędzie Chmura wersji. 

• Wpisz revcloud i naciśnij Enter. 

2 Określ punkt początkowy. 

3 Przesuń mysz, okrążając żądany obszar. 

Po powrocie do punktu początkowego polecenie chmury rewizji kończy się 

automatycznie. 

 
 

 

Wybierz punkt początkowy (A), a następnie 
przesuń mysz wokół żądanego obszaru i z 
powrotem w kierunku punktu początkowego 
(A). 

Wynikowa chmura rewizji. 

 
 

 

Edytuj chmury rewizji tak samo jak polilinię. 

Zaznacz chmurę rewizji i przesuń jej wierzchołki lub użyj narzędzia Edytuj polilinię (

 ) na pasku narzędzi Modyfikuj. 
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Tworzenie chmury wersji przy użyciu istniejących jednostek 

Oprócz rysowania nowych chmur rewizji, można także konwertować istniejące 

jednostki - linie, łuki, okręgi, polilinie 2D i splajny - na chmury rewizji. 
 

Aby utworzyć chmurę wersji przy użyciu istniejącej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Revision Cloud (  ): 

• Na wstążce wybierz polecenie Adnotacje > Chmura wersji (w sekcji Znaczniki). 

• W menu wybierz Rysuj > Chmura wersji. 

• Na pasku narzędzi Rysuj kliknij narzędzie Chmura wersji. 

• Wpisz revcloud i naciśnij Enter. 

2 Wybierz podmiot. 

3 Wybierz istniejącą linię, łuk, okrąg, polilinię 2D lub splajn do konwersji. 

4 Wybierz, czy chcesz odwrócić kierunek poszczególnych łuków chmury wersji. 

Wybierz Nie, aby zachować łuki skierowane do wewnątrz. Wybierz Yes, by 

odwrócić łuki tak, by były skierowane na zewnątrz. 

Tworzona jest chmura rewizji, a wybrana jednostka pozostaje lub jest usuwana w 

zależności od ustawienia zmiennej systemowej DELOBJ. 

 

Dostosowywanie domyślnych ustawień chmury wersji 

Wszystkie chmury rewizji są rysowane przy użyciu ustawień domyślnych, które można 

dostosować: 

• Minimalna długość łuku - Poszczególne łuki tworzące chmurę rewizji mogą być 

mniejsze lub większe poprzez ustawienie minimalnej długości łuku. 

• Maksymalna długość łuku - Poszczególne łuki tworzące chmurę rewizji mogą 

być mniejsze lub większe poprzez ustawienie maksymalnej długości łuku. 

• Styl - Chmury rewizyjne mogą wyglądać tak, jakby zostały narysowane 

zwykłym piórem lub piórem do kaligrafii. 

Tylko nowe chmury rewizji będą rysowane z nowymi ustawieniami. Nie ma to 

wpływu na istniejące chmury rewizji. 
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Aby dostosować ustawienia chmury wersji 

1 Wykonaj jedną z poniższych czynności, aby wybrać Revision Cloud (  ): 

• Na wstążce wybierz polecenie Adnotacje > Chmura wersji (w sekcji Znaczniki). 

• W menu wybierz Rysuj > Chmura wersji. 

• Na pasku narzędzi Rysuj kliknij narzędzie Chmura wersji. 

• Wpisz revcloud i naciśnij Enter. 

2 Wybierz długość łuku. 

3 Wprowadź minimalną długość poszczególnych łuków tworzących chmurę 

rewizji, a następnie naciśnij Enter. 

4 Wprowadź maksymalną długość poszczególnych łuków tworzących chmurę 

rewizji, a następnie naciśnij Enter. Wartość nie może być większa niż 

trzykrotność minimalnej długości łuku. 
 

Długości łuków mogą być również skalowane. 

Ustawienie zmiennej systemowej DIMSCALE również wpływa na długość łuku. 
 

5 Wybierz Styl i wybierz jedną z poniższych opcji: 

• Normalny - rysuje nowe chmury rewizji tak, jakby były rysowane zwykłym piórem. 

• Kaligrafia - rysuje nowe chmury wersji tak, jakby zostały narysowane piórem 

kaligraficznym. 



 

 
Próbka 

 

Dodawanie liderów 
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Multileadery składają się z segmentów linii lub krzywej splajnu, które łączą element 

na rysunku z tekstem wielowierszowym lub blokiem. Zazwyczaj w pierwszym 

punkcie umieszczany jest grot strzałki, a tekst wielowierszowy lub blok jest 

umieszczany bezpośrednio obok ostatniego punktu. Linie łączące można również 

umieszczać poziomo między linią odniesienia a zawartością (tekstem 

wielowierszowym lub blokiem). 

 

Tworzenie mutilatorów 

Domyślnie podczas tworzenia multileadera zawiera on strzałkę, segmenty linii i 

tekst wielowierszowy w punkcie końcowym. Można jednak wybrać splajn zamiast 

segmentów linii i blok (lub nic) zamiast tekstu wielowierszowego. 

Dostępnych jest także więcej opcji. Po uruchomieniu polecenia Multi-lider należy 

użyć podpowiedzi Multileader. Aby uzyskać większą kontrolę nad formatem, użyj 

stylów multileadera. Aby uzyskać więcej informacji, zobacz "Praca ze stylami 

multileadera" na stronie 163 w tym rozdziale. 
 

Aby utworzyć multileader zawierający tekst wielowierszowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multileader (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Multileader (w obszarze Liderzy). 

• W menu wybierz Wymiary > Multileader. 

• Na pasku narzędzi Multileader kliknij narzędzie Multileader. Lub na pasku 

narzędzi Wymiarowanie kliknij narzędzie Multileader. 

• Wpisz mleader i naciśnij Enter. 

2 Określa punkt początkowy multileadera. 

3 Określa punkt końcowy segmentu linii wieloprzewodowej. 

4 Określa dodatkowe punkty końcowe segmentu linii wieloliniowej, jeśli 

maksymalna liczba punktów jest większa niż dwa. 

5 Po określeniu ostatniego punktu końcowego naciśnij klawisz Enter. 

6 W edytorze tekstu wielowierszowego wpisz adnotację. 

7 Po zakończeniu kliknij poza edytorem tekstu wielowierszowego. 

 
 

Określ punkt początkowy multileadera (A) i punkt końcowy multileadera (B). Następnie 
wpisz tekst wielowierszowy (C). 
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Aby utworzyć multileader zawierający blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multileader (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Multileader (w obszarze Liderzy). 

• W menu wybierz Wymiary > Multileader. 

• Na pasku narzędzi Multileader kliknij narzędzie Multileader. Lub na pasku 

narzędzi Wymiarowanie kliknij narzędzie Multileader. 

• Wpisz mleader i naciśnij Enter. 

2 Wybierz Opcje, wybierz Typ zawartości, a następnie wybierz Blokuj. 

3 Wpisz nazwę bloku, który ma zostać dołączony na końcu multileadera, a 

następnie naciśnij klawisz Enter. 

4 Wybierz Wyjdź. 

5 Określa punkt początkowy multileadera. 

6 Określa punkt końcowy segmentu linii wieloprzewodowej. 

7 Określa dodatkowe punkty końcowe segmentu linii wieloliniowej, jeśli 

maksymalna liczba punktów jest większa niż dwa. 

8 Po określeniu ostatniego punktu końcowego naciśnij klawisz Enter. 

 
 

Określ punkt początkowy multileadera (A) i punkt końcowy multileadera (B). Określony blok 
zostanie narysowany automatycznie. 

Aby utworzyć multileader, który nie zawiera tekstu wielowierszowego lub bloku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multileader (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Multileader (w obszarze Liderzy). 

• W menu wybierz Wymiary > Multileader. 

• Na pasku narzędzi Multileader kliknij narzędzie Multileader. Lub na pasku 

narzędzi Wymiarowanie kliknij narzędzie Multileader. 

• Wpisz mleader i naciśnij Enter. 

2 Wybierz Opcje, wybierz Typ zawartości, a następnie wybierz Brak. 

3 Wybierz Wyjdź. 

4 Określa punkt początkowy multileadera. 

5 Określa punkt końcowy segmentu linii wieloprzewodowej. 
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6 Określa dodatkowe punkty końcowe segmentu linii wieloliniowej, jeśli 

maksymalna liczba punktów jest większa niż dwa. 

7 Po określeniu ostatniego punktu końcowego naciśnij klawisz Enter. 

 
 

Określ punkt początkowy multileadera (A) i punkt końcowy multileadera (B). 

Aby określić opcje dla multileadera przed jego utworzeniem 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Multileader (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Multileader (w obszarze Liderzy). 

• W menu wybierz Wymiary > Multileader. 

• Na pasku narzędzi Multileader kliknij narzędzie Multileader. Lub na pasku 

narzędzi Wymiarowanie kliknij narzędzie Multileader. 

• Wpisz mleader i naciśnij Enter. 

2 Wybierz Opcje, a następnie jedną z poniższych opcji: 

• Typ linii prowadzącej Wybierz, czy typ linii prowadzącej to prosta, splajn, 

czy bez linii prowadzącej. 

• Lądowanie lidera Wybierz, czy linia lądowania ma być umieszczana 

poziomo między liderem a treścią tekstową lub blokową. 

• Typ zawartości Wybierz, czy multileader z tym stylem zawiera tekst 

wielowierszowy, blok, czy żaden z nich. 

• Maxpoints Wybierz, aby wprowadzić liczbę maksymalnych punktów dla linii 

prowadzącej. 

• Pierwszy kąt Wybierz, aby określić kąt wiązania pierwszego segmentu linii. 

• Drugi kąt Wybierz, aby określić kąt wiązania drugiego segmentu linii. 

3 Po zakończeniu wybierz Exit, a następnie kontynuuj tworzenie multileadera. 

 

Więcej opcji multileadera można określić za pomocą stylów multileadera. 

Więcej informacji można znaleźć w sekcji "Praca ze stylami wielopoziomowymi" na stronie 163 

w tym rozdziale. 
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Dodawanie i usuwanie linii prowadzących z multileaderów 

Do każdego multileadera może być dołączona więcej niż jedna linka prowadząca. 
 

Aby dodać linie prowadzące do multileadera 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dodaj linie prowadzące (  ): 

• Na wstążce wybierz polecenie Adnotacje > Dodaj linie prowadzące (w obszarze Linie 

prowadzące). 

• Na pasku narzędzi Multileader kliknij narzędzie Dodaj linie prowadzące. 

• Wpisz aimmleaderadd i naciśnij Enter. 

2 Wybierz żądany multileader. 

3 Wybierz lokalizację grotu strzałki dla nowego lidera. 

4 Kontynuuj wybieranie punktów, aby dodać dodatkowe linie prowadzące, a 

następnie naciśnij Enter po zakończeniu. 
 

Aby usunąć linie prowadzące z multileadera 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Usuń linie prowadzące (  ): 

• Na wstążce wybierz polecenie Adnotacje > Usuń linie prowadzące (w obszarze Linie 

prowadzące). 

• Na pasku narzędzi Multileader kliknij narzędzie Usuń linie prowadzące. 

• Wpisz aimmleaderremove i naciśnij Enter. 

2 Wybierz podmioty, które mają zostać uwzględnione w zestawie wyboru do usuwania 

liderów. 

3 Wybierz linię prowadzącą do usunięcia. 

4 Kontynuuj wybieranie linii prowadzących do usunięcia, a następnie naciśnij Enter po 

zakończeniu. 

 
Wyrównywanie pozycji wielu liderów 

Wyrównywanie i rozmieszczanie multileaderów jest łatwe. Można także zbierać 

multileadery i umieszczać je w jednym miejscu. Należy pamiętać, że multileadery z 

zawartością blokową mogą być łączone, ale nie multileadery z zawartością 

tekstową. 
 

Aby dostosować wielu liderów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Align Multileader (  ): 

• Na wstążce wybierz polecenie Adnotacje > Wyrównaj wiele elementów wiodących (w 

elementach wiodących). 

• Na pasku narzędzi Multileader kliknij narzędzie Wyrównaj Multileader. 

• Wpisz mleaderalign i naciśnij Enter. 

2 Wybierz multileadery do wyrównania, a następnie naciśnij klawisz Enter. 

3 Wybierz opcje, jeśli chcesz dostosować wyrównanie, a następnie wybierz jedną z 

poniższych opcji: 

• Rozmieszczanie bloku Places multileader lub zawartości tekstowej między 

dwoma wybranymi punktami. 

• Make Leader Segments Parallel Umieszcza blok wieloliniowy lub zawartość 



tekstową w miejscu, w którym ostatnie segmenty linii prowadzącej będą 

równoległe. 



K R E A T Y W N O Ś C I K O M P L E K S O W E 163 

 

• Specify Spacing Umieszcza bloki wieloliniowe lub zawartość tekstową 

zgodnie z określonymi odstępami. 

• Użyj bieżących odstępów Umieszcza blok wielowierszowy lub zawartość 

tekstową zgodnie z wcześniej określonymi bieżącymi odstępami. 

Poniższe monity są wyświetlane dla opcji Distribute, która jest opcją domyślną. 

4 Wybierz punkt początkowy, który ma być używany do dystrybucji bloku multileadera lub 

zawartości tekstowej. 

5 Wybierz punkt końcowy, który ma być używany do dystrybucji bloku 

multileadera lub zawartości tekstowej. Zawartość zostanie wyrównana i 

rozmieszczona między dwoma punktami. 

Aby zebrać multileadery zawierające bloki w wierszu lub kolumnie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Collect Multileader (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Zbierz wielu liderów (w obszarze 

Liderzy). 

• Na pasku narzędzi Multileader kliknij narzędzie Collect Multileader. 

• Wpisz mleadercollect i naciśnij Enter. 

2 Wybierz multileaderów do zebrania, a następnie naciśnij Enter. 

3 Wybierz, w jaki sposób chcesz gromadzić i dostosowywać zawartość dla wielu liderów: 

• Miejsca poziome gromadzą wielu liderów w poziomie. 

• Miejsca pionowe gromadzą wielu liderów w pionie. 

• Wrap Zawija zebrane multileadery zgodnie z określoną szerokością i liczbą na 

wiersz. 

4 Określ lewy górny róg nowej lokalizacji dla wybranych multileaderów. 

 
Praca ze stylami wielu liderów 

Po utworzeniu multileadera program rysuje go na bieżącej warstwie przy użyciu 

bieżącego stylu multileadera. Każdy multileader ma odpowiadający mu styl 

multileadera, który kontroluje wygląd multileadera, taki jak typ grotu strzałki, styl 

tekstu, kolory i inne. 

Można tworzyć, zapisywać, modyfikować i usuwać nazwane style multileadera, a 

także ustawić dowolny styl multileadera jako bieżący, który jest przypisywany do 

nowych multileaderów podczas dodawania ich do rysunku. 

 

Tworzenie stylu wielokrotnego lidera 

Style multileadera umożliwiają zmianę różnych ustawień, które kontrolują wygląd 

multileaderów. Ustawienia te można następnie zapisać do ponownego 

wykorzystania. Jeśli styl multileadera nie zostanie zdefiniowany przed utworzeniem 

multileadera, program użyje standardowego stylu multileadera, który przechowuje 

domyślne ustawienia multileadera. 
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Aby utworzyć styl z wieloma liderami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Menedżer stylów wielu liderów (w 

obszarze Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 Kliknij przycisk Nowy. 

3 W polu New Style Name wpisz nazwę nowego stylu multileadera. 

4 W polu Rozpocznij od wybierz istniejący styl multileadera, na którym zostanie 

oparty nowy styl multileadera. 

5 W opcji Adnotacje wybierz, czy na multileadery z tym stylem ma wpływ 

skalowanie adnotacji. 

6 Kliknij przycisk Kontynuuj. 

7 W oknie dialogowym Create New Multileader Styles dokonaj niezbędnych 

wyborów dla stylu multileadera. Aby uzyskać szczegółowe informacje na temat 

dostępnych opcji, kliknij [?] w oknie dialogowym. 

8 Po zakończeniu kliknij przycisk OK. 

 
Ustawienie bieżącego stylu multileadera 

Podczas tworzenia multileadera jest mu automatycznie przypisywany styl 

multileadera ustawiony jako bieżący. Domyślnie program używa stylu Standard 

multileader, który przechowuje domyślne ustawienia multileadera. Można też 

wybrać inny styl multileadera jako bieżący. 

Jeśli wybierzesz inny styl multilidera jako bieżący, styl ten zostanie przypisany do 

multiliderów utworzonych w przyszłości, a nie do istniejących multiliderów. 
 

Aby ustawić styl multileadera jako bieżący 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wielu liderów (w obszarze 

Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów multileadera wybierz styl multileadera z 

listy. 

3 Kliknij przycisk Ustaw bieżący. 

4 Kliknij przycisk Zamknij. 
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Przypisywanie stylu do multileadera 
Do multileadera można w dowolnym momencie przypisać inny styl. 

 

Aby przypisać styl do multileadera 

1 Wybierz multileader na rysunku. 

2 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz opcję Adnotacje, a następnie wybierz styl z listy Styl 

wielokrotny (w obszarze Liderzy). 

• Na pasku narzędzi Multileader lub Style wybierz styl z listy Styl Multileader. 

• Kliknij prawym przyciskiem myszy multileader, wybierz Właściwości, a następnie 

wybierz Styl. 

 
Zmiana nazwy stylu multileadera 

Aby zmienić nazwę stylu multileadera 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Menedżer stylów wielu liderów (w 

obszarze Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów multileadera wybierz styl 

multileadera, którego nazwę chcesz zmienić. 

3 Kliknij nazwę po raz drugi, wpisz nową nazwę, a następnie naciśnij klawisz Enter. 

4 Kliknij przycisk Zamknij. 

 
Usuwanie stylu wielokrotnego lidera 

Aby usunąć nazwany styl multileadera 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wielu liderów (w obszarze 

Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów multileadera wybierz styl 

multileadera do usunięcia. 

3 Kliknij przycisk Usuń. 

4 Aby potwierdzić usunięcie, kliknij OK. 

5 Kliknij przycisk Zamknij. 
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Kontrolowanie ustawień formatu liderów dla stylów z wieloma liderami 
Możesz kontrolować ustawienia formatu linijki, które wpływają na typ, kolor, typ 

linii, wagę linii, grot strzałki i rozmiar podziału. Wszelkie wprowadzane zmiany 

mają wpływ na używany styl linijki (nowy lub istniejący). Kafelek obrazu po prawej 

stronie okna dialogowego Utwórz nowy/modyfikuj style wielokropka pokazuje 

wygląd wielokropka w oparciu o bieżące ustawienia stylu wielokropka. 
 

Aby ustawić format lidera dla stylów z wieloma liderami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wielu liderów (w obszarze 

Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 Wybierz styl multileadera, a następnie kliknij przycisk Modyfikuj. Jeśli zamiast 

tego chcesz utworzyć nowy styl wielokrotnego lidera, zobacz sekcję "Tworzenie 

stylu wielokrotnego lidera" na stronie 163 w tym rozdziale. 

3 Kliknij zakładkę Leader Format i dokonaj wyboru. 

4 Po zakończeniu kliknij przycisk OK. 
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A 

B 

C 

D 

 
E 

F 

G 

 
 
 
 
 
 
 
 

 
A Wybierz typ linii prowadzącej: prosta, splajn 

lub bez linii prowadzącej. 

B Wybierz kolor linii leadera dla wielu 
leaderów przypisanych do tego stylu. 

C Wybierz typ linii lidera dla multileaderów 
przypisanych do tego stylu. 

D Wybierz wagę linii lidera dla multileaderów 
przypisanych do tego stylu. 

 
E Wybierz grot strzałki linii prowadzącej dla wielu linii 

prowadzących przypisanych do tego stylu. 

F Wprowadź lub wybierz rozmiar głowicy 
liniowej leadera dla wielu leaderów 
przypisanych do tego stylu. 

G Wprowadź lub wybierz rozmiar przerwania 
lidera dla multileaderów przypisanych do 
tego stylu. Rozmiar przerwania jest używany, 
gdy polecenie DIMBREAK jest używane z 
multileaderami przypisanymi do tego stylu. 
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Kontrolowanie ustawień struktury liderów dla stylów z wieloma liderami 
Możesz kontrolować ustawienia wpływające na ograniczenia lidera, ustawienia 

lądowania i skalę lidera. Wszelkie dokonane zmiany mają wpływ na styl 

multileadera, z którym pracujesz (nowy lub istniejący). Kafelek z obrazem po prawej 

stronie okna dialogowego Create New/Modify Multi-Leader Styles (Utwórz 

nowy/modyfikuj style wielu liderów) pokazuje wygląd lidera opartego na bieżących 

ustawieniach stylu. 
 

Aby ustawić strukturę liderów dla stylów z wieloma liderami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wielu liderów (w obszarze 

Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 Wybierz styl multileadera, a następnie kliknij przycisk Modyfikuj. Jeśli zamiast 

tego chcesz utworzyć nowy styl wielokrotnego lidera, zobacz sekcję "Tworzenie 

stylu wielokrotnego lidera" na stronie 163 w tym rozdziale. 

3 Kliknij zakładkę Leader Structure i dokonaj wyboru. 

4 Po zakończeniu kliknij przycisk OK. 
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D 

E 

 
F 
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A Wybierz, aby ograniczyć liczbę punktów dla 
linii prowadzącej, a następnie wprowadź lub 
wybierz maksymalną liczbę punktów. 

B Wybierz, aby określić kąt pierwszego 
segmentu linii, a następnie wprowadź 
lub wybierz kąt. 

C Wybierz, aby określić kąt drugiego 
segmentu linii, a następnie wprowadź lub 
wybierz kąt. 

D Wybierz opcję dołączenia linii poziomej 
między linią prowadzącą a treścią 
tekstową. 

E Wybierz, aby określić długość linii lądowania, 
a następnie wprowadź lub wybierz długość linii 
lądowania. 

F Wybierz, aby określić, że skalowanie 
adnotacji ma wpływ na multileadery z tym 
stylem. 

G Wybór automatycznego skalowania 
multileaderów zgodnie ze skalowaniem 
układu lub wprowadzenie stałej skali. (Dostępne 
dla stylów bez adnotacji). 
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Kontrolowanie ustawień zawartości dla stylów z wieloma liderami 
Można kontrolować ustawienia zawartości znajdującej się na końcu multileaderów. 

W szczególności należy wybrać, czy zawartość ma być tekstem wielowierszowym, 

blokiem, czy nie. Następnie można dokonać dalszych wyborów. Kafelek obrazu po 

prawej stronie okna dialogowego Utwórz nowy/modyfikuj style wielokropka 

przedstawia wygląd wielokropka w oparciu o bieżące ustawienia stylu 

wielokropka. 
 

Aby skonfigurować ustawienia zawartości dla stylu wielowierszowego z tekstem 
wielowierszowym 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Menedżer stylów wielu liderów (w 

obszarze Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 Wybierz styl multileadera, a następnie kliknij przycisk Modyfikuj. Jeśli zamiast 

tego chcesz utworzyć nowy styl wielokrotnego lidera, zobacz sekcję "Tworzenie 

stylu wielokrotnego lidera" na stronie 163 w tym rozdziale. 

3 Kliknij kartę Ustawienia treści. 

4 W polu Multileader Type wybierz Mtext. 

5 Kontynuuj dokonywanie wyborów. 

6 Po zakończeniu kliknij przycisk OK. 



K R E A T Y W N O Ś C I K O M P L E K S O W E 171 

 
 
 
 

 
A 

 
B 

C 

D 

E 

F 

 GM 

 

H 

 
I 

J 

K 

L 

 

 

A Wybierz, czy multileader z tym stylem ma 
zawierać tekst wielowierszowy, blok, czy 
żaden. Opcje w oknie dialogowym zmieniają 
się w zależności od dokonanego wyboru. 

B Wyświetla domyślny tekst dla 
wielowierszowej zawartości tekstowej. 
Kliknij [...], aby określić domyślny tekst. 

C Wybierz styl tekstu dla tekstu 
wielowierszowego. Kliknij [...], aby 
zarządzać stylami tekstu. 

D Określenie, czy kąt obrotu tekstu 
wielowierszowego ma być taki sam, jak tekstu 
wstawionego, zawsze w prawo, czy zawsze 
w poziomie. 

E Wybierz kolor tekstu wielowierszowego. 

F Wprowadź lub wybierz wysokość tekstu 
wielowierszowego. 

G Wybierz opcję zawsze wyrównuj do lewej 
tekst wielowierszowy. 

H Wybierz, aby dołączyć wielowierszową 
zawartość tekstową do multileadera poziomo 
lub pionowo. Wyświetlane opcje zależą od 
dokonanego wyboru. 

I Wybierz położenie tekstu 
wielowierszowego, gdy jest on dołączony 
do lewej (w przypadku linii poziomej) lub 
górnej (w przypadku linii pionowej) linii 
prowadzącej. 

J Wybierz lokalizację tekstu 
wielowierszowego, gdy jest on dołączony 
do prawej (w przypadku linii poziomej) lub 
dolnej (w przypadku linii pionowej) linii 
prowadzącej. 

K Wprowadź lub wybierz odległość między linią 
lądującą a tekstem wielowierszowym. 

L Wybierz, aby w razie potrzeby rozszerzyć 
multileader na tekst. (Dostępne tylko dla 
załączników poziomych). 

M Wybierz, aby dodać ramkę wokół tekstu 
wielowierszowego. 
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Aby skonfigurować ustawienia zawartości dla stylu multileadera z blokiem 

1 Wykonaj jedną z poniższych czynności, aby wybrać Multileader Styles Manager (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Menedżer stylów wielu liderów (w 

obszarze Liderzy). 

• W menu wybierz Format > Multileader Styles Manager. 

• Na pasku narzędzi Multileader lub Style kliknij narzędzie Menedżer stylów 

Multileader. Lub na pasku narzędzi Format kliknij narzędzie Multileader. 

• Wpisz mleaderstyle i naciśnij Enter. 

2 Wybierz styl multileadera, a następnie kliknij przycisk Modyfikuj. Jeśli zamiast 

tego chcesz utworzyć nowy styl wielokrotnego lidera, zobacz sekcję "Tworzenie 

stylu wielokrotnego lidera" na stronie 163 w tym rozdziale. 

3 Kliknij kartę Ustawienia treści. 

4 W polu Typ multileadera wybierz opcję Blok. 

5 Kontynuuj dokonywanie wyborów. 

6 Po zakończeniu kliknij przycisk OK. 
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A Wybierz, czy multileader z tym stylem 
zawiera tekst wielowierszowy, blok, czy też 
nie zawiera żadnego tekstu. Opcje w oknie 
dialogowym zmieniają się w zależności od 
dokonanego wyboru. 

B Wybierz blok, który ma zostać użyty 
na końcu multileadera. 

C Wybierz punkt, który ma zostać użyty do 
dołączenia bloku do multileadera: określony 
punkt wstawienia lub punkt środkowy. 

D Wybierz kolor bloku, który jest stosowany, 
jeśli kolor jednostki bloku to ByBlock. 

E Wprowadź lub wybierz skalę bloku. 
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Tworzenie polilinii granicznych 
 

Polilinia ograniczona to obszar ograniczony pojedynczą zamkniętą jednostką lub 

wieloma jednostkami, które przecinają się i są używane do kreskowania lub 

wymiarowania. 

Aby uzyskać szczegółowe informacje na temat dodawania kreskowania po 

utworzeniu polilinii granicznej, patrz "Dodawanie kreskowania i gradientów" na 

stronie 178 w tym rozdziale. Aby uzyskać szczegółowe informacje na temat 

dodawania wymiarów po utworzeniu polilinii ograniczającej, patrz "Tworzenie 

wymiarów" na stronie 428. 

 

Zrozumienie polilinii granicznych 

Za pomocą polecenia Granica można wyznaczyć określony obszar rysunku na 

potrzeby operacji takich jak kreskowanie i wymiarowanie. Polilinię graniczną tworzy 

się poprzez wybranie obszaru wewnątrz zamkniętej pętli. Wybrany obszar może być 

ograniczony pojedynczą zamkniętą jednostką lub wieloma jednostkami, które się 

przecinają. 

W przypadkach, gdy jednostki przecinają się, ALCAD interpretuje granicę jako 

zamkniętą pętlę najbliższą punktowi określającemu obszar. Na przykład na 

poniższym rysunku punkt obszaru wybrany w prostokącie powoduje, że granica 

składa się z zamkniętej pętli najbliższej wybranemu punktowi, w przeciwieństwie do 

zamkniętej pętli utworzonej przez sam prostokąt. 

 
 

Wybrany punkt (A) i wynikająca z niego granica (B). 

Aby uszczegółowić granice, można utworzyć zestaw granic. Zestaw granic określa, 

które jednostki są brane pod uwagę przy określaniu ścieżki granicy. Może to 

przyspieszyć tworzenie polilinii granicznej, jeśli pracujesz ze złożonym rysunkiem. 

Na poniższym rysunku okrąg i trójkąt są wybranymi elementami. Jeśli zaznaczysz 

obszar w dowolnym miejscu wewnątrz okręgu lub trójkąta, wynikiem będzie 

polilinia ograniczająca zacieniony obszar. 
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Wybrane jednostki (A i B) oraz punkt określony w tym wybranym obszarze (C), co 
skutkuje nową granicą wokół zacienionego obszaru. 

 
Korzystanie z wysp i wykrywanie wysp 

Wyspy to zamknięte pętle, które znajdują się wewnątrz innych zamkniętych pętli. 

ALCAD zapewnia opcje wykrywania wysp, dzięki czemu można określić, które 

wyspy, jeśli w ogóle, powinny być uwzględnione w wyborze obszaru dla granicy. 

Poniższy rysunek przedstawia prostokątną polilinię z dwiema wyspami. Okrąg jest 

określany jako wyspa zewnętrzna, a ośmiokąt jest określany jako wyspa 

zagnieżdżona. 
 

Prostokątna polilinia (A) bez wysepki (B), z punktem (C) określającym wybór obszaru i zagnieżdżoną 
wysepką (D). 

Można wybrać jedną z trzech metod wykrywania wysp. 

• Zagnieżdżone wyspy Jednostka zewnętrzna i wszystkie jej wyspy są uwzględniane w 

polilinii. 

• Tylko zewnętrzna Tylko zewnętrzna jednostka i jej zewnętrzna wyspa są 

brane pod uwagę w przypadku polilinii. 

• Ignoruj wyspy W przypadku polilinii brana jest pod uwagę tylko zewnętrzna jednostka. 
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 ABC 

Zagnieżdżone wyspy (A), z zewnętrzną wyspą (B) i z ignorowanymi wyspami (C). 
 

Tworzenie polilinii granicznej 

Podczas tworzenia polilinii granicznej wybierana jest istniejąca jednostka lub wiele 

jednostek w celu zdefiniowania granicy. 
 

Aby narysować polilinię graniczną 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Boundary (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Granica (w aplikacji 

Draw) lub Rysuj > Granica (w aplikacji Draw). 

• W menu wybierz Rysuj > Kreskowanie > Granica. 

• Na pasku narzędzi Rysuj kliknij narzędzie Granica. 

• Wpisz boundary i naciśnij Enter. 

2 Określ jednostki, które mają być dostępne dla polilinii granicznej, wykonując jedną 

z poniższych czynności: 

• Wszystkie jednostki Wybierz opcję Wszystkie widoczne jednostki, 

aby wszystkie jednostki na rysunku były brane pod uwagę podczas 

tworzenia polilinii granicznej. 

• Wybór niestandardowy Zdefiniuj tylko określone obszary, które mają być 

brane pod uwagę podczas tworzenia polilinii granicznej, co może poprawić 

wydajność systemu, jeśli pracujesz ze złożonym rysunkiem. Kliknij Wybierz 

zestaw granic. Na rysunku zaznacz elementy pojedynczo lub wybierając 

metodę zaznaczania z okna podpowiedzi, a następnie naciśnij klawisz Enter. 

Opcja Current Selection Set zostanie wybrana automatycznie, co oznacza, że 

jednostki wybrane za pomocą przycisku Select Boundary Set zostaną 

uwzględnione podczas tworzenia polilinii granicznej. 
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Nie trzeba ponownie wybierać podmiotów za pomocą przycisku Wybierz zestaw 

granic. Opcja Current Selection Set wykorzystuje ostatni zestaw jednostek 

wybranych za pomocą przycisku Select Boundary Set. 
 

3 Wybierz opcję wykrywania wysp. 

4 Kliknij przycisk Wybierz obszar. 

5 Na rysunku kliknij wewnątrz obszaru, którego zamknięty obwód tworzy 

granicę, a nie na samej polilinii. W razie potrzeby kontynuuj klikanie wewnątrz 

dodatkowych zamkniętych obwodów. 

6 Aby zakończyć wybór, naciśnij Enter. 

7 W oknie dialogowym Granice kliknij przycisk OK. 

 

 

 

E 

A 

B 

C 

 
 
 

D 

 
 
 
 
 

A Otwiera obszar rysowania w celu wybrania 
jednostek, które mają zostać uwzględnione 
podczas tworzenia polilinii granicznej. 

B Wybór uwzględnienia wszystkich 
widocznych elementów podczas 
tworzenia polilinii granicznej. 

C Wybierz, aby użyć jednostek wybranych dla 
zestawu granic. (Opcja dostępna po kliknięciu 
przycisku Wybierz zestaw granic). 

D Wybierz opcję wykrywania wysp. 

E Otwiera obszar rysowania w celu wybrania 
zamkniętych obszarów używanych do 
tworzenia nowych polilinii granicznych. 
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Dodawanie kreskowania i gradientów 
 

Po dodaniu kreskowania lub gradientów do rysunku, ALCAD wypełnia jednostki 

lub zamknięte obszary wzorem. 

Dodawanie kreskowania lub gradientów to trzyetapowy proces: 

1 Określenie wzoru kreskowania lub gradientu. 

2 Określ podmioty lub obszary. 

3 Określ dodatkowe opcje. 
 

Wzory kreskowania i gradienty wymagają dużej ilości pamięci. 

Ponieważ rysowanie i wyświetlanie wzorów kreskowania i gradientów może zająć 

znaczną ilość czasu, warto dodać kreskowanie i gradienty podczas ostatnich kroków 

tworzenia rysunku lub wstawić je na osobnej warstwie, którą można zamrozić 

podczas dalszej pracy nad rysunkiem. Na przykład, zamiast używać wzoru linii o małej 

skali do utworzenia wypełnienia bryłą, użyj wzoru kreskowania SOLID, ponieważ 

spowoduje to znacznie szybsze drukowanie i wyświetlanie. 
 

 
Określanie wzoru kreskowania lub gradientu 

Wzór kreskowania składa się z powtarzającego się wzoru linii, kresek i kropek. 

Można wybrać jeden z zestawu predefiniowanych wzorców, zdefiniować własny 

wzorzec lub wybrać wzorzec z niestandardowej biblioteki kreskowania. 

Wzór gradientu składa się ze stopniowej lub płynnej zmiany jednego koloru na 

inny. Wystarczy wybrać kolory i wzór. 

 

Istniejące włazy i nachylenia można modyfikować. 

Wpisz HATCHEDIT, aby zmodyfikować istniejący kreskowanie lub gradient, 

kliknij go dwukrotnie na rysunku lub zmień jego ustawienia w panelu 

Właściwości. 
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Określanie predefiniowanego wzoru kreskowania 
Predefiniowane wzorce kreskowania są przechowywane w następujących plikach biblioteki 

wzorców kreskowania: 

• icad.pat - Wzory zgodne z normami American National Standards Institute (ANSI). 

• icadiso.pat - wzorce zgodne z normami Międzynarodowej Organizacji Normalizacyjnej 

(ISO). 

Aby określić predefiniowany wzór kreskowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Hatch (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Kreskowanie (w aplikacji Draw) lub 

Rysunek > Kreskowanie (w aplikacji Draw). 

• W menu wybierz Rysuj > Kreskowanie > Kreskowanie. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kreskowanie. 

• Wpisz bhatch i naciśnij Enter. 

2 Kliknij kartę Hatch. 

3 W polu Typ wybierz opcję Predefiniowane. 

4 W polu Wzór wybierz żądany wzór. Możesz także kliknąć przycisk [ ] lub próbkę, aby 

otwórz okno dialogowe Wzorce kreskowania i wybierz wzorzec z zakładek 

ANSI, ISO lub Inne predefiniowane. 

5 Określ jedną z poniższych opcji: 

• Kolor Na pierwszej (lewej) liście kolorów wybierz kolor linii kreskowania. Z 

drugiej (prawej) listy kolorów wybierz kolor tła kreskowania. 

• Kąt Wprowadź kąt wzoru kreskowania względem osi x w stopniach (1- 

360). Domyślny kąt jest zgodny z ruchem wskazówek zegara; kąt można 

zmienić, wprowadzając wartość liczbową. 

• Skala Wprowadź współczynnik skali jako wartość procentową wartości 

domyślnej. Zmiana współczynnika skali powoduje zwiększenie lub zmniejszenie 

wzoru kreskowania w stosunku do rozmiaru domyślnego. W przypadku 

wybrania standardowego wzorca ISO skala wpływa na szerokość pióra ISO. 

• Powiązane z przestrzenią papieru Wybierz, aby skalować wzór 

kreskowania względem jednostek zdefiniowanych dla przestrzeni papieru. 

(Dostępne dla nazwanych układów). 

• Szerokość pióra ISO Wprowadź szerokość pióra, jeśli wybrano standardowy wzór ISO. 

6 W polu Pochodzenie kreskowania wybierz, czy wzór kreskowania ma być 

rysowany od domyślnego początku, czy od nowego początku. Jeśli zdecydujesz 

się określić nowy punkt początkowy, wykonaj jedną z poniższych czynności: 

• Kliknij (  ), aby wybrać nowy początek bezpośrednio na rysunku. 

• Wybierz opcję Default to Boundary Extents, aby ustawić początek w 

lewym górnym rogu, prawym górnym rogu, lewym dolnym rogu, prawym 

dolnym rogu lub na środku granic. 
 

Nowe pochodzenie można zapisać jako nowe domyślne. 

Aby zapisać nowy początek kreskowania jako domyślny, wybierz opcję Store as 

Default Origin. Pochodzenie kreskowania zostanie zapisane w zmiennej 

systemowej HPORIGIN. 
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7 Aby kontynuować, określ jednostki lub obszary kreskowania. Szczegółowe 

informacje zawiera sekcja "Określanie jednostek lub obszarów dla kreskowania i 

gradientów" na stronie 186 w tym rozdziale. 

 

Aby określić wzorzec kreskowania zdefiniowany przez użytkownika 

1 Wykonaj jedną z poniższych czynności, aby wybrać Hatch (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Kreskowanie (w aplikacji Draw) lub 

Rysunek > Kreskowanie (w aplikacji Draw). 

• W menu wybierz Rysuj > Kreskowanie > Kreskowanie. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kreskowanie. 

• Wpisz bhatch i naciśnij Enter. 

2 Kliknij kartę Hatch. 

3 Z listy Typ wybierz opcję Zdefiniowany przez użytkownika. 

4 Określ jedną z poniższych opcji: 

• Kolor Na pierwszej (lewej) liście kolorów wybierz kolor linii kreskowania. Z 

drugiej (prawej) listy kolorów wybierz kolor tła kreskowania. 

• Kąt Wprowadź kąt wzoru kreskowania względem osi x w stopniach (1- 

360). Domyślny kąt jest zgodny z ruchem wskazówek zegara; kąt można 

zmienić, wprowadzając wartość liczbową. 

• Dwukrotne wybranie tej opcji powoduje kreskowanie krzyżowe wzorka, 

co powoduje umieszczenie kolejnej kopii wzorka pod kątem 90 stopni 

nad oryginałem. 

• Powiązane z przestrzenią papieru Wybierz, aby skalować wzór 

kreskowania względem jednostek zdefiniowanych dla przestrzeni papieru. 

(Dostępne dla nazwanych układów). 

• Odstępy Wprowadź odstępy między wierszami dla wzoru kreskowania. 

5 W polu Pochodzenie kreskowania wybierz, czy wzór kreskowania ma być 

rysowany od domyślnego początku, czy od nowego początku. Jeśli zdecydujesz 

się określić nowy punkt początkowy, wykonaj jedną z poniższych czynności: 

• Kliknij (  ), aby wybrać nowy punkt początkowy bezpośrednio na rysunku. 

• Wybierz opcję Default to Boundary Extents, aby ustawić początek w 

lewym górnym rogu, prawym górnym rogu, lewym dolnym rogu, prawym 

dolnym rogu lub na środku granic. 
 

Nowe pochodzenie można zapisać jako nowe domyślne. 

Aby zapisać nowy początek kreskowania jako domyślny, wybierz opcję Store as 

Default Origin. Pochodzenie kreskowania zostanie zapisane w zmiennej 

systemowej HPORIGIN. 
 

6 Aby kontynuować, określ jednostki lub obszary kreskowania. Szczegółowe 

informacje zawiera sekcja "Określanie jednostek lub obszarów dla 

kreskowania i gradientów" na stronie 186 w tym rozdziale. 
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Określanie niestandardowego wzorca kreskowania biblioteki 
Można używać niestandardowych zewnętrznych bibliotek wzorców kreskowania 

(pliki .pat), takich jak standardowa biblioteka używana w biurze, niestandardowe 

wzorce i biblioteki dostępne od dostawców lub organizacji normalizacyjnych. Pliki 

.pat mogą znajdować się w dowolnej lokalizacji. 

Każdy plik .pat zawiera jeden wzorzec kreskowania, a nazwa pliku musi 

odpowiadać nazwie wzorca kreskowania. Definicja wzorca kreskowania jest 

następująca: 

*[Nazwa],[Opis] 

angle, x-origin, y-origin, delta-x, delta-y [, dash1, dash2, ...] 

Alternatywnie można dodać niestandardowy wzorzec kreskowania do pliku 

icad.pat i użyć predefiniowanych wzorców kreskowania opisanych wcześniej 

zamiast niestandardowego wzorca bibliotecznego poniżej. 
 

Aby użyć niestandardowego wzorca biblioteki 

1 Wykonaj jedną z poniższych czynności: 

• Skopiuj niestandardowy plik wzorca (plik .pat) do folderu Patterns, w którym 

zainstalowano program ALCAD. Aby sprawdzić, gdzie ALCAD wyszukuje 

pliki wzorców, wybierz Narzędzia 

> Opcje, kliknij Ścieżki/Pliki i sprawdź foldery na liście dla Hatch Patterns. 

• Wybierz Narzędzia > Opcje, kliknij Ścieżki/Pliki i dodaj lokalizację 

niestandardowego pliku wzorca (plik .pat) do folderów wymienionych dla 

Hatch Patterns. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Hatch (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Kreskowanie (w aplikacji Draw) lub 

Rysunek > Kreskowanie (w aplikacji Draw). 

• W menu wybierz Rysuj > Kreskowanie > Kreskowanie. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kreskowanie. 

• Wpisz bhatch i naciśnij Enter. 

3 Kliknij kartę Hatch. 

4 W polu Typ wybierz opcję Niestandardowy. 

5 W obszarze Wzór niestandardowy wybierz wzór z listy. Możesz także kliknąć [ ], aby 

otworzyć okno 

Okno dialogowe Wzorce kreskowania i wybierz wzorzec z zakładki Niestandardowe. 

6 Określ jedną z poniższych opcji: 

• Kolor Na pierwszej (lewej) liście kolorów wybierz kolor linii kreskowania. Z 

drugiej (prawej) listy kolorów wybierz kolor tła kreskowania. 

• Kąt Wprowadź kąt wzoru kreskowania względem osi x w stopniach (1- 

360). Domyślny kąt jest zgodny z ruchem wskazówek zegara; kąt można 

zmienić, wprowadzając wartość liczbową. 

• Skala Wprowadź współczynnik skali jako wartość procentową wartości 

domyślnej. Zmiana współczynnika skali powoduje powiększenie lub 

pomniejszenie wzoru kreskowania w stosunku do rozmiaru domyślnego. 

• Powiązane z przestrzenią papieru Wybierz, aby skalować wzór 

kreskowania względem jednostek zdefiniowanych dla przestrzeni papieru. 



(Dostępne dla nazwanych układów). 
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7 W polu Pochodzenie kreskowania wybierz, czy wzór kreskowania ma być 

rysowany od domyślnego początku, czy od nowego początku. Jeśli zdecydujesz 

się określić nowy punkt początkowy, wykonaj jedną z poniższych czynności: 

• Kliknij (  ), aby wybrać nowy punkt początkowy bezpośrednio na rysunku. 

• Wybierz opcję Default to Boundary Extents, aby ustawić początek w 

lewym górnym rogu, prawym górnym rogu, lewym dolnym rogu, prawym 

dolnym rogu lub na środku granic. 
 

Nowe pochodzenie można zapisać jako nowe domyślne. 

Aby zapisać nowy początek kreskowania jako domyślny, wybierz opcję Store as 

Default Origin. Pochodzenie kreskowania zostanie zapisane w zmiennej 

systemowej HPORIGIN. 
 

8 Aby kontynuować, określ jednostki lub obszary kreskowania. Szczegółowe 

informacje zawiera sekcja "Określanie jednostek lub obszarów dla 

kreskowania i gradientów" na stronie 186 w tym rozdziale. 
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A Wybierz, aby utworzyć wzóratch. 

B Wybierz typ wzoru kreskowania. 

C Wybierz predefiniowany wzór kreskowania z listy lub 
kliknij przycisk [...], aby wybrać go w oknie dialogowym 
Wzory kreskowania. 

D Kliknij, aby wybrać wzór kreskowania. 

E Wybierz kolor linii kreskowania. 

F Wybierz niestandardowy wzór kreskowania z listy lub kliknij 
przycisk [...], aby wybrać go w oknie dialogowym Wzory 
kreskowania. 

G Wprowadź kąt wzoru kreskowania w odniesieniu do osi 
sześciokątnej. 

H Wybierz, aby kreskować wzór zdefiniowany przez użytkownika. 

I Wprowadź odstępy między wierszami dla wzorca 
zdefiniowanego przez użytkownika. 

J Wprowadź szerokość pióra dla predefiniowanego wzoru zgodnego ze 
standardem ISO. 

K Wybierz, aby użyć domyślnego początku kreskowania lub określić nowy 
początek. 

L Kliknij, aby wybrać nowy początek kreskowania na rysunku. 

M Wybierz, aby ustawić nowy początek w lewym górnym rogu, w 
prawym górnym rogu, w lewym dolnym rogu, w prawym 
dolnym rogu lub na środku zakresu granicznego. 

N Wybierz, aby zapisać nowy początek kreskowania jako nowy domyślny. 

O Wybierz, aby przeskalować wzór kreskowania względem 
jednostek zdefiniowanych dla przestrzeni papieru. 
(Dostępne dla nazwanych układów). 

P Wprowadź współczynnik skali jako wartość procentową wartości domyślnej. 

Q Wybierz kolor tła kreskowania. 
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Określanie wzoru gradientu 
Wzór gradientu składa się ze stopniowej lub płynnej zmiany jednego koloru na 

inny. Wystarczy wybrać kolory, wzór i ustawienia orientacji. 
 

Aby określić wzór gradientu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Gradient (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Gradient (w 

aplikacji Draw) lub Rysuj > Gradient (w aplikacji Draw). 

• W menu wybierz polecenie Rysuj > Kreskowanie > Gradient. 

• Na pasku narzędzi Rysuj kliknij narzędzie Gradient. 

• Wpisz gradient i naciśnij Enter. 

2 W opcji Kolor wybierz jedną z poniższych opcji: 

• Jeden kolor Określ jeden kolor dla wzoru gradientu, a następnie określ kolor 

w polu Kolor1. Określony kolor zostanie wygładzony kolorem białym lub 

czarnym, w zależności od zmiennej systemowej GFCLRSTATE. 

• Dwa kolory Określ dwa kolory dla wzoru gradientu, a następnie określ kolory 

w polach Kolor1 i Kolor2. Kolor1 zostanie wygładzony kolorem2. 

3 Na ekranie wzorów gradientu 3x3 wybierz wzór gradientu. 

4 Określ opcje orientacji: 

• Wyśrodkowany Wybierz, aby wyśrodkować wzór gradientu. Jeśli ta opcja 

nie zostanie wybrana, wzór gradientu będzie miał źródło światła powyżej i po 

lewej stronie (wzór zostanie przesunięty w górę i w lewo). 

• Kąt Wprowadź lub wybierz kąt wzoru gradientu. 

5 Aby kontynuować, określ jednostki lub obszary dla gradientów. Szczegółowe 

informacje zawiera sekcja "Określanie jednostek lub obszarów dla 

kreskowania i gradientów" na stronie 186 w tym rozdziale. 
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A Wybierz, aby utworzyć wzór gradientu. 

B Wybierz, aby określić jeden lub dwa kolory wzoru 
gradientu. 

C Wybierz pierwszy kolor wzoru gradientu; kliknij [...], aby 
uzyskać więcej opcji kolorów. 

D Wybierz drugi kolor, jeśli tworzysz dwukolorowy wzór 
gradientu; kliknij [...], aby uzyskać więcej opcji kolorów. 

E Wybierz wzór gradientu. 

F Wybierz, aby wyśrodkować wzór gradientu; jeśli nie 
zostanie wybrany, wzór przesunie się w górę i w lewo. 

G Wprowadź lub wybierz kąt dla wzoru gradientu. 
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Określanie jednostek lub obszarów dla kreskowania i gradientów 

Można określić jednostki lub obszary, w których mają zostać zastosowane kreskowania i 

gradienty: 

• Wybierz jednostki - Dodaj kreskowanie lub gradienty do dowolnej jednostki, 

która tworzy zamkniętą granicę, na przykład okrąg lub prostokąt. Kreskowanie 

lub gradienty można przypisać do pojedynczej jednostki lub kilku jednostek 

jednocześnie. 

• Wybierz obszary - dodawanie kreskowania lub gradientów do obszaru 

zamkniętego przez elementy tworzące granicę. Kreskowanie lub gradient są 

tworzone w zamkniętym obszarze, a nie w samych elementach. Całe 

kreskowanie lub gradient, po narysowaniu, jest traktowane jako pojedyncza 

jednostka i jest asocjatywne lub niezależne od jednostek granicznych. 
 

Aby wybrać jednostki lub obszary do kreskowania i gradientów 

1 Wykonaj jedną z poniższych czynności, aby wybrać kreskowanie (  ) lub gradient (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Kreskowanie lub 

Narzędzia główne > Gradient (w aplikacji Draw); albo wybierz kolejno opcje 

Rysuj > Kreskowanie lub Rysuj > Gradient (w aplikacji Draw). 

• W menu wybierz polecenie Rysuj > Kreskowanie > Kreskowanie lub Gradient. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kreskowanie lub Gradient. 

• Wpisz bhatch lub gradient, a następnie naciśnij Enter. 

2 Kliknij jedną z poniższych opcji: 

• Dodaj: Wybierz punkty Określa obszary, dla których mają zostać 

zastosowane kreskowanie i gradienty. Na rysunku kliknij wewnątrz 

zamkniętego obwodu granicy, a nie na samej granicy. W razie potrzeby 

można kontynuować klikanie wewnątrz dodatkowych zamkniętych obwodów. 

Aby zakończyć wybór, naciśnij klawisz Enter. 

• Dodaj: Wybierz jednostki Określa jednostki, dla których mają zostać 

zastosowane kreskowanie i gradienty. Na rysunku klikaj elementy pojedynczo 

lub wybierając metodę wyboru z okna podpowiedzi, a następnie naciśnij 

klawisz Enter po zakończeniu. 

• Usuń granice Usuwa granice z zestawu zaznaczenia. Na rysunku kliknij 

granice, które chcesz usunąć z zestawu zaznaczenia. 

• Utwórz granicę Tworzy polilinię lub region wokół kreskowania lub gradientu. 

Na rysunku kliknij kreskowanie lub gradient, dla którego chcesz utworzyć 

granicę. 

• Wyświetl wybory Wyświetla zestaw wyborów. Na rysunku naciśnij Enter 

po zakończeniu przeglądania zestawu wyborów. 

3 Aby kontynuować, określ dodatkowe opcje. Szczegółowe informacje zawiera 

sekcja "Określanie dodatkowych opcji kreskowania i gradientu" na stronie 

187 w tym rozdziale. 
 

Podczas tworzenia kreskowania lub gradientu wyświetlany jest komunikat 

ostrzegawczy, jeśli liczba wybranych elementów przekracza wartość zmiennej 

systemowej HPOBJWARNING. 

Jeśli wyświetlone zostanie ostrzeżenie, należy poprawić wydajność przed kontynuowaniem 
tworzenia klapy. 



wybierz mniej jednostek. Wzory kreskowania wymagają dużej ilości pamięci, a 

ich narysowanie może zająć znaczną ilość czasu. 
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AB  CDE 
 

A Kliknij, aby wybrać punkt wewnątrz jednej lub więcej 
jednostek tworzących granicę. 

B Kliknij, aby wybrać jeden lub więcej podmiotów. 

C Kliknij, aby usunąć granicę z zestawu wyboru. 

 

D Kliknij, aby wyświetlić aktualnie wybrane jednostki na rysunku. 

E Kliknij, aby wybrać kreskowanie lub gradient, który ma 
zostać otoczony polilinią lub regionem. 

 
 

Określanie dodatkowych opcji kreskowania i gradientu 

Istnieje wiele opcji, które można określić dla kreskowań i gradientów, w tym opcje 

for- matowania, wykrywanie wysp i określone opcje związane z granicami. 

 

Istniejące włazy i nachylenia można modyfikować. 

Wpisz HATCHEDIT, aby zmodyfikować istniejący kreskowanie lub gradient, 

kliknij go dwukrotnie na rysunku lub zmień jego ustawienia w panelu 

Właściwości. 
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Aby określić dodatkowe opcje kreskowania i gradientu 

1 Wykonaj jedną z poniższych czynności, aby wybrać kreskowanie (  ) lub gradient (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Kreskowanie lub 

Narzędzia główne > Gradient (w aplikacji Draw); albo wybierz kolejno opcje 

Rysuj > Kreskowanie lub Rysuj > Gradient (w aplikacji Draw). 

• W menu wybierz polecenie Rysuj > Kreskowanie > Kreskowanie lub Gradient. 

• Na pasku narzędzi Rysuj kliknij narzędzie Kreskowanie lub Gradient. 

• Wpisz bhatch lub gradient, a następnie naciśnij Enter. 

2 Wybierz jedną z poniższych opcji formatowania: 

• Adnotacja Sprawia, że na wyświetlanie i drukowanie wzoru 

kreskowania lub gradientu ma wpływ skalowanie adnotacji. 

• Skojarzony Kojarzy wzorzec kreskowania lub gradientu z jego elementami 

brzegowymi. Deseń asocjacyjny aktualizuje się automatycznie po 

przesunięciu któregokolwiek z jego granic. 

• Utwórz oddzielne kreskowania Tworzy wiele kreskowań lub gradientów, gdy 

wybrana jest więcej niż jedna zamknięta granica. 

• Kolejność rysowania Określa kolejność rysowania wzoru kreskowania lub 

gradientu względem jego granicy. 

• Warstwa Określa warstwę, do której przypisany jest wzór kreskowania lub gradientu. 

• Przezroczysty Określa przezroczystość kreskowania lub gradientu. W 

przypadku wybrania opcji Określ wartość należy wprowadzić wartość 

przezroczystości lub użyć suwaka. 

• Odziedzicz właściwości Umożliwia wybór kreskowania lub gradientu, z 

którego mają zostać skopiowane ustawienia i wczytane do okna 

dialogowego Kreskowanie i gradient. 

3 W oknie dialogowym Kreskowanie i gradient kliknij >, jeśli to konieczne, aby 

rozwinąć okno dialogowe. 

4 Jeśli chcesz, aby granica była określana przez wyspy, w obszarze Wyspy 

wybierz opcję Wykrywanie wysp, a następnie wybierz jedną z poniższych 

opcji: 

• Normalny Jednostka zewnętrzna i wszystkie jej wyspy są brane pod uwagę do wyklucia. 

• Zewnętrzna Tylko zewnętrzna jednostka i jej zewnętrzna wyspa są brane pod uwagę przy 

wylęgu. 

• Ignoruj Tylko zewnętrzna jednostka jest brana pod uwagę przy wykluwaniu. 

 

 ABC 

Normalne lub zagnieżdżone wyspy (A), z zewnętrzną wyspą (B) i z ignorowanymi wyspami (C). 

5 Wybierz dowolną z poniższych opcji związanych z granicami: 
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• Zachowywanie granic Zachowuje wszystkie nowe jednostki utworzone w 

celu narysowania kreskowania lub gradientu. Jeśli opcja ta jest włączona, 

należy wybrać, czy nowe jednostki mają być tworzone jako polilinie czy 

regiony. Istniejące jednostki są zawsze zachowywane. 

• Zestaw granic Określa obszar jednostek, który jest brany pod uwagę przy 

tworzeniu granicy podczas korzystania z opcji Dodaj: Wybierz punkty. 

Wybierz opcję Bieżąca rzutnia, aby udostępnić wszystkie jednostki w bieżącej 

rzutni. Wybierz Existing Set, aby udostępnić tylko te jednostki, które znajdują 

się w obszarze określonym za pomocą opcji New. Kliknij przycisk New, aby 

określić nowy obszar. 

• Tolerancja odstępu Określa tolerancję, w której mogą znajdować się 

niedotykające się jednostki i nadal mogą być używane do tworzenia granic. 

Na przykład, jeśli dwie linie nie spotykają się w tym samym punkcie, ale 

odległość między ich punktami końcowymi mieści się w tolerancji 

kreskowania, zostaną one uznane za zamknięte i mogą być użyte do 

utworzenia granicy. ALCAD automatycznie oblicza tolerancję odstępu, w 

zależności od rozmiaru okna ALCAD. 

• Opcje dziedziczenia Określa, czy podczas korzystania z opcji Dziedzicz 

właściwości ma być używane bieżące pochodzenie, czy oryginalne 

pochodzenie kreskowania. 

6 Kliknij przycisk OK. 
 

Wzorce kreskowania wymagają dużej ilości pamięci. 

Ponieważ rysowanie i wyświetlanie wzorów kreskowania może zająć znaczną ilość 

czasu, warto dodać kreskowanie podczas ostatnich kroków tworzenia rysunku lub 

wstawić kreskowanie na osobnej warstwie, którą można zamrozić podczas dalszej 

pracy nad rysunkiem. Ponadto należy pamiętać o stosowaniu odpowiedniej skali i 

wzoru kreskowania. Na przykład, zamiast używać wzoru linii o małej skali do 

utworzenia wypełnienia jednolitego, użyj wzoru kreskowania SOLID, ponieważ 

spowoduje to znacznie szybsze drukowanie i wyświetlanie. 
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AB  CDE F 
 

A Wybierz, aby kreskowanie lub gradient miały charakter 
adnotacji. 

B Wybierz opcję automatycznej aktualizacji lub aktualizacji 
dowolnych granic. 

C Wybierz, aby utworzyć oddzielny kreskowanie lub 
gradient, gdy wybrano więcej niż jedną zamkniętą granicę. 

D Kliknij, aby wybrać kreskowanie lub gradient na rysunku, z 
którego chcesz skopiować ustawienia. 

E Wybierz przezroczystość łuków lub gradientów; jeśli 
określono wartość, wprowadź wartość przezroczystości lub 
użyj suwaka. 

F Wybierz warstwę kreskowania lub gradientu. 

G Wybierz początek kreskowania lub gradientu do 
zastosowania podczas korzystania z funkcji Dziedzicz 
właściwości. 

 
H Wybierz kolejność kreskowania lub gradientu 

względem granicy. 

I Wprowadź tolerancję, w której elementy niedotykające 
mogą znajdować się wewnątrz i nadal być używane do 
tworzenia granicy wzoru kreskowania. 

J Wybierz obszar podmiotów, który ma być brany pod 
uwagę przy tworzeniu granicy podczas korzystania z 
opcji Dodaj: Wybierz punkty. 

K Kliknij, aby określić nowy obszar wyboru granic podczas 
korzystania z opcji Dodaj: Wybierz punkty. 

L Jeśli opcja RetainBoundaries jest włączona, wybierz 
czy granice mają być tworzone jako polilinie czy 
regiony. 

M Wybierz, aby zachować wszystkie nowe elementy utworzone w 
celu narysowania kreskowania lub gradientu. 

N Określa, w jaki sposób wylęganie i gradienty oddziałują na wyspy. 

O Wybierz, aby wykrywać wyspy podczas określania granic. 



 
 
 
 
 
 
 
 
 
 
 
 
 

 
ALCAD zapewnia wiele sposobów wyświetlania i przeglądania rysunku. Można 

również zmienić różne ustawienia wyświetlania, aby przyspieszyć wyświetlanie lub 

drukowanie rysunku. W tej sekcji wyjaśniono, jak: 

• Nawigacja w obrębie rysunku poprzez przewijanie, przesuwanie i obracanie widoku. 

• Zmiana powiększenia rysunku poprzez powiększanie i pomniejszanie. 

• Wyświetlanie rysunku ze skalami adnotacji. 

• Praca z wieloma oknami lub widokami rysunku. 

• Kontroluj wyświetlanie elementów, aby zoptymalizować wydajność podczas 

pracy z dużymi lub złożonymi rysunkami. 

W przypadku pracy z rysunkami trójwymiarowymi patrz sekcja "Wyświetlanie 

elementów w trzech wymiarach" na stronie 576. Ukrywanie, cieniowanie lub 

renderowanie rysunku - patrz sekcja "Ukrywanie, cieniowanie i renderowanie" na 

stronie 640. 
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Przerysowywanie i regenerowanie rysunku 
 

Podczas pracy nad rysunkiem elementy wizualne mogą pozostać po zakończeniu 

polecenia. Elementy te można usunąć poprzez odświeżenie lub przerysowanie 

ekranu. 
 

Aby przerysować (odświeżyć) bieżący ekran okna 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Przerysuj ( ):  

• Na wstążce wybierz polecenie Widok > Przerysuj (w Nawiguj). 

• W menu wybierz polecenie Widok > Przerysuj. 

• Na pasku narzędzi Zoom kliknij narzędzie Przerysuj. 

• Wpisz redraw i naciśnij Enter. 

Informacje o elementach rysunku są przechowywane w bazie danych jako wartości 

zmiennoprzecinkowe, co zapewnia wysoki poziom precyzji. Czasami rysunek musi 

zostać ponownie obliczony lub zregenerowany z bazy danych 

zmiennoprzecinkowych, aby przekonwertować te wartości na odpowiednie współrzędne 

ekranu. Odbywa się to automatycznie. Regenerację można również zainicjować 

ręcznie. Gdy rysunek jest regenerowany, jest również przerysowywany. 

Aby zregenerować bieżące okno, wpisz regen na pasku poleceń. Jeśli wyświetlane 

jest więcej niż jedno okno, wpisz regenall, aby zregenerować wszystkie okna. 



 

Poruszanie się po rysunku 
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Widok rysunku wyświetlanego w bieżącej rzutni można przesuwać, przewijając, 

przesuwając lub obracając widok. Powoduje to zmianę wyświetlanej części rysunku bez 

zmiany bieżącego powiększenia. Przewijanie umożliwia poruszanie się po rysunku 

w poziomie i w pionie. Przesuwanie pozwala przesuwać rysunek w dowolnym 

kierunku. Obracanie umożliwia oglądanie rysunku pod dowolnym kątem. 

Możesz także przejść do innego widoku, korzystając z poniższych opcji: 

• Model i karty Układ. Więcej informacji można znaleźć w sekcji "Wyświetlanie 

rysunków w przestrzeni papieru i przestrzeni modelu" na stronie 520. 

• Zaprogramowane widoki. Więcej informacji można znaleźć w sekcji 

"Przełączanie na zaprogramowany kierunek wyświetlania" na stronie 576. 

• Nazwane widoki. Więcej informacji można znaleźć w sekcji "Tworzenie i 

przełączanie widoków nazwanych" na stronie 577. 

• Kamery. Aby uzyskać więcej informacji, patrz "Używanie kamery do 

przeglądania rysunku" na stronie 583. 

 
Korzystanie z pasków przewijania 

Aby ułatwić poruszanie się po rysunku, w każdym oknie rysunku dostępne są 

poziome i pionowe paski przewijania. Rozmiar pola przewijania w stosunku do 

paska przewijania wskazuje bieżący poziom powiększenia rysunku. Położenie pola 

przewijania w stosunku do paska przewijania wskazuje położenie środka rysunku w 

stosunku do wymiarów rysunku (najmniejszy prostokąt zawierający wszystkie 

elementy rysunku). 
 

Aby włączyć lub wyłączyć paski przewijania 

Wykonaj jedną z poniższych czynności, aby wybrać Scroll Bars: 

• Na wstążce wybierz polecenie Widok > Paski przewijania (na ekranie). 

• W menu wybierz Widok > Wyświetlacz > Paski przewijania. 

• Wybierz Narzędzia > Opcje > zakładkę Wyświetlanie i zaznacz opcję Pokaż paski 

przewijania. 

• Wpisz scrollbar, naciśnij Enter, a następnie wybierz On, Off lub Toggle. 

 
Przesuwanie rysunku 

Rysunek można przesuwać w dowolnym kierunku za pomocą narzędzia 

Przesuwanie (  ) na pasku narzędzi Widok. Przesuwanie przesuwa lub przesuwa 

widok rysunku w poziomie, w pionie lub po przekątnej. Powiększenie rysunku 

pozostaje takie samo, podobnie jak jego orientacja w przestrzeni. Zmienia się 

jedynie wyświetlana część rysunku. 
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Jeśli często przesuwasz (i powiększasz) do określonego obszaru rysunku, możesz 

utworzyć i ponownie użyć widoku za pomocą Menedżera widoków. 

Szczegółowe informacje można znaleźć w sekcji "Praca z widokami nazwanymi" na stronie 284. 
 

 
Przesuwanie przez określenie dwóch punktów 
Aby uzyskać precyzyjne przesuwanie, należy określić dwa punkty definiujące 

wielkość i kierunek przesuwania. Pierwszy punkt lub punkt bazowy wskazuje punkt 

początkowy obrotu. Drugi punkt wskazuje wielkość przesunięcia względem 

pierwszego punktu. 
 

Aby przesuwać, określając dwa punkty 

1 Wykonaj jedną z poniższych czynności, aby wybrać Pan (  ): 

• Na wstążce wybierz polecenie Widok > Przesuń (w Nawiguj). 

• W menu wybierz kolejno opcje Widok > Przesuń > Przesuń. 

• Na pasku narzędzi Widok kliknij narzędzie Panoramowanie. 

• Wpisz pan i naciśnij Enter. 

2 Określ punkt bazowy panoramy, wpisując współrzędne lub określając punkt w 

oknie rysunku. 

3 Określ punkt przesunięcia panoramy, wpisując współrzędne lub określając punkt 

w oknie rysowania. 

 

  
Wybierz punkt bazowy panoramy (A), a 
następnie wybierz drugi punkt (B), aby określić 
przesunięcie. 

 

Panoramowanie w czasie 
rzeczywistym 

Wynik. 

 

Przesuwanie w czasie rzeczywistym pozwala na kontrolowanie obrotu w tym samym czasie, w 

którym poruszasz myszą. 

 

Korzystanie z przesuwania w czasie rzeczywistym w dużych plikach rysunków może wymagać 
dużej ilości pamięci. 

Pomocne może być ustawienie zmiennej systemowej ZOOMDETAIL na wyższą 

liczbę, aby zmniejszyć liczbę wyświetlanych jednostek. Na przykład, jeśli wartość jest 

ustawiona na 10, tylko 10. jednostka będzie wyświetlana podczas przesuwania i 

powiększania w czasie rzeczywistym. 
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Aby przesuwać w czasie rzeczywistym 

1 Wykonaj jedną z poniższych czynności, aby wybrać funkcję obrotu w czasie rzeczywistym (

 ): 

• Na wstążce wybierz Widok > Panoramowanie w czasie rzeczywistym (w Nawiguj). 

• Wybierz kolejno opcje Widok > Panoramowanie > Panoramowanie w czasie 

rzeczywistym. 

• Na pasku narzędzi Zoom kliknij narzędzie Real-Time Pan. 

• Wpisz rtpan, a następnie naciśnij Enter. 

2 Kliknij i przytrzymaj lewy przycisk myszy. 

3 Przesuń kursor w kierunku, w którym chcesz przesuwać. 

4 Aby zatrzymać przesuwanie, zwolnij przycisk myszy. 

 
Przesuwanie za pomocą myszy z kółkiem 

Kółko myszy ułatwia poruszanie się po rysunku. Zmienna systemowa 

MBUTTONPAN kontroluje tę funkcję. 

Aby przesuwać za pomocą myszy z kółkiem 

• Naciśnij i przytrzymaj kółko, a następnie przesuń mysz w kierunku, w którym 

chcesz przesuwać. 

 
Przesuwanie za pomocą klawiszy strzałek 

Do przesuwania w małych odstępach służą klawisze strzałek. 

Można przesuwać za pomocą klawiszy strzałek, jeśli opcja Użyj strzałek w górę/w 

dół do nawigacji po historii poleceń nie jest zaznaczona na karcie Wyświetlanie w 

menu Narzędzia > Opcje. 
 

Aby przesuwać za pomocą klawiszy strzałek 

• Naciśnij przycisk strzałki w górę, w dół, w prawo lub w lewo. 

 
Orbitowanie rysunku w czasie rzeczywistym 

ALCAD umożliwia orbitowanie rysunku lub obracanie widoku w czasie 

rzeczywistym. Pozwala to na oglądanie modelu pod dowolnym kątem w przestrzeni 

modelu. Nie można obracać widoku w przestrzeni papieru. 

 

Korzystanie z poleceń 3D Orbit w dużych plikach rysunków może wymagać dużej ilości pamięci. 

Pomocne może być ustawienie zmiennej systemowej ZOOMDETAIL na wyższą 

liczbę, aby zmniejszyć liczbę wyświetlanych jednostek. Na przykład, jeśli wartość jest 

ustawiona na 10, tylko 10. jednostka będzie wyświetlana podczas przesuwania i 

powiększania w czasie rzeczywistym. 
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Aby orbitować rysunek 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Constrained Orbit (Ograniczona 

orbita) (  ): 

• Na wstążce wybierz Widok > Ograniczona orbita (w Nawiguj). 

• W menu wybierz Widok > Orbita 3D > Ograniczona orbita. 

• Na pasku narzędzi Orbita 3D kliknij narzędzie Ograniczona orbita. 

• Wpisz 3dorbit i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Kliknij i przeciągnij lewym przyciskiem myszy, aby okrążyć rysunek. 

• Wybierz opcję Ustaw, aby wybrać inny punkt orbitowania, a następnie 

kliknij i przeciągnij myszą, aby okrążyć rysunek. 

3 Aby zatrzymać orbitowanie, zwolnij przycisk myszy. 

 

Użyj skrótu. 

Naciśnij i przytrzymaj klawisz Shift podczas wyświetlania rysunku, a następnie 

kliknij i przeciągnij środkowy przycisk myszy (kółko), aby obrócić rysunek. 
 

 
Aby orbitować rysunek przy użyciu ruchu ciągłego 

1 Wykonaj jedną z poniższych czynności, aby wybrać orbitę ciągłą (  ): 

• Na wstążce wybierz Widok > Orbita ciągła (w Nawiguj). 

• W menu wybierz Widok > Orbita 3D > Orbita ciągła. 

• Na pasku narzędzi Orbita 3D kliknij narzędzie Orbita ciągła. 

• Wpisz 3dcorbit, a następnie naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Kliknij i przeciągnij lewym przyciskiem myszy, aby okrążyć rysunek. 

• Wybierz opcję Ustaw, aby wybrać inny punkt orbitowania, a następnie 

kliknij i przeciągnij myszą, aby okrążyć rysunek. 

3 Zwolnij przycisk myszy. Widok będzie kontynuował orbitowanie. 

4 Po zakończeniu naciśnij klawisz Enter lub Esc albo kliknij rysunek prawym przyciskiem 

myszy. 

 

Możesz orbitować bez blokowania żadnej osi lub wybrać inną oś do zablokowania. 

Polecenie Swobodna orbita umożliwia orbitowanie rysunku bez zablokowanej osi. 

Użyj poleceń Constrained X Orbit, Constrained Y Orbit i Constrained Z Orbit, aby 

okrążyć rysunek, zachowując wybraną oś. Możesz także nacisnąć klawisz Ctrl i użyć 

prawego przycisku myszy, aby obrócić widok wokół osi z. 
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Zmiana powiększenia rysunku 
 

Powiększenie rysunku można zmienić w dowolnym momencie. Kursor zmienia się 

w szkło powiększające (  ), gdy aktywne jest narzędzie powiększania. Zmniejsz powiększenie, 

aby zobaczyć większą część rysunku lub powiększ, aby zwiększyć powiększenie, aby 

zobaczyć część rysunku bardziej szczegółowo. Zmiana powiększenia rysunku 

wpływa tylko na sposób wyświetlania rysunku; nie ma wpływu na wymiary jednostek 

na rysunku. 

 

Jeśli często powiększasz (i przesuwasz) określony obszar rysunku, możesz utworzyć i 

ponownie użyć widoku za pomocą Menedżera widoków. 

Szczegółowe informacje można znaleźć w sekcji "Praca z widokami nazwanymi" na stronie 284. 
 

 

Jeśli nie można powiększyć rzutni układu, może ona być zablokowana. 

Skala i widok nie zmieniają się w przestrzeni modelu podczas przesuwania lub 

powiększania w zablokowanej rzutni układu. Więcej informacji można znaleźć w 

sekcji "Modyfikowanie rzutni układu" na stronie 

529. Więcej informacji można znaleźć w sekcji Modyfikowanie rzutni układu. 
 

 
Zrozumienie zoomu 

Jednym z najprostszych sposobów zmiany powiększenia rysunku jest powiększenie 
lub pomniejszenie go o zadany przyrost. Na pasku narzędzi Powiększenie, 
narzędzie Powiększ (  ) podwaja bieżące powiększenie rysunku. Narzędzie 

Zmniejsz (  ) zmniejsza powiększenie rysunku o połowę. Część rysunku znajdująca się w 

środku bieżącej rzutni pozostaje wyśrodkowana na ekranie podczas powiększania i 
pomniejszania. 

 

 

Powiększ. Pomniejsz. 
 

Powiększanie obszaru przy użyciu okna 

Możesz utworzyć okno definiujące część rysunku, do której chcesz powiększyć. 
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Aby powiększyć obszar za pomocą okna 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Powiększ okno (  ): 

• Na wstążce wybierz polecenie Widok > Powiększ okno (w Nawiguj). 

• W menu wybierz Widok > Powiększenie > Okno. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom okna. 

• Wpisz zoom i naciśnij Enter. 

2 Wybierz jeden róg okna wokół obszaru, który chcesz powiększyć. 

3 Określ przeciwległy róg okna wokół obszaru, który chcesz powiększyć. 

 
 

  
Aby określić prostokątne okno wokół 
obszaru, który chcesz powiększyć, wybierz 
najpierw jeden róg (A), a następnie wybierz 
przeciwległy róg (B). 

Wynik. 

B 

A 
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Powiększanie jednego lub więcej podmiotów 

Można powiększyć wybrane jednostki. Okno wypełni się wybranymi podmiotami. 
 

Aby powiększyć jeden lub więcej podmiotów 

1 Wybierz jeden lub więcej podmiotów. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Zoom Entity (  ): 

• Na wstążce wybierz polecenie Widok > Powiększ jednostkę (w Nawiguj). 

• W menu wybierz Widok > Powiększenie > Jednostka. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom Entity. 

 

Powiększanie w czasie rzeczywistym 

Powiększanie w czasie rzeczywistym pozwala kontrolować zoom w tym samym 

czasie, w którym poruszasz myszą. 
 

Aby powiększyć w czasie rzeczywistym 

1 Wykonaj jedną z poniższych czynności, aby wybrać Zoom w czasie rzeczywistym (  ): 

• Na wstążce wybierz Widok > Powiększenie w czasie rzeczywistym (w Nawiguj). 

• W menu wybierz polecenie Widok > Powiększenie > Powiększenie w czasie 

rzeczywistym. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom w czasie rzeczywistym. 

• Wpisz rtzoom i naciśnij Enter. 

• Jednocześnie naciśnij i przytrzymaj klawisze Ctrl + Shift. 

2 Kliknij i przytrzymaj lewy przycisk myszy. 

3 Aby powiększyć, przesuń kursor w górę ekranu; aby pomniejszyć, przesuń kursor 

w dół ekranu. 

4 Aby zatrzymać powiększanie, zwolnij przycisk myszy. 

 
Powiększanie za pomocą myszy z kółkiem 

Każdy obrót koła w kierunku od użytkownika przybliża go 8-krotnie; każdy obrót 

w kierunku użytkownika przybliża go 1,25-krotnie. 
 

Aby powiększyć za pomocą myszy z kółkiem 

• Obróć pokrętło w kierunku od siebie, aby przybliżyć lub w kierunku do siebie, aby oddalić. 

 

Dostosowywanie kółka myszy 

Ustawienia kółka myszy można dostosować do własnego stylu pracy za pomocą 

zmiennych systemowych ZOOMWHEEL (kierunek kółka), ZOOMPERCENT 

(dokładność wyświetlania zakrzywionych obiektów) i ZOOMFACTOR 

(współczynnik powiększenia kółka). 
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Wyświetlanie poprzedniego widoku rysunku 

Po powiększeniu lub przesunięciu, aby wyświetlić część rysunku bardziej 

szczegółowo, możesz przywrócić poprzedni widok, aby zobaczyć cały rysunek. 
 

Aby wyświetlić poprzedni widok rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zoom poprzedni (  ): 

• Na wstążce wybierz polecenie Widok > Powiększ poprzedni (w Nawiguj). 

• W menu wybierz kolejno opcje Widok > Powiększenie > Poprzedni. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom poprzedni. 

Wybranie tego narzędzia powoduje wielokrotne cofanie się o maksymalnie 25 

kolejnych widoków powiększonych lub przesuniętych. 

 

Powiększanie do określonej skali 

Powiększenie widoku można zwiększać lub zmniejszać za pomocą precyzyjnego 

współczynnika skali mierzonego w stosunku do całkowitego rozmiaru rysunku lub w 

stosunku do bieżącej rzutni. Po zmianie współczynnika powiększenia część rysunku 

znajdująca się w środku bieżącej rzutni pozostaje wyśrodkowana na ekranie. 

Aby zmienić powiększenie widoku w stosunku do całkowitego rozmiaru rysunku, 

wpisz liczbę reprezentującą współczynnik skali powiększenia. Na przykład, jeśli 

wpiszesz współczynnik skali równy 2, rysunek zostanie wyświetlony w dwukrotnie 

większym rozmiarze. Wpisanie współczynnika powiększenia .5 spowoduje wyświetlenie 

rysunku w połowie jego oryginalnego rozmiaru. 

Można również zmienić powiększenie rysunku w stosunku do jego aktualnego 

powiększenia, dodając znak x po współczynniku skali powiększenia. Na przykład, jeśli 

wpiszesz współczynnik skali 2x, rysunek zostanie powiększony dwukrotnie. Po 

wpisaniu współczynnika powiększenia .5x rysunek zostanie powiększony o połowę. 
 

Aby powiększyć do określonej skali względem bieżącego ekranu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Powiększenie (  ): 

• Na wstążce wybierz Widok > Powiększenie (w Nawiguj). 

• W menu wybierz polecenie Widok > Powiększenie > Powiększ. 

• Na pasku narzędzi Powiększenie kliknij narzędzie Powiększenie. 

• Wpisz zoom i naciśnij Enter. 

2 Wpisz współczynnik skali, a następnie x (np. 2x). 

3 Naciśnij Enter. 

 
Łączenie powiększania i przesuwania 

Podczas zmiany powiększenia rysunku można określić punkt znajdujący się na środku widoku. 

Podczas zmiany powiększenia rysunku za pomocą narzędzia Zoom w lewo 

można określić punkt znajdujący się w lewym dolnym rogu widoku. 

(  ) na pasku narzędzi Zoom. Z wyjątkiem narzędzia Powiększanie okna, 
pozostałe narzędzia powiększania powiększają lub pomniejszają od środka 
bieżącego widoku. 
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Aby zmienić środek bieżącego widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Zoom Center (  ): 

• Na wstążce wybierz Widok > Centrum powiększenia (w Nawiguj). 

• W menu wybierz polecenie Widok > Powiększenie > Wyśrodkuj. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom Center. 

• Wpisz zoom, naciśnij Enter, a następnie w oknie zachęty wybierz Center. 

2 Wybierz punkt znajdujący się na środku nowego widoku. 

3 Określa współczynnik skali powiększenia lub wysokość rysunku w jednostkach 

rysunkowych. 
 

Bieżący widok pokazujący punkt, który ma zostać wyśrodkowany w nowym widoku (A), oraz nowy 
widok powiększony przy użyciu współczynnika skali 2x. 

 

Wyświetlanie całego rysunku 

Istnieją dwa główne sposoby powiększania w celu wyświetlenia całego rysunku: 

• Powiększ wszystko - wyświetla cały rysunek. Jeśli narysowałeś jakiekolwiek 

elementy poza zdefiniowanymi granicami rysunku, wyświetlane są granice 

rysunku. Jeśli wszystkie elementy znajdują się w granicach rysunku, rysunek jest 

wyświetlany aż do granic rysunku. 

• Rozszerzenie powiększenia - wyświetla rysunek tak, aby obejmował wszystkie 

elementy (do ich granic), dzięki czemu obraz wypełnia wyświetlacz w 

największym możliwym powiększeniu. 
 

Aby wyświetlić cały rysunek 

1 Aby wyświetlić cały rysunek, wykonaj jedną z następujących czynności, aby wybrać opcję 

Powiększ wszystko (  ): 

• Na wstążce wybierz polecenie Widok > Powiększ wszystko (w Nawiguj). 

• W menu wybierz kolejno opcje Widok > Powiększenie > Wszystkie. 

• Na pasku narzędzi Powiększenie kliknij narzędzie Powiększ wszystko. 

Lub, aby wyświetlić rysunek w jego rozszerzeniu, wykonaj jedną z 

następujących czynności, aby wybrać Zoom Extents (  ): 

• Na wstążce wybierz polecenie Widok > Powiększ zakres (w Nawiguj). 

• W menu wybierz polecenie Widok > Powiększenie > Rozszerzenia. 

• Na pasku narzędzi Zoom kliknij narzędzie Zoom Extents. 
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Zoom extents (wyświetla wszystkie jednostki). Zoom all (wyświetla do granic rysunku). 

 
 

 

Zmiana widoku jednostek adnotacji 
 

Jeśli rysunek zawiera jednostki adnotacji, takie jak tekst i wymiary, można zmienić 

skalę lub rozmiar tych jednostek, ustawiając skalę adnotacji. 

Jednostki, które mogą być adnotowane, obejmują tekst, tekst wielowierszowy, 

tolerancje, wymiary, linie odniesienia, linie odniesienia, atrybuty, kreskowania i 

bloki. Jeśli dla jednego z tych typów jednostek ustawiono wartość Tak i zmieniono 

skalę adnotacji, jednostka będzie wyświetlana w innej skali niż inne jednostki na 

rysunku. Na przykład, jeśli ustawisz skalę adnotacji na 1:2, wszystkie jednostki adnotacji 

będą wyświetlane w tej skali (jeśli włączona jest opcja Automatyczna adnotacja) lub 

tylko te jednostki adnotacji, które obsługują skalę 1:2, będą wyświetlane w tej skali 

(jeśli opcja Automatyczna adnotacja jest wyłączona). 

Style tekstu, style wymiarów i style multileadera również mogą być adnotacyjne, 

więc może to również dotyczyć tekstu, wymiarów lub multileaderów, którym 

przypisano styl adnotacyjny. 

 

Włączanie skalowania jednostek adnotacji 

Skalowanie adnotacji umożliwia kontrolowanie niektórych jednostek, dzięki czemu 

ich rozmiar będzie wyświetlany konsekwentnie, gdy rysunek jest wyświetlany lub 

drukowany w różnych skalach. Skalowanie adnotacji nie jest konieczne, ale jest to 

wygodny sposób kontrolowania skalowania następujących elementów: tekstu, 

tolerancji, wymiarów, linii pomocniczych, linii pomocniczych wielokrotnych, 

atrybutów, kreskowania i bloków. 

Style tekstowe, style wymiarów i style multileader mogą również używać skalowania 

adnotacji. Encje tekstowe, wymiarowe i multileader, które mają przypisany styl 

adnotacji, będą miały domyślnie włączone skalowanie adnotacji. Szczegółowe 

informacje na temat stylów tekstu można znaleźć w sekcji "Praca ze stylami tekstu" 

na stronie 404. Aby uzyskać szczegółowe informacje na temat stylów wymiarów, 

patrz "Używanie stylów wymiarów i zmiennych" na stronie 445. ALCAD obsługuje 

wyświetlanie multileaderów i ich stylów, ale nie ich edycję). 
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Aby włączyć lub wyłączyć skalowanie adnotacji dla jednego lub więcej podmiotów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz Widok > Właściwości (na ekranie). 

• W menu wybierz Modyfikuj > Właściwości. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Właściwości. 

• Wpisz entprop i naciśnij Enter. 

• Naciśnij Ctrl +1. 

Zostanie wyświetlony panel Właściwości. 

2 Wybierz żądane podmioty. 

3 W sekcji Adnotacje wybierz jedną z poniższych opcji: 

• Tak Podmioty są wyświetlane zgodnie z aktualnie ustawioną skalą adnotacji. 

• Aktualnie ustawiona skala adnotacji nie ma wpływu na żadne podmioty. 

Aby automatycznie przypisać skalę do wszystkich jednostek adnotacji 

1 Na pasku stanu włącz automatyczną adnotację, klikając dwukrotnie opcję 

Automatyczna adnotacja wł. 

2 Na pasku stanu kliknij opcję Lista wag adnotacji. 

3 Wybierz skalę adnotacji. 

Wszystkim podmiotom z adnotacjami (wszystkie podmioty z adnotacją ustawioną 

na Tak) zostanie przypisana wybrana skala adnotacji. 
 

Aby dodać bieżącą skalę adnotacji do jeszcze jednego podmiotu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dodaj bieżącą skalę (  ): 

• Na wstążce wybierz polecenie Adnotacje > Dodaj bieżącą skalę (w obszarze Skalowanie 

adnotacji). 

• W menu wybierz kolejno opcje Modyfikuj > Skala adnotacji > Dodaj bieżącą skalę. 

• Wpisz aiobjectscaleadd i naciśnij Enter. 

2 Wybierz żądane podmioty. 
 

Aby usunąć bieżącą skalę adnotacji z jeszcze jednego podmiotu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Usuń bieżącą skalę (  ): 

• Na wstążce wybierz polecenie Adnotacje > Usuń bieżącą skalę (w obszarze Skalowanie 

adnotacji). 

• W menu wybierz kolejno opcje Modyfikuj > Skala adnotacji > Usuń bieżącą skalę. 

• Wpisz aiobjectscaleremove i naciśnij Enter. 

2 Wybierz żądane podmioty. 
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Aby dodać lub usunąć skale adnotacji dla jednego lub więcej podmiotów 

1 Wykonaj jedną z poniższych czynności, aby dodać/usunąć wagi (  ): 

• Na wstążce wybierz polecenie Adnotacje > Dodaj/usuń skale (w obszarze Skalowanie 

adnotacji). 

• W menu wybierz kolejno opcje Modyfikuj > Skala adnotacji > Dodaj/usuń skale. 

• Wpisz objectcale i naciśnij Enter. 

2 Wybierz żądane podmioty. 

Okno dialogowe Skale adnotacji wyświetla listę skal adnotacji przypisanych do 

jednostek. 

3 Wykonaj jedną z poniższych czynności: 

• Kliknij przycisk Dodaj, aby wybrać skalę i przypisać ją do wszystkich wybranych 

podmiotów. 

• Wybierz skalę i kliknij przycisk Usuń, aby usunąć ją ze wszystkich wybranych jednostek. 

4 Kliknij przycisk OK. 

 

 

 

 

 

 
 

A 

 
 
 

 
B 

 
 
 

A Wyświetla skale adnotacji przypisane do 
wybranych podmiotów. 

B Wybierz, czy mają być wyświetlane wszystkie 
skale adnotacji przypisane do wybranych 
podmiotów, czy tylko te, które są wspólne. 

 
D 

C 

 
 
 
 
 
 
 
 
 
 

C Kliknięcie powoduje wyświetlenie 
wybranej skali adnotacji z wybranych 
podmiotów. 

D Kliknij, aby wybrać skalę adnotacji do 
przypisania do wybranych podmiotów. 

 

Zmiana skali jednostek adnotacji 

Skala adnotacji rysunku określa rozmiar jednostek adnotacji bez zmiany skali 

innych, nieadnotacyjnych jednostek. 

Jeśli automatyczna adnotacja jest włączona, zmiana skali adnotacji zmienia skalę lub 

rozmiar wszystkich jednostek, które mają włączone skalowanie adnotacji. Jeśli 

automatyczna adnotacja jest wyłączona, rozmiar jest zmieniany tylko dla jednostek 

adnotacji, które mają przypisaną wybraną skalę adnotacji. 
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Aby ustawić skalę adnotacji 

1 Na pasku stanu kliknij opcję Lista wag adnotacji. 

2 Wybierz skalę adnotacji. 

Wszystkie włączone jednostki adnotacji, które mają przypisaną wybraną skalę, 

będą wyświetlane w nowej skali. 

Aby automatycznie przypisać i ustawić skalę dla wszystkich jednostek adnotacji 

1 Na pasku stanu włącz automatyczną adnotację, klikając dwukrotnie opcję 

Automatyczna adnotacja wł. 

2 Na pasku stanu kliknij opcję Lista wag adnotacji. 

3 Wybierz skalę adnotacji. 

Wszystkie włączone jednostki adnotacji (wszystkie jednostki z adnotacją 

ustawioną na Tak) zostaną przypisane do wybranej skali adnotacji i będą 

wyświetlane w tej skali. 
 

Użyj zmiennej systemowej. 

Automatyczną adnotację można również ustawić za pomocą zmiennej systemowej 

ANNOAUTOSCALE. 
 

 
Wyświetlanie i ukrywanie określonych jednostek adnotacji 

Jednostce adnotacji można przypisać wiele skal, które są używane do wyświetlania 

i drukowania. Domyślnie, jeśli jednostka adnotacji nie ma przypisanej bieżącej 

skali adnotacji, nadal jest wyświetlana, ale w skali domyślnej. Alternatywnie 

można ukryć jednostki adnotacji, które nie mają przypisanej bieżącej skali 

adnotacji. 

Można ustawić stan wyświetlania dla karty Model i dla każdej karty Układ. 
 

Aby wyświetlić lub ukryć jednostki adnotacji 

1 Kliknij żądaną kartę Model lub Układ. 

2 Na pasku stanu kliknij dwukrotnie przycisk Włącz/Wyłącz widoczność adnotacji. 

 
Przywrócenie domyślnych pozycji przeglądów dokumentów 
notarialnych 

Każdy widok skali włączonej jednostki adnotacji można przenieść do różnych 

lokalizacji za pomocą edycji uchwytu. Jeśli różne widoki skali jednostki adnotacji 

zostały przeniesione, można łatwo przywrócić te widoki skali do ich pierwotnego 

punktu bazowego. 
 

Aby przywrócić widoki skali jednostek adnotacji do ich domyślnych pozycji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Synchronizuj pozycje w wielu 

skalach (  ): 

• Na wstążce wybierz polecenie Adnotacje > Synchronizuj pozycje skalowania (w obszarze 

Skalowanie adnotacji). 

• W menu wybierz kolejno opcje Modyfikuj > Skala adnotacji > Synchronizuj 

pozycje w wielu skalach. 

• Wpisz annoreset i naciśnij Enter. 



2 Wybierz żądane podmioty. 
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Wyświetlanie wielu okien 
 

Po rozpoczęciu nowego rysunku jest on wyświetlany w jednym oknie. Rysunek można 

wyświetlić w drugim oknie lub podzielić jedno okno na wiele okien. Można także 

otworzyć i wyświetlić wiele rysunków. 

 

Praca z wieloma oknami pojedynczego rysunku 

Można otworzyć kilka widoków tego samego rysunku i pracować z nimi 

jednocześnie. Istnieją dwie metody podziału bieżącego rysunku na wiele 

widoków: 

• Otwórz nowe okno otwartego rysunku. 

• Podział bieżącego okna na wiele okien. 

Po podzieleniu pojedynczego okna na wiele okien można sterować każdym oknem 

osobno. Można na przykład powiększać lub przesuwać obraz w jednym oknie bez 

wpływu na wyświetlanie w pozostałych oknach. Można sterować siatką, 

przyciąganiem i or- ganizacją widoku oddzielnie dla każdego okna. Można 

przywracać nazwane widoki w poszczególnych oknach, rysować z jednego okna do 

drugiego i nazywać konfiguracje okien indywidualnie, aby móc je później ponownie 

wykorzystać. 

Podczas rysowania wszelkie zmiany wprowadzone w jednym oknie są natychmiast 

widoczne w pozostałych. Możesz przełączać się między oknami w dowolnym 

momencie, nawet w trakcie wykonywania polecenia, klikając pasek tytułu okna. 

 

Otwieranie nowego okna tego samego rysunku 

Możesz otworzyć dodatkowe okna, aby utworzyć więcej niż jeden widok 

rysunku. Aby otworzyć nowe okno, wybierz polecenie Okno > Nowe okno. Po 

otwarciu nowego okna można zmienić jego wyświetlanie bez wpływu na inne 

okna. 

W przypadku otwarcia więcej niż jednego okna dla pojedynczego rysunku, każdemu 

oknu przypisywany jest unikalny numer (na przykład mydrawing:1, mydrawing:2 

itd.). Jeśli bieżące okno jest zmaksymalizowane, można przełączyć się do innego 

otwartego okna, wybierając jego nazwę w dolnej części menu Okno. 

Nazwy innych otwartych rysunków pojawiają się w dolnej części menu Okno. Do 

rozmieszczenia wszystkich otwartych okien i rysunków można także użyć poleceń 

Kaskada, Kafelki poziomo i Kafelki pionowo. Aby ułożyć wszystkie okna i rysunki 

w stos okien o identycznych rozmiarach, wybierz polecenie Okno > Kaskada. 

Rozmieszczenie okien i rysunków w ten sposób ułatwia wyświetlanie paska tytułu 

każdego okna. 

Aby ułożyć wszystkie okna i rysunki poziomo w kolejności od góry do dołu, 

wybierz polecenie Window > Tile Horizontally. Rozmieszczenie okien i rysunków w ten 

sposób powoduje wyświetlenie każdego otwartego okna. Rozmiar okien jest 

zmieniany w celu dopasowania do dostępnej przestrzeni. 

Aby ułożyć wszystkie okna i rysunki pionowo, tak aby znajdowały się obok siebie, 

wybierz polecenie Window > Tile Vertically. Rozmieszczenie okien i rysunków w 

ten sposób powoduje usunięcie każdego otwartego okna. Rozmiar okien jest 



zmieniany w celu dopasowania do dostępnej przestrzeni. 



 CommandResult 
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Aby zarządzać wszystkimi oknami z jednego okna dialogowego, wybierz Okno > 

Okna, aby otworzyć okno dialogowe Okna. 

ALCAD używa poleceń z poniższej tabeli do sterowania oknami. 

 
Polecenia sterujące oknami ALCAD 

 

vports Dzieli bieżące okno na dwa, trzy lub cztery okna kafelkowe. 

wcascade Kaskaduje (nakłada na siebie) wszystkie otwarte okna. 

close Zamyka bieżące okno. 

Closeall        Zamyka wszystkie okna; zamyka również wszystkie  

  rysunki.  

closeallother   Zamyka wszystkie okna z wyjątkiem bieżącego okna  

  rysunku.  

wcloseall Zamyka wszystkie okna; zamyka także wszystkie 

rysunki. 

wiarrange Układa ikony okien. 

wopen Otwiera inne okno bieżącego rysunku. 

wvtile Układa wszystkie okna pionowo. 

 

Dzielenie bieżącego okna na wiele okien 

Pojedyncze okno rysunku można podzielić na wiele okien kafelkowych (zwanych 

portami widoku) na karcie Model. Można kontrolować liczbę utworzonych okien i 

ich rozmieszczenie. Można także zapisywać i przywracać nazwane konfiguracje 

okien oraz wyświetlać listę bieżących i zapisanych konfiguracji okien. 

Podczas pracy w rzutni użyj polecenia Maksymalizuj rzutnię, aby powiększyć 

widok do pełnego rozmiaru, umożliwiając łatwą pracę nad geometrią w tym 

widoku. Po zakończeniu pracy użyj polecenia Minimalizuj rzutnię, aby powrócić 

do oryginalnej skali i punktu środkowego rzutni. 
 

Aby utworzyć wiele widoków 

1 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie (  ): 

• Na wstążce wybierz Widok > Rzutnie (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie. 

• Na pasku narzędzi Widok kliknij narzędzie Rzutnie. 

• Wpisz viewports i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Utwórz 2 rzutnie, Utwórz 3 rzutnie lub 

Utwórz 4 rzutnie. 

3 W oknie dialogowym wybierz orientację rzutni. 
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Okno rysunkowe można podzielić na dwa okna ułożone pionowo (A) lub poziomo (B); trzy okna 
ułożone w lewo (C), w prawo (D), powyżej (E), poniżej (F), pionowo (G) lub poziomo (H); lub cztery 
okna kafelkowe (I). 

 

Aby połączyć dwie rzutnie 

1 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie (  ): 

• Na wstążce wybierz Widok > Rzutnie (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie. 

• Na pasku narzędzi Widok kliknij narzędzie Rzutnie. 

• Wpisz viewports i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Dołącz. 

3 Kliknij w dowolnym miejscu wewnątrz okna, które chcesz zachować. 

4 Kliknij w dowolnym miejscu sąsiedniego okna, które chcesz dołączyć do pierwszego okna. 

5 Naciśnij Enter. 
 

Aby zmaksymalizować bieżącą rzutnię 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Maksymalizuj rzutnię (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie > Maksymalizuj rzutnię. 

• Na pasku stanu kliknij przycisk Maksymalizuj rzutnię (  ). 

• Wpisz vpmax i naciśnij Enter. 

Rzutnia zostanie powiększona. 
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Aby zminimalizować bieżącą rzutnię (jeśli jest zmaksymalizowana) 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Minimalizuj rzutnię (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie > Zminimalizuj rzutnię. 

• Na pasku stanu kliknij przycisk Minimalizuj rzutnię (  ). 

• Wpisz vpmin i naciśnij Enter. 

Rzutnia powraca do pierwotnej skali i punktu środkowego. 

 
Zapisywanie konfiguracji okien 

Jeśli okno rysunku zostało podzielone na wiele widoków, można zapisać bieżący 

układ okien, aby móc go później przywołać na ekran. Liczba i rozmieszczenie okien 

są zapisywane dokładnie tak, jak są aktualnie wyświetlane. Ustawienia dla każdego 

okna są również zapisywane. 
 

Aby nazwać i zapisać konfigurację okna 

1 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie (  ): 

• Na wstążce wybierz Widok > Rzutnie (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie. 

• Na pasku narzędzi Widok kliknij narzędzie Rzutnie. 

• Wpisz viewports i naciśnij Enter. 

2 W oknie zachęty wybierz opcję Zapisz. 

3 Wpisz nazwę konfiguracji, a następnie naciśnij klawisz Enter. 

Nazwa może mieć długość do 255 znaków i może zawierać litery, cyfry, znak 

dolara ($), myślnik (-) i podkreślnik (_) lub dowolną kombinację. 
 

Aby przywrócić nazwaną konfigurację okna 

1 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie (  ): 

• Na wstążce wybierz Widok > Rzutnie (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie. 

• Na pasku narzędzi Widok kliknij narzędzie Rzutnie. 

• Wpisz viewports i naciśnij Enter. 

2 W oknie zachęty wybierz opcję Przywróć. 

3 Wpisz nazwę konfiguracji okna, którą chcesz przywrócić. 
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Praca z wieloma rysunkami 

Dzięki funkcji interfejsu wielu dokumentów (MDI) można otworzyć więcej niż 

jeden rysunek w programie ALCAD. Ponieważ można otwierać i pracować na 

kilku rysunkach jednocześnie, można kopiować, wycinać lub wklejać elementy z 

jednego rysunku do drugiego. 

Każdy rysunek jest wyświetlany w oknie rysunku, co ma następujące zalety: 

• Możesz zobaczyć dwa lub więcej rysunków obok siebie. 

• Można łatwo kopiować jednostki z jednego rysunku do drugiego. 

• Korzystając z Eksploratora ALCAD, można kopiować takie elementy jak 

warstwy, typy linii i style tekstu z jednego rysunku do drugiego. 

• Podobnie jak w przypadku rzutni na karcie Model, okna rysowania można 

nakładać na siebie; w przeciwieństwie do rzutni na karcie Model, okna 

rysowania można maksymalizować lub zmniejszać do ikony. 

 

Jedna sesja programu ALCAD z czterema otwartymi rysunkami. 

Każde okno rysowania, które zostanie otwarte i nad którym będziesz pracować, 

zachowuje w dzienniku historii wyświetlania wszystkie wykonane polecenia, ale 

wiersz poleceń nie wskazuje, kiedy przełączyłeś okna. 

Podczas pracy z więcej niż jednym rysunkiem otwartym we własnym oknie, można 

łatwo przenosić, wycinać, kopiować i wklejać pomiędzy rysunkami. Jeśli przenosisz 

element z jednego okna do drugiego, a następnie chcesz cofnąć tę czynność, musisz 

cofnąć ją w obu rysunkach, aby odniosła skutek. Jeśli kopiujesz encję z jednego 

okna do drugiego, a następnie chcesz cofnąć tę czynność, musisz cofnąć ją z 

rysunku, do którego skopiowano encję. W przypadku wycięcia i wklejenia jednostki, 

a następnie cofnięcia tej czynności, należy ją cofnąć w obu rysunkach. 



 

Kontrolowanie elementów 
wizualnych 
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Liczba elementów na rysunku i złożoność rysunku wpływają na szybkość 

przetwarzania poleceń i wyświetlania rysunku przez ALCAD. Możesz poprawić 

ogólną wydajność programu, wyłączając wyświetlanie niektórych elementów 

wizualnych, takich jak wypełnienia bryłowe i tekst, podczas pracy nad rysunkiem. 

Gdy będziesz gotowy do wydrukowania rysunku, włącz wyświetlanie tych 

elementów, aby rysunek został wydrukowany w pożądany sposób. 

Wydajność można również poprawić, wyłączając podświetlanie wyboru jednostek, 

wyłączając wyświetlanie znaczników tworzonych podczas wybierania lokalizacji na 

rysunku oraz wyłączając wyświetlanie grubości linii. 

 

Wyświetlanie wypełnień stałych 

Można skrócić czas wyświetlania lub drukowania rysunku poprzez wyłączenie 

wypełnienia bryłowego. Gdy wypełnienia bryłowe są wyłączone, wszystkie 

wypełnione elementy, takie jak szerokie polilinie i płaszczyzny, są wyświetlane i 

drukowane jako kontury. Po włączeniu lub wyłączeniu wypełnienia bryłowego 

należy ponownie narysować rysunek, zanim zmiana zostanie wyświetlona. 

Gdy polecenie Wypełnij jest włączone, w menu Ustawienia obok niego pojawia się 

znacznik wyboru. 
 

Aby włączyć lub wyłączyć wyświetlanie wypełnień stałych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wypełnienie (  ): 

• W menu wybierz kolejno opcje Widok > Wyświetlanie > Wypełnienie. 

• Na pasku narzędzi Ustawienia kliknij narzędzie Wypełnienie. 

• Wpisz fill, a następnie naciśnij Enter. 

2 Wybierz Widok > Przerysuj. 

 

 

Napełnianie włączone. Wyłącz. 
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Wyświetlanie szybkiego tekstu 

Jednostki tekstowe wymagają znacznej ilości czasu do wyświetlenia i 

wydrukowania. Można skrócić czas wyświetlania lub drukowania rysunku poprzez 

włączenie szybkiego tekstu. Na przykład, jeśli wykonujesz wstępny wydruk 

kontrolny rysunku, możesz włączyć szybki tekst, aby przyspieszyć drukowanie. Gdy 

funkcja szybkiego tekstu jest włączona, jednostki tekstu są zastępowane 

prostokątnymi polami, które wskazują kontur obszaru zajmowanego przez tekst. Po 

włączeniu lub wyłączeniu szybkiego tekstu należy ponownie wygenerować rysunek, 

zanim zmiana zostanie wyświetlona. 
 

Aby włączyć lub wyłączyć wyświetlanie szybkiego tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz qtext, naciśnij Enter, a następnie w oknie zachęty wybierz On lub Off. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij dodatkową kartę Wyświetlanie. 

4 Zaznacz lub usuń zaznaczenie pola wyboru Włącz szybki tekst. 

5 Kliknij przycisk OK. 

6 Aby zregenerować rysunek, wykonaj jedną z następujących czynności, aby wybrać opcję 

Regen (  ): 

• Na wstążce wybierz Widok > Regeneracja. 

• W menu wybierz Widok > Regeneracja. 

• Na pasku narzędzi Widok kliknij narzędzie Regeneracja. 

• Wpisz regen i naciśnij Enter. 

 
 

Quick Textoff. Quick Text on. 
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Wyświetlanie podświetlenia 

Można poprawić ogólną wydajność programu, wyłączając podświetlanie. Po 

wybraniu jednostek do modyfikacji program podświetla je za pomocą przerywanej 

linii. Podświetlenie to znika po zakończeniu modyfikacji jednostek lub po ich 

wyczyszczeniu. Czasami podświetlanie jednostek może zająć znaczną ilość czasu. 
 

Aby włączyć lub wyłączyć podświetlanie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz highlight, naciśnij Enter, a następnie w oknie zachęty wybierz On lub Off. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij dodatkową kartę Wyświetlanie. 

4 Zaznacz lub usuń zaznaczenie pola wyboru Podświetl element po wybraniu. 

5 Kliknij przycisk OK. 

 
Wyświetlanie blipów 

Blipy można wyłączyć. Są to tymczasowe znaczniki, które pojawiają się na ekranie 

po wybraniu jednostki lub lokalizacji. Odcinki są widoczne tylko do momentu 

przerysowania rysunku. Nie można wybierać blipów; są one używane tylko jako 

odniesienie i nigdy nie są drukowane. 
 

Aby włączyć lub wyłączyć wyświetlanie blipów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz blipmode, naciśnij Enter, a następnie w oknie zachęty wybierz On lub Off. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij dodatkową kartę Wyświetlanie. 

4 Zaznacz lub usuń zaznaczenie pola wyboru Show Marker Blips. 

5 Kliknij przycisk OK. 
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Blipy włączone. Przyciski wyłączone. 
 

Wyświetlanie grubości linii 

Czas wyświetlania rysunku można skrócić, wyłączając wyświetlanie obrysów. Po 

wyłączeniu obrysów wszystkie elementy są wyświetlane jako kontury. 

Można również określić skalę grubości linii. Określ mniejszą skalę, aby wyświetlić 

cieńsze linie; określ większą skalę, aby wyświetlić grubsze linie. Na przykład 

współczynnik skali 0,5 spowoduje wyświetlanie linii o grubości 80 milimetrów jako 

40 milimetrów; współczynnik skali 2 zwiększy tę samą grubość linii do 1,6 

milimetra. Może to pomóc w rozróżnieniu różnych grubości linii wyświetlanych na 

rysunku. Dostosowanie skali wyświetlania grubości linii wpływa na sposób 

wyświetlania grubości linii na ekranie, a nie na sposób ich wyświetlania po 

wydrukowaniu. 

 

Skala lineweight może mieć wpływ na wydajność. 

Ustawienie zbyt wysokiej wagi linii może spowodować spowolnienie działania systemu. 
 

Można również dostosować jednostki pomiaru grubości linii i domyślną grubość linii. 
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Aby kontrolować wyświetlanie wagi linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

• Wpisz lweight, a następnie naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij kartę Lineweights. 

4 Wybierz lub usuń zaznaczenie opcji Wyświetl wagi linii. 

5 W polu Jednostki dla listy wybierz opcję Milimetry lub Cale. 

6 W polu Domyślny wybierz grubość linii przypisaną do warstw i jednostek, które 

używają domyślnej grubości linii. 

7 W obszarze Dostosuj skalę wyświetlania przesuń suwak do żądanej skali. 

Domyślnie suwak zaczyna się od wartości 1,00. 

8 Kliknij przycisk OK. 

 

Użyj skrótu. 

Aby włączyć lub wyłączyć wyświetlanie wagi linii, należy użyć zmiennej 

systemowej LWDISPLAY lub kliknąć dwukrotnie słowo LWT na pasku stanu. 

Podczas drukowania można włączyć lub wyłączyć podziałki wierszy. Szczegółowe 

informacje znajdują się w sekcji "Określanie opcji drukowania specjalnie dla 

układów" na stronie 540. 
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Aby zapewnić dokładność rysunku, można zlokalizować określone punkty, 

wprowadzając współrzędne podczas rysowania lub modyfikowania elementów. 

Podczas tworzenia elementów dwuwymiarowych wprowadzane są współrzędne 

dwuwymiarowe; w przypadku elementów trójwymiarowych określane są 

współrzędne trójwymiarowe. 

Można również określić współrzędne w odniesieniu do innych znanych lokalizacji 

lub jednostek na rysunku. W szczególności podczas pracy z rysunkami 

trójwymiarowymi często łatwiej jest określić współrzędne w odniesieniu do 

dwuwymiarowej płaszczyzny roboczej, zwanej układem współrzędnych 

użytkownika (UCS). 

W tej sekcji wyjaśniono, jak pracować ze współrzędnymi, w tym jak: 

• Korzystanie z dwuwymiarowych i trójwymiarowych układów współrzędnych. 

• Określ współrzędne bezwzględne i względne. 

• Określ współrzędne biegunowe, sferyczne i cylindryczne. 

• Definiowanie i manipulowanie układami współrzędnych użytkownika. 

 

 

 

 
Tematy w tym rozdziale 

Używanie współrzędnych kartezjańskich .......................................................... 218 

Korzystanie z dwuwymiarowych współrzędnych  ............................................. 221 

Korzystanie z trójwymiarowych współrzędnych  ............................................... 224 

Korzystanie z filtrów punktów xyz  .................................................................... 227 

Definiowanie układów współrzędnych użytkownika  ......................................... 229 

  7  
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Używanie współrzędnych kartezjańskich 
 

Wiele poleceń w ALCAD wymaga określenia punktów podczas rysowania lub 

modyfikowania elementów. Można to zrobić, wybierając punkty za pomocą myszy 

lub wpisując wartości współrzędnych na pasku poleceń. Program lokalizuje punkty 

na rysunku przy użyciu kartezjańskiego układu współrzędnych. 

 

Zrozumienie działania układów współrzędnych 

Kartezjański układ współrzędnych wykorzystuje trzy prostopadłe osie - x, y i z - do 

określania punktów w przestrzeni trójwymiarowej. Każda lokalizacja na rysunku 

może być reprezentowana jako punkt względem punktu współrzędnych 0,0,0, 

zwanego początkiem. Aby narysować dwuwymiarowy obiekt, należy określić 

pozycje współrzędnych poziomych wzdłuż osi x i pozycje współrzędnych 

pionowych wzdłuż osi y. W ten sposób każdy punkt na płaszczyźnie może być 

reprezentowany jako para współrzędnych składająca się ze współrzędnej x i 

współrzędnej y. 

Współrzędne dodatnie znajdują się powyżej i na prawo od początku; współrzędne 

ujemne znajdują się na lewo i poniżej początku. 

 

Trzy prostopadłe osie kartezjańskiego układu współrzędnych. 

Podczas pracy w dwóch wymiarach należy wprowadzić tylko współrzędne x i y; współrzędne 

program zakłada, że wartość osi z jest zawsze aktualną wysokością. Jednak podczas 

pracy w trzech wymiarach należy również określić wartość osi z. Gdy patrzysz na 

plan rysunku (widok z góry, patrząc w dół), oś z rozciąga się prosto z ekranu pod 

kątem 90 stopni do płaszczyzny xy. Dodatnie współrzędne znajdują się powyżej 

płaszczyzny xy, a ujemne współrzędne znajdują się poniżej płaszczyzny. 
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Wszystkie rysunki ALCAD używają stałego układu współrzędnych, zwanego 

Światowym Układem Współrzędnych (WCS), a każdy punkt na rysunku ma 

określoną współrzędną x,y,z w WCS. Można również zdefiniować dowolne układy 

współrzędnych znajdujące się w dowolnym miejscu w przestrzeni trójwymiarowej. 

Są one nazywane układami współrzędnych użytkownika i mogą być zlokalizowane 

w dowolnym miejscu w WCS i zorientowane w dowolnym kierunku. 

Można utworzyć dowolną liczbę układów współrzędnych użytkownika, zapisując 

lub redefiniując je w celu ułatwienia tworzenia trójwymiarowych jednostek. 

Definiując UCS w WCS, można uprościć tworzenie większości trójwymiarowych 

jednostek do kombinacji jednostek dwuwymiarowych. 

Aby pomóc w utrzymaniu orientacji w bieżącym układzie współrzędnych, program 

wyświetla ikonę układu współrzędnych. Gdy rozpoczynasz nowy rysunek, 

automatycznie znajdujesz się w układzie współrzędnych WCS, oznaczonym literą W 

na ikonie. Podczas wyświetlania rysunku w widoku planu, ikona układu 

współrzędnych jest widoczna od góry, z osią z skierowaną prosto do użytkownika. 

Po wyświetleniu trójwymiarowego rysunku w widoku innym niż widok planu, ikona 

układu współrzędnych zmienia się, aby odzwierciedlić nowy punkt widzenia. 

 

Widoczne części osi to kierunki dodatnie. 

Niewidoczne części to kierunki ujemne. 
 

 

Ikona WCS. Plan Ikona UCS.Widok  3D Ikona WCS. 

Ikona ALCAD UCS wygląda inaczej niż ikona UCS w AutoCAD, ponieważ 

zawiera więcej informacji. Trzy kolory reprezentują trzy osie, ułatwiając 

rozpoznanie orientacji w przestrzeni trójwymiarowej: 

• Oś x: czerwona 

• Oś y: zielona 

• Oś z: niebieska 

Jeśli wolisz jeden kolor dla kursora i ikony UCS, możesz to zmienić za pomocą 

polecenia config lub options. 
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Zrozumienie sposobu wyświetlania współrzędnych 

Bieżąca pozycja kursora jest wyświetlana jako współrzędne x,y,z na pasku stanu i 

domyślnie jest aktualizowana dynamicznie podczas przesuwania kursora. Można 

przełączyć wyświetlanie współrzędnych do trybu statycznego, naciskając klawisz 

F6, aby były one aktualizowane tylko po wybraniu punktu na rysunku. 

Można również zmienić wyświetlanie współrzędnych na inny tryb dynamiczny, 

który pokazuje odległość i kąt (zamiast współrzędnych x,y,z), gdy program 

wyświetla linię gumową. Aby to zrobić, wybierz Narzędzia > Ustawienia rysowania 

i wybierz kartę Wyświetlanie. W sekcji Wyświetlanie współrzędnych wybierz opcję 

Współrzędne w postaci biegunowej dla wyboru odległości i kąta. 

 

 

Wyświetlanie współrzędnych można kontrolować w oknie dialogowym Ustawienia rysunku. 



P R A C A Z K O R D Y N A T A M I 221 

 
 

Znajdowanie współrzędnych punktu 

Aby znaleźć współrzędne x,y,z dla punktu na jednostce, takiego jak punkt końcowy 

linii, wybierz odpowiednie przyciąganie jednostki (takie jak Punkt końcowy) przed 

wybraniem jednostki. Jeśli nie ustawiono przyciągania encji, wyświetlane są 

współrzędne x,y określonego punktu, a współrzędna z jest równa bieżącej 

wysokości. 
 

Aby znaleźć współrzędną punktu na rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać ID Coordinates (  ): 

• Na wstążce wybierz opcję Narzędzia > Współrzędne ID (w zapytaniu). 

• W menu wybierz Narzędzia > Zapytanie > Współrzędne ID. 

• Na pasku narzędzi Zapytania kliknij narzędzie Współrzędne ID. 

• Wpisz idpoint i naciśnij Enter. 

2 Wybierz punkt, dla którego chcesz znaleźć współrzędne. 

Jeśli pasek poleceń jest aktywny, współrzędne x,y,z wybranego punktu są 

wyświetlane na pasku poleceń. 

Jeśli pasek poleceń nie jest aktywny, wyświetlone zostanie okno Prompt 

History, pokazujące współrzędne x,y,z wybranego punktu. 

 

 
 

Korzystanie z dwuwymiarowych współrzędnych 
 

Podczas pracy w dwóch wymiarach określa się punkty na płaszczyźnie xy. Można 

określić dowolny punkt jako współrzędną bezwzględną (lub współrzędną 

kartezjańską), używając dokładnej lokalizacji współrzędnej x i współrzędnej y w 

odniesieniu do początku (punkt współrzędnej 0,0, w którym przecinają się dwie 

osie) lub jako współrzędną względną w odniesieniu do poprzedniego punktu. Można 

również określić punkty przy użyciu względnych lub bezwzględnych współrzędnych 

biegunowych, które lokalizują punkt przy użyciu odległości i kąta. 

 

Wprowadzanie bezwzględnych współrzędnych kartezjańskich 

Aby wprowadzić bezwzględne współrzędne kartezjańskie, wpisz lokalizację punktu 

na pasku poleceń. Na przykład, aby użyć bezwzględnych współrzędnych 

kartezjańskich do narysowania linii od punktu początkowego (0,0) do punktu 

znajdującego się 3 jednostki w prawo i 1 jednostkę powyżej punktu początkowego, 

uruchom polecenie Line i odpowiadaj na monity w następujący sposób: 

Początek linii: 0,0 

Kąt - Długość - <Punkt końcowy>: 3,1 



 
 
 
 

(0, 0) 
(3, 1) 
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Rysowanie linii przy użyciu metody bezwzględnych współrzędnych kartezjańskich. 

W przypadku korzystania z bezwzględnych współrzędnych kartezjańskich należy 

znać dokładną lokalizację punktów dla wszystkich rysowanych elementów. Na 

przykład, aby użyć bezwzględnych współrzędnych kartezjańskich do narysowania 

kwadratu o boku 8,5 z lewym dolnym rogiem w punkcie 4,5, należy określić, że 

lewy górny róg znajduje się w punkcie 4,13,5, prawy górny róg w punkcie 12,5,13,5, 

a prawy dolny róg w punkcie 12,5,5. 

 

Wprowadzanie względnych współrzędnych kartezjańskich 

Inną, prostszą metodą jest użycie względnych współrzędnych kartezjańskich: 

określasz lokalizację na rysunku, określając jej położenie względem ostatniej 

określonej współrzędnej. Aby użyć względnych współrzędnych kartezjańskich, 

wpisz wartości współrzędnych na pasku poleceń, poprzedzając je symbolem at (@). 

Para współrzędnych po symbolu @ reprezentuje odległość wzdłuż osi x i osi y do 

następnego punktu. Na przykład, aby narysować kwadrat o boku 8,5 jednostki z 

lewym dolnym rogiem w punkcie 4,5 przy użyciu względnych współrzędnych 

kartezjańskich, uruchom polecenie Linia, a następnie odpowiadaj na monity w 

następujący sposób: 

Początek linii: 4,5 

Kąt - Długość - <Punkt końcowy>: @8.5,0 

Kąt - Długość - Idź za - Cofnij - <Punkt końcowy>: @0,8.5 

Kąt - Długość - Śledź - Zamknij - Cofnij - <Punkt końcowy>: @-8.5,0 

Kąt - Długość - Idź za - Zamknij - Cofnij - <Punkt końcowy>: C 



   @-8.5, 0 
 
 
 

@0, 8.5 

 
(4, 5) 

P R A C A Z K O R D Y N A T A M I 223 

 

 

Rysowanie kwadratu przy użyciu metody względnych współrzędnych kartezjańskich; wprowadź C, aby 
zamknąć. 

Pierwsza współrzędna względna (@8.5,0) lokalizuje nowy punkt 8,5 jednostki w 

prawo (wzdłuż osi x) od poprzedniego punktu 4,5; druga współrzędna względna 

(@0,8.5) lokalizuje następny punkt 8,5 jednostki powyżej (wzdłuż osi y) 

poprzedniego punktu i tak dalej. Wpisanie C (Close) powoduje narysowanie 

ostatniego segmentu linii z powrotem do pierwszego punktu określonego podczas 

uruchamiania polecenia Line. 

 

Wprowadzanie współrzędnych biegunowych 

Użycie względnych współrzędnych biegunowych sprawia, że narysowanie kwadratu 

nachylonego pod kątem 45 stopni jest prostym zadaniem. Współrzędne biegunowe 

opierają lokalizację punktu na odległości i kącie od początku (współrzędna 

bezwzględna) lub od poprzedniego punktu (współrzędna względna). 

Aby określić współrzędne biegunowe, wpisz odległość i kąt, oddzielając je 

otwartym nawiasem kątowym (<). Na przykład, aby użyć względnych 

współrzędnych biegunowych do określenia punktu oddalonego o 1 jednostkę od 

poprzedniego punktu i pod kątem 45 stopni, wpisz @1<45. 

Aby narysować kwadrat z przykładu w poprzedniej sekcji "Wprowadzanie 

względnych współrzędnych kar- tezjańskich", tym razem nachylony pod kątem 45 

stopni, uruchom polecenie Line, a następnie odpowiadaj na monity w następujący 

sposób: 

Początek linii: 4,5 

Kąt - Długość - <Punkt końcowy>: @8.5<45 

Kąt - Długość - Śledź - Cofnij - <Punkt końcowy>: @8.5<315 

Kąt - Długość - Śledź - Zamknij - Cofnij - <Punkt końcowy>: @8.5<225 

Kąt - Długość - Idź za - Zamknij - Cofnij - <Punkt końcowy>: C 



@8.5<45 
@8.5<315 

@8.5<225 
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Rysowanie pochylonego kwadratu przy użyciu metody względnych współrzędnych biegunowych; wprowadź 
C, aby zamknąć. 

 

W tym przykładzie przyjęto domyślne ustawienia programu. 

Podobnie jak wszystkie przykłady w tym przewodniku, w przykładzie przyjęto 

ustawienia domyślne: Kąty rosną przeciwnie do ruchu wskazówek zegara i maleją 

zgodnie z ruchem wskazówek zegara. Kąt 315 stopni jest taki sam jak kąt -45 stopni. 
 

 

 

 

Korzystanie ze współrzędnych trójwymiarowych 
 

Określanie współrzędnych w przestrzeni trójwymiarowej jest podobne do pracy w 

dwóch wymiarach, z wyjątkiem tego, że do lokalizacji współrzędnych używana 

jest również oś z. Współrzędne trójwymiarowe są reprezentowane w formacie 

x,y,z (na przykład 2,3,6). 

 

Korzystając z reguły prawej ręki 

Aby zwizualizować, jak ALCAD działa z trójwymiarową przestrzenią, użyj techniki 

znanej jako reguła prawej ręki. Trzymaj prawą rękę w luźnej pięści z dłonią skierowaną do 

siebie. Wyciągnij kciuk w kierunku dodatniej osi x i palec wskazujący w górę w 

kierunku dodatniej osi y. Następnie wyciągnij środkowy palec prosto do siebie w 

kierunku osi z. Te trzy palce są teraz skierowane odpowiednio w dodatnich 

kierunkach x, y i z. 

Możesz także użyć reguły prawej ręki, aby określić dodatni kierunek obrotu. Skieruj 

kciuk w dodatnim kierunku osi, wokół której chcesz się obracać, a następnie zwiń 

pozostałe palce w kierunku dłoni. Palce te zwijają się w dodatnim kierunku obrotu. 
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Reguła prawej ręki pomaga określić dodatni kierunek osi x, y i z oraz dodatni kierunek 
obrotu. 

 

Wprowadzanie współrzędnych x,y,z 

Podczas pracy w trzech wymiarach można określić współrzędne x,y,z jako 

bezwzględne odległości w stosunku do początku (punkt współrzędnych 0,0,0, w 

którym przecinają się trzy osie) lub jako współrzędne względne w oparciu o ostatnio 

wybrany punkt. Na przykład, aby określić punkt 3 jednostki wzdłuż dodatniej osi x, 4 

jednostki wzdłuż dodatniej osi y i 2 jednostki wzdłuż dodatniej osi z, należy określić 

współrzędne 3,4,2. 

 

Wprowadzanie współrzędnych sferycznych 

Podczas pracy w przestrzeni trójwymiarowej można użyć współrzędnych 

sferycznych do określenia punktu trójwymiarowego, wprowadzając jego odległość 

od początku (odległość bezwzględna) lub ostatniego punktu (odległość względna), 

wraz z kątem w płaszczyźnie xy i kątem w górę od płaszczyzny xy. W formacie 

sferycznym każdy kąt jest oddzielany nawiasem otwartym (<). 

Tak więc, aby narysować linię od początku do punktu oddalonego o 10.2500 

jednostek rysunkowych, pod kątem 45 stopni od osi x i 35 stopni od płaszczyzny 

xy, uruchom polecenie Line, a następnie odpowiedz na następujące monity: 

Początek linii: 0,0,0 

Kąt - Długość - <Punkt końcowy>: 10.2500<45<35 
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Rysując linię od punktu początkowego (A) do punktu końcowego (B) przy użyciu 
współrzędnych sferycznych, należy określić jej długość (C, w tym przypadku 10,2500 
jednostek), kąt w płaszczyźnie xy (D, w tym przypadku 45 stopni) oraz kąt w stosunku do 
płaszczyzny xy (E, w tym przypadku 35 stopni). 

 

Wprowadzanie współrzędnych cylindrycznych 

Podczas pracy w przestrzeni trójwymiarowej można również użyć współrzędnych 

cylindrycznych do określenia punktu trójwymiarowego. Punkt można określić, 

wprowadzając jego odległość od początku (odległość bezwzględna) lub ostatniego 

punktu (odległość względna), kąt w płaszczyźnie xy oraz wartość współrzędnej z. 

W formacie cylindrycznym odległość i kąt oddziela się otwartym nawiasem 

kątowym (<), a kąt i wartość z oddziela się przecinkiem. Na przykład, aby 

narysować linię od ostatniego punktu do punktu oddalonego o 7,4750 jednostki, pod 

kątem 27 stopni od osi x w płaszczyźnie xy i 3 jednostki w górę w kierunku z, 

uruchom polecenie Line, a następnie odpowiadaj na monity w następujący sposób: 

Początek linii: (wybierz punkt A) 

Kąt - Długość - <Punkt końcowy>: @7.4750<27,3 

 

Rysując linię od punktu początkowego (A) do punktu końcowego (B) przy użyciu 
współrzędnych cylindrycznych, należy określić jej długość (C, w tym przypadku 
7,4750), kąt w płaszczyźnie xy (D, w tym przypadku 27 stopni) i odległość w kierunku 
z (E, w tym przypadku 3 jednostki). 



 

Korzystanie z filtrów 
punktów xyz 
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Filtry punktów zapewniają metodę lokalizowania punktu na rysunku względem 

innego punktu bez określania całej współrzędnej. Korzystając z filtru punktu, można 

wprowadzić współrzędne częściowe, a następnie program wyświetli monit o podanie 

pozostałych informacji o współrzędnych. Aby użyć filtrów punktu xyz, należy 

odpowiedzieć na monit o współrzędną z filtrem w następującej formie: 

.coordinate 

gdzie współrzędna to jedna lub więcej liter x, y i z. Następnie program wyświetli 

monit o podanie przefiltrowanych współrzędnych. Na przykład, jeśli wpiszesz .xy, 

program wyświetli monit o wybranie punktu, którego współrzędną xy chcesz wybrać, a 

następnie wyświetli monit o współrzędną z. Filtry .x, .y, .z, .xy, .xz i .yz są 

prawidłowe. 

 

Korzystanie z filtrów punktowych w dwóch wymiarach 

Filtrów punktów można używać podczas pracy w dwóch wymiarach, aby 

zlokalizować punkty w odniesieniu do istniejących obiektów. Na przykład, aby 

narysować okrąg wyśrodkowany w prostokącie, należy uruchomić polecenie Okrąg, 

a następnie odpowiedzieć na następujące monity: 

2Point - 3Point - RadTanTan - Arc - Multiple - <Środek okręgu>: .y 

Wybierz Y z: mid 

Snap to midpoint of: (wybierz lewą stronę prostokąta) Nadal 

potrzebujesz XZ: mid 

Snap to midpoint of: (wybierz górną część prostokąta) 

Średnica - <Promień>: (określ promień okręgu) 

 

Do wyśrodkowania okręgu można użyć filtrów punktowych, wybierając osobno 
punkty środkowe dwóch boków prostokąta (A i B), a następnie określając jego 
promień. 
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Korzystanie z filtrów punktowych w trzech wymiarach 

Podczas pracy w przestrzeni trójwymiarowej można użyć filtrów punktów, aby 

zlokalizować punkty w dwóch wymiarach, a następnie określić współrzędną z jako 

wysokość nad płaszczyzną xy. Na przykład, aby rozpocząć rysowanie linii od 

punktu o współrzędnej z 3 jednostki powyżej środka okręgu, należy wstawić okrąg, 

a następnie uruchomić polecenie Linia i odpowiadać na monity w następujący 

sposób: 

ENTER, aby użyć ostatniego punktu - Follow - <początek linii>: .xy 

Wybierz XY z: cen 

Snap to centerpoint of: (wybierz punkt na okręgu) 

Nadal potrzebne jest Z wynoszące: 3 (lokalizuje punkt początkowy 3 

jednostki powyżej środka okręgu) 

Długość linii: (określić długość linii) 

 

Możesz użyć filtrów punktowych do narysowania linii, wybierając najpierw 
punkt na płaszczyźnie xy (A), określając współrzędną z (B), a następnie 
określając długość linii (C). 



 

Definiowanie układów 
współrzędnych użytkownika 
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Układ współrzędnych użytkownika (UCS) to kartezjański układ współrzędnych z 

początkiem i orientacją zdefiniowanymi przez użytkownika. 

 

Zrozumienie systemów współrzędnych użytkownika 

Podczas pracy w przestrzeni trójwymiarowej można zdefiniować UCS z własnym 

początkiem 0,0,0 i orientacją oddzielną od WCS. Można utworzyć dowolną liczbę 

systemów współrzędnych użytkownika, a następnie zapisywać je i przywoływać w 

razie potrzeby, aby uprościć konstrukcję trójwymiarowych obiektów. 

Na przykład można utworzyć oddzielny układ UCS dla każdej strony budynku. 

Następnie, przełączając się na UCS dla wschodniej strony budynku, można 

narysować okna po tej stronie, określając tylko ich współrzędne x i y. Po utworzeniu 

jednego lub więcej układów współrzędnych użytkownika wpis współrzędnych jest 

oparty na bieżącym układzie współrzędnych UCS. 

 

UCS wyrównany z przednią ścianą domu. 
 

Definiowanie układu współrzędnych użytkownika 

Aby zdefiniować UCS, można użyć jednej z poniższych metod: 

• Określ nowy początek i punkty na dodatnich osiach x i y. 

• Określ nowy początek i punkt na dodatniej osi z. 

• Dostosowanie UCS do istniejącego podmiotu. 

• Obrót bieżącego układu UCS wokół dowolnej osi. 

• Wyrównaj układ UCS tak, aby jego oś z była równoległa do bieżącego kierunku 

wyświetlania. 

• Wyrównuje płaszczyznę UCS xy prostopadle do bieżącego widoku. 

Po zdefiniowaniu nowego UCS ikona UCS zmienia się, aby wskazać początek i 

orientację nowego UCS. 
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Aby zdefiniować UCS, określając nowy początek i punkty na dodatnich 

osiach x i y 

1 Wykonaj jedną z poniższych czynności, aby wybrać system współrzędnych użytkownika ( ):
 

• Na wstążce wybierz Rysuj > Układy współrzędnych użytkownika 

lub wybierz Widok > Układy współrzędnych użytkownika. 

• W menu wybierz Narzędzia > Układy współrzędnych użytkownika > 

Wybierz predefiniowany układ współrzędnych użytkownika. 

• Na pasku narzędzi UCS kliknij narzędzie Select a Predefined UCS. 

• Wpisz setucs i naciśnij Enter. 

2 W oknie dialogowym Układy współrzędnych użytkownika kliknij opcję Eksploruj układy 

współrzędnych użytkownika. 

3 W Eksploratorze ALCAD upewnij się, że wybrano Układy współrzędnych i 

kliknij narzędzie Nowy element (  ). 

4 W oknie dialogowym wybierz opcję 3 Point (3 punkty). 

5 Wybierz nowe źródło. 

6 Wybierz punkt na dodatniej osi x. 

7 Wybierz punkt w dodatnim kierunku y. 

8 W oknie dialogowym ALCAD Explorer - Coordinate Systems wpisz nazwę 

nowego UCS, a następnie zamknij okno dialogowe. 
 

Zdefiniuj nowy UCS, wybierając początek (A), punkt na dodatniej osi x 
(B) i punkt w dodatnim kierunku y (C). 

 

Korzystanie ze wstępnie ustawionego układu współrzędnych 
użytkownika 

ALCAD pozwala wybrać wstępnie ustawiony UCS. Sześć płaszczyzn 

zdefiniowanych przez spojrzenie wzdłuż osi x, y, z wyrównuje UCS z górą, lewą, 

przednią, dolną, prawą lub tylną, w oparciu o WCS lub bieżący UCS 

obowiązujący po wybraniu narzędzia. Można również wybrać poprzedni układ 

UCS, wyrównać układ UCS do bieżącego widoku lub wybrać układ WCS. 

Po wybraniu układu UCS orientacja kursora i ikona układu UCS zmieniają się, aby 

odzwierciedlić nowy układ UCS. Wyświetlanie nie zmienia się jednak, chyba że 

zaznaczone zostanie pole wyboru Change View To Plan View Of The Selected UCS. 
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Po wyrównaniu UCS do wstępnie ustawionego UCS można użyć Eksploratora 

ALCAD, aby zapisać UCS. Aby to zrobić, w oknie Eksploratora ALCAD wybierz 

Edytuj > Nowy > UCS, a następnie wybierz Bieżący. 
 

Aby wybrać zaprogramowany układ UCS 

1 Wykonaj jedną z poniższych czynności, aby wybrać system współrzędnych użytkownika (

 ): 

• Na wstążce wybierz Rysuj > Układy współrzędnych użytkownika 

lub wybierz Widok > Układy współrzędnych użytkownika. 

• W menu wybierz Narzędzia > Układy współrzędnych użytkownika > 

Wybierz predefiniowany układ współrzędnych użytkownika. 

• Na pasku narzędzi UCS kliknij narzędzie Select a Predefined UCS. 

• Wpisz setucs i naciśnij Enter. 

2 W sekcji Ustaw wybrany układ współrzędnych UCS względem wybierz opcję 

Bieżący układ współrzędnych UCS, aby zmienić na nowy układ współrzędnych 

UCS poprzez zmianę orientacji względem bieżącego układu współrzędnych UCS 

lub Światowy układ współrzędnych (WCS), aby oprzeć orientację nowego układu 

współrzędnych UCS na WCS. 

3 W sekcji Wybierz UCS kliknij przycisk odpowiadający UCS, który ma być 

nowym bieżącym UCS. 
 

Wstępnie ustawione UCS są również dostępne w oknie dialogowym. 

Wybierz Format > Układy współrzędnych użytkownika, a następnie wybierz z listy 

predefiniowany układ współrzędnych użytkownika. Wstępnie ustawione układy 

UCS są również dostępne bezpośrednio na pasku narzędzi UCS. 
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ALCAD Explorer zapewnia potężny i wygodny sposób utrzymywania i zarządzania 

wieloma funkcjami i ustawieniami rysunków. Możesz użyć ALCAD Explorer do 

pracy z warstwami, typami linii, stylami tekstu, układami współrzędnych, 

nazwanymi widokami, blokami, stylami wymiarów i innymi elementami w bieżącym 

rysunku lub do kopiowania tych informacji między rysunkami. 

W tej sekcji wyjaśniono, jak używać ALCAD Explorer do: 

• Organizowanie informacji na warstwach, zarządzanie warstwami i praca ze stanami warstw. 

• Tworzenie i używanie typów linii. 

• Wczytywanie czcionek tekstowych i tworzenie stylów tekstu. 

• Wybieranie i kontrolowanie układów współrzędnych. 

• Zapisywanie i przywracanie nazwanych widoków. 

• Praca z układami. 

• Zapisywanie, wstawianie i zarządzanie blokami i odniesieniami zewnętrznymi. 

• Praca z grupami. 

• Praca z materiałami. 

• Kopiowanie, wycinanie i wklejanie stylów wymiarów między plikami .dwg. 

Tematy w tym rozdziale 

Korzystanie z ALCAD Explorer  ....................................................................... 234 

Organizowanie informacji na warstwach  ......................................................... 240 

Praca z linetypes  ............................................................................................ 267 

Praca ze stylami tekstu .................................................................................... 276 

Praca z układami współrzędnych ..................................................................... 281 

Praca z widokami nazwanymi .......................................................................... 284 

Praca z układami ............................................................................................. 288 

Praca z blokami  .............................................................................................. 291 

Praca z odwołaniami do plików zewnętrznych  ................................................ 298 

Praca ze stylami wymiarów  ............................................................................. 301 

Praca z grupami ............................................................................................... 304 

Praca z materiałami  ........................................................................................ 306 
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Korzystanie z ALCAD Explorer 
 

ALCAD Explorer umożliwia przeglądanie, tworzenie, kopiowanie i edytowanie 

warstw, stanów warstw, typów linii, stylów tekstu, układów współrzędnych, 

bloków, stylów wymiarów i innych elementów w rysunkach. Możesz także użyć 

ALCAD Explorer do kopiowania tych elementów z jednego otwartego rysunku do 

drugiego. ALCAD Explorer to świetny sposób na zarządzanie i konserwację 

rysunków. 

 

Wyświetlanie Eksploratora ALCAD 

ALCAD Explorer otwiera się we własnej, oddzielnej palecie lub oknie, które można 

przenosić lub zmieniać jego rozmiar. ALCAD Explorer posiada własne menu i 

narzędzia. 
 

Aby wyświetlić ALCAD Explorer 

Wykonaj jedną z poniższych czynności, aby wybrać ALCAD Explorer ( ):  

• Na wstążce wybierz Narzędzia > ALCAD Explorer (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj warstwy (lub 

dowolną inną pozycję). 

• Na pasku narzędzi Narzędzia kliknij narzędzie ALCAD Explorer. 

• Wpisz explorer i naciśnij Enter. 
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Domyślnie ALCAD Explorer wyświetla się jako paleta. 

 
 

A 
B 

 
 
 
 
 
 
 

C 

 
 
 
 
 
 
 
 
 

 
A Kliknij, aby włączyć lub wyłączyć automatyczne 

ukrywanie palety. 
Dostępne, gdy eksplorator jest paletą 
zablokowaną. 

B Kliknij, aby wybrać pozycję i przezroczystość 
palety. (Dostępne, gdy paleta jest zablokowana). 

 
D 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
C Dwukrotne kliknięcie elementu otwiera jego 

paletę. 

D Narzędzia na pasku narzędzi ALCAD Explorer 
zapewniają elementy sterujące wspólne dla 
wszystkich elementów. 



 ToolFunction 
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Możesz kliknąć narzędzie Pokaż jako palety, aby zamiast tego wyświetlić 

Eksplorator ALCAD jako okno dialogowe, które umożliwia przeglądanie 

elementów dla każdego otwartego rysunku. Intelli- CAD Explorer wyświetla elementy, 

takie jak warstwy, stany warstw, typy linii itp. po lewej stronie i odpowiadające im 

ustawienia rysunku po prawej stronie. 

 

 

 
A E 

B D 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
A Narzędzia na pasku narzędziALCADExplorer zapewniają 

kontrolę wspólną dla wszystkich elementów. 

B PanelElements wyświetla nazwę każdego aktualnie otwartego 
rysunku i zawiera listę elementów, którymi można sterować na 
każdym rysunku. 

C 

C Kliknij ustawienie, aby je zmienić. 

D Nazwane ustawienia dla wybranego elementu. 

E Inne narzędzia pojawiają się w zależności od wyboru panelu Elementy. 

 

Za pomocą Eksploratora ALCAD można tworzyć, usuwać lub modyfikować 

dowolne ustawienia dla aktualnie wybranego elementu dla danego rysunku. Można 

również skopiować zawartość dowolnego elementu z jednego rysunku do drugiego. 

Narzędzia i pozycje menu w oknie Intelli- CAD Explorer zapewniają następujące 

funkcje: 

 
Narzędzia ALCAD Explorer 

 

( ) Nowy element Tworzy nową warstwę, typ linii, styl tekstu, układ współrzędnych, widok, 
blok, odniesienie zewnętrzne lub styl wymiaru. 

 

( ) Bieżący Sprawia, że wybór jest aktualny. 

 

(  ) Wytnij Wycina zaznaczenie do schowka. 

(  ) Kopiuj Kopiuje zaznaczenie do schowka. 

( ) Wklej Wkleja ten wybór ze schowka do odpowiedniej listy innego 
rysunku. 

 



 ToolFunction 

) Pomoc 
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Narzędzia ALCAD Explorer 
 

(  ) Usuń Usuwa zaznaczenie z listy. 

(  ) Oczyść Eliminuje elementy bez odniesienia z pliku rysunku. 

(  ) Regen Przelicza wyświetlanie dla bieżącego okna. 

(  ) On/Off Regen Włącza lub wyłącza ponowne przeliczanie wyświetlacza. 

 

Ustawienia kopiowania 

Szczególnie potężną cechą Eksploratora ALCAD jest możliwość kopiowania wielu 

ustawień - warstw, typów linii, stylów tekstu, układów współrzędnych, widoków, 

bloków lub stylów wymiarów - z jednego rysunku do drugiego. Jeśli masz otwarty 

więcej niż jeden rysunek, Eksplorator ALCAD ułatwia ponowne wykorzystanie 

informacji. Na przykład, podczas kopiowania warstw z jednego rysunku do 

drugiego, nazwy warstw, jak również ich typy linii, kolory i inne ustawienia są 

również kopiowane, ale nie elementy na tych warstwach. 
 

Aby skopiować warstwy z jednego otwartego rysunku do innego otwartego rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 W panelu Elementy wybierz rysunek, z którego chcesz skopiować warstwy. 

3 W razie potrzeby kliknij symbol plusa (+), aby rozwinąć listę elementów 

rysunku, a następnie kliknij opcję Warstwy. 

4 Na liście Layers Settings In Drawing (prawy panel) wybierz warstwy, które 

chcesz skopiować. 

5 Wybierz polecenie Edycja > Kopiuj lub kliknij narzędzie Kopiuj (  ). 

6 W panelu Elementy wybierz rysunek, do którego chcesz skopiować warstwy. 

7 W razie potrzeby kliknij symbol plusa (+), aby rozwinąć listę elementów 

rysunku, a następnie kliknij Warstwy. 

8 Wybierz polecenie Edycja > Wklej lub kliknij narzędzie Wklej ( ). 
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Usuwanie ustawień 

Możesz użyć Eksploratora ALCAD, aby usunąć wiele elementów, które pojawiają 

się na liście elementów. Możesz usunąć warstwę, typ linii, styl tekstu, układ 

współrzędnych, widok, blok lub styl wymiaru. 

Ze względu na to, że elementy mogły już zostać utworzone na określonej warstwie 

lub przy użyciu określonego typu linii lub stylu tekstu, usunięcie jednego z tych 

elementów wymaga dokonania pewnych wyborów spośród opcji prezentowanych 

przez program. Na przykład, jeśli spróbujesz usunąć warstwę, program wyświetli 

monit o określenie, czy chcesz przenieść dowolne elementy z tej warstwy na inną 

warstwę. Każdy rysunek ma co najmniej jedną warstwę, warstwę domyślną o nazwie 

"0". Warstwy tej nie można usunąć ani zmienić jej nazwy. Rysunek może również 

zawierać nieograniczoną liczbę dodatkowych warstw, z których każda ma przypisaną 

unikalną nazwę. 

W przypadku próby usunięcia typu linii program wyświetli monit o określenie, czy 

wszystkie elementy narysowane przy użyciu tego typu linii mają zostać przekonwertowane na inny 

typ linii. W przypadku próby usunięcia stylu tekstu program wyświetli monit o 

określenie, czy wszystkie elementy tekstowe utworzone przy użyciu tego stylu mają 

zostać przekonwertowane na inny styl. 
 

Aby usunąć warstwę i przenieść jej jednostki do innej warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Z listy Layer Name wybierz warstwę, którą chcesz usunąć. 

Jeśli warstwa ta jest warstwą bieżącą, warstwa 0 automatycznie staje się warstwą bieżącą. 

3 Wybierz polecenie Edycja > Usuń lub kliknij narzędzie Usuń (  ). 

4 W oknie dialogowym kliknij opcję Zmień, a następnie wybierz warstwę, do 

której chcesz przenieść jednostki. 
 

Usunięcie warstwy i jej elementów. 

Na pasku poleceń wpisz LAYDEL, a następnie wybierz jednostkę przypisaną do 

warstwy, którą chcesz usunąć. Użycie tej metody usuwa również wszystkie jednostki 

przypisane do warstwy. 
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Elementy oczyszczające 

Z poziomu Eksploratora ALCAD można wyeliminować nieużywane bloki, 

warstwy, typy linii, style tekstu, style wymiarów lub skale adnotacji z pliku 

rysunku. Usunięcie nieużywanych elementów może znacznie zmniejszyć rozmiar 

pliku rysunku. 
 

Aby wyczyścić element 

1 Wykonaj jedną z poniższych czynności, aby wybrać ALCAD Explorer ( ):  

• Na wstążce wybierz Narzędzia > ALCAD Explorer (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer. 

• Na pasku narzędzi Narzędzia kliknij narzędzie ALCAD Explorer. 

• Wpisz explayers i naciśnij Enter. 

2 Wybierz element, z którego chcesz usunąć elementy bez odniesienia. 

3 Wybierz polecenie Edycja > Oczyść lub kliknij narzędzie Oczyść ( ). 
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Organizowanie informacji na warstwach 
 

Zrozumienie warstw 

Warstwy w ALCAD przypominają przezroczyste nakładki używane podczas 

ręcznego rysowania. Warstwy służą do organizowania różnych typów informacji 

rysunkowych. W programie ALCAD każda jednostka na rysunku istnieje na 

warstwie. Podczas rysowania elementu jest on tworzony na bieżącej warstwie. 

Widoczność warstw można kontrolować w poszczególnych rzutniach. Po 

wyłączeniu warstwy obiekty narysowane na tej warstwie nie są już widoczne i nie 

są drukowane. Chociaż warstwa może być niewidoczna, nadal można wybrać ją jako 

bieżącą warstwę, w którym to przypadku nowe obiekty są również niewidoczne do 

momentu ponownego włączenia warstwy. Jednostki na niewidocznych warstwach 

mogą również wpływać na wyświetlanie i drukowanie jednostek na innych 

warstwach. Na przykład, jednostki na niewidocznych warstwach mogą ukrywać inne jednostki, gdy 

używane jest polecenie Ukryj w celu usunięcia ukrytych linii. 

Można również zamrażać i rozmrażać warstwy. Obiekty narysowane na 

zamrożonych warstwach nie są wyświetlane, nie są drukowane i nie są 

regenerowane. Po zamrożeniu warstwy jej elementy nie wpływają na wyświetlanie ani 

drukowanie innych elementów. Na przykład obiekty na zamrożonych warstwach nie 

ukrywają innych obiektów, gdy polecenie Ukryj służy do usuwania ukrytych linii. 

Ponadto nie można rysować na zamrożonej warstwie do momentu jej rozmrożenia i 

nie można nadać zamrożonej warstwie aktualności. 

Nie można zamrozić bieżącej warstwy. Próba zamrożenia bieżącej warstwy 

spowoduje wyświetlenie okna dialogowego z monitem o określenie innej warstwy. 

Nie można również zamrozić ani rozmrozić warstwy rzutni, chyba że pracujesz na 

karcie Układ. 

Warstwy można zablokować lub odblokować. Jednostki na zablokowanej warstwie 

są nadal widoczne i będą drukowane, ale nie można ich edytować. Zablokowanie warstwy 

zapobiega przypadkowej modyfikacji elementów. 

Każda warstwa ma własne właściwości, takie jak kolor, typ linii, grubość linii, 

przezroczystość, widoczność wydruku i inne. W przypadku rysunków 

korzystających z nazwanych stylów wydruku, warstwy mogą również mieć własny 

styl wydruku. Obiekty rysowane na określonej warstwie są wyświetlane w kolorze, 

typie linii i grubości linii powiązanych z tą warstwą, chyba że ustawienia te zostaną 

zastąpione. Wszystkie powiązane ustawienia warstw można kontrolować za pomocą 

elementu Warstwy w Eksploratorze ALCAD. Możesz także uzyskać dostęp do 

ustawień warstw dla jednostek za pomocą paska narzędzi Właściwości jednostki. 

Niektóre rysunki zawierają duże listy warstw, w którym to przypadku można 

wyszukiwać warstwy według nazwy lub organizować warstwy w podzbiory za 

pomocą filtrów warstw. Stany warstw są również przydatne w przypadku rysunków 

zawierających wiele warstw. Za pomocą stanów warstw można przypisać 

właściwości do poszczególnych warstw i zapisać je w stanie warstwy, a następnie 

zastosować te ustawienia w dowolnym momencie. 
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Wyświetlanie informacji o warstwie w ALCAD Explorer 

Aby wyświetlić informacje o warstwie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Narzędzia kliknij narzędzie ALCAD Explorer ( ).  

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 W razie potrzeby można wyświetlić informacje tylko dla niektórych warstw, wykonując 

jedną z poniższych czynności: 

• Na pasku narzędzi wpisz nazwę żądanych warstw, w tym symbole 

wieloznaczne, i naciśnij klawisz Enter. 

• Na liście filtrów warstw wybierz opcję Wszystkie używane warstwy, aby 

wyświetlić tylko te warstwy, które są używane na rysunku. 

• Z listy filtrów warstw wybierz istniejący filtr grupy lub filtr właściwości. 

Szczegółowe informacje na temat filtrowania i wyszukiwania warstw znajdują 

się w sekcji "Filtrowanie i wyszukiwanie warstw" na stronie 244 w tym 

rozdziale. 
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A 
B P 

 
 
 
 

C 

 
 
 
 
 
 
 
 
 

 DEFGHIJKLMNO 
 

 
A Kliknij, aby włączyć lub wyłączyć automatyczne ukrywanie 

palety. Dostępne, gdy eksplorator jest paletą niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość palety. 
Dostępne, gdy eksplorator jest paletą niezablokowaną. 

C Wybierz wyświetlanie wszystkich warstw, wszystkich 
używanych warstw lub filtrowanego podzbioru. 

D Kliknij, aby zwinąć lub rozwinąć wyświetlanie filtrów warstw. 

E Wyświetla listę nazwanych warstw w bieżącym rysunku. Lista 
zawiera wszystkie warstwy lub podzbiór w przypadku przeglądania 
według filtra lub tylko używane warstwy. Znacznik wyboru 
wskazuje bieżącą warstwę. 

F Wyświetla kolor przypisany do każdej warstwy. 

 
G Wskazuje typ linii przypisany do każdej warstwy. 

H Wskazuje stan widoczności każdej warstwy. 

I Wskazuje stan zablokowania lub odblokowania każdej warstwy. 

J Wskazuje stan zamrożenia lub rozmrożenia każdej warstwy dla wszystkich rzutni. 

K Wskazuje wagę linii przypisaną do każdej warstwy. 

L Wskazuje przezroczystość przypisaną do każdej warstwy. 

M Wskazuje materiał przypisany do każdej 

warstwy. N Wskazuje styl drukowania 

przypisany do każdej warstwy. O Wskazuje stan 

drukowania każdej warstwy. 

P Kliknij tytuł kolumny, aby sortować według kategorii. 

 

Tworzenie i nazywanie warstw 

Na każdym rysunku można utworzyć nieograniczoną liczbę warstw i używać ich do 

porządkowania informacji. Po utworzeniu nowej warstwy jest jej początkowo 

przypisywany kolor biały (lub czarny, w zależności od ustawień systemu) oraz typ 

linii CIĄGŁE. Domyślnie nowa warstwa jest również widoczna. Po utworzeniu i 

nazwaniu warstwy można zmienić jej kolor, typ linii, widoczność i inne właściwości. 
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Aby utworzyć nową warstwę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edycja > Nowa > Warstwa. 

• Kliknij narzędzie Nowy element (  ). 

Nowa warstwa zostanie dodana do listy Layer Name z domyślną nazwą NewLayer1. 

3 Wpisz nazwę nowej warstwy nad podświetloną nazwą domyślną, a następnie naciśnij Enter. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Aby zmienić nazwę warstwy w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Z listy Layer Name wybierz warstwę, której nazwę chcesz zmienić. 

3 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Zmień nazwę, wpisz nową nazwę i naciśnij Enter. 

• Podświetl nazwę warstwy, którą chcesz zmienić, wpisz nową nazwę i naciśnij 

Enter. 

• Kliknij prawym przyciskiem myszy nazwę warstwy, którą chcesz zmienić i 

z menu skrótów wybierz Zmień nazwę, wpisz nową nazwę, a następnie 

naciśnij Enter. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Warstwa o nazwie "0" jest zarezerwowana. 

Nie można zmienić jego nazwy. 
 



244 C H A P T E R 8 

 

Filtrowanie i wyszukiwanie warstw 

Niektóre rysunki zawierają duże listy warstw. Aby ograniczyć warstwy wyświetlane 

na liście, można wyszukiwać warstwy według nazwy (w tym symboli 

wieloznacznych), a także tworzyć filtry warstw. 

Domyślnie dostępne są dwa predefiniowane filtry. Jeden wyświetla wszystkie 

warstwy, a drugi wyświetla wszystkie warstwy używane na rysunku. 

Istnieją dwa rodzaje filtrów warstw, które można utworzyć: 

• Filtr właściwości - uwzględnia warstwy zgodnie z określonymi przez 

użytkownika właściwościami. Filtr ten jest dynamiczny, tzn. jeśli nowa warstwa 

spełnia wymagania filtra właściwości, jest automatycznie dodawana do filtra. 

• Filtr grupy - obejmuje warstwy, które zostały włączone do grupy. Ten filtr jest 

statyczny, tzn. nowe warstwy są obsługiwane ręcznie. 

Po utworzeniu filtra warstw można włączyć lub wyłączyć wszystkie jego warstwy, 

rozmrozić lub zamrozić warstwy oraz zablokować lub odblokować warstwy. Filtry 

warstw można także odwracać, importować i eksportować. 
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Kliknięcie, aby włączyć lub wyłączyć automatyczne ukrywanie 
palety. Dostępne, gdy eksplorator jest paletą niezadokowaną. 

B Kliknij, aby wybrać pozycję i przezroczystość palety. 
Dostępne, gdy eksplorator jest paletą niezadokowaną. 

C Wyświetla listę filtrów warstw. 

D Kliknij, aby utworzyć nowy filtr właściwości warstwy. 

E Kliknij, aby utworzyć nowy filtr grupy warstw. 

F Kliknij, aby odwrócić aktualnie wybrany filtr warstwy. 

G Kliknij, aby wyświetlić Menedżera stanów warstw. 

H Kliknij, aby wyeksportować aktualnie wybrany filtr warstwy do pliku .lft. 

I Kliknij, aby zaimportować filtr warstwy (plik .lft). 

J Wpisz wyszukiwane hasło, w tym symbole 
wieloznaczne, a następnie naciśnij klawisz Enter, aby 
wyszukać nazwy warstw. 
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Wyszukiwanie warstw według nazwy 

Aby wyszukać warstwy według nazwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Na pasku narzędzi ALCAD Explorer wpisz nazwę wyszukiwania, w tym 

następujące symbole wieloznaczne: 

• * Dopasowuje dowolny znak lub serię znaków. 

• ? Dopasowuje pojedynczy znak. 

• # Dopasowuje dowolny znak numeryczny. 

• @ Dopasowuje dowolny znak alfabetu. 

• . Dopasowuje dowolny znak, który nie jest alfabetyczny ani numeryczny. 

• [ ] Dopasowuje dowolne znaki wewnątrz nawiasów. 

• ~ Dopasowuje wszystkie znaki z wyjątkiem tych po tyldach. 

• [~] Dopasowuje dowolne znaki z wyjątkiem tych wewnątrz nawiasów. 

• [-] Dopasowuje zakres znaków wewnątrz nawiasów. 

• ' Dopasowuje dokładne znaki znajdujące się po znaku cudzysłowu. Jest to 

najczęściej używane podczas wyszukiwania nazw warstw zawierających 

symbole wieloznaczne, na przykład @Floor lub Field#. 

3 Aby ponownie wyświetlić wszystkie warstwy na liście, usuń wyszukiwane hasło. 

4 Kliknij przycisk OK. 
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Filtrowanie warstw według właściwości 
Filtry właściwości warstw uwzględniają warstwy zgodnie z określonymi przez 

użytkownika właściwościami. Na przykład filtr właściwości może wyświetlać 

wszystkie warstwy z przerywanym typem linii, a następnie można łatwo włączyć lub 

wyłączyć te warstwy. 

Aby utworzyć filtr właściwości 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij narzędzie Filtr właściwości (  ). 
 

Filtry mogą być zagnieżdżane. 

Aby utworzyć filtr podrzędny istniejącego filtra, kliknij prawym przyciskiem 

myszy istniejący filtr i wybierz opcję Nowy filtr właściwości lub Nowy filtr grupy. 
 

3 Wpisz nazwę filtra. 

4 Wykonaj dowolną z poniższych czynności w definicji filtra: 

• Kliknij kolumnę pustego wiersza, aby określić właściwość do dopasowania. 

Uwzględnione zostaną wszystkie warstwy pasujące do określonych 

właściwości dowolnego wiersza. 

• Kliknij kolumnę istniejącego wiersza, aby określić dodatkową właściwość, 

którą musi spełniać warstwa, aby została uwzględniona w filtrze. Wszystkie 

właściwości warstwy w jednym wierszu muszą być zgodne, aby warstwa 

została uwzględniona. 

• Kliknij wiersz prawym przyciskiem myszy i wybierz opcję Usuń wiersz, aby usunąć 

niepotrzebny wiersz. 

• Kliknij prawym przyciskiem myszy wiersz i wybierz Duplikuj wiersz, aby 

utworzyć kopię istniejącego wiersza. Podgląd filtra wyświetla warstwy, które 

zostaną uwzględnione w filtrze. 

5 Kliknij przycisk OK. 

6 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
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A Wpisz nazwę nowego filtra właściwości 

warstwy. 

B Kliknij kolumnę istniejącego filtra, aby określić 
dodatkową właściwość, z którą warstwa musi 
być zgodna, aby została uwzględniona w 
filtrze. 

Aby zmodyfikować filtr właściwości 

 
C Kliknij kolumnę pustego wiersza, aby 

wybrać właściwość do dopasowania. 

D Wyświetla warstwy pasujące do ustawień 
filtra właściwości warstwy. 

 

1 W Eksploratorze ALCAD wybierz Warstwy, a następnie wykonaj jedną z poniższych 

czynności: 

• Aby zmienić nazwę filtra właściwości, wybierz go i wpisz nową nazwę. 

• Aby usunąć filtr właściwości, wybierz go i naciśnij przycisk Usuń. 

• Aby zmienić definicję filtra właściwości, kliknij go dwukrotnie. 

• Aby zmienić kolejność filtrów na liście, przeciągnij i upuść filtr 

właściwości w nowe miejsce na liście. Aby posortować wszystkie filtry w 

kolejności alfabetycznej, kliknij prawym przyciskiem myszy górny 

element, Wszystkie, i wybierz Sortuj filtry. 
 

Użyj skrótu. 

Kliknij prawym przyciskiem myszy filtr właściwości, aby go zmodyfikować. 
 

 
Aby zmodyfikować warstwy w filtrze właściwości 

1 W Eksploratorze ALCAD wybierz Warstwy. 

2 Aby zmienić widoczność wszystkich warstw w filtrze właściwości, kliknij 

prawym przyciskiem myszy filtr właściwości, wybierz opcję Widoczność, a 

następnie wybierz jedną z poniższych opcji: 

• Na 

• Wył. 

• Odwilż 

• Zamrożenie 
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3 Aby zmienić dostępność wszystkich warstw w filtrze właściwości, kliknij 

prawym przyciskiem myszy filtr właściwości, wybierz opcję Zablokuj, a 

następnie wybierz jedną z poniższych opcji: 

• Blokada 

• Odblokowanie 

 
Filtrowanie warstw według grupy 
Filtry grup warstw obejmują dowolną warstwę wybraną dla grupy. Na przykład 

filtr grupowy może wyświetlać wszystkie warstwy zawierające jednostki 

tekstowe, a następnie można zamrażać lub rozmrażać te warstwy w zależności 

od potrzeb. 
 

Aby utworzyć filtr grupowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij narzędzie Filtr grupowy (  ). 
 

Filtry mogą być zagnieżdżane. 

Aby utworzyć filtr podrzędny istniejącego filtra, kliknij prawym przyciskiem 

myszy istniejący filtr i wybierz opcję Nowy filtr właściwości lub Nowy filtr grupy. 
 

3 Wpisz nazwę nowego filtra grupowego, a następnie naciśnij klawisz Enter. 

4 Aby wybrać warstwy dla filtra grupowego, wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy filtr grupy, wybierz opcję Wybierz 

warstwy > Dodaj, a następnie wybierz jednostki na rysunku, które znajdują 

się na warstwach, które mają zostać uwzględnione w grupie. Po zakończeniu 

naciśnij klawisz Enter. Wybierz opcję Wybierz warstwy > Zamień, jeśli filtr 

grupy zawiera istniejące warstwy, które chcesz usunąć przed dodaniem 

nowych warstw. 

• Kliknij dwukrotnie filtr grupy, a następnie zaznacz i odznacz żądane warstwy. 

5 Kliknij przycisk OK. 

6 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Utwórz filtr grupowy, konwertując istniejący filtr właściwości. 

W Eksploratorze ALCAD wyświetl filtry warstw, kliknij prawym przyciskiem 

myszy filtr właściwości i wybierz Konwertuj na filtr grupowy. 
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 BC 

A Kliknij zielony okrąg, aby włączyć jego warstwę 
do filtra grupy warstw. Kliknij ponownie, aby 
ją wykluczyć. 

 

Aby zmodyfikować filtr grupowy 

 
 
 
 
 
 
 
 
 
 
 
 

B Wyświetla warstwy na rysunku. 

C Wyświetla opis warstwy, jeśli jest dostępny. 

 

1 W Eksploratorze ALCAD wybierz Warstwy, a następnie wykonaj jedną z poniższych 

czynności: 

- Aby zmienić nazwę filtra grupowego, wybierz go i wpisz nową nazwę. 

- Aby usunąć filtr grupowy, wybierz go i naciśnij przycisk Usuń. 

- Aby zmienić warstwy zawarte w filtrze grupowym, kliknij go dwukrotnie. 

- Aby zmienić kolejność filtrów na liście, przeciągnij i upuść filtr grupowy w 

nowe miejsce na liście. Aby posortować wszystkie filtry w kolejności 

alfabetycznej, kliknij prawym przyciskiem myszy górny element, Wszystkie, 

i wybierz Sortuj filtry. 

- Aby wybrać nowe warstwy dla filtra grupowego bezpośrednio na rysunku, 

kliknij prawym przyciskiem myszy filtr grupowy. Wybierz Wybierz warstwy 

> Dodaj, jeśli chcesz zachować wszystkie istniejące warstwy w filtrze grupy i 

wybrać nowe do dodania bezpośrednio na rysunku. Wybierz Wybierz warstwy 

> Zamień, jeśli chcesz usunąć wszystkie istniejące warstwy z filtra grupowego 

i wybrać nowe bezpośrednio na rysunku. 
 

Użyj skrótu. 

Kliknij prawym przyciskiem myszy filtr grupy, aby go zmodyfikować. 
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Aby zmodyfikować warstwy w filtrze grupowym 

1 W Eksploratorze ALCAD wybierz Warstwy. 

2 Aby zmienić widoczność wszystkich warstw w filtrze grupowym, kliknij 

prawym przyciskiem myszy filtr grupowy, wybierz opcję Widoczność, a 

następnie wybierz jedną z poniższych opcji: 

• Na 

• Wył. 

• Odwilż 

• Zamrożenie 

3 Aby zmienić dostępność wszystkich warstw w filtrze grupowym, kliknij prawym 

przyciskiem myszy filtr grupowy, wybierz opcję Zablokuj, a następnie wybierz 

jedną z poniższych opcji: 

• Blokada 

• Odblokowanie 

 
Odwracające filtry warstwowe 
Filtry warstw można odwracać, na przykład można odwrócić filtr Wszystkie 

używane warstwy, aby wyświetlić listę wszystkich warstw, które nie są używane na 

rysunku. 
 

Aby odwrócić filtr warstwowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Wybierz filtr warstwy. 

3 Kliknij narzędzie Odwróć filtr (  ). 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Filtr pozostaje odwrócony, dopóki nie zostanie wyłączony. 

Jeśli zawartość filtra wygląda nieprawidłowo, może to być spowodowane jego odwróceniem. 
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Importowanie i eksportowanie filtrów właściwości warstw 
Filtry właściwości warstw mogą być importowane i eksportowane jako pliki .lst. 

 

Aby zaimportować filtry właściwości warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij narzędzie Importuj filtr warstw (  ). 

3 Przejdź do miejsca, w którym chcesz zapisać filtr warstwy, wpisz nazwę, a następnie kliknij 

przycisk Zapisz. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Aby wyeksportować filtry właściwości warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Wybierz filtr warstwy, który chcesz wyeksportować. 

3 Kliknij narzędzie Eksportuj filtr warstw (  ). 

4 Znajdź filtr warstwy (plik .lft) i wybierz go. 

5 Kliknij przycisk Otwórz. 

6 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Ustawianie bieżącej warstwy 

Podczas tworzenia nowych elementów są one rysowane na bieżącej warstwie. Aby 

narysować nowe encje na innej warstwie, należy najpierw ustawić tę warstwę jako 

warstwę bieżącą. 
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Aby warstwa była aktualna 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Z listy Layer Name wybierz warstwę, którą chcesz uczynić aktualną. 

3 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Bieżące. 

• Z listy Layer Name wybierz nazwę, którą chcesz uczynić aktualną, a 

następnie kliknij narzędzie Current ( ). 

• Kliknij dwukrotnie nazwę warstwy na liście Layer Name. 

• Kliknij prawym przyciskiem myszy nazwę warstwy, którą chcesz zmienić, 

a następnie z menu skrótów wybierz opcję Bieżąca. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Aby ustawić bieżącą warstwę na warstwę istniejącego podmiotu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Ustaw warstwę według jednostki 

(  ): 

• Na wstążce wybierz Strona główna > Ustaw warstwę według jednostki (w Warstwy). 

• W menu wybierz Format > Narzędzia warstw > Ustaw warstwę według jednostki. 

• Na pasku narzędzi Narzędzia warstw kliknij narzędzie Ustaw warstwę według jednostki. 

• Wpisz setlayer i naciśnij Enter. 

2 Wybierz jednostkę, aby ustawić bieżącą warstwę. 

 

Użyj paska poleceń. 

Na pasku poleceń wpisz LAYBYENT i wybierz Set lub wpisz LAYMCUR, a następnie 

wybierz jednostkę, która jest przypisana do warstwy, która ma być aktualna. 

 
Kontrolowanie widoczności warstwy 

Warstwa może być widoczna lub niewidoczna. Obiekty na niewidocznych warstwach 

nie są wyświetlane i nie są drukowane. Kontrolując widoczność warstwy, można 

wyłączyć niepotrzebne informacje, takie jak linie konstrukcyjne lub notatki. 

Zmieniając widoczność warstwy, można wykorzystać ten sam rysunek do wielu 

celów. 
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Na przykład, jeśli rysujesz plan piętra, możesz narysować układ opraw 

oświetleniowych na jednej warstwie, a lokalizację linii wodno-kanalizacyjnych na 

innej. Poprzez selektywne włączanie i wyłączanie warstw można drukować rysunki 

elektryczne i hydrauliczne z tego samego pliku rysunku. Dla jeszcze większej 

wygody można kontrolować widoczność warstw w poszczególnych rzutniach, dzięki 

czemu warstwy wyświetlane w jednej rzutni są niewidoczne w innych rzutniach tego 

samego rysunku. 

Po wyłączeniu warstwy obiekty narysowane na tej warstwie nie są już widoczne. 

Po ponownym włączeniu warstwy elementy na tej warstwie są ponownie 

wyświetlane. 
 

Aby włączyć lub wyłączyć warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Włącz/Wyłącz warstwę, którą chcesz włączyć lub wyłączyć. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Warstwy można również zamrażać w celu poprawy wydajności operacji, takich jak 

powiększanie i przesuwanie lub tworzenie ukrytych linii lub cieniowanych obrazów. 

Gdy warstwa jest zamrożona, obiekty narysowane na tej warstwie nie są już 

widoczne. 

 

Wybierz jednostkę przypisaną do warstwy, którą chcesz wyłączyć. 

Na pasku poleceń wpisz LAYBYENT i wybierz Off lub wpisz LAYOFF, a następnie 

wybierz jednostkę przypisaną do warstwy, którą chcesz wyłączyć. 
 

 

Użyj skrótu, aby włączyć wszystkie warstwy. 

Wybierz Format > Narzędzia warstw > Włącz wszystkie warstwy lub wpisz LAYON 

na pasku poleceń, aby włączyć wszystkie warstwy na rysunku. 
 

Aby kontrolować widoczność zewnętrznych warstw odniesienia i zapisywać 

wszelkie wprowadzone w nich zmiany w bieżącym rysunku, włącz opcję 

Widoczność Xref. 
 

Aby włączyć widoczność warstwy Xref 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 



• Wpisz explayers i naciśnij Enter 
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2 Wybierz Widok > Rekordy z Xref Visibility. 

 

Użyj zmiennej systemowej. 

Możesz także włączyć widoczność warstwy xref, wpisując visretain, aby uzyskać 

dostęp do zmiennej systemowej. 
 

 
Aby zamrozić lub rozmrozić warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Wszystkie rzutnie dla warstwy, którą chcesz zamrozić lub rozmrozić. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Wybierz jednostkę przypisaną do warstwy, którą chcesz zamrozić. 

Na pasku poleceń wpisz LAYBYENT i wybierz Freeze lub wpisz LAYFRZ i wybierz 

jednostkę, która jest przypisana do warstwy, którą chcesz zamrozić. 
 

 

Użyj skrótu, aby rozmrozić wszystkie warstwy. 

Wybierz Format > Narzędzia warstw > Rozmroź wszystkie warstwy lub wpisz 

LAYTHW na pasku poleceń, aby rozmrozić wszystkie warstwy na rysunku. 
 

 
Blokowanie i odblokowywanie warstw 

Zablokowanie warstwy ułatwia odwoływanie się do informacji zawartych na 

warstwie, ale chroni przed przypadkową modyfikacją jej elementów. Gdy warstwa 

jest zablokowana (ale widoczna i rozmrożona), jej encje pozostają widoczne, ale nie 

można ich edytować. Po zablokowaniu bieżącej warstwy nadal można dodawać do 

niej nowe jednostki. Odblokowanie warstwy przywraca pełne możliwości edycji. 
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Aby zablokować lub odblokować warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Zablokowane dla warstwy, którą chcesz zablokować lub odblokować. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Wybierz jednostkę przypisaną do warstwy, którą chcesz zablokować lub odblokować. 

Na pasku poleceń wpisz LAYBYENT i wybierz Zablokuj lub Odblokuj lub wpisz 

LAYLCK lub LAYULK, a następnie wybierz jednostkę, która jest przypisana do 

warstwy, którą chcesz zablokować lub odblokować. 
 

 
Sterowanie drukowaniem warstw 

Kontrolowanie drukowania warstw to kolejny sposób na określenie, które jednostki 

są drukowane na rysunku. 

Kontrolując drukowanie warstw, można wyłączyć niepotrzebne informacje podczas 

drukowania. Na przykład, jeśli rysujesz plan piętra, możesz narysować układ opraw 

oświetleniowych na jednej warstwie, a lokalizację linii wodno-kanalizacyjnych na 

innej. Poprzez selektywne włączanie i wyłączanie warstw podczas drukowania, 

można wydrukować rysunki elektryczne i hydrauliczne z tego samego pliku rysunku. 

Zmieniając drukowanie warstw, można wykorzystać ten sam rysunek do wielu 

zastosowań. 

Po wyłączeniu drukowania dla warstwy elementy narysowane na tej warstwie są 

nadal widoczne, ale nie są drukowane. Jeśli wyłączysz widoczność warstwy, 

elementy narysowane na tej warstwie nie będą wyświetlane ani drukowane. 

Kontrolowanie drukowania warstw może być szczególnie przydatne, jeśli chcesz 

włączyć widoczność warstwy, ale nie chcesz drukować elementów na tej warstwie. 

Widoczność warstwy musi być włączona, aby można było drukować obiekty narysowane na tej 

warstwie. 
 

Aby włączyć lub wyłączyć drukowanie warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Drukuj dla warstwy, dla której chcesz włączyć lub wyłączyć 



drukowanie. 
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Ustawianie koloru warstwy 

Każda warstwa na rysunku ma przypisany kolor. ALCAD używa koloru 

BYLAYER jako domyślnego ustawienia koloru dla tworzenia jednostek, dzięki 

czemu nowe jednostki są rysowane w kolorze warstwy, na której są wstawiane 

(ustawionym w oknie dialogowym Ustawienia rysunku). 

Za pomocą Eksploratora ALCAD można ustawić lub zmienić kolor przypisany do 

warstwy. Dzięki funkcji edycji bezpośredniej możesz kliknąć kolor, który chcesz 

zmienić, a następnie wybrać nowy kolor z wyświetlonego okna dialogowego. Zmiana 

koloru warstwy automatycznie zmienia kolor wszystkich elementów na tej warstwie z 

kolorem BYLAYER. 
 

Aby zmienić kolor warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Kolor warstwy, którą chcesz zmienić. 

3 W oknie dialogowym Kolor wybierz kolor na jednej z poniższych kart: 

• Kolor indeksu - kliknij BYBLOCK, BYLAYER lub jeden z 255 kolorów 

indeksu. Możesz także wpisać numer koloru w polu Indeks. 

• True Color - Kliknij kolor podstawowy, kliknij kolor w palecie kolorów, 

wprowadź wartości odcienia, nasycenia i luminancji (HSL) lub wprowadź 

wartości czerwonego, zielonego i niebieskiego (RGB). Do wyboru jest ponad 

16 milionów prawdziwych kolorów. 

• Kolorniki - wybierz kolornik z listy, a następnie kliknij kolor. Można wybrać 

opcję Pokaż tylko kolory z książki kolorów użyte w rysunku, aby ograniczyć 

wybór tylko do tych kolorów z książki kolorów, które są używane w 

bieżącym rysunku. W razie potrzeby można tworzyć lub edytować książki 

kolorów, klikając przycisk Edytor książki kolorów. Więcej szczegółów 

znajduje się w sekcji "Korzystanie z książek kolorów" na stronie 66. 

4 Kliknij przycisk OK. 
 

Jednostki nie muszą używać koloru warstwy. 

Do jednostki można przypisać określony kolor, który zastępuje ustawienie koloru 

warstwy. Podczas tworzenia nowej encji użyj polecenia Format > Kolory > Wybierz 

kolor, aby zmienić bieżący kolor. W przypadku istniejącej encji zaznacz ją, kliknij 

prawym przyciskiem myszy, aby wyświetlić menu skrótów, a następnie wybierz 

polecenie Właściwości, aby zmienić kolor encji za pomocą panelu Właściwości. 
 

Więcej informacji na temat używania kolorów w wielu aspektach rysunku można 

znaleźć w sekcji "Praca z kolorami" na stronie 63. 
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Ustawianie typu linii warstwy 

Każda warstwa używa domyślnego typu linii (powtarzający się wzór kresek, kropek 

lub pustych przestrzeni). Typ linii określa wygląd jednostek zarówno na ekranie, 

jak i po wydrukowaniu. 

Dobrym pomysłem jest przypisanie typu linii BYLAYER do wszystkich elementów 

rysowanych na tej warstwie. ALCAD używa typu linii BYLAYER jako 

domyślnego ustawienia typu linii dla Entity Creation (w oknie dialogowym 

Drawing Settings). 

Korzystając z Eksploratora ALCAD, można ustawić lub zmienić typ linii przypisany 

do warstwy. Dzięki funkcji edycji bezpośredniej możesz kliknąć typ linii, który 

chcesz zmienić, a następnie wybrać nowy typ linii z wyświetlonego okna 

dialogowego. Zmiana rodzaju linii przypisanego do warstwy zmienia rodzaj linii 

wszystkich elementów narysowanych na tej warstwie z rodzajem linii BYLAYER. 

Tylko te typy linii, które zostały już ustawione na rysunku mogą być przypisane do 

warstw. Więcej informacji na temat ustawiania dodatkowych typów linii znajduje się 

w sekcji "Praca z typami linii" na stronie 267 w tym rozdziale. 
 

Aby zmienić typ linii przypisany do jednej lub więcej warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Linetype dla warstwy, którą chcesz zmienić. 

3 W oknie dialogowym Typ linii wybierz nowy typ linii dla warstwy lub kliknij 

przycisk Przeglądaj, aby wybrać plik z typem linii. 
 

Jednostki nie muszą używać typu linii warstwy. 

Można również przypisać określony typ linii do elementu, który zastępuje ustawienie 

typu linii warstwy. Podczas tworzenia nowej jednostki użyj polecenia Narzędzia > 

Eksplorator ALCAD > Eksploruj typy linii, aby zmienić bieżący typ linii za pomocą 

Eksploratora ALCAD. W przypadku istniejącej encji wybierz ją, kliknij prawym 

przyciskiem myszy, aby wyświetlić menu skrótów i wybierz Właściwości. Następnie 

można zmodyfikować typ linii encji za pomocą panelu Właściwości. 
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Ustawianie grubości linii warstwy 

Każda warstwa używa domyślnej grubości linii. Grubość linii określa grubość 

elementów zarówno na ekranie, jak i po wydrukowaniu. 

Wszystkie nowe warstwy mają przypisaną domyślną grubość linii, która wynosi .25 milimetrów 

lub 

.01 cala. Jeśli chcesz mieć inną grubość linii przypisaną do warstwy, możesz ją 

łatwo zmienić za pomocą Eksploratora ALCAD. Na przykład, możesz chcieć 

różnych grubości linii na każdej warstwie rysunku, aby pokazać oddzielne 

elementy, takie jak ściany, wymiary, stal konstrukcyjna i plany elektryczne. Zmiana 

grubości linii przypisanej do warstwy zmienia grubość linii wszystkich elementów 

narysowanych na tej warstwie za pomocą grubości linii BYLAYER. 

Podczas tworzenia nowych jednostek dobrym pomysłem jest przypisanie grubości 

linii BYLAYER do wszystkich jednostek rysowanych na tej warstwie, chyba że 

chcesz zastąpić grubość linii warstwy. ALCAD używa grubości linii BYLAYER 

jako domyślnego ustawienia grubości linii podczas tworzenia jednostek (w oknie 

dialogowym Ustawienia rysowania). 

 

Można zmienić domyślną grubość linii. 

Aby zmienić DOMYŚLNĄ grubość linii, wybierz Narzędzia > Ustawienia 

rysowania, kliknij kartę Wyświetlanie, kliknij kartę Grubość linii, a następnie 

wybierz nową wartość domyślną. 
 

 
Aby zmienić grubość linii przypisaną do jednej lub więcej warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Lineweight dla warstwy, którą chcesz zmienić. 

3 Z listy Grubość linii wybierz nową grubość linii dla warstwy, a następnie kliknij przycisk 

OK. 
 

Jednostki nie muszą używać wagi linii warstwy. 

Do elementu można przypisać określoną grubość linii, która zastępuje ustawienie 

grubości linii warstwy. Podczas tworzenia nowej jednostki, użyj Narzędzia > 

Ustawienia rysunku > zakładka Tworzenie jednostki, aby zmienić bieżącą grubość 

linii. W przypadku istniejącej jednostki zaznacz ją, kliknij prawym przyciskiem myszy, 

aby wyświetlić menu skrótów, a następnie wybierz polecenie Właściwości. Następnie 

można zmodyfikować grubość linii elementu za pomocą panelu Właściwości. 
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Ustawianie przezroczystości warstwy 

Każda warstwa używa wartości przezroczystości od 0 do 90, gdzie zero oznacza brak 

przezroczystości (wyraźna widoczność), a 90 oznacza największą przezroczystość 

(prawie niewidoczna). 

Domyślnie każda warstwa ma przypisaną zerową przezroczystość. Jeśli chcesz mieć 

inną przezroczystość przypisaną do warstwy, możesz ją łatwo zmienić za pomocą 

Eksploratora ALCAD. 
 

Aby zmienić przezroczystość przypisaną do jednej lub więcej warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Przezroczystość dla warstwy, którą chcesz zmienić. 

3 Wprowadź nową wartość przezroczystości, a następnie naciśnij Enter. 

 
Ustawianie materiału warstwy 

Każdej warstwie można przypisać materiał. Domyślnie każda warstwa ma 

przypisany materiał globalny. Jeśli chcesz przypisać inny materiał do warstwy, 

możesz go łatwo zmienić za pomocą Eksploratora ALCAD. 
 

Aby zmienić materiał przypisany do jednej lub więcej warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Materiał dla warstwy, którą chcesz zmienić. 

3 Z listy Materiał wybierz nowy materiał dla warstwy. 
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Ustawianie stylu drukowania warstwy 

Jeśli rysunek korzysta z nazwanych tabel stylów wydruku, można określić styl 

wydruku dla każdej warstwy. Nazwane tabele stylów wydruku zawierają style 

wydruku, które można skonfigurować w celu kontrolowania wyglądu elementów 

podczas drukowania, bez faktycznej zmiany elementów na rysunku. 

Jeśli rysunek korzysta z tabel stylów wydruku zależnych od koloru, nie można 

określić stylu wydruku dla warstwy. Tego typu tabele stylów wydruku 

automatycznie określają wymagania dotyczące drukowania na podstawie koloru 

przypisanego do warstwy lub jednostki. Aby uzyskać szczegółowe informacje na 

temat konwersji rysunku, który korzysta z tabeli stylów wydruku zależnych od koloru, na korzystanie z nazwanych 

tabel stylów wydruku, patrz "Zmiana typu tabeli stylów wydruku rysunku" na 

stronie 555. 

W rysunkach, które używają nazwanych tabel stylów wydruku, domyślnym stylem 

wydruku jest Normalny dla wszystkich nowych warstw. W razie potrzeby można 

przypisać styl wydruku za pomocą Eksploratora ALCAD. Zmiana stylu wydruku 

przypisanego do warstwy zmienia styl wydruku wszystkich elementów 

narysowanych na tej warstwie za pomocą stylu wydruku BYLAYER. 

Podczas tworzenia nowych jednostek dobrym pomysłem jest przypisanie stylu 

drukowania BYLAYER do wszystkich jednostek rysowanych na tej warstwie, chyba 

że chcesz zastąpić styl drukowania warstwy. ALCAD używa stylu drukowania 

BYLAYER jako domyślnego ustawienia stylu drukowania podczas tworzenia 

jednostek (w oknie dialogowym Ustawienia rysowania). 
 

Aby zmienić styl wydruku przypisany do jednej lub więcej warstw (tylko na 

rysunku, który używa nazwanych tabel stylów wydruku) 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Styl wydruku dla warstwy, którą chcesz zmienić. 

3 W razie potrzeby wybierz inną tabelę stylów wydruku z listy Aktywna tabela stylów 

wydruku. 

4 W obszarze Style wydruku wybierz styl wydruku. 

5 Kliknij przycisk OK. 
 

Jednostki nie muszą używać stylu wydruku warstwy. 

W przypadku rysunków korzystających z nazwanych tabel stylów wydruku można 

również przypisać określony styl wydruku do elementu, który zastępuje ustawienia 

stylu wydruku warstwy. Podczas tworzenia 

nowej jednostki, użyj Narzędzia > Ustawienia rysunku > zakładka Tworzenie 

jednostki, aby zmienić bieżący styl wydruku. W przypadku istniejącej jednostki zaznacz ją, 

kliknij prawym przyciskiem myszy, aby wyświetlić menu skrótów, a następnie wybierz 

polecenie Właściwości. Następnie można zmodyfikować styl wydruku jednostki za 



pomocą panelu Właściwości. 
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Praca ze stanami warstw 

Stany warstw to zbiory poszczególnych warstw i ich właściwości. Stany warstw można 

przywracać w dowolnym momencie, co ułatwia przełączanie się między 

konfiguracjami warstw zgodnie z zadaniami. 

Stany warstw można również importować i eksportować. Na przykład, aby szybko 

utworzyć wszystkie potrzebne warstwy w nowym rysunku, należy utworzyć i 

wyeksportować stan warstwy z istniejącego rysunku, który zawiera potrzebne 

warstwy, a następnie zaimportować stan warstwy do nowego rysunku. 

Stany warstw są zapisywane w rysunku, w tym w szablonach rysunków oraz 

wyeksportowanych lub zaimportowanych rysunkach. 

Dla każdej warstwy zawartej w stanie warstwy można ustawić następujące właściwości: 

• Kolor 

• Typ linii 

• Wł. 

• Blokada/Odblokowanie 

• Zamrażanie/rozmrażanie 

• Waga liniowa 

• Przejrzystość 

• Drukuj 

• Nowe rzutnie 

 
Wyświetlanie stanów warstw w Menedżerze stanów warstw 

Aby wyświetlić Menedżera stanów warstw 

1 Wykonaj jedną z poniższych czynności, aby wybrać Layer State Manager (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Menedżer stanów warstw (w 

obszarze Warstwy). 

• W menu wybierz polecenie Format > Menedżer stanów warstw lub 

wybierz polecenie Format > Eksploruj warstwy, a następnie kliknij 

narzędzie Menedżer stanów warstw. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stanów warstw. 

• Wpisz layerstate i naciśnij Enter. 
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A 

 
 

N 

 
 

 
B 

 

C M 
D 

L 

 

E F G H I J K 
 

A Wyświetla stany warstw. 

B Kliknij, aby wyświetlić stany warstwy bocznej 
znajdujące się na rysunkach z odniesieniami 
zewnętrznymi. 

C Kliknij, aby wyłączyć rysowanie warstw, które nie 
znajdują się w stanie wybranej warstwy po jej 
przywróceniu. 

D Kliknij, aby zamrozić warstwy rysunkowe w bieżącej 
rzutni, które nie znajdują się w stanie wybranej 
warstwy po jej przywróceniu. 

E Kliknij, aby utworzyć nowy stan warstwy. 

F Kliknij, aby zmodyfikować ustawienia wybranego 
stanu warstwy. 

 

 
Tworzenie stanów warstw 

 
G Kliknij, aby skopiować bieżące ustawienia warstwy z 

rysunku do wybranego stanu warstwy. 

H Kliknij, aby zmienić nazwę lub opis wybranego stanu 
warstwy. 

I Kliknij, aby usunąć wybrany stan warstwy. 

J Kliknij, aby wyeksportować wybrany stan warstwy do pliku .las. 

K Kliknij, aby zaimportować stan warstwy (plik .las). 

L Kliknij, aby zaznaczyć wszystkie pola wyboru. 

M Kliknij, aby usunąć znaczniki ze wszystkich pól wyboru. 

N Wybierz właściwości, które mają zostać przywrócone 
dla wybranego stanu warstwy. 

 

Oprócz wczytywania predefiniowanych typów linii z pliku biblioteki typów linii, 

można tworzyć nowe typy linii. Utworzone nowe typy linii można zapisać w pliku 

biblioteki typów linii do wykorzystania w innych rysunkach. 
 

Aby utworzyć stan warstwy 

1 Utwórz wszystkie warstwy, które mają być w stanie warstwy. 

Chociaż można modyfikować warstwę stanu warstwy, najpierw należy 

skonfigurować rysunek z jego warstwami i właściwościami, tak aby podczas 

tworzenia stanu warstwy przechwytywane były wszystkie warstwy. 
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ustawień. Jeśli nie chcesz utracić bieżących ustawień warstwy, po prostu zapisz 

je jako stan warstwy, który możesz później przywrócić. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Menedżera stanów warstw (  ): 

- Na wstążce wybierz kolejno opcje Strona główna > Menedżer stanów warstw (w obszarze 

Warstwy). 

- W menu wybierz polecenie Format > Menedżer stanów warstw lub wybierz 

polecenie Format > Eksploruj warstwy, a następnie kliknij narzędzie 

Menedżer stanów warstw. 

- Na pasku narzędzi Format kliknij narzędzie Menedżer stanów warstw. 

- Wpisz layerstate i naciśnij Enter. 

3 Kliknij przycisk Nowy. 

4 Wprowadź nazwę i opis, a następnie kliknij przycisk OK. 

5 Kliknij Edytuj i wykonaj jedną z poniższych czynności: 

- Kliknij dowolną kolumnę dowolnej warstwy, aby zmienić jej ustawienie. 

Nowe ustawienie ma zastosowanie tylko wtedy, gdy ten stan warstwy 

zostanie zastosowany (przywrócony). 

- Kliknij narzędzie Dodaj warstwę i wybierz warstwę, którą chcesz dodać do stanu warstw. 

- Zaznacz warstwę i kliknij narzędzie Usuń warstwę, aby usunąć warstwę ze 

stanu warstw. 

6 Kliknij OK. 

7 Kliknij przycisk Zamknij. 
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A 

 
B C  DEF G  HIJKL M 

 
 

A Wyświetla warstwy uwzględnione w stanie 
warstwy. 
Kliknij, aby wybrać warstwę. 

B Kliknij, aby dodać warstwę do stanu 
warstwy. 

C Kliknięcie powoduje usunięcie wybranej 
warstwy ze stanu warstwy. 

D Kliknij, aby zmienić kolor warstwy tylko 
dla tego stanu warstwy. 

E Kliknij, aby zmienić typ linii warstwy tylko 
dla tego stanu warstwy. 

F Kliknij, aby przełączyć stan 
włączenia/wyłączenia warstwy tylko dla 
tego stanu warstwy. 

G Kliknij, aby przełączyć stan 
blokady/odblokowania warstwy tylko dla 
tego stanu warstwy. 

 
H Kliknij, aby przełączyć stan 

zamrożenia/rozmrożenia warstwy tylko 
dla tego stanu warstwy. 

I Kliknij, aby zmienić grubość linii 
warstwy tylko dla tego stanu warstwy. 

J Kliknij, aby zmienić przezroczystość 
warstwy tylko dla tego stanu warstwy. 

K Kliknij, aby zmienić styl wydruku 
warstwy tylko dla tego stanu warstwy. 

L Kliknij, aby zmienić stan drukowania 
warstwy tylko dla tego stanu warstwy. 

M Kliknij, aby zmienić widoczność warstwy w 
nowych rzutniach tylko dla tego stanu 
warstwy. 

N Kliknij tytuł kolumny, aby sortować według kategorii. 
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Stosowanie stanu warstwy 

Aby zastosować ustawienia stanu warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Layer State Manager (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Menedżer stanów warstw (w 

obszarze Warstwy). 

• W menu wybierz polecenie Format > Menedżer stanów warstw lub 

wybierz polecenie Format > Eksploruj warstwy, a następnie kliknij 

narzędzie Menedżer stanów warstw. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stanów warstw. 

• Wpisz layerstate i naciśnij Enter. 

2 Wybierz stan warstwy do zastosowania. 

3 Stany warstw z założenia nie zawsze zawierają wszystkie warstwy rysunku. 

Dokonaj selekcji dla następujących elementów: 

• Warstwy nie znalezione w stanie są wyłączone - Po zastosowaniu stanu warstwy, 

włączone zostaną tylko te warstwy, które zostały uwzględnione w stanie 

warstwy. Jeśli nie są zaznaczone, stan włączenia/wyłączenia 

niedopasowanych warstw nie jest zmieniany. 

• Warstwy nie znalezione w stanie są zamrożone w bieżącej rzutni - Po zastosowaniu 

stanu warstwy, jedynymi warstwami, które zostaną rozmrożone w bieżącej 

rzutni są te, które są zawarte w stanie warstwy. Jeśli nie jest zaznaczone, 

stany zamrożenia/rozmrożenia niedopasowanych warstw nie są zmieniane. 

4 W polu Właściwości warstwy do przywrócenia zaznacz, które właściwości 

wszystkich warstw zawartych w stanie warstwy mają zostać zastosowane. Jeśli 

właściwość nie zostanie zaznaczona, nie zostanie ona zastosowana do 

pasujących warstw. 

5 Kliknij przycisk Przywróć. 

 
 

Wyświetlanie stanów warstw w Eksploratorze ALCAD 

Aby wyświetlić stany warstw 

Wykonaj jedną z poniższych czynności lub wybierz opcję Explore Layer States (  ): 

• Na wstążce wybierz polecenie Narzędzia > Stany warstw (w Eksploratorze). 

• Z menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj stany warstw. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj stany warstw. 

• Wpisz explayerstates i naciśnij Enter. 

• Wybierz Narzędzia > Eksplorator ALCAD, a następnie kliknij element Stany warstw. 
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Importowanie i eksportowanie stanów warstw z plików 
Stany warstw mogą być importowane i eksportowane jako pliki .las. 

Eksportowanie stanów warstw z jednego rysunku i importowanie ich do nowego 

rysunku to szybki sposób na utworzenie wszystkich nowych warstw potrzebnych 

do nowego rysunku. 

Aby zaimportować stan warstwy z pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżera stanów warstw (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Menedżer stanów warstw (w 

obszarze Warstwy). 

• W menu wybierz polecenie Format > Menedżer stanów warstw lub 

wybierz polecenie Format > Eksploruj warstwy, a następnie kliknij 

narzędzie Menedżer stanów warstw. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stanów warstw. 

• Wpisz layerstate i naciśnij Enter. 

2 Kliknij przycisk Otwórz. 

3 Wybierz plik .las do zaimportowania. 

4 Kliknij przycisk Importuj. 
 

Aby wyeksportować stan warstwy do pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Layer State Manager (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Menedżer stanów warstw (w 

obszarze Warstwy). 

• W menu wybierz polecenie Format > Menedżer stanów warstw lub 

wybierz polecenie Format > Eksploruj warstwy, a następnie kliknij 

narzędzie Menedżer stanów warstw. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stanów warstw. 

• Wpisz layerstate i naciśnij Enter. 

2 Wybierz stan warstwy do wyeksportowania. 

3 Kliknij przycisk Eksportuj. 

4 Wprowadź nazwę pliku .las. 

5 Kliknij przycisk OK. 



 

Praca z typami linii 
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Typy linii to sekwencje naprzemiennych segmentów linii, kropek i pustych miejsc, 

które wpływają na wygląd linii. 

 

Zrozumienie typów linii 

ALCAD zapewnia proste i złożone typy linii: 

• Prosty typ linii składa się z powtarzającego się wzoru kropek, kresek lub spacji. 

• Złożony typ linii zawiera osadzone elementy kształtu i tekstu wraz z 

kropkami, myślnikami i spacjami. 

Do reprezentowania określonych rodzajów informacji można używać różnych 

typów linii. Na przykład, jeśli rysujesz plan terenu, możesz narysować drogi za 

pomocą ciągłego typu linii, ogrodzenie za pomocą typu linii z kreskami i 

kwadratowymi słupkami lub linię gazową za pomocą złożonego typu linii z tekstem 

"GAS". 
 

Domyślnie każdy rysunek ma co najmniej trzy typy linii: CONTINUOUS, 

BYLAYER i BYBLOCK. Nie można zmienić nazwy ani usunąć tych typów linii. 

Rysunek może również zawierać nieograniczoną liczbę dodatkowych typów linii. 

Możesz załadować więcej typów linii do programu z pliku biblioteki typów linii lub 

utworzyć i zapisać zdefiniowane przez siebie typy linii. 
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Wyświetlanie informacji o typie linii w ALCAD Explorer 

Aby wyświetlić element ALCAD Explorer Linetypes 

Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 

 

A 

B F 

 
 
 
 
 
 
 
 
 
 
 

 CE E 
 

A Kliknij, aby włączyć lub wyłączyć 
automatyczne ukrywanie palety. Dostępne, 
gdy eksplorator jest paletą 
niezadokowaną. 

B Kliknij, aby wybrać położenie i 
przezroczystość palety. Dostępne, gdy 
eksplorator jest paletą niezadokowaną. 

 
Ustawianie bieżącego typu 
linii 

C Wyświetla nazwy typów linii załadowanych 
do bieżącego rysunku. Znacznik wyboru 
wskazuje bieżący typ linii. 

D Opisuje typy linii załadowane do bieżącego rysunku. 

E Pokazuje, w jaki sposób typy linii będą wyświetlane na rysunku. 

F Kliknij tytuł kolumny, aby sortować według kategorii. 

 

Zazwyczaj jednostka jest rysowana przy użyciu typu linii przypisanego do bieżącej 

warstwy, oznaczonego jako BYLAYER. Można również przypisać typ linii dla 

każdego elementu, co zastępuje ustawienie typu linii warstwy. Trzecią opcją jest 

przypisanie typu linii BYBLOCK, dzięki czemu nowe obiekty są rysowane przy 

użyciu domyślnego typu linii, dopóki nie zostaną zgrupowane w blok. Jednostki 

dziedziczą bieżące ustawienie rodzaju linii po wstawieniu bloku do rysunku. 
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Aby ustawić bieżący typ linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 

2 Z listy Linetype Name (Nazwa typu linii) wybierz typ linii, który chcesz ustawić jako 

aktualny. 

3 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Bieżące. 

• Wybierz ją z listy Linetype Name i kliknij narzędzie Current ( ). 

• Kliknij dwukrotnie nazwę typu linii. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Użyj paska stanu. 

Na pasku stanu kliknij prawym przyciskiem myszy słowo BYLAYER dla bieżącego 

rodzaju linii, kliknij Właściwości, a następnie wybierz rodzaj linii, który chcesz 

uczynić aktualnym. 

 
Ładowanie dodatkowych typów linii 

Zanim będzie można wybrać nowy typ linii do użycia w rysunku, należy utworzyć 

definicję typu linii lub załadować predefiniowany typ linii z pliku biblioteki typów 

linii (*.lin). ALCAD zawiera plik biblioteki typów linii, icad.lin, który zawiera 

ponad 100 predefiniowanych typów linii. 
 

Aby załadować nowy typ linii z biblioteki typów linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 

2 Za pomocą jednej z poniższych metod otwórz okno dialogowe Nowy typ linii: 

• Wybierz Edycja > Nowy > Typ linii. 

• Kliknij narzędzie Nowy element (  ). 

• Gdy kursor znajduje się po prawej stronie okna, kliknij prawym 

przyciskiem myszy, aby wyświetlić menu skrótów, a następnie wybierz 

Nowy > Typ linii. 
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3 Wybierz typ linii do załadowania. 

4 W razie potrzeby kliknij przycisk Przeglądaj, aby wybrać inny plik biblioteki 

typów linii zawierający definicje typów linii, które chcesz załadować. 

5 Kliknij przycisk OK. 

 

 

 
A E 

D 

 
 
 
 

B 

 
 
 
 

C 

 

 

A Wyświetla nazwę bieżącego pliku biblioteki 
typów linii zawierającego definicje typów linii, 
z których można wybierać. 

B Kliknij, aby wybrać i załadować typ linii. 

C Kliknij, aby utworzyć nową definicję typu 
linii dla bieżącego pliku biblioteki typów linii. 

 

Tworzenie i nazywanie typów 
linii 

D Kliknij tytuł kolumny, aby sortować według kategorii. 

E Kliknij, aby otworzyć inny plik biblioteki 
typów linii zawierający typy linii, które 
chcesz wybrać. 

 

Oprócz wczytywania predefiniowanych typów linii z pliku biblioteki typów linii, 

można tworzyć nowe typy linii. Utworzone nowe typy linii można zapisać w pliku 

biblioteki typów linii do wykorzystania w innych rysunkach. 

 

Tworzenie nowego prostego typu linii 

Aby utworzyć nowy prosty typ linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 
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2 Za pomocą jednej z poniższych metod otwórz okno dialogowe Nowy typ linii: 

• Wybierz Edycja > Nowy > Typ linii. 

• Kliknij narzędzie Nowy element (  ). 

• Po umieszczeniu kursora w prawej części okna kliknij prawym 

przyciskiem myszy, aby wyświetlić menu skrótów, a następnie wybierz 

polecenie Nowy > Typ linii. 

3 Kliknij przycisk Nowy. 

4 Wpisz nazwę typu linii. Nie używaj spacji między słowami w nowej nazwie 

typu linii. 

5 W razie potrzeby w polu Linetype File Name określ inny plik biblioteki 

linetype, do którego chcesz dodać nowy linetype. 

6 W polu Opis typu linii wpisz opis typu linii. 

W tym polu można wpisać wszystko, co pomoże zapamiętać cel lub wygląd tego 

typu linii. Na przykład pomocne jest wpisanie tekstu lub symboli , które 

przybliżają wygląd typu linii. 

7 W polu Definicja typu linii wpisz definicję typu linii. 

Definicja składa się z liczb dodatnich i ujemnych oddzielonych przecinkami. 

Liczba dodatnia rysuje ciągły segment linii dla określonej liczby jednostek rysowania; 

liczba ujemna tworzy przerwę dla określonej liczby jednostek; zero tworzy 

kropkę. 

8 Kliknij przycisk OK. 

 

 

 

 
A 

B D 

 
 

C 

 

 
D 

 
 
 

A Wpisz nazwę nowego typu linii. 

B Wprowadź ścieżkę do pliku biblioteki linetype, 
do którego chcesz dodać nowy linetype. 

C Wpisz w tym polu dowolny opis, który 
pomoże ci zapamiętać cel lub wygląd typu 
linii. 

D Typdefinicja typulinii, składająca się z liczb 
dodatnich i ujemnych oddzielonych 
przecinkami. 

E Kliknij, aby przejrzeć i wybrać inny plik 
biblioteki typów linii. 
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Tworzenie nowego złożonego typu linii 

Aby utworzyć nowy complexlinetype 

Złożony typ linii może oznaczać narzędzia, granice, kontury itp. Podobnie jak w 

przypadku prostych typów linii, linie złożone są rysowane dynamicznie, gdy 

użytkownik określa wierzchołki. Kształty i jednostki tekstowe osadzone w liniach są 

zawsze wyświetlane w całości; nigdy nie są przycinane. 

1 Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 

2 Za pomocą jednej z poniższych metod otwórz okno dialogowe Nowy typ linii: 

• Wybierz Edycja > Nowy > Typ linii. 

• Kliknij narzędzie Nowy element (  ). 

• Po umieszczeniu kursora w prawej części okna kliknij prawym przyciskiem 

myszy, aby wyświetlić menu skrótów, a następnie wybierz polecenie Nowy > 

Typ linii. 

3 Kliknij przycisk Nowy. 

4 Wpisz nazwę typu linii. Nie używaj spacji między słowami w nowej nazwie 

typu linii. 

5 W polu Opis typu linii wpisz opis typu linii. 

W tym polu można wpisać wszystko, co pomoże zapamiętać cel lub wygląd 

tego typu linii. W przypadku złożonych typów linii pomocne jest wpisanie opisu 

tekstowego typu linii. 

6 W polu Definicja typu linii wpisz definicję typu linii. 

Podobnie jak w przypadku prostych typów linii, składnia złożonego typu linii 

jest listą deskryptorów wzorców oddzielonych przecinkami. Aby uzyskać więcej 

informacji, zobacz "Składnia definicji złożonego typu linii" na stronie 273 w tym 

rozdziale. 

7 Kliknij przycisk OK. 
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Składnia złożonej definicji typu linii 
Złożone typy linii mogą zawierać jednostki kształtu i tekstu jako deskryptory 

wzorca, a także deskryptory kresek i kropek prostych typów linii. 
 

Składnia deskryptora kształtu 

Jednostkę kształtu można dodać do złożonego typu linii przy użyciu następującej składni: 

[nazwa_kształtu, nazwa_kształtu] lub [nazwa_kształtu, nazwa_kształtu, transform] 

Definicje pól w składni są następujące. 

shape_name 

Nazwa kształtu dodawanego do typu linii. Nazwa kształtu musi istnieć w 

określonym pliku kształtu (nazwa_kształtu). 

shape_filename 

Nazwa skompilowanego pliku definicji kształtu (rozszerzenie *.shx). Jeśli nie 

określono ścieżki dla nazwy pliku kształtu, przeszukiwana jest ścieżka biblioteki. 

przekształcenie 

Argument transform jest opcjonalny i może być dowolną serią następujących 

argumentów (każdy poprzedzony przecinkiem): 

R=wartość Obrót względny 

A=wartość Obrót bezwzględny 

S=wartość  Skala 

X=wartość X offset 

Y=wartość Y offset 

W tej składni wartość reprezentuje liczbę dziesiętną ze znakiem. Obrót jest 

wyrażony w stopniach, podczas gdy inne opcje są w jednostkach rysunkowych 

skalowanego typu linii. 

obrót 

R=wartość lub A=wartość 

R= określa względny lub styczny obrót względem rozwinięcia linii. 

A= określa bezwzględny obrót kształtu względem początku. Wszystkie kształty 

mają taki sam obrót niezależnie od ich względnego położenia względem linii. 

Obrót 
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można dodać d dla stopni (domyślnie), r dla radianów lub g dla gradów. Jeśli 

rotacja zostanie pominięta, używana jest rotacja względna 0. 

skala 

S=wartość 

Określa współczynnik, przez który mnożona jest wewnętrzna skala kształtu. Jeśli 

wewnętrzna skala kształtu wynosi 0, wartość skali jest używana jako skala. 

X offset 

X=wartość 

Określa przesunięcie kształtu wzdłuż osi X typu linii obliczonej od końca 

wierzchołka definicji typu linii. Jeśli przesunięcie X jest pominięte lub wynosi 0, 

kształt jest opracowywany bez przesunięcia. Uwzględnij to pole, jeśli chcesz 

uzyskać ciągłą linię z kształtami. Wartość ta nie jest skalowana przez 

współczynnik skali zdefiniowany przez S. 

Y offset 

Y=wartość 

Określa przesunięcie kształtu wzdłuż osi Y typu linii obliczonej od końca 

wierzchołka definicji typu linii. Jeśli przesunięcie Y jest pominięte lub wynosi 0, 

kształt jest elaborowany bez przesunięcia. Wartość ta nie jest skalowana przez 

współczynnik skali zdefiniowany przez S. 
 

Składnia deskryptora tekstowego 

Jednostkę tekstową można dodać do złożonego typu linii przy użyciu następującej składni: 

["string", style_name] lub ["string", style_name, transform]. 

Definicje pól w składni są następujące. 

ciąg 

Tekst, który ma być użyty w złożonym typie linii. W ciągu tekstowym nie 

można używać znaków ` lub ". Aby użyć tych znaków, należy zamiast nich 

wprowadzić kod sterujący (%%) z wartością ASCII znaku. 

style_name 

Nazwa stylu tekstu, który ma zostać opracowany. Określony styl tekstu musi 

być dołączony. Jeśli zostanie pominięty, użyty zostanie aktualnie zdefiniowany 

styl. 

przekształcenie 

Argument transform jest opcjonalny i może być dowolną serią następujących 

argumentów (każdy poprzedzony przecinkiem): 

R=wartość Rotacja względna 

A=wartość Rotacja 

bezwzględna S=wartość Skala 

X=wartość X offset 

Y=wartość Y offset 
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W tej składni wartość reprezentuje liczbę dziesiętną ze znakiem. Obrót jest 

wyrażony w stopniach, podczas gdy inne opcje są w jednostkach rysunkowych 

skalowanego typu linii. 

obrót 

R=wartość lub A=wartość 

R= określa względny lub styczny obrót względem rozwinięcia linii. 

A= określa bezwzględny obrót tekstu względem początku. Cały tekst ma taki sam 

obrót niezależnie od jego względnego położenia względem linii. Do wartości 

można dodać d dla stopni (domyślnie), r dla radianów lub g dla gradów. Jeśli 

rotacja zostanie pominięta, używana jest rotacja względna 0. 

Obrót jest wyśrodkowany między linią bazową a polem nominalnej wysokości nakładki. 

skala 

S=wartość 

Określa współczynnik, przez który mnożona jest wysokość stylu. Jeśli wysokość 

stylu wynosi 0, wartość skali jest używana jako skala. 

Ponieważ ostateczna wysokość tekstu jest definiowana zarówno przez wartość 

skali, jak i wysokość przypisaną do stylu tekstu, można uzyskać bardziej 

przewidywalne wyniki, ustawiając wysokość stylu tekstu na 0. Zaleca się 

utworzenie oddzielnych stylów tekstu dla tekstu w złożonych typach linii, aby 

uniknąć konfliktów z innym tekstem w rysunku. 

X offset 

X=wartość 

Określa przesunięcie tekstu wzdłuż osi X typu linii obliczone od końca 

wierzchołka definicji typu linii. Jeśli przesunięcie X zostanie pominięte lub 

wyniesie 0, tekst zostanie opracowany przy użyciu lewego dolnego rogu tekstu 

jako przesunięcia. Uwzględnij to pole, jeśli chcesz uzyskać ciągłą linię z tekstem. 

Wartość ta nie jest skalowana przez współczynnik skali zdefiniowany przez S. 

Y offset 

Y=wartość 

Określa przesunięcie tekstu wzdłuż osi Y typu linii obliczonej od końca 

wierzchołka definicji typu linii. Jeśli przesunięcie Y jest pominięte lub wynosi 0, 

tekst jest przesuwany przy użyciu lewego dolnego rogu tekstu jako przesunięcia. 

Wartość ta nie jest skalowana przez współczynnik skali zdefiniowany przez S. 
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Modyfikowanie typów linii 

Aby zmienić nazwę typu linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać Explore Linetypes (  ): 

• Na wstążce wybierz Narzędzia > Typy linii (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj typy linii. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj typy linii. 

• Wpisz expltypes i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz typ linii, a następnie wybierz polecenie Edycja > Zmień nazwę. 

• Kliknij nazwę typu linii, którą chcesz zmienić, a następnie wpisz nową nazwę. 

• Kliknij prawym przyciskiem myszy nazwę typu linii, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 

Typy linii o nazwach CONTINUOUS, BYBLOCK i BYLAYER są zarezerwowane. 

Nie można zmienić ich nazwy. 
 

 

 

 

Praca ze stylami tekstu 
 

Styl tekstu to nazwany, zapisany zbiór ustawień formatu, który określa wygląd 

tekstu. 

 

Zrozumienie stylów tekstu 

Po dodaniu tekstu do rysunku jest on tworzony przy użyciu bieżącego stylu tekstu. 

Styl tekstu określa czcionkę, rozmiar, kąt, orientację, czy tekst jest domyślnie 

adnotacyjny i inne cechy tekstu. 

Każdy rysunek ma co najmniej jeden styl tekstu o nazwie Standardowy, który 

początkowo używa czcionki Arial. Stylu Standard nie można usunąć, ale można 

zmienić jego nazwę lub zmodyfikować go. Można na przykład zmienić czcionkę 

lub kąt pochylenia zastosowany do czcionki. W rysunku można także użyć 

nieograniczonej liczby dodatkowych stylów tekstu. 

Z poziomu Eksploratora ALCAD można bezpośrednio edytować dowolne 

ustawienie powiązane ze stylem tekstu, korzystając z metody edycji jednym 

kliknięciem w celu zmiany ustawienia. 
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Wyświetlanie informacji o stylu tekstu w ALCAD Explorer 

Aby wyświetlić element Style tekstu Eksploratora ALCAD 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style tekstu (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj style tekstu. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style tekstu. 

• Wpisz expstyles i naciśnij Enter. 

 

 
A 
B 

 
 
 
 
 
 
 
 
 
 
 

 CDEFGHIJKLMNOP 
 

 
A Kliknij, aby włączyć lub wyłączyć automatyczne ukrywanie 

palety. Dostępne, gdy eksplorator jest paletą 
niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość palety. 
Dostępne, gdy eksplorator jest paletą niezadokowaną. 

C Wyświetla nazwy stylów tekstu zdefiniowanych w 
bieżącym rysunku. Znacznik wyboru wskazuje bieżący 
styl. 

D Wskazuje, czy tekst będzie domyślnie opatrzony 
adnotacjami; można kliknąć, aby włączyć lub wyłączyć tę 
opcję. 

E Wskazuje, czy tekst adnotacji w przestrzeni papieru 
będzie zorientowany zgodnie z rzutnią układu; można 
kliknąć, aby włączyć lub wyłączyć tę opcję. 

F Wyświetla wysokość stylu tekstu; można wpisać nową 
wysokość. 

G Wyświetla współczynnik szerokości dla stylu tekstu; można 
wpisać nowy współczynnik szerokości. 

H Wyświetla kąt ukośny dla stylu tekstu; można 
wprowadzić nowy kąt ukośny. 

 
I Wyświetla nazwę czcionki, na której oparty jest styl; 

można wybrać nową czcionkę. 

J Wyświetla styl czcionki, taki jak pogrubienie lub kursywa; 
można wybrać nowy styl czcionki. 

K Wyświetla język, na którym oparty jest styl tekstu; 
można wybrać nowy język. 

L Wyświetla, czy używane są pliki dużych czcionek w języku azjatyckim (dla 
tylko czcionki z pliku .shx). 

M Wskazuje, czy tekst będzie wyświetlany do tyłu; można 
kliknąć, aby włączyć lub wyłączyć tę opcję. 

N Wskazuje, czy tekst będzie wyświetlany do góry nogami; 
można kliknąć, aby włączyć lub wyłączyć tę opcję. 

O Wskazuje, czy tekst będzie wyświetlany pionowo; 
można kliknąć, aby włączyć lub wyłączyć tę opcję. 

P Kliknij tytuł kolumny, aby sortować według kategorii. 
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Tworzenie i nazywanie stylów tekstu 

Czcionki to zestawy znaków składające się z liter, cyfr, znaków interpunkcyjnych i 

symboli. Każda czcionka jest przechowywana we własnym pliku czcionki. Style 

tekstu stosują dodatkowe formatowanie do czcionek. Można utworzyć wiele stylów 

tekstu opartych na tej samej czcionce, zmieniając różne cechy w celu zmiany 

wyglądu czcionki. Aby utworzyć nowy styl tekstu, należy przypisać charakterystykę 

formatowania do czcionki. 

ALCAD używa plików czcionek *.shx i zapewnia wybór czcionek. Czcionki te 

znajdują się w katalogu ALCAD/Fonts. Można również użyć dowolnej czcionki 

zaprojektowanej do pracy z AutoCAD, a także czcionek systemowych Windows. 

Wiele czcionek jest dostępnych od innych producentów. 
 

Aby utworzyć nowy styl tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style tekstu (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj style tekstu. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style tekstu. 

• Wpisz expfonts i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edycja > Nowy > Styl tekstu. 

• Kliknij narzędzie Nowy element (  ). 

Do listy stylów tekstu dodawany jest nowy styl o domyślnej nazwie NewStyle1. 

3 Wpisz nazwę nowego stylu, wpisując ją nad podświetlonym tekstem 

domyślnym, a następnie naciśnij klawisz Enter. 

4 Kliknij kolumny elementów, które chcesz zmienić i dokonaj wyboru nowego 

stylu tekstu. 

5 Aby zakończyć polecenie, zamknij okno. 
 

Aby zmienić nazwę stylu tekstu w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style tekstu (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj style tekstu. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style tekstu. 

• Wpisz expfonts i naciśnij Enter. 
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2 Wykonaj jedną z poniższych czynności: 

• Zaznacz styl tekstu, wybierz polecenie Edycja > Zmień nazwę, wpisz nową 

nazwę i naciśnij klawisz Enter. 

• Kliknij nazwę stylu tekstu, którą chcesz zmienić, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę stylu tekstu, którą chcesz zmienić, 

a następnie z menu skrótów wybierz polecenie Zmień nazwę, wpisz nową 

nazwę i naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Modyfikowanie stylów tekstu 

Nowy styl tekstu ma początkowo przypisane wartości domyślne dla wysokości, 

współczynnika szerokości, kąta nachylenia i innych cech. Wartości te można 

zmienić zarówno dla nowych, jak i istniejących stylów tekstu. Można również 

zmienić czcionkę przypisaną do stylu tekstu. W przypadku zmiany właściwości 

czcionki lub orientacji stylu tekstu przypisanego do tekstu wcześniej wstawionego 

do rysunku, cały tekst korzystający z tego stylu jest odtwarzany w celu odzwierciedlenia 

zmian. Kąt pochylenia i wysokość, jeśli są określone, są podawane przez definicję 

stylu podczas tworzenia tekstu, ale nie są aktualizowane dla istniejącego tekstu po 

zmianie stylu. 

Stała wartość wysokości tekstu równa 0 umożliwia określenie wysokości tekstu w 

momencie wstawiania tekstu do rysunku. Każda inna wartość ustawia wysokość 

tekstu na tę wartość; program nie pyta o wysokość tekstu podczas wstawiania tekstu do 

rysunku. Współczynnik szerokości określa poziome skalowanie tekstu. Wartość 

mniejsza niż 1 zmniejsza tekst (na przykład 0,75 zmniejsza tekst o 25%); wartość 

większa niż 1 rozszerza tekst (na przykład 1,50 rozszerza tekst o 50%). Kąt 

pochylenia określa pochylenie tekstu do przodu lub do tyłu jako kąt przesunięty 

względem 90 stopni. Wartości ujemne pochylają tekst w lewo; wartości dodatnie 

pochylają tekst w prawo. 
 

Aby zmodyfikować styl tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style tekstu (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj style tekstu. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style tekstu. 

• Wpisz expfonts i naciśnij Enter. 

2 Kliknij żądaną kolumnę dla stylu tekstu, który chcesz zmienić, a następnie 

wprowadź żądane zmiany. 

3 Aby zakończyć polecenie, zamknij okno ALCAD Explorer. 
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Ustawianie bieżącego stylu tekstu 

Podczas wstawiania tekstu do rysunku tekst jest tworzony przy użyciu bieżącego 

stylu tekstu. Podczas tworzenia tekstu można także wybrać inny styl tekstu. 
 

Aby styl tekstu był aktualny 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style tekstu (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj style tekstu. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style tekstu. 

• Wpisz expfonts i naciśnij Enter. 

2 Na liście Nazwa stylu tekstu kliknij styl, który chcesz włączyć. 

3 Użyj jednej z poniższych metod, aby ustawić styl jako bieżący styl: 

• Wybierz Edytuj > Bieżące. 

• Kliknij Bieżące narzędzie ( ). 

• Gdy kursor znajduje się po prawej stronie okna, kliknij prawym 

przyciskiem myszy, aby wyświetlić menu skrótów, a następnie wybierz 

opcję Bieżące. 

4 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno 

Eksploratora ALCAD. 

 

Użyj skrótu. 

Styl tekstu można również ustawić jako bieżący, zaznaczając go na liście Nazwa 

stylu tekstu i klikając narzędzie Bieżący (  ) lub klikając dwukrotnie nazwę stylu 

tekstu na liście Nazwa stylu tekstu. 
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Praca z układami współrzędnych 
 

Układ współrzędnych to układ punktów, który reprezentuje przestrzeń rysunkową 

w odniesieniu do początku (0,0,0) i zestawu osi, które przecinają się w początku. 

 

Zrozumienie układów współrzędnych 

Podczas tworzenia jednostek na rysunku są one umieszczane w odniesieniu do 

bazowego kartezjańskiego układu współrzędnych rysunku. Każdy rysunek ma stały 

układ współrzędnych zwany Światowym Układem Współrzędnych (WCS). Nie 

można usunąć ani zmodyfikować WCS. 

Rysunek może jednak zawierać dodatkowe układy współrzędnych, każdy z własnym 

początkiem i orientacją 0,0,0. Możesz utworzyć dowolną liczbę układów 

współrzędnych użytkownika, a następnie zapisać je i przywołać w razie potrzeby. 

Pochodzenie układu współrzędnych można edytować z poziomu Eksploratora 

ALCAD, klikając pojedynczo współrzędne pochodzenia, a następnie wpisując nowe 

współrzędne. 

Można na przykład utworzyć oddzielny układ współrzędnych użytkownika (UCS) 

dla każdej strony budynku. Następnie, przełączając się na UCS dla wschodniej 

strony budynku, można narysować okna po tej stronie, określając tylko ich 

współrzędne x i y. 

Możesz tworzyć, a następnie przełączać się między różnymi układami 

współrzędnych użytkownika, wybierając Układy współrzędnych w Eksploratorze 

ALCAD. 

 

Wyświetlanie informacji o układzie współrzędnych w ALCAD Explorer 

Aby wyświetlić element Układy współrzędnych 

Wykonaj jedną z poniższych czynności, aby wybrać Eksploruj układy współrzędnych (  ): 

• Na wstążce wybierz Narzędzia > Układy współrzędnych (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy współrzędnych. 

• Wybierz kolejno Narzędzia > Układy współrzędnych użytkownika > Eksploruj układy 

współrzędnych. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy współrzędnych. 

• Wpisz expucs i naciśnij Enter. 
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H 

A 

B G 

 
 
 
 
 
 
 
 
 
 
 

 
 CDEF 

 

A Kliknij, aby włączyć lub wyłączyć automatyczne 
ukrywanie palety. Dostępne, gdy eksplorator jest 
paletą niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość 
palety. 
Dostępne, gdy eksplorator jest paletą niezadokowaną. 

C Wyświetla nazwy układów współrzędnych 
zdefiniowanych w bieżącym rysunku. Znacznik 
wyboru wskazuje bieżący układ współrzędnych. 

D Wyświetla początek układu współrzędnych w 
odniesieniu do WCS. 

E Wyświetla kierunek osi sześciokątnej układu 
współrzędnych w odniesieniu do WCS. 

F Wyświetla kierunek osi układu współrzędnych w 
odniesieniu do WCS. 

G Kliknij tytuł kolumny, aby sortować według kategorii. 

H Wybierz podstawowy układ współrzędnych użytkownika. 

 

Definiowanie i nazywanie układów współrzędnych użytkownika 

Rysunek może zawierać dowolną liczbę układów współrzędnych, które można 

nazwać odpowiednimi nazwami, aby można było zapamiętać, w jaki sposób są one 

używane na rysunku w celu ich późniejszego przywołania. 
 

Aby zdefiniować nowe układy współrzędnych użytkownika w ALCAD Explorer 

1 Wykonaj jedną z poniższych czynności, aby wybrać Eksploruj układy współrzędnych (  ): 

• Na wstążce wybierz Narzędzia > Układy współrzędnych (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy 

współrzędnych. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy współrzędnych. 

• Wpisz expucs i naciśnij Enter. 
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2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > UCS. 

• Kliknij narzędzie Nowy element (  ). 

• Umieść kursor w prawej części okna i kliknij prawym przyciskiem 

myszy, aby wyświetlić menu skrótów, a następnie wybierz New > UCS. 

3 Wybierz metodę z okna podpowiedzi lub paska poleceń, za pomocą której 

chcesz zdefiniować układ UCS w oknie rysunku. 

Na przykład wybierz opcję 3 punkty, a następnie określ trzy punkty w oknie 

rysunku, aby zdefiniować osie x, y i z dla układu współrzędnych. 

4 Wpisz nazwę nowego układu współrzędnych użytkownika, wpisując ją nad 

podświetlonym tekstem domyślnym, a następnie naciśnij klawisz Enter. 

5 Aby zakończyć polecenie, zamknij okno. 
 

Aby zmienić nazwę układu współrzędnych użytkownika w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Eksploruj układy współrzędnych (  ): 

• Na wstążce wybierz Narzędzia > Układy współrzędnych (w Eksploratorze). 

• Z menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy 

współrzędnych. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy współrzędnych. 

• Wpisz expucs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz układ współrzędnych użytkownika, a następnie wybierz Edytuj > 

Zmień nazwę, wpisz nową nazwę i naciśnij klawisz Enter. 

• Kliknij nazwę systemu współrzędnych użytkownika, którą chcesz zmienić, 

wpisz nową nazwę, a następnie naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę systemu współrzędnych 

użytkownika, którą chcesz zmienić, a następnie z menu skrótów wybierz 

opcję Zmień nazwę, wpisz nową nazwę, a następnie naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Ustawienie bieżącego układu współrzędnych użytkownika 

Podczas rysowania nowych elementów są one tworzone w odniesieniu do 

bieżącego układu współrzędnych. Bieżący UCS można ustawić w Eksploratorze 

ALCAD. 
 

Aby ustawić bieżący UCS z ALCAD Explorer 

Wykonaj jedną z poniższych czynności: 

• Kliknij dwukrotnie nazwę UCS na liście UCS Name. 

• Wybierz UCS z listy UCS Name, a następnie wybierz Edit > Current. 

• Wybierz UCS z listy UCS Name, a następnie kliknij narzędzie Current ( ). 
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Praca z nazwanymi widokami  
 

Nazwany widok to zapisana kolekcja ustawień widoku, która określa kierunek 

widoku, granice, UCS, styl wizualny, tło, perspektywę itp. Nazwane widoki mogą być 

zapisywane i przywracane w bieżącym oknie w dowolnym momencie. Użyj Eksploratora 

ALCAD, aby zarządzać nazwanymi widokami i szybko przełączać się między 

widokami. 

Z poziomu Eksploratora ALCAD dostępny jest również Menedżer widoków, który 

służy do tworzenia nowych widoków i modyfikowania wszelkich ustawień widoku. 

Aby uzyskać więcej informacji, zobacz "Tworzenie i przełączanie na nazwane 

widoki" na stronie 577. 

 

Wyświetlanie widoków w Eksploratorze ALCAD 

Aby wyświetlić widoki w Eksploratorze ALCAD 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj widoki (  ): 

• Na wstążce wybierz Narzędzia > Widoki (w Eksploratorze). 

• Wybierz Narzędzia > Eksploruj widoki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj widoki. 

• Wpisz expviews i naciśnij Enter. 

• Wybierz Narzędzia > ALCAD Explorer, a następnie kliknij element Widoki. 
 

Nazwane widoki są przechowywane na rysunku. 

Eksploratora ALCAD można używać do kopiowania i wklejania nazwanych 

widoków z jednego rysunku do drugiego. Kliknij narzędzie Pokaż jako palety, aby 

wyświetlić Eksplorator jako okno dialogowe, aby zobaczyć aktualnie otwarte 

rysunki, a następnie skopiować i wkleić między nimi. 
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A Kliknij, aby włączyć lub wyłączyć automatyczne 
ukrywanie palety. Dostępne, gdy eksplorator jest 
paletą niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość 
palety. Dostępne, gdy eksplorator jest paletą 
niezadokowaną. 

C Wyświetla nazwy widoków zdefiniowanych w 
bieżącym rysunku. 
Znacznik wyboru oznacza bieżący 

widok. 

D Wyświetla wysokość widoku w jednostkach rysunkowych. 

 
E Wyświetla szerokość widoku w jednostkach rysunkowych. 

F Wyświetla kierunek widoku, wyrażony jako 
trójwymiarowa współrzędna w WCS. 

G Kliknij tytuł kolumny, aby sortować według kategorii. 

H Kliknij, aby otworzyć Menedżera widoków w celu 
określenia dodatkowych ustawień widoku. 
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Zapisywanie i nazywanie widoków 

Widok wyświetlany w bieżącym oknie można zapisać jako widok nazwany. Po 

zapisaniu nazwanego widoku można go w dowolnym momencie przywrócić w 

bieżącym oknie. 
 

Aby zapisać część bieżącego widoku jako widok nazwany 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj widoki (  ): 

• Na wstążce wybierz Narzędzia > Widoki (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj widoki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj widoki. 

• Wpisz expviews i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > Widok. 

• Na pasku narzędzi ALCAD Explorer kliknij narzędzie Nowy element (  ). 

3 Określa pierwszy narożnik okna widoku. 

4 Określ przeciwległy róg okna widoku. 

5 Wpisz nową nazwę widoku, a następnie naciśnij klawisz Enter. 
 

Nazwane widoki można tworzyć na więcej sposobów za pomocą Menedżera widoków. 

W obszarze Eksploruj widoki kliknij narzędzie Menedżer widoków. Więcej 

informacji można znaleźć w sekcji "Tworzenie i przełączanie widoków nazwanych" 

na stronie 577. 
 

 
Przywracanie nazwanych widoków 

Po zapisaniu jednego lub więcej nazwanych widoków można przywrócić dowolny 

z tych widoków w bieżącym oknie za pomocą polecenia Widok lub Eksploratora 

ALCAD. 
 

Aby przywrócić nazwany widok z Eksploratora ALCAD 

Wykonaj jedną z poniższych czynności: 

• Wybierz nazwę widoku na liście ustawień widoku, a następnie wybierz Edytuj > Bieżący. 

• Wybierz nazwę widoku na liście ustawień widoku, a następnie kliknij 

narzędzie Bieżący (  ). 

• Kliknij dwukrotnie nazwę widoku na liście widoków. 
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Aby przywrócić nazwany widok za pomocą polecenia View 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• W menu wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• Wpisz view i naciśnij Enter. 

2 Wybierz widok, który chcesz przywrócić. 

3 Kliknij przycisk OK. 

 
Modyfikowanie ustawień nazwanych widoków 

Po utworzeniu nazwanego widoku można modyfikować jego właściwości, takie jak 

kierunek docelowy i kąt skręcenia. Daje to dostęp do wielu ustawień widoku po jego 

zdefiniowaniu. Niektóre właściwości są dostępne bezpośrednio w Eksploratorze 

ALCAD, podczas gdy inne są dostępne w Menedżerze widoków. 

Zmieniać można tylko utworzone widoki nazwane; nie można modyfikować widoków 

predefiniowanych. 
 

Aby zmienić opcje widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj widoki (  ): 

• Na wstążce wybierz Narzędzia > Widoki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksploruj widoki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj widoki. 

• Wpisz expviews i naciśnij Enter. 

2 Aby zmienić nazwę widoku, wykonaj jedną z poniższych czynności: 

• Zaznacz widok, wybierz Edytuj > Zmień nazwę, wpisz nową nazwę i naciśnij Enter. 

• Kliknij nazwę widoku, którą chcesz zmienić, wpisz nową nazwę, a następnie naciśnij 

klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę widoku, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę 

i naciśnij klawisz Enter. 

3 Kliknij kolumnę Wysokość, Szerokość lub Kierunek widoku dla widoku, 

który chcesz zmienić, a następnie wpisz zmiany. 

4 Aby wprowadzić dodatkowe zmiany, kliknij narzędzie Menedżer widoku (

 ), zmień żądane ustawienia, a następnie zamknij okno dialogowe. 
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Praca z układami 
 

Każdy tworzony rysunek zawiera obszar, w którym wykonywana jest większość 

pracy na karcie Model, a także może zawierać liczne układy na kartach Układ, które 

symulują papier, na którym zostanie wydrukowana kopia rysunku. 

Korzystając z ALCAD Explorer, można zarządzać układami w rysunku, 

przypisywać ustawienia strony, a także łatwo kopiować układy do ponownego 

wykorzystania w innych rysunkach. 

Aktywacja układu w ALCAD Explorer jest odpowiednikiem kliknięcia 

odpowiedniej zakładki w oknie rysunku. 

 

Wyświetlanie układów w Eksploratorze ALCAD 

Aby wyświetlić układy w Eksploratorze ALCAD 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj układy (  ): 

• Na wstążce wybierz Narzędzia > Układy (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksploruj układy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy. 

• Wpisz explayouts i naciśnij Enter. 

• Wybierz Narzędzia > ALCAD Explorer, a następnie kliknij element Widoki. 

 

A 
 BF 

 
 
 
 
 
 
 
 

 
 CDE 

 

A Kliknij, aby włączyć lub wyłączyć 
automatyczne ukrywanie palety. Dostępne, 
gdy eksplorator jest paletą 
niezadokowaną. 

B Kliknij, aby wybrać położenie i 
przezroczystość palety. Dostępne, gdy 
eksplorator jest paletą niezadokowaną. 

C Wyświetla nazwy układów zdefiniowanych 
w bieżącym rysunku. Znacznik wyboru 
wskazuje bieżący układ. 

D Wyświetla nazwę bloku, do którego 
należy układ. 

E Kliknij, aby wyświetlić lub określić aktualnie 
przypisane ustawienia stron dla 
odpowiedniego układu. 

F Kliknij tytuł kolumny, aby sortować według kategorii. 
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Tworzenie i nazywanie układów 

Każdy rysunek może zawierać jeden układ dla modelu i do 255 innych układów. 
 

Aby utworzyć nowy układ 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj układy (  ): 

• Na wstążce wybierz Narzędzia > Układy (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy. 

• Wpisz explayouts i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > Układ. 

• Kliknij narzędzie Nowy element (  ). 

Nowy układ jest dodawany do listy układów z domyślną nazwą. 

3 Wpisz nazwę nowego układu, wpisując ją nad podświetlonym tekstem 

domyślnym, a następnie naciśnij klawisz Enter. 

4 Aby zakończyć polecenie, zamknij okno. 
 

Aby zmienić nazwę układu za pomocą ALCAD Explorer 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj układy (  ): 

• Na wstążce wybierz Narzędzia > Układy (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy. 

• Wpisz explayouts i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz układ, wybierz polecenie Edycja > Zmień nazwę, wpisz nową nazwę, a następnie 

naciśnij klawisz Enter. 

• Kliknij nazwę układu, którą chcesz zmienić, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę układu, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę, 

a następnie naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Określanie opcji konfiguracji strony dla układu 

Do każdego układu można przypisać własne ustawienia strony. Umożliwia to dostosowanie 

unikatowych ustawień drukowania dla każdego układu. Jeśli niektóre układy 

korzystają z tych samych ustawień drukowania, układom tym można przypisać te 

same ustawienia strony. 

Przypisanie konfiguracji strony do modelu lub układu nie oznacza, że będzie on 

zawsze drukowany z określonymi ustawieniami. Wszystkie ustawienia drukowania 

określone dla konfiguracji strony można zastąpić podczas drukowania. 
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Więcej informacji na temat konfiguracji stron można znaleźć w sekcji "Praca z konfiguracjami 

stron" na stronie 530. 
 

Aby przypisać konfigurację strony do układu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj układy (  ): 

• Na wstążce wybierz Narzędzia > Układy (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy. 

• Wpisz explayouts i naciśnij Enter. 

2 Kliknij w kolumnie Ustawienia strony dla żądanego układu. 

3 Wybierz żądaną konfigurację strony, kliknij przycisk Ustaw bieżącą, a następnie kliknij 

przycisk Zamknij. 

4 Aby zakończyć polecenie, zamknij okno ALCAD Explorer. 
 

Aby zmodyfikować ustawienia przypisanej konfiguracji strony 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj układy (  ): 

• Na wstążce wybierz Narzędzia > Układy (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj układy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj układy. 

• Wpisz explayouts i naciśnij Enter. 

2 Kliknij w kolumnie Ustawienia strony dla wybranego układu. 

3 Wybierz konfigurację strony, która wymaga zmian, a następnie kliknij przycisk Modyfikuj. 

4 Wybierz nowe opcje, a następnie kliknij przycisk OK. 

5 W razie potrzeby wybierz konfigurację strony, którą chcesz przypisać do 

układu, a następnie kliknij przycisk Ustaw bieżące. 

6 Kliknij przycisk Zamknij. 

7 Aby zakończyć polecenie, zamknij okno ALCAD Explorer. 
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Bloki reprezentują specjalny typ jednostek, które po zapisaniu mogą być wstawiane 

i manipulowane na rysunku jako pojedyncza jednostka. 

 

Zrozumienie bloków 

Blok może składać się z widocznych elementów, takich jak linie, łuki i okręgi, a 

także widocznych lub niewidocznych danych zwanych atrybutami. Atrybutów 

można używać do śledzenia takich elementów jak numery części i ceny oraz do 

eksportowania informacji o atrybutach do zewnętrznej bazy danych. Można również 

śledzić liczbę części, zliczając liczbę wstawień bloku do rysunku. Bloki są 

przechowywane jako część pliku rysunku. 

Odniesienia zewnętrzne mają podobne zastosowania jak bloki. Korzystając z 

odniesień zewnętrznych, można dołączać całe rysunki do bieżącego rysunku. Jednak 

w przeciwieństwie do bloku, odniesienie zewnętrzne nie staje się częścią bieżącego 

rysunku. 

Bloki można zapisywać w Eksploratorze ALCAD. Możesz także użyć 

Eksploratora ALCAD do zarządzania i wstawiania kopii bloków. Eksplorator 

ALCAD wyświetla nazwy wszystkich bloków zawartych w bieżącym rysunku, 

wraz z innymi informacjami o każdym bloku lub odnośniku zewnętrznym. 

Możesz także zmienić nazwę bloku, zmodyfikować jego punkt wstawienia i 

zmienić ścieżkę rysunku z odniesieniem zewnętrznym, klikając pojedynczo 

właściwość i wprowadzając zmiany w Eksploratorze ALCAD. 

Oprócz Eksploratora ALCAD można również pracować z blokami za pomocą 

Edytora bloków, używając różnych poleceń bloków i dodając bloki do palet 

narzędzi. Aby uzyskać więcej informacji na temat Edytora bloków i różnych poleceń 

bloków, patrz "Praca z blokami" na stronie 468. Więcej informacji na temat palet 

narzędzi można znaleźć w sekcji "Dostosowywanie palet narzędzi" na stronie 723. 

 

Wyświetlanie informacji o bloku w ALCAD Explorer 

Aby wyświetlić bloki w Eksploratorze ALCAD 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 



 ToolFunction 
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Element Bloki w Eksploratorze ALCAD domyślnie ma włączone ikony. Widok 

ikon pokazuje mały obraz każdego bloku. 

 
 

W widoku Obrazy wyświetlany jest obraz każdego bloku na wybranym rysunku. Kliknij obraz, aby go 
zaznaczyć. 

 

Gdy wyświetlane są bloki, dodatkowe narzędzia na pasku narzędzi Bloki 

udostępniają funkcje opisane w poniższej tabeli: 
 

Dodatkowe narzędzia na pasku narzędzi Blokuj 
 

(  ) Ikony Wyświetla obraz każdego bloku. 

 
( ) Szczegóły Wyświetla informacje o każdym bloku. 

 
(  ) Wstaw Wstawia blok. 

(  ) Wstaw blok pliku zewnętrznego Wstawia rysunek dostępny z dysku jako blok. 

(  )Zapisz blok Zapisuje wybrany blok jako niezależny plik.dwg. 

 

(  ) Edytuj odniesienie do bloku Zmienia definicję bloku. 

 

Aby wyświetlić więcej informacji o każdym bloku, kliknij narzędzie Szczegóły (  

). W widoku szczegółów można edytować ścieżkę i punkt wstawienia, klikając 
ustawienie i wpisując zmiany. 
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B 

 
 
 
 
 
 
 
 
 
 
 

 CDE  FGHIJ 
 

A Kliknij, aby włączyć lub wyłączyć automatyczne 
ukrywanie palety. Dostępne, gdy eksplorator jest 
paletą niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość 
palety. Dostępne, gdy eksplorator jest paletą 
niedokowaną. 

C Wyświetla nazwy bloków zdefiniowanych w bieżącym 
rysunku. 

Kliknij i wpisz, aby ją zmodyfikować. 

D Wyświetla liczbę wystąpień bloku w bieżącym 
rysunku. 

E Wyświetla punkt wstawienia bloku na bieżącym 
rysunku. Kliknij i wpisz, aby go zmodyfikować. 

F Wskazuje, czy blok domyślnie zawiera adnotacje; 
kliknij, aby włączyć lub wyłączyć tę opcję. 

G Wskazuje, czy blok, gdy znajduje się w przestrzeni 
papieru, jest zorientowany automatycznie zgodnie z 
rzutnią układu; kliknij, aby włączyć lub wyłączyć 
opcję. (Dostępne tylko dla bloków adnotacji). 

H Wskazuje, czy blok musi być skalowany proporcjonalnie; 
kliknij, aby włączyć lub wyłączyć tę opcję. 

I Wskazuje, czy blok może zostać rozbity; kliknij, aby 
włączyć lub wyłączyć tę opcję. 

J Wyświetla opis bloku. Kliknij i wpisz, aby go 
zmodyfikować. 

K Kliknij tytuł kolumny, aby sortować według kategorii. 
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Tworzenie i nazywanie bloków 

Można połączyć dowolną liczbę elementów w jeden blok. Po utworzeniu bloku 

można wstawić jego kopie do rysunku. Każde wstawienie bloku jest traktowane 

jako pojedyncza jednostka; na przykład można obracać lub skalować każdy blok po 

jego wstawieniu. Program dodaje nazwę nowego wstawionego bloku do listy 

Nazwa bloku w Eksploratorze ALCAD. 
 

Aby utworzyć blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > Blok. 

• Na pasku narzędzi ALCAD Explorer kliknij narzędzie Nowy element (  ). 

3 W oknie dialogowym Block definition wprowadź nazwę i opis nowego bloku. 

4 Określ punkt wstawienia bloku, wykonując jedną z poniższych czynności: 

• Określ na ekranie Zaznacz to pole wyboru, aby wybrać punkt bazowy na 

rysunku po kliknięciu przycisku OK. 

• Wybierz punkt bazowy Kliknij (  ), aby tymczasowo zamknąć okno 

dialogowe, wybrać punkt bazowy na rysunku, a następnie powrócić do okna 

dialogowego. Ta opcja jest dostępna tylko wtedy, gdy opcja Określ na ekranie 

nie jest zaznaczona. 

• X, Y i Z Wprowadź współrzędne x, y i z punktu bazowego. Ta opcja jest 

dostępna tylko wtedy, gdy opcja Specify on Screen nie jest zaznaczona. 

5 Wybierz jednostki, które mają zostać połączone w blok, wykonując jedną z poniższych 

czynności: 

• Określ na ekranie Zaznacz to pole wyboru, aby wybrać jednostki na rysunku 

po kliknięciu przycisku OK. 

• Wybierz encje Kliknij (  ), aby tymczasowo zamknąć okno dialogowe, 

wybrać encje na rysunku, a następnie powrócić do okna dialogowego. Możesz 

też kliknąć (  ), aby wybrać elementy według typu lub wartości. Ta opcja 

jest dostępna tylko wtedy, gdy opcja Określ na ekranie nie jest zaznaczona. 

6 Wybierz, co zrobić z podmiotami po utworzeniu bloku: 

• Zachowaj podmioty Podmioty wybrane dla bloku pozostają na rysunku. 

• Konwertuj na blok Podmioty wybrane dla bloku są konwertowane na 

blok, który pozostaje na rysunku. 

• Usuń podmioty Podmioty wybrane dla bloku są usuwane z rysunku. 
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7 Wybierz dowolną z poniższych opcji dla bloku: 

• Adnotacje Określa, czy blok jest domyślnie opatrzony adnotacjami. 

Skalowanie adnotacji ma wpływ na wyświetlanie i drukowanie bloków z 

adnotacjami. W przypadku domyślnego ustawienia adnotacji można określić, czy blok, gdy 

znajduje się w przestrzeni papieru, jest automatycznie orientowany zgodnie z 

rzutnią układu. 

• Skaluj równomiernie Zaznacz to pole wyboru, aby zachować proporcje, 

jeśli blok jest skalowany. Bloki adnotacji muszą być skalowane 

proporcjonalnie. 

• Zezwalaj na rozbicie Zaznacz to pole wyboru, aby umożliwić rozbicie 

bloku na osobne jednostki. 

• Jednostka Określa jednostkę bloku, na przykład cale lub milimetry. 

8 Kliknij przycisk OK. 

The program adds a new block to the blocks list, with the name you entered for it. 

 

 
 

A 

B 

 
C 

D 

 

E 

 
 
 

 
 
 

A Wprowadź nazwę bloku. 

F  GHI 

I Kliknij, aby wybrać jednostki według typu lub wartości. 

B Wprowadź opis bloku. 

C Wybierz, aby wybrać punkt bazowy na 
rysunku po kliknięciu OK. 

D Wybierz, aby wybrać punkt bazowy na 
rysunku. 

E Wyświetla współrzędne punktu bazowego 
lub można je wprowadzić ręcznie. 

F Wybierz, aby wybrać jednostki do 
uwzględnienia w bloku po kliknięciu 
przycisku OK. 

G Kliknij, aby wybrać jednostki znajdujące się 
teraz na rysunku. 

H Wybierz, czy po utworzeniu bloku 
jednostki mają zostać zachowane, 
przekonwertowane czy usunięte. 

J Wybierz jednostki blokowe. 

K Wybierz, aby umożliwić rozbicie bloku na 
jednostki. 

L Wybierz, aby zachować proporcje, jeśli 
blok jest skalowany. 

M Wybierz, aby blok, gdy znajduje się w 
przestrzeni papieru, był zorientowany zgodnie 
z rzutnią układu (dostępne tylko wtedy, gdy 
zaznaczono opcję Adnotacje). 

N Zaznacz, aby blok domyślnie zawierał adnotacje. 

N 

   

N 

M 

L 

K 

   
J 
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Aby zmienić nazwę bloku w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz blok, wybierz polecenie Edycja > Zmień nazwę, wpisz nową nazwę i naciśnij 

klawisz Enter. 

• Kliknij nazwę bloku, którą chcesz zmienić, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę bloku, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę 

i naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Wstawianie bloku 

Do rysunku można wstawić dowolny blok wymieniony na liście Nazwa bloku w 

Eksploratorze Intelli-CAD. Obejmuje to bloki zawarte w dowolnym otwartym 

rysunku. 
 

Aby wstawić blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 

2 Jeśli chcesz wstawić blok z innego otwartego rysunku, wybierz rysunek po lewej 

stronie okna Eksploratora ALCAD. (Jeśli blok znajduje się w tym samym 

rysunku, możesz pominąć ten krok). 

3 Wybierz blok, który ma zostać wstawiony. 

4 Na pasku narzędzi ALCAD Explorer kliknij narzędzie Wstaw (  ). 

5 Na rysunku określ punkt wstawienia. 

6 Określ współczynnik skali x, y i z oraz kąt obrotu lub w oknie zachęty 

wybierz Gotowe. 

7 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
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Użyj skrótu. 

Możesz wstawić blok, wybierając Narzędzia > Eksplorator ALCAD, a następnie 

klikając dwukrotnie nazwę bloku, który chcesz wstawić na liście Nazwa bloku. 

Możesz również wstawić blok z menu Wstaw, patrz Rozdział 13, "Praca z innymi 

plikami w rysunkach". 
 

 
Wstawianie rysunku jako bloku 

Możesz wstawić inny rysunek jako blok do bieżącego rysunku. Po wykonaniu tej 

czynności nazwa bloku zostanie dodana do listy Nazwa bloku w Eksploratorze ALCAD. 

Zmiany wprowadzone później do wstawionego rysunku nie zostaną 

odzwierciedlone w tym rysunku. 
 

Aby wstawić rysunek jako blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 

2 Na pasku narzędzi ALCAD Explorer kliknij narzędzie Wstaw zewnętrzny 

blok pliku (  ). 

3 W oknie dialogowym Wstaw blok wybierz rysunek, który chcesz wstawić, a 

następnie kliknij przycisk Otwórz. 

4 Na rysunku określ punkt wstawienia. 

5 Określ współczynnik skali x, y i z oraz kąt obrotu lub w oknie zachęty 

wybierz Gotowe. 

6 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Zapisywanie bloku jako osobnego rysunku 

Blok można zapisać jako osobny rysunek, a następnie otworzyć i zmodyfikować 

ten rysunek w taki sam sposób, jak każdy inny rysunek. 
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Aby zapisać blok jako osobny plik rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj bloki (  ): 

• Na wstążce wybierz Narzędzia > Bloki (w Eksploratorze). 

• W menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj bloki. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj bloki. 

• Wpisz expblocks i naciśnij Enter. 

2 Wybierz blok, który chcesz zapisać. 

3 Na pasku narzędzi ALCAD Explorer kliknij narzędzie Zapisz blok (  ). 

4 W oknie dialogowym Zapisz blok wybierz folder, w którym chcesz zapisać 

blok. 

5 W polu Nazwa pliku wpisz nazwę nowego pliku rysunku (lub zaakceptuj 

domyślną, w którym to przypadku nowa nazwa rysunku jest taka sama jak 

nazwa bloku), a następnie kliknij Zapisz. 

 

 
 

Praca z odwołaniami do plików zewnętrznych 
 

W ALCAD Explorer można pracować z dowolnym plikiem, do którego odwołanie 

znajduje się w otwartym rysunku. Oprócz powszechnie używanych plików xref lub 

plików rysunków z odniesieniami zewnętrznymi, można również zarządzać 

obrazami rastrowymi, plikami .dwf, .dgn, .pdf i chmurami punktów bezpośrednio z 

ALCAD Explorer. 

Gdy odwołujesz się do zewnętrznego pliku z rysunku, zawartość odwołanego pliku 

pojawia się w bieżącym rysunku, ale sama zawartość nie jest dodawana do rysunku. 

 

Wyświetlanie informacji o przywoływanych plikach w ALCAD Explorer 

Aby wyświetlić informacje o plikach, do których istnieją odwołania 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Explore External References (  

): 

• Na wstążce wybierz Narzędzia > Odwołania zewnętrzne (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj 

zewnętrzne odniesienia. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj odwołania zewnętrzne. 

• Wpisz exprefs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Kliknij narzędzie Ikony (  ), aby zobaczyć mały obraz każdego pliku, do którego się 

odwołujesz, 

• Kliknij narzędzie Szczegóły ( ), aby wyświetlić bardziej szczegółowe informacje o 

każdym bloku. 
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A J 

B 

 
 
 
 
 
 
 
 
 
 
 
 

 
 CDEFGHI 

 
A Kliknij, aby włączyć lub wyłączyć 

automatyczne ukrywanie palety. Dostępne, 
gdy eksplorator jest paletą 
niezadokowaną. 

B Kliknij, aby wybrać położenie i 
przezroczystość palety. Dostępne, gdy 
eksplorator jest paletą niezadokowaną. 

C Wyświetla nazwy plików, do których 
odwołuje się bieżący rysunek. 

D Wyświetla status ładowania pliku w 
bieżącym rysunku. 

 

Dołączanie plików z 
odwołaniami 

Aby dołączyć plik z odwołaniem 
zewnętrznym 

 
E Wyświetla liczbę odwołań do pliku z 

bieżącego rysunku. 

F Wyświetla rozmiar pliku. 

G Wyświetla typ pliku. 

H Wyświetla datę pliku. 

I Wyświetla lokalizację pliku. 

J Kliknij tytuł kolumny, aby sortować według kategorii. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Explore External References (  

): 

• Na wstążce wybierz Narzędzia > Odwołania zewnętrzne (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Odniesienia zewnętrzne. 

• Na pasku narzędzi Explorer kliknij narzędzie Explore External Reference. 

• Wpisz exprefs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > Odnośnik zewnętrzny. 

• Na pasku narzędzi ALCAD Explorer kliknij narzędzie Nowy element (  ). 

3 W polu Pliki typu wybierz typ pliku do załączenia, a następnie kliknij przycisk Otwórz. 

4 Określ punkt wstawienia pliku i wypełnij dodatkowe monity. 

5 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
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Modyfikowanie ustawień plików, do których istnieją odniesienia 

Każdy plik, do którego istnieje odniesienie, może być modyfikowany z poziomu 

Eksploratora ALCAD, w tym zmiana nazwy, łączenie z nową lokalizacją, 

przycinanie i inne. 
 

Aby zmienić nazwę odwołanego pliku w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Explore External References (  

): 

• Na wstążce wybierz Narzędzia > Odwołania zewnętrzne (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj 

zewnętrzne odniesienia. 

• Na pasku narzędzi Explorer kliknij narzędzie Explore External Reference. 

• Wpisz exprefs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz plik, wybierz Edytuj > Zmień nazwę, wpisz nową nazwę i naciśnij Enter. 

• Kliknij nazwę pliku, którą chcesz zmienić, wpisz nową nazwę, a następnie naciśnij 

klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę pliku, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Aby zmienić nazwę odwołanego pliku w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Explore External References (  

): 

• Na wstążce wybierz Narzędzia > Odwołania zewnętrzne (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj 

zewnętrzne odniesienia. 

• Na pasku narzędzi Explorer kliknij narzędzie Explore External Reference. 

• Wpisz exprefs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz plik, wybierz Edytuj > Zmień nazwę, wpisz nową nazwę i naciśnij Enter. 

• Kliknij nazwę pliku, którą chcesz zmienić, wpisz nową nazwę, a następnie naciśnij 

klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę pliku, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
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Aby zarządzać plikiem z odwołaniem zewnętrznym 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Explore External References (  

): 

• Na wstążce wybierz Narzędzia > Odwołania zewnętrzne (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj 

zewnętrzne odniesienia. 

• Na pasku narzędzi Explorer kliknij narzędzie Explore External Reference. 

• Wpisz exprefs i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz plik na liście, wybierz Edytuj, a następnie żądaną opcję. 

• Kliknij prawym przyciskiem myszy żądany plik i z menu skrótów 

wybierz żądaną opcję. 

• Kliknij narzędzie Image Manager (  ) lub narzędzie Xref Manager (  ). 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 
 

Więcej informacji na temat pracy z odnośnikami zewnętrznymi można znaleźć w 

sekcji "Praca z odnośnikami zewnętrznymi" na stronie 488. 

 

 
 

Praca ze stylami wymiarów 
 

Z poziomu Eksploratora ALCAD można użyć elementu Style wymiarów do 

wycinania, kopiowania i wklejania stylów wymiarów z jednego rysunku do 

drugiego. 

Styl wymiaru zawiera ustawienia kontrolujące wygląd wymiaru. Chociaż nie można 

kontrolować tych ustawień z poziomu Eksploratora ALCAD, można użyć okna 

dialogowego Style wymiaru, aby kontrolować ustawienia związane z wyglądem 

strzałek, linii, tekstu, jednostek i innych cech formatowania. 

 

Wyświetlanie informacji o stylu wymiaru w Eksploratorze ALCAD 

Aby wyświetlić element Style wymiarów Eksploratora ALCAD 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style wymiarów (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style wymiarów (w Eksploratorze). 

• Z menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj style wymiarów. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Style wymiarów. 

• Wpisz setdim i naciśnij Enter. 
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A D 

B 

 
 
 
 
 
 
 
 
 

 
 BC 

 
A Kliknij, aby włączyć lub wyłączyć automatyczne 

ukrywanie palety. Dostępne, gdy eksplorator jest 
paletą niezadokowaną. 

B Kliknij, aby wybrać położenie i przezroczystość 
palety. Dostępne, gdy eksplorator jest paletą 
zablokowaną. 

 
C Wyświetla nazwy stylów wymiarów 

zdefiniowanych w bieżącym rysunku. 

D Kliknij, aby edytować odpowiedni styl wymiaru. 

E Kliknij tytuł kolumny, aby sortować według kategorii. 

 
 

Tworzenie i nazywanie stylów wymiarów 

Korzystając z elementu Style wymiarów w połączeniu z oknem dialogowym Style 

wymiarów, można tworzyć nowe style wymiarów, modyfikować je i kopiować do 

innego rysunku. 
 

Aby utworzyć styl wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style wymiarów (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style wymiarów (w Eksploratorze). 

• Z menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj style wymiarów. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style wymiarów. 

• Wpisz expdimstyles i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wymiarów kliknij przycisk Nowy. 

3 Wpisz nazwę nowego stylu wymiaru. 

4 Kliknij ikonę Edytuj dla nowego stylu wymiaru. 

5 W oknie dialogowym Modyfikuj style wymiarów wybierz żądane opcje. 

6 Kliknij przycisk OK. 
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Aby zmienić nazwę stylu wymiaru w bieżącym rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style wymiarów (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style wymiarów (w Eksploratorze). 

• Z menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj style wymiarów. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style wymiarów. 

• Wpisz expdimstyles i naciśnij Enter. 

2 Wykonaj jedną z poniższych czynności: 

• Zaznacz styl wymiaru, wybierz polecenie Edycja > Zmień nazwę, wpisz 

nową nazwę i naciśnij klawisz Enter. 

• Kliknij nazwę stylu wymiaru, którą chcesz zmienić, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę stylu wymiaru, którą chcesz 

zmienić, i z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę, a 

następnie naciśnij klawisz Enter. 

3 Aby zakończyć polecenie i powrócić do rysunku, zamknij okno. 

 
Kopiowanie stylów wymiarów 

Style wymiarów można kopiować i wklejać między rysunkami. Oprócz poniższych 

kroków można również wybrać styl wymiaru i użyć klawiszy skrótu systemu 

Windows (Ctrl+A, aby zaznaczyć wszystkie, Ctrl+X, aby wyciąć, Ctrl+C, aby 

skopiować, Ctrl+V, aby wkleić), aby skopiować go w Eksploratorze ALCAD. Tych 

skrótów klawiszowych można również używać ze wszystkimi innymi elementami 

Eksploratora ALCAD. 
 

Aby skopiować styl wymiaru z jednego rysunku do drugiego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj style wymiarów (  ): 

• Na wstążce wybierz polecenie Narzędzia > Style wymiarów (w Eksploratorze). 

• Z menu wybierz Narzędzia > Eksplorator ALCAD > Eksploruj style wymiarów. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj style wymiarów. 

• Wpisz expdimstyles i naciśnij Enter. 

2 Kliknij prawym przyciskiem myszy nazwę stylu wymiaru, który chcesz skopiować. 

3 Z menu skrótów wybierz Kopiuj. 

4 W lewym panelu wybierz rysunek, do którego chcesz skopiować styl wymiaru. 

5 Kliknij element Style wymiarów dla tego rysunku. 

6 W prawym panelu kliknij prawym przyciskiem myszy, a następnie z menu skrótów wybierz 

Wklej. 
 

Każdy rysunek zawiera styl wymiaru o nazwie Standard. 

Nie można usunąć tego stylu wymiaru, ale można zmienić jego nazwę z poziomu 

Eksploratora Intelli-CAD lub zmodyfikować jego właściwości w oknie dialogowym 

Style wymiarów. 
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Praca z grupami 
 

W ALCAD Explorer można zarządzać grupami - zbiorami jednostek zapisanych 

razem jako jedna jednostka - które istnieją w otwartym rysunku, tworzyć nowe grupy, 

zarządzać jednostkami zawartymi w grupie i zmieniać ustawienia grup. 

 

Wyświetlanie informacji o grupach w ALCAD Explorer 

Aby wyświetlić grupy w ALCAD Explorer 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj grupy (  ): 

• Na wstążce wybierz Narzędzia > Grupy (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj grupy. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj grupy. 

• Wpisz expgroups i naciśnij Enter. 

 

Tworzenie nowej grupy za pomocą ALCAD Explorer 

Aby utworzyć nową grupę za pomocą ALCAD Explorer 

1 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Nowy > Grupa. 

• Na pasku narzędzi ALCAD Explorer kliknij narzędzie Nowy 

element (  ). Nowa grupa zostanie dodana jako Anonimowa. 

2 Wpisz nazwę nowej grupy, wpisując ją nad podświetlonym tekstem 

domyślnym, a następnie naciśnij klawisz Enter. 

3 Kliknij narzędzie [+], aby wybrać jednostki, które mają zostać dołączone do 

grupy; kliknij narzędzie [-], aby wybrać jednostki, które mają zostać usunięte z 

grupy. 

Możesz także kliknąć kolumnę Liczba podmiotów i wybrać opcję Dodaj 

podmioty lub Usuń podmioty. 

4 Naciśnij Enter po zakończeniu wybierania podmiotów. 

5 Aby zakończyć polecenie, zamknij okno. 
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Modyfikowanie grup 

Aby zmodyfikować grupę za pomocą ALCAD Explorer 

1 W Eksploratorze wybierz opcję Grupy. 

2 Aby zmienić nazwę grupy, wykonaj jedną z poniższych czynności: 

• Zaznacz grupę, wybierz Edytuj > Zmień nazwę, wpisz nową nazwę i naciśnij Enter. 

• Kliknij nazwę grupy, którą chcesz zmienić, wpisz nową nazwę, a następnie 

naciśnij klawisz Enter. 

• Kliknij prawym przyciskiem myszy nazwę grupy, którą chcesz zmienić, a 

następnie z menu skrótów wybierz opcję Zmień nazwę, wpisz nową nazwę, 

a następnie naciśnij klawisz Enter. 

3 Aby dodać jednostki do grupy, wybierz grupę i kliknij narzędzie [+], wybierz 

jednostki na rysunku, które mają zostać uwzględnione w grupie, a następnie 

naciśnij klawisz Enter po zakończeniu wybierania jednostek. 

4 Aby usunąć jednostki z grupy, wybierz grupę i kliknij narzędzie [-], wybierz 

jednostki na rysunku, które mają zostać usunięte z grupy, a następnie naciśnij 

klawisz Enter po zakończeniu wybierania jednostek. 

5 Aby zaznaczyć lub odznaczyć grupę na rysunku, kliknij dla niej opcję Zaznaczenie. 

6 Aby zmienić kolejność jednostek w grupie, wybierz grupę i kliknij narzędzie 

Zmień kolejność, dokonaj wyboru, a następnie kliknij przycisk OK. 

7 Aby wybrać grupę na rysunku i wyróżnić ją na liście grup, kliknij narzędzie 

Wyróżnij, wybierz żądaną grupę, a następnie naciśnij klawisz Enter. 

Odpowiednia grupa zostanie podświetlona na liście. 

8 Aby zakończyć polecenie, zamknij okno. 
 

Więcej informacji na temat pracy z grupami można znaleźć w sekcji "Grupowanie podmiotów" 

na stronie 379. 
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Praca z materiałami 
 

Materiały to obrazy lub tekstury, które poprawiają wizualny wygląd elementów 

podczas ich renderowania. Z poziomu Eksploratora ALCAD można użyć elementu 

Materiały, aby załadować materiały z biblioteki materiałów do rysunku, dzięki czemu 

rysunek zawiera tylko te materiały, których potrzebujesz, co pomaga zmniejszyć 

rozmiar pliku rysunku. Można również wycinać, kopiować i wklejać materiały z 

jednego rysunku do drugiego. 

Po zaimportowaniu materiałów do rysunku w Eksploratorze ALCAD można 

następnie przypisać je do elementów i warstw, dołączyć je do pakietów 

utworzonych za pomocą polecenia eTrans- mit i renderować je za pomocą stylów 

wizualnych bezpośrednio w ALCAD. 

Wyświetl materiały na rysunku przy użyciu stylu wizualnego Realistyczny. Więcej 

informacji na temat pracy ze stylami wizualnymi można znaleźć w sekcji 

"Używanie dynamicznych stylów wizualnych do ukrywania, cieniowania i 

renderowania" na stronie 640. 

 

Wyświetlanie informacji o materiałach w ALCAD Explorer 

Aby wyświetlić materiały w ALCAD Explorer 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj materiały (  ): 

• Na wstążce wybierz Narzędzia > Materiały (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj materiały. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj materiały. 

• Wpisz expmaterials i naciśnij Enter. 

 

A 

B 

C 

D 

 
 
 
 
 
 
 
 

 EF 
 

A Wybierz wyświetlanie materiałów w widoku listy 
lub obrazu. 

B Kliknij, aby dodać materiały do rysunku z 
biblioteki, dzięki czemu materiały mogą zostać 
przypisane do jednostek i warstw. 

C Wybierz podgląd wybranego materiału po 
prawej stronie jako sześcianu, kuli lub 
płaszczyzny. 

 
D Kliknij dwukrotnie materiał, aby ustawić go 

jako bieżący materiał. 

E Wyświetla nazwy materiałów dostępnych w bieżącym 
rysunku. 

F Wyświetla wybrany materiał na kształcie. 
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Importowanie materiałów do rysunku 

Materiały są przechowywane w bibliotece z rozszerzeniem .icmat. Aby zmniejszyć 

rozmiar plików rysunków, można importować z biblioteki tylko te materiały, które są 

potrzebne w rysunku. 

Zaimportowane materiały są przechowywane na rysunku, a następnie można z nimi 

pracować w całym programie ALCAD, w tym przypisywać je do jednostek i 

warstw, dołączać je do pakietów utworzonych za pomocą polecenia eTransmit, 

usuwać je i wyświetlać na jednostkach przy użyciu dowolnego stylu wizualnego 

innego niż 2D Wireframe. 
 

Aby zaimportować materiały do rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj materiały (  ): 

• Na wstążce wybierz Narzędzia > Materiały (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj materiały. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj materiały. 

• Wpisz expmaterials i naciśnij Enter. 

2 Na pasku narzędzi ALCAD Explorer kliknij narzędzie Importuj materiały (  ). 
 

Użyj skrótu. 

Na pasku poleceń wpisz materialimport, aby otworzyć okno dialogowe Importuj materiały. 
 

3 Kliknij prawym przyciskiem myszy dowolną listę i z menu skrótów wybierz 

sposób wyświetlania materiałów podczas ich wybierania. 

4 Po lewej stronie wybierz kategorię materiałów, które chcesz wyświetlić. 

5 Po prawej stronie wybierz materiały, które chcesz dodać do rysunku. Naciśnij 

Shift + kliknij, aby zaznaczyć wiele materiałów. 

6 Kliknij przycisk Importuj. 

Wybrane materiały zostaną dodane do rysunku i pojawią się w Eksploratorze 

materiałów. 

7 Po zakończeniu importowania kliknij przycisk Zamknij. 

 
Przypisywanie materiałów do jednostek i warstw 

Podczas tworzenia nowych obiektów są one rysowane przy użyciu bieżącego 

materiału. Aby narysować nowe obiekty przy użyciu innego materiału, należy najpierw 

ustawić ten materiał jako bieżący materiał. 

Można także oddzielnie przypisywać materiały do określonych jednostek i warstw. 
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Aby wytworzyć prąd materiałowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj materiały (  ): 

• Na wstążce wybierz Narzędzia > Materiały (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj materiały. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj materiały. 

• Wpisz expmaterials i naciśnij Enter. 

2 Wybierz materiał, który chcesz włączyć. 

3 Wykonaj jedną z poniższych czynności: 

• Wybierz Edytuj > Bieżące (jeśli opcja Pokaż jako palety nie jest włączona). 

• Kliknij Bieżące narzędzie ( ). 

• Kliknij dwukrotnie nazwę materiału. 

• Kliknij prawym przyciskiem myszy nazwę materiału i z menu skrótów wybierz opcję 

Bieżący. 

Aby przypisać materiał do jednostki 

1 Wykonaj jedną z poniższych czynności: 

• Przeciągnij i upuść materiał z palety Eksploratora materiałów na jednostkę. 

• Wybierz jednostkę i w panelu Właściwości wybierz odpowiedni materiał. 

• Wybierz jednostkę, wpisz change i postępuj zgodnie z instrukcjami, aby 

zmodyfikować właściwość materiału. 
 

Aby przypisać materiał do warstwy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj warstwy (  ): 

• Na wstążce wybierz Strona główna > Warstwy lub Narzędzia > Warstwy (w 

Eksploratorze). 

• W menu wybierz Format > Eksploruj warstwy lub wybierz Narzędzia > 

ALCAD Explorer > Eksploruj warstwy. 

• Na pasku narzędzi Eksploratora kliknij narzędzie Eksploruj warstwy. 

• Wpisz explayers i naciśnij Enter. 

2 Kliknij w kolumnie Materiał dla wybranej warstwy. 

3 Wybierz materiał z listy. 

 
Kopiowanie materiałów 

Materiały można kopiować i wklejać między rysunkami. Oprócz poniższych 

kroków można również wybrać materiał i użyć klawiszy skrótu systemu Windows (Ctrl+A, 

aby zaznaczyć wszystkie, Ctrl+X, aby wyciąć, Ctrl+C, aby skopiować, Ctrl+V, aby 

wkleić), aby skopiować go w Eksploratorze ALCAD. Tych skrótów klawiszowych 

można również używać ze wszystkimi innymi elementami Eksploratora ALCAD. 
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Aby skopiować materiał z jednego rysunku do drugiego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploruj materiały (  ): 

• Na wstążce wybierz Narzędzia > Materiały (w Eksploratorze). 

• W menu wybierz Narzędzia > ALCAD Explorer > Eksploruj materiały. 

• Na pasku narzędzi Format kliknij narzędzie Eksploruj materiały. 

• Wpisz expmaterials i naciśnij Enter. 

2 Kliknij prawym przyciskiem myszy materiał, który chcesz skopiować. 

3 Z menu skrótów wybierz Kopiuj. 

4 W razie potrzeby kliknij opcję Pokaż jako palety (  ), aby wyświetlić 

Eksplorator materiałów jako okno dialogowe zamiast palety. (Palety mogą 

wyświetlać tylko informacje o bieżącym rysunku). 

5 W lewym panelu wybierz rysunek, do którego chcesz skopiować materiał. 

6 Kliknij element Materiały dla tego rysunku. 

7 W prawym panelu kliknij prawym przyciskiem myszy, a następnie z menu skrótów wybierz 

Wklej. 
 

Każdy rysunek zawiera materiał o nazwie Global. 

Nie można usunąć ani zmienić nazwy tego materiału. 
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ALCAD przechowuje dokładne, szczegółowe informacje o wszystkich elementach 

rysunku. Możesz uzyskać szczegółowe informacje o istniejącym rysunku i jego elementach 

za pomocą narzędzi do pomiaru odległości i obliczania powierzchni. Można również 

śledzić czas spędzony na edycji rysunku. W tej sekcji wyjaśniono, jak: 

• Mierzy odległości wzdłuż jednostki. 

• Pomiar odległości i kątów. 

• Podzielenie jednostki na pewną liczbę równych segmentów. 

• Obliczanie powierzchni. 

• Wyświetla informacje o jednostkach na rysunku. 

• Śledzenie czasu spędzonego na edycji rysunku. 

Wiele funkcji opisanych w tej sekcji wymaga ustawienia programu ALCAD na 

poziom zaawansowany. 
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Określanie wymiarów i podziałów 
 

Możesz podzielić linię, łuk, okrąg, polilinię, elipsę lub splajn na kilka równych 

segmentów lub zaznaczyć odstępy o określonej długości wzdłuż jednostki. (Należy 

pamiętać, że dzielenie to nie to samo, co przerywanie). Na przykład można umieścić 

znaczniki punktów stacji co 50 stóp wzdłuż linii środkowej drogi lub podzielić 

widok okna na trzy sekcje o równej szerokości, umieszczając słupek w każdym 

punkcie podziału. 

 

Zrozumienie pomiarów i podziałów 

Aby określić wymiary i podziały, należy użyć tych poleceń: 

• Aby uzyskać długość segmentów, użyj polecenia Measure. 

• Aby uzyskać liczbę segmentów o równej długości, użyj polecenia Divide. 

Można mierzyć lub dzielić łuki, okręgi, linie, polilinie, elipsy i splajny. Za pomocą 

każdego z tych poleceń można zidentyfikować segmenty, umieszczając na końcu 

każdego przedziału element blokowy lub punktowy. W przypadku korzystania z 

punktów można przyciągać się do końców interwałów za pomocą przyciągania 

jednostek punktów. Wygląd jednostek punktowych zależy od bieżącego typu 

wyświetlania punktów, który można kontrolować w oknie dialogowym Ustawienia 

rysowania. 

Aby użyć bloku jako znacznika, blok musi być już zdefiniowany w bieżącym 

rysunku. Ponadto można wskazać, czy blok ma zostać obrócony w celu 

wyrównania prostopadle do mierzonej lub dzielonej jednostki. 

 
 

Blok nie jest wyrównany z jednostką.  Blok jest wyrównany z jednostką. 

ALCAD rozpoczyna pomiar lub dzielenie w oparciu o punkt, w którym wybrano 

jednostkę i typ jednostki, z którą pracujesz. W przypadku większości jednostek 

pomiar rozpoczyna się od punktu końcowego najbliższego punktowi użytemu do 

wybrania jednostki. W przypadku wybrania jednostki, która ma zostać zmierzona 

lub podzielona przy użyciu metody innej niż wskazywanie (na przykład przy użyciu 

wyboru okna lub ogrodzenia), program wyświetli monit o określenie końca, od 

którego chcesz rozpocząć pomiar. 
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Interwały pomiarowe na jednostkach 

Określone przyrosty długości można zaznaczać wzdłuż wybranej jednostki za 

pomocą jednostki punktowej lub bloku. 
 

Aby mierzyć odstępy wzdłuż encji i oznaczać je za pomocą encji punktowych 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Measure (  ): 

• Na wstążce wybierz kolejno Edytuj > Zmierz (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Pomiar. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zmierz. 

• Wpisz measure, a następnie naciśnij Enter. 

2 Wybierz podmiot. 

3 Określ długość segmentu, a następnie naciśnij Enter. 

 
 

Po wybraniu elementu przez wskazanie odstępy są mierzone od końca 
najbliższego punktowi, w którym wybrano element (A). Bloki lub elementy 
punktowe (B) są umieszczane wzdłuż elementu w określonych odstępach. 

Aby zmierzyć odstępy wzdłuż jednostki i oznaczyć je za pomocą bloków 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Measure (  ): 

• Na wstążce wybierz kolejno Edytuj > Zmierz (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Pomiar. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zmierz. 

• Wpisz measure, a następnie naciśnij Enter. 

2 Wybierz podmiot. 

3 W oknie dialogowym wybierz opcję Wstaw bloki. 

4 Wpisz nazwę bloku, który chcesz wstawić jako znacznik. 

5 W oknie dialogowym wybierz opcję Yes-Align Blocks, aby obrócić każdy 

wstawiony blok tak, aby jego pionowe wyrównanie było zawsze prostopadłe do 

jednostki, lub opcję No-Do Not Align, aby wstawić każdą kopię bloku z 

zerowym kątem obrotu. 

6 Określ długość segmentu, a następnie naciśnij Enter. 
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Podział jednostek na segmenty 

Znaczniki można umieszczać wzdłuż wybranej jednostki, dzieląc ją na określoną 

liczbę segmentów o równej długości. Do oznaczenia segmentów można użyć 

elementu punktowego lub bloku. 
 

Aby podzielić encję na segmenty i oznaczyć je za pomocą encji punktowych 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Podziel (  ): 

• Na wstążce wybierz kolejno Edytuj > Zmierz (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Podziel. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Podziel. 

• Wpisz divide, a następnie naciśnij Enter. 

2 Wybierz podmiot. 

3 Określ liczbę segmentów, a następnie naciśnij Enter. 

 
 

Po wybraniu jednostki przez wskazanie, podziały są zaznaczane począwszy od końca 
najbliższego punktowi, w którym wybrano jednostkę (A). Bloki lub jednostki punktowe (B) są 
umieszczane wzdłuż jednostki w celu oznaczenia jej w równych odstępach. 

Aby podzielić jednostkę na segmenty i oznaczyć je za pomocą bloków 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Measure (  ): 

• Na wstążce wybierz kolejno Edytuj > Zmierz (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Podziel. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Podziel. 

• Wpisz divide, a następnie naciśnij Enter. 

2 Wybierz podmiot. 

3 W oknie dialogowym wybierz opcję Wstaw bloki. 

4 Wpisz nazwę bloku, który chcesz wstawić jako znacznik. 

5 W oknie dialogowym wybierz opcję Tak - Wyrównaj bloki, aby obrócić każde 

wstawienie bloku tak, aby jego pionowe wyrównanie było zawsze prostopadłe 

do jednostki lub 

No-Do Not Align, aby wstawić każdą kopię bloku z zerowym kątem obrotu. 

6 Określ liczbę segmentów, a następnie naciśnij Enter. 



 

Obliczanie 
powierzchni 
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Można obliczyć pole powierzchni i obwód wielokąta na podstawie serii punktów 

określonych lub otoczonych okręgiem lub zamkniętą polilinią. Można również 

określić obszar kilku połączonych jednostek i dodać lub odjąć obszar jednej lub 

więcej jednostek od całkowitego połączonego obszaru. 

 

Obliczanie obszarów zdefiniowanych przez punkty 

Można znaleźć pole powierzchni i obwód dowolnego zamkniętego obszaru, 

określając serię punktów. Program oblicza pole i obwód przestrzeni zamkniętej 

wyimaginowanym wielokątem składającym się z odcinków prostych łączących 

każdy punkt. 
 

Aby obliczyć obszar zdefiniowany przez określone punkty 

1 Wykonaj jedną z poniższych czynności, aby wybrać obszar (  ): 

• Na wstążce wybierz polecenie Narzędzia > Obszar (w zapytaniu). 

• W menu wybierz kolejno Narzędzia > Zapytanie > Obszar. 

• Na pasku narzędzi Zapytania kliknij narzędzie Obszar. 

• Wpisz obszar i naciśnij Enter. 

2 Określ pierwszy punkt. 

3 Określ drugi punkt. 

4 Kontynuuj określanie punktów w kolejności, aby zdefiniować obwód 

obszaru, który chcesz zmierzyć. 

Po wybraniu każdego kolejnego punktu na ekranie wyświetlany jest wynikowy 

wielokąt. 

5 Aby zakończyć obliczenia, naciśnij Enter. 

Wyświetlany jest obszar i obwód zdefiniowanego regionu. Na przykład 

wyświetlane są następujące informacje: 

Powierzchnia = 11,0583, Obwód = 15,3092 

 
 

Wybierz punkty (A, B, C), które tworzą wielokąt. Następnie 
obliczane są pole powierzchni i obwód regionu. 
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Obliczanie powierzchni zamkniętych jednostek 

Można znaleźć obszar dowolnej zamkniętej bryły. Ponadto program oblicza obwód lub obwód 

bryły, w zależności od wybranego typu bryły. 
 

Aby obliczyć obszar zamkniętej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać obszar (  ): 

• Na wstążce wybierz polecenie Narzędzia > Obszar (w zapytaniu). 

• W menu wybierz kolejno Narzędzia > Zapytanie > Obszar. 

• Na pasku narzędzi Zapytania kliknij narzędzie Obszar. 

• Wpisz obszar i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Znajdź obszar jednego podmiotu. 

3 Wybierz podmiot. 

Wyświetlane są następujące informacje: 
 

Powierzchnia = 62,3837, Obwód = 27,9989 

 

Obliczanie połączonych obszarów 

Można znaleźć łączną powierzchnię kilku połączonych regionów, określając 

punkty lub wybierając jednostki. Można również odjąć obszary jednostek lub wielokątów 

od bieżącej sumy. 
 

Aby dodać obszary w celu obliczenia połączonego obszaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać obszar (  ): 

• Na wstążce wybierz polecenie Narzędzia > Obszar (w zapytaniu). 

• W menu wybierz kolejno Narzędzia > Zapytanie > Obszar. 

• Na pasku narzędzi Zapytania kliknij narzędzie Obszar. 

• Wpisz obszar i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Dodaj obszary razem. 

3 Korzystając z jednej z poniższych metod, zidentyfikuj pierwszy obszar: 

• Określ punkty definiujące wielokąt, a następnie w oknie zachęty wybierz 

opcję Gotowe określanie obszaru. 

• W oknie zachęty wybierz opcję Dodaj jednostki do obszaru, wybierz 

jednostki, które chcesz dodać, a następnie naciśnij klawisz Enter, aby zakończyć 

obliczenia. 

4 Aby zakończyć polecenie, wybierz Gotowe w oknie zachęty. 
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Aby odjąć obszary podczas obliczania połączonego obszaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać obszar (  ): 

• Na wstążce wybierz polecenie Narzędzia > Obszar (w zapytaniu). 

• W menu wybierz kolejno Narzędzia > Zapytanie > Obszar. 

• Na pasku narzędzi Zapytania kliknij narzędzie Obszar. 

• Wpisz obszar i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Dodaj obszary razem. 

3 Korzystając z jednej z poniższych metod, zidentyfikuj pierwszy obszar: 

• Określ punkty definiujące wielokąt, a następnie w oknie zachęty wybierz 

opcję Gotowe określanie obszaru. 

• W oknie zachęty wybierz opcję Dodaj jednostki do obszaru, wybierz 

jednostki, które chcesz dodać, a następnie naciśnij klawisz Enter, aby zakończyć 

obliczenia. 

4 W oknie dialogowym wybierz opcję Odejmij obszary. 

5 Korzystając z jednej z poniższych metod, określ obszar, który ma zostać odjęty: 

• Określ punkty definiujące wielokąt, a następnie w oknie zachęty wybierz 

opcję Gotowe określanie obszaru. 

• W oknie dialogowym wybierz Odejmij jednostki od obszaru, wybierz 

jednostki, które chcesz odjąć, a następnie naciśnij klawisz Enter, aby 

zakończyć obliczenia. 

6 Aby zakończyć polecenie, wybierz Gotowe w oknie zachęty. 

 
 

Aby obliczyć obszar uszczelki za pomocą polecenia Obszar, najpierw 
dodaj obszar całej uszczelki (A), a następnie odejmij obszary 
dwóch okręgów (B i C). 
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Wyświetlanie szczegółów obliczonego obszaru 

Po wybraniu jednostek program wyświetla obliczenia. Jeśli wyświetlany jest pasek 

poleceń, wyświetlane są tam informacje. Jeśli pasek poleceń nie jest wyświetlany, 

program otwiera okno Prompt History i wyświetla obliczenia. Poniższy typ 

informacji jest przykładem tego, co jest wyświetlane: 

Podmiot - Dodaj - Odejmij - <Pierwszy punkt>: Wybierz Dodaj obszary 

razem: Podmiot - Odejmij - <Pierwszy punkt>: Wybierz Dodaj encje do 

obszaru Dodawanie obszaru: <Wybierz encje>: Wybierz pierwszy podmiot 

Pole powierzchni = 64,6259, obwód = 

33,3049 Długość całkowita = 33,3049 

Całkowity obszar = 64,6259 

Obszar dodawania: <Wybierz podmioty>: naciśnij Enter 

Dodawanie: Podmiot - Odejmij - <Pierwszy punkt>: Wybierz Odejmij obszary 

Odejmowanie: Podmiot - Dodaj - <Pierwszy punkt>: Wybierz Odejmij 

podmioty od obszaru 

Obszar odejmowania: <Wybierz jednostki>: Wybierz pierwszą jednostkę do odjęcia 

Powierzchnia = 3,1597, Obwód = 6,3012 

Całkowita długość = 27,0036 

Całkowity obszar = 61,4662 

Obszar odejmowania: <Wybierz jednostki>: Wybierz drugą jednostkę do odjęcia 

Powierzchnia = 3,1597, Obwód = 6,3012 

Całkowita długość = 20,7024 

Całkowity obszar = 58,3066 

Obszar odejmowania: <Wybierz podmioty>: Naciśnij Enter 

Odejmowanie: Podmiot - Dodaj - <Pierwszy punkt>: Wybierz Gotowe 

 

 

 

Obliczanie odległości i kątów 
 

Możesz obliczyć odległość między dowolnymi dwoma wybranymi punktami, aby 

określić następujące informacje: 

• Odległość między punktami, mierzona w jednostkach rysunkowych. 

• Ich kąt w płaszczyźnie xy. 

• Ich kąt mierzony od płaszczyzny xy. 

Zmiana (delta) odległości x, y i z między dwoma punktami. 
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Obliczanie odległości między dwoma punktami i ich kąta Podczas 

obliczania odległości między punktami często pomocne jest użycie przyciągania encji 

w celu precyzyjnego określenia punktów. 

Aby obliczyć odległość między dwoma punktami i ich kąt 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Odległość ( ): 

• Na wstążce wybierz kolejno Narzędzia > Odległość (w zapytaniu). 

• W menu wybierz Narzędzia > Zapytanie > Odległość. 

• Na pasku narzędzi Zapytania kliknij narzędzie Odległość. 

• Wpisz distance i naciśnij Enter. 

2 Określ pierwszy punkt. 

3 Określ drugi punkt. 

 
 

Użyj polecenia Distance, aby obliczyć odległość (A) między dwoma 
punktami (B i C), kąt w płaszczyźnie xy (D), kąt od płaszczyzny xy oraz 
odległości delta x (E), delta y (F) i delta z między dwoma punktami. 

 

Wyświetlanie szczegółów obliczonej odległości 

Po wybraniu jednostek program wyświetla obliczenia. Jeśli wyświetlany jest pasek 

poleceń, wyświetlane są tam informacje. Jeśli pasek poleceń nie jest wyświetlany, 

program otwiera okno Prompt History i wyświetla obliczenia. Poniższy typ 

informacji jest przykładem tego, co jest wyświetlane: 

Odległość = 13,2850, Kąt w płaszczyźnie XY = 31º, Kąt od płaszczyzny XY = 

0º Delta X = 11,3878, Delta Y = 6,8418, Delta Z = 0,0000 
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Wyświetlanie informacji o rysunku 
 

Można wyświetlać różne informacje o rysunku i zawartych w nim jednostkach, w 

tym: 

• Informacje w bazie danych rysunków o wybranych podmiotach. 

• Bieżący status rysunku. 

• Czas spędzony na pracy nad rysunkiem. 

Informacje te są wyświetlane w oknie Historia zapytań i na pasku poleceń. 

 

Wyświetlanie informacji o podmiotach 

Można wyświetlić informacje o wybranych podmiotach. Informacje różnią się w 

zależności od typu wybranych podmiotów. Wszystkie listy wyświetlają następujące 

informacje: 

• Typ podmiotu. 

• Warstwa. 

• Kolor. 

• Typ linii. 

• Lokalizacja podmiotu (jego współrzędne xyz względem bieżącego 

układu współrzędnych użytkownika [UCS]). 

• Bieżąca przestrzeń (przestrzeń modelu na karcie Model lub przestrzeń papieru na karcie 

Układ). 

• Rozmiar podmiotu (informacje różnią się w zależności od typu podmiotu). 

Aby wyświetlić informacje o podmiocie 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać List Entity Info (  ): 

• Na wstążce wybierz Narzędzia > Lista informacji o podmiocie (w zapytaniu). 

• W menu wybierz Narzędzia > Zapytanie > Lista informacji o podmiocie. 

• Na pasku narzędzi Inquiry kliknij narzędzie List Entity Info. 

• Wpisz list i naciśnij Enter. 

2 Wybierz jeden lub więcej podmiotów. 

3 Naciśnij Enter. 

 

Użyj skrótu. 

Aby powrócić do okna rysowania, naciśnij klawisz F2. 
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Wyświetlane są następujące informacje: 

    Koło  

Uchwyt: 2C 

Bieżąca przestrzeń: 

Warstwa modelu: 0 

Kolor: BYLAYER Typ 

linii: CONTINUOUS 

Uchwyt: 4C 

Obecna przestrzeń: Model 

Punkt środkowy: X= -5.8583 Y= 7.2752 Z= 0.0000 

Promień: 4.4562 

Obwód: 27,9989 Obszar: 

62.383y 

 

Wyświetlanie informacji o właściwościach zewnętrznych 
odniesień i bloków 

Można wyświetlić informacje o właściwościach wybranego zewnętrznego 

odnośnika lub bloku. Wszystkie listy wyświetlają następujące informacje: 

• Typ podmiotu 

• Nazwa 

• Kolor 

• Warstwa 

• Typ linii i skala typu linii 

• Styl drukowania 

• Waga liniowa 

• Materiał 

• Przejrzystość 

• Grubość 

Aby wyświetlić informacje o właściwościach zewnętrznego odwołania lub bloku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję List Xref/Block Properties (  ): 

• Na wstążce wybierz kolejno Express Tools > List Xref/Block Properties (in Blocks). 

• W menu wybierz Express Tools > Blocks > List Xref/Block Properties. 

• Wpisz xlist i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie lub blok. 
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Wyświetlanie stanu rysunku 

Można wyświetlić informacje o bieżącym stanie rysunku, w tym: 

• Nazwa rysunku. 

• Limity. 

• Punkt bazowy wstawienia. 

• Ustawienia przyciągania i siatki. 

• Bieżąca warstwa, kolor i typ linii. 

• Bieżące ustawienia dla różnych trybów (wypełnienia, siatki, ortogonalny, przyciągania, 

blipów itd.). 

Aby wyświetlić stan rysunku 

Zaawansowany poziom doświadczenia 

Wykonaj jedną z poniższych czynności, aby wybrać Status rysowania (  ): 

• Na wstążce wybierz Przycisk aplikacji > Narzędzia do rysowania > Stan 

rysowania lub wybierz Narzędzia > Stan rysowania (w Zapytaniu). 

• W menu wybierz Narzędzia > Zapytanie > Status rysunku. 

• Na pasku narzędzi Zapytania kliknij narzędzie Status rysunku. 

• Wpisz status i naciśnij Enter. 
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Wyświetlane są następujące informacje: 

Aktualna nazwa rysunku: Plan terenu 

Limity rysowania są następujące: X=0.0000 Y=0.0000 

Z=0.0000 X=12.0000 Y=9.0000 Z=0.0000 

Limity miejsca na papier są następujące: X=0.0000 Y=0.0000 

Z=0.0000 X=12.0000 Y=9.0000 Z=0.0000 

Szerokość ekranu (piksele): 

971 Wysokość ekranu 

(piksele): 569 

Podstawa wstawiania to: X=0.0000 Y=0.0000 

Z=0.0000 Rozdzielczość przyciągania wynosi: 

X=0.5000 Y=0.5000 Z=0.0000 Odstęp między 

siatkami wynosi: X:0.5000 Y:0.5000 Z=0.0000 

Bieżąca warstwa: 0 

Bieżący kolor: BYLAYER 

Bieżący typ linii: 

BYLAYER Aktualna 

wysokość: 0.0000 

Aktualna grubość: 0.0000 

Wypełnienie: włączone 

Siatka: 

wyłączone 

Ortho: 

wyłączone 

Snap: 

wyłączone 

Blips: 

wyłączone 

Drag: 

włączone 

Polecenie echo: on 

Kierunek kąta dodatniego: Przeciwnie do 

ruchu wskazówek zegara Jednostki kątowe: 

Stopnie dziesiętne 

Jednostki wymiaru: 

Dziesiętne Wysokość pola 

wyboru: 3 Jednostki na 

rysunku: 288 
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Śledzenie czasu spędzonego na pracy nad rysunkiem 

Można wyświetlić informacje o czasie pracy nad rysunkiem, w tym: 

• Data i godzina utworzenia rysunku. 

• Data i godzina ostatniego zapisu rysunku. 

• Całkowity czas pracy nad rysunkiem. 

• Czas pracy nad rysunkiem podczas bieżącej sesji edycji. Licznik czasu 

pracy można włączać i wyłączać lub wyzerować. 

Aby wyświetlić informacje o timerze 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Zmienne czasowe ( ):  

• Na wstążce wybierz kolejno Narzędzia > Zmienne czasowe (w zapytaniu). 

• W menu wybierz Narzędzia > Zapytanie > Zmienne czasowe. 

• Na pasku narzędzi Zapytania kliknij narzędzie Zmienne czasowe. 

• Wpisz godzinę, a następnie naciśnij klawisz Enter. 

2 Wybierz dowolną z opcji pola monitu: 

• Wybierz Timer On, aby włączyć licznik czasu, który upłynął. 

• Wybierz Timer Off, aby wyłączyć licznik czasu, który upłynął. 

• Wybierz opcję Wyświetl timer, aby ponownie wyświetlić informacje o timerze. 

• Wybierz Reset Timer, aby wyzerować licznik czasu, który upłynął. 

3 W oknie zachęty wybierz Anuluj, aby wyjść z polecenia. 
 

Za każdym razem, gdy wyświetlane są informacje o zegarze, wyświetlany jest 

następujący typ informacji: 

Aktualny czas to Fri Dec 19 09:58:43 1997 

Rysunek został utworzony dnia: Wed 17 Dec 1997 at 

16:17:59.8090 Rysunek został ostatnio zaktualizowany w dniu: 

Thur 18 Dec 1997 at 09:58:43.3040 Całkowity czas edycji: 1 2: 

35:4.2345 

Czas, który upłynął (wł.): 0 1: 21:5.6324 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ALCAD zapewnia wiele narzędzi edycyjnych do modyfikowania rysunku. Można 

łatwo przesuwać, obracać lub rozciągać elementy rysunku, a także zmieniać ich 

skalę. Jeśli chcesz usunąć element, możesz go usunąć kilkoma kliknięciami myszy. 

Można również tworzyć wiele kopii dowolnego elementu i kopiować elementy z 

jednego rysunku do drugiego. 

Większość jednostek można modyfikować za pomocą ogólnych poleceń edycji. 

Niektóre złożone jednostki wymagają specjalnych poleceń. W tej sekcji 

wyjaśniono, jak 

• Wybieranie encji przy użyciu metod wyboru encji i uchwytów. 

• Zmiana właściwości podmiotów. 

• Zmień kolejność jednostek, przesuwając je, obracając lub zmieniając kolejność 

wyświetlania. 

• Zmiana rozmiaru jednostek poprzez rozciąganie, skalowanie, wydłużanie, przycinanie lub 

edycję ich długości. 

• Dziel i łącz jednostki, rozbijając je, łącząc, eksplodując i grupując. 

• Edycja polilinii. 

• Tworzenie faz i filetów. 

 

 

 

 

 

Tematy w tym rozdziale 

Wybieranie podmiotów  .................................................................................... 326 

Modyfikowanie właściwości podmiotów  ........................................................... 343 

Usuwanie podmiotów ....................................................................................... 347 

Kopiowanie podmiotów  ................................................................................... 347 

Zmiana układu podmiotów  .............................................................................. 359 

Zmiana rozmiaru jednostek ............................................................................. 365 

Dzielenie i łączenie podmiotów  ....................................................................... 374 

Edycja polilinii  ................................................................................................. 382 

Podmioty zajmujące się fazowaniem i filetowaniem  ........................................ 389 

10  
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Wybieranie podmiotów 
 

Można utworzyć zestaw selekcji składający się z jednej lub więcej jednostek do 

modyfikacji. Aby utworzyć zestaw selekcji, należy użyć dowolnej z poniższych 

metod: 

• Najpierw wybierz polecenie lub narzędzie, a następnie zaznacz jednostki. 

• Najpierw zaznacz podmioty, a następnie wybierz polecenie lub narzędzie (większość 

podmiotów). 

• Wybieraj jednostki poprzez wskazywanie, a następnie używaj uchwytów do ich modyfikacji. 

 
Zrozumienie, kiedy wybierać jednostki 

Jednostki można wybierać przed lub po wybraniu polecenia. 
 

Wybieranie podmiotów w pierwszej kolejności 

Po wybraniu jednostek, a następnie wydaniu polecenia, program natychmiast działa 

na wybranych jednostkach. W wielu przypadkach okno zachęty specyficzne dla 

polecenia zapewnia dodatkowe opcje dla tej operacji edycji. Jeśli chcesz 

zmodyfikować zestaw selekcji w tym momencie, kliknij prawym przyciskiem myszy, 

aby wyświetlić okno zachęty z opcjami selekcji i wybierz żądaną opcję. Aby 

ponownie wyświetlić okno monitu z poleceniem, kliknij ponownie prawym 

przyciskiem myszy. 

Po zaznaczeniu jednej lub więcej jednostek można wybrać polecenie modyfikujące 

jednostkę, takie jak polecenie Kopiuj lub Przenieś. Można również kliknąć prawym 

przyciskiem myszy, aby wyświetlić menu skrótów zawierające polecenia modyfikacji 

jednostek odpowiednie dla wybranych jednostek, a następnie wybrać polecenie z 

menu. 
 

Wybór polecenia w pierwszej kolejności 

Po wybraniu narzędzia lub polecenia modyfikującego encje program wyświetla 

monit o wybranie encji i wyświetla okno zachęty, z którego można wybrać metodę 

selekcji. Można wybrać pojedyncze jednostki lub użyć innych technik, takich jak 

okna wyboru, aby wybrać wiele jednostek. 

Wybranie podmiotów powoduje dodanie ich do zestawu selekcji. Po wybraniu co 

najmniej jednego podmiotu można usunąć podmioty z zestawu wyboru. Aby 

zakończyć dodawanie jednostek do zestawu selekcji, naciśnij klawisz Enter. Większość 

poleceń modyfikacji jednostek działa następnie na cały zestaw selekcji. 
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Zrozumienie metod wyboru encji 

Po wybraniu polecenia, które wymaga wybrania jednostek (na przykład podczas 

usuwania lub modyfikowania jednostek), można użyć dowolnej z poniższych metod 

wyboru, wybierając je w polu zachęty lub wprowadzając na pasku poleceń: 

 
Metody wyboru jednostek 

Opis paska poleceń metody wyboru  

Wybierz 
wszystki
e 
jednostki 

WSZYSTKO Wybiera wszystkie jednostki w bieżącym rysunku. 

 

Dodaj do zestawu     + lub  Dodaje jeden lub więcej podmiotów do zestawu 

wyboru.  

Odejmij od zestawu - lub R Usuwa jeden lub więcej podmiotów z zestawu 

wyboru.  

Poprzedni wybór  P Wybiera jednostki zawarte w poprzednim zestawie 

selekcji. 

Ostatni 
podmiot na 
rysunku 

L Wybiera jednostkę ostatnio dodaną do rysunku. 

 

Okno wewnętrzne W Wybiera jednostki znajdujące się w całości w prostokątnym oknie 
okno wyboru. 

Okno przejścia C Wybiera jednostki znajdujące się wewnątrz lub przekraczające granicę 
prostokątne okno wyboru. 

Okno zewnętrzne O Wybiera jednostki znajdujące się całkowicie poza 
prostokątnym oknem wyboru. 

Wielokąt okna WP Wybiera jednostki zawarte w całości w zaznaczeniu wielokąta 
okno. 

Przekraczanie wielokąta CP Wybiera jednostki znajdujące się wewnątrz lub przekraczające granicę 
okno wyboru wielokąta. 

Wielokąt zewnętrzny OP Wybiera jednostki znajdujące się całkowicie poza zaznaczonym 
wielokątem 

okno. 

Okrąg okienny WC Wybiera jednostki znajdujące się w całości w zaznaczeniu kołowym 
okno. 

Przekraczanie kręgu CC Wybiera jednostki znajdujące się wewnątrz lub przekraczające granicę 
okrągłe okno wyboru. 

Koło zewnętrzne OC Wybiera jednostki znajdujące się całkowicie poza zaznaczeniem 
kołowym 

okno. 

Point PO Wybiera wszystkie zamknięte elementy otaczające 

wybrany punkt.  FenceF Wybiera jednostki przecinające linię lub segmenty 

linii. 

Szybki wybór QSELECT Wybiera jednostki według typu zgodnie z określoną 
wartością lub zakresem wartości. 



Wybierz według 
właściwości 

PRO Wybiera jednostki, które pasują do określonego zestawu 
właściwości - na przykład wszystkie jednostki na określonej 
warstwie lub narysowane w określonym kolorze. 

 
 



328 C H A P T E R 1 0 

 

Można również użyć kilku metod wyboru automatycznie, bez wyświetlania okna 

zachęty: 

• Kliknij jeden lub więcej podmiotów, aby je zaznaczyć. 

• Shift+kliknięcie, aby dodać lub usunąć podmiot z zestawu wyboru. 

• Kliknij jednostkę, aby ją zaznaczyć, a następnie Ctrl + kliknij, aby przełączać 

się między jednostkami poniżej kursora, wybierając jedną na raz. 

• Kliknij dwa przeciwległe rogi prostokątnego okna wyboru. Kierunek 

definiowania punktów prostokąta (od lewej do prawej lub od prawej do lewej) 

określa typ tworzonego okna. 
 

Na wybór wielu podmiotów może mieć wpływ ustawienie PICKADD. 

Jeśli wybierzesz jeden lub więcej dodatkowych podmiotów, gdy podmioty są już 

wybrane, dodatkowe podmioty mogą zastąpić lub dodać do istniejącego zestawu 

wyboru. Kliknij (  ) w panelu Właściwości lub użyj zmiennej systemowej 

PICKADD, aby przełączyć to, co dzieje się podczas wybierania wielu zestawów 

jednostek. 
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Wybieranie podmiotów poprzez ich kliknięcie 

Możesz kliknąć podmioty, aby je wybrać. 
 

Aby wybrać jednostki, klikając je 

1 Kliknij podmiot. 

 
Wybieranie podmiotów poprzez narysowanie okna wyboru 

Okno wyboru można narysować tak, aby obejmowało podmioty znajdujące się w 

oknie. 
 

Aby utworzyć okno wyboru od lewej do prawej 

1 Kliknij, aby wybrać punkt na rysunku. 

2 Kliknij po prawej stronie pierwszego punktu, aby wybrać drugi punkt na rysunku. 

 
 

 
Window-Inside poprzez wybranie pierwszego (A) i 
drugiego (B) punktu. 

Aby utworzyć okno wyboru od prawej do 
lewej 

1 Kliknij, aby wybrać punkt na rysunku. 

Wynikowy wybór. 

 

2 Kliknij po lewej stronie pierwszego punktu, aby wybrać drugi punkt na rysunku. 

 
 

 
CrossingWindow, wybierając pierwszy (A) i drugi 
(B) przycisk. 
(B) punkty. 

Wynikowy wybór. 

 

Oprócz prostokątnego okna można zdefiniować okno wyboru przy użyciu innych 

kształtów, takich jak wielokąt lub okrąg. 
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Aby wybrać jednostki za pomocą okna wyboru wielokąta 

1 Aktywacja polecenia modyfikacji podmiotu. 

2 W oknie dialogowym wybierz opcję Window Polygon. 

3 Określa wierzchołki wielokąta. 

4 Aby zakończyć zaznaczanie wielokąta, naciśnij Enter. 

 
 

 
WindowPolygon poprzez określenie 
wierzchołków wielokąta (A, B i C). 

 

Wybieranie podmiotów za 
pomocą ogrodzenia 

Wynikowy wybór. 

 

Ogrodzenie selekcji to wielosegmentowa linia, która wybiera jednostki, przez które przechodzi. 
 

Aby wybrać jednostki za pomocą ogrodzenia 

1 Aktywacja polecenia modyfikacji podmiotu. 

2 W oknie dialogowym wybierz opcję Fence. 

3 Określ punkty końcowe segmentów ogrodzenia. 

4 Aby ukończyć Fence, naciśnij Enter. 

 
 

 
Ogrodzenie poprzez określenie punktów końcowych 
segmentów ogrodzenia 
(A, B i C). 

Wynikowy wybór. 
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Filtrowanie wyboru jednostek 

Filtrowanie selekcji to skuteczny sposób na wybranie zestawu jednostek, które mają 

ze sobą coś wspólnego. Na przykład można wybrać wszystkie jednostki o tej samej 

właściwości, takiej jak kolor, wszystkie jednostki, które są proxy, lub wszystkie 

jednostki o tej samej wartości, nazwie bloku lub typie. Możesz nawet dodać lub 

usunąć więcej filtrów do zestawu jednostek, aby jeszcze bardziej dostosować wybór. 

 

Wybieranie podmiotów według właściwości 
ALCAD ułatwia wybieranie elementów zgodnie z ich wspólnymi właściwościami, 

umożliwiając szybką i wydajną modyfikację dużych zestawów elementów. Podczas 

wybierania jednostek wystarczy użyć filtra, aby dodać lub usunąć jednostki zgodnie z 

tymi wspólnymi właściwościami: kolorem, warstwą, skalą linetype, linetype, 

lineweight, grubością i szerokością. 

 

Użyj polecenia List, aby uzyskać więcej informacji na temat filtrowania. 

Jeśli nie masz pewności, jakie właściwości są dostępne do filtrowania, wpisz listę, 

aby wybrać obszar rysunku i wyświetlić listę wybranych jednostek i ich właściwości. 
 

 
Aby wybrać jednostki według właściwości przy użyciu filtra właściwości 

1 Aktywuj polecenie modyfikacji jednostki lub wpisz select. 

2 Wybierz Filtr. 

3 Wybierz opcję filtrowania: 

• Kolor - Wprowadź kolor jednostek, które chcesz wybrać. 

• Warstwa - Wprowadź nazwę warstwy jednostek, które chcesz wybrać. 

• LinetypeScale - Wprowadź skalę typu linii podmiotów, które chcesz wybrać. 

• Typ linii - Wprowadź typ linii jednostek, które chcesz wybrać. 

• Lineweight - Wprowadź wagę linii podmiotów, które chcesz wybrać. 

• Grubość - Wprowadź grubość elementów, które chcesz zaznaczyć. Należy 

pamiętać, że niektóre elementy mają grubość, jednak linie, okręgi, łuki i polilinie 

mają grubość. 

• Szerokość - Wprowadź szerokość jednostek, które chcesz wybrać. Należy 

pamiętać, że tylko polilinie mają szerokość. 
 

W nazwach właściwości rozróżniana jest wielkość liter. 

Na przykład rysunek z warstwami SAMPLE Layer 1, sample Layer 2 i SAM- PLE 

Layer 3 nie zwróci żadnego wyboru, jeśli jako nazwę warstwy podasz "SAMPLE". 

Określenie "SAMPLE*" zwraca dwie warstwy, "*Layer*" zwraca wszystkie 

warstwy, a "sample*" zwraca jedną warstwę. 
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4 W razie potrzeby dodaj lub usuń więcej podmiotów za pomocą filtra: 

• Wybierz dowolną inną opcję filtrowania, aby dodać więcej jednostek do zestawu wyboru. 

• Wybierz Usuń, aby usunąć jednostki z zestawu wyboru zgodnie z wybranym 

filtrem. 

Zostanie wyświetlony monit z całkowitą liczbą podmiotów w zestawie wyboru. 

5 Aby zakończyć wybór, naciśnij Enter. 

 
 

 
Wybór poprzez określenie najmniejszej wagi 
woliny 
właściwości. 

 

Wybieranie podmiotów proxy przy 
użyciu filtra 

Wynikowy wybór. 

 

Podmioty proxy to podmioty lub obiekty niestandardowe, których ALCAD nie 

obsługuje. Gdy rysunek zawierający jednostki proxy jest ładowany do ALCAD, 

wyświetlany jest komunikat wskazujący, że niektóre jednostki nie będą 

wyświetlane, jednak jednostki te pojawią się ponownie po otwarciu rysunku 

później w aplikacji CAD, która obsługuje te jednostki. 

Jednostki proxy mogą być zaznaczane przy użyciu typowych metod zaznaczania, ale 

mogą być również zaznaczane przy użyciu filtra, na przykład możesz chcieć 

zaznaczyć wszystkie jednostki proxy i umieścić je na ukrytej warstwie lub usunąć je, 

jeśli wiesz, że nie będą potrzebne w przyszłości. 
 

Aby wybrać jednostki proxy za pomocą filtra 

1 Aktywuj polecenie modyfikacji jednostki lub wpisz select. 

2 Wybierz Filtr. 

3 Wybierz Proxy. 

4 W razie potrzeby można dodać lub usunąć więcej podmiotów za pomocą filtra: 

• Wybierz dowolną inną opcję filtrowania, aby dodać więcej jednostek do zestawu wyboru. 

• Wybierz Usuń, aby usunąć jednostki z zestawu wyboru zgodnie z wybranym 

filtrem. 

Zostanie wyświetlony monit z całkowitą liczbą podmiotów w zestawie wyboru. 

5 Aby zakończyć wybór, naciśnij Enter. 

 
Wybieranie bloków o tej samej nazwie 

Niektóre rysunki zawierają wiele takich samych bloków, które można łatwo 

wybrać jako zestaw za pomocą filtra. 



E N T Y W N O Ś C I M O D Y F I K A C Y J N E

 333 

 
 

Użyj polecenia List, aby uzyskać nazwy bloków. 

Jeśli nie masz pewności, które bloki są dostępne do filtrowania, wpisz listę, aby 

wybrać obszar rysunku i wyświetlić listę wybranych elementów i ich nazw bloków. 
 

 
Aby wybrać jednostki według nazwy bloku 

1 Aktywuj polecenie modyfikacji jednostki lub wpisz select. 

2 Wybierz Filtr. 

3 Wybierz blok. 

4 Wprowadź nazwę bloku jednostek, które chcesz wybrać. 

5 W razie potrzeby dodaj lub usuń więcej podmiotów za pomocą filtra: 

• Wybierz dowolną inną opcję filtrowania, aby dodać więcej jednostek do zestawu wyboru. 

• Wybierz Usuń, aby usunąć jednostki z zestawu wyboru zgodnie z wybranym 

filtrem. 

Zostanie wyświetlony monit z całkowitą liczbą podmiotów w zestawie wyboru. 

6 Aby zakończyć wybór, naciśnij Enter. 

 
Wybieranie podmiotów według typu 
Jednostki w zestawie selekcji można filtrować według ich typu, na przykład okręgu, 

linii, tekstu, atrybutu lub typu bloku. 

 

Użyj polecenia List, aby uzyskać nazwy typów. 

Jeśli nie masz pewności, jakie typy jednostek są dostępne do filtrowania, wpisz 

listę, aby wybrać obszar rysunku i wyświetlić listę wybranych jednostek i ich 

typów. 
 

 
Aby wybrać podmioty według typu przy użyciu opcji filtrowania 

1 Aktywuj polecenie modyfikacji jednostki lub wpisz select. 

2 Wybierz Filtr. 

3 Wybierz typ. 

4 Wprowadź nazwę typu (wartość łańcuchową) podmiotów, które chcesz wybrać. 

5 W razie potrzeby dodaj lub usuń więcej podmiotów za pomocą filtra: 

• Wybierz dowolną inną opcję filtrowania, aby dodać więcej jednostek do zestawu wyboru. 

• Wybierz Usuń, aby usunąć jednostki z zestawu wyboru zgodnie z wybranym 

filtrem. 

Zostanie wyświetlony monit z całkowitą liczbą podmiotów w zestawie wyboru. 

6 Aby zakończyć wybór, naciśnij Enter. 
 

Użyj panelu wyboru i polecenia Szybki wybór, aby zaznaczyć jednostki według typu. 

Możesz także wpisać selfilter lub qselect, aby wybrać jednostki według typu. 
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Wybieranie podmiotów według wartości 
Jednostki w zestawie selekcji można filtrować według wspólnych właściwości i ich 

wartości. Na przykład można filtrować zestaw selekcji, aby uwzględnić wszystkie 

jednostki, które mają kolor czerwony i używają typu linii Dashed2, a następnie 

zmienić wartość typu linii. 

Aby wybrać podmioty według wartości za pomocą panelu Filtr wyboru 

1 Wykonaj jedną z poniższych czynności, aby wybrać Filtr wyboru (  ): 

• Na wstążce wybierz polecenie Widok > Filtr wyboru (na ekranie). 

• W menu wybierz polecenie Widok > Wyświetlanie > Filtr wyboru. 

• Wpisz selfilter i naciśnij Enter. 

2 Kliknij kartę Warstwa, Kolor, Typ jednostki lub Typ linii. 

Panel Filtr zaznaczenia zawiera listę wszystkich warstw, kolorów, typów 

jednostek i typów linii, które są dostępne na rysunku. 

3 W kolumnie Włączone zaznacz odpowiednią komórkę, aby uwzględnić lub 

wykluczyć wszystkie jednostki z odpowiednią wartością. Kliknięta komórka zostanie 

wyświetlona jako pusta (zaznaczenie jest wyłączone) lub z czarnym kółkiem 

(zaznaczenie jest włączone), w zależności od jej stanu przed kliknięciem. 

Może to wpłynąć na stan włączenia innych wartości na innych kartach. Kolumna 

Włączone dla wszystkich kart wskazuje następujące elementy: 

• Puste - na rysunku nie wybrano żadnych podmiotów o odpowiedniej wartości. 

• Czarne kółko - wszystkie jednostki z odpowiednią wartością są 

zaznaczone na rysunku. 

• Szare kółko - tylko niektóre jednostki z odpowiednią wartością są wybrane 

na rysunku (z powodu określonych wartości na innych zakładkach lub 

wybranych jednostek na rysunku). 
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A Kliknij, aby zaznaczyć wszystkie podmioty 

podczas rysowania. 

B Kliknij, aby wyświetlić i wybrać jednostki na 
rysunku zgodnie z przypisaną im warstwą. 

C Wyświetla wszystkie warstwy, kolory, 
typy encji lub typy linii, które są 
dostępne na rysunku w zależności od 
wybranej zakładki. 

D Kliknij, aby zmienić wybór w celu 
uwzględnienia lub wykluczenia wszystkich 
podmiotów z odpowiednią wartością. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
E Kliknij, aby wyświetlić i wybrać elementy na 

rysunku zgodnie z przypisanym im typem 
linii. 

F Kliknij, aby wyświetlić i wybrać jednostki na 
rysunku zgodnie z ich typem jednostki. 

G Kliknij, aby wyświetlić i wybrać elementy 
na rysunku zgodnie z ich kolorem. 

 

Aby wybrać jednostki według wartości przy użyciu funkcji Quick Select 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Szybki wybór (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Szybkie zaznaczanie 

(w aplikacji Narzędzia) lub Edycja > Szybkie zaznaczanie (w aplikacji 

Zaznaczanie). 

• W menu wybierz Edycja > Zaznaczanie > Szybkie zaznaczanie lub Narzędzia > Szybkie 

zaznaczanie. 

• W panelu Właściwości lub oknie dialogowym Zapisz blok na dysku kliknij 

narzędzie Szybki wybór. 

• Wpisz qselect. 

2 W polu Zastosuj do określ, które jednostki mają być brane pod uwagę przy 

wyborze. Na przykład wybierz opcję Cały rysunek, aby uwzględnić wszystkie 

jednostki na rysunku. Aby określić część 

A 

 
B 

G 

F 

   
E 

C D 
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rysunek do wyboru, kliknij (  ) i dokonaj wyboru bezpośrednio na rysunku. 

3 W polu Typ podmiotu określ typ podmiotu, który chcesz wybrać. 

4 Określ właściwość do filtrowania w celu zaznaczenia, jej operator i wartość. 

Opcje różnią się w zależności od typu jednostki. 

5 Wybierz jedną z poniższych opcji: 

• Include in New Selection Set (Uwzględnij w nowym zestawie selekcji) 

Tworzy nową selekcję, która zawiera tylko te jednostki, które spełniają 

wybrane opcje. 

• Exclude from New Selection Set (Wyklucz z nowego zestawu wyboru) 

Tworzy nowy zestaw wyboru, który zawiera wszystkie podmioty z wyjątkiem 

tych, które spełniają wybrane opcje. 

6 Aby dodać nowo wybrane jednostki do bieżącego zestawu wyboru (dostępnego, 

jeśli jednostki zostały wybrane przed użyciem polecenia Quick Select), zaznacz 

opcję Append to Current Selection Set. 

7 Kliknij przycisk OK. 

 

 

 

 AH 

B 

 
 

 
C 

 
 

 
D 

E 

 
F 

G 

 
A Wybierz autentyczność, która 

będzie brana pod uwagę przy 
wyborze. 

B Wybierz typ podmiotu, który chcesz 
wybrać. 

C Wybierz żądaną właściwość. 

D Wybierz sposób porównania wartości 
i nieruchomości. 

E Wybierz żądaną wartość. 

F Wybierz, czy chcesz uwzględnić lub 
wykluczyć wybrane podmioty z 
nowego zestawu wyborów. 

G Wybierz, aby dodać nowo wybrane 
podmioty do wcześniej określonego zestawu 
wyboru (jeśli jest dostępny). 

H Kliknij, aby określić część rysunku do 
zaznaczenia. Opcja Bieżący wybór 
pojawi się w polu Zastosuj do. 
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Aby wybrać podmioty według wartości przy użyciu opcji filtrowania 

1 Aktywuj polecenie modyfikacji jednostki lub wpisz select. 

2 Wybierz Filtr. 

3 Wybierz wartość. 

4 Wprowadź wartość (ciąg znaków) jednostek, które chcesz wybrać. 

5 W razie potrzeby dodaj lub usuń więcej podmiotów za pomocą filtra: 

• Wybierz dowolną inną opcję filtrowania, aby dodać więcej jednostek do zestawu wyboru. 

• Wybierz Usuń, aby usunąć jednostki z zestawu wyboru zgodnie z wybranym 

filtrem. 

Zostanie wyświetlony monit z całkowitą liczbą podmiotów w zestawie wyboru. 

6 Aby zakończyć wybór, naciśnij Enter. 
 

Użyj polecenia List, aby uzyskać wartości. 

Jeśli nie masz pewności, jakie wartości są dostępne do filtrowania, wpisz listę, aby 

wybrać obszar rysunku i wyświetlić listę wybranych jednostek i ich wartości. 
 

 
Wybieranie podmiotów pasujących do właściwości innych podmiotów 
Można wybrać wszystkie jednostki na rysunku, które mają ten sam kolor, warstwę, 

typ linii, skalę typu linii, grubość linii, styl wydruku, styl jednostki, nazwę, typ 

jednostki lub dowolną kombinację tych właściwości. Najpierw wybierasz jedną lub 

więcej jednostek, które mają właściwości, które chcesz dopasować, a następnie 

określasz, które właściwości mają być wyszukiwane i dopasowywane. Dopasowane 

jednostki są następnie dodawane do zestawu wyboru. 

Zestaw selekcji może być ponownie użyty w innych poleceniach poprzez selekcję 

pick-first lub poprzez wybranie poprzedniej selekcji. 
 

Aby wybrać podmioty, które pasują do jednej lub więcej właściwości innych 
podmiotów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wybierz podobne (  ): 

• Na wstążce wybierz kolejno Express Tools > Select Similar (w menu Tools). 

• W menu wybierz Express Tools > Tools > Select Similar. 

• Wpisz selectsimilar, a następnie naciśnij Enter. 

2 Wybierz jeden lub więcej podmiotów, których właściwości chcesz dopasować. 

3 Wybierz Ustawienia. 

4 W oknie dialogowym Wybierz podobne ustawienia zaznacz właściwości 

wybranych urządzeń, które chcesz dopasować. 
 

Zmienna systemowa SELECTSIMILARMODE również kontroluje ustawienia okna 
dialogowego. 

Szczegółowe informacje na temat korzystania z tej zmiennej systemowej można znaleźć w 

pomocy online dotyczącej zmiennych systemowych. 
 

5 Kliknij przycisk OK. 

Podmioty z dopasowanymi właściwościami są dodawane do zestawu wyboru. 
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Tworzenie filtrów używanych do wybierania podmiotów 
Tworzenie filtrów, które można ponownie wykorzystać, jest pomocne w przypadku 

regularnego filtrowania jednostek przy użyciu tych samych parametrów. Filtry 

wielokrotnego użytku są łatwe do utworzenia nawet w przypadku skomplikowanych 

zestawów selekcji. 

Aby utworzyć filtr używany do wybierania podmiotów 

1 Filtr typu. 

2 W polu Wybierz filtr wybierz element z listy filtrów. Na przykład wybierz 

Line, aby uwzględnić jednostki liniowe w zestawie wyboru. 

3 W razie potrzeby określ parametry elementu. Na przykład, jeśli wybrano 

Linetype, kliknij Select, aby wybrać typ linii; jeśli wybrano Line End, 

wprowadź współrzędne x, y i z. 

4 Kliknij przycisk Dodaj do listy. 

5 Powtórz tę czynność dla dodatkowych elementów filtra i w razie potrzeby dołącz operatory: 

• AND - Dodaj BEGIN AND przed jednym lub kilkoma elementami, aby je 

dodać; dodaj BEGIN END po elementach. 

• OR - Dodaj BEGIN OR przed jednym lub kilkoma elementami, aby je 

porównać i uwzględnić tylko jeden z nich; dodaj BEGIN OR po elementach. 

• XOR - Dodaj BEGIN XOR przed wieloma elementami, aby określić 

wykluczenia; dodaj BEGIN XOR po elementach. 

• NOT - Dodaj BEGIN NOT przed jednym elementem, aby określić 

wykluczenie; dodaj BEGIN NOT po elemencie. 

6 W polu Zapisz jako wprowadź nazwę filtra. 

7 Kliknij przycisk Zapisz jako. 
 

Aby wybrać jednostki przy użyciu utworzonego filtra 

1 Filtr typu. 

2 W polu Bieżący wybierz żądany filtr. 

3 Kliknij przycisk Zastosuj. 
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A 
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B L 

K 
C 
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I 

D H 

E 

 

 
 

 
A Wyświetla parametry definiujące filtr. 

B Wybierz element do uwzględnienia w 
filtrze. 

F G 

H Kliknij, aby usunąć nazwany filtr wybrany w 
Current. 

 

C Wprowadź współrzędne x, y i z, jeśli ma to 
zastosowanie do elementu filtra. 

D Kliknij, aby dodać określony element do 
filtra. 

E Kliknij, aby dodać aktualnie wybraną 
jednostkę na rysunku do filtra. 

F Kliknij, aby zastąpić aktualnie wybrany 
wiersz na liście filtrów aktualnie 
określonym elementem. 

G Kliknij, aby określić wartość dla 
wybranego elementu filtra. 

I Kliknij, aby zapisać filtr. 

J Wprowadź nazwę filtra. 

K Wybierz wcześniej zapisany filtr, aby go załadować. 

L Kliknij, aby edytować ustawienia 
aktualnie wybranej linii w filtrze. 

M Kliknij, aby usunąć wszystkie pozycje z filtra. 

N Kliknij, aby usunąć aktualnie wybrany element 
linii z filtra. 



340 C H A P T E R 1 0 

 

Usuwanie zaznaczenia podmiotów 

Jeśli jednostka nie jest już potrzebna w zestawie selekcji, można usunąć jej 

zaznaczenie, aby usunąć ją z zestawu selekcji. 
 

Aby usunąć podmiot z zestawu wyboru 

1 Naciśnij klawisz Shift, a następnie ponownie wybierz podmiot. 
 

Użyj skrótu. 

Naciśnięcie klawisza Shift podczas wybierania podmiotów za pomocą okna 

krzyżowania usuwa wszystkie podmioty z określonego zestawu wyboru. 
 

 
Aby usunąć wszystkie podmioty z zestawu wyboru 

1 Naciśnij klawisz Escape. 

 
Korzystanie z uchwytów 

Aby użyć uchwytów do edycji, należy wybrać jednostkę, aby wyświetlić uchwyty, a 

następnie kliknąć uchwyt, aby go aktywować. Podczas korzystania z uchwytów nie 

trzeba wprowadzać poleceń. 

Istnieją dwa rodzaje uchwytów: 

• Uchwyty jednostek - Uchwyty wyświetlane dla każdej wybranej jednostki i 

umożliwiające szybkie przesuwanie i skalowanie jednostek jedna po drugiej. 

• Uchwyty zaznaczenia - Uchwyty, które są wyświetlane dla całego zestawu 

zaznaczeń i umożliwiają szybkie przesuwanie, skalowanie i obracanie 

wszystkich wybranych elementów. Tego typu uchwyty mogą być pomocne w 

przypadku rysunków schematycznych, na których nie jest wymagana 

precyzyjna skala lub rozmiar. 

 

Włączanie i wyłączanie uchwytów 
Można włączać i wyłączać korzystanie z uchwytów oraz kontrolować ich rozmiar i kolor. 

 

Aby zmienić ustawienia uchwytu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz ddgrips i naciśnij Enter. 

2 W oknie dialogowym Ustawienia rysunku kliknij kartę Wyświetlanie. 

3 Kliknij kartę Uchwyty i wybierz jedną z poniższych opcji: 

• Włącz uchwyty jednostek - Kliknij, aby aktywować osobne uchwyty dla każdej wybranej 

jednostki. 

• Włącz uchwyty wyboru - kliknij, aby aktywować jeden zestaw uchwytów 

dla wszystkich podmiotów w zestawie wyboru. 
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• Rozmiar uchwytu - Określ rozmiar uchwytu. 

• Kolor uchwytu - kliknij, aby przypisać kolor uchwytu. 

4 Kliknij przycisk OK. 

 
Używanie uchwytów jednostek do edycji 
Możesz najpierw wybrać jednostki, a następnie wybrać sposób ich modyfikacji. Po 

wybraniu każdej jednostki jest ona podświetlana małymi kwadratami zwanymi 

uchwytami, które pojawiają się w strategicznych punktach jednostki. 

Wybrany uchwyt encji zależy od typu aktywnych uchwytów, typu modyfikowanej 

encji i wykonywanej operacji edycji. Na przykład, aby przesunąć jednostkę liniową 

z aktywnymi uchwytami jednostki, przeciągnij ją za uchwyt punktu środkowego. 

Aby rozciągnąć linię, przeciągnij jeden z uchwytów punktu końcowego. Jeśli jednak aktywne 

są uchwyty zaznaczenia, jednostkę linii można przesuwać, zmieniając położenie 

uchwytu punktu bazowego. 

Lokalizacje uchwytów jednostek zależą od wybranego typu jednostki. Na przykład 

uchwyty pojawiają się w punktach końcowych i środkowych linii, w punktach 

ćwiartki i środku okręgu oraz w punktach końcowych, środkowych i środku łuku. 

Uchwyty strzałkowe różnią się od uchwytów kwadratowych. Na przykład uchwyty 

strzałek na linii umożliwiają zmianę długości linii, ale pod tym samym kątem. 

Kwadratowe uchwyty na końcu linii umożliwiają zmianę punktów końcowych, 

czyli długości i kąta. 

 
 

Przykłady lokalizacji uchwytu jednostki. 

Aby edytować za pomocą uchwytów jednostek 

1 Upewnij się, że uchwyty jednostki są włączone. Szczegółowe informacje można 

znaleźć w sekcji "Włączanie i wyłączanie uchwytów" na stronie 340. 

2 Kliknij jednostkę, aby ją zaznaczyć i wyświetlić uchwyty. 

3 Kliknij uchwyt, aby go aktywować. 

4 Wykonaj dowolną z poniższych czynności: 

• Przeciągnij uchwyt, aby go przesunąć. 

• Wybierz polecenie, takie jak Kopiuj lub Przenieś. 

• Naciśnij spację, aby przełączać się między dostępnymi poleceniami, takimi 

jak Kopiuj, Przenieś, Obróć i inne, w zależności od jednostki i wybranego 

uchwytu. 
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Używanie uchwytów wyboru do edycji 
Za pomocą uchwytów wyboru można szybko przesuwać, skalować i obracać 

wszystkie wybrane elementy. Uchwyty wyboru są szczególnie przydatne w 

przypadku rysunków schematycznych, gdzie precyzyjna skala lub rozmiar nie są 

wymagane. Ponadto ten standardowy interfejs do manipulowania obrazami i 

obiektami w aplikacjach Windows może być pomocny dla użytkowników, którzy 

mogą nie być zaznajomieni z precyzyjnymi interfejsami edycji CAD. 

Uchwyty wyboru są podobne do uchwytów jednostek, ale są wyświetlane jako 

pojedynczy zestaw uchwytów dla wszystkich jednostek w zestawie wyboru. Po 

wybraniu pojedynczych bloków pojawiają się dodatkowe uchwyty dla 

niejednolitego skalowania dla wszystkich trzech osi. 

Lokalizacje uchwytów jednostek są jednolite dla zestawu selekcji. Uchwyty w 

rogach zestawu selekcji służą do skalowania, dolny środkowy uchwyt służy do przesuwania, 

górny uchwyt służy do obracania, a środkowy uchwyt służy do pozycjonowania 

orientacji obrotu. 

 
 

Przykłady lokalizacji uchwytu wyboru. Uchwyt obrotu znajduje się na górze, a uchwyt ruchu na dole 
pośrodku. 

Aby edytować za pomocą uchwytów wyboru 

1 Upewnij się, że uchwyty jednostki są włączone. Szczegółowe informacje można 

znaleźć w sekcji "Włączanie i wyłączanie uchwytów" na stronie 340. 

2 Kliknij podmiot, aby go zaznaczyć i wyświetlić uchwyty wyboru. W przypadku 

wybrania więcej niż jednej jednostki wyświetlany jest pojedynczy zestaw 

uchwytów wyboru dla całego zestawu. 

3 Kliknij uchwyt, aby go aktywować. 

4 Przeciągnij uchwyt, aby go przesunąć. 
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Wyświetlanie podświetlonych wybranych podmiotów 

Można określić, czy wybrane jednostki mają być podświetlane, co ułatwia 

przeglądanie zestawu selekcji. Domyślnie funkcja podświetlania jest włączona. 
 

Aby włączyć lub wyłączyć funkcję podświetlania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij dodatkową kartę Wyświetlanie. 

4 Zaznacz lub usuń zaznaczenie pola wyboru Podświetl element po wybraniu. 

5 Kliknij przycisk OK. 

 

 
 

Modyfikowanie właściwości podmiotów 
 

Można zmienić warstwę , grubość, typ linii, kolor i skalę typu linii jednego lub 

więcej elementów. W zależności od typu wybranej jednostki lub jednostek można 

także zmieniać inne właściwości, takie jak punkt początkowy i punkt końcowy linii, 

punkt środkowy i promień okręgów oraz wierzchołki polilinii. 

 

Modyfikowanie właściwości jednostki 

Użyj panelu Właściwości, aby wybrać właściwości dla dowolnej jednostki. Opcje 

wyświetlane w panelu Właściwości zależą od typu wybranej jednostki i od tego, czy wybrano więcej 

niż jedną jednostkę. 

Jeśli nie wybrano żadnych podmiotów, w panelu Właściwości wyświetlane są różne 

ustawienia domyślne rysunku, które można również modyfikować. 
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Aby zmodyfikować właściwości podmiotów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz Widok > Właściwości (na ekranie). 

• W menu wybierz Modyfikuj > Właściwości. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Właściwości. 

• Wpisz entprop i naciśnij Enter. 

• Naciśnij Ctrl +1. 

Wyświetlony zostanie panel Właściwości. 

2 Wybierz żądane podmioty. 

3 Wprowadź zmiany we właściwościach. Dostępne właściwości różnią się w 

zależności od wybranych podmiotów. 

 
 

A H 
G 

B F 

 
 

C 

 
 
 

 
D 

 
 
 

 
E 

 
 
 
 

 
A Wyświetla typy podmiotów w tym 

zestawie wyboru. 

B Kliknij, aby wyświetlić typy jednostek jako 
listę płaską lub hierarchiczną. 

C Określ właściwości, które są wspólne dla 
większości jednostek. 

D Określ właściwości dla wizualizacji 3D. 

 
E Określa właściwości specyficzne dla 

wybranej geometrii. 

F Kliknij, aby wyświetlić lub ukryć panel 
Filtr wyboru. 

G Kliknij, aby wybrać jednostki na rysunku. 

H Kliknij, aby określić, czy bieżący 
zestaw wyboru zostanie zastąpiony 
lub dodany do kolejnych wybranych 
elementów. 
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Można również skorzystać z paska narzędzi Właściwości jednostki. 

Kliknij narzędzie na pasku narzędzi Właściwości jednostki, aby zmienić właściwości 

wybranych jednostek. Należy pamiętać, że ustawienia paska narzędzi Właściwości 

jednostki, które są wyświetlane, gdy żadna jednostka nie jest zaznaczona, określają 

właściwości nowych jednostek podczas ich rysowania. 
 

 
Modyfikowanie właściwości wielu podmiotów 

Można modyfikować wszystkie właściwości wszystkich wybranych podmiotów 

jednocześnie. Przykładowo, za pomocą polecenia entprop można zaznaczyć 

wszystkie obiekty na określonej warstwie, a następnie przenieść je na inną warstwę, 

wybierając nazwę z pola tekstowego Warstwa. Dodatkowo, używając polecenia 

select i opcji Select by Properties, można zaznaczyć wszystkie niebieskie obiekty i 

zmienić ich kolor na zielony. 

W panelu Właściwości zmiany wprowadzone w polach Warstwa, Kolor, Grubość, 

Waga linii, Typ linii, Skala typu linii i Styl wydruku (jeśli używane są nazwane 

tabele stylów wydruku) mają wpływ na wszystkie zaznaczone jednostki. Aby 

zmienić właściwości pojedynczej jednostki w zestawie zaznaczenia, wybierz tę 

jednostkę z listy w górnej części panelu Właściwości. 

Jednostki, które mają zostać zmienione, można wybrać za pomocą dowolnej metody wyboru 

jednostek. 
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Zmiana wielu właściwości na ByLayer 

Polecenie Set to ByLayer ustawia właściwości wybranych elementów na ByLayer. 

Właściwości, które można zmienić za pomocą polecenia Set to ByLayer obejmują: kolor, 

typ linii, grubość linii, materiał, styl wydruku i przezroczystość. 
 

Aby zmodyfikować właściwości podmiotów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Set to ByLayer (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Ustaw na ByLayer (w Warstwy). 

• W menu wybierz Format > Narzędzia warstw > Ustaw na ByLayer. 

• Na pasku narzędzi Narzędzia warstw kliknij narzędzie Ustaw na ByLayer. 

• Wpisz setbylayer i naciśnij Enter. 

2 Naciśnij Enter. 

3 W oknie dialogowym SetByLayer Settings dokonaj wyboru właściwości, które 

chcesz zmienić: 

• Kolor - wynikowe jednostki będą miały właściwość Kolor ustawioną na ByLayer. 

• Linetype - Wynikowe jednostki będą miały właściwość Linetype ustawioną na ByLayer. 

• Lineweight - Wynikowe jednostki będą miały właściwość Lineweight 

ustawioną na ByLayer. 

• Materiał - podmioty wynikowe będą miały właściwość Materiał ustawioną na ByLayer. 

• Styl wydruku - wynikowe jednostki będą miały właściwość stylu wydruku ustawioną na 

ByLayer. 

• Przezroczystość - Wynikowe jednostki będą miały właściwość 

Przezroczystość ustawioną na ByLayer. 

4 Kliknij przycisk OK. 

5 Po wyświetleniu monitu wybierz żądane podmioty. 

6 Wybierz Tak, aby zmienić wszystkie znalezione właściwości ByBlock na 

ByLayer. W przeciwnym razie wybierz opcję Nie. 

7 Wybierz opcję Tak, aby zmienić właściwości zaznaczonych bloków. Bloki muszą 

znajdować się na odblokowanych warstwach. W przeciwnym razie wybierz 

opcję Nie. 



 

Usuwanie 
podmiotów 
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Jednostki można usuwać z rysunku. Jednostki można usuwać za pomocą 

dowolnej metody wyboru jednostek. 
 

Aby usunąć zestaw wyboru 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Usuń (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Usuń (w oknie 

Modyfikuj) lub Edytuj > Usuń (w oknie Modyfikuj). 

• W menu wybierz Edytuj > Usuń. 

• Na pasku narzędzi Standard kliknij narzędzie Usuń. 

• Wpisz delete i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

 

Wpisanie polecenia Cofnij usunięcie przywraca ostatnio usunięty zestaw zaznaczeń. 

Jeśli od momentu usunięcia podmiotów wprowadzono dodatkowe modyfikacje, 

należy użyć opcji Cofnij usunięcie zamiast Cofnij, aby przywrócić te podmioty bez 

cofania tych modyfikacji. 
 

 

Polecenie Overkill usuwa dodatkowe jednostki jednocześnie. 

Jeśli rysunek zawiera nakładające się lub zduplikowane elementy, które chcesz 

usunąć lub połączyć, na przykład polilinie ze zbyt dużą liczbą wierzchołków, użyj 

polecenia Overkill, aby oczyścić rysunek. 
 

 

 

Kopiowanie podmiotów 
 

Można skopiować jeden lub więcej elementów, tworząc jedną kopię lub wiele kopii 

w ramach bieżącego rysunku. Można także kopiować elementy między rysunkami. 

Użyj dowolnej z poniższych metod, aby skopiować jednostki w ramach bieżącego rysunku: 

• Utworzenie kopii w lokalizacji, do której odwołuje się oryginał. 

• Utwórz kopię wyrównaną równolegle do oryginału. 

• Utwórz kopię jako lustrzane odbicie oryginału. 

• Utwórz kilka kopii w układzie prostokątnym lub kołowym. 
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Kopiowanie jednostek w obrębie rysunku 

Można powielać elementy w obrębie bieżącego rysunku. Domyślną metodą jest 

utworzenie zestawu selekcji, a następnie określenie punktu początkowego (punktu 

bazowego) i punktu końcowego (punktu rozlokowania) dla kopii. Można również 

utworzyć wiele kopii lub skopiować zestaw selekcji do określonej lokalizacji, 

używając wektora kierunku. Można również utworzyć tablicę skopiowanych 

jednostek; więcej szczegółów można znaleźć w sekcji "Tworzenie tablic jednostek" 

na stronie 354 w tym rozdziale. 

Oprócz kopiowania zwykłych elementów na rysunku, można również kopiować 

elementy zawarte w blokach, odniesienia zewnętrzne i podkłady. 
 

Aby skopiować zestaw zaznaczeń 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj (  ): 

• Na wstążce wybierz polecenie Edycja > Kopiuj (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Kopiuj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Kopiuj. 

• Wpisz copy i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt bazowy. 

4 Określ punkt wstawienia. 

5 Kontynuuj określanie punktów wstawiania, aby umieścić dodatkowe kopie. 

6 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 
 

 
Aby utworzyć pojedynczą kopię jednostki, 
wybierz jednostkę do skopiowania (A), 
punkt bazowy (B), a następnie punkt 
przesunięcia (C). 

Wynik. 
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Aby utworzyć wiele kopii jednostki, wybierz 
jednostkę do skopiowania (A), określ punkt 
bazowy (B), a następnie określ punkty 
przesunięcia (C, D i E). 

 
 
 
 

 

Wynik. 

 
 

 

Użyj skrótu. 

Naciśnij i przytrzymaj klawisz Ctrl, a następnie kliknij i przeciągnij lewym przyciskiem myszy, 

aby skopiować jednostkę. 
 

 

Użyj zmiennej systemowej. 

Zmienna systemowa COPYMODE kontroluje, czy pojawi się monit o wiele kopii. 
 

 

Użyj polecenia Przenieś/Kopiuj/Obróć. 

Wybrane elementy można przenosić, kopiować, obracać i skalować za pomocą 

jednego polecenia. Wybierz narzędzie Move/Copy/Rotate express lub wpisz 

mocoro. 
 

 
Aby skopiować jednostki zagnieżdżone w blokach, odniesienia zewnętrzne lub 
podkłady 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj zagnieżdżone jednostki (

 ): 

• Na wstążce wybierz kolejno Express Tools > Copy Nested Entities (in Blocks). 

• W menu wybierz Express Tools > Blocks > Copy Nested Entities. 

• Wpisz ncopy i naciśnij Enter. 

2 Wybierz jednostki zagnieżdżone w blokach, odniesieniach zewnętrznych lub 

podkładach, a następnie naciśnij klawisz Enter. 

3 Określ punkt bazowy. 

4 Określ punkt wstawienia. 

5 Kontynuuj określanie punktów wstawiania, aby umieścić dodatkowe kopie. 

6 Aby zakończyć polecenie, naciśnij klawisz Enter. 
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Kopiowanie między rysunkami 

Schowka można używać do wycinania lub kopiowania elementów z jednego 

rysunku do drugiego. Wycinanie powoduje usunięcie zaznaczonych elementów z 

rysunku i zapisanie ich w Schowku. Kopiowanie duplikuje wybrane elementy z 

rysunku i umieszcza je w Schowku. 
 

Aby wyciąć jednostki do schowka 

1 Wybierz jednostki, które chcesz wyciąć. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wytnij (  ): 

• Na wstążce wybierz polecenie Edycja > Wytnij (w sekcji Modyfikuj). 

• W menu wybierz polecenie Edycja > Wytnij. 

• Na pasku narzędzi Standardowy kliknij narzędzie Wytnij. 

• Wpisz cutclip i naciśnij Enter. 

Aby skopiować jednostki do schowka 

1 Wybierz jednostki, które chcesz skopiować. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj do schowka (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Kopiuj do schowka (w Schowku). 

• W menu wybierz Edytuj > Kopiuj do schowka. 

• Na pasku narzędzi Standard kliknij narzędzie Kopiuj do schowka. 

• Wpisz copyclip i naciśnij Enter. 

Wszystko, co można skopiować do Schowka, można wkleić do rysunku. Format, w 

jakim program dodaje zawartość schowka do rysunku, zależy od typu informacji w 

schowku. Na przykład, jeśli skopiujesz elementy rysunku ALCAD do Schowka, 

program wklei je do rysunku jako elementy ALCAD. Jeśli skopiujesz elementy do 

Schowka z innych programów, zostaną one wklejone do bieżącego rysunku jako 

osadzone obiekty ActiveX®. 

 

Czasami format, który chcesz wkleić, nie jest dostępny w schowku. 

Jest to najprawdopodobniej spowodowane ustawieniami na karcie Schowek w menu 

Narzędzia > Opcje. Szczegółowe informacje można znaleźć w sekcji "Zmiana opcji 

na karcie Zaznaczanie cykliczne" na stronie 722. 
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Aby wkleić jednostki ze schowka 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wklej (  ): 

• Na wstążce wybierz polecenie Narzędzia główne > Wklej (w Schowku) lub 

wybierz polecenie Edycja > Wklej (w Modyfikuj). 

• W menu wybierz Edytuj > Wklej. 

• Na pasku narzędzi Standard kliknij narzędzie Wklej. 

• Wpisz pasteclip i naciśnij Enter. 

2 Określ punkt wstawienia. 
 

Zawartość schowka można również wstawić jako blok. 

Wpisz pasteblock, aby przekonwertować zawartość schowka na blok po wstawieniu. 
 

 
Kopiowanie między przestrzeniami 

Jednostki można kopiować z przestrzeni modelu do przestrzeni papierowej lub z 

przestrzeni papierowej do przestrzeni modelu. Aby móc kopiować jednostki między 

przestrzeniami, należy przeglądać kartę Układ, która ma co najmniej jedną rzutnię 

układu. Jednostki można także przenosić między przestrzeniami za pomocą tego 

samego polecenia Zmień przestrzeń. 

Więcej informacji na temat przestrzeni modelu i przestrzeni papieru można znaleźć 

w sekcji "Zrozumienie przestrzeni papieru i przestrzeni modelu" na stronie 518. 
 

Aby kopiować jednostki między przestrzeniami 

1 Kliknij kartę Układ. 

2 Wybierz jednostki, które chcesz skopiować. 

3 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zmień miejsce (  ): 

• Na wstążce wybierz polecenie Edycja > Zmień miejsce (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Zmień miejsce. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zmień miejsce. 

• Wpisz chspace, a następnie naciśnij Enter. 

4 Wybierz Kopiuj. 
 

W przypadku korzystania z paska poleceń opcja Kopiuj może zostać pomylona z 

zaznaczeniami krzyżującymi się. Aby użyć metody krzyżowania, należy wpisać pełne 

słowo kluczowe "krzyżowanie". Wpisanie "c" powoduje wywołanie opcji Kopiuj. 
 

 
Tworzenie kopii równoległych 

Funkcja przesunięcia umożliwia kopiowanie wybranych elementów i 

wyrównywanie ich równolegle do oryginalnych elementów w określonej 

odległości. Równoległe, przesunięte elementy można tworzyć przy użyciu łuków, 

okręgów, elips, łuków eliptycznych, linii, dwuwymiarowych polilinii, promieni i 

linii nieskończonych. 
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Tworzenie równoległych, przesuniętych kopii zakrzywionych elementów tworzy 

większe lub mniejsze krzywe, w zależności od tego, po której stronie oryginalnego 

elementu zostanie umieszczona kopia. Na przykład, umieszczenie równoległej kopii 

okręgu na zewnątrz okręgu tworzy większy koncentryczny okrąg; umieszczenie kopii 

wewnątrz okręgu tworzy mniejszy koncentryczny okrąg. 
 

Aby utworzyć kopię równoległą, określając odległość 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Offset (  ): 

• Na wstążce wybierz polecenie Edycja > Przesunięcie (w obszarze Modyfikuj). 

• W menu wybierz kolejno opcje Modyfikuj > Edycja podstawowa > Przesunięcie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przesunięcie. 

• Wpisz offset, a następnie naciśnij Enter. 

2 Określ odległość, wybierając dwa punkty lub wprowadzając odległość. 

3 Wybierz jednostkę do skopiowania. 

4 Określa, po której stronie jednostki ma zostać umieszczona kopia równoległa. 

5 Wybierz inną jednostkę do skopiowania lub naciśnij Enter, aby zakończyć polecenie. 

 
 

 
Aby wykonać kopię równoległą, należy określić odległość między 
kopiami 
wprowadzając odległość lub wybierając dwa punkty (A i B), 
wybierz punkt do skopiowania (C) i określ, po której stronie 
ma zostać umieszczona kopia (D). 

Aby utworzyć równoległą kopię przechodzącą 
przez punkt 

1 Wykonaj jedną z poniższych czynności, aby 

wybrać opcję Offset (  ): 

• Na wstążce wybierz polecenie Edycja > 

Przesunięcie (w obszarze Modyfikuj). 

Wynik. 

 

• W menu wybierz kolejno opcje Modyfikuj > Edycja podstawowa > Przesunięcie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przesunięcie. 

• Wpisz offset, a następnie naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Przez punkt. 

3 Wybierz jednostkę do skopiowania. 

4 Określa punkt, przez który jednostka ma przejść. 

5 Powtórz kroki 3 i 4 lub naciśnij Enter, aby zakończyć polecenie. 
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Aby wykonać kopię równoległą przechodzącą przez punkt, wybierz jednostkę do skopiowania (A), a 
następnie określ punkt przechodzący (B). 

 

Jednostki lustrzane 

Można utworzyć lustrzane odbicie jednostki. Odbicie lustrzane jednostki jest 

tworzone wokół linii lustrzanej, którą definiuje się poprzez określenie dwóch 

punktów na rysunku. Oryginalne elementy można usunąć lub zachować. 
 

Aby odzwierciedlić jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Lustro (  ): 

• Na wstążce wybierz polecenie Edycja > Przesunięcie (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Lustro. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Lustro. 

• Wpisz mirror i naciśnij Enter. 

2 Wybierz podmiot, a następnie naciśnij klawisz Enter. 

3 Określa pierwszy punkt linii lustrzanej. 

4 Określa drugi punkt linii lustrzanej. 

5 W oknie zachęty wybierz jedną z poniższych opcji: 

• Tak, Usuń jednostki - usuwa oryginalne jednostki. 

• Nie, Zachowaj jednostki - zachowuje oryginalne jednostki. 

 
 

 
Aby wykonać kopię lustrzaną jednostki, wybierz ją 
(A), a następnie określ 
pierwszy punkt (B) i drugi punkt (C) linii 
lustrzanej. 

Wynik. 
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Układanie jednostek 

Możesz skopiować encję we wzorcu, który tworzy tablicę. Istnieją trzy sposoby 

tworzenia tablic: 

• Tablica liniowa - użyj polecenia Copy, aby kontrolować liczbę kopii w tablicy 

i linię, wzdłuż której umieszczane są kopie. 

• Tablica prostokątna - polecenie Array służy do kontrolowania liczby kopii w 

tablicy poprzez określenie liczby wierszy i kolumn. Określa się również 

odległość między każdym wierszem i kolumną. 

• Szyk biegunowy (kołowy) - polecenie Array służy do kontrolowania liczby 

kopii tworzących szyk i obracania kopii. 
 

Aby utworzyć tablicę liniową 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj (  ): 

• Na wstążce wybierz polecenie Edycja > Kopiuj (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Kopiuj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Kopiuj. 

• Wpisz copy i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt początkowy linii, wzdłuż której chcesz umieścić jednostki. 

4 Wybierz Array. 

5 Wprowadź liczbę elementów w tablicy, a następnie naciśnij klawisz Enter. 

6 Określ drugi punkt linii, wzdłuż której chcesz umieścić jednostki; jest to punkt, 

w którym zostaną umieszczone pierwsze jednostki w tablicy. Lub jeśli 

wybierzesz Fit, jest to punkt, w którym zostaną umieszczone ostatnie jednostki w 

tablicy. 

7 Kontynuuj określanie punktów, aby w razie potrzeby umieścić dodatkowe 

kopie, lub naciśnij Enter po zakończeniu. 
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Aby utworzyć układ biegunowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Array (  ): 

• Na wstążce wybierz Edytuj > Tablica (w Modyfikuj). 

• W menu wybierz Modyfikuj > Tablica. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Tablica. 

• Wpisz array, a następnie naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 W oknie dialogowym Array wybierz opcję Polar Array. 

4 Określ punkt środkowy tablicy lub kliknij (  ), aby wybrać punkt środkowy na 

rysunku. 

5 Wybierz metodę, która określa dwie zmienne używane do utworzenia tablicy, a 

następnie określ te dwie zmienne: 

• Całkowita liczba elementów - Wprowadź liczbę elementów do 

utworzenia w tablicy, w tym jeden dla oryginalnego zestawu wyboru. 

• Kąt wypełnienia - Wprowadź kąt wypełnienia: od 0 do 360 stopni. Domyślne 

ustawienie kąta to 360 stopni. Wartości dodatnie tworzą tablicę w kierunku 

przeciwnym do ruchu wskazówek zegara; wartości ujemne tworzą tablicę w 

kierunku zgodnym z ruchem wskazówek zegara. Można również kliknąć (  ), aby 

wybrać kąt na rysunku. 

• Kąt między elementami - Wprowadź kąt między liniami. Ustawienie 

domyślne to 90 stopni. Możesz także kliknąć (  ), aby wybrać kąt na 

rysunku. 

6 W polu wyboru Obróć kopiowane elementy zaznacz pole wyboru, aby obrócić 

elementy podczas ich układania, lub usuń jego zaznaczenie, aby zachować 

oryginalną orientację każdej kopii podczas jej układania. 

7 Aby określić nowy punkt bazowy dla tablicy, wykonaj następujące czynności: 

• Kliknij Więcej. 

• Usuń zaznaczenie Ustaw na domyślne dla podmiotu. 

• W polu Punkt bazowy wprowadź nowy punkt bazowy jednostki, który 
zostanie użyty dla tablicy, lub kliknij (  ), aby wybrać punkt bazowy na 

rysunku. 

 
 

Aby utworzyć macierz biegunową, wybierz jednostkę do skopiowania (A), określ punkt środkowy 
macierzy (B), a następnie określ inne opcje. 
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A Wybierz Polar, aby utworzyć macierz kołową. 

B Kliknij, aby określić punkt środkowy 
bezpośrednio na rysunku. 

C Wprowadź współrzędne X i Y punktu 
środkowego, wokół którego mają być 
rozmieszczone jednostki. 

D Wybierz, aby utworzyć tablicę przy użyciu 
kombinacji dwóch z następujących 
elementów: całkowita liczba elementów w 
tablicy, kąt, który wypełni tablica, oraz kąt 
między elementami. 

E Wprowadź liczbę elementów do utworzenia w 
tablicy. 

F Wprowadź kąt wypełnienia tablicy. 

G Wprowadź stopień kąta między ułożonymi 
elementami. 

H Kliknij, aby określić kąt między elementami 
bezpośrednio na rysunku. 

I Kliknij, aby określić kąt do wypełnienia 
bezpośrednio na rysunku. 

 
J Wybierz, aby automatycznie obracać 

elementy podczas ich układania. 

K Wybierz, aby użyć domyślnego punktu 
bazowego jednostki dla tablicy. 

L Wprowadź nowy punkt bazowy 
jednostki, który zostanie użyty dla 
tablicy. 

M Kliknij, aby wyświetlić podgląd tablicy na rysunku (dostępne są 
tylko opcje wybrane dla tablicy). 

N Kliknij, aby określić punkt bazowy 
bezpośrednio na rysunku. 

O Kliknij, aby wyświetlić lub ukryć więcej opcji. 

P Wyświetla liczbę podmiotów wybranych na 
rysunku dla tablicy. 

Q Kliknij, aby tymczasowo przełączyć się na 
rysunek w celu wybrania jednostek do 
uwzględnienia w tablicy. 
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Aby utworzyć prostokątną tablicę 

1 Wykonaj jedną z poniższych czynności, aby wybrać Array (  ): 

• Na wstążce wybierz Edytuj > Tablica (w Modyfikuj). 

• W menu wybierz Modyfikuj > Tablica. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Tablica. 

• Wpisz array, a następnie naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 W oknie dialogowym Array wybierz opcję Rectangular Array. 

4 Wprowadź liczbę wierszy i liczbę kolumn. 

Prostokątna tablica musi mieć co najmniej dwa wiersze lub dwie kolumny. 

5 W polu Przesunięcie wiersza określ odległość między wierszami. Możesz także 

kliknąć (  ), aby określić przesunięcie wiersza i kolumny w tym samym 

czasie na rysunku, lub możesz kliknąć (  ), aby wybrać tylko przesunięcie 

wiersza. 

6 W polu Przesunięcie kolumn określ odległość między kolumnami. Możesz także kliknąć 

(  ), aby określić przesunięcie wiersza i kolumny w tym samym czasie na 

rysunku, lub można kliknąć (  ), aby wybrać tylko przesunięcie kolumny. 

7 W polu Kąt tablicy wprowadź kąt, o jaki ma zostać obrócona tablica, lub 
kliknij (  ), aby wybrać kąt bezpośrednio na rysunku. 

 

Aby utworzyć prostokątną tablicę, wybierz jednostkę do skopiowania (A), wpisz liczbę wierszy i kolumn, 
a następnie określ odległość między każdym wierszem (B) i kolumną (C). 
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A Wybierz opcję Prostokątny, aby utworzyć 
prostokątną tablicę. 

B Wprowadź liczbę wierszy i kolumn tablicy. 

C Kliknij, aby określić przesunięcie wiersza 
bezpośrednio na rysunku. 

D Kliknij, aby określić zarówno przesunięcie 
wiersza, jak i przesunięcie kolumny 
bezpośrednio na rysunku. 

E Wprowadź ilość pionowego odstępu 
między poszczególnymi wierszami w 
tablicy. 

F Wprowadź żądany odstęp poziomy między 
każdą kolumną w tablicy. 

G Wprowadź kąt, o jaki ma zostać obrócona tablica. 

H Kliknij, aby określić kąt układu bezpośrednio 
na rysunku. 

I Kliknij, aby określić przesunięcie kolumny 
bezpośrednio na rysunku. 

J Kliknij, aby wyświetlić podgląd tablicy na 
rysunku (dostępne tylko po wybraniu opcji dla 
tablicy). 

K Wyświetla liczbę podmiotów wybranych na 
rysunku dla tablicy. 

L Kliknij, aby tymczasowo przełączyć się na 
rysunek w celu wybrania jednostek do 
uwzględnienia w tablicy. 



 

Zmiana kolejności 
jednostek 
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Można przesuwać jeden lub więcej elementów, a także zmieniać ich położenie 

względem określonego punktu. Jeśli obiekty nakładają się na siebie, można również 

zmienić kolejność wyświetlania. 

 

Przenoszenie podmiotów 

Jednostki można przenosić w obrębie bieżącego rysunku lub z jednego rysunku do 

drugiego. Domyślną metodą jest utworzenie zestawu zaznaczeń, a następnie 

określenie punktu początkowego (punktu bazowego) i punktu końcowego (punktu 

przesunięcia) w celu zdefiniowania relokacji jednostek. Można również przenieść 

jednostki za pomocą wektora kierunku. 
 

Aby przenieść zestaw wyboru 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przenieś (  ): 

• Na wstążce wybierz polecenie Edycja > Przenieś (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Przenieś. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przesuń. 

• Wpisz move i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt bazowy. 

4 Określ punkt przesunięcia. 

 
 

 
Aby przenieść jednostkę, zaznacz ją (A), a 
następnie wybierz opcję 
punkt bazowy (B) i punkt przemieszczenia (C). 

Wynik. 

 
 

 

Użyj polecenia Przenieś/Kopiuj/Obróć. 

Wybrane elementy można przenosić, kopiować, obracać i skalować za pomocą 

jednego polecenia. Wybierz narzędzie Move/Copy/Rotate express lub wpisz 

mocoro. 
 

Jednostki można także przenosić za pomocą uchwytów. Aby przenieść element za 

pomocą uchwytów, wybierz element, aby wyświetlić jego uchwyty, a następnie 

kliknij uchwyt i przeciągnij go. Wybrany uchwyt zależy od typu modyfikowanej 

jednostki. Na przykład, aby przesunąć jednostkę liniową, wybierz uchwyt punktu 

środkowego. Aby przenieść zakrzywioną jednostkę, taką jak łuk, okrąg lub elipsa, 

wybierz uchwyt punktu środkowego. Nie wszystkie jednostki mogą być 



przenoszone za pomocą uchwytów. 
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Aby przenieść jednostkę za pomocą uchwytów 

1 Wybierz podmiot. 

2 Kliknij uchwyt, aby go wybrać. 

3 Przeciągnij jednostkę do miejsca, do którego chcesz ją przenieść. 

4 Kliknij, aby zwolnić. 

 
Przenoszenie jednostek między przestrzeniami 

Jednostki można przenosić z przestrzeni modelu do przestrzeni papierowej lub z 

przestrzeni papierowej do przestrzeni modelu. Aby móc przenosić jednostki między 

przestrzeniami, należy przeglądać kartę Układ, która ma co najmniej jedną rzutnię 

układu. Można również kopiować jednostki między przestrzeniami za pomocą tego 

samego polecenia Zmień przestrzeń. 

Więcej informacji na temat przestrzeni modelu i przestrzeni papieru można znaleźć 

w sekcji "Zrozumienie przestrzeni papieru i przestrzeni modelu" na stronie 518. 
 

Aby przenosić jednostki między przestrzeniami 

1 Kliknij kartę Układ. 

2 Wybierz jednostki, które chcesz przenieść. 

3 Wykonaj jedną z poniższych czynności, aby wybrać (  ): 

• Na wstążce wybierz polecenie Edycja > Zmień miejsce (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Zmień miejsce. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zmień miejsce. 

• Wpisz chspace, a następnie naciśnij Enter. 

4 Wybierz opcję Przenieś. 
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Obracające się jednostki 

Obiekty można obracać wokół określonego punktu o określony kąt obrotu lub o kąt 

odnoszący się do kąta bazowego. Domyślna metoda obraca encje przy użyciu 

odpowiedniego kąta obrotu w stosunku do ich bieżącej orientacji. 
 

Aby obrócić zestaw wyboru 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obróć ( ): 

• Na wstążce wybierz polecenie Edycja > Obróć (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Obróć. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Obróć. 

• Wpisz rotate i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt obrotu. 

4 W razie potrzeby wybierz opcję Kopiuj, aby obrócić kopię wybranych jednostek. 

5 Określa kąt obrotu. 

 
 

Torotateanentity, wybierz torotate(A), a następnie określ punkt obrotu (B) i kąt obrotu (C). 

Aby obrócić zestaw wyboru w odniesieniu do kąta bazowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obróć (  ): 

• Na wstążce wybierz polecenie Edycja > Obróć (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Obróć. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Obróć. 

• Wpisz rotate i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt obrotu. 

4 W razie potrzeby wybierz opcję Kopiuj, aby obrócić kopię wybranych jednostek. 

5 W oknie dialogowym wybierz opcję Kąt bazowy. 

6 Określ kąt bazowy, a następnie nowy kąt. 
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Aby obrócić obiekt w odniesieniu do kąta bazowego, wybierz obiekt (A), określ punkt obrotu (B), wybierz 
kąt bazowy i ponownie wybierz punkt (B) (lub wpisz symbol @), określ drugi punkt (C), a następnie 
określ punkt reprezentujący nowy kąt (D). 

 

Istnieją również inne sposoby rotacji jednostek. 

Wybrane elementy można przenosić, kopiować i obracać za pomocą jednego polecenia. 

Wybierz narzędzie ekspresowe Przenieś/Kopiuj/Obróć lub wpisz mocoro. 

 
Możesz obracać tekst jednowierszowy, wielowierszowy, definicje atrybutów i tekst 

atrybutów blokowych za pomocą narzędzia ekspresowego, które ma wygodną opcję 

wyboru obrotu, który jest najłatwiejszy do odczytania. Wybierz narzędzie ekspresowe 

Obróć tekst lub wpisz torient. 
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Zmiana kolejności jednostek 

Gdy wiele jednostek nakłada się na siebie, można zmienić kolejność ich 

wyświetlania i drukowania. Jednostki można przesuwać do przodu, do tyłu, na 

wierzch lub pod inną jednostkę. 

Można również zmienić kolejność rysowania kreskowań, tak aby były one 

rysowane i drukowane za wszystkimi innymi elementami na rysunku. 

W przypadku tekstu, wymiarów i liderów łatwo jest przenieść je na przód innych 

jednostek. Jeśli jednak są one częścią bloku lub zewnętrznego odniesienia, nie są 

przenoszone na przód. 
 

Aby zmienić kolejność podmiotów: 

1 Wykonaj jedną z poniższych czynności, aby wybrać Draw Order (  ): 

• Na wstążce wybierz Strona główna > Modyfikuj ekspander > Przód, Tył, 

Powyżej lub Poniżej; Edytuj > Przód, Tył, Powyżej lub Poniżej (w 

DrawOrder); lub Narzędzia > Kolejność rysowania (w Zarządzaj). 

• W menu wybierz Narzędzia (lub Modyfikuj) > Kolejność rysowania > Przód, 

Tył, Powyżej lub Poniżej. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Kolejność rysowania lub użyj paska 

narzędzi Kolejność rysowania. 

• Wpisz draworder i naciśnij Enter. 

2 Wybierz jednostkę, której kolejność chcesz zmienić, a następnie naciśnij klawisz Enter. 

3 W oknie zachęty określ nową kolejność rysowania, a następnie naciśnij klawisz Enter. 

4 Jeśli zmieniasz kolejność powyżej lub poniżej, wybierz jednostkę, nad którą lub 

pod którą ma znajdować się pierwsza jednostka, a następnie naciśnij klawisz 

Enter. 
 

Zmienna systemu SORTENTS włącza się automatycznie. 

Zmienna systemowa SORTENTS włącza się automatycznie, co może mieć wpływ na 

wydajność systemu. 
 

 
Aby zmienić kolejność włazów z tyłu: 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Send Hatches Back (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Modyfikuj ekspander > 

Wyślij włazy z powrotem (w narzędziach Kolejność rysowania) lub wybierz 

kolejno opcje Edycja > Wyślij włazy z powrotem (w narzędziach Kolejność 

rysowania). 

• W menu wybierz Narzędzia (lub Modyfikuj) > Kolejność rysowania > Wyślij włazy z 

powrotem. 

• Na pasku narzędzi Draw Order - Annotation kliknij narzędzie Send Hatches Back. 

• Wpisz hatchtoback i naciśnij Enter. 

Liczba włazów, których to dotyczy, jest wyświetlana na pasku poleceń. 
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Aby zmienić kolejność tekstu, wymiarów lub liderów: 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Text to Front (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Modyfikuj ekspander > 

Przenieś tekst z przodu, Przenieś liderów z przodu, Przenieś wymiary z 

przodu, Przenieś wszystkie adnotacje z przodu (w narzędziach kolejności 

rysowania) lub Edytuj > Przenieś tekst z przodu, Przenieś liderów z przodu, 

Przenieś wymiary z przodu, Przenieś wszystkie adnotacje z przodu (w 

narzędziach kolejności rysowania). 

• W menu wybierz kolejno Narzędzia (lub Modyfikuj) > Kolejność rysowania > 

Przenieś tekst na przód, Przenieś liderów na przód, Przenieś wymiary na 

przód, Przenieś wszystkie adnotacje na przód. 

• Na pasku narzędzi Draw Order - Annotation kliknij narzędzie Bring Text 

Front, Bring Leaders Front, Bring Dimensions Front lub Bring All 

Annotations Front. 

• Wpisz texttofront i naciśnij Enter. 



 

Zmiana rozmiaru 
jednostek 
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Rozmiar jednostki lub zestawu jednostek można zmieniać poprzez rozciąganie, 

skalowanie, wydłużanie, przycinanie lub edytowanie ich długości. 

 

Podmioty rozciągające 

Rozmiar jednostek można zmienić, rozciągając je. Podczas rozciągania elementów 

należy je wybrać za pomocą okna przecięcia lub wielokąta przecięcia. Następnie należy 

określić odległość przesunięcia lub wybrać punkt bazowy i punkt przesunięcia. 

Jednostki, które przekraczają granicę okna lub wielokąta są rozciągane; te, które 

znajdują się całkowicie wewnątrz okna lub wielokąta są po prostu przesuwane. 
 

Aby rozciągnąć jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać Stretch (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Rozciąganie (w obszarze Edycja). 

• W menu wybierz opcję Modyfikuj > Rozciągnij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Rozciąganie. 

• Wpisz stretch i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Przekraczanie okna lub Przekraczanie wielokąta. 

3 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

4 Określ punkt bazowy. 

5 Określ drugi punkt przesunięcia. 

 
 

Aby rozciągnąć obiekty, zaznacz je za pomocą okna przecięcia (A) lub wielokąta przecięcia, a 
następnie określ punkt bazowy (B) i punkt przesunięcia (C). 

Aby rozciągnąć jednostkę za pomocą uchwytów, należy ją wybrać, aby wyświetlić 

jej uchwyty, a następnie wybrać uchwyt, aby stał się uchwytem aktywnym. Stanie się 

on punktem bazowym. Następnie należy przenieść aktywny uchwyt w nowe miejsce. 

Wybrany uchwyt zależy od typu modyfikowanej jednostki. Na przykład, aby 

rozciągnąć jeden z narożników prostokąta, wybierz uchwyt punktu narożnego. Aby 

rozciągnąć linię, wybierz uchwyt punktu końcowego. Nie wszystkie obiekty można 

rozciągać za pomocą uchwytów. 
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Aby rozciągnąć jednostkę za pomocą uchwytów 

1 Wybierz podmiot. 

2 Kliknij uchwyt, aby go aktywować. 

3 Przeciągnij uchwyt. 

4 Kliknij, aby zwolnić. 

 
 

 
Aby rozciągnąć jednostkę za pomocą 
uchwytów, wybierz jednostkę 
(A) , wybierz uchwyt (B) i przeciągnij go do 
nowej lokalizacji (C). 

 

Skalowanie jednostek 

Wynik. 

 

Rozmiar wybranej jednostki można zmienić, skalując ją względem punktu 

bazowego. Rozmiar elementu można zmienić, określając punkt bazowy i długość, 

która jest używana jako współczynnik skali oparty na bieżących jednostkach 

rysunkowych, lub określając współczynnik skali. Można również użyć współczynnika skali 

odnoszącego się do bazowego współczynnika skali, na przykład określając bieżącą 

długość i nową długość encji. 
 

Aby przeskalować zestaw wyboru o współczynnik skali 

1 Wykonaj jedną z poniższych czynności, aby wybrać Skalę (  ): 

• Na wstążce wybierz polecenie Edycja > Skaluj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Skaluj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Skala. 

• Wpisz scale, a następnie naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 Określ punkt bazowy. 

4 Określa współczynnik skali. 

 
 

 
Aby przeskalować jednostkę o współczynnik skali, wybierz 
jednostkę (A), a następnie 
określa punkt bazowy (B) i współczynnik skali. 

Wynik. 
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Niektóre jednostki można również skalować za pomocą uchwytów. Aby 

przeskalować element, należy go zaznaczyć, a następnie kliknąć uchwyt. Następnie 

można zmienić rozmiar jednostki, przesuwając uchwyt. Wybrany uchwyt zależy od 

typu modyfikowanej jednostki. Na przykład, aby przeskalować okrąg, wybierz 

uchwyt punktu kwadrantu. 
 

Aby skalować jednostkę za pomocą uchwytów 

1 Wybierz podmiot. 

2 Kliknij uchwyt, aby go wybrać. 

3 Przeciągnij uchwyt. 

4 Kliknij, aby zwolnić. 

 
 

 
Aby skalować za pomocą uchwytów, wybierz jednostkę 
(A), kliknij uchwyt (B) i skaluj jednostkę, przeciągając 
uchwyt do nowej lokalizacji (C). 

Wynik. 

 
 

 

Użyj polecenia Przenieś/Kopiuj/Obróć. 

Wybrane elementy można przenosić, kopiować, obracać i skalować za pomocą 

jednego polecenia. Wybierz narzędzie ekspresowe Przenieś/Kopiuj/Obróć lub wpisz 

MOCORO. 
 

 

Aby przeskalować wybrane jednostki tekstowe, użyj narzędzia Skaluj tekst lub wpisz 

SCALETEXT. 
 

 
Rozszerzanie jednostek 

Można rozszerzyć encje tak, aby kończyły się na granicy zdefiniowanej przez inne 

encje. Można również rozszerzyć encje do punktu, w którym przecinałyby one 

domniemaną krawędź graniczną. Podczas rozszerzania jednostek należy najpierw 

wybrać krawędzie graniczne, a następnie określić jednostki do rozszerzenia, 

wybierając je pojedynczo, używając metody wyboru ogrodzenia lub metody wyboru 

projekcji. 

Można rozszerzać łuki, linie, dwuwymiarowe polilinie i promienie. Łuki, okręgi, 

elipsy, linie, splajny, polilinie, promienie, nieskończone linie i rzutnie na karcie 

Układ mogą działać jako krawędzie graniczne. 
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Aby rozszerzyć jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extend (  ): 

• Na wstążce wybierz Edytuj > Rozszerz (w sekcji Modyfikuj). 

• W menu wybierz Modyfikuj > Rozszerz. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Rozszerz. 

• Wpisz extend i naciśnij Enter. 

2 Wybierz jedną lub więcej jednostek jako krawędzie graniczne, a następnie naciśnij Enter. 

3 Wybierz jednostkę do rozszerzenia. 

4 Wybierz inną jednostkę do rozszerzenia lub naciśnij Enter, aby zakończyć polecenie. 

 

 
Aby rozszerzyć encje, wybierz krawędź graniczną (A), a następnie 
wybierz jednostki do rozszerzenia (B). 

Aby rozszerzyć jednostkę do domniemanej 
granicy 

1 Wykonaj jedną z poniższych czynności, aby wybrać 

opcję Extend (  ): 

• Na wstążce wybierz Edytuj > Rozszerz (w sekcji 

Modyfikuj). 

• W menu wybierz Modyfikuj > Rozszerz. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie 

Rozszerz. 

• Wpisz extend i naciśnij Enter. 

Wynik. 

 

2 Wybierz jedną lub więcej krawędzi granicznych, a następnie naciśnij Enter. 

3 W oknie dialogowym wybierz opcję Edge Mode. 

4 W oknie dialogowym wybierz opcję Rozszerz. 

5 Wybierz jednostkę do rozszerzenia. 

6 Wybierz inną jednostkę do rozszerzenia lub naciśnij Enter, aby zakończyć polecenie. 
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Wybierz krawędź graniczną (A), a następnie wybierz 
jednostki do rozszerzenia (B). 

 
 
 
 
 
 
 
 
 
 
 

 
Wynik. 

 

Aby rozszerzyć kilka jednostek przy użyciu metody wyboru ogrodzenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extend (  ): 

• Na wstążce wybierz Edytuj > Rozszerz (w sekcji Modyfikuj). 

• W menu wybierz Modyfikuj > Rozszerz. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Rozszerz. 

• Wpisz extend i naciśnij Enter. 

2 Wybierz jedną lub więcej krawędzi granicznych, a następnie naciśnij Enter. 

3 W oknie dialogowym wybierz opcję Fence. 

4 Określ pierwszy punkt ogrodzenia. 

5 Określ drugi punkt ogrodzenia. 

6 Określ następny punkt ogrodzenia lub naciśnij Enter, aby zakończyć polecenie. 

 

 

 
Wybierz krawędź graniczną (A), a następnie określ pierwszy 
punkt (B) i drugi punkt (C) ogrodzenia. 

Wynik. 
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Po rozciągnięciu szerokiej polilinii jej linia środkowa przecina krawędź graniczną. 

Ponieważ koniec polilinii jest zawsze cięty pod kątem 90 stopni, część polilinii może 

rozciągać się poza krawędź graniczną. Zwężająca się polilinia zwęża się aż do 

przecięcia z krawędzią graniczną. Jeśli skutkowałoby to ujemną szerokością 

polilinii, szerokość końcowa zmienia się na 0. 

 

 
Zwężająca się polilinia (A) zwęża się aż do przecięcia się z 
linią 
krawędź graniczna (B). 

Wynik. 

 
 

Podmioty przycinające 

Jednostki można przycinać tak, aby kończyły się na jednej lub kilku domniemanych 

krawędziach tnących zdefiniowanych przez inne jednostki. Można także przycinać 

elementy do punktu, w którym przecinałyby domniemaną krawędź tnącą. Podczas 

przycinania jednostek należy najpierw zaznaczyć krawędzie tnące, a następnie 

określić jednostki do przycięcia, zaznaczając je pojedynczo lub przy użyciu metody 

zaznaczania paserów. 

Można przycinać łuki, okręgi, linie, otwarte dwuwymiarowe i trójwymiarowe 

polilinie oraz promienie. Łuki, okręgi, linie, polilinie, promienie, nieskończone linie i 

rzutnie na karcie Układ mogą działać jako krawędzie tnące. Jednostka może być 

zarówno krawędzią tnącą, jak i jedną z przycinanych jednostek. 
 

Aby przyciąć jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przytnij (  ): 

• Na wstążce wybierz polecenie Edycja > Przytnij (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Przytnij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przytnij. 

• Wpisz trim i naciśnij Enter. 

2 Wybierz jedną lub więcej krawędzi tnących, a następnie naciśnij Enter. 

3 Wybierz jednostkę do przycięcia. 

4 Wybierz inną jednostkę do przycięcia lub naciśnij Enter, aby zakończyć polecenie. 
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Aby przyciąć elementy, wybierz krawędź tnącą (A), a 
następnie wybierz elementy do przycięcia (B). 

Aby przyciąć jednostkę do domniemanej 
granicy 

1 Wykonaj jedną z poniższych czynności, aby 

wybrać opcję Przytnij (  ): 

• Na wstążce wybierz polecenie Edycja > 

Przytnij (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Przytnij. 

• Na pasku narzędzi Modyfikuj kliknij 

narzędzie Przytnij. 

• Wpisz trim i naciśnij Enter. 

 

 

 

 

 

 

 

 

Wynik. 

 

2 Wybierz jedną lub więcej krawędzi tnących, a następnie naciśnij Enter. 

3 W oknie dialogowym wybierz opcję Edge Mode. 

4 W oknie dialogowym wybierz opcję Rozszerz. 

5 Wybierz jednostkę do przycięcia. 

6 Wybierz inną jednostkę do przycięcia lub naciśnij Enter, aby zakończyć polecenie. 
 

 
Wybierz zakładaną krawędź graniczną (A), a 
następnie wybierz elementy do przycięcia (B). 

Wynik. 

 

Aby przyciąć kilka podmiotów przy użyciu metody wyboru ogrodzenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przytnij (  ): 

• Na wstążce wybierz polecenie Edycja > Przytnij (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Przytnij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przytnij. 

• Wpisz trim i naciśnij Enter. 

2 Wybierz jedną lub więcej krawędzi tnących, a następnie naciśnij Enter. 

3 W oknie dialogowym wybierz opcję Fence. 

4 Określ pierwszy punkt ogrodzenia. 

5 Określ drugi punkt ogrodzenia. 

6 Określ następny punkt ogrodzenia lub naciśnij Enter, aby zakończyć polecenie. 
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Wybierz krawędź graniczną (A), a następnie określ 
pierwszą krawędź graniczną (A). 
punkt (B) i drugi punkt (C) ogrodzenia. 

 

Edytowanie długości 
jednostek 

Wynik. 

 

Można zmienić długość elementów lub kąt łuków. Użyj jednej z poniższych metod, 

aby zmienić długość elementu: 

• Dynamicznie przeciągnij punkt końcowy lub kąt. 

• Określa przyrostową długość lub kąt mierzony od punktu końcowego. 

• Określ nową długość jako procent całkowitej długości lub kąta. 

• Określ nową długość lub kąt. 

Można zmieniać długość łuków, linii i otwartych polilinii. 
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Aby zmienić długość jednostki poprzez przeciągnięcie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj długość (  ): 

• Na wstążce wybierz Edytuj > Edytuj długość (w Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Edytuj długość. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj długość. 

• Wpisz editlen i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Dynamic. 

3 Wybierz jednostkę, którą chcesz zmienić. 

4 Określ nowy punkt końcowy lub dołączony kąt. 

 

 

 
Wybierz jednostkę (A), a następnie 
wybierz nową jednostkę (A). 
punkt końcowy (B). 

Wynik. 
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Dzielenie i łączenie jednostek 
 

Jednostki można rozbijać i łączyć przy użyciu następujących metod: 

• Rozbicie - rozdzielenie pojedynczej jednostki na dwie części, usuwając przy tym 

część jednostki. 

• Join - połączenie dwóch jednostek w jedną jednostkę. 

• Rozbij - rozdziela złożoną całość, taką jak blok lub polilinia, na różne części 

składowe. 

• Group - łączy wiele podmiotów, aby zachowywały się jak pojedyncza jednostka. 

 
Jednostki rozbijające 

Można łamać łuki, okręgi, elipsy, linie, polilinie, promienie i linie nieskończone. 

Podczas łamania jednostek należy określić dwa punkty łamania. Domyślnie punkt użyty 

do wybrania encji staje się pierwszym punktem łamania; można jednak użyć opcji Pierwszy, 

aby wybrać punkt łamania inny niż ten, który wybiera encję. 
 

Aby złamać jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przerwa (  ): 

• Na wstążce wybierz Edytuj > Przerwij (w Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Przerwij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przerwij. 

• Wpisz break i naciśnij Enter. 

2 Wybierz podmiot. 

3 Określ drugi punkt przerwania. 

 
 

 
Wybierz jednostkę (A), a następnie określ punkt 
przerwania (B). 

Wynik. 
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Aby wybrać podmiot, a następnie określić dwa punkty przerwania 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przerwa (  ): 

• Na wstążce wybierz polecenie Edycja > Przerwij (w sekcji Modyfikuj). 

• W menu wybierz Modyfikuj > Przerwij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Przerwij. 

• Wpisz break i naciśnij Enter. 

2 Wybierz podmiot. 

3 W oknie dialogowym wybierz opcję First. 

4 Określ pierwszy punkt przerwania. 

5 Określ drugi punkt przerwania. 

 

 
Wybierz podmiot (A), a następnie określ pierwszy 
(B) i drugi (B). 
drugi (C) break point. 

Wynik. 

 
 

 

Jednostkę można podzielić na dwie części bez usuwania jej części. 

Określ ten sam punkt dla pierwszego i drugiego punktu przerwania, wpisując znak at 

(@) i naciskając Enter zamiast określania drugiego punktu przerwania. 
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Łączenie podmiotów 

Można połączyć dwa elementy w jeden element. Można połączyć dwie linie lub 

dwa łuki. Dwie linie muszą być współliniowe; dwa łuki muszą mieć ten sam punkt 

środkowy i promień. 

Podczas łączenia dwóch linii najdalsze punkty końcowe pozostają w swoich 

dotychczasowych lokalizacjach; program rysuje nową linię między tymi punktami. Łuki 

są łączone w kierunku przeciwnym do ruchu wskazówek zegara, od pierwszego 

wybranego łuku do drugiego. 

 

Polecenie Edytuj polilinię służy do łączenia jednostek i polilinii. 

Więcej szczegółów znajduje się w sekcji "Łączenie polilinii" na stronie 384 w tym rozdziale. 
 

 
Aby połączyć dwa podmioty 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dołącz (  ): 

• Na wstążce wybierz polecenie Edycja > Dołącz (w sekcji Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Dołącz. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Dołącz. 

• Wpisz join i naciśnij Enter. 

2 Wybierz pierwszy łuk lub linię. 

3 Wybierz drugi łuk lub linię. 
 

 
Wybierz pierwszy łuk lub linię (A), a następnie 
wybierz opcję 
drugi łuk lub linia (B). 

Wynik. 

 
 

 

Komenda Overkill może również łączyć jednostki. 

Jeśli rysunek zawiera nakładające się lub zduplikowane elementy, które chcesz 

połączyć, na przykład polilinie ze zbyt dużą liczbą wierzchołków, możesz użyć 

polecenia Overkill, aby oczyścić rysunek. 
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Eksplodujące jednostki 

Złożoną jednostkę, taką jak blok lub polilinia, można przekonwertować z 

pojedynczej jednostki na jej części składowe. Rozbicie polilinii, prostokąta, pączka, 

wielokąta, wymiaru lub linii odniesienia redukuje je do zbioru pojedynczych 

elementów liniowych i łukowych, które można następnie indywidualnie 

modyfikować. 

Bloki są konwertowane na poszczególne jednostki, w tym ewentualnie inne, 

zagnieżdżone bloki, które tworzyły oryginalną jednostkę. Podczas eksplodowania 

bloków można również użyć polecenia Eksploduj atrybuty, aby rozgrupować bloki, 

tworząc osobne jednostki dla każdego elementu i konwertując atrybuty na tekst. 

Powstałe w ten sposób rozbite encje są umieszczane na warstwie bloku (a nie na 

warstwie oryginalnych encji), podczas gdy rozbite atrybuty są umieszczane na 

warstwie oryginalnego atrybutu. Polecenie Eksploduj atrybuty jest najlepsze, jeśli 

chcesz eksplodować blok z atrybutami i zachować ten sam wygląd wizualny dla 

właściwości i tekstu. Jeśli jednak chcesz rozbić blok, aby zmodyfikować definicję 

bloku i ponownie go zdefiniować, powinieneś użyć polecenia Rozbij, a nie Rozbij 

atrybuty. 

Eksplozja tekstu wielowierszowego lub jednowierszowego za pomocą polecenia 

Eksplozja tekstu redukuje tekst do polilinii. 

Z następującymi wyjątkami, eksplodowanie jednostki zwykle nie ma widocznego 

wpływu na rysunek: 

• Jeśli oryginalna polilinia miała szerokość, informacje o szerokości zostaną 

utracone po jej rozwinięciu. Powstałe linie i łuki podążają za linią środkową 

oryginalnej polilinii. 

• Jeśli blok zawierający atrybuty zostanie rozbity, atrybuty zostaną utracone, ale 

oryginalne definicje atrybutów pozostaną. 

• Kolory, typy linii, grubości linii i style drukowania przypisane BYBLOCK mogą 

być różne po eksplodowaniu jednostki, ponieważ przyjmą one domyślny kolor, 

typ linii, grubość linii i styl drukowania, dopóki nie zostaną wstawione do 

innego bloku. 
 

Aby eksplodować jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksplozja (  ): 

• Na wstążce wybierz kolejno Home > Explode (w oknie Modify) lub Edit > 

Explode (w oknie Modify). 

• W menu wybierz Modyfikuj > Rozbij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Eksplozja. 

• Wpisz explode i naciśnij Enter. 

2 Wybierz jednostki do eksplozji. 

3 Naciśnij Enter. 
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Aby rozwinąć tekst wielowierszowy lub jednowierszowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Rozbij tekst (  ): 

• Na wstążce wybierz kolejno Express Tools > Explode Text (in Text). 

• W menu wybierz kolejno Express Tools > Text > Explode Text. 

• Wpisz txtexp i naciśnij Enter. 

2 Wybierz tekst do eksplozji. 

3 Naciśnij Enter. 
 

Eksplozja bocka i jego atrybutów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksploduj atrybuty (  ): 

• Na wstążce wybierz kolejno Express Tools > Explode Attributes (in Blocks). 

• W menu wybierz Express Tools > Blocks > Explode Attributes. 

• Wpisz burst i naciśnij Enter. 

2 Wybierz bloki z atrybutami, które chcesz eksplodować. 

3 Naciśnij Enter. 
 

Aby eksplodować encję i określić właściwości wynikowych encji 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xplode (  ): 

• Na wstążce wybierz Edytuj > Xplode (w Modyfikuj). 

• W menu wybierz Modyfikuj > Xplode. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Xplode. 

• Wpisz xplode i naciśnij Enter. 

2 Wybierz jednostki do eksplozji. 

3 Wybierz opcję: 

• Wszystkie - wyświetla monity o określenie wszystkich dostępnych 

właściwości: koloru, warstwy, rodzaju linii i grubości linii. 

• Kolor - Wprowadź kolor. Można wprowadzić kolor indeksu, kolor 

rzeczywisty lub kolor z książki kolorów. 

• Warstwa - Wprowadź warstwę dla jednostek wynikowych. 

• LType - Wprowadź typ linii dla wynikowych jednostek. 

• LWeight - Wprowadź wagę linii dla wynikowych jednostek. 

• Dziedzicz - eksploduje wybrane jednostki i przypisuje podjednostkom ten sam 

kolor, warstwę, typ linii i grubość linii, co jednostce nadrzędnej, jeśli warstwa 

jednostki podrzędnej ma wartość 0, a inne właściwości mają wartość 

BYBLOCK. 

• Eksploduj - eksploduje wybrane elementy w taki sam sposób, jak 

polecenie Eksploduj. 
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Grupowanie podmiotów 

Grupa to zbiór podmiotów zapisanych razem jako jedna jednostka. Po wybraniu 

jednostek, które należą do grupy, można później dodać więcej jednostek, usunąć jednostki 

i zmienić ich kolejność. W razie potrzeby można również w dowolnym momencie 

rozgrupować jednostki, aby pracować z nimi osobno. 

 

Tworzenie grup 
Podczas tworzenia grupy należy wprowadzić jej nazwę i opis, a następnie wybrać 

jednostki dla grupy. 
 

Aby utworzyć grupę 

1 Wykonaj jedną z poniższych czynności, aby wybrać Grupę (  ): 

• Na wstążce wybierz Strona główna > Grupa (w aplikacji Narzędzia) lub 

Narzędzia > Grupa (w aplikacji Zarządzaj). 

• W menu wybierz Narzędzia > Grupa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Grupa. 

• Wpisz group, a następnie naciśnij Enter. 

2 W sekcji Utwórz nową grupę wprowadź nazwę i opis grupy. 

3 Kliknij opcję Możliwość wyboru, jeśli chcesz, aby wszystkie jednostki w grupie 

zostały wybrane po wybraniu jednej jednostki z grupy na rysunku. 

4 Kliknij Wybierz podmioty i Utwórz grupę. 

5 Wybierz jednostki dla grupy, a następnie naciśnij Enter. 

6 W oknie dialogowym Grupa kliknij przycisk OK. 
 

Jednostki można wybierać za pomocą grup. 

Wprowadź nazwę grupy na pasku poleceń podczas wybierania podmiotów. 
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Okno dialogowe Grupa steruje ustawieniami wszystkich grup na rysunku. 
 

 
Modyfikowanie grup 

Aby zmodyfikować grupę i jej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Grupę (  ): 

• Na wstążce wybierz kolejno Home > Group (w Utilities). 

• W menu wybierz Narzędzia > Grupa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Grupa. 

• Wpisz group, a następnie naciśnij Enter. 

2 Wybierz grupę, którą chcesz zmodyfikować. 

3 W sekcji Modyfikuj wybraną grupę wykonaj co najmniej jedną z poniższych czynności: 

• Wprowadź nową nazwę, a następnie kliknij przycisk Zmień nazwę grupy. 

• Wprowadź nowy opis, a następnie kliknij przycisk Zmień opis grupy. 

• Wybierz, czy grupa ma być wybierana na rysunku. 
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• Kliknij przycisk Dodaj jednostki do grupy, wybierz jednostki, które chcesz 

dodać do grupy, a następnie naciśnij klawisz Enter. 

• Kliknij przycisk Remove Entities from Group, wybierz podmioty do usunięcia 

z grupy, a następnie naciśnij klawisz Enter. 

4 W oknie dialogowym Grupa kliknij przycisk OK. 
 

Aby zmienić kolejność podmiotów w grupie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Grupę (  ): 

• Na wstążce wybierz kolejno Home > Group (w Utilities). 

• W menu wybierz Narzędzia > Grupa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Grupa. 

• Wpisz group, a następnie naciśnij Enter. 

2 W sekcji Modyfikuj wybraną grupę kliknij opcję Zmień kolejność podmiotów. 

3 W oknie dialogowym Zmień kolejność pogrupowanych jednostek wybierz grupę, której 

kolejność chcesz zmienić. 

4 Aby zobaczyć kolejność podmiotów w grupie, kliknij przycisk Wyróżnij. 

Postępuj zgodnie z wyświetlanymi instrukcjami, aby wyświetlić jednostki jedna 

po drugiej. 

5 Aby odwrócić kolejność wszystkich podmiotów w grupie, kliknij przycisk Odwróć 

kolejność. 

6 Aby zmienić kolejność określonych podmiotów lub zakresu podmiotów: 

• W polu Usuń z pozycji wprowadź bieżącą pozycję podmiotu. 

• W polu Place to Position wprowadź nową pozycję podmiotu. 

• W polu Liczba podmiotów wprowadź liczbę podmiotów lub zakres 

podmiotów do zmiany kolejności. Na przykład, jeśli zmieniasz kolejność 

tylko jednej jednostki, wprowadź 1. 

• Kliknij przycisk Zmień kolejność. 

Jednostki w grupie są ponumerowane 0, 1, 2, 3 itd. 

7 Kliknij przycisk OK, a następnie kliknij ponownie przycisk OK. 
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Rozgrupowywanie jednostek 
Po rozgrupowaniu jednostek, jednostki pozostają na rysunku, ale grupa jest usuwana 

z rysunku. 
 

Aby rozgrupować jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Grupę (  ): 

• Na wstążce wybierz kolejno Home > Group (w Utilities). 

• W menu wybierz Narzędzia > Grupa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Grupa. 

• Wpisz group, a następnie naciśnij Enter. 

2 Wybierz grupę do usunięcia. 

3 W sekcji Modyfikuj wybraną grupę kliknij opcję Rozgrupuj jednostki. 

4 Kliknij przycisk OK. 

 

 

Edycja polilinii 
 

Można modyfikować dowolny typ dwuwymiarowej lub trójwymiarowej polilinii. 

Jednostki takie jak prostokąty, wielokąty i pączki, a także jednostki trójwymiarowe, 

takie jak piramidy, cylindry i kule, są odmianami polilinii, które można edytować. 

Polilinię można edytować, otwierając ją lub zamykając, zmieniając jej całkowitą 

szerokość lub szerokość poszczególnych segmentów, a także konwertując polilinię z 

prostymi segmentami na płynną krzywą lub przybliżenie splajnu. Ponadto narzędzie 

Edytuj polilinię umożliwia edycję poszczególnych wierzchołków, dodawanie, 

usuwanie lub przenoszenie wierzchołków. Można także dodawać nowe segmenty do 

istniejącej polilinii, zmieniać typy linii polilinii oraz odwracać kierunek lub 

kolejność wierzchołków. 

 

Konwersja encji na polilinię 

Aby zmodyfikować polilinię, należy ją najpierw zaznaczyć, a następnie wybrać 

opcję edycji polilinii. Dostępne opcje różnią się w zależności od tego, czy wybrana 

polilinia jest obiektem dwuwymiarowym czy trójwymiarowym. Jeśli wybrana 

jednostka nie jest polilinią, narzędzie Edytuj polilinię umożliwia przekształcenie jej 

w polilinię. W polilinie można przekształcać tylko łuki i linie. Jeśli kilka łuków lub 

linii jest połączonych punktami końcowymi, można je wszystkie zaznaczyć i 

przekształcić w jedną polilinię. 
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Aby przekonwertować encję na polilinię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz podmiot. 

3 W oknie dialogowym wybierz opcję Tak - przekształć w polilinię. 

4 W oknie zachęty wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 

Otwieranie i zamykanie polilinii 

Podczas zamykania polilinii program rysuje prosty segment polilinii od ostatniego 

wierzchołka polilinii do pierwszego wierzchołka. Otwarcie polilinii powoduje 

usunięcie segmentu zamykającego. Po wybraniu polilinii do edycji, w oknie zachęty 

wyświetlana jest opcja Otwórz lub Zamknij, w zależności od tego, czy wybrana 

polilinia jest zamknięta czy otwarta. 
 

Aby zamknąć otwartą polilinię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie zachęty wybierz opcję Zamknij. 

4 W oknie monitu wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 
 

 
Zamknięcie otwartej polilinii dodaje 
prostą 
odcinek polilinii między pierwszym (A) i 
ostatnim 
(B) wierzchołki. 

Wynik. 
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Zakrzywianie i dekurowanie polilinii 

Polilinię wielosegmentową można przekształcić w gładką krzywą za pomocą opcji 

Dopasuj lub Splajn. Opcja Fit tworzy gładką krzywą łączącą wszystkie wierzchołki. 

Opcja Spline oblicza gładką krzywą, która jest przyciągana do wierzchołków, ale 

przechodzi tylko przez pierwszy i ostatni wierzchołek. Opcja Decurve usuwa krzywe 

i łuki Fit lub Spline, pozostawiając proste odcinki między wierzchołkami. 
 

Aby dopasować krzywą do polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz opcję Dopasuj. 

4 W oknie zachęty wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 
 

Oryginalna polilinia. Po zastosowaniu krzywej dopasowania. Po zastosowaniu splajnu. 
 

Łączenie polilinii 

Do istniejącej otwartej polilinii można dodać jednostkę łuku, linii lub polilinii, 

tworząc jedną ciągłą jednostkę polilinii. Aby dołączyć jednostkę do polilinii, 

jednostka ta musi już współdzielić punkt końcowy z wierzchołkiem końcowym 

wybranej polilinii. 

Podczas dołączania jednostki do polilinii, szerokość nowego segmentu polilinii 

zależy od szerokości oryginalnej polilinii i typu jednostki, która jest do niej 

dołączana: 

• Linia lub łuk przyjmuje taką samą szerokość jak segment polilinii dla 

końcowego wierzchołka, do którego jest dołączony. 

• Polilinia połączona z polilinią zwężającą się zachowuje swoje własne wartości szerokości. 
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• Polilinia połączona z polilinią o jednakowej szerokości przyjmuje szerokość 

polilinii, z którą jest połączona. 

 

Polecenie Join służy do łączenia łuków i linii. 

Więcej informacji można znaleźć w sekcji "Łączenie podmiotów" na stronie 376 w tym 

rozdziale. 
 

 
Aby dołączyć łuk, linię lub polilinię do istniejącej polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz opcję Dołącz. 

4 Wybierz łuk, linię lub polilinię do połączenia. 

5 W oknie zachęty wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 

Zmiana szerokości polilinii 

Można zmienić szerokość całej polilinii, stosując jednolitą szerokość do całej 

jednostki lub zwężając polilinię równomiernie na całej jej długości. 
 

Aby zastosować jednolitą szerokość do całej polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz opcję Szerokość. 

4 Określa nową szerokość polilinii. 

5 W oknie zachęty wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 
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Aby równomiernie zwęzić polilinię wzdłuż jej długości 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz opcję Taper. 

4 Określ szerokość początkową. 

5 Określ szerokość końcową. 

6 W oknie zachęty wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 

Edycja wierzchołków polilinii 

Możesz użyć opcji Edytuj wierzchołki, aby zmodyfikować poszczególne 

wierzchołki polilinii. Po wybraniu tej opcji program przełącza się w specjalny tryb 

edycji wierzchołków i umieszcza znak x na pierwszym wierzchołku. Znak x 

wskazuje edytowany wierzchołek. Opcje Next (Następny) i Previous (Poprzedni) 

przenoszą znak x do następnego lub poprzedniego wierzchołka. W danym momencie 

można edytować tylko jeden wierzchołek. 

Podczas edycji wierzchołków można modyfikować polilinię na następujące sposoby: 

• Przekształcenie segmentu polilinii w krzywą poprzez określenie nowego kąta stycznej. 

• Podział polilinii na dwie oddzielne polilinie. 

• Wstawia nowy wierzchołek za bieżącym wierzchołkiem. 

• Przesunięcie bieżącego wierzchołka. 

• Wyprostuj segment polilinii między dwoma wierzchołkami. 

• Zmiana szerokości segmentu polilinii między dwoma wierzchołkami. 
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Aby przesunąć wierzchołek polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz Edytuj wierzchołki. 

4 W oknie dialogowym wybierz opcję Następny wierzchołek. 

Powtarzaj tę czynność, aż x osiągnie wierzchołek, który chcesz przesunąć. 

5 W oknie dialogowym wybierz opcję Przenieś. 

6 Określa nową lokalizację wierzchołka. 

7 W oknie dialogowym wybierz inną opcję lub wybierz Wyjdź, aby zakończyć edycję 

wierzchołków. 

8 W oknie monitu wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 
 

 
Wybierz polilinię (A), przesuń bieżący 
wierzchołek 
do wierzchołka, który chcesz przenieść (B), a 
następnie określ nową lokalizację wierzchołka 
(C). 

Wynik. 
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Aby zmniejszyć szerokość pojedynczego segmentu polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj polilinię (  ): 

• Na wstążce wybierz polecenie Edycja > Edytuj polilinię (w obszarze Modyfikuj). 

• Z menu wybierz polecenie Modyfikuj > Edytuj polilinię. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj polilinię. 

• Wpisz editpline i naciśnij Enter. 

2 Wybierz polilinię. 

3 W oknie dialogowym wybierz Edytuj wierzchołki. 

4 W oknie dialogowym wybierz opcję Następny wierzchołek. 

Powtarzaj tę czynność, aż x osiągnie pierwszy wierzchołek segmentu, który chcesz zwęzić. 

5 W oknie dialogowym wybierz opcję Szerokość. 

6 Określ szerokość początkową. 

7 Określ szerokość końcową. 

8 W oknie dialogowym wybierz inną opcję lub wybierz Wyjdź, aby zatrzymać 

edycję wierzchołków i zaktualizować ekran. 

9 W oknie monitu wybierz inną opcję lub wybierz Gotowe, aby zakończyć 

polecenie. 

 
 

 
Wybierz polilinię (A), przesuń znacznik 
bieżącego wierzchołka do pierwszego 
wierzchołka segmentu, który chcesz zwęzić (B), 
a następnie określ nową szerokość początkową i 
końcową dla tego segmentu. 

Wynik. 



 

Jednostki fazujące i filetujące 
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Elementy można fazować lub zaokrąglać. Fazowanie łączy dwie nierównoległe 

jednostki za pomocą linii w celu utworzenia ściętej krawędzi. Zaokrąglenie łączy 

dwa obiekty łukiem o określonym promieniu, tworząc zaokrągloną krawędź. Jeśli 

oba obiekty, z którymi pracujesz, znajdują się na tej samej warstwie, fazowanie lub 

zaokrąglenie jest rysowane na tej warstwie. Jeśli obiekty znajdują się na różnych 

warstwach, sfazowanie lub zaokrąglenie jest rysowane na bieżącej warstwie. 

 

Modyfikowanie ustawień fazowania i zaokrąglania 

Ustawienia Faza/Fazowanie w oknie dialogowym Ustawienia rysunku kontrolują 

ustawienia fazowania i zaokrąglania. Części elementów, które wykraczają poza fazę 

lub zaokrąglenie, są zwykle usuwane podczas tworzenia fazy lub zaokrąglenia. 

Można jednak zachować te oryginalne elementy, zmieniając ustawienia w oknie 

dialogowym. 
 

Aby zmodyfikować ustawienia fazowania i zaokrąglania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 W oknie dialogowym Ustawienia rysunku kliknij kartę Modyfikacja jednostki. 

3 Kliknij kartę Chamfer/Fillet i wybierz jedną z poniższych opcji: 

• Narożniki - Wybierz, aby usunąć lub zachować części elementów, które 

wykraczają poza fazę lub zaokrąglenie. 

• Promień zaokrąglenia - Określ promień zaokrąglenia lub kliknij Wybierz, aby 

go określić, wybierając dwa punkty na rysunku. 

• Odległości i kąty fazowania - podczas tworzenia fazowania można wybrać 

metodę odległość-odległość lub odległość-kąt. Metoda odległość-odległość 

tworzy fazę przy użyciu dwóch określonych odległości fazowania. Metoda 

odległość-kąt tworzy fazę przy użyciu określonej długości i kąta fazowania. 

4 Kliknij przycisk OK. 

 
Jednostki fazujące 

Można połączyć dwa nierównoległe elementy, wydłużając je lub przycinając, a 

następnie łącząc je linią w celu utworzenia ściętej krawędzi. Można fazować linie, 

polilinie, promienie i linie nieskończone. Podczas tworzenia fazowania można 

określić, jak daleko należy przyciąć elementy od ich przecięcia (metoda odległość-

odległość) lub określić długość fazowania i kąt, jaki tworzy wzdłuż pierwszego 

elementu (metoda odległość-kąt). 
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Podczas fazowania polilinii można fazować wiele segmentów między dwoma 

wybranymi segmentami polilinii lub fazować całą polilinię. 

 

Fazowanie dwóch elementów przy użyciu metody odległość-odległość 

Aby sfazować dwa elementy przy użyciu metody odległość-odległość 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Fazowanie (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Fazuj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Fazowanie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Fazowanie. 

• Wpisz chamfer i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Ustawienia fazowania. 

3 W oknie dialogowym Ustawienia rysunku kliknij kartę Modyfikacja jednostki. 

4 W sekcji Odległości i kąty fazowania kliknij opcję Odległość-odległość. 

5 W sekcji Odległości i kąty fazowania określ pierwszą i drugą odległość 

fazowania. 

6 Kliknij przycisk OK. 

7 Wybierz pierwszy podmiot. 

8 Wybierz drugi podmiot. 

 

Wybierz pierwszy (A) i drugi (B) element. Faza zostanie narysowana na podstawie odległości 
pierwszej (C) i drugiej (D) fazy. 
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Fazowanie dwóch elementów przy użyciu metody odległość-kąt 

Aby sfazować dwa elementy przy użyciu metody odległość-kąt 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Fazowanie (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Fazuj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Fazowanie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Fazowanie. 

• Wpisz chamfer i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Ustawienia fazowania. 

3 W oknie dialogowym Ustawienia rysunku kliknij kartę Modyfikacja jednostki. 

4 W sekcji Odległości i kąty fazowania kliknij opcję Odległość-kąt. 

5 W sekcji Odległości i kąty fazowania określ odległość i kąt fazowania. 

6 Kliknij przycisk OK. 

7 Wybierz pierwszy podmiot. 

8 Wybierz drugi podmiot. 

 
 

Wybierz pierwszy (A) i drugi (B) element. Na podstawie pomiaru odległości między pierwszym 
obiektem (C) i kąta (D) utworzonego z pierwszym obiektem rysowany jest wykres. 

 

Fazowanie wszystkich wierzchołków polilinii 

Aby sfazować wszystkie wierzchołki polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Fazowanie (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Fazuj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Fazowanie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Fazowanie. 

• Wpisz chamfer i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Polilinia. 

3 Wybierz polilinię. 
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Oryginalna polilinia. Wynik po fazowaniu. 
 

Fazowanie wybranych wierzchołków polilinii 

Aby sfazować wybrane wierzchołki polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Fazowanie (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Fazuj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Fazowanie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Fazowanie. 

• Wpisz chamfer i naciśnij Enter. 

2 Wybierz polilinię wzdłuż segmentu, w którym chcesz rozpocząć fazowanie. 

3 Wybierz polilinię wzdłuż segmentu, w którym chcesz zakończyć fazowanie. 

 
 

 
Wybierz polilinię wzdłuż segmentów 
(A) i (B). 

Wynik po fazowaniu. 
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Podmioty zajmujące się filetowaniem 

Można połączyć dwa obiekty łukiem o określonym promieniu, aby utworzyć 

zaokrągloną krawędź. Można zaokrąglać pary segmentów linii, proste segmenty 

polilinii, łuki, okręgi, promienie i linie nieskończone. Można także zaokrąglać linie 

równoległe, promienie i linie nieskończone. Podczas zaokrąglania polilinii można 

zaokrąglić wiele segmentów pomiędzy dwoma wybranymi segmentami lub całą 

polilinię. 

 

Filetowanie dwóch podmiotów 

Aby filetować dwa podmioty 

1 Wykonaj jedną z poniższych czynności, aby wybrać filet (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Zaokrąglij (w obszarze Modyfikuj). 

• W menu wybierz Modyfikuj > Filet. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zaokrąglenie. 

• Wpisz filet i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Fillet Settings. 

3 W oknie dialogowym Ustawienia rysunku określ promień zaokrąglenia. 

4 Kliknij przycisk OK. 

5 Wybierz pierwszy podmiot. 

6 Wybierz drugi podmiot. 

 
 

Wybierz pierwszy (A) i drugi (B) podmiot.  Wynik po wypełnieniu. 
 

Filetowanie całej polilinii 

Aby zaokrąglić całą polilinię 

1 Wykonaj jedną z poniższych czynności, aby wybrać filet (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Zaokrąglij (w obszarze Modyfikuj). 

• W menu wybierz Modyfikuj > Filet. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zaokrąglenie. 

• Wpisz filet i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Polilinia. 

3 Wybierz polilinię. 
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Wybierz polilinię (A). Wynik po wypełnieniu. 
 

Filetowanie wybranych wierzchołków polilinii 

Aby zaokrąglić wybrane wierzchołki polilinii 

1 Wykonaj jedną z poniższych czynności, aby wybrać filet (  ): 

• Na wstążce wybierz polecenie Modyfikuj > Zaokrąglij (w obszarze Modyfikuj). 

• W menu wybierz Modyfikuj > Filet. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zaokrąglenie. 

• Wpisz filet i naciśnij Enter. 

2 Wybierz polilinię wzdłuż segmentu, od którego chcesz rozpocząć zaokrąglenie. 

3 Wybierz polilinię wzdłuż segmentu, w którym chcesz zakończyć zaokrąglenie. 

 
 

 
Wybierz polilinię wzdłuż (A) i (B) 
segmenty. 

Wynik po filetowaniu. 

 

Podczas zaokrąglania okręgów i łuków między elementami może istnieć więcej niż 

jedno zaokrąglenie. Punkt, w którym zaznaczono elementy, określa zaokrąglenie. 
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Wybrane elementy (A i B).  Wyniki po wypełnieniu. 

Można zaokrąglać linie równoległe, półproste i linie nieskończone. Pierwszy 

element musi być linią lub półprostą; drugi element może być linią, półprostą lub 

linią nieskończoną. Średnica łuku zaokrąglenia jest zawsze równa odległości 

między równoległymi elementami. Bieżący promień zaokrąglenia jest ignorowany. 

 
 

Oryginalne podmioty. wynik po wypełnieniu. 
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Możesz wstawiać tekst do rysunku i kontrolować jego wygląd, umożliwiając 

dostarczanie dodatkowych informacji do rysunków ALCAD. W tej sekcji 

wyjaśniono, jak 

• Tworzenie tekstu liniowego, w tym wzdłuż łuku. 

• Tworzenie akapitów. 

• Tworzenie stylów tekstu. 

• Format tekstu. 

• Zmiana tekstu wiersza i akapitu. 

• Konwersja tekstu liniowego na tekst akapitowy. 

• Sprawdź pisownię tekstu. 

• Użyj alternatywnego edytora tekstu. 

• Praca z tekstem napisanym w różnych językach. 

 

 

 

 

 

 

 

 

Tematy w tym rozdziale 

Tworzenie tekstu liniowego  ............................................................................ 398 

Tworzenie tekstu akapitowego  ....................................................................... 400 
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Korzystanie z alternatywnego edytora tekstu ................................................. 421 

Praca z tekstem napisanym w językach .......................................................... 422 
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Tworzenie tekstu liniowego 
 

Najczęściej linie tekstu są tworzone za pomocą polecenia Tekst, które tworzy 

jednoliniowe jednostki tekstowe. Linię tekstu można również utworzyć wzdłuż łuku 

za pomocą polecenia Tekst wyrównany do łuku. 

 

Tworzenie wiersza tekstu 

Podczas tworzenia tekstu jednowierszowego każdy wiersz tekstu kończy się 

naciśnięciem klawisza Enter. Każdy wiersz tekstu jest tworzony jako osobna 

jednostka, którą można modyfikować. 
 

Aby utworzyć wiersz tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst (w adnotacji) lub 

Adnotacje > Tekst (w tekście). 

• W menu wybierz polecenie Rysuj > Tekst. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst. 

• Wpisz tekst i naciśnij klawisz Enter. 

2 Określa punkt wstawienia pierwszego znaku. 

3 Określa wysokość tekstu. 

4 Określa kąt obrotu tekstu. 

5 Wpisz tekst, a następnie naciśnij Enter na końcu każdej nowej linii. 

6 Aby zakończyć polecenie, naciśnij ponownie Enter. 

 

Jeśli tekst został już utworzony, nowy tekst może pojawić się bezpośrednio pod 

poprzednim tekstem. Wybierz polecenie Wstaw > Tekst. Po wyświetleniu monitu o 

punkt wstawienia naciśnij klawisz Enter. Nowy tekst zachowa tę samą wysokość i 

kąt obrotu, co poprzedni tekst. 
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Tworzenie pojedynczej linii tekstu wzdłuż łuku 

Można utworzyć pojedynczą linię tekstu umieszczoną wzdłuż łuku. Tekst 

wyrównany do łuku jest specjalnym typem jednostki tekstowej; nie jest dokładnie 

tym samym, co jednostka tekstu jednowierszowego. 
 

Aby utworzyć linię tekstu wzdłuż łuku 

1 Wykonaj jedną z poniższych czynności, aby wybrać tekst wyrównany łukiem (  ): 

• Na wstążce wybierz kolejno Express Tools > Arc-Aligned Text (w tekście). 

• W menu wybierz kolejno Express Tools > Text > Arc-Aligned Text. 

• Wpisz arctext i naciśnij Enter. 

2 Wybierz łuk, wzdłuż którego chcesz wyrównać tekst. 

3 W polu Tekst wpisz tekst. 

4 Wybierz opcje tekstu wyrównanego do łuku. 

5 Kliknij przycisk OK. 
 

P 

O 

A 
B N 
C M 
D 

L
 

E 

 
F K 

G J 

H I 

 
 
 

A Kliknięcie pozwala zachować układ tekstu 
względem łuku podczas przesuwania łuku. 

B Kliknij, aby odwrócić kierunek przepływu 
tekstu. 

C Kliknij, aby wyrównać tekst do lewej, prawej, 
dopasować (tekst wypełnia długość łuku) lub 
wyśrodkować. 

D Wybierz styl tekstu. 

E Wpisz tekst do wyświetlenia wzdłuż łuku. 

F Wpisz wysokość czcionki tekstu. 

G Wpisz współczynnik szerokości czcionki. 

H Wpisz odstępy między znakami. 

I Ta opcja nie jest dostępna, gdy wyrównanie 
jest ustawione do prawej i do środka łuku. 

 
J Wprowadź odstęp między tekstem a lewą 

krawędzią łuku. Ta opcja jest niedostępna, 
gdy wyrównanie jest ustawione do lewej i do 
środka łuku. 

K Wprowadź odstęp między łukiem a tekstem. 

L Wyświetla próbkę tekstu. 

M Kliknięcie powoduje skierowanie znaku 
tekstowego na zewnątrz lub do środka łuku. 

N Kliknij, aby ustawić kolor tekstu na 
BYLAYER, BYBLOCK, jeden ze 
standardowych kolorów lub wybierz opcję 
Wybierz kolor, aby uzyskać więcej opcji. 

O Kliknij, aby zastosować pogrubienie, 
kursywę i podkreślenie tekstu. 

P Kliknij, aby umieścić tekst po wypukłej lub 
wklęsłej stronie łuku. 
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Tworzenie tekstu akapitu 
 

Tekst akapitu składa się z jednego lub więcej wierszy tekstu lub akapitów, które 

mieszczą się w określonej przez użytkownika szerokości. Każda utworzona 

jednostka tekstu akapitu jest traktowana jako pojedyncza jednostka, niezależnie od 

liczby poszczególnych akapitów lub wierszy tekstu, które zawiera. 

Podczas tworzenia tekstu akapitu należy najpierw określić jego szerokość graniczną, 

określając przeciwległe rogi prostokąta. Tekst akapitu jest automatycznie zawijany 

tak, aby zmieścił się w tym prostokącie. Pierwszy narożnik prostokąta określa 

domyślny punkt dołączenia tekstu akapitu. Można określić kierunek, w którym tekst 

przepływa w obrębie prostokąta, a także wybrać format tekstu i akapitu, styl tekstu, 

wysokość tekstu i kąt obrotu całej jednostki tekstu akapitu. 
 

Aby utworzyć tekst akapitu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst wielowierszowy (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst wielowierszowy (w aplikacji 

Adnotacje). 

• W menu wybierz Rysuj > Tekst wielowierszowy. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst wielowierszowy. 

• Wpisz mtext i naciśnij Enter. 

2 Wybierz pierwszy róg obszaru tekstowego. 

3 Na pasku poleceń lub w menu kontekstowym opcjonalnie wybierz właściwości, 

które chcesz ustawić, lub przejdź bezpośrednio do następnego kroku. 

Właściwości te można również wybrać później dla wynikowej wielowierszowej 

jednostki tekstowej. 

4 Wybierz drugi róg obszaru tekstowego. 

5 Wpisz żądany tekst. 

Aby utworzyć akapity, naciśnij klawisz Enter i kontynuuj wpisywanie. 

6 Na wstążce (lub pływającym pasku narzędzi, jeśli wstążka nie jest wyświetlana) 

użyj narzędzi edytora tekstu, aby zaznaczyć podświetlony tekst lub jeśli żaden 

tekst nie jest podświetlony, zmiany wpłyną na nowy tekst podczas jego 

wpisywania. 

7 Kliknij przycisk Zamknij edytor, aby zaakceptować zmiany i zamknąć edytor. 
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     Styl tekstu Wybór stylu tekstu. 

                       Wysokość tekstu  Wybierz lub wpisz wysokość 

czcionki tekstu. 

Pogrubienie i kursywa Kliknij, aby pogrubić i/lub pochylić tekst. 

Podkreślenie i 
nadkreślenie 

Wielkie i małe 
litery 

Kliknij, aby podkreślić i/lub przesłonić 

tekst. Kliknij, aby zmienić tekst na wielkie lub 

małe litery. 

 
            Czcionka tekstu Wybierz czcionkę tekstu. 

Kolor tekstu Wybierz opcję BYBLOCK, BYLAYER, kolor tekstu 
lub wybierz opcję Wybierz kolor, aby 
wybrać spośród dodatkowych kolorów. 

Maska tła Kliknij, aby skonfigurować ustawienia tła dla tekstu. 
Aby uzyskać więcej informacji, kliknij Pomoc 
w wyświetlonym oknie dialogowym. 

          Kąt ukośny Wybierz lub wpisz kąt znaków tekstowych. 

Śledzenie Wybierz lub wpisz współczynnik 
reprezentujący odstępy między 
znakami. 

          Współczynnik szerokości Wybierz lub wpisz współczynnik 

szerokości czcionki. 

Wyczyść formatowanie Wybierz, czy usunąć znaki 
formatowanie z wybranych znaków, 
formatowanie akapitu lub formatowanie z 
wybranego akapitu. 

Łączenie 
akapitów 

Kliknij, aby połączyć wybrane akapity w jeden 
akapit. 

 

Uzasadnienie Wybierz uzasadnienie pola tekstowego. 

 
 ListaWybierz typ listy dla tekstu. 

Można również określić kontynuowanie lub 
ponowne uruchamianie list 
numerowanych. 

Odstęp między wierszami Wybór odstępu między wierszami. 
 

Domyślny, Lewy i 
Środek 

Prawo, 
uzasadnienie i 
dystrybucja 

Kliknij, aby ustawić justowanie akapitu na 
domyślne, lewe lub środkowe. 

Kliknij, aby ustawić wyrównanie akapitu do 
prawej, wyjustować lub rozdzielić. 

 ToolNameDescription 



 

Cofnij i ponów Kliknij, aby ponowić lub cofnąć poprzednią czynność. 

 
Symbol Kliknij, aby wstawić znak symbolu w 

miejscu, w którym znajduje się kursor w 

edytorze tekstu. 



 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
. 

 

 
Więcej opcji można uzyskać, klikając prawym przyciskiem myszy edytor tekstu. 

Kliknij prawym przyciskiem myszy edytor tekstu, aby uzyskać dostęp do 

dodatkowych opcji, w tym Zaznacz wszystko, Wytnij, Kopiuj, Wklej i Wklej 

specjalnie. Możesz także użyć typowych skrótów klawiszowych, takich jak Ctrl + V, 

aby wkleić tekst ze schowka. 
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Narzędzie Nazwa Opis 
 

 
Pole wstawiania Kliknij, aby wstawić pole w miejscu, w 

którym znajduje się kursor w edytorze tekstu. 
Aby uzyskać więcej informacji, kliknij 
przycisk Pomoc w wyświetlonym oknie 
dialogowym. 

 

 
Kolumny Kliknij, aby określić kolumny dla tekstu i 

opcje dla kolumn. Aby uzyskać więcej 
informacji, kliknij Pomoc w programie. 

 

 
Znajdź i zamień Kliknij, aby znaleźć i zamienić tekst w 

edytorze tekstu. 

 
 

Importuj tekst Kliknij, aby wybrać plik zawierający tekst 
do zaimportowania. 

 
 

AutoCAPS Kliknij, aby włączyć lub wyłączyć 
automatyczne pisanie tekstu 
wielkimi literami. 

 

 
Władca Kliknij, aby wyświetlić lub ukryć linijkę w 

edytorze tekstu. 

 

 
Tekst ułożony w 
stos 

Kliknij, aby ułożyć w stos lub usunąć stos 
zaznaczonego tekstu, na przykład ułamki 
mogą być wyświetlane jako tekst ułożony w 
stos. 

 

 
Więcej Kliknięcie powoduje wyświetlenie menu 

dodatkowych opcji, w tym zestawu znaków, 
ustawień edytora tekstu i pomocy online. 

 Zamknij edytor Akceptuje zmiany i zamyka edytor 
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E 
 

A D 

 
 
 

B 

 
 

 
C 

 

A Kliknij, aby zaakceptować zmiany i 
zamknąć edytor. 

B Wpisywanie i zaznaczanie tekstu. 

C Kliknij i przeciągnij, aby zmienić rozmiar 
edytora w pionie. 

D Kliknij i przeciągnij, aby zmienić rozmiar edytora w poziomie. 

E Wyświetla linijkę. 

 
 

 

Dostępne są dwa wielowierszowe edytory tekstu. 

Aby przełączyć się na wersję okna dialogowego wielowierszowego edytora tekstu, 

należy ustawić zmienną systemową MTEXTED na "oldeditor". 
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Praca ze stylami tekstu 
 

Po dodaniu tekstu do rysunku używany jest bieżący styl tekstu. Styl tekstu określa 

czcionkę, rozmiar, kąt, orientację, czy tekst jest domyślnie adnotacyjny i inne 

cechy. 

Każdy rysunek ma domyślny styl tekstu o nazwie Standardowy, który początkowo 

używa czcionki Arial. Stylu Standard nie można usunąć, ale można zmienić jego 

nazwę lub zmodyfikować go. Można zmienić czcionkę, jej rozmiar i zastosowany 

kąt pochylenia. Jeśli zmienisz czcionkę lub orientację istniejącego stylu, wszystkie 

istniejące jednostki tekstowe utworzone przy użyciu tego stylu zostaną 

automatycznie zaktualizowane w celu odzwierciedlenia nowej czcionki lub 

orientacji. 

Zmiana jakiejkolwiek innej cechy nie ma wpływu na istniejący tekst. Można także 

tworzyć i używać nieograniczonej liczby dodatkowych stylów tekstu. 

Styl tekstu określa cechy przedstawione w poniższej tabeli. 

 
Charakterystyka 
stylu 

Domyślne Opis 

Nazwa stylu Standard Nazwa stylu, do 255 znaków. 

Plik czcionki Arial Plik czcionki, na którym opiera się styl, oraz to, czy używane są duże pliki czcionek w 
języku azjatyckim (dla 
.SHX). 

Język Zachód Wysokość znaku. Wartość 0 powoduje wyświetlenie monitu o wysokość tekstu 
podczas wstawiania. 

Adnotacja Nie Określa, czy tekst jest domyślnie adnotacyjny, a zatem na jego wyświetlanie i drukowanie ma 
wpływ skalowanie adnotacji. Jeśli domyślnie jest adnotacyjny, określa również, czy tekst 
wyświetlany w przestrzeni papieru jest automatycznie orientowany zgodnie z rzutnią 
układu. 

Wysokość tekstu 0 Wysokość znaku. Wartość 0 powoduje wyświetlenie monitu o wysokość tekstu po wstawieniu. 
Wysokość tekstu jest wysokością tekstu na papierze, jeśli styl tekstu jest adnotacyjny. 

Współczynnik 
szerokości 

1 Pozioma ekspansja lub kompresja tekstu. Wartości mniejsze niż 1 kompresują tekst; wartości 
większe niż 1 rozszerzają tekst. 

Kąt pochylenia 0 Pochylenie tekstu w stopniach. Wartości ujemne pochylają tekst w lewo; wartości dodatnie 
pochylają tekst w prawo. 

Do tyłu Nie Określa, czy tekst jest wyświetlany do tyłu. 

Do góry nogami Nie Określa, czy tekst jest wyświetlany do góry nogami. 

Pionowy Nie Określa, czy tekst ma orientację pionową. 

 
Aby utworzyć styl tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów tekstu (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów tekstu (w obszarze Tekst). 

• W menu wybierz Format > Menedżer stylów tekstu. 

• Na pasku narzędzi Format lub Style kliknij narzędzie Menedżer stylów tekstu. 

• Wpisz style, a następnie naciśnij Enter. 

2 Kliknij przycisk Nowy. 

3 Wpisz nową nazwę stylu tekstu, a następnie kliknij przycisk OK. 
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4 W sekcji Czcionka tekstu wybierz nazwę, styl i język czcionki, której chcesz użyć. 

5 W sekcji Pomiary tekstu zaznacz pola wyboru, jeśli chcesz mieć tekst z 

adnotacjami; możesz także wprowadzić stałą wysokość tekstu (wysokość tekstu na 

papierze, jeśli jest to tekst z adnotacjami), szerokość lub kąt nachylenia. 

6 W sekcji Generowanie tekstu zaznacz pola wyboru, które mają wskazywać 

kierunek wyświetlania drukowanego tekstu. 

7 Kliknij przycisk OK. 

8 Aby rozpocząć korzystanie z nowego stylu, wybierz Rysuj > Tekst. 

9 W oknie dialogowym wybierz opcję Użyj zdefiniowanego stylu. 

 

 

Formatowanie tekstu 
 

Podczas tworzenia tekstu wybierany jest styl tekstu i ustawiane wyrównanie. Styl określa 

charakterystykę czcionki tekstu. W przypadku tekstu jednowierszowego punkt 

wyrównania określa sposób wyrównania tekstu względem punktu wstawiania tekstu. 

W przypadku tekstu akapitowego punkt wyrównania określa położenie punktu 

dołączenia w stosunku do granicy tekstu akapitu oraz kierunek przepływu tekstu w tej 

granicy. 

Można także użyć obszaru Narzędzia ekspresowe > Tekst w celu uzyskania poleceń 

skalowania tekstu, justowania tekstu, otaczania tekstu kształtami i innych. 

Wszystkie te opcje zostały opisane w pomocy online. 

 

Ustawianie stylu tekstu linii 

Styl tekstu można ustawić przed określeniem punktu wstawiania. Styl tekstu można 

wybrać, wpisując nazwę wcześniej zdefiniowanego stylu. 
 

Aby określić styl tekstu linii 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst (w adnotacji) lub 

Adnotacje > Tekst (w tekście). 

• W menu wybierz polecenie Rysuj > Tekst. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst. 

• Wpisz dtext, a następnie naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Użyj zdefiniowanego stylu. 

3 Wpisz nazwę wcześniej zdefiniowanego stylu tekstu, a następnie naciśnij klawisz Enter. 

Aby wyświetlić listę dostępnych stylów tekstu, wpisz znak zapytania (?), a 

następnie naciśnij klawisz Enter. 

4 Określa punkt wstawienia tekstu. 
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5 Określa wysokość tekstu. 

6 Określa kąt obrotu. 

7 Wpisz wiersz tekstu, a następnie naciśnij klawisz Enter. 

8 Aby zakończyć polecenie, naciśnij ponownie Enter. 

 
Ustawianie stylu tekstu akapitu 

Styl tekstu akapitu można ustawić przed określeniem punktu wstawiania. Styl tekstu 

można wybrać, wpisując nazwę wcześniej zdefiniowanego stylu. 
 

Aby określić styl tekstu akapitu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst wielowierszowy (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst wielowierszowy (w aplikacji 

Adnotacje). 

• W menu wybierz Rysuj > Tekst wielowierszowy. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst wielowierszowy. 

• Wpisz mtext i naciśnij Enter. 

2 Określ pierwszy punkt pola tekstowego. 

3 W oknie dialogowym wybierz Styl tekstu. 

4 Wpisz nazwę wcześniej zdefiniowanego stylu tekstu, a następnie naciśnij klawisz Enter. 

5 Określa wysokość tekstu. 

6 Określa kąt obrotu. 

7 Określ przeciwległy róg pola tekstowego. 

8 Wpisz tekst. 

9 Aby zakończyć polecenie, kliknij przycisk Zamknij edytor. 
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Ustawianie wyrównania tekstu linii 

Podczas tworzenia tekstu można ustawić wyrównanie tekstu przed określeniem 

punktu wstawiania. Wyrównanie ustawia się, wybierając je w polu podpowiedzi. 

Domyślnie tekst jest wyrównany do lewej. Tekst można wyrównać do lewej, do 

środka lub do prawej, a także do górnej, środkowej lub dolnej linii tekstu lub do dołu 

malejących liter. 

 

 

 

 

 

 

 

 
 

H 

 
A U góry po 

lewej 

B Środkowy 
lewy 

C Lewa 

D Lewy dolny 
róg 

E Centrum 

F Dolny środek 

G Bottomright 

H Linia bazowa 

I Prawo 

J Środkowa prawa 

K Prawy górny róg 

L Środek 

M Środek 

N Górny środek 

 

Można również wyrównać tekst, tak aby pasował lub był wyrównany między 

dwoma punktami. Opcja Wyrównaj tworzy tekst, który skaluje się w górę lub w 

dół, zachowując stały stosunek wysokości do szerokości; opcja Dopasuj rozszerza 

lub kompresuje tekst, aby zmieścił się między dwoma punktami. 

 

 

Tekst wyrównany między punktami 
zachowuje stały stosunek wysokości do 
szerokości. 

Dopasowanie tekstu między dwoma punktami 
rozszerza się lub kompresuje w celu 
dopasowania. 

 

Aby określić wyrównanie tekstu w wierszu przed wprowadzeniem tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst (w adnotacji) lub 

Adnotacje > Tekst (w tekście). 

• W menu wybierz polecenie Rysuj > Tekst. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst. 

• Wpisz dtext, a następnie naciśnij Enter. 

2 W oknie podpowiedzi wybierz opcję wyrównania lub wybierz Opcje 



justowania, aby wyświetlić wszystkie opcje justowania. 
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3 Określ punkt wstawiania tekstu, a następnie kontynuuj tworzenie tekstu liniowego. 
 

Aby określić justowanie dla istniejących jednostek tekstu liniowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Justuj tekst (  ): 

• Na wstążce wybierz kolejno Express Tools > Justify Text (w menu Text > Modify Text). 

• W menu wybierz kolejno Express Tools > Text > Justify Text. 

• Wpisz tjust i naciśnij Enter. 

2 Wybierz jednostki tekstowe. Oprócz tekstu jednowierszowego można również 

wybrać tekst wielowierszowy i tekst atrybutów. 

3 Wybierz jedną z poniższych opcji: 

• Punkt wyśrodkowania tekstu jest wyrównany do środka. 

• Środkowy punkt justowania tekstu jest wyrównany do środka 

(lewo/prawo i góra/dół). 

• Prawy punkt justowania tekstu jest wyrównany do prawej. 

• TL Punkt justowania tekstu jest wyrównany do lewego górnego rogu. 

• TC Punkt justowania tekstu jest wyrównany do górnego środka. 

• TR Punkt justowania tekstu jest wyrównany do prawego górnego rogu. 

• ML Punkt justowania tekstu jest wyrównany do środka do lewej. 

• MC Punkt justowania tekstu jest wyrównany do środka. 

• MR Punkt justowania tekstu jest wyrównany do środka po prawej stronie. 

• BL Punkt justowania tekstu jest wyrównany do lewego dolnego rogu. 

• BC Punkt justowania tekstu jest wyrównany do dolnego środka. 

• BR Punkt justowania tekstu jest wyrównany do prawego dolnego rogu. 

Aby zmieścić istniejący tekst w dwóch punktach 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dopasowanie tekstu (  ): 

• Na wstążce wybierz polecenie Narzędzia ekspresowe > Dopasuj tekst (w obszarze Tekst > 

Modyfikuj tekst). 

• W menu wybierz kolejno Express Tools > Text > Fit Text. 

• Wpisz textfit i naciśnij Enter. 

2 Wybierz jednoliniowe jednostki tekstowe. 

3 Określ nowy żądany punkt końcowy lub wybierz Punkt początkowy, aby 

określić nowy punkt początkowy, a następnie określ punkt końcowy. 

 

Polecenie Text Fit działa tylko z tekstem jednowierszowym. 

Aby zmieścić tekst wielowierszowy w dwóch punktach, należy najpierw użyć 

polecenia Rozbij, aby przekonwertować go na tekst jednowierszowy. 
 



Kod kontrolny Funkcja 
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Aby zmienić skalę istniejącego tekstu liniowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Skaluj tekst ( ): 

• Na wstążce wybierz kolejno Express Tools > Skaluj tekst (w menu Tekst > Modyfikuj 

tekst). 

• W menu wybierz kolejno Express Tools > Text > Scale Text. 

• Wpisz scaletext i naciśnij Enter. 

2 Wybierz jednoliniowe jednostki tekstowe. 

3 Wybierz opcję punktu bazowego do skalowania. 

4 Wybierz jeden z trybów skalowania tekstu i postępuj zgodnie z instrukcjami. 

Więcej informacji można znaleźć w pomocy online. 

 

Ustawianie wyrównania tekstu akapitu 

Podczas tworzenia tekstu akapitu można ustawić wyrównanie tekstu, określając 

kierunek, w którym tekst przepływa w obrębie granicy. Wyrównanie tekstu akapitu 

można ustawić w oknie dialogowym wyświetlanym po określeniu pierwszego 

narożnika granicy tekstu akapitu, w panelu Właściwości lub za pomocą polecenia 

narzędzia Justuj tekst ekspresowy. Punkt dołączenia można określić w lewym 

górnym rogu, środkowym górnym rogu, prawym górnym rogu, lewym środkowym 

rogu, środkowym środkowym rogu, prawym środkowym rogu, lewym dolnym 

rogu, środkowym dolnym rogu lub prawym dolnym rogu. Tekst akapitu może 

przepływać od lewej do prawej, od prawej do lewej, od góry do dołu lub od dołu do 

góry. Skalę istniejącego tekstu akapitu można zmienić za pomocą polecenia 

narzędzia Skaluj tekst ekspresowy. 

 

W tym specjalne znaki tekstowe 

Kodów sterujących można używać do podkreślania lub podkreślania tekstu lub do 

dołączania znaków specjalnych. Zarówno podkreślenie, jak i podkreślenie mogą być 

aktywne w tym samym czasie. Aby dołączyć kody sterujące, podczas wpisywania 

tekstu wpisz dwa symbole procentu (%%), a następnie specjalny kod sterujący lub 

znak. Pojedynczy znak procentu jest traktowany jako normalny znak tekstowy. 

Potrójny kod sterujący jest dostępny w przypadkach, gdy sekwencja kodu 

sterującego musi następować po znaku procentu w tekście. 

 

 
Specjalne znaki tekstowe 

%%oWłącza lub wyłącza tryb overscore. 

%%uWłącza lub wyłącza tryb podkreślenia. 

 %%dRysuje symbol stopnia (º). 

%%pRysuje symbol plus-minus (±). 

 %%cRysuje symbol średnicy okręgu (Ø). 

 %%% Wymusza pojedynczy znak procentu. 

%%nnn Rysuje znak specjalny o numerze nnn. 
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Tekst utworzony przy użyciu specjalnych znaków tekstowych: Ut wisi %%uenim%%d ad%%p%%u minim 
%%c %%oveniam. 

 

Tworzenie ramki wokół tekstu 

Można narysować ramkę wokół każdej zaznaczonej linii tekstu, tekstu akapitu lub 

tekstu atrybutu, czyli otoczyć tekst kształtem. Ramki mogą mieć kształt koła, 

prostokąta lub szczeliny. 
 

Aby narysować ramkę wokół tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obejmij tekst kształtem (

 ): 

• Na wstążce wybierz polecenie Narzędzia ekspresowe > Otocz tekst 

kształtem (w obszarze Tekst > Modyfikuj tekst). 

• W menu wybierz kolejno Express Tools > Text > Enclose Text with Shape. 

• Wpisz tcircle i naciśnij Enter. 

2 Wybierz tekst wiersza, akapitu lub atrybutu. 

3 Określ kształt, który chcesz narysować wokół tekstu. Więcej informacji można 

znaleźć w pomocy online. 



 

Zmiana tekstu 
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W rysunku można zmieniać tekst linii i akapitów. 

 

Zmiana tekstu linii 

Tekst można edytować i modyfikować tak, jak każdy inny element rysunku. 

Oznacza to, że można usuwać, przesuwać, obracać i skalować tekst. 
 

Aby edytować tekst i jego właściwości 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj tekst (  ): 

• Na wstążce wybierz polecenie Adnotacje > Edytuj tekst (w tekście). 

• W menu wybierz Modyfikuj > Podmioty > Tekst. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj tekst. 

• Wpisz ddedit i naciśnij Enter. 

2 Wybierz jednostkę tekstową. 

3 W oknie dialogowym Tekst edytuj tekst. 

4 Zmień żądane właściwości tekstu. 
 

Okno dialogowe Text jest wyświetlane, gdy EDITTEXTMODE jest ustawiony na 3 (domyślnie). 

Jeśli zmienna systemowa TEXTEDITMODE jest ustawiona na 1 lub 2, tekst linii jest 

edytowany odpowiednio na pasku poleceń lub w panelu Właściwości zamiast w oknie 

dialogowym Tekst. 
 

 
Zmiana tekstu akapitu 

Tekst można modyfikować tak samo, jak każdy inny element rysunku. Oznacza 

to, że można usuwać, przesuwać, obracać i skalować tekst. 
 

Aby edytować tekst akapitu i jego właściwości 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj tekst (  ): 

• Na wstążce wybierz polecenie Adnotacje > Edytuj tekst (w tekście). 

• W menu wybierz Modyfikuj > Podmioty > Tekst. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Edytuj tekst. 

• Wpisz ddedit i naciśnij Enter. 

2 Wybierz jednostkę tekstową. 

3 W edytorze tekstu edytuj tekst. 

4 Zmień żądane właściwości tekstu. 

5 Kliknij przycisk Zamknij edytor. 



412 C H A P T E R 1 1 

 

Znajdowanie i zastępowanie tekstu 

Można wyszukiwać i opcjonalnie zamieniać tekst w całym rysunku, w układzie lub 

w wybranych jednostkach. 

ALCAD wyszukuje i wyświetla listę pasującego tekstu. Każdy znaleziony element 

tekstowy ma powiązany typ jednostki, który pomaga zidentyfikować jego 

lokalizację na rysunku. Typy jednostek mogą obejmować tekst jednowierszowy, 

tekst wielowierszowy, liderzy wymiarów, hiperłącza, tekst alternatywny, przestrzeń 

papieru i przestrzeń modelu. Należy pamiętać, że niektóre typy liderów wymiarów 

są wymienione jako tekst wielowierszowy ze względu na sposób tworzenia 

wymiarów. 

Wszelkie zmiany dokonane w tekście są widoczne na rysunku po kliknięciu przycisku Gotowe. 
 

Aby znaleźć opcjonalnie zastępowany tekst 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Znajdź i zamień (  ): 

• Wybierz Edycja > Znajdź i zamień. 

• Na pasku narzędzi Standard kliknij narzędzie Znajdź i zamień. 

• Wpisz find i naciśnij Enter. 

2 W polu Znajdź co wpisz tekst, który chcesz wyszukać, lub wybierz wcześniej 

wprowadzony tekst z listy. 

3 W polu Znajdź gdzie wybierz lokalizację, w której chcesz wyszukiwać: 

• Cały rysunek Przeszukuje cały rysunek. 

• Bieżący układ Przeszukuje tylko bieżący układ. 

• Wybrane jednostki Wyszukuje tylko wybrane jednostki. Możesz kliknąć (  
), aby tymczasowo przełączyć się na rysunek i wybrać podmioty. 

4 W polu Typy tekstu wybierz typy tekstu, które chcesz uwzględnić w wyszukiwaniu. 

5 W sekcji Opcje wyszukiwania wybierz żądane opcje wyszukiwania. 

6 Kliknij przycisk Znajdź, aby wyświetlić listę wszystkich pasujących tekstów. 

7 Aby zastąpić tekst, wykonaj następujące czynności: 

• W polu Zamień na wprowadź lub wybierz nowy tekst. 

• Na liście znalezionego tekstu zaznacz tekst do zastąpienia. 

• Kliknij przycisk Zamień. 
 

Użyj skrótu do zastępowania tekstu. 

Kliknij przycisk Zamień wszystko, aby zastąpić cały pasujący tekst bez jego wcześniejszego 

wyszukiwania. 
 

8 Kliknij przycisk Gotowe, aby wyświetlić zmiany tekstu (jeśli występują) na rysunku. 
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A Wpisz lub zaznacz tekst do wyszukania. 

B Wpisz lub wybierz tekst, którym chcesz 
zastąpić znaleziony tekst (opcjonalnie). 

C Wyświetla cały znaleziony tekst. 

D Wybierz, aby znaleźć tylko tekst pasujący do 
wielkich i małych liter określonych w polu 
Znajdź co. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
H I  JK 

J Kliknij, aby znaleźć pasujący tekst. 

K Kliknij po zakończeniu, aby zobaczyć 
zmiany na rysunku. 

L Wybierz, aby wyszukać wartości atrybutów bloku. 

M Wybierz, aby przeszukiwać zarówno wymiar, jak i tekst lidera. 

N Wybierz, aby przeszukiwać zarówno tekst jednowierszowy, jak i 
wielowierszowy. 

E Wybierz, aby znaleźć tylko całe słowa pasujące 
do tekstu w polu Znajdź co. 

F Wybierz, aby uwzględnić odniesienia zewnętrzne 
w wyszukiwaniu. 

G Wybierz, aby uwzględnić bloki w wyszukiwaniu. 

H Kliknij, aby zastąpić zaznaczony tekst na liście 
Lokalizacja tekstem z listy Zamień na. 

I Kliknij, aby zastąpić wszystkie pasujące teksty 
bez wcześniejszego wyszukiwania. 

O Wybierz, aby wyszukać hiperłącza. 

P Wybierz, aby przeszukać opisy hiperłączy. 

Q Wybierz miejsce wyszukiwania tekstu: cały 
rysunek, bieżący układ lub wybrane jednostki. 

R Kliknij, aby przełączyć się na rysunek i wybrać 
podmioty do wyszukania. 
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Zmiana wielkości liter 

Możesz szybko zmienić wielkość liter w jednowierszowych i wielowierszowych 

jednostkach tekstowych na następujące metody: wielkość liter w zdaniach, 

wszystkie małe litery, wszystkie wielkie litery, wielkość liter w tytule i przełączanie 

wielkości liter. 
 

Aby ustawić formatowanie wielkich liter 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zmień wielkość liter (  ): 

• Na wstążce wybierz kolejno Express Tools > Zmień wielkość liter (w menu 

Tekst > Modyfikuj tekst). 

• W menu wybierz kolejno Express Tools > Text > Change Text Case. 

• Wpisz tcase i naciśnij Enter. 

2 Wybierz jednostki tekstowe. 

3 Wybierz jedną z poniższych opcji: 

• Wielkość liter w zdaniu Pierwsza litera pierwszego znaku tekstu jest wielka. 

• małe litery Wszystkie znaki tekstowe są małymi literami. 

• WIELKIE LITERY Wszystkie znaki tekstowe są pisane wielkimi literami. 

• Tytuł Pierwsze litery wszystkich znaków tekstowych są wielkie. 

• tOGGLE cASE Pierwsze litery wszystkich znaków tekstowych są pisane 

małymi literami, a pozostałe są pisane wielkimi literami. 

 
Konwersja tekstu liniowego na akapitowy 

Podczas konwersji tekstu liniowego na tekst akapitowy jedna lub więcej jednostek 

tekstowych utworzonych za pomocą polecenia Tekst jest łączonych w jedną 

wielowierszową jednostkę tekstową. Podczas konwersji wybrane jednostki tekstowe 

są usuwane z rysunku i tworzona jest wielowierszowa jednostka tekstowa. 
 

Aby przekonwertować tekst liniowy na akapitowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst na tekst wielowierszowy (

 ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Tekst na tekst 

wielowierszowy (w adnotacji), Adnotacje > Tekst na tekst wielowierszowy (w 

tekście) lub Narzędzia ekspresowe > Tekst na tekst wielowierszowy (w 

tekście). 

• W menu wybierz kolejno opcje Rysuj > Tekst na tekst wielowierszowy lub 

Express Tools > Tekst > Tekst na tekst wielowierszowy. 

• Na pasku narzędzi Tekst kliknij narzędzie Tekst na tekst wielowierszowy. 

• Wpisz txt2mtxt i naciśnij Enter. 

2 Wybierz jedną lub więcej jednostek tekstowych. 

3 Po zakończeniu wyboru naciśnij Enter. 
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Aby dostosować opcje podczas konwersji tekstu liniowego na akapitowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst na tekst wielowierszowy (

 ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Tekst na tekst 

wielowierszowy (w adnotacji), Adnotacje > Tekst na tekst wielowierszowy (w 

tekście) lub Narzędzia ekspresowe > Tekst na tekst wielowierszowy (w 

tekście). 

• W menu wybierz kolejno opcje Rysuj > Tekst na tekst wielowierszowy lub 

Express Tools > Tekst > Tekst na tekst wielowierszowy. 

• Na pasku narzędzi Tekst kliknij narzędzie Tekst na tekst wielowierszowy. 

• Wpisz txt2mtxt i naciśnij Enter. 

2 Naciśnij Enter. 

3 Wybierz jedną z poniższych opcji: 

• Wybierz, aby dodać tekst jednowierszowy do tekstu wielowierszowego w 

wybranej kolejności. 

• Kolejność od góry do dołu Wybierz, aby dodać tekst jednowierszowy do 

tekstu wielowierszowego w kolejności, w jakiej pojawiają się one na rysunku, 

od góry do dołu. 

4 Zaznacz opcję Utwórz Word-Wrap MText, aby dodać spacje w 

poszczególnych wierszach tekstu, co pomaga zrównoważyć wiele wierszy 

tekstu. 

5 Kliknij przycisk OK. 

6 Wybierz jedną lub więcej jednostek tekstowych. 

7 Po zakończeniu wyboru naciśnij Escape. 

Wszystkie jednostki tekstowe są łączone w jedną wielowierszową jednostkę tekstową. 

 

 

 
 

A 

B 

 

A Wybierz dodawanie tekstu w wybranej 
kolejności lub w kolejności od góry do dołu. 

B Kliknij, aby dodać spacje w wierszach tekstu w celu 
zrównoważenia wielu wierszy tekstu. 
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Sprawdzanie pisowni 
 

Można sprawdzić pisownię tekstu na rysunku, dostosować słownik do rozpoznawania 

nowych słów i użyć innego słownika pisowni, który obsługuje inny język. 

 

Sprawdzanie pisowni tekstu 

Za pomocą polecenia Sprawdź pisownię można sprawdzić pisownię tekstu 

jednowierszowego, tekstu wielowierszowego, tekstu akapitu, atrybutów, definicji 

atrybutów i tekstu wymiaru. 
 

Aby sprawdzić pisownię tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Sprawdź pisownię (  ): 

• Na wstążce wybierz polecenie Adnotacje > Sprawdź pisownię (w tekście). 

• W menu wybierz Narzędzia > Sprawdź pisownię. 

• Na pasku narzędzi Standard kliknij narzędzie Sprawdź pisownię. 

• Wpisz spell i naciśnij Enter. 

2 Wybierz jedną lub więcej jednostek tekstowych. 

3 W oknie dialogowym Sprawdź pisownię błędnie napisane słowa są wyświetlane 

pojedynczo. Wykonaj jedną z poniższych czynności dla każdego znalezionego 

słowa: 

• Zachowaj tekst niezmieniony - kliknij Ignoruj, aby zachować znalezione 

słowo niezmienione na rysunku, lub kliknij Ignoruj wszystko, aby zachować 

wszystkie wystąpienia znalezionego słowa niezmienione na rysunku. 

• Zmień tekst - wybierz lub wpisz słowo w polu sugestii, a następnie kliknij 

przycisk Zmień, aby zmienić znalezione słowo na rysunku na nowy tekst, lub 

kliknij przycisk Zmień wszystko, aby zmienić wszystkie wystąpienia 

znalezionego słowa na rysunku. 

4 Kliknij przycisk Dodaj, jeśli chcesz dodać aktualnie znalezione słowo do listy 

niestandardowych słów pisowni. Okno dialogowe Sprawdź pisownię rozpozna 

dodane słowo jako poprawnie napisane przy następnym sprawdzaniu pisowni. 
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A Wyświetla bieżący słownik. 

B Wyświetla błędnie wpisane słowo i jego 
kontekst na rysunku. 

C Wyświetla (lub można wpisać) nowe słowo 
zastępujące błędnie wpisane słowo na rysunku. 

D Kliknij, aby wybrać nowe słowo, które zastąpi 
aktualnie znalezione błędnie wpisane słowo. 

E Kliknij, aby wybrać nowy słownik lub 
zmodyfikować słownik niestandardowy. 

F Kliknij, aby dodać sugerowane słowo do 
słownika niestandardowego. 

G Kliknij, aby zasugerować dodatkowe słowa 
na podstawie wybranego słowa z listy 
sugestii. 

H Kliknij, aby zmienić wszystkie wystąpienia 
błędnie wpisanego słowa na sugerowane 
słowo. 

I Kliknij, aby zmienić pojedyncze wystąpienie 
pisowni słowa na sugerowane słowo. 

J Kliknij, aby pominąć wszystkie wystąpienia błędnie wpisanego 
słowa. 

K Kliknij, aby pominąć pojedyncze wystąpienie 
błędnie napisanego słowa bez jego zmiany. 

 

Dostosowywanie pisowni wyrazów 

Większość rysunków zawiera tekst, który nie jest rozpoznawany jako poprawnie 

napisany, nawet jeśli jest poprawnie napisany. Na przykład, jeśli nazwa firmy 

Zaffer, Inc. pojawia się we wszystkich rysunkach, nazwa firmy będzie wyświetlana 

jako błędna za każdym razem, gdy sprawdzisz pisownię tekstu rysunku. Słowa 

można łatwo dodawać do słownika niestandardowego, dzięki czemu każde słowo w 

słowniku niestandardowym będzie rozpoznawane jako napisane poprawnie. 

Słownik niestandardowy jest niezależny od wybranego słownika pisowni. Można 

sprawdzić pisownię tekstu przy użyciu jednego słownika, a następnie sprawdzić 

pisownię tego samego lub innego tekstu przy użyciu innego słownika, przy czym w 

obu przypadkach używany jest słownik niestandardowy. 



418 C H A P T E R 1 1 

 

Aby utworzyć słownik niestandardowy i zarządzać nim 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Sprawdź pisownię (  ): 

• Na wstążce wybierz polecenie Adnotacje > Sprawdź pisownię (w tekście). 

• W menu wybierz Narzędzia > Sprawdź pisownię. 

• Na pasku narzędzi Standard kliknij narzędzie Sprawdź pisownię. 

• Wpisz spell i naciśnij Enter. 

2 Wybierz jedną lub więcej jednostek tekstowych. 

3 W oknie dialogowym Sprawdź pisownię kliknij przycisk Zmień słowniki. 

4 Aby dodać słowo niestandardowe, wpisz je w polu Słowa słownika niestandardowego, a 

następnie kliknij przycisk Dodaj. 

5 Aby usunąć słowo niestandardowe, wybierz je w polu Słowa słownika 

niestandardowego, a następnie kliknij przycisk Usuń. 

6 Kliknij przycisk OK. 

 

 
A Wpisz słowo dla słownika niestandardowego. 

B Wyświetla słowa w słowniku niestandardowym. 

C Kliknij, aby usunąć aktualnie wybrane słowo ze 
słownika niestandardowego. 

D Kliknij, aby dodać bieżące słowo w polu edycji (A) 
do słownika niestandardowego. 

E Kliknij, aby wybrać inny słownik niestandardowy. 

F Wyświetla nazwę pliku słownika 
niestandardowego. Można wpisać nową ścieżkę i 
nazwę pliku lub kliknąć przycisk Przeglądaj, 
aby wybrać plik. 

 
 

 

Słowa niestandardowe można także dodawać do słownika niestandardowego 

podczas sprawdzania pisowni tekstu. W oknie dialogowym Sprawdź pisownię 

kliknij przycisk Dodaj, aby dodać aktualnie znalezione słowo do słownika 

niestandardowego. 

F 

E 

A 

B 

D 

   
C 
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Zmiana słownika 

Polecenie Sprawdź pisownię porównuje tekst znaleziony na rysunku z poprawnie 

napisanymi słowami w zainstalowanym słowniku (plik .dic). Istnieje wiele różnych 

słowników, które mogą być używane z ALCAD, w tym słowniki w różnych 

językach. 

Możesz pobrać i zainstalować nowy słownik lub użyć słownika już 

zainstalowanego na komputerze. 
 

Aby pobrać i zainstalować nowy słownik 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Sprawdź pisownię (  ): 

• Na wstążce wybierz polecenie Adnotacje > Sprawdź pisownię (w tekście). 

• W menu wybierz Narzędzia > Sprawdź pisownię. 

• Na pasku narzędzi Standard kliknij narzędzie Sprawdź pisownię. 

• Wpisz spell i naciśnij Enter. 

• Na wstążce wybierz polecenie Adnotacje > Sprawdź pisownię (w tekście). 

2 Zaznacz jedną lub więcej jednostek tekstowych, a następnie w oknie 

dialogowym Sprawdź pisownię kliknij przycisk Zmień słowniki. 

3 Kliknij Pobierz. 

4 Z wyświetlonej strony internetowej (lub z innej strony internetowej) pobierz 

żądany słownik. 

5 Rozpakuj zawartość pobranego pliku do \MyDocuments\Spelling lub lokalizacji, 

w której zainstalowano słowniki pisowni dla ALCAD. 

6 Kliknij ponownie Change Dictionaries, co spowoduje załadowanie nowo zainstalowanego 

słownika. 

7 W Słowniku głównym wybierz żądany słownik. 

8 Kliknij przycisk OK. 
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A 

B 

 
 
 
 
 
 
 
 
 
 
 
 
 

A Wybierz żądany słownik ortograficzny. B Kliknij, aby otworzyć domyślną przeglądarkę internetową na stronie 
gdzie można pobrać słowniki ortograficzne w 
różnych językach. 

 
Aby użyć słownika już zainstalowanego na komputerze 

1 Wykonaj jedną z poniższych czynności: 

• Skopiuj istniejący słownik (plik .dic) do \MyDocuments\Spelling lub do 

lokalizacji, w której zainstalowano słowniki pisowni dla ALCAD. 

• Dodaj folder istniejącego słownika do listy folderów, w których ALCAD 

wyszukuje słowniki. Wybierz Narzędzia > Opcje, kliknij Ścieżki/Pliki i dodaj 

lokalizację folderu do ścieżek słownika. Aby uzyskać więcej informacji, 

zobacz "Zmiana opcji na karcie Ścieżki/Pliki" na stronie 690. 

2 Wybierz polecenie Narzędzia > Sprawdź pisownię, zaznacz jedną lub 

więcej jednostek tekstowych, a następnie w oknie dialogowym Sprawdź 

pisownię kliknij przycisk Zmień słowniki. 

3 W Słowniku głównym wybierz żądany słownik. 

4 Kliknij przycisk OK. 



 

Korzystanie z  tekstu 
alternatywnego  edytora  
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ALCAD zawiera wbudowany edytor tekstu do tworzenia tekstu akapitowego za 

pomocą polecenia Tekst wielowierszowy. Można również określić alternatywny edytor 

tekstu dla polecenia Tekst wielowierszowy. 

 

Wybór alternatywnego edytora tekstu 

Przed użyciem alternatywnego edytora tekstu należy określić edytor, ustawiając 

zmienną systemową MTEXTED. 
 

Aby wybrać alternatywny edytor tekstu 

1 Wpisz mtexted i naciśnij Enter. 

2 Wprowadź ścieżkę i nazwę pliku wykonywalnego edytora tekstu, którego chcesz 

użyć do tworzenia lub edycji tekstu wielowierszowego. Na przykład, aby użyć 
Microsoft® Wordpad, należy wpisać coś podobnego do poniższego (dostosowując 

nazwę ścieżki w razie potrzeby): 

C:\Program Files\Windows\Accessories\Wordpad.exe 

 
Tworzenie tekstu akapitowego w alternatywnym edytorze tekstu 

Po skonfigurowaniu programu ALCAD do korzystania z alternatywnego edytora 

tekstu można zacząć używać go do dołączania tekstu do rysunków. 
 

Aby użyć alternatywnego edytora tekstu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tekst wielowierszowy (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Tekst wielowierszowy (w aplikacji 

Adnotacje). 

• W menu wybierz polecenie Rysuj > Tekst wielowierszowy. 

• Na pasku narzędzi Rysuj kliknij narzędzie Tekst wielowierszowy. 

• Wpisz mtext i naciśnij Enter. 

2 Zaznacz pierwszy i drugi róg obszaru tekstowego. 

3 W edytorze tekstu wpisz żądany tekst, używając znaków specjalnych z tabeli 

pokazanej obok, aby uzyskać specjalne formatowanie. Wpisz \P, aby zakończyć 

akapit i rozpocząć nowy akapit w następnym wierszu. Na przykład, aby użyć 

wartości wyrównania 1 i umieścić dwie liczby w stosie w celu wyświetlenia ich 

jako ułamka: 

{\A1;\S1/2;}\P 

4 Gdy tekst jest gotowy, zapisz zmiany i zamknij edytor tekstu. 
 

Specjalny znak formatu Funkcja  

\0...\o Włącza lub wyłącza tryb overscore. 

\L...\l Włącza lub wyłącza tryb podkreślenia. 

\~ Wstawia nieprzerywającą spację. 

\\ Wstawia odwrotny ukośnik. 



Specjalny znak formatu Funkcja 

Kod kontrolny Unicode Funkcja 
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\{...\} Wstawia nawias otwierający i zamykający. 

\Cvalue; Ustawia kolor na określoną wartość. 

\Filename; Ustawia czcionkę na podstawie określonej nazwy pliku czcionki. 

\Hvalue; Ustawia wysokość tekstu na określoną wartość. 

\Hvaluex; Ustawia wysokość tekstu na wielokrotność bieżącej wysokości tekstu. 

\S...^...; Umieszcza kolejny tekst na stosie po symbolu /, # lub ^. 

\Wartość; Dostosowuje odstęp między znakami od 0,75 do 4 razy. 

\Qangle; Zmienia kąt pochylenia. 

\Wartość; Zmienia współczynnik szerokości, aby uzyskać szeroki tekst. 

\A Ustawia wartość wyrównania. 

\P Kończy akapit. 

\p[i],[l],[tX1,X2,...,X32] Formatuje akapit: i = wcięcie pierwszego wiersza; l = przesunięcie akapitu; t 
= tabulator 

pozycje. 

 
 
 

 

Praca z tekstem napisanym w różnych językach 
 

Do rysunków można dołączać tekst napisany w różnych językach. 

 

Używanie znaków Unicode 

ALCAD obsługuje standard kodowania znaków Unicode, który umożliwia 

wyświetlanie i pisanie tekstu w różnych językach przy użyciu różnych liter. Czcionki 

Unicode zawierają znacznie więcej znaków niż typowo zdefiniowane w systemie. 

Poniższa tabela opisuje tylko niewielki zestaw, który jest dostępny 

 

 \U+00B0Rysuje symbol stopnia (º). 

\U+00B1 Rysuje symbol plusa lub minusa (±). 

 \U+0394Rysuje symbol delta (Δ). 

\U+2205 Rysuje symbol średnicy okręgu (Ø). 

\U+03A9Rysuje symbol omega (Ω). 

\U+2260 Rysuje symbol nierówności (≠). 

 
Szczegółowe informacje na temat używania innych znaków specjalnych można 

znaleźć w sekcji "Dołączanie specjalnych znaków tekstowych" na stronie 409 w tym 

rozdziale. Można również użyć innego edytora tekstu; zobacz "Używanie 

alternatywnego edytora tekstu" na stronie 421 w tym rozdziale. 
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Określanie zestawów znaków dla rysunków 

Zestaw znaków używany do wyświetlania tekstu na rysunkach zazwyczaj zależy od 

zestawu znaków określonego przez system operacyjny, na przykład ANSI_1252 to 

Latin 1, ANSI_1253 to grecki, a ANSI_1254 to turecki. Jest to również nazywane 

stroną kodową. 

ALCAD pozwala zarządzać stroną kodową przypisaną do rysunku. Ta unikalna 

funkcja zwykle nie jest konieczna w przypadku dystrybucji rysunków w tym samym 

regionie geograficznym, ale może być bardzo pomocna podczas udostępniania lub 

dystrybucji rysunków między różnymi regionami geograficznymi. Zmiana strony 

kodowej jest bardzo pożądana, zwłaszcza w regionach geograficznych, w których 

używanych jest kilka języków, które wymagają różnych zestawów znaków do 

prawidłowego wyświetlania tekstu. 

Ustawienie strony kodowej nie zmienia języka tekstu; zamiast tego określa zestaw 

znaków, w którym tekst jest wyświetlany. Niektóre czcionki mogą wyświetlać swoje 

znaki na kilka różnych sposobów, w zależności od ustawienia strony kodowej. 

Istnieją dwie zmienne systemowe, które odnoszą się do strony kodowej rysunku: 

• SYSCODEPAGE - zestaw znaków zdefiniowany dla systemu operacyjnego. 

• DWGCODEPAGE - Zestaw znaków zdefiniowany dla indywidualnego 

rysunku, który zastępuje stronę kodową systemu operacyjnego. 
 

Aby wybrać stronę kodową dla bieżącego rysunku 

1 Wpisz stronę kodową i naciśnij Enter. 

Zostanie otwarte okno dialogowe Code Page Manager. 

2 Jeśli chcesz przekonwertować rysunek w celu użycia strony kodowej innej niż 

strona kodowa systemu operacyjnego, w polu Strona kodowa rysunku wybierz 

nową stronę kodową dla rysunku. 

3 Kliknij przycisk OK. 

 

 

 
 

A 

B 

 
 
 
 

A Wyświetla stronę kodową systemu operacyjnego. B Wybór strony kodowej dla bieżącego rysunku. 
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Narzędzia wymiarowania ALCAD umożliwiają dodawanie wymiarów do 

rysunku. Wymiary można szybko dodawać, po prostu wskazując jednostki. Do 

rysunków można również dodawać symbole tolerancji. 

Wiele zmiennych wymiarowania programu pozwala kontrolować wygląd 

wymiarów. Style wymiarów umożliwiają zapisywanie ustawień zmiennych 

wymiarów, dzięki czemu można ich używać ponownie bez konieczności ich 

ponownego tworzenia. 

W tej sekcji wyjaśniono, jak 

• Tworzenie wymiarów liniowych, kątowych, łukowych, średnicowych, promieniowych i 

rzędnych. 

• Tworzenie liderów i adnotacji. 

• Wymiary edycji. 

• Używaj stylów wymiarów i zmiennych. 

• Dodaj tolerancje geometryczne. 

• Tolerancja wymiaru kontrolnego. 

• Kontrola jednostek wymiaru alternatywnego. 

 

 

 

 

 

 

 

 
 

Tematy w tym rozdziale 

Zrozumienie koncepcji wymiarowania  ............................................................ 426 
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Edytowanie wymiarów  .................................................................................... 441 
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Zrozumienie koncepcji wymiarowania 
 

Można tworzyć pięć podstawowych typów wymiarów: liniowe, kątowe, 

promieniowe, średnicowe i rzędne. Wymiary można tworzyć dla istniejących 

jednostek poprzez ich zaznaczenie lub poprzez zaznaczenie punktów na rysunku. Na 

przykład wymiar liniowy można utworzyć poprzez wybranie jednostki, która ma 

zostać zwymiarowana, lub poprzez określenie początków pierwszej i drugiej linii 

przedłużającej. 

 

 

 
A Wymiar promieniowy. 

B Pionowy wymiar liniowy. 

C Wymiar kątowy. 

D Liniowe wymiary ciągłe. 

E Wyrównany wymiar. 

F Średnica. 

G Poziomy wymiar liniowy. 

H Liniowy wymiar bazowy. 

 

Po utworzeniu wymiaru program rysuje go na bieżącej warstwie przy użyciu 

bieżącego stylu wymiaru. Każdy wymiar ma odpowiadający mu styl wymiaru, który 

steruje wyglądem wymiaru, np. typami grotów strzałek, stylem tekstu i kolorami 

różnych elementów. Istniejące style wymiarów można modyfikować, zmieniając 

jedno z ustawień zmiennej wymiaru, a następnie aktualizując styl wymiaru w celu 

odzwierciedlenia nowych ustawień. 

Każdy tworzony wymiar składa się z kilku części. Linia wymiarowa pokazuje, gdzie 

zaczyna się i kończy wymiar. W przypadku tworzenia wymiaru kątowego linia 

wymiarowa jest łukiem linii wymiarowej odejmującym mierzony kąt. 
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Linie przedłużające, zwane również liniami rzutowania, to linie, które rozciągają się 

od jednostki, dla której tworzony jest wymiar, dzięki czemu można umieścić linię 

wymiarową z dala od jednostki. Groty strzałek tworzą zakończenie na każdym 

końcu linii wymiarowej. 

Tekst wymiaru zawiera zmierzony wymiar i może również zawierać przedrostki, 

poprawki, tolerancje i inny opcjonalny tekst. Podczas wstawiania wymiarów można 

kontrolować tekst wymiaru oraz określać jego położenie i orientację. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
A Linia przedłużająca. 

B Arrowhead. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
C Linia wymiarowa. 

D Wymiar tekstu. 

 

Wymiary mogą również zawierać inne opcjonalne elementy. Lider to linia 

prowadząca od elementu rysunku do adnotacji. Linie pomocnicze zaczynają się od 

grotu strzałki i można ich używać do umieszczania wymiaru z dala od linii 

wymiarowej lub do dodawania notatek. Podczas tworzenia wymiaru promieniowego 

można dodać znacznik środka, który jest małym krzyżykiem oznaczającym środek 

okręgu lub łuku, lub można dodać linie środkowe, które są przecinającymi się 

liniami wychodzącymi ze środka okręgu lub łuku. 

 
 

Lider. Znak środka. Linie środkowe. 

Wymiary mogą być jednego z trzech typów: 

• Asocjacyjny - wymiar jest powiązany z jednostkami, które mierzy. Jeśli jednostki 

mierzone przez wymiar są modyfikowane, wymiar jest automatycznie 

aktualizowany. Nowo utworzone wymiary są asocjacyjne, gdy wartość 

DIMASSOC jest ustawiona na 2 (domyślnie) i są tworzone przy użyciu 

zatrzasków encji. 
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• Nieasocjacyjny - wymiar nie jest powiązany z jednostkami, które mierzy. Jeśli 

jednostki mierzone przez wymiar zostaną zmodyfikowane, wymiar nie zostanie zaktualizowany 

automatycznie. Nowo utworzone wymiary są nieasocjatywne, gdy wartość 

DIMASSOC jest ustawiona na 1. 

• Exploded - wymiary są tworzone jako oddzielne jednostki, a nie jako 

pojedyncza jednostka wymiaru. Nowo utworzone wymiary są rozbijane, gdy 

wartość DIMASSOC jest ustawiona na 0. 

 

 
 

Tworzenie wymiarów 
 

Wymiary można tworzyć poprzez: 

• Wybór jednostki do wymiarowania i określenie położenia linii wymiarowej. 

• Określenie początków linii rozszerzenia i lokalizacji linii wymiarowej. 

Podczas tworzenia wymiarów przez wybranie jednostki, program automatycznie 

umieszcza początki linii rozszerzenia w odpowiednich punktach definicji w oparciu 

o typ wybranej jednostki. Na przykład punkty definicji znajdują się w punktach 

końcowych łuków, linii i segmentów polilinii. Podczas tworzenia wymiarów poprzez 

określenie początków linii rozszerzenia, określone punkty określają punkty definicji. 

Aby precyzyjnie ustalić te punkty, należy użyć przyciągania jednostek. 

Wymiary można tworzyć w przestrzeni modelu lub przestrzeni papieru. 

 

Tworzenie wymiarów liniowych 

Wymiary liniowe opisują odległości lub długości liniowe i mogą być zorientowane 

poziomo, pionowo lub równolegle do istniejącej jednostki lub do wybranych 

punktów początkowych rozszerzenia. Po utworzeniu wymiaru liniowego można 

dodać wymiar bazowy lub wymiar kontynuowany. Liniowy wymiar bazowy 

wstawia dodatkowy wymiar od wspólnego punktu początkowego pierwszej linii 

przedłużenia poprzedniego wymiaru liniowego. Wymiar liniowy kontynuowany 

kontynuuje wymiar liniowy od drugiej linii przedłużenia poprzedniego wymiaru 

liniowego. 

 

Wybór dokładnych punktów jest ważny podczas tworzenia wymiarów. 

Użyj przyciągania jednostek, aby wybrać precyzyjne punkty rzędnych. 
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Aby utworzyć wymiar poziomy lub pionowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Linear (  ): 

• Na wstążce wybierz polecenie Adnotacje > Liniowe (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Liniowy. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Liniowy. 

• Wpisz dimlinear i naciśnij Enter. 

2 Naciśnij Enter, a następnie wybierz jednostkę do zwymiarowania. 

Można też wstawić wymiar, określając początki pierwszego i drugiego wiersza 

rozszerzenia. 

3 Określ położenie linii wymiarowej. 

 
 

 
Aby wstawić wymiar liniowy przez wybranie jednostki, 
wybierz jednostkę (A) do zwymiarowania, a 
następnie określ położenie linii wymiarowej (B). 

Wynik. 

 

 

 
Aby wstawić wymiar liniowy, wybierając rozszerzenie 
wybierz pierwszy początek rozszerzenia (A), 
wybierz drugi początek rozszerzenia (B), a 
następnie określ położenie linii wymiarowej (C). 

Wynik. 
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Aby utworzyć wyrównany wymiar 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyrównane (  ): 

• Na wstążce wybierz polecenie Adnotacje > Wyrównane (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Wyrównane. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Wyrównanie. 

• Wpisz dimaligned i naciśnij Enter. 

2 Naciśnij Enter, a następnie wybierz jednostkę do zwymiarowania. 

Można też wstawić wymiar, określając początki pierwszego i drugiego wiersza 

rozszerzenia. 

3 Określ położenie linii wymiarowej. 

 
 

 
Aby wstawić wymiar wyrównany przez wybranie jednostki, 
wybierz jednostkę (A) do zwymiarowania, a następnie 
wybierz lokalizację linii wymiarowej (B). 

Wynik. 

 

 

 
Aby wstawić wyrównany wymiar, wybierając linię 
rozszerzenia 
początki, wybierz pierwszy początek rozszerzenia (A), 
wybierz drugi początek rozszerzenia (B), a następnie określ 
położenie linii wymiarowej (C). 

Wynik. 
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Aby utworzyć liniowy wymiar bazowy 

1 Utwórz wymiar. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Baseline (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Linia bazowa (w obszarze Wymiary). 

• W menu wybierz kolejno Wymiary > Linia bazowa. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Linia bazowa. 

• Wpisz dimbaseline i naciśnij Enter. 

3 Aby wybrać wymiar początkowy, naciśnij klawisz Enter. 

4 Wybierz początek następnej linii wewnętrznej, a następnie naciśnij Enter. 

Możesz też nacisnąć Enter, a następnie wybrać istniejący wymiar dla linii 

bazowej. Wybierz początek następnej linii rozszerzenia, a następnie naciśnij 

klawisz Enter. 

Program automatycznie umieszcza nowy wymiar linii bazowej powyżej lub poniżej 

poprzedniej linii wymiarowej. Odległość między dwiema liniami wymiarowymi jest 

określana przez wartość Baseline Offset (Przesunięcie linii bazowej) w oknie 

dialogowym Dimension Styles (Style wymiarów). 

 
 

Aby dodać wymiar linii bazowej do istniejącego wymiaru liniowego, wybierz istniejący wymiar (A), 
wybierz następny początek linii przedłużenia (B) i wybierz dowolną liczbę dodatkowych punktów (C). 

 

Wynik. 
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Aby utworzyć liniowy wymiar ciągły 

1 Utwórz wymiar. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kontynuuj (  ): 

• Na wstążce wybierz polecenie Adnotacje > Kontynuuj (w obszarze Wymiary). 

• W menu wybierz Wymiary > Kontynuuj. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Kontynuuj. 

• Wpisz dimcontinue, a następnie naciśnij Enter. 

3 Aby wybrać wymiar początkowy, naciśnij klawisz Enter. 

4 Wybierz początek następnej linii wewnętrznej, a następnie naciśnij Enter. 

Możesz też nacisnąć klawisz Enter, a następnie wybrać istniejący wymiar, aby kontynuować. 

5 Aby dodać kolejne wymiary, kontynuuj wybieranie początków linii rozszerzeń. 

6 Aby zakończyć polecenie, naciśnij dwukrotnie klawisz Enter. 
 

Aby dodać wymiar ciągły do istniejącego wymiaru liniowego, wybierz istniejący wymiar (A), wybierz 
następny początek linii rozszerzenia (B) i wybierz kolejny początek linii rozszerzenia (C). 

 

Wynik. 
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Tworzenie wymiarów kątowych 

Wymiary kątowe określają kąt mierzony między dwiema liniami. Kąt można także 

zwymiarować, wybierając wierzchołek kąta i dwa punkty końcowe. Po utworzeniu 

wymiaru kątowego można dodać wymiar bazowy lub wymiar kontynuowany. Kątowy wymiar bazowy 

wstawia dodatkowy wymiar od wspólnego początku pierwszej linii przedłużającej 

poprzedniego wymiaru kątowego. Kątowy wymiar kontynuowany kontynuuje 

wymiar kątowy od drugiej linii przedłużenia poprzedniego wymiaru kątowego. 
 

Aby zwymiarować kąt objęty łukiem 

1 Wykonaj jedną z poniższych czynności, aby wybrać Angular (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Kątowe (w obszarze Wymiary). 

• W menu wybierz pozycję Wymiary > Kątowe. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Kąt. 

• Wpisz dimangular i naciśnij Enter. 

2 Wybierz łuk. 

3 Określ lokalizację łuku wymiaru. 

 
 

 
Aby zwiększyć kąty przedłużone przez łuk, 
wybierz opcję 
łuku (A), a następnie określ lokalizację 
wymiaru łuku (B). 

Wynik. 
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Aby zwymiarować kąt między dwiema liniami 

1 Wykonaj jedną z poniższych czynności, aby wybrać Angular (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Kątowe (w obszarze Wymiary). 

• W menu wybierz pozycję Wymiary > Kątowe. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Kąt. 

• Wpisz dimangular i naciśnij Enter. 

2 Wybierz jedną linię. 

3 Wybierz drugą linię. 

4 Określ położenie linii wymiarowej. 

 
 

 
Wybierz jedną linię (A), wybierz drugą linię (B), a 
następnie określ położenie linii wymiarowej (C). 

Wynik. 
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Tworzenie wymiarów łuku 

Wymiary łuku określają długość łuku lub segmentu łuku. Można również zwymiarować 

część łuku, wybierając dwa punkty. Po utworzeniu wymiaru łuku można zmienić 

jego tekst na kąt łuku lub dowolny inny tekst. 
 

Aby zwymiarować długość łuku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Arc (  ): 

• Na wstążce wybierz polecenie Adnotacje > Łuk (w obszarze Wymiary). 

• W menu wybierz kolejno opcje Wymiary > Łuk. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Łuk. 

• Wpisz dimarc i naciśnij Enter. 

2 Wybierz łuk lub segment łuku. 

3 Określ lokalizację łuku wymiaru. 

 
 

 
Aby zwymiarować długość łuku, wybierz łuk (A), a 
następnie określ lokalizację wymiarowania łuku 
(B). 

Wynik. 

 

 
Aby zwymiarować część długości łuku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Arc (  ): 

• Na wstążce wybierz polecenie Adnotacje > Łuk (w obszarze Wymiary). 

• W menu wybierz kolejno opcje Wymiary > Łuk. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Łuk. 

• Wpisz dimarc i naciśnij Enter. 

2 Wybierz opcję Częściowe. 

3 Wybierz punkt początkowy długości łuku, który chcesz zmierzyć. 

4 Wybierz punkt końcowy. 
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Aby zwymiarować część długości łuku, wybierz łuk 
(A), 
wybierz punkt początkowy (B) i punkt końcowy 
(C) mierzonej części, a następnie określ położenie 
łuku wymiarowego (D). 

Wynik. 

 

Tworzenie wymiarów średnicowych i promieniowych 

Wymiary średnicy i promienia zawierają adnotacje o promieniach i średnicach 

łuków i okręgów. Opcjonalnie można dołączyć linie środkowe lub znaczniki środka. 
 

Aby utworzyć wymiar średnicowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać średnicę (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Średnica (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Średnica. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Średnica. 

• Wpisz dimdiameter i naciśnij Enter. 

2 Wybierz łuk lub okrąg. 

3 Określ położenie linii wymiarowej. 

 
 

 
Wybierz okrąg (A), a następnie określ wymiar 
położenie linii (B). 

Wynik. 
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Aby utworzyć wymiar promieniowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Radius (Promień) (  ): 

• Na wstążce wybierz polecenie Adnotacja > Promień (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Promień. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Promień. 

• Wpisz dimradius i naciśnij Enter. 

2 Wybierz łuk lub okrąg. 

3 Określ położenie linii wymiarowej. 

 
 

 
Wybierz okrąg (A), a następnie określ położenie linii 
wymiarowej (B). 

 

Tworzenie wymiarów rzędnych 

Wynik. 

 

Wymiar rzędnej określa prostopadłą odległość od początku lub punktu bazowego 

(początku bieżącego układu współrzędnych użytkownika [UCS]). Wymiary 

porządkowe składają się ze współrzędnej x lub y oraz lidera. Wymiar współrzędnej 

x mierzy odległości wzdłuż osi x; wymiar współrzędnej y mierzy odległości wzdłuż 

osi y. 

Podczas wybierania punktów rzędnych program automatycznie określa, czy punkt 

jest współrzędną x czy y, na podstawie kierunku przeciągania drugiego punktu. Można 

również określić, czy rzędna reprezentuje współrzędną x czy y. Tekst wymiaru rzędnej jest 

zawsze wyrównany do linii odniesienia rzędnej, niezależnie od orientacji tekstu 

określonej przez bieżący styl wymiaru. 
 

Wymiary rzędnych mierzą odległość wzdłuż osi x lub y od początku do wybranego punktu rzędnych. 
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Aby utworzyć wymiar rzędnej 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ordinate (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Rzędne (w wymiarach). 

• W menu wybierz kolejno opcje Dimensions > Ordinate. 

• Na pasku narzędzi Dimensioning kliknij narzędzie Ordinate. 

• Wpisz dimordinate i naciśnij Enter. 

2 Wybierz punkt dla wymiaru rzędnej. 

3 Określa punkt końcowy rzędnej lidera. 

 
 

Wybierz punkt rzędnych (A), a następnie określ punkt końcowy lidera rzędnych (B). 
 

Wybór dokładnych punktów jest ważny podczas tworzenia wymiarów. 

Użyj przyciągania jednostek, aby wybrać precyzyjne punkty rzędnych. 
 

 
Tworzenie liderów i adnotacji 

Prowadnice składają się z linii lub serii linii łączących element na rysunku z 

adnotacją. Zazwyczaj w pierwszym punkcie umieszcza się grot strzałki. Adnotacja, 

utworzona jako tekst wymiaru, jest umieszczana bezpośrednio obok ostatniego 

punktu. Domyślnie tekst umieszczony na końcu linii prowadzącej składa się z 

ostatniego wymiaru. Adnotację można także wpisać jako pojedynczy wiersz tekstu. 
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Aby utworzyć lidera i adnotację 

1 Wykonaj jedną z poniższych czynności, aby wybrać Lidera (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Lider (w obszarze Wymiary). 

• W menu wybierz kolejno Wymiary > Lider. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Lider. 

• Wpisz dimleader i naciśnij Enter. 

2 Określ punkt początkowy lidera. 

3 Określa punkt końcowy segmentu linii prowadzącej. 

4 Określ dodatkowe punkty końcowe segmentu linii prowadzącej. 

5 Po określeniu ostatniego punktu końcowego naciśnij klawisz Enter. 

6 Wpisz adnotację lub naciśnij klawisz Enter, aby zaakceptować najnowszy 

wymiar jako domyślną adnotację. 

 
 

 
Określ punkt początkowy linii 
prowadzącej (A) i punkt końcowy 
segmentu linii prowadzącej (B). 

Wynik. 

 

Wymiarowanie jednostek przestrzeni modelu w przestrzeni papieru 

Aby zwiększyć wydajność, można oddzielić model rysunku od adnotacji za pomocą 

kart Model i Układ. 

Wyświetlanie wymiarów, bloków tytułowych, słów kluczowych i innych adnotacji 

jest czasochłonne. Jeśli narysujesz je na karcie Układ, czas wyświetlania i bałagan 

wizualny zostaną zredukowane podczas pracy nad modelem (na karcie Model). 

ALCAD umożliwia wymiarowanie jednostek przestrzeni modelu na karcie Model 

lub na karcie Układ - możesz dokonać wyboru w zależności od metody, która 

najlepiej odpowiada Twoim potrzebom. 
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Aby zwymiarować jednostki przestrzeni modelu w przestrzeni papieru 

1 Kliknij kartę Układ. 

2 Utwórz co najmniej jedną rzutnię układu. Szczegółowe informacje zawiera 

sekcja "Tworzenie rzutni układu" na stronie 525. 

3 Zablokuj żądaną rzutnię układu, wykonując następujące czynności: 

• Kliknij prawym przyciskiem myszy krawędź rzutni układu, której chcesz 

użyć do utworzenia wymiarów. 

• Wybierz opcję Właściwości. 

• Zaznacz opcję Zablokuj rzutnię, a następnie kliknij przycisk OK. 

Zablokowanie rzutni nie jest wymagane, ale jest niezwykle pomocne podczas 

powiększania lub przesuwania w rzutni układu; zapobiega zmianie skali rzutni i 

środka widoku. 
 

W rzutni układu można pracować bez zaśmiecania ekranu lub zaznaczeń. Umieść 

rzutnie układu na ich własnej warstwie, a po ich zablokowaniu ukryj warstwę, 

która je zawiera. 
 

 

4 Upewnij się, że pracujesz w przestrzeni papierowej, sprawdzając, czy 

przełącznik Model/Przestrzeń papierowa na pasku stanu zaczyna się od "P". W 

razie potrzeby przełącz się na przestrzeń papieru, klikając dwukrotnie 

przełącznik Model/Przestrzeń papieru na pasku stanu. 

5 Utwórz wymiar. Możesz wybrać encje przestrzeni modelu bezpośrednio, określić 

punkty definicji lub użyć przyciągania encji, aby pomóc w dokładnym wyborze 

punktów definicji. 

Wymiar jest tworzony w przestrzeni papierowej. 
 

Więcej informacji na temat korzystania z przestrzeni na papier i przestrzeni modelu 

można znaleźć w sekcji "Zrozumienie przestrzeni na papier i przestrzeni modelu" na 

stronie 518. 



 

Edytowanie 
wymiarów 
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Za pomocą uchwytów można edytować wymiary encji. Można również edytować 

tekst wymiaru. Linie wymiarowe i tekst wymiaru można obracać pod dowolnym 

kątem, a tekst wymiaru można zmienić w dowolnym miejscu wzdłuż linii 

wymiarowej. 

 

Tworzenie wymiarów ukośnych 

Linie przedłużające są zwykle tworzone pod kątem prostopadłym do linii 

wymiarowej. Można jednak zmienić kąt linii przedłużających, tak aby nachylały się 

względem linii wymiarowej. 
 

Aby utworzyć ukośne linie przedłużające 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Make Oblique (  ): 

• Na wstążce wybierz polecenie Adnotacje > Utwórz ukośne (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Utwórz skos. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Utwórz skos. 

• Wpisz dimedit, naciśnij Enter, a następnie w oknie zachęty wybierz Oblique Lines. 

2 Wybierz wymiar liniowy, a następnie naciśnij klawisz Enter. 

3 Wpisz kąt pochylenia, a następnie naciśnij klawisz Enter. 

 
 

 
Wybierz wymiar skosu (A) i wpisz kąt skosu. Wynik. 

 
 

 

Jeśli nie znasz dokładnego pomiaru, możesz ustawić kąt ukośny. 

Użyj zatrzasków jednostki, aby wybrać dwa punkty na jednostce. 
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Edycja tekstu wymiaru 

Można obrócić tekst istniejącego wymiaru, przenieść tekst wymiaru do nowej 

pozycji lub zastąpić zaznaczony tekst wymiaru nowym tekstem. Tekst wymiaru 

można także przywrócić do pierwotnego położenia zdefiniowanego przez bieżący 

styl wymiaru. 

Podczas obracania lub zamieniania zaznaczonego tekstu należy najpierw określić 

zmianę, a następnie wybrać jeden lub więcej wymiarów, do których zmiana ma 

zostać zastosowana. Wszystkie wybrane wymiary są aktualizowane jednocześnie. 
 

Aby obrócić tekst wymiaru 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obróć wymiar tekstu (  ): 

• Na wstążce wybierz polecenie Adnotacje > Obróć tekst wymiaru (w obszarze Wymiary). 

• W menu wybierz kolejno Wymiary > Obróć tekst wymiaru. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Obróć tekst wymiaru. 

• Wpisz dimedit, naciśnij Enter, a następnie w oknie zachęty wybierz Obróć tekst. 

2 Wpisz nowy kąt tekstu wymiaru, a następnie naciśnij klawisz Enter. 

3 Wybierz wymiar, który ma zostać obrócony, a następnie naciśnij klawisz Enter. 

 
 

 
Wybierz wymiar, który ma zostać obrócony 
(A), a następnie wpisz kąt obrotu. 

Wynik. 

 
 

 

Kąt tekstu wymiaru jest względny w stosunku do linii wymiarowej. 

Jeśli obrót tekstu wymiaru jest ustawiony na zero, kąt tekstu jest definiowany przez 

typ wymiaru i styl wymiaru. 
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Aby przenieść tekst wymiaru 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zmień położenie tekstu wymiaru 

(  ): 

• Na wstążce wybierz polecenie Adnotacje > Zmień położenie tekstu wymiaru (w obszarze 

Wymiary). 

• W menu wybierz polecenie Wymiary > Zmień położenie tekstu wymiaru. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Zmień położenie tekstu wymiaru. 

• Wpisz dimtedit i naciśnij Enter. 

2 Wybierz wymiar, aby zmienić położenie tekstu. 

3 Wybierz nową pozycję tekstu. 
 

 
Wybierz wymiar, który ma zostać usunięty (A), a 
następnie wybierz 
nowa pozycja tekstu (B). 

Aby przywrócić wymiar tekstu do pozycji 
wyjściowej 

Zaawansowany poziom doświadczenia 

Wynik. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przywróć pozycję tekstu (  ): 

• Na wstążce wybierz polecenie Adnotacje > Przywróć położenie tekstu (w wymiarach). 

• W menu wybierz kolejno opcje Wymiary > Przywróć pozycję tekstu. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Przywróć pozycję tekstu. 

• Wpisz dimedit, naciśnij Enter, a następnie w oknie zachęty wybierz Przywróć tekst. 

2 Wybierz tekst wymiaru do przywrócenia, a następnie naciśnij klawisz Enter. 
 

Aby zastąpić istniejący tekst wymiaru nowym tekstem 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj tekst wymiaru (  ): 

• Na wstążce wybierz polecenie Adnotacje > Edytuj tekst wymiaru (w obszarze Wymiary). 

• W menu wybierz kolejno Wymiary > Edytuj tekst wymiaru. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Edytuj tekst wymiaru. 

• Wpisz dimedit, a następnie w oknie zachęty wybierz Edytuj tekst. 

2 Wpisz nowy tekst wymiaru, a następnie naciśnij klawisz Enter. 

3 Wybierz wymiar, który ma zostać zastąpiony, a następnie naciśnij klawisz Enter. 
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Aby przywrócić oryginalną wartość tekstu wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Resetuj tekst wymiaru (  ): 

• Na wstążce wybierz kolejno Express Tools > Resetuj tekst wymiaru (w wymiarze). 

• W menu wybierz kolejno Express Tools > Dimensions > Reset Dimension Text. 

• Wpisz dimreassoc i naciśnij Enter. 

2 Wybierz tekst wymiaru do przywrócenia, a następnie naciśnij klawisz Enter. 
 

Aby ponownie powiązać tekst wymiaru z nową jednostką lub punktem na jednostce 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Reassociate Dimensions (  ): 

• Na wstążce wybierz polecenie Adnotacje > Ponownie skojarz wymiary (w obszarze 

Wymiary). 

• W menu wybierz Wymiary > Ponownie skojarz wymiary. 

• Wpisz dimreassociate, a następnie naciśnij Enter. 

2 Wybierz wymiary, które chcesz ponownie powiązać z inną jednostką lub 

punktem, a następnie naciśnij klawisz Enter. 

3 Postępuj zgodnie z instrukcjami, aby wybrać nową jednostkę lub punkt na 

jednostce. Wyświetlane monity różnią się w zależności od wybranego typu 

wymiarów. 



D Y M E N S J O N A L I Z A C J A D R A W N O Ś C I 445 

 

Używanie stylów wymiarów i zmiennych 
 

Wstawiane wymiary t są tworzone przy użyciu bieżącego stylu wymiaru. Nazwane 

style wymiarów można tworzyć, zapisywać, przywracać i usuwać. 

Aby wyświetlić informacje o bieżącym stylu wymiaru i porównać go z innymi 

nazwami stylów, można użyć polecenia dimstyle. 

 

Tworzenie stylu wymiaru 

Style wymiarów umożliwiają zmianę różnych ustawień kontrolujących wygląd 

wymiarów. Ustawienia te można następnie zapisać w celu ponownego użycia. Jeśli 

styl wymiaru nie zostanie zdefiniowany przed utworzeniem wymiarów, program 

użyje stylu wymiaru Standardowy, który przechowuje domyślne ustawienia 

zmiennych wymiaru. Każda opcja w oknie dialogowym Style wymiarów odnosi się 

do zmiennej, którą można ustawić ręcznie. Więcej informacji można znaleźć w 

internetowym podręczniku poleceń. 
 

Aby utworzyć styl wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Style wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wymiarów kliknij przycisk Nowy. 

3 Wpisz nazwę nowego stylu wymiaru. 

4 Kliknij przycisk Kontynuuj. 

5 W oknie dialogowym Style wymiarów dokonaj odpowiednich wyborów stylu 

wymiaru. 

6 Po zakończeniu kliknij przycisk OK. 
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Wybieranie stylu wymiaru 

Aby wybrać styl wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Style wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wymiaru wybierz styl wymiaru z 

listy. 

3 Kliknij przycisk Ustaw bieżący. 

4 Kliknij przycisk Zamknij. 

 
Zmiana nazwy stylu wymiaru 

Aby zmienić nazwę stylu wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 W oknie dialogowym Menedżer stylów wymiarów kliknij przycisk Zmień nazwę. 

3 Z listy Zmień nazwę wybierz styl wymiaru, którego nazwę chcesz zmienić. 

4 Wpisz nazwę nowego stylu wymiaru. 

5 Kliknij przycisk Zmień nazwę. 

6 Kliknij przycisk OK. 
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Usuwanie stylu wymiaru 

Aby usunąć nazwany styl wymiaru 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 W oknie dialogowym Style wymiaru wybierz styl wymiaru do usunięcia. 

3 Kliknij przycisk Usuń. 

4 Aby potwierdzić usunięcie, kliknij OK. 

5 Kliknij przycisk OK. 
 

Aby wyświetlić informacje o bieżącym stylu 

1 Wpisz dimstyle i naciśnij Enter. 

2 Wpisz v, a następnie naciśnij Enter, aby wyświetlić informacje o zmiennych. 

3 Wpisz nazwę stylu wymiaru i naciśnij klawisz Enter. 

 
Kontrolowanie ustawień linii 

Można kontrolować ustawienia wpływające na linie wymiarowe, linie przedłużające 

i znaczniki środka. Wszelkie wprowadzone zmiany mają wpływ na bieżący styl 

wymiarowania. Kafelek obrazu po prawej stronie okna dialogowego Style 

wymiarowania przedstawia wygląd wymiarów w oparciu o bieżące ustawienia stylu 

wymiarowania. 

 
 

 
A Rozszerzenie poza 

wymiar. 

B Przesunięcie linii 
bazowej. 

C Przesunięcie od początku. 
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Aby ustawić kolor linii wymiarowych 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Linie. 

3 Dokonaj wyboru. 
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A 

B 

C 

D 

E 

F 

G 

 

H 

I 

J O 

K N 

L M 

 
 

 
A Wybierz kolor linii wymiarowej. 

B Wybierz typ linii wymiaru. 

C Typy zarządzania kliknięciami 
wALCADExplorer. 

D Wybierz grubość linii wymiaru. 

E Wpisz odległość, na jaką linie wymiarowe 
wykraczają poza znaczniki. 

F Typeorselect the baseline offset distance 
(odległość przesunięcia kolejnych linii 
wymiarowych podczas tworzenia wymiarów 
linii bazowej) i offset fromorigin (odległość 
przesunięcia linii rozszerzenia od ich 
punktów początkowych). 

G Kliknij , aby zapobiec utworzeniu pierwszej 
lub drugiej linii wymiarowej. 

 
H Wybierz kolor linii przedłużającej. 

I Wybierz typ linii pierwszego rozszerzenia. 

J Wybierz typ linii drugiej linii wewnętrznej. 

K Wybierz przedłużenie lineweight. 

L Kliknij , aby zapobiec utworzeniu pierwszej 
lub drugiej linii wewnętrznej. 

M Kliknij, aby ustawić długość linii wewnętrznych, a 
następnie wpisz lub wybierz długość linii 
wewnętrznej. 

N Wpisz lub wybierz odległość, aby odsunąć 
linie rozszerzeń od linii wymiarowych. 

O Wpisz lub wybierz odległość, aby 
przesunąć linie rozszerzenia od ich 
początku. 



450 C H A P T E R 1 2 

 

Kontrolowanie strzałek wymiarów 

Można kontrolować wygląd i rozmiar grotów strzałek lub znaczników 

umieszczanych na końcach linii wymiarowych. Wszelkie wprowadzone zmiany 

mają wpływ na bieżący styl wymiarowania. Wybrane groty strzałek są wyświetlane 

na kafelku obrazu po prawej stronie okna dialogowego Style wymiarów. 

Można wybierać spośród wielu typów grotów strzałek. Można określić różne groty 

strzałek dla każdego końca linii wymiarowej i dla linii pomocniczych. Strzałka 

początkowa odpowiada pierwszej linii przedłużenia; strzałka końcowa odpowiada drugiej linii 

przedłużenia. Bloki zdefiniowane na rysunku są również wyświetlane na trzech 

listach strzałek jako strzałki zdefiniowane przez użytkownika. Za pomocą tych 

bloków można tworzyć i przypisywać własne groty strzałek. 

Wartość Rozmiar strzałki określa rozmiar grotu strzałki, mierzony w jednostkach 

rysunkowych. Zamiast grotów strzałek można również używać znaczników. 

Aby wybrać grot strzałki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Symbole i strzałki. 

3 Na liście Początkowy grot strzałki lub Końcowy grot strzałki kliknij, aby wybrać 

odpowiednio początkowy lub końcowy grot strzałki. W razie potrzeby zaznacz 

opcję Allow Separate Arrowheads, jeśli chcesz użyć różnych początkowych i 

końcowych grotów strzałek. 

4 Na liście Grot strzałki prowadzącej kliknij, aby wybrać grot strzałki prowadzącej dla linii 

prowadzących. 

5 Kliknij przycisk OK. 

 

Użyj zmiennej systemowej. 

Zmienna systemowa DIMLDRBLK również określa typy strzałek liderów. 
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A 

B 

C 

D 

E 

F 
K 

 

G 

H J 

I 

 

 
A Wybierz, aby włączyć możliwość 

używania różnych początkowych i 
końcowych grotów strzałek. 

B Kliknij, aby wybrać początkowy grot strzałki, 
lub kliknij obrazek grotu strzałki, aby 
automatycznie przewinąć listę. 

C Kliknij, aby wybrać końcowy grot strzałki, lub 
kliknij obrazek grotu strzałki, aby automatycznie 
przewinąć listę. 

D Kliknij, aby wybrać grot strzałki lidera, lub 
kliknij obrazek grotu strzałki, aby automatycznie 
przewinąć listę. 

E Wpisz lub wybierz rozmiar grotu strzałki. 

F Wybierz opcję włączenia znaczników 
zamiast grotów strzałek, a następnie 
wybierz rozmiar znaczników. 

 
G Wybierz symbol znaczników środka. 

H Wartości dodatnie tworzą znacznik środka. 
Wartości ujemne tworzą linie środkowe. 

I Wpisz lub wybierz kąt dla impulsów o 
wymiarach promienia. 

J Wpisz lub wybierz współczynnik skali dla 
wysokości impulsowania wymiarów 
liniowych. 

K Wybór miejsca umieszczenia symboli 
łuku dla wymiarów łuku. 
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Kontrolowanie tekstu wymiaru 

Można kontrolować ustawienia wpływające na wygląd tekstu wymiaru. Wszelkie 

wprowadzone zmiany mają wpływ na bieżący styl wymiaru. Kafelek obrazu po prawej 

stronie okna dialogowego Style wymiarów przedstawia wygląd wymiarów w oparciu 

o bieżące ustawienia stylu wymiarów. 

 

 
Wyrównanie tekstu między wierszami rozszerzenia 
poziomo. 

 

Aby wyrównać tekst wymiaru z linią 
wymiarową 

Tekst między liniami rozszerzeń 
wyrównane z linią wymiarową. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Tekst. 

3 Dokonaj wyboru. 

4 Kliknij przycisk OK. 
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A 

B 

C 

D 

E 

 

F 

G 

H 

I 

 

J M 

K L 
 
 
 

A Kliknij, aby wybrać styl tekstu używany dla 
tekstu wymiaru. Kliknij Eksplorator, aby 
zarządzać stylami tekstu w Eksploratorze 
ALCAD. 

B Wybierz kolor tekstu wymiaru. 

C Wybierz brak, kolor rysunku lub kolor 
użytkownika dla koloru tła tekstu wymiaru. 

D Wybierz kolor tła tekstu wymiarowego 
(dostępny, jeśli dla opcji Tło tekstu 
wybrano kolor użytkownika). 

E Wpisz lub wybierz wysokość tekstu 
mierzoną w jednostkach 
rysunkowych. 

F Wybierz pionowe justowanie tekstu wymiaru. 

 
G Wpisz lub wybierz odległość przesunięcia tekstu w pionie. 

H Wybierz poziome justowanie tekstu wymiaru. 

I Wybierz kierunek widoku tekstu wymiaru. 

J Wybierz wyrównanie, gdy tekst wymiaru 
znajduje się poza liniami wewnętrznymi. 

K Wybierz wyrównanie, gdy tekst wymiaru znajduje się 
wewnątrz linii rozszerzeń. 

L Wpisz lub wybierz odległość wokół tekstu 
wymiaru. 

M Kliknij, aby umieścić ramkę wokół tekstu wymiaru. 
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Kontrola dopasowania wymiarów 

Można kontrolować sposób, w jaki tekst wymiaru i groty strzałek są umieszczane 

względem linii wymiarowych. Można również kontrolować sposób skalowania 

wymiaru, wybierając, czy ma on domyślnie zawierać adnotacje, czy też ma być 

skalowany zgodnie z określoną skalą lub zgodnie z układem. Wszelkie wprowadzone 

zmiany mają wpływ na bieżący styl wymiaru. Kafelek obrazu po prawej stronie okna 

dialogowego Style wymiarów przedstawia wygląd wymiarów w oparciu o bieżące 

ustawienia stylu wymiarów. 

Program określa, czy zarówno tekst wymiaru, jak i groty strzałek zmieszczą się 

między liniami rozszerzenia, porównując odległość między liniami rozszerzenia z 

rozmiarem tekstu wymiaru, rozmiarem grotów strzałek i ilością miejsca 

wymaganego wokół tekstu wymiaru. Program stosuje metodę najlepszego 

dopasowania w oparciu o dostępną przestrzeń. Jeśli to możliwe, zarówno tekst 

wymiaru, jak i groty strzałek są umieszczane między liniami pomocniczymi. Jeśli 

oba elementy nie mieszczą się między liniami pomocniczymi, można określić sposób 

umieszczania tekstu i grotów strzałek za pomocą ustawień Fit Method w oknie 

dialogowym Dimension Styles. 

 

 
Umieszczony tekst i strzałki 
zewnętrzne linie wewnętrzne. 

 
 

Aby sformatować 
dopasowanie wymiarów 

Tekst umieszczony pomiędzy 
rozszerzeniem 
linie i groty strzałek poza 
liniami wewnętrznymi. 

Tekst umieszczony powyżej 
linia wymiarowa z linią 
łączącą tekst z linią 
wymiarową. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Dopasowanie. 

3 Kliknij żądane opcje. 

4 Kliknij przycisk OK. 

 

Użyj zmiennych systemowych. 

Zmienna systemowa DIMATFIT określa sposób rozmieszczenia tekstu wymiaru i 

strzałek. Zmienna systemowa DIMTMOVE określa sposób przesuwania tekstu 

wymiaru. 
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A 

 

 
B 

C 

D 

 

 

E H 

F G 

 
 
 

A Wybierz sposób dopasowania tekstu i 
strzałek, jeśli nie mieszczą się one w liniach 
rozszerzeń. 

B Wybierz, aby zawsze umieszczać linie 
rozszerzeń obok siebie. 

C Wybierz, aby zapobiec tworzeniu strzałek, 
jeśli nie mieszczą się one w liniach 
rozszerzeń. 

D Wybierz, aby rysować linie wymiarowe 
między liniami przedłużenia, gdy tekst i 
strzałki są umieszczone poza liniami 
przedłużenia. 

E Wybierz sposób pozycjonowania tekstu 
względem linii wymiarowych i czy ma być 
dołączony lider. 

F Wybierz, aby podczas tworzenia wymiarów 
był wyświetlany monit o umieszczenie 
tekstu. 

G Wybierz, aby przeskalować wymiar 
zgodnie z układem lub zastosować inną 
skalę do wszystkich ustawień stylu 
wymiaru (dostępne tylko wtedy, gdy nie 
wybrano opcji Adnotacje). 

H Wybierz, aby wymiar domyślnie obsługiwał 
skalowanie adnotacji. 
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Kontrolowanie jednostek wymiaru podstawowego 

Można określić wygląd i format podstawowych jednostek wymiaru. Kafelek obrazu 

po prawej stronie okna dialogowego Style wymiarów przedstawia wygląd wymiarów 

w oparciu o bieżące ustawienia stylu wymiarów. 

 

 
Zaokrąglij odległość do .0100 
(oryginalny wymiar przed 
zaokrągleniem). 

Odległość zaokrąglenia 
ustawiona na 
0.2500. 

Ustawiona odległość zaokrąglenia 
do 1,0000. 

 
Aby ustawić podstawowe jednostki wymiarów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Jednostki podstawowe. 

3 Dokonaj wyboru. 

4 Kliknij przycisk OK. 

 

Użyj zmiennych systemowych. 

Zmienna systemowa DIMLUNIT określa jednostki dla wymiarów liniowych. Zmienna 

systemowa DIMFRAC określa formaty ułamkowe. 
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A Wybierz format jednostki wymiaru liniowego. 

B Wpisz lub wybierz liczbę miejsc dziesiętnych 
dla tekstu o wymiarach liniowych. 

C Wybierz format ułamków tekstowych o 
wymiarach liniowych. 

D Wprowadź symbol znacznika używany dla 
ułamków dziesiętnych. 

E Wpisz lub wybierz najbliższą wartość do 
zaokrąglenia dla odległości liniowych. 

F Typ przedrostka dodawanego do tekstu 
wymiaru. 

G Typ jako sufiks dodawany do tekstu 
wymiaru liniowego. 

H Wybierz, aby zapobiec dołączaniu 
końcowych zer dla tekstu o wymiarze 
liniowym. 

I Wybierz, aby zapobiec włączeniu znaków 
wiodących dla tekstu o wymiarach 
liniowych. 

 
J Wybierz, aby zapobiec uwzględnianiu cali 

lub stóp w tekście wymiaru, gdy 
odpowiednia liczba cali lub stóp wynosi 
zero. 

K Wybierz, aby zapobiec włączeniu 
wiodących zera dla wymiarów kątowych. 

L Wybierz format jednostki wymiaru kątowego. 

M Wpisz lub wybierz liczbę miejsc dziesiętnych dla 
wymiarów kątowych. 

N Wybierz, aby zapobiec dołączaniu 
końcowych zer dla wymiarów kątowych. 

O Wpisz lub wybierz współczynnik skali 
liniowej stosowany do wszystkich długości 
mierzonych za pomocą poleceń 
wymiarowania. 

P Wpisz lub wybierz współczynnik skali 
stosowany do wszystkich wymiarów. 
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Kontrolowanie jednostek wymiaru alternatywnego 

Oprócz tekstu wymiaru podstawowego można dołączyć wymiary alternatywne. Można 

również określić wygląd i format wymiarów alternatywnych, w tym współczynnik 

skali stosowany do generowania wymiarów alternatywnych. Kafelek obrazu po 

prawej stronie okna dialogowego Style wymiarów przedstawia wygląd wymiarów w 

oparciu o bieżące ustawienia stylu wymiarów. 
 

Wymiar alternatywny utworzony przy użyciu współczynnika skali 25,4 z dołączonym przyrostkiem. 

 

Aby kontrolować jednostki alternatywnych wymiarów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Jednostki alternatywne. 

3 Wybierz opcję Wyświetl alternatywne jednostki. 

4 Dokonaj wyboru. 

5 Kliknij przycisk OK. 
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A Wybierz, aby dołączyć alternatywne jednostki do 

tekstu wymiaru. 

B Kliknij, aby wybrać format tekstu o 
zmienionym rozmiarze. 

C Wpisz lub wybierz liczbę miejsc 
dziesiętnych wyświetlanych w tekście 
wymiaru alternatywnego. 

D Wpisz lub wybierz współczynnik skali 
zastosowany do zmierzonych wymiarów w 
celu wygenerowania tekstu wymiaru 
alternatywnego. 

E Zignoruj wszelkie zaokrąglenia dla 
tekstu wymiaru alternatywnego. 

F Wpisz prefiks, który zostanie 
dołączony do tekstu wymiaru 
alternatywnego. 

G Wpisz przyrostek, który zostanie 
dołączony do tekstu wymiaru 
alternatywnego. 

H Wybierz umieszczenie tekstu wymiaru 
alternatywnego. 

I Wybierz, aby zapobiec dołączaniu 
końcowych zer dla tekstu alternatywnego 
wymiaru. 

J Wybierz, aby zapobiec uwzględnianiu 
znaków wiodących w tekście wymiaru 
alternatywnego. 

K Wybierz, aby zapobiec uwzględnianiu cali 
lub stóp w tekście wymiaru 
alternatywnego, gdy odpowiednia liczba 
cali lub stóp wynosi zero. 

L Wybierz, aby zapobiec włączeniu 
wiodących zera dla tolerancji 
uwzględnionych jako część wymiarów 
alternatywnych. 

M Wybierz, aby zapobiec włączeniu końcowych zer dla 
tolerancji zawartych w alternatywnych wymiarach. 

N Wybierz, aby zapobiec uwzględnianiu cali 
lub stóp dla tolerancji uwzględnionych jako 
część wymiarów alternatywnych, gdy 
odpowiednia liczba cali lub stóp wynosi zero. 

O Wpisz liczbę miejsc dziesiętnych 
wyświetlanych w limitach lub tolerancjach 
uwzględnionych jako część wymiarów 
alternatywnych. 
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Dodawanie tolerancji geometrycznych 
 

Tolerancje geometryczne wskazują maksymalne dopuszczalne odchylenia w 

geometrii zdefiniowanej przez rysunek. ALCAD rysuje tolerancje geometryczne 

za pomocą ramki kontrolnej elementu, która jest prostokątem podzielonym na 

przedziały. 

 

Zrozumienie tolerancji geometrycznych 

Każda ramka kontrolna elementu składa się z co najmniej dwóch przedziałów. 

Pierwszy przedział zawiera symbol tolerancji geometrycznej, który wskazuje 

charakterystykę geometryczną, do której stosowana jest tolerancja, taką jak lokalizacja, 

orientacja lub kształt. Na przykład tolerancja kształtu może wskazywać płaskość lub 

okrągłość powierzchni. Symbole tolerancji geometrycznych i ich charakterystyki 

przedstawiono w poniższej tabeli. 

 
Geometryczne symbole tolerancji 

Symbol Charakterystyka Typ 
 

 
Pozycja Lokalizacja 

 

 
Koncentryczność lub 
współosiowość 

Lokalizacja 

 
 Symetria Lokalizacja 

 

 
Równoległość Orientacja 

 

 Prostopadłość Orientacja 

 

 Kątowość Orientacja 

 

 
Cylindryczność Formularz 

 

 Płaskość Formularz 

 

 
Okrągłość lub okrągłość Formularz 

 
 

 
 

Prostoliniowość 
 

Profil powierzchni 

Formularz 
 

Profil 

 

 Profil linii Profil 

 

 Bicie okrągłe Bicie 

 

 
Bicie całkowite Bicie 



 SymbolDefinition 
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Drugi przedział zawiera wartość tolerancji. W stosownych przypadkach wartość 

tolerancji jest poprzedzona symbolem średnicy, a następnie symbolem warunków 

materiałowych. Warunki materiałowe mają zastosowanie do elementów, które mogą 

różnić się rozmiarem. Symbole warunków materiałowych i ich znaczenie 

przedstawiono w poniższej tabeli. 

 
Warunki materialne 

 

Przy maksymalnym stanie materiału (MMC) funkcja zawiera maksymalną ilość 
materiału określoną w limitach. 

Przy najmniejszym stanie materiału (LMC), element zawiera minimalną ilość 
materiału określoną w limitach. 

Niezależnie od rozmiaru elementu (RFS) wskazuje, że element może mieć 
dowolny rozmiar w podanych granicach. 

 
Po wartości tolerancji mogą następować podstawowe, drugorzędne i trzeciorzędne 

litery odniesienia układu odniesienia, wraz z warunkami materiałowymi każdego 

układu odniesienia. Litery odniesienia układu odniesienia są zwykle używane jako tolerancje 

odniesienia do jednej z maksymalnie trzech prostopadłych płaszczyzn, z których 

dokonywany jest pomiar, chociaż litery odniesienia układu odniesienia mogą 

również wskazywać dokładny punkt lub oś. 

 
 

 
A Geometryczny symbol 

charakterystyczny. 

B Symbol średnicy. 

C Wartość tolerancji. 

D Symbol stanu materiału. 

E Odniesienie do układu odniesienia. 

 

Gdy dwie tolerancje mają zastosowanie do tej samej geometrii, można również 

dodać tolerancję złożoną składającą się z podstawowej wartości tolerancji, po której 

następuje dodatkowa wartość tolerancji. Aby uczynić tolerancję jeszcze bardziej 

szczegółową, może ona również zawierać tolerancję rzutowaną składającą się z wartości 

wysokości, po której następuje symbol tolerancji rzutowanej. Na przykład można 

użyć przewidywanej tolerancji, aby wskazać prostopadłość osadzonej części. 
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Dodawanie tolerancji geometrycznej 

Aby dodać tolerancję geometryczną 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Tolerancja (  ): 

• Na wstążce wybierz kolejno opcje Adnotacje > Tolerancja (w wymiarach). 

• W menu wybierz kolejno Wymiary > Tolerancja. 

• Na pasku narzędzi Wymiarowanie kliknij narzędzie Tolerancja. 

• Wpisz tolerancja, a następnie naciśnij klawisz Enter. 

2 Aby wyświetlić symbole tolerancji geometrycznej, w pierwszym wierszu kliknij pole Sym. 

3 Kliknij, aby wybrać symbol tolerancji geometrycznej. 

4 W obszarze Tolerancja 1 kliknij pole Dia, aby dodać symbol średnicy. 

5 W polu wpisz pierwszą wartość tolerancji. 

6 Aby wyświetlić symbole stanu materiału, kliknij pole M.C.. 

7 Kliknij, aby wybrać stan materiału. 

8 W sekcji Tolerancja 2 powtórz kroki od 4 do 7, aby w razie potrzeby dodać 

dodatkową wartość tolerancji. 

9 W polu Datum 1 wpisz literę odniesienia głównego układu odniesienia. 

10 Aby wyświetlić symbole stanu materiału, kliknij pole M.C.. 

11 Kliknij, aby wybrać stan materiału. 

12 Powtórz kroki od 9 do 11, aby dodać drugorzędny i trzeciorzędny układ odniesienia, jeśli to 

konieczne. 

13 W drugim wierszu powtórz kroki od 2 do 12, aby w razie potrzeby dodać 

tolerancje kompozytowe. 

14 W polu Wysokość wpisz przewidywaną wartość wysokości strefy tolerancji, jeśli to 

konieczne. 

15 Aby wstawić symbol przewidywanej strefy tolerancji, kliknij pole 

Przewidywana strefa tolerancji. 

16 Kliknij przycisk OK. 

17 Na rysunku określ lokalizację ramki elementu. 
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A 

 
B D 

C 

 
 

 
A Użyj tego wiersza, aby uwzględnić złożone 

tolerancje. 

B Wpisz przewidywaną wartość wysokości tolerancji. 

C Wpisz identyfikator układu odniesienia. 

D Kliknij, aby dołączyć przewidywany symbol 
tolerancji. 

E Kliknij, aby wybrać symbol warunków 
materiałowych dla danych trzeciorzędnych. 

F Wpisz literę odniesienia trzeciorzędowego układu 
odniesienia. 

G Kliknij, aby wybrać symbol stanu materiału 
dla drugorzędnego układu odniesienia. 

H Wpisz literę referencyjną wtórnego układu 
odniesienia. 

I Kliknij, aby wybrać symbol stanu materiału dla 
podstawowego układu odniesienia. 

 
J Wpisz literę odniesienia głównego układu odniesienia. 

K Kliknij, aby wybrać symbol stanu materiału dla 
drugiej wartości tolerancji. 

L Wpisz drugą wartość tolerancji. 

M Kliknij, aby dołączyć symbol średnicy dla drugiej wartości 
tolerancji. 

N Kliknij, aby wybrać symbol warunków 
materiałowych dla pierwszej wartości tolerancji. 

O Wpisz pierwszą wartość tolerancji. 

P Kliknij, aby dołączyć symbol średnicy do pierwszej 
wartości tolerancji. 

Q Kliknij, aby wybrać symbol tolerancji geometrycznej. 

 
 

Kontrola tolerancji wymiarów 

Wymiary można tworzyć jako wymiary tolerancji lub limity. Podczas tworzenia 

wymiaru tolerancji można kontrolować górną i dolną granicę tolerancji, a także liczbę miejsc 

dziesiętnych tekstu wymiaru. Kafelek graficzny po prawej stronie okna dialogowego 

Style wymiarów przedstawia wygląd wymiarów tolerancji i limitów w oparciu o 

bieżące ustawienia stylu wymiarów. 
 

Wymiar tolerancji. Wymiar graniczny. 
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Wyświetlanie wartości tolerancji zera zależy od jednostek pomiarowych. 

Rysunki metryczne są zgodne z metrycznymi normami wymiarowymi ISO i 

wyświetlają zerowe wartości tolerancji bez znaku plus lub minus (0,0). W przypadku 

rysunków imperialnych zerowe wartości tolerancji są wyświetlane ze znakiem plus lub 

minus (+0,0 lub -0,0). Aby sprawdzić typ pomiaru rysunku, należy użyć zmiennej 

systemowej MEASUREMENT. 
 

 
Kontrola tolerancji wymiarów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Menedżer stylów wymiarów (  ): 

• Na wstążce wybierz polecenie Adnotacje > Menedżer stylów wymiarów (w obszarze 

Wymiary). 

• W menu wybierz kolejno Wymiary > Menedżer stylów wymiarów lub 

Format > Menedżer stylów wymiarów. 

• Na pasku narzędzi Wymiarowanie lub Style kliknij narzędzie Menedżer 

stylów wymiarowania. 

• Wpisz setdim i naciśnij Enter. 

2 Kliknij kartę Tolerancja. 

3 Dokonaj wyboru. 

4 Kliknij przycisk OK. 
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A 

B 

C 

D 

E 

F 

G 

H 

I 

 
J 
K 

 
 

 
A Wybierz, aby wstawić wartość tolerancji plus i 

minus do tekstu wymiaru. 

B Wybierz, aby wstawić górną i dolną granicę 
tolerancji z tekstem wymiaru. 

C Wpisz lub wybierz liczbę miejsc 
dziesiętnych wyświetlanych w tekście limitów 
lub wymiarów tolerancji. 

D Wybierz minimalną tolerancję lub dolną 
wartość graniczną. 

E Wpisz lub wybierz maksymalną tolerancję 
lub górną wartość graniczną. 

 
F Wpisz lub wybierz współczynnik skali 

stosowany do wysokości limitów lub 
tekstu wymiaru tolerancji. 

G Wybierz pionowe uzasadnienie 
limitów lub tekstu wymiaru tolerancji. 

H Wybierz, aby zapobiec włączeniu końcowych 
zer w limitach lub tekście wymiaru tolerancji. 

I Wybierz, aby zapobiec włączeniu 
wprowadzających zera limitów lub tekstu 
wymiaru tolerancji. 

J Wybierz, aby zapobiec uwzględnianiu cali 
lub stóp w tekstach limitów lub wymiarów 
tolerancji, gdy odpowiednia liczba cali lub 
stóp wynosi zero. 
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Bloki, atrybuty i odniesienia zewnętrzne zapewniają mechanizmy zarządzania 

jednostkami w rysunkach i dołączania dodatkowych informacji do standardowych 

jednostek rysunkowych. Za pomocą bloków można połączyć wiele elementów w 

jeden element, a następnie użyć go ponownie, wstawiając wiele kopii. Za pomocą 

atrybutów można powiązać tekst, taki jak numery części lub ceny, z blokami, a 

następnie wyodrębnić informacje tekstowo-atrybutowe do osobnego pliku, takiego jak 

baza danych, w celu dalszej analizy. W przypadku odniesień zewnętrznych można 

połączyć oddzielne pliki rysunków referencyjnych z rysunkiem w celu połączenia 

informacji bez dodawania zawartości rysunków referencyjnych do bieżącego 

rysunku. W przypadku wprowadzenia zmian w pliku odniesienia, wszystkie 

odniesienia są aktualizowane automatycznie. 

W tej sekcji wyjaśniono, jak 

• Tworzenie, wstawianie i redefiniowanie bloków. 

• Tworzenie, edytowanie i wstawianie atrybutów. 

• Wyodrębnienie danych atrybutów do osobnego pliku. 

• Dołączanie i praca z zewnętrznymi referencjami i podkładami. 

• Używaj obrazów w swoich rysunkach. 

 

 

 

 

 

 

 

 

 
Tematy w tym rozdziale 

Praca z blokami  .............................................................................................. 468 

Praca z atrybutami  .......................................................................................... 482 

Praca z odnośnikami zewnętrznymi  ................................................................ 488 

Dołączanie podkładów utworzonych w innych formatach plików  .................... 500 

Praca z obrazami  ............................................................................................ 504 

13  

Praca z innymi plikami w rysunkach 
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Praca z blokami 
 

Zazwyczaj bloki to kilka elementów połączonych w jeden, który można wstawić do 

rysunku i manipulować nim jak pojedynczym elementem. Blok może składać się z 

widocznych elementów, takich jak linie, łuki i okręgi, a także widocznych lub 

niewidocznych danych zwanych atrybutami. Bloki są przechowywane jako część pliku 

rysunku. 

 

Zrozumienie bloków 

Bloki mogą pomóc w lepszej organizacji pracy, szybkim tworzeniu i poprawianiu 

rysunków oraz zmniejszeniu rozmiaru pliku rysunku. Korzystając z bloków, można 

utworzyć bibliotekę często używanych symboli. Następnie można wstawić symbol 

jako blok, zamiast rysować go od nowa. 

Po utworzeniu bloku z wielu jednostek, zapisuje się go raz, co również oszczędza 

miejsce na dysku. Można wstawić tylko wiele odwołań do pojedynczej definicji 

bloku. Można zmienić definicję bloku, aby szybko zmienić rysunek, a następnie 

zaktualizować wszystkie wystąpienia bloku. 

W przypadku wstawienia bloku zawierającego elementy pierwotnie narysowane na 

warstwie 0 z przypisanym kolorem i typem linii BYLAYER, zostanie on 

umieszczony na bieżącej warstwie i przyjmie kolor i typ linii tej warstwy. W 

przypadku wstawienia bloku zawierającego elementy pierwotnie narysowane na 

innych warstwach lub z jawnie określonymi kolorami lub typami linii, blok 

zachowuje oryginalne ustawienia. 

W przypadku wstawienia bloku zawierającego elementy, którym pierwotnie 

przypisano kolor i typ linii BYBLOCK, a sam blok ma kolor i typ linii BYLAYER, 

elementy te przyjmują kolor i typ linii warstwy, do której zostały wstawione. Jeśli blok ma 

przypisany wyraźny kolor lub typ linii, taki jak czerwony lub przerywany, jednostki 

te przyjmują te cechy. 

Procedura zwana zagnieżdżaniem występuje, gdy inne bloki są dołączane do nowego 

tworzonego bloku. Zagnieżdżanie jest przydatne, gdy chcesz połączyć i dołączyć 

małe elementy, takie jak nakrętki i śruby, do większego zespołu i musisz wstawić 

wiele instancji tego zespołu do jeszcze większego rysunku. 

Najszybszym sposobem tworzenia i zapisywania bloków jest użycie edytora bloków. 

Umożliwia on rysowanie i zapisywanie bloku na miejscu, bezpośrednio w obszarze 

rysowania. Można również tworzyć bloki za pomocą poszczególnych poleceń bloku 

i zawierać więcej opcji. Trzecim sposobem tworzenia bloków jest użycie 

Eksploratora ALCAD. Aby uzyskać szczegółowe informacje na temat tworzenia 

bloków za pomocą Eksploratora ALCAD, patrz "Praca z blokami" na stronie 291. 

 

Tworzenie i zapisywanie bloku przy użyciu edytora bloków 

Podczas tworzenia bloku za pomocą Edytora bloków użytkownik określa jego 

nazwę, a następnie rysuje elementy składające się na blok bezpośrednio w obszarze 

rysowania. Podczas tworzenia bloku na miejscu można zapisać blok z istniejącą lub 

nową nazwą. 

Punkt wstawienia utworzonego bloku jest automatycznie definiowany względem UCS. 
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Aby utworzyć blok za pomocą edytora bloków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Edytor bloków (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Edytor bloków (w 

definicji bloku) lub Wstaw > Edytor bloków (w definicji bloku). 

• Wpisz bedit i naciśnij Enter. 

2 W oknie dialogowym Edytuj definicję bloku wprowadź nazwę i opis nowego 

bloku. 

3 Kliknij przycisk OK. 

4 Narysuj jednostki tworzące blok. 

5 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz blok  : 

• Na wstążce wybierz kolejno opcje Edytor bloków > Zapisz blok. 

• Na pływającym pasku narzędzi (jeśli wstążka nie jest wyświetlana) wybierz opcję Zapisz 

blok. 

• Wpisz bsave i naciśnij Enter. 

6 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zamknij edytor bloków (  

): 

• Na wstążce wybierz polecenie Edytor bloków > Zamknij edytor bloków. 

• Na pływającym pasku narzędzi (jeśli wstążka nie jest wyświetlana) 

wybierz opcję Zamknij edytor bloków. 

• Wpisz bclose i naciśnij Enter. 

Program doda nowy blok do listy bloków z wprowadzoną nazwą. 

Jeśli w rysunkach często występują bloki, można utworzyć paletę narzędzi 

zawierającą najczęściej używane bloki. Szczegółowe informacje można znaleźć w 

sekcji "Tworzenie palet narzędzi oraz dodawanie poleceń i bloków" na stronie 723. 

 

Tworzenie i zapisywanie bloku przy użyciu poszczególnych 

poleceń Podczas tworzenia bloku przy użyciu polecenia Block określana jest 

jego nazwa, punkt wstawienia i jednostki tworzące blok. Punkt wstawienia jest podstawą 

dla bloku i służy jako punkt odniesienia podczas późniejszego wstawiania bloku do 

rysunku. 

Nowo utworzony blok istnieje tylko w bieżącym rysunku, chyba że zostanie 

zapisany oddzielnie za pomocą polecenia Zapisz blok na dysku. 
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Tworzenie bloku do użycia w bieżącym rysunku 

Aby utworzyć blok do użycia w bieżącym rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Utwórz blok (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Utwórz blok (w bloku) 

lub Wstaw > Utwórz blok (w definicji bloku). 

• W menu wybierz Rysuj > Blok > Utwórz blok. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Utwórz blok. 

• Wpisz block i naciśnij Enter. 

2 W oknie dialogowym Block definition wprowadź nazwę i opis nowego bloku. 

3 Określ punkt wstawienia bloku, wykonując jedną z poniższych czynności: 

• Określ na ekranie Zaznacz to pole wyboru, aby wybrać punkt bazowy na 

rysunku po kliknięciu przycisku OK. 

• Wybierz punkt bazowy Kliknij (  ), aby tymczasowo zamknąć okno 

dialogowe, wybrać punkt bazowy na rysunku, a następnie powrócić do okna 

dialogowego. Ta opcja jest dostępna tylko wtedy, gdy opcja Określ na ekranie 

nie jest zaznaczona. 

• X, Y i Z Wprowadź współrzędne x, y i z punktu bazowego. Ta opcja jest 

dostępna tylko wtedy, gdy opcja Specify on Screen nie jest zaznaczona. 

4 Wybierz jednostki, które mają zostać połączone w blok, wykonując jedną z poniższych 

czynności: 

• Określ na ekranie Zaznacz to pole wyboru, aby wybrać jednostki na rysunku 

po kliknięciu przycisku OK. 

• Wybierz encje Kliknij (  ), aby tymczasowo zamknąć okno dialogowe, 

wybrać encje na rysunku, a następnie powrócić do okna dialogowego. Możesz 

też kliknąć (  ), aby wybrać elementy według typu lub wartości. Ta opcja 

jest dostępna tylko wtedy, gdy opcja Określ na ekranie nie jest zaznaczona. 

5 Wybierz, co zrobić z podmiotami po utworzeniu bloku: 

• Zachowaj podmioty Podmioty wybrane dla bloku pozostają na rysunku. 

• Konwertuj na blok Podmioty wybrane dla bloku są konwertowane na 

blok, który pozostaje na rysunku. 

• Usuń podmioty Podmioty wybrane dla bloku są usuwane z rysunku. 
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6 Wybierz dowolną z poniższych opcji dla bloku: 

• Adnotacje Określa, czy blok jest domyślnie opatrzony adnotacjami. 

Skalowanie adnotacji ma wpływ na wyświetlanie i drukowanie bloków z 

adnotacjami. W przypadku domyślnego ustawienia adnotacji można określić, czy blok, gdy 

znajduje się w przestrzeni papieru, jest automatycznie orientowany zgodnie z 

rzutnią układu. 

• Skaluj równomiernie Zaznacz to pole wyboru, aby zachować proporcje, 

jeśli blok jest skalowany. Bloki adnotacji muszą być skalowane 

proporcjonalnie. 

• Zezwalaj na rozbicie Zaznacz to pole wyboru, aby umożliwić rozbicie 

bloku na osobne jednostki. 

• Jednostka Określa jednostkę bloku, na przykład cale lub milimetry. 

7 Kliknij przycisk OK. 

The program adds a new block to the blocks list, with the name you entered for it. 

 

 

 
A 

B 

 
C 

D 

 

E 

 
 
 
 
 
 

A Wprowadź nazwę bloku. 

F  GHI 

I Kliknij, aby wybrać jednostki według typu lub wartości. 

B Wprowadź opis bloku. 

C Wybierz, aby wybrać punkt bazowy na 
rysunku po kliknięciu OK. 

D Wybierz, aby wybrać punkt bazowy na 
rysunku. 

E Wyświetla współrzędne punktu bazowego 
lub można je wprowadzić ręcznie. 

F Wybierz, aby wybrać jednostki do 
uwzględnienia w bloku po kliknięciu 
przycisku OK. 

G Kliknij, aby wybrać jednostki znajdujące się 
teraz na rysunku. 

H Wybierz, czy po utworzeniu bloku 
jednostki mają zostać zachowane, 
przekonwertowane czy usunięte. 

J Wybierz jednostki blokowe. 

K Wybierz, aby umożliwić rozbicie bloku na 
jednostki. 

L Wybierz, aby zachować proporcje, jeśli 
blok jest skalowany. 

M Wybierz, aby blok, gdy znajduje się w 
przestrzeni papieru, był zorientowany zgodnie 
z rzutnią układu (dostępne tylko wtedy, gdy 
zaznaczona jest opcja Adnotacje). 

N Zaznacz, aby blok domyślnie zawierał adnotacje. 

 

Jeśli w rysunkach często występują bloki, można utworzyć paletę narzędzi 

zawierającą najczęściej używane bloki. Szczegółowe informacje można znaleźć w 

N 

   

N 

M 

L 

K 

   
J 



sekcji "Tworzenie palet narzędzi oraz dodawanie poleceń i bloków" na stronie 723. 
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Niektórzy użytkownicy często przywracają oryginalne jednostki po zdefiniowaniu bloku. 

Aby przywrócić oryginalne jednostki do rysunku, zachowując nowy blok, wpisz 

undelete lub oops. Możesz także dodać polecenie Cofnij usunięcie do menu lub 

paska narzędzi, wybierając polecenie Narzędzia > Dostosuj. 
 

 
Zapisywanie bloków 
Blok można utworzyć jako oddzielny plik rysunku, który można wstawić do innych rysunków. 

 

Aby zapisać blok jako osobny plik rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz blok na dysku (  ): 

• Na wstążce wybierz polecenie Wstaw > Zapisz blok na dysku (w definicji bloku). 

• W menu wybierz Narzędzia > Zapisz blok na dysku. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Zapisz blok na dysku. 

• Wpisz wblock i naciśnij Enter. 

2 W polu Źródło wybierz opcję Blok, a następnie wybierz żądany blok z listy. 

3 W polu Nazwa pliku i ścieżka wpisz nazwę i ścieżkę docelowego pliku rysunku, 

który chcesz utworzyć, lub kliknij [...], aby go wyszukać. 

4 W polu Wstaw jednostki wybierz jednostki używane do wstawienia oddzielnego pliku 

rysunku. 

5 Kliknij przycisk OK. 
 

Program przypisuje współrzędną 0,0,0 jako punkt bazowy wstawiania. 

Punkt bazowy można zmienić, otwierając rysunek i ponownie definiując blok. 
 

 
Aby zapisać bieżący rysunek jako osobny plik rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz blok na dysku (  ): 

• Na wstążce wybierz polecenie Wstaw > Zapisz blok na dysku (w definicji bloku). 

• W menu wybierz Narzędzia > Zapisz blok na dysku. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Zapisz blok na dysku. 

• Wpisz wblock i naciśnij Enter. 

2 W polu Źródło wybierz opcję Cały rysunek. 

3 W polu Nazwa pliku i ścieżka wpisz nazwę i ścieżkę docelowego pliku rysunku, 

który chcesz utworzyć, lub kliknij [...], aby go wyszukać. 

4 W polu Wstaw jednostki wybierz jednostki używane do wstawienia oddzielnego pliku 

rysunku. 

5 Kliknij przycisk OK. 
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Program przypisuje współrzędną 0,0,0 jako punkt bazowy wstawiania. 

Punkt bazowy można zmienić, otwierając rysunek i ponownie definiując blok. 
 

 
Aby wybrać jednostki i zapisać je jako osobny plik rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz blok na dysku (  ): 

• Na wstążce wybierz polecenie Wstaw > Zapisz blok na dysku (w definicji bloku). 

• W menu wybierz Narzędzia > Zapisz blok na dysku. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Zapisz blok na dysku. 

• Wpisz wblock i naciśnij Enter. 

2 W sekcji Źródło wybierz Podmioty. 

3 W polu Punkt bazowy wprowadź współrzędne x,y,z punktu bazowego do 

zapisania w oddzielnym pliku rysunku lub kliknij (  ), aby wybrać go 

bezpośrednio w bieżącym rysunku. 

4 Kliknij (  ), a następnie wybierz jednostki źródłowe bezpośrednio na bieżącym 

rysunku. Możesz też kliknąć (  ), aby wybrać jednostki według typu lub 

wartości. 

5 Wybór czynności, które mają zostać wykonane z wybranymi elementami na 

bieżącym rysunku po utworzeniu oddzielnego pliku rysunku: 

• Zachowaj Zachowuje wybrane jednostki źródłowe w bieżącym rysunku. 

• Konwertuj na blok Konwertuje wybrane jednostki źródłowe na blok w 

bieżącym rysunku. 

• Usuń z rysunku Usuwa wybrane jednostki źródłowe z bieżącego 

rysunku. 

Jeśli nie wybrano żadnych podmiotów, oddzielny plik rysunku nie zostanie utworzony. 

6 W polu Nazwa pliku i ścieżka wpisz nazwę i ścieżkę docelowego pliku rysunku, 

który chcesz utworzyć, lub kliknij [ ], aby go wyszukać. 

7 W polu Wstaw jednostki wybierz jednostki używane do wstawienia oddzielnego pliku 

rysunku. 

8 Kliknij przycisk OK. 

Jeśli w rysunkach często występują bloki, można utworzyć paletę narzędzi 

zawierającą najczęściej używane bloki. Szczegółowe informacje można znaleźć w 

sekcji "Tworzenie palet narzędzi oraz dodawanie poleceń i bloków" na stronie 723. 
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A Wybierz zawartość do zapisania jako 
oddzielny plik rysunku. Jeśli wybrano Entities, 
dostępne są opcje Base Point i Entities. 

B Kliknij, aby wybrać na bieżącym rysunku 
współrzędne x,y,z punktu bazowego do 
zapisania w osobnym pliku rysunku. 

C Wprowadź współrzędne x,y,z punktu 
bazowego, aby zapisać je w osobnym pliku 
rysunku. 

D Wprowadź ścieżkę i nazwę pliku nowego 
rysunku lub kliknij [...], aby go wyszukać. 

E Wybierz jednostki wstawiania dla nowego 
pliku rysunku. 

F Wyświetla liczbę jednostek aktualnie wybranych 
do zapisania w osobnym pliku rysunku. Jeśli 
nie wybrano żadnych elementów, oddzielny plik 
rysunku nie zostanie utworzony. 

G Wybór czynności, które mają zostać wykonane 
z wybranymi elementami w bieżącym rysunku po 
utworzeniu oddzielnego pliku rysunku. 

H Kliknij, aby wybrać jednostki według typu lub wartości. 

I Kliknij, aby wybrać w bieżącym rysunku 
elementy do zapisania w osobnym pliku 
rysunku. 

J Wybór bloku do zapisania w osobnym pliku 
rysunku. Dostępne tylko wtedy, gdy jako źródło 
wybrano Blok. 
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Wstawianie bloków 

Do bieżącego rysunku można wstawiać bloki i inne rysunki. Po wstawieniu bloku jest 

on traktowany jako pojedyncza jednostka. Po wstawieniu rysunku jest on dodawany 

do bieżącego rysunku jako blok. Następnie można wstawić wiele wystąpień bloku bez 

ponownego wczytywania oryginalnego pliku rysunku. W przypadku zmiany 

oryginalnego pliku rysunku, zmiany te nie mają wpływu na bieżący rysunek, chyba 

że blok zostanie ponownie zdefiniowany poprzez ponowne wstawienie zmienionego 

rysunku. 

Można również wstawiać bloki z innego rysunku do bieżącego rysunku za pomocą 

Eksploratora ALCAD. Aby to zrobić, oba rysunki muszą być otwarte w tym 

samym czasie. 

Podczas wstawiania bloku lub rysunku należy określić punkt wstawienia, skalę i kąt 

obrotu. Punkt wstawienia bloku jest punktem odniesienia określonym podczas 

tworzenia bloku. Po wstawieniu rysunku jako bloku, program przyjmuje określony punkt 

wstawienia jako punkt wstawienia bloku. Punkt wstawienia można jednak zmienić, 

otwierając najpierw oryginalny rysunek i ponownie definiując blok. 

 

Ustawienia bloku można również skonfigurować przed wstawieniem bloku. 

Przed wstawieniem bloku można określić punkt wstawienia, współczynniki skali i kąt 

obrotu w oknie dialogowym Wstaw blok. Można również kontrolować, czy po 

wstawieniu blok jest rozbijany z powrotem na oryginalne elementy składowe. W 

sekcji Pozycjonowanie usuń zaznaczenie pola wyboru Pozycjonuj blok podczas wstawiania i 

określ odpowiednie współczynniki. Jeśli chcesz natychmiast rozbić blok, zaznacz pole 

wyboru Rozbij po wstawieniu. 
 

 
Aby wstawić blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wstaw blok (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Wstaw blok (w bloku) 

lub Wstaw > Wstaw blok (w bloku). 

• W menu wybierz Wstaw > Blok. 

• Na pasku narzędzi Rysuj kliknij narzędzie Blok. 

• Wpisz ddinsert i naciśnij Enter. 

2 W oknie dialogowym Wstaw blok, w obszarze Wstaw kliknij opcję Nazwa bloku. 

3 W polu Nazwa bloku wybierz nazwę bloku, który chcesz wstawić. 

4 Kliknij przycisk Wstaw. 

5 Określ punkt wstawienia bloku. 

6 Określ współczynniki skali x, y i z oraz kąt obrotu lub naciśnij Enter, aby 

zaakceptować wartości domyślne. 
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Aby wstawić cały rysunek do bieżącego rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wstaw blok (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Wstaw blok (w bloku) 

lub Wstaw > Wstaw blok (w bloku). 

• W menu wybierz Wstaw > Blok. 

• Na pasku narzędzi Rysuj kliknij narzędzie Blok. 

• Wpisz ddinsert i naciśnij Enter. 

2 W oknie dialogowym Wstaw blok, w obszarze Wstaw kliknij opcję Z pliku. 

3 Wpisz ścieżkę i nazwę pliku rysunku lub kliknij przycisk Przeglądaj, aby 

wskazać plik z okna dialogowego Wstaw rysunek, a następnie kliknij przycisk 

Otwórz. 

4 Kliknij przycisk Wstaw. 

5 Określ punkt wstawienia bloku. 

6 Określ współczynniki skali x, y i z oraz kąt obrotu lub naciśnij Enter, aby 

zaakceptować wartości domyślne. 

 

Rysunki można również wstawiać podczas przeglądania plików na komputerze. 

Jeśli zmienna systemowa DRAGOPEN jest ustawiona na 0, można przeciągnąć plik 

.dwg do obszaru rysowania w ALCAD, aby wstawić go jako blok. Jeśli DRAGOPEN 

jest ustawiony na 1 (domyślnie), rysunek otwiera się w ALCAD. 
 

 

Bloki mogą być konwertowane na odniesienia zewnętrzne. 

Użyj polecenia Convert Block to Xref, które jest ekspresowym narzędziem szybko 

zmieniającym wszystkie wystąpienia bloku w zewnętrzne odniesienia. 
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A Kliknij, a następnie wpisz nazwę pliku 

rysunku, aby wstawić cały plik rysunku jako 
blok. 

B Kliknij, aby ustawić blok podczas wstawiania. 

C Określenie punktu wstawienia, 
współczynników skali i kąta obrotu przed 
wstawieniem bloku (dostępne tylko wtedy, 
gdy opcja Position Block When Inserting 
jest wyczyszczona). 

D Kliknij, aby eksplodować blok po wstawieniu. 

E Określ kolumny, odstępy między kolumnami, 
wiersze i odstępy między wierszami. 

F Kliknij, aby wstawić blok. 

G Kliknij, aby wybrać punkt wstawienia bloku na 
rysunku przed wstawieniem bloku (dostępne tylko 
wtedy, gdy pole wyboru Umieść blok podczas 
wstawiania jest wyczyszczone). 
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Modyfikowanie bloków 

Blok można zmodyfikować na kilka sposobów. Po zmodyfikowaniu wszystkie bloki 

na rysunku są automatycznie aktualizowane. 

 

Edytowanie bloków przy użyciu edytora bloków 

Można przedefiniować wszystkie wystąpienia bloku w bieżącym rysunku. Aby 

przedefiniować blok, który został utworzony w bieżącym rysunku, należy utworzyć 

nowy blok o tej samej nazwie. Poprzez ponowne zdefiniowanie bloku można 

zaktualizować wszystkie bloki w bieżącym rysunku. Jeśli blok został wstawiony z 

oddzielnego pliku rysunku, który został następnie zaktualizowany, należy ponownie 

wstawić ten blok, aby zaktualizować wszystkie inne instancje w bieżącym rysunku. 
 

Aby przedefiniować blok w bieżącym rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Edytor bloków (  ): 

• Na wstążce wybierz kolejno opcje Strona główna > Edytor bloków (w 

definicji bloku) lub Wstaw > Edytor bloków (w definicji bloku). 

• Wpisz bedit i naciśnij Enter. 
 

Użyj skrótu. 

Kliknij dwukrotnie blok, aby otworzyć go w edytorze bloków. Należy pamiętać, że 

zmienna systemowa BLOCKEDITLOCK kontroluje akcję dwukrotnego kliknięcia 

dla bloków: jeśli jest ustawiona na 0, otwiera się edytor bloków; jeśli jest 

ustawiona na 1, otwiera się panel właściwości. 
 

2 W oknie dialogowym Edytuj definicję bloku wybierz blok, który chcesz edytować. 

3 Kliknij przycisk OK. 

4 W obszarze rysowania wprowadź zmiany w bloku. 

5 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zapisz blok  : 

• Na wstążce wybierz kolejno opcje Edytor bloków > Zapisz blok. 

• Na pływającym pasku narzędzi (jeśli wstążka nie jest wyświetlana) wybierz opcję Zapisz 

blok. 

• Wpisz bsave i naciśnij Enter. 

Możesz także wybrać opcję Zapisz blok jako (  ), aby zapisać blok z nową nazwą. 

6 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zamknij edytor bloków (  

): 

• Na wstążce wybierz polecenie Edytor bloków > Zamknij edytor bloków. 

• Na pływającym pasku narzędzi (jeśli wstążka nie jest wyświetlana) 

wybierz opcję Zamknij edytor bloków. 

• Wpisz bclose i naciśnij Enter. 

Program aktualizuje wszystkie instancje bloku. 

Można zaktualizować wszystkie wystąpienia bloku wstawionego z oddzielnego 

rysunku poprzez ponowne wstawienie rysunku. 
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Redefiniowanie bloków 

Można przedefiniować wszystkie wystąpienia bloku w bieżącym rysunku. Aby 

przedefiniować blok, który został utworzony w bieżącym rysunku, należy utworzyć 

nowy blok o tej samej nazwie. Poprzez ponowne zdefiniowanie bloku można 

zaktualizować wszystkie bloki w bieżącym rysunku. Jeśli blok został wstawiony z 

oddzielnego pliku rysunku, który został następnie zaktualizowany, należy ponownie 

wstawić ten blok, aby zaktualizować wszystkie inne instancje w bieżącym rysunku. 
 

Aby przedefiniować blok w bieżącym rysunku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Utwórz blok (  ): 

• Na wstążce wybierz kolejno opcje Narzędzia główne > Utwórz blok (w bloku) 

lub Wstaw > Utwórz blok (w definicji bloku). 

• W menu wybierz Rysuj > Blok > Utwórz blok. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Utwórz blok. 

• Wpisz block i naciśnij Enter. 

2 W polu Nazwa wybierz z listy nazwę bloku, który chcesz przedefiniować. 

3 Określ punkt wstawienia bloku. 

4 Wybierz podmioty dla bloku. 

5 Dokonaj wyborów dotyczących zachowania. 

6 Kliknij przycisk OK. 

7 Po wyświetleniu monitu wybierz opcję Tak, aby ponownie zdefiniować blok. 

Blok zostaje przedefiniowany, a wszystkie jego wystąpienia na rysunku zostają 

zaktualizowane. 

8 Aby przywrócić oryginalne jednostki do rysunku, zachowując nowy blok, wpisz 

undelete lub oops. 

Można zaktualizować wszystkie wystąpienia bloku wstawionego z oddzielnego 

rysunku poprzez ponowne wstawienie rysunku. 
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Edytowanie bloków w miejscu 
Po wstawieniu bloku do rysunku można go edytować bezpośrednio w programie 

ALCAD, a blok źródłowy i wszystkie odniesienia do bloku są aktualizowane 

automatycznie. Edycja w miejscu to łatwy sposób na wprowadzanie zmian w bloku 

bez konieczności jego lokalizowania i wczytywania. 

Aby edytować bloki w miejscu 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Edytuj odnośnik w miejscu (w odnośniku). 

• W menu wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Edytuj w miejscu. 

• Wpisz refedit i naciśnij Enter. 

2 Po wyświetleniu monitu wybierz blok, który 

chcesz edytować. Wyświetlone zostanie okno 

dialogowe Reference Edit. 

3 W polu Reference Name wybierz blok, który chcesz edytować. 

4 Wybierz kartę Ustawienia i wybierz jedną z poniższych opcji: 

• Utwórz unikalne nazwy warstw, stylów i bloków Wybierz, aby utworzyć 

unikalne nazwy dla zmienianych warstw, stylów i bloków. Do oryginalnej 

nazwy zmienionej warstwy, stylu lub bloku dodawany jest prefiks. Nazwy 

niezmienionych warstw, stylów i bloków nie ulegają zmianie. 

• Wyświetl definicje atrybutów podczas edycji Wybierz, aby ukryć atrybuty 

i wyświetlić definicje atrybutów podczas edycji. Po zapisaniu zmienione 

definicje atrybutów wpływają tylko na nowe wstawienia bloków. Nie ma to 

wpływu na istniejące bloki. 

5 Kliknij przycisk OK. 

6 Wprowadzanie zmian w zawartości bloku. 

7 Aby dodać element z rysunku do bloku, wybierz element i wykonaj jedną z 

poniższych czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Dodaj do zestawu roboczego. 

• Wpisz refset, naciśnij Enter, a następnie wybierz Add. 

8 Aby usunąć podmiot z bloku, wybierz podmiot i wykonaj jedną z poniższych czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Usuń z zestawu roboczego. 

• Wpisz refset, naciśnij Enter, a następnie wybierz Remove. 

9 Po zakończeniu edycji bloku wykonaj jedną z poniższych czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Zamknij odniesienie. 

• Wpisz refclose i naciśnij Enter. 

10 Wybierz Zapisz, aby zapisać zmiany lub Odrzuć, aby je anulować. 

Jeśli zmiany zostaną zapisane, wszystkie wystąpienia bloku zostaną zaktualizowane w 

bieżącym rysunku. 
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Wybuchające bloki 

Wstawiony blok można rozbić na jego oryginalne elementy składowe. Rozbicie 

bloku ma wpływ tylko na jego pojedyncze wystąpienie. Oryginalna definicja bloku 

pozostaje w rysunku i nadal można wstawiać dodatkowe kopie oryginalnego bloku. 

W przypadku rozbicia bloku zawierającego atrybuty, atrybuty zostaną utracone, ale 

oryginalne definicje atrybutów pozostaną. 

Eksplozja dysocjuje jednostki składowe do ich następnego najprostszego poziomu 

złożoności; bloki lub polilinie w bloku stają się ponownie blokami lub poliliniami 
 

Aby eksplodować blok 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksplozja (  ): 

• Na wstążce wybierz kolejno Home > Explode (w oknie Modify) lub Edit > 

Explode (w oknie Modify). 

• W menu wybierz Modyfikuj > Rozbij. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Rozbij. 

• Wpisz explode i naciśnij Enter. 

2 Wybierz blok. 

3 Naciśnij Enter. 
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Praca z atrybutami 
 

Atrybut jest szczególną jednostką, którą można zapisać jako część definicji bloku. 

Atrybuty składają się z danych tekstowych. Atrybutów można używać do śledzenia takich 

rzeczy jak numery części i ceny. Atrybuty mają stałe lub zmienne wartości. Po 

wstawieniu bloku zawierającego atrybuty, program dodaje stałe wartości do rysunku 

wraz z blokiem, a użytkownik jest proszony o podanie wszelkich zmiennych 

wartości. 

Po wstawieniu bloków zawierających atrybuty można wyodrębnić informacje o 

atrybutach do osobnego pliku, a następnie użyć tych informacji w arkuszu 

kalkulacyjnym lub bazie danych w celu utworzenia listy części lub zestawienia 

materiałów. Informacje o atrybutach można również wykorzystać do śledzenia 

liczby wstawień określonego bloku do rysunku. 

Atrybuty mogą być widoczne lub ukryte. Ukryte atrybuty nie są wyświetlane ani 

drukowane, ale informacje są nadal przechowywane w rysunku i zapisywane w 

pliku po ich wyodrębnieniu. 

 

Definiowanie atrybutów 

Atrybut można dodać do rysunku, najpierw definiując go, a następnie zapisując jako 

część definicji bloku. Aby zdefiniować atrybut, należy określić jego charakterystykę, 

w tym nazwę, podpowiedź i wartość domyślną, lokalizację i formatowanie tekstu 

oraz opcjonalne tryby (ukryty, stały, zatwierdzony, predefiniowany i zablokowany). 
 

Aby zdefiniować atrybut 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zdefiniuj atrybuty (  ): 

• Na wstążce wybierz polecenie Wstaw > Zdefiniuj atrybuty (w definicji bloku). 

• W menu wybierz Rysuj > Blok > Zdefiniuj atrybuty. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Definiuj atrybuty. 

• Wpisz ddattdef i naciśnij Enter. 

2 W oknie dialogowym Definiowanie atrybutu wpisz nazwę, monit i wartość domyślną. 

3 W obszarze Wstaw współrzędne określ lokalizację atrybutu lub kliknij 

Wybierz, aby wybrać punkt na rysunku. 

4 W sekcji Flagi atrybutów wybierz opcjonalne tryby atrybutów. 

5 W sekcji Tekst określ charakterystykę tekstu. 

6 Aby dodać atrybut do rysunku, wykonaj jedną z poniższych czynności: 

• Kliknij przycisk Zdefiniuj, aby dodać atrybut i zachować aktywne okno 

dialogowe, aby można było zdefiniować inny atrybut. 

• Kliknij przycisk Zdefiniuj i zakończ, aby dodać atrybut i zakończyć polecenie. 
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A Wpisz nazwę, którą chcesz przypisać 

do atrybutu. 

B Wprowadź informacje identyfikacyjne 
wyświetlane po wstawieniu bloku 
zawierającego atrybut. 

C Wprowadź wartość domyślną lub stałą. W 
przypadku atrybutów zmiennych wartość 
domyślna jest zastępowana wartością 
rzeczywistą po późniejszym wstawieniu 
bloku zawierającego atrybut. 

D Określa współrzędne x, y i z punktu 
wstawienia atrybutu. 

E Wybierz, aby utworzyć atrybut ukryty. 

F Wybierz, aby utworzyć atrybut o stałej 
wartości. 

G Wybierz, aby utworzyć atrybut, którego 
wartość musi zostać zatwierdzona podczas 
późniejszego wstawiania bloku 
zawierającego ten atrybut. 

H Wybierz, aby utworzyć atrybut, którego 
wartość jest zdefiniowana i nie jest 
wymagana podczas późniejszego wstawiania 
bloku zawierającego atrybut, ale który można 
edytować po wstawieniu bloku. 

I Wybierz, aby utworzyć atrybut, którego 
pozycja jest zablokowana. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

K L 

J Wybierz, aby utworzyć atrybut, którego 
domyślny tekst zawiera wiele wierszy 
tekstu. 

K Kliknij, aby dodać atrybut i zachować 
aktywne okno dialogowe, aby można było 
zdefiniować inny atrybut. 

L Kliknij, aby dodać atrybut i zakończyć polecenie. 

M Określ kąt obrotu tekstu lub kliknij, aby określić 
kąt obrotu, wybierając dwa punkty na 
rysunku. 

N Określ wysokość tekstu lub kliknij, aby 
określić wysokość, wybierając dwa punkty 
na rysunku. 

O Wybierz justowanie tekstu. 

P Wybierz styl tekstu spośród stylów już 
zdefiniowanych w rysunku. 

Q Wybierz, aby utworzyć atrybut, który 
domyślnie jest atrybutem adnotacyjnym. 

R Kliknij, aby określić punkt wstawienia 
atrybutu, wybierając punkt na rysunku. 

S Kliknij, aby wprowadzić wiele wierszy 
domyślnego tekstu. Dostępne tylko po 
wybraniu opcji Wiele wierszy. 

A 

B 

C S 

 
R 

D 

E 

F 

G 
H 

I 

J   

Q 

P 

O 

N 

  M 
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Edytowanie definicji atrybutów 

Definicję atrybutu można edytować przed powiązaniem jej z blokiem i przed 

zapisaniem jej jako części definicji bloku. 
 

Aby edytować definicję atrybutu 

Zaawansowany poziom doświadczenia 

1 Wybierz tekst definicji atrybutu do edycji. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz Widok > Właściwości (na ekranie). 

• W menu wybierz Modyfikuj > Właściwości. 

• Kliknij prawym przyciskiem myszy tekst definicji atrybutu, a następnie wybierz opcję 

Właściwości. 

• Wpisz entprop i naciśnij Enter. 

3 Zmodyfikuj właściwości, w tym nazwę, podpowiedź, wartość domyślną i inne 

właściwości specyficzne dla atrybutu. 

 

Dołączanie atrybutów do bloków 

Atrybuty można dołączyć do bloku po jego zdefiniowaniu i wybraniu go jako 

jednego z elementów do uwzględnienia. Atrybuty należy dołączyć, gdy program 

wyświetli monit o uwzględnienie jednostek w zestawie wyboru dla bloku. Po 

włączeniu atrybutu do bloku, program wyświetla monit za każdym razem, gdy 

wstawiasz blok, więc możesz określić różne wartości atrybutów za każdym razem, 

gdy wstawiasz go do nowego rysunku. 

 

Edytowanie atrybutów dołączonych do bloków 

Można edytować wartości atrybutów bloku wstawionego do rysunku. 
 

Aby edytować atrybut dołączony do bloku 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Edytuj atrybuty bloku (  ): 

• Na wstążce wybierz polecenie Wstaw > Edytuj atrybuty bloku (w definicji bloku). 

• W menu wybierz Narzędzia > Edytuj atrybuty bloku. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Edytuj atrybuty bloku. 

• Wpisz ddatte i naciśnij Enter. 

2 Wybierz blok do edycji. 

Okno dialogowe Edytuj atrybuty bloku wyświetla wszystkie atrybuty dołączone 

do wybranego bloku. 

3 W razie potrzeby edytuj wartości atrybutów. 

4 Kliknij przycisk OK. 
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A 
E 

B 

 
 
 
 
 
 

 
C 

 
 
 

D 
 

A Określa nazwę bloku. 

B Kliknij, aby wybrać atrybut. 

C Wpisz nową wartość dla wybranego atrybutu. 

Wyodrębnianie informacji o 
atrybutach 

D Kliknij, aby zaktualizować wartości atrybutów i wyjść. 

E Wyświetla nazwy, podpowiedzi i wartości 
wszystkich atrybutów dołączonych do bloku. 

 

Można wyodrębnić informacje o atrybutach z rysunku i zapisać je w osobnym pliku 

tekstowym do użytku z programem bazy danych. Plik można zapisać w dowolnym z 

następujących formatów: 

• Comma Delimited Format (CDF) Zawiera jeden wiersz dla każdego 

wystąpienia bloku, z poszczególnymi polami atrybutów oddzielonymi 

przecinkami. Pola ciągów znaków są ujęte w pojedyncze cudzysłowy. Podczas 

wyodrębniania do pliku CDF należy określić plik szablonu. 

• Space Delimited Format (SDF) Zawiera jeden wiersz dla każdego wystąpienia 

bloku. Każde pole atrybutu ma stałą długość; nie ma separatorów ani 

ograniczników ciągów znaków. Podczas wyodrębniania do pliku SDF należy 

określić plik szablonu. 

• Drawing Exchange Format (DXF) Tworzy podzbiór standardowego pliku DXF 

(plik *.dxx) zawierający wszystkie informacje o każdym bloku, w tym punkty 

wstawienia, kąty obrotu i wartości atrybutów. Nie jest wymagany plik szablonu. 

Przed wyodrębnieniem atrybutów do pliku CDF lub SDF należy utworzyć plik 

szablonu. Plik szablonu jest plikiem tekstowym ASCII, który określa pola danych 

atrybutów, które mają zostać zapisane w pliku wyodrębnionym. Każdy wiersz pliku 

szablonu określa jedno pole atrybutu. 

ALCAD rozpoznaje 15 różnych pól, które zawierają takie elementy jak nazwa 

bloku, współrzędne x, y i z jego punktu wstawienia, warstwę, na której jest 

wstawiony, i tak dalej. Można dołączyć dowolne z tych pól. Plik szablonu musi 

zawierać co najmniej jedną nazwę atrybutu. 
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Każdy wiersz w pliku szablonu musi zaczynać się od nazwy pola. Nazwa bloku i 

wartości punktu wstawienia muszą zaczynać się od BL:. Następnym niepustym 

znakiem musi być C (wskazujące pole ciągu znaków) lub N (wskazujące pole 

numeryczne). Po tym znaku następują trzy cyfry wskazujące szerokość pola (w znakach). 

Ostatnie trzy cyfry wskazują liczbę miejsc dziesiętnych (w przypadku pól 

numerycznych). W przypadku pól znakowych ostatnie trzy cyfry muszą być zerami 

(000). Typowy plik szablonu jest podobny do pokazanego tutaj: 

 

 
A Nazwa pola. 

B Nazwa bloku. Nazwy bloków muszą zaczynać 
się od BL:. 

C Punkt wstawienia. Wartości punktu wstawienia 
muszą zaczynać się od BL:. 

D Tagi atrybutów. 

Aby utworzyć plik szablonu 

E Liczba miejsc dziesiętnych dla pól numerycznych lub 
000 dla pól znakowych. 

F Szerokość pola dla pól znakowych lub numerycznych. 

G C dla pól znakowych; N dla pól numerycznych. 

 

1 Utwórz plik szablonu za pomocą dowolnego edytora tekstu ASCII (takiego jak 
Microsoft® Notepador Microsoft® WordPad) lub programu do edycji tekstu, takiego jak 
Microsoft® Word. 

2 Dołącz niezbędne pola do pliku szablonu. 

3 Zapisz plik szablonu w formacie tekstowym ASCII. 
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Aby wyodrębnić informacje o atrybucie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyodrębnij atrybuty (  ): 

• Na wstążce wybierz polecenie Wstaw > Wyodrębnij atrybuty (w definicji bloku). 

• W menu wybierz Narzędzia > Wyodrębnij atrybuty. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Wyodrębnij atrybuty. 

• Wpisz ddattext i naciśnij Enter. 

2 Kliknij przycisk Wybierz, określ jednostki, z których mają zostać 

wyodrębnione atrybuty, a następnie naciśnij klawisz Enter. 

3 Określa format wyodrębnionego pliku. 

4 W przypadku formatów CDF i SDF należy określić plik szablonu. 

5 Określa plik wyjściowy wyodrębniania. 

6 Kliknij przycisk Wyodrębnij. 

 

 

 
A H 

 
 

B 

 
 

C G 

D F 
E 

 
 

A Kliknij, aby wybrać bloki na rysunku 
zawierające atrybuty, które chcesz 
wyodrębnić. 

B Kliknij, aby określić format wyodrębnionego 
pliku. 

C Określa plik szablonu dla wyciągów 
CDF i SDF. 

D Określa plik wyjściowy wyodrębniania. 

E Kliknij, aby wyodrębnić atrybuty. 

F Kliknij, aby określić plik wyjściowy za pomocą 
okna dialogowego pliku. 

G Kliknij, aby określić plik szablonu za 
pomocą okna dialogowego pliku. 

H Wskazuje liczbę bloków z atrybutami 
wybranymi do wyodrębnienia. 
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Praca z zewnętrznymi referencjami 
 

Można łączyć całe rysunki z bieżącym rysunkiem jako odniesienia zewnętrzne. W 

przeciwieństwie do wstawiania rysunku jako bloku, w którym wszystkie elementy z 

oddzielnego rysunku są dodawane do bieżącego rysunku, odniesienia zewnętrzne 

dołączają wskaźnik do pliku zewnętrznego. Jednostki w zewnętrznym odwołaniu 

pojawiają się w bieżącym rysunku, ale same jednostki nie są dodawane do rysunku. 

W związku z tym dołączenie odniesienia zewnętrznego nie zwiększa znacząco 

rozmiaru bieżącego pliku rysunku. 

 

Zrozumienie zewnętrznych odniesień 

Odniesienia zewnętrzne zapewniają dodatkowe możliwości niedostępne po 

wstawieniu rysunku jako bloku. Po wstawieniu rysunku jako bloku, jednostki są 

przechowywane na rysunku. Wszelkie zmiany wprowadzone do oryginalnego 

rysunku nie są odzwierciedlane w rysunku, do którego został wstawiony. Jednak po 

dołączeniu odniesienia zewnętrznego wszelkie zmiany wprowadzone w 

oryginalnym pliku rysunku są odzwierciedlane w rysunkach, które się do niego 

odwołują. Zmiany te pojawiają się automatycznie przy każdym otwarciu rysunku 

zawierającego odniesienie zewnętrzne. Jeśli wiesz, że oryginalny rysunek został 

zmodyfikowany, możesz ponownie załadować odniesienie zewnętrzne w 

dowolnym momencie pracy nad rysunkiem. 

Odniesienia zewnętrzne są przydatne do składania rysunków głównych z rysunków 

komponentów. Odniesienia zewnętrzne służą do koordynowania pracy z innymi 

osobami w grupie. Odniesienia zewnętrzne pomagają zmniejszyć rozmiar pliku rysunku i 

zapewniają, że zawsze pracujesz z najnowszą wersją rysunku. Jeśli jednak wysyłasz 

lub otrzymujesz rysunki zawierające odniesienia zewnętrzne, ważne jest, aby 

dołączyć do rysunku głównego wszystkie dołączone do niego odniesienia 

zewnętrzne. Po otwarciu rysunku zawierającego odniesienia zewnętrzne, źródłowe pliki odniesień 

zewnętrznych muszą być dostępne, aby odniesienia zewnętrzne były wyświetlane na 

rysunku. 

Xref Manager pomaga w łatwym dołączaniu i pracy z zewnętrznymi odnośnikami. 
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A 

J 

I 

B H 

G 

F 

E 

C 

D 

 

 
A Kliknij, aby wyświetlić szczegółową listę lub 

hierarchiczne drzewo. 

B Wybierz odnośnik zewnętrzny, aby 
zmodyfikować jego załącznik. 

C Wpisz lub kliknij przycisk Przeglądaj, aby 
określić zewnętrzną lokalizację 
referencyjną. 

D Wpisz lub kliknij przycisk Przeglądaj, aby 
określić inne katalogi wyszukiwania, w 
których mogą znajdować się zewnętrzne 
odniesienia. 

E Kliknij, aby otworzyć rysunek źródłowy dla 
odniesienia zewnętrznego. 

 

 
F Kliknij, aby odnośnik zewnętrzny stał się stałą 

częścią rysunku. 

G Kliknij, aby usunąć zewnętrzne odniesienie, ale 
zachować elementy i informacje o ścieżce w celu 
łatwego przeładowania. 

H Kliknij, aby zaktualizować zmiany z 
zewnętrznego odniesienia. 

I Kliknij, aby całkowicie usunąć zewnętrzne odniesienie. 

J Kliknij, aby połączyć rysunek. 

 

Dołączanie zewnętrznych referencji 

Dołączenie oddzielnego rysunku do bieżącego tworzy odniesienie zewnętrzne. 

Odniesienie zewnętrzne pojawia się na rysunku jako definicja bloku, ale elementy 

rysunku są połączone, a nie dodane do bieżącego rysunku. Jeśli zmodyfikujesz 

połączony rysunek, bieżący rysunek zawierający odniesienie zewnętrzne zostanie 

zaktualizowany automatycznie po jego otwarciu lub możesz ręcznie przeładować odniesienie 

zewnętrzne, aby odzwierciedlało najnowszą wersję odniesienia zewnętrznego. 

Po dołączeniu odniesienia zewnętrznego jego warstwy, typy linii, style tekstu i inne 

elementy nie są dodawane do bieżącego rysunku. Elementy te są raczej łączone z plikiem, 

do którego się odwołano. 
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Istnieją dwa sposoby dołączenia zewnętrznego odniesienia: 

• Załącznik to wstawiony rysunek zawierający łącze do oryginalnego pliku. 

Załączniki mogą same zawierać inne, zagnieżdżone pliki odniesienia. Po 

dołączeniu zewnętrznego odniesienia, wszelkie zagnieżdżone odniesienia zawarte 

w pliku pojawiają się również w bieżącym rysunku. 

• Nakładka to wstawiony rysunek zawierający łącze do oryginalnego pliku. 

Nakładki umożliwiają umieszczenie rysunku na innym rysunku, podobnie jak w 

przypadku ręcznej pracy z foliami. Gdy rysunek zawierający nałożone odniesienia 

zewnętrzne jest sam dołączony lub nałożony jako odniesienie zewnętrzne w 

innym rysunku, nakładki nie są wyświetlane jako część odniesienia 

zewnętrznego. Nakładania należy używać, gdy na rysunku ma być widoczna geometria 

odniesienia, ale nie ma potrzeby dołączania tej geometrii do rysunków, które 

będą używane przez inne osoby (zagnieżdżone odniesienia zewnętrzne). 

Można dołączyć dowolną liczbę kopii zewnętrznego pliku referencyjnego. Każda 

kopia może mieć inną pozycję, skalę i kąt obrotu. 
 

Aby dołączyć zewnętrzny odnośnik 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Kliknij przycisk Załącz. 

3 Określ plik rysunku do załączenia jako odniesienie zewnętrzne, a następnie kliknij Otwórz. 

4 W polu Typ odniesienia wybierz sposób wstawienia rysunku: 

• Załącznik - wstawia kopię rysunku i zawiera wszelkie inne rysunki, które są 

zewnętrznie przywoływane w przywoływanym rysunku. 

• Nakładka - nakłada kopię rysunku na oryginalny rysunek; nie zawiera 

żadnych zagnieżdżonych odniesień zewnętrznych z rysunku z odniesieniem 

zewnętrznym. 

5 Dokonaj wszelkich dodatkowych wyborów. 

6 Kliknij przycisk OK. 

7 Jeśli zaznaczyłeś opcję Określ na ekranie dla dowolnego elementu, postępuj 

zgodnie z instrukcjami, aby dołączyć zewnętrzne odniesienie. 
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A G 

 

B F 

 
 
 

E 

C 

 
 
 

D 

 

 
A Wyświetla zewnętrzny odnośnik do dołączenia 

lub wybiera go z listy. 

B Kliknij Załącznik, aby połączyć rysunek, w tym 
wszelkie jego własne odniesienia zewnętrzne. 
Kliknij Nakładka, aby połączyć rysunek, 
pomijając wszelkie jego własne zagnieżdżone 
odniesienia zewnętrzne. 

C Wybierz, aby określić punkt wstawienia 
na rysunku, a następnie współrzędne x, y i 
z. 

 
D Wybierz skalę rysunku lub wprowadź 

współczynniki skali x, y i z. 

E Wybierz kąt obrotu podczas rysowania lub 
wprowadź kąt obrotu. 

F Wybierz, aby zapisać lokalizację folderu 
przywołanego rysunku. Jeśli opcja nie zostanie 
wybrana, rysunek odniesienia musi znajdować 
się w tym samym folderze co bieżący rysunek. 

G Kliknij przycisk lokalizacji i wybierz inne 
odniesienie zewnętrzne. 

 

Wyświetlanie listy odnośników zewnętrznych 

Listę zewnętrznych odnośników, które są powiązane z bieżącym rysunkiem, 

można wyświetlić na dwa różne sposoby za pomocą Menedżera odnośników: 

• Widok listy wyświetla odniesienia zewnętrzne na liście, która umożliwia 

sortowanie listy odniesień według nazwy, statusu, rozmiaru, typu, daty lub 

zapisanej ścieżki. 

• Widok drzewa wyświetla hierarchiczną reprezentację zewnętrznych odniesień i 

relacji między nimi. Widok drzewa pokazuje poziom zagnieżdżenia relacji 

dołączonych odniesień zewnętrznych. 
 

Aby wyświetlić listę odnośników zewnętrznych 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Kliknij Widok listy ( ) lub Widok drzewa ( ). 



492 C H A P T E R 1 3 

 

Otwieranie odnośników zewnętrznych 

Z poziomu Xref Manager można szybko otworzyć rysunek źródłowy dla dowolnego 

odniesienia zewnętrznego. Jest to szczególnie pomocne w przypadku pracy z 

zagnieżdżonymi odnośnikami zewnętrznymi, których nie można powiązać ani 

odłączyć. Z poziomu Xref Manager otwórz rysunek źródłowy, wprowadź zmiany, a 

następnie zapisz i zamknij rysunek źródłowy. Gdy Xref Manager wyświetli się 

ponownie, wystarczy ponownie załadować odniesienie zewnętrzne. 
 

Aby otworzyć odniesienie zewnętrzne 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie do otwarcia. 

3 Kliknij przycisk Otwórz. 

 

Użyj skrótu. 

Wpisz xopen, aby otworzyć odniesienie zewnętrzne bez korzystania z Xref Manager. 

Aby zobaczyć wszelkie zmiany dokonane w zewnętrznym odnośniku, gdy jest on 

otwarty, załaduj go ponownie. 
 

Usuwanie zewnętrznych odniesień 

Usuwanie odniesień zewnętrznych z bieżącego rysunku jest łatwe dzięki narzędziu 

Xref Man- ager. Można wyładować odniesienie zewnętrzne, które zachowuje pewne 

informacje o odniesieniu zewnętrznym w bieżącym rysunku w celu późniejszego łatwego 

ponownego załadowania, lub można całkowicie odłączyć odniesienie zewnętrzne. 

Po wyładowaniu zewnętrznego odnośnika, zostanie on usunięty z bieżącego rysunku. 

Jednak jego elementy, takie jak warstwy i typy linii, pozostają w rysunku i są nadal 

wyświetlane w Menedżerze odnośników. Odłączenie odnośnika zewnętrznego 

powoduje usunięcie go i wszystkich jego elementów z bieżącego rysunku i nie jest on 

już wyświetlany w Menedżerze odnośników. 
 

Aby rozładować zewnętrzne odniesienie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie do rozładowania. 

3 Kliknij przycisk Rozładuj. 
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Aby odłączyć zewnętrzne odniesienie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie do odłączenia. 

3 Kliknij przycisk Odłącz. 

 

Zagnieżdżonych odwołań zewnętrznych nie można odłączyć. 

Odłączyć można tylko zewnętrzne odniesienia, które są dołączone bezpośrednio do 

bieżącego rysunku. 
 

 
Przeładowywanie zewnętrznych referencji 

Po otwarciu lub wydrukowaniu rysunku wszelkie odniesienia zewnętrzne w rysunku 

są aktualizowane automatycznie. Jeśli rysunek jest już otwarty, a odwołanie do 

rysunku zostało zmodyfikowane, można ręcznie zaktualizować bieżący rysunek, aby 

wyświetlić najnowszą wersję odwołanego rysunku. 

Możesz także chcieć ponownie załadować zewnętrzną referencję, która została 

tymczasowo wyładowana. 

Aby przeładować zewnętrzne odniesienie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie do przeładowania. 

3 Kliknij przycisk Przeładuj. 

 

Użyj zmiennej systemowej, aby kontrolować powiadomienia o zmodyfikowanych odniesieniach 
zewnętrznych. 

Domyślnie, gdy odniesienie zewnętrzne jest modyfikowane poza programem ALCAD, 

powiadomienie pojawia się w komunikacie w dymku i w dzienniku zdarzeń. Aby 

wyłączyć te powiadomienia, należy ustawić zmienną systemową XREFNOTIFY na 0; 

aby włączyć powiadomienia, należy ustawić ją na 2. 
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Zmiana ścieżki dla odwołań zewnętrznych 

Jeśli plik powiązany z odnośnikiem zewnętrznym zostanie przeniesiony do innego 

katalogu lub zostanie zmieniona jego nazwa, program wyświetli komunikat 

informujący, że nie może załadować odnośnika zewnętrznego. Połączenie z 

plikiem można przywrócić, wykonując jedną z poniższych czynności: 

• Zmień ścieżkę dla zewnętrznego odniesienia. 

• Określ dodatkowe katalogi do przeszukania przez ALCAD. Jest to szczególnie 

przydatne, jeśli masz kilka zewnętrznych odniesień, które zostały przeniesione 

do nowego katalogu. 
 

Aby zmienić ścieżkę dla pojedynczego odnośnika zewnętrznego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz odniesienie zewnętrzne, którego ścieżkę chcesz zmienić. 

3 W Xref Path wykonaj jedną z poniższych czynności: 

• Wprowadź nową nazwę pliku lub lokalizację. 

• Kliknij Przeglądaj, aby zlokalizować i wybrać rysunek z 

odniesieniem. ALCAD automatycznie przeładuje określone 

odniesienie zewnętrzne. 

 

Odwołania zewnętrzne nie mogą być rekurencyjne. 

Nie można rekursywnie odwoływać się do rysunku z tego samego oryginalnego rysunku. 
 

 
Aby zmienić ścieżki wyszukiwania dla wszystkich odwołań zewnętrznych na rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 W polu Dodatkowe ścieżki wyszukiwania odnośników wykonaj jedną z poniższych 

czynności: 

• Wprowadź nowy katalog i jego ścieżkę. Oddziel wiele ścieżek średnikiem, na 

przykład c:\My Drawings;d:\My Drawings\Backup. 

• Kliknij przycisk Przeglądaj, aby zlokalizować i wybrać katalog. 

ALCAD przeszukuje określone katalogi; wszelkie znalezione zewnętrzne 

odniesienia są ładowane automatycznie. 
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Wiązanie zewnętrznych odniesień do rysunków 

Odniesienia zewnętrzne nie są częścią rysunku. Są to raczej łącza do pliku z odniesieniami 

zewnętrznymi. Aby dostarczyć kopię rysunku zawierającego odniesienia zewnętrzne 

komuś innemu, należy również dostarczyć wszystkie pliki odniesień zewnętrznych. 

Ponadto osoba otrzymująca rysunki musi albo ponownie utworzyć te same ścieżki, 

które zostały użyte podczas łączenia odniesień zewnętrznych, albo zmienić ścieżki 

dla odniesień zewnętrznych. 

Aby zapewnić kopię rysunku zawierającego odniesienia zewnętrzne, często łatwiej 

jest najpierw powiązać odniesienia zewnętrzne z rysunkiem. Powiązanie odniesień 

zewnętrznych sprawia, że stają się one stałą częścią rysunku, co jest podobne do 

wstawiania oddzielnego rysunku jako bloku. 

Można powiązać odniesienia zewnętrzne, które są dołączone bezpośrednio do 

bieżącego rysunku; nie można powiązać zagnieżdżonych odniesień zewnętrznych. 
 

Aby powiązać istniejące odniesienie zewnętrzne z rysunkiem 

1 Wykonaj jedną z poniższych czynności, aby wybrać Xref Manager ( ):  

• Na wstążce wybierz Wstaw > Menedżer odnośników (w odnośniku). 

• W menu wybierz Wstaw > Menedżer odnośników. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Xref Manager. 

• Wpisz xrm i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienie do powiązania. 

3 Kliknij przycisk Powiąż. 

4 Wybierz jedną z poniższych opcji: 

• Powiąż Powiąże odniesienie zewnętrzne i utworzy unikalną nazwę dla 

każdej nazwanej jednostki, takiej jak warstwa lub blok, która znajduje się w 

odniesieniu zewnętrznym. Na przykład, warstwa o nazwie Elektryczny w 

zewnętrznym odnośniku zostanie nazwana Xref$0$Elektryczny w 

bieżącym rysunku. Jeśli bieżący rysunek ma już warstwę lub blok o tej 

samej nazwie, nazwa jest zmieniana przyrostowo, na przykład 

Xref$1$Electric. 

• Wstaw Wiąże odniesienie zewnętrzne, ale nie zmienia nazw żadnych 

nazwanych jednostek w odniesieniu zewnętrznym. Na przykład, warstwa o 

nazwie Elektryczny w odniesieniu zewnętrznym będzie miała tę samą nazwę, 

Elektryczny, w bieżącym rysunku. Jeśli bieżący rysunek ma warstwę lub blok 

o tej samej nazwie, nazwana jednostka w odwołaniu zewnętrznym przyjmuje 

właściwości nazwanej jednostki na bieżącym rysunku. 

5 Kliknij przycisk OK. 
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Przycinanie zewnętrznych odniesień 

Po dołączeniu rysunku jako odniesienia zewnętrznego, cały rysunek, do którego 

istnieje odniesienie, jest wyświetlany w bieżącym rysunku. Jednak po dołączeniu 

zewnętrznego odniesienia można zdefiniować granicę przycinania, która określa, 

która część odwołanego rysunku jest widoczna lub ukryta. 

Przycięte odniesienia zewnętrzne można edytować, przenosić lub kopiować w taki 

sam sposób, w jaki modyfikuje się nieprzycięte odniesienia zewnętrzne. Granica 

przesuwa się wraz z odniesieniem. Jeśli odniesienie zewnętrzne zawiera zagnieżdżone 

przycięte odniesienia zewnętrzne, są one również wyświetlane jako przycięte na 

rysunku. 

Oprócz przycinania zewnętrznych odniesień, można także częściowo ukrywać 

bloki za pomocą granic przycinania. 

 

Przykład zewnętrznego odnośnika przypiętego przy użyciu granicy przypinania. Granicą 
przypinania jest prostokąt w górnym oknie. 
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Dodawanie granic przycinania 

Po utworzeniu granicy przycinania ma ona wpływ tylko na wyświetlanie rysunku z 

odniesieniem; nie ma ona wpływu na oryginalny rysunek z odniesieniem ani na 

żadną geometrię z odniesieniem. Część odniesienia zewnętrznego w obrębie granicy 

przycinania jest widoczna, a pozostała część odniesienia zewnętrznego zostaje 

ukryta. 
 

Aby zdefiniować prostokątną granicę przycinania 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Klip Xref (w odnośniku). 

• Z menu wybierz polecenie Modyfikuj > Xref Clip. 

• Wpisz xclip i naciśnij Enter. 

2 Wybierz zewnętrzne odniesienia do przycięcia. W razie potrzeby można również wybrać 

bloki. 

3 Naciśnij Enter. 

4 Naciśnij Enter, aby utworzyć nową granicę przycinania. 

5 Jeśli pojawi się monit, naciśnij Enter, aby usunąć istniejące granice. 

6 Wybierz Prostokątny. 

7 Zdefiniuj pierwszy róg prostokąta przycinania. 

8 Zdefiniuj drugi róg prostokąta przycinania. 

Wybrane odniesienia zewnętrzne są przycinane przez prostokąt. 
 

Użyj skrótu. 

Możesz najpierw zaznaczyć wszystkie zewnętrzne odniesienia, kliknąć prawym 

przyciskiem myszy zaznaczenie, a następnie wybrać Xref Clip z menu skrótów. 
 

 
Aby zdefiniować granicę przycinania za pomocą polilinii 

1 Narysuj polilinię w miejscu, w którym chcesz przyciąć odniesienia zewnętrzne. 

2 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Klip Xref (w odnośniku). 

• Z menu wybierz polecenie Modyfikuj > Xref Clip. 

• Wpisz xclip i naciśnij Enter. 

3 Wybierz zewnętrzne odniesienia do przycięcia. W razie potrzeby można również wybrać 

bloki. 

4 Naciśnij Enter. 

5 Naciśnij Enter, aby utworzyć nową granicę przycinania. 

6 Jeśli pojawi się monit, naciśnij Enter, aby usunąć istniejące granice. 

7 Wybierz opcję Wybierz polilinię. 

8 Wybierz polilinię, która ma zostać użyta jako granica przycinania. 
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Włączanie i wyłączanie granic przycinania 
Przycinanie odnośników można włączyć lub wyłączyć. Gdy granica przycinania jest 

wyłączona, granica nie jest wyświetlana, a całe odniesienie zewnętrzne jest 

widoczne, pod warunkiem, że geometria znajduje się na warstwie, która jest 

włączona i rozmrożona. Gdy granica przycinania jest wyłączona, nadal istnieje i można ją 

włączyć. Jednak usunięcie granicy przycinania jest trwałe. 
 

Aby włączyć lub wyłączyć granice przycinania 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Klip Xref (w odnośniku). 

• Z menu wybierz polecenie Modyfikuj > Xref Clip. 

• Wpisz xclip i naciśnij Enter. 

2 Wybierz żądane odniesienia zewnętrzne. 

3 Naciśnij Enter. 

4 Aby wyłączyć granice przycinania, wybierz opcję Wył. Aby włączyć istniejące 

granice przycinania, wybierz opcję On. 

5 Naciśnij Enter. 

Jeśli wyłączasz granicę przycinania, kliknij przyciętą część zewnętrznego 

odniesienia, aby wyświetlić poprzednio ukrytą część rysunku, do którego się 

odwołujesz. 

 

Użyj zmiennej systemowej XCLIPFRAME. 

Gdy zmienna systemowa XCLIPFRAME jest włączona (ustawiona na 1), można 

wybrać i wydrukować ramkę graniczną przycinania. 
 

 
Usuwanie granic przycinania 
Jeśli granica przycinania dla zewnętrznego odniesienia nie jest już potrzebna, można ją usunąć. 

 

Aby usunąć granicę przycinania 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Klip Xref (w odnośniku). 

• W menu wybierz polecenie Modyfikuj > Xref Clip. 

• Wpisz xclip i naciśnij Enter. 

2 Wybierz żądane odniesienia zewnętrzne. 

3 Naciśnij Enter. 

4 Wybierz opcję Usuń, a następnie naciśnij klawisz Enter. 

5 Kliknij przyciętą część zewnętrznego odniesienia. 

Wyświetlona zostanie poprzednio ukryta część rysunku. 
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Edytowanie zewnętrznych odniesień w miejscu 

Po wstawieniu zewnętrznego odniesienia do rysunku można je edytować 

bezpośrednio w Intelli-CAD, a źródłowy plik rysunku jest aktualizowany 

automatycznie. Edycja w miejscu to łatwy sposób na wprowadzanie zmian w pliku 

źródłowym bez konieczności lokalizowania pliku i wczytywania go. 
 

Aby edytować odniesienie zewnętrzne w miejscu 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Edytuj odnośnik w miejscu (w odnośniku). 

• W menu wybierz Narzędzia > Edytuj blok lub wybierz X-Ref In-Place > 

Edytuj w miejscu. 

• Wpisz refedit i naciśnij Enter. 

2 Po wyświetleniu monitu wybierz odnośnik zewnętrzny, 

który chcesz edytować. Wyświetlone zostanie okno 

dialogowe Reference Edit. 

3 W polu Nazwa odnośnika wybierz odnośnik zewnętrzny, który chcesz edytować. 

4 Wybierz kartę Ustawienia i wybierz jedną z poniższych opcji: 

• Utwórz unikalne nazwy warstw, stylów i bloków Wybierz, aby utworzyć 

unikalne nazwy dla zmienianych warstw, stylów i bloków. Do oryginalnej 

nazwy zmienionej warstwy, stylu lub bloku dodawany jest prefiks. Nazwy 

niezmienionych warstw, stylów i bloków nie ulegają zmianie. 

• Wyświetl definicje atrybutów podczas edycji Wybierz, aby ukryć atrybuty 

i wyświetlić definicje atrybutów podczas edycji. Po zapisaniu zmienione 

definicje atrybutów wpływają tylko na nowe wstawienia. 

5 Kliknij przycisk OK. 

6 Wprowadzanie zmian w zawartości odnośnika zewnętrznego. Wszelkie nowe 

jednostki utworzone podczas edycji na miejscu są automatycznie dodawane po 

zamknięciu i zapisaniu odniesienia zewnętrznego. 

7 Aby dodać istniejącą jednostkę z rysunku do zewnętrznego odniesienia, 

wybierz jednostkę i wykonaj jedną z następujących czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Dodaj do zestawu roboczego. 

• Wpisz refset, naciśnij Enter, a następnie wybierz Add. 
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8 Aby usunąć podmiot z zewnętrznego odniesienia, wybierz podmiot i wykonaj 

jedną z poniższych czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Usuń z zestawu roboczego. 

• Wpisz refset, naciśnij Enter, a następnie wybierz Remove. 

9 Po zakończeniu edycji odnośnika zewnętrznego wykonaj jedną z poniższych czynności: 

• Wybierz Narzędzia > Edytuj blok lub X-Ref In-Place > Zamknij odniesienie. 

• Wpisz refclose i naciśnij Enter. 

10 Wybierz Zapisz, aby zapisać zmiany lub Odrzuć, aby je anulować. 

11 Zewnętrzne odniesienie jest aktualizowane, a bieżący rysunek wyświetla zmiany. 
 

Możesz także wpisać xopen, aby bezpośrednio otworzyć zewnętrzne odwołanie. 

Aby zobaczyć wszelkie zmiany wprowadzone w zewnętrznym odnośniku, gdy jest on otwarty, 

należy go ponownie załadować. 
 

 

 

 

Dołączanie podkładów utworzonych w innych formatach plików 
 

Po dołączeniu podkładu obraz reprezentujący zawartość pliku jest wstawiany do 

rysunku. Podkład jest podobny do obrazu i różni się od zewnętrznego odniesienia 

tym, że nie może być połączony i automatycznie aktualizowany. 

Podkłady można dołączać przy użyciu plików o następujących formatach: 

• Format PDF - przenośny format dokumentu, który można wyświetlać za 

pomocą programów Adobe® Acrobat® Reader® i Adobe® Acrobat. Format 

PDF wykorzystuje rozszerzenie pliku .pdf. 

• Format Autodesk® - Autodesk Design Web (używany z plikami 

.dwf) służy do dystrybucji rysunków dla innych osób w celu przeglądania w 

przeglądarce internetowej, recenzowania i edytowania przy użyciu bezpłatnego 

oprogramowania i narzędzi Autodesk. Format DWF wykorzystuje rozszerzenie 

pliku .dwf. 

• Format DGN - pliki rysunkowe używane z 

DGN wykorzystuje rozszerzenie pliku .dgn. 

• Format PCG - pliki chmury punktów używane przez oprogramowanie i 

narzędzia Autodesk®. Format PCG wykorzystuje rozszerzenie pliku .pcg. 

• Format RCP/RCS - pliki chmury punktów. Format RCP/RCS wykorzystuje 

rozszerzenie pliku .rcp lub .rcs. 

• Format IFC - pliki BIM w formacie Industry Foundation Classes dla danych 

budowlanych. 

• Format RVT/RFA - pliki BIM używane przez Autodesk Revit® dla danych 

budowlanych i konstrukcyjnych. 
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Dołączanie podkładu PDF 

Dołączanie pliku .pdf jest podobne do dołączania pliku graficznego. 
 

Aby dołączyć podkład PDF 

1 Użyj jednej z poniższych metod: 

• Na wstążce wybierz polecenie Wstaw > Podkład PDF (w danych). 

• W menu wybierz Wstaw > Podkład PDF. 

• Wpisz pdfattach i naciśnij Enter. 

2 Wybierz plik .pdf, który chcesz załączyć. 

3 Kliknij przycisk Otwórz. 

4 Określ, która strona pliku .pdf ma zostać załączona. 

5 Wybierz punkt wstawiania. 

6 Wprowadź skalę, w której ma zostać wstawiony plik .pdf. 

7 Wprowadź obrót, który ma zostać użyty do wstawienia. 

 
Dołączanie podkładu DWF 

Dołączanie pliku .dwf jest podobne do dołączania pliku obrazu. 
 

Aby dołączyć podkład DWF 

1 Użyj jednej z poniższych metod: 

• Na wstążce wybierz Wstaw > Podkład DWF (w Danych). 

• W menu wybierz Wstaw > Podkład DWF. 

• Wpisz dwfattach i naciśnij Enter. 

2 Wybierz plik .dwf, który chcesz dołączyć. 

3 Kliknij przycisk Otwórz. 

4 Wybierz punkt wstawiania. 

5 Wprowadź skalę, w której ma zostać wstawiony plik .dwf. 

6 Wprowadź obrót, który ma zostać użyty do wstawienia. 
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Dołączanie podkładu DGN 

Dołączanie pliku .dgn jest podobne do dołączania pliku obrazu. 
 

Aby dołączyć podkład DGN 

1 Użyj jednej z poniższych metod: 

• Na wstążce wybierz Wstaw > Podkład DGN (w Danych). 

• W menu wybierz Wstaw > Podkład DGN. 

• Wpisz dgnattach i naciśnij Enter. 

2 Wybierz plik .dgn, który chcesz dołączyć. 

3 Kliknij przycisk Otwórz. 

4 Wybierz punkt wstawiania. 

5 Wprowadź skalę, w której ma zostać wstawiony plik .dgn. 

6 Wprowadź obrót, który ma zostać użyty do wstawienia. 

 
Dołączanie podkładu chmury punktów 

Chmura punktów to zestaw punktów 3D, które reprezentują powierzchnię jednostki 

w trzech wymiarach. Pliki chmur punktów są zazwyczaj tworzone przez skanery 

3D. 

Dołączanie pliku chmury punktów (plik .pcg, .rcp lub .rcs) jest podobne do 

dołączania pliku obrazu. 
 

Aby dołączyć podkład chmury punktów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Point Cloud Underlay ( ):  

• Na wstążce wybierz polecenie Wstaw > Podkład chmury punktów (w danych). 

• W menu wybierz Wstaw > Podkład chmury punktów. 

• Wpisz pointcloudattach i naciśnij Enter. 

2 Wybierz plik .pcg, .rcp lub .rcs, który chcesz dołączyć. 

3 Kliknij przycisk Otwórz. 

4 W oknie dialogowym Dołącz chmurę punktów wybierz punkt wstawienia. 

5 Wprowadź skalę, w której ma zostać wstawiony plik chmury punktów. 

6 Wprowadź obrót, który ma zostać użyty do wstawienia. 

7 Jeśli chcesz zablokować chmurę punktów, aby nie można jej było przesuwać ani 

obracać po wstawieniu, zaznacz opcję Zablokuj chmurę punktów. 

8 Jeśli chcesz automatycznie powiększyć chmurę punktów po wstawieniu, zaznacz 

Zoom to Point Cloud. 

9 Kliknij przycisk OK. 
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Dołączanie podkładu BIM 

Plik modelowania informacji o budynku (BIM) to rysunek, który zazwyczaj zawiera 

model 3D budynku, który może być używany do wizualizacji, projektowania, 

analizy i generowania dokumentacji konstrukcyjnej budynku. Można dołączyć następujące 

typy plików BIM: 

• Format RVT - pliki rysunków używane przez Autodesk Revit® dla danych 

budowlanych i konstrukcyjnych. Pliki .rvt można załączać tylko przy użyciu 64-

bitowej wersji programu. 

• Format RFA - pliki rodzinne używane przez Autodesk Revit® zazwyczaj do 

przechowywania elementów budowlanych i konstrukcyjnych. Pliki .rfa można 

dołączać tylko przy użyciu 64-bitowej wersji programu. 

• Format IFC - pliki w formacie IFC (Industry Foundation Classes) używane 

do danych budowlanych. 

Dołączanie pliku BIM jest podobne do dołączania pliku 

obrazu. Po dołączeniu podkładu BIM należy zwrócić 

uwagę na następujące kwestie: 

• Warstwy Mimo że pliki BIM nie zawierają warstw, można kontrolować ich widoczność 

poprzez 

włączanie/wyłączanie pięter lub kategorii za pomocą panelu wyświetlanego dla 

pliku BIM. Użyj polecenia BIMPROP, aby otworzyć odpowiedni panel (i użyj 

BIM- PROPCLOSE, aby zamknąć panel). 

• Przyciąganie encji Podkłady BIM obsługują przyciąganie encji, jeśli włączysz 

przyciąganie za pomocą zmiennej systemowej UOSNAP (lub RVTOSNAP tylko 

dla plików .rvt i .rfa lub IFCOSNAP tylko dla plików .ifc). Można również użyć 

polecenia Options, zakładka Snapping. 

• Polecenie BIM Explode rozbija dołączony podkład BIM na siatki 

wielopowierzchniowe i polilinie, które można edytować. Polecenie BIM 

Explode jest podobne do polecenia Explode dla podkładu BIM, z wyjątkiem 

tego, że cała inteligencja podkładu BIM pozostaje nienaruszona, a każda 

wynikowa jednostka jest umieszczana na własnej warstwie. 

 

Import pliku .ifc w celu zachowania jego tożsamości. 

Podczas importowania pliku .ifc dostępne są wszystkie jednostki, a jednostki 

konstrukcyjne i architektoniczne są konwertowane na jednostki AEC. Aby uzyskać 

więcej informacji, patrz "Importowanie pliku w formacie IFC, RVT lub RFA" na 

stronie 659. 
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Aby dołączyć podkład BIM 

1 Wykonaj jedną z poniższych czynności, aby wybrać podkład BIM ( ):  

• Na wstążce wybierz Wstaw > Podkład BIM (w Danych). 

• W menu wybierz Wstaw > Podkład BIM. 

• Wpisz bimattach i naciśnij Enter. 

2 Wybierz plik .rvt, rfa lub .ifc, który chcesz dołączyć. 

3 Kliknij przycisk Otwórz. 

4 Wybierz punkt wstawiania. 

5 Wprowadź skalę, w której chcesz wstawić plik, a następnie naciśnij Enter. 

6 Wprowadź obrót, który ma zostać użyty do wstawienia, a następnie naciśnij Enter. 

 

 
 

Praca z obrazami 
 

Obrazy rastrowe można modyfikować i wyświetlać bezpośrednio w programie 

ALCAD. Możesz ładować, edytować i modyfikować wiele obrazów jako nakładki 

lub podkłady do rysunków ALCAD. Obrazy można wybrać do użycia z poleceniami 

ALCAD, wybierając ramkę obrazu, którą można włączyć lub wyłączyć w celu 

drukowania lub wyboru. 

ALCAD obsługuje wiele formatów plików graficznych, w tym BMP, JPG, GIF, 

EMF, TIF, PNG, WMF, SID i wiele innych. 

 

Dołączanie obrazów 

Po dołączeniu obrazu do rysunku, obraz jest wyświetlany na rysunku, ale nie jest w 

nim zapisywany. Podobnie jak w przypadku odniesienia zewnętrznego, plik obrazu 

pozostaje zapisany w oryginalnej lokalizacji na komputerze, w sieci lub na innym 

nośniku. 

W przypadku wysyłania lub odbierania rysunków zawierających obrazy, ważne jest, 

aby dołączyć do rysunku wszystkie załączone do niego pliki obrazów. Po otwarciu 

rysunku zawierającego obrazy, źródłowe pliki obrazów muszą być dostępne, aby 

obrazy były wyświetlane na rysunku. 
 

Aby dołączyć obraz 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dołącz obraz: 

• Na wstążce wybierz polecenie Wstaw > Dołącz obraz (w danych). 

• Wybierz Wstaw > Obraz > Dołącz obraz. 

• Na pasku narzędzi Obraz kliknij narzędzie Dołącz obraz. 

• Wpisz imageattach i naciśnij Enter. 

2 Określ plik do załączenia, a następnie kliknij Otwórz. 
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3 W polu Ścieżka obrazu zostanie zapisana jako wprowadź inną lokalizację pliku 

obrazu, jeśli to konieczne. Możesz kliknąć [ > ], aby wybrać sposób zapisania 

ścieżki obrazu: 

• Pełna ścieżka - obraz jest przywoływany przy użyciu pełnej ścieżki, na 

przykład c:\MojeObrazy\MójObraz.jpg. Użyj tej opcji, jeśli obraz jest 

zapisany w folderze niezwiązanym z bieżącym folderem rysowania. 

• Ścieżka względna - obraz jest przywoływany przy użyciu ścieżki względnej 

do bieżącego folderu rysunku, na przykład ..\MojeObrazy\MójObraz.jpg. Użyj 

tej opcji, jeśli obraz jest przechowywany w podfolderze bieżącego folderu 

rysunku. 

• Tylko nazwa pliku - obraz jest przywoływany przy użyciu nazwy pliku w 

bieżącym folderze rysunku, na przykład MyImage.jpg. Użyj tej opcji, jeśli 

obraz jest zapisany w tym samym folderze, co bieżący rysunek. 

4 W oknie dialogowym Dołącz obraz określ położenie, skalę, obrót, 

przezroczystość i opcje przycinania, a następnie kliknij przycisk OK. 
 

UWAGA Przezroczystość działa w przypadku obrazów obsługujących 

przezroczystość alfa, tj. obrazów, które mają co najmniej jeden kolor, który 

można wyświetlić jako kolor przezroczysty. 
 

 

5 Na rysunku określ punkt wstawienia, skalę i obrót, jeśli zdecydowałeś się określić je 

na ekranie. 
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A 

J 

B 
I 

 

C 

H 
 

D 

 
 

E 

 

 
A W razie potrzeby wprowadź inną lokalizację pliku 
obrazu. 

B Wybierz opcję automatycznego umieszczenia 
obrazu na rysunku przy użyciu specyfikacji 
znajdujących się w pliku pozycjonowania. Wprowadź 
plik TWF powiązany z obrazem lub kliknij [...], 
aby go wybrać. 

C Wprowadź nazwę obrazu. 

D Wybierz, aby określić punkt wstawienia na 
rysunku podczas wstawiania lub wprowadź 
współrzędne. 

E Wybierz, aby określić rozmiar obrazu na 
rysunku po wstawieniu lub inne wartości 
rozmiaru. 

F Wybór włączenia lub wyłączenia wyświetlania 
przycinania dla obrazu. 

 
G 

F 

 
 
 

G Wybierz, czy jednostki znajdujące się pod obrazem 
mają być widoczne (w przypadku obrazów 
obsługujących przezroczystość alfa). 

H Wybierz, aby określić obrót w rysunku po 
wstawieniu lub wprowadź liczbę stopni, aby 
obrócić obraz w lewo. 

I Kliknij, aby wyświetlić informacje o obrazie, w tym 
głębię kolorów i rozdzielczość. 

J Wybierz, aby zapisać ścieżkę obrazu jako 
pełną ścieżkę, względną ścieżkę do bieżącego 
folderu rysunku lub nazwę pliku w bieżącym 
folderze rysunku. 

 

 
 

Możesz także dołączyć obrazy za pomocą Menedżera obrazów lub Eksploratora 

ALCAD Wybierz Wstaw > Obraz > Menedżer obrazów, a następnie kliknij 

Dołącz, aby określić obraz, a następnie go dołączyć lub jeśli chcesz szybko 

dodać kolejne wystąpienie obrazu. 

obraz już znajdujący się na rysunku, wybierz obraz w Menedżerze obrazów, a 

następnie kliknij Dodaj. Możesz też wybrać Narzędzia > ALCAD Explorer i 

dołączyć obraz jako zewnętrzny plik referencyjny. 
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Modyfikowanie obrazów 

Obraz można modyfikować, zmieniając jego jasność, kontrast, zanikanie, rozmiar, 

obrót lub przezroczystość. Zmiany te mają wpływ tylko na obraz w rysunku - nie na 

oryginalny zewnętrzny plik obrazu. 

Oprócz modyfikowania pojedynczego obrazu lub wielu wybranych obrazów, można 

również modyfikować wszystkie wystąpienia obrazu na rysunku. Na przykład, jeśli 

logo firmy pojawia się w wielu miejscach na rysunku, można użyć Menedżera 

obrazów, aby określić zmiany raz i zastosować je do wszystkich wystąpień logo. 

Do typowych modyfikacji można użyć innych poleceń ALCAD, takich jak Usuń, 

Przenieś, Kopiuj, Obróć i innych. 
 

Aby zmodyfikować obrazy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Image Manager (  ): 

• Na wstążce wybierz polecenie Wstaw > Menedżer obrazów (w obszarze Dane). 

• W menu wybierz Wstaw > Obraz > Menedżer obrazów. 

• Na pasku narzędzi Obraz kliknij narzędzie Menedżer obrazów. 

• Wpisz image, a następnie naciśnij Enter. 
 

WSKAZÓWKA Obrazy można również modyfikować, zaznaczając jeden lub 

więcej obrazów na rysunku, a następnie wybierając opcję Modyfikuj > 

Właściwości. 
 

 

2 Z listy Obrazy wybierz obraz, który chcesz zmodyfikować. Jeśli na rysunku 

występuje więcej niż jeden obraz, wykonaj jedną z poniższych czynności: 

• Aby zmodyfikować wszystkie wystąpienia obrazu, wybierz obraz najwyższego poziomu 

na liście. 

• Aby zmodyfikować pojedyncze wystąpienie obrazu, rozwiń obraz 

najwyższego poziomu na liście, a następnie wybierz pojedynczy obraz. 

3 Dostosuj jasność, kontrast i zanikanie, przesuwając suwak do żądanego 

ustawienia lub wprowadzając dokładną liczbę. Podgląd obrazu pokazuje, jak 

wprowadzone zmiany wpłyną na obraz. 
 

WSKAZÓWKA Jeśli chcesz przywrócić domyślne ustawienia jasności, kontrastu 

i wygaszania obrazu, kliknij przycisk Resetuj. 
 

 

4 Dostosuj rozmiar, zmieniając szerokość (X) i wysokość (Y) w jednostkach 

rysunkowych. Zaznacz opcję Zachowaj proporcje, jeśli chcesz, aby szerokość 

i wysokość zmieniały się razem w celu zachowania proporcji obrazu. 

5 Dostosuj Obrót, wprowadzając liczbę stopni, o jaką obraz ma zostać 

obrócony w lewo. Zero stopni oznacza brak obrotu. 

6 Zaznacz opcję Użyj przezroczystości, jeśli chcesz, aby jednostki znajdujące się 

pod obrazem były widoczne (w przypadku obrazów obsługujących 

przezroczystość alfa, tj. obrazów, które mają co najmniej jeden kolor, który 

można wyświetlić jako kolor przezroczysty). 
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7 Zaznacz opcję Show Clipping Boundary, jeśli chcesz wyświetlić przycięty 

obraz, jeśli dla obrazu zdefiniowano granicę przycinania. Odznaczenie tej opcji 

powoduje wyświetlenie całego obrazu, nawet jeśli zdefiniowano granicę 

przycinania. 

8 Kliknij przycisk OK. 

 

 

 

 

 

A 

 
 
 
 
 

 
L 

 
 

 BK 
C 
D 

J
 

E I 

H 

F G 

 
 

 

A Kliknij obraz najwyższego poziomu, aby 
zmodyfikować wszystkie wystąpienia znajdujące 
się na rysunku. Rozwiń obraz najwyższego poziomu i 
kliknij pojedynczy obraz, aby zmodyfikować tylko 
to wystąpienie. 

B Przesuń suwak lub wprowadź dokładną wartość 
jasności obrazu. 

C Przesuń suwak lub wprowadź dokładną liczbę 
dla kontrastu obrazu. 

D Przesuń suwak lub wprowadź dokładną liczbę 
dla opcji zanikania obrazu, która powoduje 
zanikanie obrazu bez wyświetlania elementów 
znajdujących się pod obrazem. 

E Kliknij, aby powrócić do domyślnych ustawień 
jasności, kontrastu i wygaszania. 

F Wybór, czy wszystkie ramki obrazu mają być 
wyświetlane i drukowane. 

G Wybierz, czy wszystkie obrazy na rysunku mają 
być wyświetlane w wysokiej jakości (wymaga 
więcej zasobów systemowych). 

H Wprowadź szerokość (X) i wysokość (Y) w 
jednostkach rysunkowych. Zaznacz opcję 
Zachowaj proporcje, aby zmienić szerokość i 
wysokość razem. 

I Wybór włączenia lub wyłączenia wyświetlania 
przycinania dla obrazu. 

J Wybierz, czy jednostki znajdujące się pod obrazem 
mają być widoczne (w przypadku obrazów 
obsługujących przezroczystość alfa). 

K Wprowadź liczbę stopni obrotu obrazu w lewo. 

L Kliknij, aby wyświetlić szczegóły wybranego obrazu. 
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Zmiana sposobu wyświetlania obrazów 

Sposób wyświetlania wszystkich obrazów na rysunku można zmienić w następujący sposób: 

• Jakość obrazu - obrazy mogą być wyświetlane w wysokiej lub niskiej rozdzielczości. 

• Ramki obrazów - obrazy mogą być wyświetlane i drukowane z ramkami na 

krawędziach lub bez nich. 

 
Zmiana jakości wyświetlania wszystkich obrazów 
Wysoka jakość wyświetla obrazy w wysokiej rozdzielczości i wymaga więcej 

zasobów systemowych. Jakość robocza wyświetla obrazy w niskiej rozdzielczości i 

zużywa mniej zasobów systemowych. Zmiana ustawienia jakości ma wpływ na 

wszystkie obrazy na rysunku. 
 

Aby zmienić jakość wyświetlania wszystkich obrazów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Jakość obrazu (  ): 

• Na wstążce wybierz polecenie Wstaw > Jakość obrazu (w obszarze Dane). 

• W menu wybierz Wstaw > Obraz > Jakość obrazu. 

• Na pasku narzędzi Obraz kliknij narzędzie Jakość obrazu. 

• Wpisz imagequality i naciśnij Enter. 

2 Wybierz opcję High lub Draft. 
 

WSKAZÓWKA Ta funkcja jest również dostępna w Menedżerze obrazów. Wpisz 

image, a następnie w oknie dialogowym Image Manager wybierz opcję High-

quality image display. 
 

 
Włączanie lub wyłączanie ramek obrazu dla wszystkich obrazów 
Gdy ramki obrazu są włączone, ramka jest wyświetlana i drukowana na krawędzi 

wszystkich obrazów na rysunku. Gdy ramki obrazu są wyłączone, żaden z obrazów 

nie jest wyświetlany ani drukowany z ramką, co również sprawia, że obrazy nie są 

wybierane. Każda ramka obrazu ma przypisane właściwości (warstwa, kolor, typ linii 

itp.). 

Wyłączenie ramek obrazu może być pomocne, na przykład, jeśli obrazy są 

częścią tła na rysunku. 
 

Aby włączyć lub wyłączyć ramki obrazu dla wszystkich obrazów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyświetl ramkę obrazu ( ):  

• Na wstążce wybierz polecenie Wstaw > Wyświetl ramkę obrazu (w danych). 

• W menu wybierz Wstaw > Obraz > Wyświetl ramkę obrazu. 

• Na pasku narzędzi Obraz kliknij narzędzie Wyświetl ramkę obrazu. 

• Wpisz imageframemode i naciśnij Enter. 

2 Wybierz Włączone lub Wyłączone. 

3 W przypadku wybrania opcji Wł. należy wybrać, czy mają być drukowane ramki obrazu. 
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WSKAZÓWKA Ta funkcja jest również dostępna w Menedżerze obrazów. Wpisz 

obraz, a następnie w oknie dialogowym Menedżer obrazów wybierz opcję Ramki 

obrazu. Można też użyć zmiennej systemowej IMAGEFRAME. 
 

 
Przycinanie obrazów 

Obrazy można przycinać w taki sposób, aby tylko ich część była widoczna na 

rysunku. Widoczna część (lub niewidoczna część w przypadku klipów 

odwróconych) może mieć kształt prostokąta lub wielokąta. 

Przycinanie obrazu można włączać i wyłączać. Jeśli wyłączysz przycinanie obrazu, 

cały obraz będzie widoczny, pod warunkiem, że obraz znajduje się na warstwie, 

która jest włączona i rozmrożona. Informacje o przycinaniu są jednak zachowywane 

i można je ponownie włączyć w dowolnym momencie. 

Jeśli usuniesz przycięcie z obrazu, zostanie ono trwale usunięte, ale sam obraz 

pozostanie na rysunku. 

 

Przycinanie obrazów w kształcie prostokąta 

Aby przyciąć obraz w kształcie prostokąta 

1 Upewnij się, że ramki obrazu są włączone - aby można było wybierać obrazy 

- wybierając opcję Obraz > Wyświetl ramkę obrazu, a następnie opcję Włącz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Clip Image (  ): 

• Na wstążce wybierz polecenie Wstaw > Wycinek obrazu (w obszarze Dane). 

• W menu wybierz polecenie Wstaw > Obraz > Przytnij obraz. 

• Na pasku narzędzi Obraz kliknij narzędzie Przytnij obraz. 

• Wpisz imageclip i naciśnij Enter. 

3 Wybierz krawędź obrazu, którą chcesz przyciąć. 

4 Jeśli pojawi się monit, wybierz opcję Nowy, aby utworzyć nową granicę przycinania. 

5 Wybierz opcję Prostokąt. Jeśli chcesz odwrócić klip, czyli ukryć obszar 

wewnątrz granicy, wybierz opcję Odwróć klip przed wybraniem opcji 

Prostokąt. 

6 Zdefiniuj pierwszy róg prostokąta przycinania. 

7 Zdefiniuj przeciwległy narożnik prostokąta przycinania. 

Widoczna jest tylko część obrazu znajdująca się w prostokącie przycinania. 
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Przycinanie obrazów w kształcie wielokąta 

Aby przyciąć obraz w kształcie wielokąta 

1 Upewnij się, że ramki obrazu są włączone - aby można było wybierać obrazy 

- wybierając opcję Obraz > Wyświetl ramkę obrazu, a następnie opcję Włącz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Clip Image (  ): 

• Na wstążce wybierz polecenie Wstaw > Wycinek obrazu (w obszarze Dane). 

• W menu wybierz polecenie Wstaw > Obraz > Przytnij obraz. 

• Na pasku narzędzi Obraz kliknij narzędzie Przytnij obraz. 

• Wpisz imageclip i naciśnij Enter. 

3 Wybierz krawędź obrazu, którą chcesz przyciąć. 

4 Jeśli pojawi się monit, wybierz opcję Nowy, aby utworzyć nową granicę przycinania. 

5 Wybierz opcję Wielokąt. Jeśli chcesz odwrócić klip, czyli ukryć obszar 

wewnątrz granicy, wybierz opcję Odwróć klip przed wybraniem opcji 

Wielokąt. 

6 Wybierz punkty wielokąta, a następnie naciśnij klawisz Enter, gdy wielokąt 

będzie kompletny. 

Widoczna jest tylko część obrazu znajdująca się w wielokącie przycinania. 

 
Włączanie lub wyłączanie przycinania obrazów 

Aby włączyć lub wyłączyć przycinanie obrazu 

1 Upewnij się, że ramki obrazu są włączone - aby można było wybierać obrazy 

- wybierając opcję Obraz > Wyświetl ramkę obrazu, a następnie opcję Włącz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Clip Image (  ): 

• Na wstążce wybierz polecenie Wstaw > Wycinek obrazu (w obszarze Dane). 

• W menu wybierz polecenie Wstaw > Obraz > Przytnij obraz. 

• Na pasku narzędzi Obraz kliknij narzędzie Przytnij obraz. 

• Wpisz imageclip i naciśnij Enter. 

3 Wybierz krawędź obrazu, dla której chcesz włączyć lub wyłączyć przycinanie. 

4 Wybierz Włączone lub Wyłączone. 
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Usuwanie przycięć z obrazów 

Aby usunąć przycięcia z obrazu 

1 Upewnij się, że ramki obrazu są włączone - aby można było wybierać obrazy 

- wybierając opcję Obraz > Wyświetl ramkę obrazu, a następnie opcję Włącz. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Clip Image (  ): 

• Na wstążce wybierz polecenie Wstaw > Wycinek obrazu (w obszarze Dane). 

• W menu wybierz polecenie Wstaw > Obraz > Przytnij obraz. 

• Na pasku narzędzi Obraz kliknij narzędzie Przytnij obraz. 

• Wpisz imageclip i naciśnij Enter. 

3 Wybierz krawędź obrazu, dla której chcesz usunąć przycięcie. 

4 Wybierz Usuń. 

 
Rozładowywanie i ponowne ładowanie obrazów 

Jeśli okaże się, że dołączenie obrazu wpływa na wydajność systemu, można go 

wyładować, tak aby wyświetlana była tylko ramka obrazu oznaczająca jego 

lokalizację. Jeśli chcesz wydrukować niezaładowany obraz, załaduj go ponownie przed 

wydrukowaniem. Wczytanie obrazu może być również konieczne, jeśli oryginalny 

plik zawiera nową zawartość. 
 

Aby rozładować i ponownie załadować obraz 

1 Wykonaj jedną z poniższych czynności, aby wybrać Image Manager (  ): 

• Na wstążce wybierz polecenie Wstaw > Menedżer obrazów (w obszarze Dane). 

• W menu wybierz Wstaw > Obraz > Menedżer obrazów. 

• Na pasku narzędzi Obraz kliknij narzędzie Menedżer obrazów. 

• Wpisz image, a następnie naciśnij Enter. 

2 Na liście Obrazy wybierz żądany obraz. Jeśli na rysunku występuje więcej niż 

jeden obraz, wykonaj jedną z poniższych czynności: 

• Aby wyładować lub przeładować wszystkie wystąpienia obrazu, wybierz 

obraz najwyższego poziomu na liście. 

• Aby wyładować lub przeładować pojedyncze wystąpienie obrazu, rozwiń 

obraz najwyższego poziomu na liście, a następnie wybierz pojedynczy obraz. 

3 Wykonaj jedną z poniższych czynności: 

• Aby wyładować obraz tak, by wyświetlana była tylko jego zewnętrzna krawędź, kliknij 

przycisk Wyładuj. 

• Aby przeładować obraz w celu wyświetlenia i wydrukowania jego zawartości, kliknij 

przycisk Przeładuj. 
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Zmiana ścieżki dla obrazów 

Jeśli nazwa pliku powiązanego z obrazem zostanie zmieniona lub przeniesiony on 

zostanie do innej lokalizacji, program wyświetli komunikat informujący, że nie może 

załadować obrazu. Można ponownie utworzyć łącze do pliku, zmieniając ścieżkę 

do obrazu. 
 

Aby zmienić ścieżkę dla obrazu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Image Manager (  ): 

• Na wstążce wybierz polecenie Wstaw > Menedżer obrazów (w obszarze Dane). 

• W menu wybierz Wstaw > Obraz > Menedżer obrazów. 

• Na pasku narzędzi Obraz kliknij narzędzie Menedżer obrazów. 

• Wpisz image, a następnie naciśnij Enter. 

2 Na liście Obrazy wybierz żądany obraz. Jeśli na rysunku występuje więcej niż 

jeden obraz, wykonaj jedną z poniższych czynności: 

• Aby zmienić ścieżkę dla wszystkich wystąpień obrazu, wybierz obraz 

najwyższego poziomu na liście. 

• Aby zmienić ścieżkę dla pojedynczego wystąpienia obrazu, rozwiń obraz 

najwyższego poziomu na liście, a następnie wybierz pojedynczy obraz. 

3 Kliknij przycisk [. 

4 Wybierz plik o nowej nazwie lub w nowej lokalizacji, a następnie kliknij przycisk Otwórz. 

5 Kliknij przycisk Ustaw ścieżkę. 

 
Usuwanie obrazów 

Gdy obraz nie jest już potrzebny na rysunku, można go z niego usunąć. Usunięcie 

obrazu powoduje usunięcie go z rysunku oraz z listy obrazów w oknie dialogowym 

Menedżer obrazów. 
 

Aby usunąć obraz 

1 Wykonaj jedną z poniższych czynności, aby wybrać Image Manager (  ): 

• Na wstążce wybierz polecenie Wstaw > Menedżer obrazów (w obszarze Dane). 

• W menu wybierz Wstaw > Obraz > Menedżer obrazów. 

• Na pasku narzędzi Obraz kliknij narzędzie Menedżer obrazów. 

• Wpisz image, a następnie naciśnij Enter. 

2 Z listy Obrazy wybierz obraz, który chcesz usunąć. Jeśli na rysunku występuje 

więcej niż jeden obraz, wykonaj jedną z poniższych czynności: 

• Aby usunąć wszystkie wystąpienia obrazu, wybierz obraz najwyższego poziomu na liście. 

• Aby usunąć pojedyncze wystąpienie obrazu, rozwiń obraz najwyższego 

poziomu na liście, a następnie wybierz pojedynczy obraz. 

3 Kliknij przycisk Odłącz. 
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Możesz wydrukować kopię rysunku dokładnie tak, jak go utworzyłeś, lub możesz 

dodać formatowanie i określić elementy sterujące drukiem, aby zmienić wygląd 

rysunku po wydrukowaniu. 

Czasami może być wymagane wydrukowanie wielu rysunków, każdy o innym 

wyglądzie lub układzie. Na przykład, może być potrzebny jeden wydrukowany 

rysunek do prezentacji dla klienta, wraz z kilkoma innymi wariantami dla 

wykonawców produkcji. Dla każdego typu drukowanego rysunku, który jest 

wymagany, można utworzyć układ, który definiuje jego cechy, w tym skalę, obszar 

do wydrukowania, tabele stylów drukowania i inne. 

W tej sekcji wyjaśniono, jak 

• Rozpocznij drukowanie od razu. 

• Skonfiguruj rysunek, aby wydrukować wiele układów z przestrzeni papieru na karcie Układ. 

• Dostosuj wygląd rysunku po wydrukowaniu. 

• Zdefiniuj sposób drukowania rysunku za pomocą stylów wydruku. 

• Wydrukuj lub narysuj rysunek. 

• Opublikuj swój rysunek. 

 

 

 

 

 

 

 
Tematy w tym rozdziale 

Rozpoczęcie drukowania  .................................................................................. 516 
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Rozpoczęcie drukowania 
 

Podczas tworzenia rysunku większość pracy wykonywana jest na karcie Model. W 

dowolnym momencie można wydrukować rysunek, aby zobaczyć, jak wygląda na papierze. Łatwo jest 

rozpocząć drukowanie, a następnie utworzyć układy i niestandardowe ustawienia 

drukowania, aby ulepszyć wydruk. 

 

Aby rozpocząć drukowanie 

1 Na karcie Model wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj lub wybierz kolejno Wyjście > Drukuj (w oknie Drukuj). 

• W menu wybierz Plik > Drukuj. 

• Na pasku narzędzi Standardowy kliknij narzędzie Drukuj. 

• Wpisz print i naciśnij Enter. 

2 Kliknij przycisk Drukuj. 
 

W tej sekcji wyszczególniono wiele opcji drukowania, takich jak skala rysunku, 

obszar drukowania, tabele stylów drukowania i inne. 

 

Wpisz qprint i naciśnij Enter, aby wydrukować bieżącą rzutnię. 

Okno dialogowe Drukuj jest pomijane, a rysunek jest wysyłany bezpośrednio do 

wybranej drukarki. 
 



 

Definiowanie układów do 
drukowania 
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Rysunek można wydrukować bezpośrednio z karty Model, w której został 

utworzony, lub można utworzyć niestandardowe układy do drukowania na kartach 

Układ. 

Podczas drukowania z karty Model można wydrukować rysunek dokładnie w takiej 

postaci, w jakiej jest wyświetlany, lub można zmodyfikować rysunek przed 

wydrukowaniem, dodając wymiary, koniec nogi lub blok tytułu. 

Zazwyczaj do drukowania używa się kart Układ, jeśli wymagane jest drukowanie w 

wielu układach. Można również użyć karty Układ do drukowania, nawet jeśli 

rysunek ma zostać wydrukowany tylko w jeden sposób. Na przykład, jeśli chcesz 

umieścić dużą ilość tekstu na wydrukowanym rysunku, możesz dodać tekst do karty 

Układ, aby nie zaśmiecał rysunku podczas pracy na karcie Model. 

 

Zrozumienie układów 

Podczas tworzenia rysunku większość pracy wykonywana jest na karcie Model. 

Każdy tworzony rysunek może zawierać wiele układów, które symulują papier, na 

którym zostanie wydrukowana kopia rysunku. Każdy z tych układów jest tworzony 

na karcie Układ. 

Dla każdego sposobu drukowania rysunku można przygotować osobny układ. Układ 

umożliwia organizowanie różnych widoków w celu kontrolowania, która część rysunku jest 

drukowana i w jakiej skali. 

Przed wydrukowaniem można również dołączyć dodatkowe jednostki i ustawienia 

układu, które kontrolują sposób drukowania rysunku. Dodatkowe elementy 

pojawiają się tylko na karcie Układ, a nie na karcie Model. Na przykład układ może 

zawierać wymiary, bloki tytułowe, legendy lub słowa kluczowe, które są drukowane 

wraz z modelem, ale nie zaśmiecają ekranu podczas pracy z modelem na karcie 

Model. 

Skorzystaj z tych ogólnych kroków, aby przygotować rysunek do drukowania wielu układów: 

1 Na karcie Model utwórz rysunek. 

2 Utwórz nowy układ. Można użyć istniejącej karty Layout1 lub Layout2 albo 

utworzyć nową kartę Layout. Szczegółowe informacje zawiera sekcja "Tworzenie 

nowego układu" na stronie 521 w tym rozdziale. 

3 Utwórz co najmniej jedną rzutnię układu na karcie Układ. Każda rzutnia 

pomaga kontrolować, która część rysunku jest drukowana i w jakiej skali. 

Szczegółowe informacje zawiera sekcja "Praca z rzutniami układu" na stronie 

524 w tym rozdziale. 

4 Dołącz wszelkie dodatkowe elementy, które mogą być wymagane dla 

określonego układu, takie jak wymiary, legenda lub blok tytułowy. 

5 Określenie dodatkowych ustawień układu, takich jak skala rysunku, obszar 

wydruku, tabele stylów wydruku i inne. Szczegółowe informacje można znaleźć 

w sekcji "Dostosowywanie i ponowne wykorzystywanie ustawień drukowania" 

na stronie 530 w tym rozdziale. 



6 Wydrukuj lub wykreśl rysunek. Więcej informacji można znaleźć w sekcji 

"Drukowanie lub plotowanie rysunku" na stronie 558 w tym rozdziale. 
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Zrozumienie przestrzeni papieru i przestrzeni modelu 

Po rozpoczęciu sesji rysowania początkowy obszar roboczy nazywany jest 

przestrzenią modelu. Przestrzeń modelu to obszar, w którym tworzone są 

dwuwymiarowe i trójwymiarowe obiekty w oparciu o światowy układ 

współrzędnych (WCS) lub układ współrzędnych użytkownika (UCS). Przeglądanie 

i praca w przestrzeni modelu odbywa się za pomocą karty Model. 

Widok tego obszaru to pojedyncza rzutnia wypełniająca ekran. Na karcie Model 

można tworzyć dodatkowe widoki, zwane rzutniami, które mogą wyświetlać te 

same lub inne dwuwymiarowe lub trójwymiarowe widoki, z których wszystkie są 

wyświetlane w sposób kafelkowy. Na karcie Model można pracować tylko w jednej 

z tych rzutni jednocześnie i można drukować tylko bieżącą rzutnię. 

 

Model przestrzeni z dwoma rzutniami. 

ALCAD zapewnia dodatkowy obszar roboczy, zwany przestrzenią papieru. 

Zawartość przestrzeni papieru reprezentuje układ rysunku na papierze. W tym obszarze 

roboczym można tworzyć i rozmieszczać różne widoki modelu, podobnie jak w 

przypadku rozmieszczania rysunków szczegółowych lub ortogonalnych widoków 

modelu na kartce papieru. W przestrzeni papieru można także dodawać wymiary, 

słowa kluczowe, adnotacje, obramowania, bloki tytułowe i inne elementy związane z 

wydrukiem, co zmniejsza bałagan podczas pracy z modelem w przestrzeni modelu. 

Użytkownik przegląda i pracuje w przestrzeni papierowej, korzystając z karty 

Układ. Każdy widok lub rzutnia układu utworzona w przestrzeni papieru zapewnia 

okno rysunku w przestrzeni modelu. Można utworzyć jedną lub kilka rzutni układu. 

Rzutnie układu można umieszczać w dowolnym miejscu na ekranie; ich krawędzie 

mogą się stykać lub nie; można je drukować jednocześnie. 
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Do wydrukowania rysunku nie trzeba używać miejsca na papierze, ale oferuje on 

kilka zalet: 

• Drukowanie tego samego rysunku z różnymi ustawieniami drukowania, które są 

zapisywane z każdym układem, na przykład pliki konfiguracyjne drukarki, tabele 

stylów drukowania, ustawienia grubości linii, skala rysunku i inne. 

• Dodaj encje związane z drukowaniem, które nie są istotne dla samego modelu, 

takie jak notatki lub adnotacje, aby zmniejszyć bałagan podczas pracy z 

modelem w przestrzeni modelu na karcie Model. 

• Dla pojedynczego układu można utworzyć wiele rzutni układu, które drukują 

model w różnych widokach i skalach. 
 

 
Przestrzeń papierowa z rzutniami układu. 

 

Jednostki można kopiować i przenosić między przestrzenią modelu a przestrzenią papieru. 

Wybierz polecenie Modyfikuj > Zmień przestrzeń, a następnie zaznacz jednostki, 

które chcesz skopiować lub przenieść z przestrzeni papieru do przestrzeni modelu 

lub z przestrzeni modelu do przestrzeni papieru. 
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Wyświetlanie rysunków w przestrzeni papieru i przestrzeni modelu 

Podczas pracy w przestrzeni papierowej na karcie Układ można nadal wyświetlać 

rysunek w przestrzeni modelu. Najpierw należy utworzyć rzutnię układu w 

przestrzeni papieru; umożliwia to wyświetlanie elementów przestrzeni modelu z 

przestrzeni papieru. 

W rzutni układu można modyfikować i przyciągać jednostki przestrzeni modelu 

podczas pracy w przestrzeni modelu, a nawet przyciągać jednostki przestrzeni 

modelu z przestrzeni papieru. Przyciąganie do jednostek przestrzeni modelu z 

przestrzeni papieru pozwala na dokładne wymiarowanie jednostek przestrzeni 

modelu w przestrzeni papieru. I choć generalnie wygodniej jest modyfikować 

jednostki na karcie Model, często zdarza się, że wygodnie jest wprowadzać 

modyfikacje z rzutni układu na karcie Układ. 

Powiększanie lub przesuwanie rysunku w przestrzeni modelu lub przestrzeni papieru 

wpływa na cały rysunek, chyba że używanych jest wiele okien lub rzutni. 

Dodatkowo, jeśli pracujesz w przestrzeni papieru, możesz zablokować rzutnię układu, 

aby skala rzutni i centrum widoku nie zmieniały się podczas przesuwania i 

powiększania w rzutni układu. 
 

Aby wyświetlić rysunek w przestrzeni modelu na karcie Model 

Wykonaj jedną z poniższych czynności: 

• Kliknij kartę Model. 

• Kliknij prawym przyciskiem myszy przełącznik Model/Paper Space na 

pasku stanu, a następnie wybierz opcję Model. 
 

Aby wyświetlić rysunek w przestrzeni papieru na karcie Układ 

Wykonaj jedną z poniższych czynności: 

• Kliknij jedną z kart Układ. 

• Wpisz layout, a następnie naciśnij Enter. W oknie zachęty wybierz opcję Ustaw. 

Wpisz nazwę układu, który chcesz uczynić aktualnym, a następnie naciśnij 

klawisz Enter. 

• Kliknij dwukrotnie przełącznik Model/Przestrzeń papieru na pasku stanu. Na 

przykład, kliknij dwukrotnie "Model" lub "M:Tab Name" na pasku stanu, aby 

przełączyć na przestrzeń papieru. 

• Na karcie Układ wpisz pspace, a następnie naciśnij klawisz Enter. 

• Podczas korzystania z karty Układ kliknij dwukrotnie poza rzutnią układu. 
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Aby wyświetlić rysunek w przestrzeni modelu na karcie Układ 

Wykonaj jedną z poniższych czynności: 

• Kliknij żądaną kartę Układ, a następnie utwórz i wyświetl rzutnię układu. Więcej 

informacji zawiera sekcja "Praca z rzutniami układu" na stronie 524 w tym 

rozdziale. 

• Kliknij dwukrotnie przełącznik Model/Przestrzeń papieru na pasku stanu. Na 

przykład, kliknij dwukrotnie "P:Tab Name" na pasku stanu, aby przełączyć na 

przestrzeń modelu na bieżącej karcie układu. 

• Wpisz mspace i naciśnij Enter. 

• Podczas korzystania z karty Układ kliknij dwukrotnie wewnątrz rzutni układu. 

 

Wyświetlanie kart Model i Układ 

Zakładki Model i Układ można w razie potrzeby ukryć. Ukrycie zakładek może być 

konieczne w przypadku pracy wyłącznie na zakładce Model lub korzystania z paska poleceń i 

paska stanu do przełączania się między zakładkami. 
 

Aby włączyć lub wyłączyć wyświetlanie kart Model i Układ 

Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz karty Widok > Model i Układ (w obszarze Wyświetlanie). 

• Wybierz Widok > Wyświetlanie > zakładki Model i Układ. 

• Wybierz Narzędzia > Opcje > Zakładka Wyświetlanie i wybierz Pokaż zakładki. 

 

Tworzenie nowego układu 

W programie ALCAD można utworzyć wiele układów dla jednego rysunku. Każdy 

układ reprezentuje arkusz papieru. Dla każdego układu można określić obszar 

wydruku, style drukowania, skalę wydruku, skalę grubości linii, mapowanie pióra 

oraz dodać rzutnie, wymiary, blok tytułu i inną geometrię specyficzną dla układu. 

Jednostki dodane do układu w przestrzeni papierowej nie pojawiają się w przestrzeni modelu. 

Każdy układ wymaga co najmniej jednej rzutni układu, która jest tworzona 

automatycznie podczas tworzenia nowego układu. Ta rzutnia wyświetla 

jednostki przestrzeni modelu rysunku. 

Podczas tworzenia nowego rysunku, rysunek automatycznie zawiera dwa domyślne 

układy: Układ1 i Układ2. Możesz zacząć od użycia jednego z domyślnych układów, 

możesz utworzyć własny lub możesz utworzyć nowy układ z innego pliku szablonu 

(.dwt), pliku rysunku (.dwg) lub pliku wymiany rysunku (.dxf). Możesz także użyć 

ALCAD Explorer do tworzenia i zarządzania układami. 

Każdy rysunek może zawierać do 255 układów. 
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Aby utworzyć nowy układ za pomocą karty Układ1 lub Układ2 

1 Kliknij kartę Layout1 lub Layout2. 

2 W razie potrzeby skonfiguruj co najmniej jedną rzutnię układu. Szczegółowe 

informacje zawiera sekcja "Praca z rzutniami układu" na stronie 524 w tym 

rozdziale. 

3 W razie potrzeby zmień nazwę układu. Szczegółowe informacje zawiera sekcja 

"Zmiana nazwy układu" na stronie 524 w tym rozdziale. 
 

Aby utworzyć nowy układ przy użyciu nowej karty Układ 

1 Wykonaj jedną z poniższych czynności, aby wybrać Nowy układ (  : 

• Na wstążce wybierz polecenie Widok > Nowy układ (w obszarze Układy). 

• Wybierz Wstaw > Układ > Nowy układ. 

• Na pasku narzędzi Układy kliknij narzędzie Nowy układ. 

• Wpisz layout, naciśnij Enter i wybierz New. 

2 Wpisz unikalną nazwę układu, a następnie naciśnij klawisz Enter. 

Nazwa może mieć długość do 255 znaków i może zawierać litery, cyfry, znak 

dolara ($), myślnik (-) i podkreślnik (_) lub dowolną kombinację. 

3 Skonfiguruj co najmniej jedną rzutnię układu. Szczegółowe informacje zawiera 

sekcja "Praca z rzutniami układu" na stronie 524 w tym rozdziale. 

Aby utworzyć nowy układ z istniejącego pliku 

1 Wykonaj jedną z następujących czynności :aby wybrać Układ z szablonu (  

• Na wstążce wybierz polecenie Widok > Układ z szablonu (w obszarze Układy). 

• W menu wybierz Wstaw > Układ > Układ z szablonu. 

• Na pasku narzędzi Układy kliknij narzędzie Układ z szablonu. 

• Wpisz layout, naciśnij Enter i wybierz Template. 

• Kliknij prawym przyciskiem myszy kartę Układ i wybierz opcję Z szablonu. 

2 Wybierz żądany szablon, rysunek lub plik wymiany rysunku zawierający żądany 

układ, a następnie kliknij przycisk Otwórz. 

3 Wybierz układy, a następnie kliknij przycisk OK. Można wybrać wiele układów, 

przytrzymując klawisz Ctrl podczas wybierania nazw układów. 

 

Ponowne wykorzystanie układów z innych plików 

Oszczędność czasu dzięki ponownemu wykorzystaniu już utworzonych układów. W 

ramach tego samego rysunku można utworzyć kopię układu, która zawiera 

większość żądanych ustawień, a następnie wprowadzić zmiany w nowej kopii. Jeśli 

utworzyłeś układy, których chcesz użyć ponownie podczas tworzenia nowych 

rysunków, możesz zapisać układy jako szablon rysunku. 
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Aby utworzyć kopię układu 

1 Wpisz layout i naciśnij Enter. 

2 W oknie dialogowym wybierz opcję Kopiuj. 

3 Wpisz nazwę układu, który chcesz skopiować, a następnie naciśnij klawisz Enter. 

4 Wpisz nazwę nowego układu, a następnie naciśnij klawisz Enter. 
 

Aby zapisać układ jako szablon rysunku 

1 Wpisz layout, a następnie naciśnij Enter. 

2 W oknie zachęty wybierz opcję Zapisz. 

3 Wpisz nazwę układu, który chcesz zapisać, a następnie naciśnij klawisz Enter. 

4 Określ nazwę pliku i lokalizację szablonu, a następnie kliknij przycisk Zapisz. 
 

Po zapisaniu układu jako szablonu można użyć szablonu podczas tworzenia nowych 

rysunków. Można również zaimportować układy szablonu do innego rysunku. 

 

Eksportowanie układów do przestrzeni modelu nowego rysunku 

Każdy układ można wyeksportować do przestrzeni modelu nowego rysunku. Podczas 

eksportu elementy mogą być modyfikowane przez przycinanie, skalowanie lub 

eksplodowanie w celu wizualnego przedstawienia zawartości układu w przestrzeni 

modelu. 
 

Aby wyeksportować układ do przestrzeni modelu nowego rysunku 

1 Kliknij kartę układu, którą chcesz wyeksportować. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Eksportuj układ do modelu (  ): 

• Na wstążce wybierz polecenie Widok > Eksportuj układ do modelu (w obszarze Układy). 

• W menu wybierz Wstaw > Układ > Eksportuj układ do modelu. 

• Na pasku narzędzi Układy kliknij narzędzie Eksportuj układ do modelu. 

• Wpisz exportlayout i naciśnij Enter. 

• Kliknij prawym przyciskiem myszy zakładkę Układ i wybierz opcję Eksportuj układ do 

modelu. 

3 Określ nazwę pliku, który chcesz utworzyć, a następnie kliknij przycisk Zapisz. 

 
Zarządzanie układami na rysunku 

Można zmieniać nazwy układów, usuwać układy i wyświetlać listę wszystkich 

układów dostępnych w rysunku. Można również zmienić kolejność wyświetlania 

kart Układ; karta Model jest zawsze nieruchoma. 

Jeśli chcesz zmienić nazwę, usunąć lub zmienić kolejność układu, gdy zakładki 

układu są ukryte, możesz wpisać układ, aby wprowadzić zmiany lub wybrać Widok > 

Wyświetl > Model i zakładki układu, aby wyświetlić zakładki. 
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Aby zmienić nazwę układu 

1 Kliknij prawym przyciskiem myszy kartę Układ, aby zmienić nazwę. 

2 Wpisz nową nazwę układu. 

3 Kliknij przycisk OK. 

Nazwa może mieć długość do 255 znaków i może zawierać litery, cyfry, znak 

dolara ($), myślnik (-) i podkreślnik (_) lub dowolną kombinację. 

Aby usunąć układ 

1 Kliknij prawym przyciskiem myszy kartę Układ, aby ją usunąć. 

2 Kliknij OK, aby potwierdzić usunięcie. 

 

Nie można usunąć zakładki Model ani ostatniej pozostałej zakładki Układ. 

Aby usunąć całą geometrię z karty Model lub karty Układ, najpierw zaznacz całą 

geometrię, a następnie użyj polecenia Wymaż. 

 
Aby zmienić kolejność kart układu 

1 Kliknij prawym przyciskiem myszy kartę układu, którą chcesz przenieść. 

2 Wykonaj jedną z poniższych czynności: 

• Wybierz Przenieś w prawo, a następnie wybierz nową lokalizację. 

• Wybierz Przenieś w lewo, a następnie wybierz nową lokalizację. 

Aby wyświetlić listę wszystkich układów 

1 Wpisz layout, a następnie naciśnij Enter. 

2 W oknie dialogowym wybierz ?, aby wyświetlić listę wszystkich układów. 

3 Wpisz s lub naciśnij Enter, aby przewijać układy. 

 
Praca z rzutniami układu 

Rzutnia układu to okno w zakładce Układ (przestrzeń papieru), które wyświetla 

wszystkie lub część elementów przestrzeni modelu rysunku. 

 

Zrozumienie rzutni układu 
Po rozpoczęciu pracy z rysunkiem na karcie Model składa się on z pojedynczego 

widoku modelu. Możesz utworzyć dodatkowe widoki, dzieląc przestrzeń rysunku na 

wiele okien; każde okno jest oddzielną rzutnią na karcie Model. 

Podobnie, po rozpoczęciu pracy z rysunkiem na karcie Układ, składa się on z 

jednego widoku modelu z przestrzeni papieru. Można również utworzyć wiele rzutni 

układu, które wyświetlają unikalne widoki modelu. Każda rzutnia układu 

funkcjonuje jako okno rysunku przestrzeni modelu - każde okno wygląda inaczej niż 

kolejne. Można dostosować centrum widoku, skalę, widoczność warstw i zawartość 

każdej rzutni układu. Każda rzutnia układu jest tworzona jako oddzielna jednostka, 

którą można przenosić, kopiować lub usuwać. 
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Kliknij dowolną rzutnię układu, aby uczynić ją bieżącą rzutnią, a następnie dodaj lub 

zmodyfikuj jednostki przestrzeni modelu w tej rzutni, nawet podczas przyciągania 

do jednostek przestrzeni modelu z przestrzeni papieru. Wszelkie zmiany 

wprowadzone w jednej rzutni układu są natychmiast widoczne w innych rzutniach 

(jeśli inne rzutnie układu wyświetlają tę część rysunku). Powiększanie lub 

przesuwanie w bieżącej rzutni ma wpływ tylko na tę rzutnię. 

Niniejsza sekcja skupia się na pracy z rzutniami układu w przestrzeni papieru na 

karcie Układ. Dodatkowe informacje na temat rzutni w przestrzeni modelu można 

znaleźć w sekcji "Dzielenie bieżącego okna na wiele okien" na stronie 207. 

 

Tworzenie rzutni układu 

Po pierwszym przełączeniu na kartę Układ model jest wyświetlany w domyślnej 

rzutni układu. Można utworzyć inne rzutnie układu w dowolnym miejscu obszaru 

rysowania. Można kontrolować liczbę utworzonych rzutni i ich rozmieszczenie. 
 

Aby utworzyć rzutnie układu 

1 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie układu (  ): 

• Na wstążce wybierz polecenie Widok > Rzutnie układu (w obszarze Układy). 

• W menu wybierz Widok > Rzutnie > Rzutnie układu. 

• Na pasku narzędzi rzutnie kliknij narzędzie Rzutnie układu. 

• Wpisz mview i naciśnij Enter. 

2 Określ dwa przeciwległe narożniki, aby utworzyć niestandardową prostokątną 

rzutnię, lub w oknie zachęty wybierz jedną z poniższych opcji: 

• Dopasuj do widoku - tworzy rzutnię układu, która wypełnia ekran. 

• Jednostka - konwertuje zamkniętą jednostkę na rzutnię układu. Można 

konwertować okrąg, elipsę, zamkniętą polilinię, splajn lub region. 

• Polygonal - tworzy nieprostokątną rzutnię układu. 

• Utwórz 2 rzutnie, Utwórz 3 rzutnie, Utwórz 4 rzutnie - tworzy dwie, trzy lub 

cztery rzutnie układu w określonej orientacji. Można wybrać, czy rzutnie 

mają być rozmieszczone w taki sposób, aby wypełniały bieżący obszar 

graficzny lub określony obszar prostokątny. 
 

Obramowanie nowej rzutni układu jest tworzone na bieżącej warstwie. 

Obramowania rzutni układu można uczynić niewidocznymi, tworząc nową warstwę 

przed utworzeniem rzutni układu, a następnie wyłączając tę warstwę po utworzeniu rzutni układu. 

Aby wybrać granice rzutni układu, należy ponownie włączyć tę warstwę przed 

zmianą układu lub modyfikacją rzutni układu. 
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 DEF 

 

 GHI 

Można utworzyć pojedynczą rzutnię układu lub podzielić obszar graficzny na dwie rzutnie ułożone 
pionowo (A) lub poziomo (B); trzy rzutnie ułożone w lewo (C), w prawo (D), powyżej (E), poniżej (F), 
pionowo (G) lub poziomo (H); lub cztery rzutnie (I). 

 

Wyświetlanie i skalowanie rzutni układu 
Jeśli utworzono wiele rzutni układu, może to mieć wpływ na wydajność systemu. W 

razie potrzeby można włączyć lub wyłączyć rzutnię układu. Wyłączenie rzutni 

układu nie powoduje usunięcia rzutni ani jej zawartości, a jedynie wyłączenie jej 

wyświetlania. 

Można również zmienić sposób wyświetlania elementów w rzutni układu, określając 

współczynnik skali, który zmienia sposób wyświetlania dużych lub małych jednostek 

przestrzeni modelu w rzutni układu. 

Podczas pracy w rzutni układu można użyć polecenia Maksymalizuj rzutnię, aby 

powiększyć widok do pełnego rozmiaru i emulować przestrzeń modelu, 

umożliwiając łatwą pracę nad geometrią w tym widoku. Po zakończeniu pracy 

można użyć polecenia Minimalizuj rzutnię, aby powrócić do oryginalnej skali i 

punktu środkowego rzutni układu. 
 

Aby włączyć lub wyłączyć rzutnie układu 

1 Kliknij żądaną kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać rzutnie układu (  ): 

• Na wstążce wybierz polecenie Widok > Rzutnie układu (w obszarze Układy). 

• W menu wybierz Widok > Rzutnie > Rzutnie układu. 

• Na pasku narzędzi rzutnie kliknij narzędzie Rzutnie układu. 

• Wpisz mview i naciśnij Enter. 

3 Wybierz Włączone lub Wyłączone. 
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4 Wybierz krawędź rzutni układu, którą chcesz włączyć lub wyłączyć, a następnie naciśnij 

klawisz Enter. 
 

Aby zmaksymalizować rzutnię układu 

1 Na karcie Układ wybierz rzutnię układu. Możesz też pominąć ten krok, aby 

zmaksymalizować bieżącą rzutnię układu. 

2 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Maksymalizuj rzutnię (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie > Maksymalizuj rzutnię. 

• Na pasku stanu kliknij przycisk Maksymalizuj rzutnię (  ). 

• Wpisz vpmax, a następnie 

naciśnij klawisz Enter. Rzutnia 

układu zostanie powiększona. 

Aby zminimalizować rzutnię układu (jeśli jest zmaksymalizowana) 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Widok > Minimalizuj rzutnię (w rzutniach modelu). 

• W menu wybierz Widok > Rzutnie > Zminimalizuj rzutnię. 

• Na pasku stanu kliknij przycisk Minimalizuj rzutnię (  ). 

• Wpisz vpmin i naciśnij Enter. 

Rzutnia układu powraca do pierwotnej skali i punktu środkowego. 
 

Aby zmienić skalę rzutni układu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz Widok > Właściwości (na ekranie). 

• W menu wybierz Modyfikuj > Właściwości. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Właściwości. 

• Wpisz entprop i naciśnij Enter. 

2 Wybierz krawędź layoutviewport. 

3 W polu Skala niestandardowa wprowadź skalę, w jakiej mają być wyświetlane 

jednostki przestrzeni modelu w rzutni układu. 

4 Kliknij przycisk OK. 
 

Aby zgłosić skalę rzutni układu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Skalę rzutni listy (  ): 

• Na wstążce wybierz kolejno Express Tools > Skala rzutni listy (w układzie). 

• W menu wybierz kolejno Express Tools > Layout > List Viewport Scale. 

• Wpisz vpscale i naciśnij Enter. 

2 Wybierz krawędź rzutni układu, a następnie naciśnij klawisz Enter. 

Skala rzutni (przestrzeń papieru do przestrzeni modelu) jest wyświetlana na pasku poleceń. 
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Aby zmienić skalę jednostek przestrzeni modelu względem przestrzeni papieru 

1 Kliknij kartę Model. 

2 Kliknij rzutnię, aby ją zaktualizować. 

3 Wybierz kolejno opcje Widok > Powiększenie > Zoom. 

4 Wpisz współczynnik skali powiększenia względem miejsca na papierze, 

dodając przyrostek xp do współczynnika skali, a następnie naciśnij klawisz 

Enter. 

Na przykład, aby zwiększyć skalę jednostek w rzutni na karcie Model do 

dwukrotności rozmiaru jednostek przestrzeni papieru, wpisz 2xp. Aby zmniejszyć 

skalę do połowy rozmiaru jednostek przestrzeni papieru, wpisz .5xp. 

Aby zsynchronizować rzutnie układu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Synchronizuj rzutnie (  ): 

• Na wstążce wybierz kolejno Express Tools > Synchronize Viewports (w Layout). 

• W menu wybierz kolejno Express Tools > Layout > Synchronize Viewports. 

• Wpisz vpsync i naciśnij Enter. 

2 Wybierz rzutnię układu głównego, która ma żądany współczynnik powiększenia. 

3 Wybierz jedną lub więcej rzutni do wyrównania z rzutnią główną, a następnie naciśnij 

klawisz Enter. 
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Modyfikowanie rzutni układu 

Po utworzeniu rzutni układu można je modyfikować zgodnie z potrzebami. Na 

karcie Układ można przyciągać do granic rzutni za pomocą przyciągania 

jednostek. Rzutnie układu można kopiować, usuwać, przenosić, skalować i 

rozciągać, tak jak każdą inną jednostkę rysunkową. 

Dodatkowo można zablokować rzutnię układu, aby skala i środek widoku nie 

zmieniały się w przestrzeni modelu podczas przesuwania lub powiększania w rzutni 

układu. Jeśli pracujesz nad jednostkami przestrzeni modelu z karty Układ, 

zablokowanie rzutni układu zapobiega ciągłej zmianie skali i środka widoku rzutni 

układu. 

Przypisanie układu UCS do każdej rzutni umożliwia szybkie przełączanie się 

między rzutniami układu i natychmiastowe rysowanie w innym układzie UCS. Może 

to znacznie zwiększyć produktywność, zwłaszcza podczas tworzenia złożonych 

modeli 3D. 

Modyfikacja rzutni układu na karcie Układ nie ma wpływu na jednostki przestrzeni 

modelu w rzutni układu. 
 

Aby zmodyfikować właściwości rzutni układu 

1 Kliknij żądaną kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz Widok > Właściwości (na ekranie). 

• W menu wybierz Modyfikuj > Właściwości. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Właściwości. 

• Wpisz entprop i naciśnij Enter. 

3 Wybierz krawędź rzutni układu, którą chcesz zmodyfikować. 

4 Dostosowanie punktu środkowego, szerokości lub wysokości rzutni. 

5 W polu Skala niestandardowa wprowadź skalę, w jakiej mają być wyświetlane 

jednostki przestrzeni modelu w rzutni układu. 

6 Wybierz True, aby zablokować skalę rzutni i widok w przestrzeni modelu 

podczas przesuwania lub powiększania w rzutni układu. 

7 Zaznacz UCS per Viewport, jeśli chcesz użyć unikalnego UCS dla każdego 

widoku układu. 

8 Kliknij przycisk OK. 
 

Do modyfikacji można wybrać tylko rzutnie układu. 

Kliknięcie rzutni na karcie Model spowoduje, że będzie ona aktywna i niedostępna 

do modyfikacji. 
 

 
Przycinanie rzutni układu 
Rzutnie układu można przycinać, aby na karcie Układ widoczna była tylko część 

rzutni. Rzutnie układu można przycinać w kształcie nowego wielokąta lub istniejącego 

okręgu, elipsy, zamkniętego splajnu, zamkniętej polilinii lub regionu. 
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W przypadku usunięcia przycinania z rzutni układu, przycinanie jest usuwane na 

stałe, ale sama rzutnia i jej zawartość pozostają na rysunku. 
 

Aby przyciąć rzutnię układu do kształtu istniejącej jednostki 

1 Kliknij kartę Układ i wybierz żądaną rzutnię układu. 

2 Wpisz vpclip i naciśnij Enter. 

3 Na rysunku wybierz istniejący okrąg, elipsę, zamknięty splajn, zamkniętą 

polilinię lub region, który ma zostać użyty jako granica przycinania. 
 

Aby przyciąć rzutnię układu do kształtu nowego wielokąta 

1 Kliknij kartę Układ i wybierz żądaną rzutnię układu. 

2 Wpisz vpclip i naciśnij Enter. 

3 Naciśnij Enter, aby utworzyć nową granicę przycinania. 

4 Zdefiniuj pierwszy punkt wielokąta przycinającego. 

5 Zdefiniuj dodatkowe punkty. 

6 Po zakończeniu naciśnij Enter. 
 

Aby usunąć granicę przycinania 

1 Kliknij kartę Układ i wybierz żądaną rzutnię układu. 

2 Wpisz vpclip i naciśnij Enter. 

3 Wybierz opcję Usuń, a następnie naciśnij klawisz Enter. 

 

 
 

Dostosowywanie i ponowne wykorzystywanie ustawień drukowania 
 

Większość rysunków wymaga dostosowania ustawień drukowania w celu 

wydrukowania ich w pożądany sposób. Ustawienia drukowania można 

dostosowywać przy każdym drukowaniu, ale można także utworzyć konfiguracje stron, 

które zapisują ustawienia drukowania i przypisują je do różnych układów rysunku. 

Jeśli masz kilka perspektyw rysunku, które wymagają drukowania, użycie ustawień 

strony jest najbardziej wydajnym sposobem drukowania. 

 

Praca z konfiguracjami stron 

Konfiguracje stron przechowują informacje o drukarce dla określonych modeli lub 

układów, co eliminuje potrzebę całkowitej rekonfiguracji ustawień drukowania za 

każdym razem, gdy drukujesz rysunek i pomaga zapewnić, że każda perspektywa 

rysunku zostanie wydrukowana zgodnie z planem. 

 

Przypisywanie konfiguracji strony do modelu lub układu 
Ponieważ główny model na karcie Model i różne układy do drukowania na kartach 

Układ mogą wymagać unikatowych ustawień drukowania, modelowi i każdemu 

układowi można przypisać osobne ustawienia strony. Jeśli niektóre układy 

korzystają z tych samych ustawień drukowania, układom tym można przypisać te 

same ustawienia strony. 
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Przypisanie konfiguracji strony do modelu lub układu nie oznacza, że będzie on 

zawsze drukowany z określonymi ustawieniami. Wszystkie ustawienia drukowania 

określone dla konfiguracji strony można zastąpić podczas drukowania. 
 

Aby przypisać ustawienia strony do modelu lub układu 

1 Kliknij kartę Model lub Układ, do której chcesz przypisać ustawienia strony. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony. 

4 Kliknij przycisk Ustaw bieżący. 

5 Kliknij przycisk OK. 

 

Ustawienia strony można również wybrać podczas drukowania. 

W oknie dialogowym Drukuj, przed kliknięciem przycisku Drukuj wybierz inną 

konfigurację strony z listy Ustawienia strony. 
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A Wyświetla nazwę modelu lub układu, do 
którego przypisana jest bieżąca konfiguracja 
strony. 

B Wyświetla listę wszystkich ustawień strony 
modelu lub strony układu, w zależności od 
tego, czy przed otwarciem okna 
dialogowego wyświetlana była karta Model czy Układ. 

C Wyświetla szczegóły dotyczące aktualnie wybranej 
konfiguracji strony. 

 

Tworzenie konfiguracji strony 
Istnieją dwa rodzaje konfiguracji 

stron: 

D Kliknij, aby usunąć aktualnie wybraną konfigurację strony. 

E Kliknij, aby zmodyfikować ustawienia dla 
aktualnie wybranej konfiguracji strony. 

F Kliknij, aby utworzyć nową konfigurację strony. 

G Kliknij, aby przypisać aktualnie wybraną 
konfigurację strony do bieżącego układu. 

 

• Ustawienia strony modelu - zawiera ustawienia drukowania dostępne dla modelu 

na karcie Model. 

• Ustawienia strony układu - zawiera ustawienia drukowania dostępne dla jednego 

lub kilku układów na kartach Układ. 

ALCAD posiada dwie domyślne konfiguracje stron - jedną konfigurację strony 

modelu i jedną konfigurację strony układu. Możesz utworzyć dowolną liczbę 

dodatkowych ustawień strony, dowolnego typu, zgodnie z wymaganiami dla 

dowolnego rysunku. Każda konfiguracja strony określa wiele aspektów drukowania, 

w tym rozmiar strony, domyślną drukarkę lub ploter, orientację strony, skalę wydruku 

i inne. 
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Aby utworzyć konfigurację strony 

1 Aby utworzyć konfigurację strony modelu, kliknij kartę Model. Aby utworzyć 

konfigurację strony układu, kliknij dowolną kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Kliknij przycisk Dodaj. 
 

Nową konfigurację strony można utworzyć na podstawie ustawień drukowania 

istniejącej konfiguracji strony. Wybierz istniejącą konfigurację strony na liście, a 

następnie kliknij przycisk Dodaj. Nowa konfiguracja strony wykorzystuje 

ustawienia drukowania istniejącej konfiguracji strony jako punkt początkowy. 
 

 

4 Wprowadź nazwę konfiguracji strony, a następnie kliknij przycisk OK. 

5 Wybierz żądane opcje drukowania. 

6 Kliknij przycisk OK. 
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A Wyświetla "Layout" w przypadku tworzenia 

konfiguracji strony układu lub "Model" w 
przypadku tworzenia konfiguracji strony 
modelu. 

B Wprowadź wszelkie zmiany w nazwie 
konfiguracji strony. 

C Kliknij, aby określić opcje dla wybranej drukarki 
lub 
.pc3. 

D Wybierz drukarkę i wyświetl jej szczegóły. 

E Wybierz rozmiar papieru obsługiwany 
przez wybraną drukarkę. 

F Wybierz predefiniowaną skalę wydruku lub 
wybierz opcję Niestandardowa, aby określić 
własną. 

G Wybierz, aby dopasować określony obszar 
drukowania do bieżącego rozmiaru papieru. 

H Określ niestandardową skalę obszaru 
drukowania, wpisując stosunek jednostek 
drukowania do cali lub milimetrów. 

I Kliknij, aby określić jednostki rysowania i 
rozmiar papieru w milimetrach lub calach. 

J Wybierz, aby wyśrodkować obszar drukowania 
na drukowanej stronie. 

K Wpisz współrzędne x i y, aby określić 
początek obszaru drukowania. 

L Kliknij, aby wybrać obszar rysunku, który chcesz 
wydrukować. 

 
M Wpisz współrzędne x i y dwóch przeciwległych 

narożników prostokątnego obszaru wydruku lub 
kliknij Wybierz obszar wydruku, aby określić 
współrzędne w oknie rysunku. (Dostępne 
tylko wtedy, gdy dla opcji Co drukować 
wybrano opcję Okno). 

N Wybierz, aby wydrukować rysunek do góry 
nogami na drukarce. 

O Wybierz orientację pionową lub poziomą. 

P Wybór sposobu drukowania grubości linii i stylów drukowania. 

Q Wybierz, aby zapobiec drukowaniu jednostek przestrzeni 
papieru. 

R Wybierz, aby drukować jednostki przestrzeni 
papieru po wydrukowaniu jednostek 
przestrzeni modelu. 

S Wybierz opcję wyświetlania stylów wydruku podczas 
przeglądania układu. 

T Wybierz, aby drukować jednostki z 
przypisanymi im obrysami. W przypadku 
wyłączenia drukowania z obrysem, jednostki 
będą drukowane z domyślnym obrysem. 

U Wybór opcji dla cieniowanych rzutni. Jakość i DPI 
nie są obecnie zaimplementowane. 

V Wybierz tabelę stylów wydruku do zastosowania 
podczas drukowania lub wybierz opcję Brak. 
Kliknij przycisk [...], aby zmodyfikować wybraną 
tabelę stylów wydruku. 
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Modyfikowanie istniejącej konfiguracji strony 

Można zmienić dowolne ustawienia drukowania powiązane z konfiguracją strony, 

co eliminuje konieczność zastępowania ustawień, gdy nadejdzie czas drukowania 

modelu lub każdego układu przypisanego do konfiguracji strony. 

W przypadku zmiany ustawień konfiguracji drukowania układu wszystkie układy 

przypisane do tej konfiguracji drukowania będą drukowane przy użyciu nowych 

ustawień. 
 

Aby zmodyfikować istniejącą konfigurację strony 

1 Aby zmodyfikować ustawienia strony modelu, kliknij kartę Model. Aby 

zmodyfikować ustawienia strony układu, kliknij dowolną kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz konfigurację strony, którą chcesz zmienić. 

4 Kliknij przycisk Modyfikuj. 

5 Wybierz żądane opcje drukowania. 

6 Kliknij przycisk OK. 

 
Usuwanie konfiguracji strony 

Usunięcie ustawień strony przypisanych do modelu lub układu spowoduje, że do 

tego modelu lub układu nie będą już przypisywane ustawienia strony. 
 

Aby usunąć konfigurację strony 

1 Aby usunąć konfigurację strony modelu, kliknij kartę Model. Aby usunąć 

konfigurację strony układu, kliknij dowolną kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz konfigurację strony, którą chcesz usunąć. 

4 Kliknij przycisk Usuń. 

5 Kliknij przycisk Tak, aby potwierdzić usunięcie. 
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Ustawianie rozmiaru i orientacji papieru 

Dla wszystkich rysunków można określić rozmiar i orientację papieru. Orientację 

można również dostosować, drukując rysunek na papierze do góry nogami. W 

każdym układzie rysunku można określić, czy ma on być drukowany do góry 

nogami. 
 

Aby wybrać rozmiar i orientację papieru 

1 Kliknij kartę Układ lub Model, dla której chcesz ustawić rozmiar i orientację 

papieru. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W polu Rozmiar papieru wybierz rozmiar papieru obsługiwany przez aktualnie wybraną 

drukarkę. 

5 W opcji Orientacja wybierz następujące ustawienia: 

• Portrait (Pionowo) lub Landscape (Poziomo) - wybierz opcję Portrait 

(Pionowo) dla pionowej orientacji papieru lub opcję Landscape 

(Poziomo) dla poziomej orientacji papieru. 

• Drukuj do góry nogami - Wybierz, aby wydrukować rysunek do góry nogami na 

drukarce. 

6 Kliknij przycisk OK. 

7 Kliknij przycisk OK. 
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Wybór drukarki lub plotera 

Można określić drukarkę lub ploter, który będzie używany podczas drukowania 

dowolnego rysunku. Rysunek można wydrukować na dowolnej drukarce lub 

ploterze zgodnym z systemem Windows, w tym na drukarkach rastrowych. 

Zamiast fizycznej drukarki można wybrać drukowanie bezpośrednio do pliku, w tym 

.pdf, dwf, .png i .jpg. Drukowanie do pliku to nie to samo, co eksportowanie. Aby 

wyeksportować rysunek do jednego z różnych dostępnych formatów plików, patrz 

"Eksportowanie rysunków" na stronie 665. 
 

Aby wybrać drukarkę lub ploter 

1 Kliknij kartę Układ lub Model, dla której chcesz wybrać drukarkę. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 Z listy Nazwa drukarki wybierz drukarkę lub ploter. 

5 W razie potrzeby kliknij przycisk Właściwości, aby wybrać opcje dla aktualnie wybranej 

drukarki. 

6 Kliknij przycisk OK. 

7 Kliknij przycisk OK. 
 

Drukarka lub ploter wybrany dla konfiguracji strony jest również używany podczas 

publikowania list arkuszy. Szczegółowe informacje znajdują się w sekcji 

"Publikowanie listy arkuszy na drukarce wskazanej w konfiguracji strony" na stronie 

565 w tym rozdziale. 

 

Ustawianie skali i widoku 

Można wydrukować lub wykreślić cały rysunek lub wybraną część rysunku. Można 

wydrukować to, co jest widoczne na ekranie, lub określić drukowanie obszaru 

rysunku. 

Położenie rysunku na papierze można kontrolować, określając początek obszaru 

drukowania, czyli położenie lewego dolnego rogu obszaru drukowania w stosunku 

do lewego dolnego rogu papieru. Początek jest zwykle ustawiony na 0,0, co umieszcza lewy dolny róg 

obszaru drukowania tak blisko lewego dolnego rogu papieru, jak pozwala na to 

drukarka lub ploter. Można jednak określić inny punkt początkowy, podając inne 

współrzędne. 

Kiedy tworzysz rysunek, zazwyczaj rysujesz jednostki w pełnym rozmiarze. Podczas 

drukowania rysunku można określić skalę wynikowego wydruku lub pozwolić programowi 

dostosować rozmiar rysunku do papieru. Aby wydrukować rysunek w określonej 

skali, należy określić skalę jako stosunek jednostek rysunkowych do jednostek 

drukowanych. 
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W przypadku drukowania z karty Układ, skala i opcje widoku mogą być różne dla 

każdego utworzonego układu. 
 

Aby automatycznie skalować rysunek do drukowania 

1 Kliknij kartę Układ lub Model, dla której chcesz ustawić automatyczne 

skalowanie. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W obszarze Skala wydruku wybierz opcję Dopasuj do papieru, aby przeskalować rysunek 

tak, by zmieścił się na jednej wydrukowanej stronie. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 
 

Aby samodzielnie określić współczynnik skali 

1 Kliknij kartę Układ lub Model, dla której chcesz określić współczynnik skali. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W Print Scale wykonaj jedną z następujących czynności: 

• Wybierz wstępnie zdefiniowaną skalę z listy Skala. Na przykład wybierz 1:2, 

jeśli chcesz, aby 1 wydrukowana jednostka (cal lub milimetr) odpowiadała 2 

jednostkom rysunkowym. Lista dostępnych skal jest konfigurowana za pomocą 

polecenia Lista skal. Więcej informacji można znaleźć w sekcji 

"Dostosowywanie listy skal" na stronie 57. 

• Wpisz stosunek drukowanych jednostek miary (cali lub milimetrów) do 

jednostek rysunkowych. 

5 Aby określić drukowane jednostki miary, wybierz cale lub milimetry. 

6 Kliknij przycisk OK. 

7 Kliknij przycisk OK. 
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Aby określić część rysunku do wydrukowania 

1 Kliknij kartę Układ lub Model, dla której chcesz określić obszar do wydrukowania. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W sekcji Co wydrukować kliknij jedną z poniższych opcji: 

• Wyświetl - drukuje widok na ekranie. 

• Extents - drukuje obszar zawierający elementy na rysunku. 

• Limity - drukuje do limitów zdefiniowanych dla rysunku.  (Dostępne tylko 

dla ustawień strony modelu). 

• Układ - drukuje do krawędzi układu. (Dostępne tylko w przypadku 

konfiguracji strony układu). 

• Widok - drukuje wybrany zapisany widok. (Dostępne dla rysunków z 

zapisanymi widokami). 

• Okno - drukuje część rysunku zawartą w określonym oknie, zachowując 

proporcje obszaru okna do rysunku. 

Jeśli kliknięto opcję Okno, należy określić okno. W obszarze Windowed Print 

Area wprowadź współrzędne x i y okna lub wybierz obszar na ekranie. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 
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Aby określić początek obszaru drukowania 

1 Kliknij kartę Układ lub Model, dla której chcesz ustawić rozmiar papieru i or- 

ganizację. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W obszarze Print Offset wykonaj jedną z poniższych czynności: 

• Aby wyśrodkować określony obszar drukowania na wydrukowanej stronie, wybierz opcję 

Center on Page. 

• Aby określić początek obszaru drukowania, wpisz współrzędne x i y. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 

 
Określanie opcji drukowania specjalnie dla układów 

Każdy układ w rysunku może określać pewne ustawienia drukowania, które mają 

zastosowanie tylko do układów: skalowanie grubości linii, wyświetlanie stylu 

drukowania i opcje drukowania obszaru papieru. 
 

Aby ustawić opcje drukowania tylko dla układów 

1 Kliknij kartę Układ. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W obszarze Opcje karty Układ wybierz żądane ustawienia drukowania: 

• Scale lineweights (Skaluj linie pomocnicze) - opcja umożliwiająca 

drukowanie linii pomocniczych proporcjonalnie do określonych ustawień 

skali wydruku; jeśli opcja ta nie zostanie wybrana, linie pomocnicze będą 

drukowane w przypisanym im rozmiarze. Należy pamiętać, że style 

wydruku mogą również wpływać na sposób drukowania znaczników linii. 

• Wyświetl style wydruku - Wybierz, aby wyświetlać style wydruku podczas przeglądania 

układu. 
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• Drukuj przestrzeń papierową jako ostatnią - Wybierz, aby drukować jednostki 

przestrzeni papierowej po wydrukowaniu jednostek przestrzeni modelu. 

Domyślnie jednostki przestrzeni papieru są drukowane jako pierwsze. 

• Ukryj jednostki przestrzeni papieru - Wybierz, aby uniemożliwić drukowanie jednostek 

przestrzeni papieru. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 

 
Określanie opcji drukowania cieniowanej rzutni 

Każde ustawienie strony modelu może określać sposób drukowania cieniowanych 

rzutni: jako wyświetlane, druciane, ukryte lub renderowane. Jakość i DPI nie są obecnie 

zaimplementowane. 
 

Aby ustawić opcje drukowania dla cieniowanych rzutni 

1 Kliknij kartę Layout lub Model, dla której chcesz ustawić ustawienia 

cieniowanej rzutni. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W obszarze Opcje cieniowanej rzutni wybierz żądane ustawienia: 

• Cieniowanie - wybór sposobu drukowania cieniowanych rzutni. 

• Jakość - wybór rozdzielczości używanej dla drukowanej rzutni. (Obecnie nie 

zaimplementowane). 

• DPI - Wprowadź niestandardową liczbę punktów na cal, która będzie 

używana do drukowania cieniowania rzutni. Dostępne tylko wtedy, gdy opcja 

Jakość jest ustawiona na Niestandardowa. (Obecnie nie zaimplementowane). 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 

 
Określanie opcji drukowania piórem i linii 

Każdy układ w rysunku może określać pewne ustawienia drukowania, które mają 

zastosowanie tylko do układów: skalowanie grubości linii, wyświetlanie stylu 

drukowania i opcje drukowania obszaru papieru. 
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Aby ustawić opcje drukowania piórem i linii 

1 Kliknij kartę Układ lub Model, dla której chcesz ustawić opcje drukowania 

piórem i linią. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 Wybierz żądane ustawienia: 

• Tabela stylów wydruku - wybierz tabelę stylów wydruku, która ma być 

stosowana podczas drukowania, lub wybierz opcję Brak. Po wybraniu tabeli 

stylów wydruku można kliknąć przycisk [...], aby zmodyfikować jej 

ustawienia. 

• Print with entity lineweights - Wybierz, aby drukować encje z 

przypisanymi im obrysami. W przypadku wyłączenia drukowania z 

obrysem, jednostki będą drukowane z domyślnym obrysem. Ta opcja jest 

dostępna, jeśli opcja Drukuj ze stylami wydruku jest wyłączona. 

• Drukuj ze stylami drukowania - Wybierz, aby drukować zgodnie z 

ustawieniami stylu drukowania w aktualnie wybranej tabeli stylów 

drukowania. Odstępy między wierszami jednostki są ignorowane. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 

 
Korzystanie z plików konfiguracyjnych drukarki 

Pliki konfiguracji drukarki przechowują informacje o drukarce używane dla 

określonych rysunków lub układów, co eliminuje potrzebę całkowitego ponownego 

konfigurowania ustawień drukowania za każdym razem, gdy drukujesz rysunek. 

Pliki konfiguracji drukarki umożliwiają również udostępnianie i ponowne 

wykorzystywanie ustawień drukowania między różnymi rysunkami i układami. 

ALCAD obsługuje pliki konfiguracyjne drukarek (pliki PCP i PC3) używane przez 

Auto- CAD. Ta funkcja umożliwia korzystanie z istniejących plików PCP 

zapisanych w programie AutoCAD, a także zapisywanie ustawień konfiguracji 

drukowania ALCAD w formacie PC3. 

Plik AutoCAD PC2 można przekonwertować do formatu PCP za pomocą funkcji 

wyboru urządzenia i ustawień domyślnych w oknie dialogowym AutoCAD Print. 
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Wybór pliku konfiguracji drukarki do drukowania 

Można określić, że plik konfiguracji drukarki będzie używany podczas drukowania dowolnego 

rysunku. 
 

Aby wybrać plik konfiguracji drukarki do drukowania 

1 Kliknij kartę Układ lub Model, dla której chcesz wybrać drukarkę. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj lub wybierz kolejno Wyjście > Drukuj (w oknie Drukuj). 

• Wybierz Plik > Drukuj. 

• Na pasku narzędzi Standardowy kliknij narzędzie Drukuj. 

• Wpisz print i naciśnij Enter. 

3 Z listy Nazwa drukarki wybierz plik .pc3 lub .pcp. 

4 Kliknij przycisk OK. 

5 Kliknij OK, aby wydrukować. 
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Modyfikowanie i zapisywanie ustawień drukarki w pliku .pc3 

Aby zmodyfikować i zapisać ustawienia drukarki w pliku .pc3 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj lub wybierz kolejno Wyjście > Drukuj (w oknie Drukuj). 

• Wybierz Plik > Drukuj. 

• Na pasku narzędzi Standardowy kliknij narzędzie Drukuj. 

• Wpisz print i naciśnij Enter. 

2 Z listy Nazwa drukarki wybierz plik .pc3. 

3 Kliknij przycisk Właściwości. 

4 W oknie dialogowym Edytor konfiguracji drukarki kliknij kartę Ustawienia. 

5 Rozwiń Media na liście, aby wyświetlić i wybrać domyślny rozmiar papieru dla 

drukarki. Wybierz Source and Size, a następnie w Media Source and Size 

wybierz nowy domyślny rozmiar papieru dla drukarki. 

6 Rozwiń Grafika na liście i wybierz jedną z poniższych opcji: 

• Grafika wektorowa - wyświetla ustawienia drukowania grafiki wektorowej. 

W polu Color Depth (Głębia koloru) wybierz, czy chcesz drukować w 

kolorze czy monochromatycznie, a następnie wybierz głębię bitową koloru 

lub skali szarości. 

• Grafika rastrowa - wyświetla ustawienia drukowania grafiki rastrowej. Gdy 

zasoby drukarki są ograniczone, można przesunąć suwaki, aby zrównoważyć 

szybkość drukowania i jakość obrazu dla obrazów rastrowych, obiektów OLE 

i ogólnych kompromisów. 

• TrueType Text - Wybierz, czy tekst TrueType ma być drukowany jako tekst czy grafika. 

• Kontrola scalania - Aby zachować kolory linii, które się nakładają, wybierz 

opcję Nadpisz linie. Widoczny jest kolor linii, która została ostatnio dodana 

do rysunku. Aby scalić kolory, wybierz opcję Scal linie. 

7 Wybierz opcję Właściwości niestandardowe z listy, aby określić dodatkowe 

ustawienia drukowania, które różnią się w zależności od wybranej drukarki: 

• Standardowe drukarki i sterowniki - Zostanie otwarte standardowe 

okno dialogowe drukarki. 

• Pliki DWF .pc3 - Zostanie otwarte okno dialogowe Właściwości 

niestandardowe. Kliknij [?], aby uzyskać więcej informacji na temat każdej 

dostępnej opcji. 

• Pliki PDF .pc3 - Zostanie otwarte okno dialogowe Właściwości 

niestandardowe. Kliknij [?], aby uzyskać więcej informacji na temat każdej 

dostępnej opcji. 

• Pliki JPG i PNG .pc3 - We Właściwościach niestandardowych wybierz kolor 

tła i zaznacz, czy obrócić rastrowe linie skanowania o 90 stopni. 
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8 Wybierz opcję Rozmiary papieru zdefiniowane przez użytkownika, a następnie 

kliknij przycisk Modyfikuj rozmiary papieru, aby zmodyfikować marginesy dla 

każdego rozmiaru papieru, dołączyć i odłączyć pliki .pmp oraz zapisać 

modyfikacje w pliku .pmp. Kliknij przycisk [?], aby uzyskać więcej informacji 

na temat każdej dostępnej opcji. 

9 Kliknij przycisk Zapisz jako. 

10 Wprowadź nazwę i lokalizację pliku .pc3. 

11 Kliknij przycisk Zapisz. 

12 Kliknij przycisk OK. 

13 Kliknij OK, aby wydrukować, lub anuluj. 

 

Pliki konfiguracyjne drukarki można również modyfikować i zapisywać za pomocą 

polecenia Options. Wybierz Opcje, kliknij kartę Drukowanie, kliknij Dodaj lub 

Konfiguracja drukarek, a następnie dokonaj wyboru. 
 

 
Aby dodać ustawienia drukarki w pliku .pc3 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje: 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Drukowanie. 

3 Kliknij Dodaj lub Konfiguruj drukarki. 

4 Aby dodać plik PC3, kliknij przycisk Add w celu utworzenia nowego pliku PC3. 

W otwartym oknie dialogowym Add Printer Configu- ration File wybierz żądaną 

drukarkę dla nowego pliku PC3, kliknij przycisk Continue (Kontynuuj) i wybierz 

żądane opcje dla pliku PC3. Jeśli nie zostaną wybrane żadne opcje 

niestandardowe, plik PC3 nie zostanie utworzony. 

5 Aby zmodyfikować lub usunąć plik PC3, wybierz żądany plik z listy i kliknij 

przycisk Modyfikuj lub Usuń. 

6 Kliknij przycisk OK. 

 
Korzystanie ze sterowników plotera 

Aby wydrukować rysunek, program wysyła dane wyjściowe do dowolnego 

sterownika drukarki w maksymalnie 256 kolorach, ale bez określonej szerokości. 

Początkowo wydruk będzie miał jednolitą cienką szerokość, która jest najcieńszą 

linią, jaką może wytworzyć urządzenie plotera. 

Sterownik przekazuje następnie kolorowe wektory do drukarki, która tworzy 

kolorowe wydruki na drukarkach kolorowych i wydruki w skali szarości na 

drukarkach laserowych. (Kolorowe wydruki, które są konwertowane do skali 

szarości na drukarce laserowej, są zwykle niedopuszczalne przez użytkowników 

CAD do ostatecznego drukowania). 

Za pomocą tabel stylów wydruku można zmapować wszystkie kolory na czarny i 



ustawić wszystkie grubości linii na wybraną szerokość. Należy użyć wartości 

odpowiedniej do możliwości drukowania. Dzięki tym funkcjom można zaspokoić 

większość potrzeb związanych z drukowaniem nieprezentacyjnym. 
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Korzystanie ze stylów drukowania 
 

ALCAD wykorzystuje style wydruku do zmiany wyglądu drukowanego rysunku bez 

modyfikowania rzeczywistych elementów rysunku. Przypisanie stylów wydruku 

pozwala dostosować kolor, szerokość pióra, typ linii i grubość linii, które są 

używane do drukowania rysunku. 

Style wydruku pomagają kontrolować wygląd rysunku po wydrukowaniu. Zamiast 

opisywać, jak jednostka wygląda na ekranie, style wydruku opisują, jak jednostka 

będzie wyglądać po wydrukowaniu. Na przykład, można zmapować wszystkie żółte 

elementy na rysunku, aby były drukowane w kolorze niebieskim bez modyfikowania 

rzeczywistych elementów. Można również zmapować wszystkie żółte elementy, aby 

drukowały się z dowolną określoną grubością linii, typem linii lub szerokością pióra. 

Ponieważ style drukowania są zapisywane w tabelach stylów drukowania, które są 

plikami znajdującymi się na komputerze, dysku lub serwerze, można je ponownie 

wykorzystać, aby wyeliminować potrzebę ponownego konfigurowania ustawień 

drukowania za każdym razem, gdy drukujesz rysunek. Na przykład, możesz mieć 

wielu klientów, którzy mają własne preferencje drukowania. Możesz zapisać style 

drukowania w nazwanym pliku dla każdego z klientów. Możesz nawet udostępnić 

plik współpracownikom lub przechowywać pliki w sieci, aby upewnić się, że wszyscy w 

biurze używają tych samych standardów. 

 

Zrozumienie tabel stylów wydruku 

Tabela stylów wydruku to zbiór stylów wydruku, który umożliwia zmianę wyglądu 

drukowanego rysunku bez modyfikowania rzeczywistych elementów rysunku. 

Każda tabela stylów wydruku jest zapisywana w pliku, który może znajdować się na 

komputerze, dysku lub serwerze. 

Rysunek może jednocześnie korzystać z jednego typu tabeli stylów wydruku. 

Istnieją dwa rodzaje tabel stylów wydruku: 

• Tabele stylów wydruku zależnych od koloru (CTB) zawierają kolekcję stylów 

wydruku opartych na każdym z 255 kolorów indeksu dostępnych na rysunku. 

Prawdziwe kolory i książki kolorów nie mają zastosowania do tabel stylów 

wydruku zależnych od kolorów. 

• Nazwy tabel stylów wydruku (STB) zawierają kolekcję stylów wydruku 

zdefiniowanych przez użytkownika. Mogą się one różnić niezależnie od 

koloru. 

W przypadku tabel stylów wydruku zależnych od koloru nie można przypisywać 

stylów wydruku do poszczególnych jednostek lub warstw. Aby użyć tych stylów 

wydruku, należy przypisać określony kolor do jednostki lub warstwy. Po określeniu 

tabeli stylów wydruku zależnych od kolorów w czasie drukowania, kolory jednostek 

i warstw są mapowane na style wydruku oparte na kolorach w określonej tabeli 

stylów wydruku. 
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Tabele nazwanych stylów wydruku umożliwiają przypisywanie nazwanych stylów 

wydruku do poszczególnych jednostek i warstw. Jednostki i warstwy z przypisanymi 

stylami wydruku są drukowane zgodnie z tabelą stylów wydruku określoną w czasie 

drukowania. W przypadku określenia stylu wydruku dla określonej jednostki, ten styl 

wydruku zastępuje wszelkie style wydruku przypisane do warstwy, na której 

znajduje się jednostka. 

Czasami nazwany styl wydruku przypisany do jednostki lub warstwy nie znajduje 

się w tabeli stylów wydruku przypisanej do layoutu lub rysunku. Może się tak 

zdarzyć, jeśli styl wydruku został usunięty z tabeli nazwanych stylów wydruku lub 

jeśli do rysunku zostanie przypisana inna tabela nazwanych stylów wydruku, która 

nie zawiera nazwanego stylu wydruku. W takim przypadku jednostka jest 

drukowana przy użyciu jej domyślnych właściwości, co jest podobne do przypisania 

normalnego stylu wydruku do jednostki lub warstwy. Jeśli planujesz wymieniać 

nazwane tabele stylów wydruku w ramach tego samego rysunku, dobrym pomysłem jest 

skoordynowanie tabel w celu użycia tych samych nazw stylów wydruku. 

Jeśli nowy rysunek jest oparty na szablonie, nowy rysunek używa tego samego typu 

tabeli stylów wydruku co szablon. Jeśli nowy rysunek jest tworzony bez szablonu, 

typ tabeli stylów wydruku jest określany w Kreatorze nowego rysunku; domyślnie 

nowy rysunek używa typu tabeli stylów wydruku określonego w menu Narzędzia > 

Opcje na karcie Drukowanie. Każdy rysunek jest zaprojektowany do korzystania z 

tabel stylów wydruku, ale to użytkownik decyduje, czy je wdrożyć. 

 
Porównanie typów tabel stylów wydruku 

 
Opis Zawiera wstępnie zdefiniowane 
style drukowania 

według koloru; istnieje jeden styl 
wydruku dla każdego z 255 kolorów 
indeksu dostępnych w rysunku. 
Jednostki o tym samym kolorze są 
drukowane w ten sam sposób. 

Przykład Wszystkie niebieskie elementy są 
drukowane z grubością linii 
wynoszącą 5 milimetrów. 

Zawiera unikatowe style wydruku 
utworzone przez użytkownika. Jednostki o 
tym samym kolorze mogą mieć różne 
ustawienia drukowania. 

 

 
Jedna jednostka drukuje z grubością 
linii .7 milimetra; druga niebieska 
drukuje z grubością linii .5 milimetra. 

 
Liczba 
stylów 

drukowani
a 

 
255 (stałe).  Co najmniej jeden (różne). 

 

Nazwy 
stylów 
wydruku 

 
Dodawanie, 
usuwanie i 
modyfikow
anie stylów 
wydruku 

Nazwy stylów wydruku mieszczą się w 
zakresie od "Color_1" do "Color_255". 
Nie można zmienić stylów wydruku. 

Istniejące style wydruku można 
modyfikować, ale nie można ich 
dodawać ani usuwać. 

Użytkownik definiuje nowe nazwy stylów 
drukowania. Można zmienić nazwy wszystkich 
stylów drukowania z wyjątkiem stylu 
Normal. 

Można dodawać i usuwać style 
drukowania. Można modyfikować 
wszystkie style drukowania z 
wyjątkiem stylu Normal, który 
wykorzystuje domyślne właściwości 
jednostki. 

 
 

 

tabela stylów (CTB) 
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Porównanie typów tabel stylów wydruku 

 
Tworzen
ie 
dodatkow
ych tabel 

Tak . 

 

Przydział Bieżący styl wydruku: Nowym 
podmiotom zawsze przypisywany 
jest BYCOLOR. 

 

Style drukowania: Przypisane kolory w 
tabeli stylów drukowania. 

Bieżący styl wydruku: Przypisany do 
nowych podmiotów. 

 

Style wydruku: Przypisane do jednostek i 
warstw. 

 
 
 
 

Obsługa 
starszych 
plików 

Tabele stylów wydruku: Przypisane do 
karty Układ lub karty Model. 

Istniejące pliki konfiguracji drukarki 
(PCP) można zaimportować do tabeli 
stylów wydruku. Pliki CTB są podobne do 
plików PCP używanych głównie w 
poprzednich wersjach ALCAD. 

Tabele stylów wydruku: Przypisane do 
karty Układ lub karty Model. 

Nie dotyczy. 

 
 

 

Wdrażanie tabel stylów wydruku 

Każdy rysunek jest zaprojektowany do korzystania z tabel stylów wydruku, ale to 

użytkownik decyduje, czy je wdrożyć. Nawet jeśli używasz jednej z domyślnych tabel 

stylów wydruku dostępnych w Intelli- CAD, korzystanie z tabel stylów wydruku 

wymaga wcześniejszego planowania, aby upewnić się, że rysunek zostanie 

wydrukowany zgodnie z planem. 

Na przykład pojedynczy rysunek planu piętra może wymagać wydrukowania następujących 

arkuszy rysunkowych: 

• Główny plan piętra Ściany są drukowane grubymi, czarnymi liniami. 

• Ściany planu elektrycznego są drukowane z normalnymi szarymi liniami, co 

wskazuje, że nie są one w centrum uwagi. 

• Ściany planu HVAC są drukowane z normalnymi szarymi liniami, co 

wskazuje, że nie są one w centrum uwagi. 

• Ściany rzutu dachu są drukowane z cienkimi, szarymi liniami i ukrytym typem 

linii, co wskazuje, że są one ukryte pod dachem w widoku rzutu. 

W tym przykładzie można utworzyć cztery nazwane tabele stylów wydruku, z 

których każda zawiera styl wydruku o nazwie "WallPstyle". Każda tabela stylu 

wydruku zawiera własne ustawienia dla "WallPstyle" w celu kontrolowania sposobu 

drukowania ścian. Przypisz WallPstyle do elementów ściany lub do warstwy ściany. 

Następnie za każdym razem należy przypisać inną tabelę stylu wydruku lub utworzyć 

cztery układy i przypisać inną tabelę stylu wydruku do każdego z nich. 

W poniższej tabeli opisano w kolejności kroki, które należy wykonać, aby 

rozpocząć korzystanie z tabel stylów drukowania zależnych od koloru i nazwanych 

tabel stylów drukowania. 

 

tabela stylów (CTB) 
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Rozpoczęcie korzystania z tabel stylów wydruku 
 

Zależne od 
koloru 

 

Nazwany 
 

Zadanie 
 

Polecenie 
 

Gdzie uzyskać szczegółowe 
informacje 

X X Utwórz nowy rysunek. Wybierz 
szablon rysunku, który używa żądanego 
typu tabeli stylu wydruku lub wybierz go w 
Kreatorze nowego rysunku. 

Plik > Nowy Tworzenie nowego rysunku, strona 
42 

X X (Opcjonalnie) Utwórz nowy styl 
wydruku. 

Plik > Menedżer stylów 
wydruku 

Tworzenie nowych tabel stylów 
wydruku, strona 551 

X 
 

Przypisywanie kolorów do jednostek i 
warstw, które odpowiadają ustawieniom 
tabeli stylów wydruku. 

Modyfikuj > Narzędzia 
właściwości 
>ALCADExplorer 

Ustawianie bieżącego koloru 
encji, strona 47; Modyfikowanie 
właściwości encji, strona 343; 
Ustawianie koloru warstwy, 
strona 256 

 
X Ustawienie bieżącego stylu drukowania 

przypisanego do nowych jednostek. 
Narzędzia > Ustawienia 
rysowania > karta 
Tworzenie podmiotu; 
pasek stanu; styl 
wydruku 

Ustawianie bieżącego stylu 
drukowania, strona 52 

 X Przypisywanie stylów wydruku do 
jednostek. 

Modyfikuj > Właściwości; 
pasek narzędzi Właściwości 
jednostki; printstyle 

Modyfikowanie 
właściwości podmiotów, 
strona 343 

 X UżyjALCAD Explorer, aby przypisać 
style wydruku do warstw. 

Narzędzia 
>ALCADExplorer 

Ustawianie stylu wydruku warstwy, 
strona 260 

X X Przypisanie tabeli stylów wydruku do 
karty modelu, układu lub wszystkich 
układów w rysunku. 

Plik > Drukuj > karta 
Zaawansowane 

Przypisywanie tabel stylów 
wydruku, strona 550 

X X (Opcjonalnie) Wprowadź zmiany w tabeli 
przypisanych stylów drukowania. 

Plik > Menedżer stylów 
wydruku Plik > Drukuj > 
karta Zaawansowane 

Modyfikowanie tabel stylów 
wydruku, strona 552 

X X Wydrukuj rysunek. Plik > Drukuj Drukowanie lub plotowanie 
rysunku, 

    strona 558 
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W poniższej tabeli opisano sposób dalszego dostosowywania działania stylów 

wydruku w rysunkach. 

 
Dalsze dostosowywanie tabel stylów wydruku 

 

Kopiowanie, zmiana nazwy lub 
usuwanie tabel stylów wydruku. 

 

Zmień rysunek na inny typ tabeli 
stylów wydruku, na przykład zmień 
rysunek wykorzystujący tabele 
stylów wydruku zależne od kolorów 
na taki, który wykorzystuje 
nazwane tabele stylów wydruku. 

Konwertuje tabelę stylów wydruku 
zależną od kolorów na nazwaną 
tabelę stylów wydruku. 

File>PrintStylesManager Kopiowanie, zmiana nazwy lub 

Usuwanie stylów 

wydruku, strona 555 

convertpstyles Zmiana typu tabeli 
stylów wydruku 
rysunku, strona 555 

 

 
convertctb Konwersja tabel 

stylów wydruku, 
strona 556 

 

Zmiana domyślnej lokalizacji, w której 
przechowywane są tabele stylów 
wydruku. 

Narzędzia >Opcje 
>Zakładka Ścieżki/Pliki 

Zmiana opcji na karcie 

Ścieżki/Pliki, strona 690 

Dostosuj sposób działania stylów 
wydruku z nowymi rysunkami, które 
tworzysz i starszymi rysunkami, 
które otwierasz. 

Narzędzia > Opcje > Zmiana opcji na karcie 

         karta Drukowanie           karta Drukowanie, strona 
714 

 
 

 

Przypisywanie tabel stylów wydruku 

Jeśli chcesz zmienić wygląd rysunku podczas drukowania, wybierz tabelę stylów 

wydruku przed drukowaniem. Tabele stylów wydruku mogą modyfikować wygląd 

kolorów, szerokości pióra, typów linii i grubości linii podczas drukowania. 

Tabele stylów wydruku można przypisać globalnie do wszystkich układów (w tym 

do karty Model) lub indywidualnie do karty Model lub karty Układ. Przypisanie 

tabeli stylów wydruku do konkretnego układu umożliwia dalsze dostosowanie 

układów używanych do drukowania rysunku. 

Jednak przypisanie różnych nazwanych tabel stylów wydruku do różnych układów 

może skutkować niedopasowaniem nazw stylów wydruku; nazwany styl wydruku 

przypisany do encji lub warstwy może nie znajdować się w przypisanej tabeli stylów 

wydruku w czasie drukowania. W takim przypadku encje są drukowane przy użyciu 

ich domyślnych właściwości, co jest podobne do przypisania normalnego stylu 

wydruku do encji lub warstwy. 
 

Aby przypisać tabelę stylów drukowania podczas drukowania 

1 W razie potrzeby kliknij żądaną kartę Układ lub kliknij kartę Model. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj lub wybierz kolejno Wyjście > Drukuj (w oknie Drukuj). 

• W menu wybierz Plik > Drukuj. 

• Wpisz print i naciśnij Enter. 

 TaskCommandGdzie uzyskać szczegółowe 
informacje 
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Do konfiguracji strony można przypisać tabelę stylów drukowania. 

Za pomocą Menedżera konfiguracji strony można przypisać tabelę stylów 

drukowania do konfiguracji strony używanej do drukowania. Więcej informacji 

można znaleźć w części Określanie opcji drukowania pióra i linii. 
 

3 W obszarze Print Style Table (Pen Assignments) wybierz utworzoną tabelę stylów 

drukowania lub jedną z poniższych: 

• Brak - nie stosuje tabeli stylów wydruku. Podmioty drukują zgodnie z 

własnymi właściwościami. 

• Icad - używa domyślnej tabeli stylów wydruku i przypisanych do niej kolorów. 

• Monochromatyczny - drukuje wszystkie kolory jako czarne. 

4 Wybierz Zapisz zmiany w układzie, a następnie kliknij OK. 

 

Gdy rysunek jest tworzony po raz pierwszy, jest on przypisywany do korzystania z 

tabel stylów zależnych od kolorów lub nazwanych. 

Aby uzyskać szczegółowe informacje na temat konwertowania rysunku w celu użycia innego 
typu tabeli stylów wydruku, zob. 

"Zrozumienie tabel stylów wydruku" na stronie 546 w tym rozdziale. 
 

 
Tworzenie nowych tabel stylów wydruku 

ALCAD oferuje kilka tabel stylów drukowania, które pomogą Ci zacząć. Jeśli 

chcesz jeszcze bardziej dostosować wydruk, możesz utworzyć własną tabelę 

stylów drukowania. Możesz utworzyć nową tabelę stylów drukowania całkowicie 

od zera, w oparciu o ustawienia rejestru ALCAD lub importując plik konfiguracji 

drukarki (plik PCP). 
 

Aby utworzyć nowe tabele stylów wydruku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer stylów wydruku (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj > Menedżer stylów wydruku lub polecenie Wyjście > Menedżer 

stylów wydruku (w oknie Drukuj). 

• W menu wybierz kolejno Plik > Menedżer stylów wydruku lub Format > 

Menedżer stylów wydruku. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stylów wydruku. 

• Wpisz stylesmanager i naciśnij Enter. 

2 Kliknij przycisk Dodaj. 

3 Ukończ kreatora konfiguracji. 

Na ostatniej stronie kreatora można kliknąć opcję Edytor stylu wydruku tabeli, 

aby skonfigurować style wydruku dla tabeli. Więcej informacji na temat opcji 

edytora stylu wydruku tabeli znajduje się w następnej sekcji. 
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A 

 

E 

D 

B 
C 

 
 
 
 
 
 

 
A Wyświetla lokalizację, w której znajdują się 

drukowane tabele. 

B Wyświetla listę wszystkich tabel stylów wydruku 
dostępnych w nazwanym folderze. 

 

 
Modyfikowanie tabel 
stylów wydruku 

 
C Kliknij, aby usunąć aktualnie wybraną 

tabelę stylów wydruku. 

D Kliknij, aby zmodyfikować ustawienia dla 
aktualnie wybranej tabeli stylów 
wydruku. 

E Kliknij, aby utworzyć nową tabelę stylów wydruku. 

Po utworzeniu rysunku został on skonfigurowany do korzystania z tabel stylów 

wydruku zależnych od koloru lub nazwanych: 

• Tabele stylów wydruku zależnych od koloru (pliki .ctb) - można modyfikować 

poszczególne style wydruku w tabeli, ale nie można dodawać, zmieniać nazw 

ani usuwać stylów wydruku. Tabele stylów wydruku zależnych od koloru zawsze 

zawierają 255 stylów wydruku, z których każdy ma nazwę określonego koloru. 

Zmiany mają wpływ na wszystkie jednostki i warstwy przypisane do tego 

koloru. 

• Tabele nazwanych stylów drukowania (pliki .stb) - w ramach tabeli można 

dodawać, modyfikować, zmieniać nazwy i usuwać poszczególne style 

drukowania. Nie można jednak modyfikować, zmieniać nazwy ani usuwać 

normalnego stylu wydruku. Zmiany mają wpływ na wszystkie jednostki i 

warstwy, którym przypisano tę nazwę stylu wydruku. 

 

Użyj zmiennej systemowej, aby określić typ tabeli stylów wydruku używanej przez 

rysunek. Jeśli nie pamiętasz, jaki typ tabeli stylów wydruku jest przypisany do 

rysunku, użyj zmiennej systemowej PSTYLEMODE, aby określić typ tabeli stylów 

wydruku. 
 

Każdy styl wydruku w tabeli stylów wydruku określa kolor, numery pióra, typ linii i 

grubość linii. ALCAD rozpoznaje dodatkowe właściwości dla kompatybilności tylko 

z AutoCAD, w tym: dither, skalę szarości, ekranowanie, adaptacyjny, styl końca linii, 

styl łączenia linii i styl wypełnienia. 

Określając charakterystykę stylu drukowania, należy wziąć pod uwagę ograniczenia 

urządzenia wyjściowego. 
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Zaleca się modyfikowanie tylko tych tabel stylów wydruku, które zostały 

utworzone przez użytkownika. Jeśli zmodyfikujesz domyślną tabelę stylów 

wydruku dostarczoną z ALCAD, nadpiszesz oryginalne informacje, które zostaną 

utracone. 
 

 
Aby zmodyfikować tabele stylów wydruku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer stylów wydruku (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj > Menedżer stylów wydruku lub polecenie Wyjście > Menedżer 

stylów wydruku (w oknie Drukuj). 

• W menu wybierz kolejno opcje Plik > Menedżer stylów wydruku lub 

Format > Menedżer stylów wydruku. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stylów wydruku. 

• Wpisz stylesmanager i naciśnij Enter. 

2 Wybierz tabelę stylów wydruku, którą chcesz zmodyfikować. 

3 Kliknij przycisk Modyfikuj. 

4 Kliknij kartę Ogólne, a następnie wykonaj jedną z poniższych czynności: 

• Wprowadź nowy opis tabeli. 

• Wybierz opcję Zastosuj globalny współczynnik skali do typów linii innych niż 

ISO, aby zastosować współczynnik skali do typów linii innych niż ISO 

używanych dla dowolnego stylu wydruku w bieżącej tabeli stylów wydruku. 

Dotyczy to również wzorów wypełnienia, które nie są używane w programie 

ALCAD, ale są rozpoznawane w celu zapewnienia zgodności z programem 

AutoCAD. 

• Wprowadź współczynnik skali, aby zastosować go do typów linii innych niż 

ISO używanych dla dowolnego stylu drukowania w bieżącej tabeli stylów 

drukowania. 

5 Kliknij kartę Widok formularza, a następnie wykonaj jedną z poniższych czynności: 

• Dokonaj zmian formatu stylu wydruku, wybierając go z listy Style wydruku, 

a następnie dokonaj zmian koloru, mapy pióra, rodzaju linii lub grubości linii dla 

stylu wydruku. Zmiany są zapisywane automatycznie dla wybranego stylu 

wydruku. 

• Dodaj nowy styl wydruku, klikając przycisk Dodaj styl. Wprowadź nową 

nazwę, a następnie kliknij przycisk OK. Wybierz opcje stylu wydruku. 

(Dostępne tylko dla nazwanych stylów drukowania). 

• Zmień nazwę stylu wydruku, wybierając go z listy Style wydruku. Kliknij 

ponownie styl wydruku, a następnie wprowadź nową nazwę. (Dostępne tylko 

dla nazwanych stylów wydruku). 

• Usuń styl wydruku, zaznaczając go na liście Style wydruku. Kliknij 

przycisk Usuń styl. (Dostępne tylko dla nazwanych stylów wydruku). 
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6 Kliknij OK. 
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A Wybierz styl drukowania, aby go 
zmodyfikować. 

B Wprowadź opis wybranego stylu druku. 

C Kliknij, aby utworzyć nowy styl wydruku. 
(Tylko nazwane tabele stylów wydruku). 

D Kliknij, aby usunąć wybrany styl wydruku. 
(Tylko nazwane tabele stylów wydruku). 

E Kliknij, aby zmodyfikować listę dostępnych 
grubości linii dla bieżącej tabeli stylów 
wydruku. 

F Kliknij, aby zapisać tabelę stylów drukowania 
z nową nazwą lub w nowej lokalizacji. 

G Wybierz styl wypełnienia dla wybranego stylu 
wydruku. 

H Wybierz styl łączenia linii dla wybranego 
stylu wydruku. 

I Wybierz styl zakończenia linii dla 
wybranego stylu wydruku. 

J Wybierz grubość linii dla wybranego stylu 
drukowania. 

 
K Wybierz, czy skala linii ma być 

dostosowywana automatycznie w celu 
uzupełnienia wzoru linii w razie potrzeby. 

L Wybierz typ linii dla wybranego stylu drukowania. 

M Wybierz poziom intensywności kolorów dla 
wybranego stylu drukowania: 100 oznacza 
pełną intensywność, 0 oznacza biel (Dither 
musi być włączony). 

N Wpisz lub przewiń szerokość wirtualnego 
pióra dla wybranego stylu drukowania (w 
przypadku drukarek, które nie mają fizycznych 
piór, takich jak drukarki laserowe lub 
atramentowe). 

O Wpisz lub przewiń szerokość pióra fizycznego 
dla wybranego stylu drukowania. 

P Wybierz, czy wybrany styl druku ma być 
drukowany w skali szarości. 

Q Określenie, czy dla wybranego stylu 
wydruku ma być włączony dithering. 

R Wybierz kolor dla wybranego stylu drukowania. 
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Kopiowanie, zmiana nazwy lub usuwanie tabel stylów wydruku 

Tabelę stylów wydruku można kopiować, zmieniać jej nazwę lub usuwać tak samo, 

jak każdy inny plik na komputerze. Niezależnie od typu tabeli stylów wydruku 

używanej w rysunku, można użyć Menedżera stylów wydruku do zarządzania 

zarówno tabelami stylów wydruku zależnymi od koloru, jak i nazwanymi. 
 

Aby usunąć tabele stylów wydruku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer stylów wydruku (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj > Menedżer stylów wydruku lub polecenie Wyjście > Menedżer 

stylów wydruku (w oknie Drukuj). 

• W menu wybierz kolejno Plik > Menedżer stylów wydruku lub Format > 

Menedżer stylów wydruku. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer stylów wydruku. 

• Wpisz stylesmanager i naciśnij Enter. 

2 Wybierz tabelę stylów wydruku, a następnie kliknij przycisk Usuń. 

Tabele stylów wydruku zależne od koloru to pliki .ctb, a nazwane tabele stylów wydruku to 

.stb. 
 

Aby skopiować, zmienić nazwę lub usunąć tabele stylów wydruku 

1 Na komputerze otwórz folder, w którym przechowywane są na przykład tabele stylów 

wydruku, 

\Nazwa firmy\Wersja produktu\Style druku. 

2 Skopiuj, zmień nazwę lub usuń tabelę stylów wydruku, tak jak każdy inny plik 

na komputerze. 

 

Zmiana typu tabeli stylów wydruku rysunku 

Podczas tworzenia rysunku został on skonfigurowany do korzystania z tabel stylów 

wydruku zależnych od koloru (pliki .ctb) lub nazwanych tabel stylów wydruku 

(pliki .stb). Rysunek może korzystać z jednego typu tabeli stylów wydruku na raz. W razie 

potrzeby, po utworzeniu rysunku można przekonwertować rysunek na inny typ 

tabeli stylów wydruku. 

Jeśli nie pamiętasz, jaki typ tabeli stylów wydruku jest przypisany do rysunku, użyj 

zmiennej systemowej PSTYLEMODE, aby określić typ tabeli stylów wydruku. 
 

Aby zmienić rysunek w celu użycia nazwanych tabel stylów wydruku 

1 Jeśli chcesz ponownie wykorzystać istniejące informacje o stylu wydruku, 

przekonwertuj tabele stylów wydruku zależnych od koloru na nazwane tabele stylów 

wydruku. Aby uzyskać szczegółowe informacje, patrz "Konwertowanie tabeli 

stylów wydruku zależnych od koloru na nazwaną tabelę stylów wydruku" na 

stronie 557 w tym rozdziale. 

2 Otwórz rysunek wykorzystujący tabele stylów wydruku zależne od kolorów (pliki .ctb). 

3 Wpisz convertpstyles, a następnie naciśnij Enter. 
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4 Jeśli tabele indywidualnych stylów wydruku zależnych od kolorów zostały już 

przekonwertowane na tabele nazwane, kliknij przycisk OK w wyświetlonym 

oknie dialogowym. 

Jeśli tabele nie zostały przekonwertowane, kliknij przycisk Anuluj. Najpierw 

użyj convertctb, aby przekonwertować tabele stylów wydruku zależne od kolorów na 

tabele nazwane. W przeciwnym razie wszystkie informacje o stylu wydruku 

określone w rysunku zostaną utracone. 

5 Wybierz nazwaną tabelę stylów wydruku (plik .stb), której chcesz użyć z rysunkiem. 

6 Kliknij przycisk Otwórz. 
 

Jeśli tabele stylów wydruku nie zostały przekonwertowane, wystąpią błędy. 

Jeśli tabela stylów wydruku zależna od kolorów nie została przekonwertowana na 

nazwaną tabelę stylów wydruku, zostanie wyświetlone ostrzeżenie, że wybrana tabela 

nie zawiera mapowania kolorów i rysunek nie może zostać przekonwertowany. 
 

 
Aby zmienić rysunek w celu użycia tabel stylów wydruku zależnych od koloru 

1 Otwórz rysunek wykorzystujący nazwane tabele stylów wydruku (pliki .stb). 

2 Wpisz convertpstyles, a następnie naciśnij Enter. 

3 Jeśli jesteś pewien, że chcesz przekonwertować rysunek i utracić wszystkie 

przypisane style drukowania, kliknij OK w wyświetlonym monicie. 

Jeśli nie chcesz utracić przypisanych stylów drukowania, kliknij przycisk Anuluj. 
 

Konwersja rysunku w celu użycia zależnych od koloru tabel stylów wydruku 

spowoduje usunięcie wszystkich nazwanych informacji o stylu wydruku z 

elementów i warstw. 

Nazwane tabele stylów wydruku nie są jednak usuwane z komputera. 
 

 
Konwersja tabel stylów wydruku 

Tabelę stylów wydruku zależnych od koloru można przekonwertować na tabelę 

nazwanych stylów wydruku. Nie można przekonwertować nazwanej tabeli stylów 

wydruku na tabelę stylów wydruku zależnych od koloru, ponieważ tabele zależne 

od koloru zawierają tylko style wydruku, których nazwy pochodzą od 255 kolorów, 

na które są mapowane. 

Konwersja tabeli stylów wydruku zależnej od koloru na nazwaną tabelę stylów 

wydruku może być przydatna w następujących sytuacjach: 

• Nie ma potrzeby tworzenia nazwanej tabeli stylów wydruku od podstaw. 

• Użytkownik chce utworzyć nazwaną tabelę stylów wydruku, która ma takie 

same ustawienia jak tabela stylów wydruku zależnych od kolorów, ale z 

kilkoma nowymi stylami wydruku lub innymi ustawieniami niestandardowymi. 

• Chcesz przekonwertować rysunek, aby używać nazwanych tabel stylów 

wydruku i chcesz ponownie użyć większości stylów wydruku już 

zdefiniowanych w tabeli stylów wydruku zależnych od koloru. 
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Aby przekonwertować tabelę stylów wydruku zależną od koloru na nazwaną tabelę 
stylów wydruku 

1 Wpisz convertctb, a następnie naciśnij Enter. 

2 Wybierz tabelę stylów druku zależnych od kolorów (plik .ctb), którą chcesz 

przekonwertować. 

3 Kliknij przycisk Otwórz. 

4 Wprowadź nazwę nowej tabeli stylów wydruku (plik .stb). 

5 Kliknij przycisk Zapisz. 
 

Style wydruku w nowej tabeli mają nazwy Styl 1, Styl 2 itd. Jeśli chcesz użyć 

innych nazw stylów wydruku, zmień nazwy stylów wydruku przed przypisaniem ich 

do jednostek i warstw na rysunku. Jeśli zmienisz nazwy stylów wydruku po ich 

przypisaniu, nie będą one pasować podczas drukowania rysunku. Informacje na 

temat zmiany nazw stylów wydruku można znaleźć w sekcji "Modyfikowanie tabel 

stylów wydruku" na stronie 552 w tym rozdziale. 

 

Włączanie lub wyłączanie tabel stylów wydruku 

Po wyłączeniu tabel stylów wydruku elementy są drukowane zgodnie z ich 

własnymi właściwościami. Jednak wszystkie informacje o stylu wydruku są 

zapisywane, dzięki czemu można łatwo ponownie włączyć style wydruku. 

Rzeczywiste pliki tabel stylów wydruku nie są usuwane, a w przypadku rysunków 

korzystających z nazwanych tabel stylów wydruku, elementy i warstwy zachowują 

przypisane im style wydruku. 
 

Aby wyłączyć tabele stylów wydruku 

1 Kliknij kartę Układ lub Model, dla której chcesz włączyć lub wyłączyć tabele 

stylów wydruku. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Menedżer ustawień strony (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Menedżer 

ustawień strony lub wybierz kolejno opcje Wydruk > Menedżer ustawień 

strony (w trybie drukowania). 

• W menu wybierz Plik > Menedżer ustawień strony. 

• Na pasku narzędzi Format kliknij narzędzie Menedżer ustawień strony. 

• Wpisz pagesetup i naciśnij Enter. 

3 Wybierz żądaną konfigurację strony, a następnie kliknij przycisk Modyfikuj. 

4 W obszarze Tabela stylów drukowania wybierz tabelę stylów drukowania, aby 

włączyć tabele stylów drukowania, lub wybierz opcję Brak, aby wyłączyć 

tabele stylów drukowania. 

5 Kliknij przycisk OK. 

6 Kliknij przycisk OK. 
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Drukowanie lub plotowanie rysunku 
 

Po skonfigurowaniu rysunku i wszelkich układów do drukowania można przystąpić 

do drukowania. W razie potrzeby przed wydrukowaniem można wyświetlić 

podgląd strony. 

 

Podgląd rysunku przed wydrukowaniem 

Wyświetlenie rysunku przed wydrukowaniem daje podgląd tego, jak rysunek 

będzie wyglądał po wydrukowaniu. Pomaga to sprawdzić, czy są jakieś zmiany, 

które chcesz wprowadzić przed faktycznym wydrukowaniem rysunku. 

Jeśli używane są tabele stylów wydruku, podgląd pokazuje, jak rysunek zostanie 

wydrukowany z przypisanymi stylami wydruku. Na przykład, podgląd może 

wyświetlać inne kolory lub grubości linii niż te użyte w rysunku z powodu 

przypisanych stylów wydruku. 
 

Aby wyświetlić podgląd rysunku przed wydrukowaniem 

1 W razie potrzeby kliknij żądaną kartę Układ lub Model. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Podgląd wydruku ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj > Podgląd wydruku lub polecenie Wyjście > Podgląd wydruku (w 

oknie Drukuj). 

• W menu wybierz Plik > Podgląd wydruku. 

• Na pasku narzędzi Standard kliknij narzędzie Podgląd wydruku. 

• Wpisz ppreview i naciśnij Enter. 

3 Po sprawdzeniu obrazu podglądu wykonaj jedną z poniższych czynności: 

• Aby wydrukować rysunek, kliknij przycisk Drukuj. 

• Aby powrócić do rysunku, kliknij przycisk Anuluj. 
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A Kliknij, aby powiększyć. 

B Kliknij, aby pomniejszyć. W przypadku 
kilkukrotnego powiększenia kliknij kilka 
razy, aby przywrócić cały obraz 
podglądu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
C Kliknij, aby wydrukować rysunek. 

D Kliknij, aby zamknąć podgląd i powrócić 
do rysunku. 
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Drukowanie rysunku 

Okno dialogowe Drukuj zawiera ustawienia drukowania opisane w poprzednich 

sekcjach dotyczących konfiguracji stron. 

 

Wyrenderowanego obrazu nie można wydrukować bezpośrednio na drukarce. 

Aby wydrukować wyrenderowany obraz, należy najpierw zapisać rysunek w innym 

formacie, a następnie wydrukować go z innego programu graficznego. 
 

 
Aby wydrukować rysunek 

1 W razie potrzeby kliknij żądaną kartę Układ lub Model. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Drukuj lub wybierz kolejno Wyjście > Drukuj (w oknie Drukuj). 

• W menu wybierz Plik > Drukuj. 

• Na pasku narzędzi Standardowy kliknij narzędzie Drukuj. 

• Wpisz print i naciśnij Enter. 

3 W polu Nazwa konfiguracji strony wybierz konfigurację strony, która ma zostać 

zastosowana do drukowania. Opcje drukowania w oknie dialogowym Drukuj 

zmienią się, aby odzwierciedlić ustawienia wybranej konfiguracji strony. 

4 Dokonaj wszelkich niezbędnych regulacji, w tym następujących opcji, które 

są dostępne tylko podczas drukowania (nie podczas konfigurowania 

ustawień strony): 

• Drukuj do pliku - Wybierz, aby drukować do pliku zamiast do drukarki. 

• Liczba kopii - Wprowadź liczbę kopii do wydrukowania. 

• Drukuj przezroczystość - Wybierz, aby drukować jednostki z przypisaną im 

przezroczystością. Należy pamiętać, że włączenie tej opcji może spowolnić 

drukowanie. 

• Drukuj w tle - drukowanie w tle innych zadań wykonywanych przez 

komputer. 

• Print stamp on - Wybierz, aby drukować z nagłówkiem i stopką. Kliknij 

przycisk [...], aby zmodyfikować tekst stempla wydruku. 

• Zapisz zmiany w układzie - Wybierz, aby zapisać ustawienia drukowania 

dla modelu lub układu. 

5 Kliknij przycisk Drukuj. 
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A Wybierz drukowanie do pliku zamiast na 
drukarce. 

B Wprowadź liczbę kopii do wydrukowania. 

C Wybierz, aby zapisać ustawienia drukowania 
dla modelu lub układu. 

D Wybierz opcję drukowania z nagłówkiem i 
stopką. Kliknij [...], aby zmodyfikować tekst 
stempla wydruku. 

E Wybierz, aby drukować w tle innych zadań 
wykonywanych przez komputer. 

F Wybierz, aby wydrukować jednostki z 
przypisaną im przezroczystością. 
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Zapisywanie ustawień drukowania dla modelu lub układu 

Wszystkie ustawienia drukowania można zapisać wraz z modelem lub layoutem, co 

może być szczególnie pomocne w przypadku nieużywania konfiguracji stron. Przy następnym 

drukowaniu modelu lub układu zapisane ustawienia drukowania zostaną 

automatycznie wczytane w oknie dialogowym Drukuj. 

 

Zapisane ustawienia drukowania są również używane podczas publikowania. 

W przypadku publikowania rysunków przy użyciu arkuszy, które nie mają 

przypisanych ustawień strony, domyślnie używane są ustawienia drukowania 

zapisane dla modelu lub układu. 
 

 
Aby zapisać ustawienia drukowania z modelem lub układem 

1 Kliknij żądaną kartę Układ lub Model, dla której chcesz zapisać ustawienia 

drukowania. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Drukuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie polecenie Drukuj lub 

polecenie Wyjście > Drukuj (w oknie Drukuj). 

• W menu wybierz Plik > Drukuj. 

• Na pasku narzędzi Standardowy kliknij narzędzie Drukuj. 

• Wpisz print i naciśnij Enter. 

3 Dokonaj wyboru drukowania. 

4 Kliknij przycisk Zastosuj do układu. 

5 Wykonaj jedną z poniższych czynności: 

• Kliknij OK, aby wydrukować i zamknąć okno dialogowe. 

• Kliknij przycisk Anuluj, aby zamknąć okno dialogowe bez drukowania. 



 

Publikowanie 
rysunków 
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Zamiast drukować jeden rysunek na raz, można użyć polecenia Publikuj, aby 

zapisać i wydrukować kolekcję rysunków i ich układów. 

Najpierw należy utworzyć listę arkuszy, określając żądane układy, które mogą być 

kombinacją układów przestrzeni modelu i przestrzeni papieru z dowolnej liczby 

rysunków. Zapisz listę arkuszy, a następnie wydrukuj ją. 

 

Tworzenie listy arkuszy do opublikowania 

Lista arkuszy to zbiór arkuszy, które mają zostać opublikowane. Każdy arkusz na 

liście odwołuje się do układu, który może być przestrzenią modelu lub układem przestrzeni 

papieru z dowolnego rysunku. 

Listy arkuszy są zapisywane jako pliki opisu zestawu rysunków (pliki dsd). 
 

Aby utworzyć listę arkuszy do opublikowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Publikuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz kolejno opcje 

Publikuj > Publikuj lub Wyjście > Publikuj. 

• W menu wybierz Plik > Publikuj. 

• Na pasku narzędzi Standard kliknij narzędzie Publikuj. 

• Wpisz publish i naciśnij Enter. 

2 Aby dodać arkusze, wykonaj następujące czynności: 

• Kliknij przycisk Dodaj. 

• Wybierz jeden lub więcej rysunków zawierających modele i układy, które 

chcesz dodać jako arkusze. 

• Kliknij przycisk Otwórz. 

3 Aby dodać arkusze ze wszystkich otwartych rysunków, zaznacz opcję 

Automatycznie załaduj wszystkie otwarte rysunki. Modele i układy ze 

wszystkich otwartych rysunków zostaną dodane jako arkusze. 

4 Aby usunąć niechciane arkusze z listy arkuszy, wybierz arkusz, a następnie kliknij przycisk 

Usuń. 

5 Aby przenieść arkusze w górę lub w dół listy, wybierz arkusz i kliknij przycisk 

Przenieś w górę lub Przenieś w dół. Arkusze są publikowane w kolejności ich 

wyświetlania. 

6 Kliknij przycisk Zapisz. 

7 W oknie dialogowym Zapisz plik DSD wprowadź nazwę listy arkuszy, a następnie kliknij 

przycisk Zapisz. 
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A Zaznacz, aby załadować modele i układy jako 
arkusze ze wszystkich otwartych rysunków. 

B Kliknij, aby usunąć aktualnie wybrany arkusz z 
listy arkuszy. 

C Kliknij, aby wybrać rysunek zawierający 
model i układy do dodania jako arkusze. 

D Wyświetla arkusze do opublikowania z 
ustawieniami każdego arkusza. 

E Wyświetla szczegóły dotyczące aktualnie wybranego 
arkusza. 

F Kliknij, aby przesunąć aktualnie wybrany 
arkusz o jedną pozycję w górę. 

G Kliknij, aby przesunąć aktualnie wybrany 
arkusz o jedną pozycję w dół. 

H Kliknij, aby zmienić ustawienia strony dla 
aktualnie wybranego arkusza. 

I Kliknij, aby zapisać listę układów jako listę arkuszy. 
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Modyfikowanie istniejącej listy arkuszy 

Otwórz lub załaduj istniejący wykaz arkuszy (plik .dsd), aby go zmodyfikować. 

Podczas wczytywania rysunki określone w liście arkuszy muszą być dostępne w 

lokalizacji folderu, do której się odwołano. 
 

Aby zmodyfikować listę arkuszy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Publikuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz kolejno opcje 

Publikuj > Publikuj lub Wyjście > Publikuj. 

• W menu wybierz Plik > Publikuj. 

• Na pasku narzędzi Standard kliknij narzędzie Publikuj. 

• Wpisz publish i naciśnij Enter. 

2 Kliknij przycisk Załaduj. 

3 Zlokalizuj i wybierz plik .dsd, który chcesz zmodyfikować. 

4 Kliknij przycisk Otwórz. 

5 Aby dodać arkusze, wykonaj następujące czynności: 

• Kliknij przycisk Dodaj lub naciśnij przycisk wstawiania po wybraniu arkusza. 

• Wybierz jeden lub więcej rysunków zawierających modele i układy, które 

chcesz dodać jako arkusze. 

• Kliknij przycisk Otwórz. 

6 Aby usunąć niechciane arkusze z listy arkuszy, wybierz arkusz, a następnie 

kliknij przycisk Usuń lub naciśnij przycisk Usuń. 

7 Aby przypisać inny układ strony do arkusza, wybierz układ strony z listy dla 

arkusza. Aby zmienić ustawienia strony, wykonaj następujące czynności: 

• Wybierz arkusz i kliknij przycisk Zmień. Możesz także kliknąć arkusz dwukrotnie. 

• Wybierz konfigurację strony, którą chcesz zmienić, a następnie kliknij przycisk 

Modyfikuj. 

• Dokonaj wyboru, a następnie kliknij przycisk OK. 

• Kliknij przycisk Zamknij. 

8 Aby opublikować arkusz przy użyciu określonego stanu warstwy, wybierz stan 

warstwy dla arkusza w kolumnie Stan warstwy. Lista wyświetla wszystkie stany 

warstw utworzone dla rysunku. 

9 Aby przenieść arkusze w górę lub w dół listy, wybierz arkusz i kliknij przycisk 

Przenieś w górę lub Przenieś w dół. Arkusze są publikowane w kolejności ich 

wyświetlania. 

10 Kliknij przycisk Zapisz. 

 
Publikowanie listy arkuszy na drukarce wskazanej w 

ustawieniach strony Publikowanie listy arkuszy powoduje jednoczesne 

wydrukowanie wszystkich arkuszy, do których istnieją odniesienia. Arkusze są 

drukowane na drukarce wskazanej w ustawieniach strony przypisanych do każdego 

arkusza. Jeśli kolumna Ustawienia strony wskazuje Brak dla arkusza, arkusz jest 

publikowany przy użyciu opcji drukowania określonych dla układu. 
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Aby opublikować listę arkuszy na drukarce wskazanej w ustawieniach strony 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Publikuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz kolejno opcje 

Publikuj > Publikuj lub Wyjście > Publikuj. 

• W menu wybierz Plik > Publikuj. 

• Na pasku narzędzi Standard kliknij narzędzie Publikuj. 

• Wpisz publish i naciśnij Enter. 

2 Otwórz żądaną listę arkuszy: 

• Kliknij przycisk Załaduj. 

• Zlokalizuj i wybierz plik .dsd do opublikowania. 

• Kliknij przycisk Otwórz. 

Szczegółowe informacje na temat tworzenia listy arkuszy zawiera sekcja 

"Tworzenie listy arkuszy do opublikowania" na stronie 563 w tym rozdziale. 

3 W obszarze Publish To (Publikuj do) wybierz opcję Printer Named (Drukarka nazwana) w 

obszarze Page Setup (Ustawienia strony). 

4 Jeśli regularnie publikujesz na drukarce konfiguracji strony zamiast na 

innych formatach, opcjonalnie kliknij opcję Ustaw jako domyślne. 

5 Aby przypisać inny układ strony do arkusza, wybierz układ strony z listy dla 

arkusza. Aby zmienić ustawienia strony, wykonaj następujące czynności: 

• Wybierz arkusz i kliknij przycisk Zmień. Możesz także kliknąć arkusz dwukrotnie. 

• Wybierz konfigurację strony, którą chcesz zmienić, a następnie kliknij przycisk 

Modyfikuj. 

• Dokonaj wyboru, a następnie kliknij przycisk OK. 

• Kliknij przycisk Zamknij. 

6 Sprawdź status każdego arkusza na liście: 

• Brak błędów - arkusz jest gotowy do publikacji. 

• Layout Not Initialized (Układ niezainicjowany) - do układu arkusza nie 

przypisano prawidłowej drukarki. Jeśli arkusz ma przypisaną konfigurację 

strony, wybierz Plik > Konfiguracja strony i określ prawidłową drukarkę dla 

konfiguracji strony. Jeśli nie przypisano konfiguracji strony, otwórz źródłowy 

plik rysunku, kliknij kartę Model lub Układ, wybierz Plik > Drukuj, określ 

drukarkę, a następnie kliknij Zastosuj do układu. 

7 Aby opublikować arkusz przy użyciu określonego stanu warstwy, wybierz stan 

warstwy dla arkusza w kolumnie Stan warstwy. Lista wyświetla wszystkie stany 

warstw utworzone dla rysunku. 

8 Określ jedną z poniższych opcji: 

• Liczba kopii - Wprowadź liczbę kopii do wydrukowania. 

• Include print stamp - Wybierz, aby drukować z nagłówkiem i stopką. 

Kliknij przycisk [...], aby zmodyfikować tekst nagłówka i stopki. 

• Publikuj w tle - Wybierz, aby drukować w tle innych zadań wykonywanych 

przez komputer. 
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9 Kliknij przycisk Opublikuj. 
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A Kliknij, aby otworzyć listę arkuszy. 

B Wybierz listę arkuszy do opublikowania. 

C Wybierz opcję drukowania w ustawieniach 
stron dla każdego arkusza. Kliknij przycisk 
Ustaw jako domyślne, aby ustawić to ustawienie 
jako domyślne przy każdym otwarciu okna 
dialogowego. 

D Wyświetla arkusze do opublikowania z 
ustawieniami każdego arkusza. 

E Wyświetla szczegóły dotyczące wybranego 
arkusza. 

F Wprowadź liczbę kopii do wydrukowania. 

G  Zaznacz, aby publikować w tle innych zadań 
wykonywanych przez komputer. 

H Zaznacz, aby opublikować z nagłówkiem i 
stopką. Kliknij przycisk [...], aby zmodyfikować 
tekst stempla wydruku. 

I Kliknij, aby zmienić ustawienia strony dla 
aktualnie wybranego arkusza. 

J Kliknij, aby zapisać listę układów jako listę arkuszy. 

 

Publikowanie listy arkuszy do pliku PDF 

Publikowanie listy arkuszy do pliku PDF powoduje jednoczesne wydrukowanie 

wszystkich arkuszy, do których istnieją odniesienia, do pliku .pdf. Pliki PDF 

umożliwiają dystrybucję rysunku do innych osób w celu przeglądania w programie 

Adobe® Acrobat® Reader®, który jest bezpłatnym oprogramowaniem do pobrania 

przez użytkowników. Pliki PDF można również przeglądać, sprawdzać i edytować 

w programie Adobe Acrobat. 

Jeśli kolumna Ustawienia strony wskazuje Brak dla arkusza, arkusz jest 

publikowany przy użyciu opcji drukowania określonych dla układu. 
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Aby opublikować listę arkuszy w formacie PDF 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Publikuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz kolejno opcje 

Publikuj > Publikuj lub Wyjście > Publikuj. 

• W menu wybierz Plik > Publikuj. 

• Na pasku narzędzi Standard kliknij narzędzie Publikuj. 

• Wpisz publish i naciśnij Enter. 

2 Otwórz żądaną listę arkuszy: 

• Kliknij przycisk Załaduj. 

• Zlokalizuj i wybierz plik .dsd do opublikowania. 

• Kliknij przycisk Otwórz. 

Szczegółowe informacje na temat tworzenia listy arkuszy zawiera sekcja 

"Tworzenie listy arkuszy do opublikowania" na stronie 563 w tym rozdziale. 

3 W sekcji Publikuj do wybierz PDF. 

4 Jeśli regularnie publikujesz w formacie PDF zamiast w innych formatach, 

opcjonalnie kliknij opcję Ustaw jako domyślny. 

5 Kliknij przycisk Opcje publikacji i wykonaj jedną z poniższych czynności: 

• Wybierz opcje dla opublikowanego pliku .pdf. 

• Kliknij Właściwości niestandardowe, aby wybrać dodatkowe opcje, a następnie kliknij 

OK po zakończeniu. 

• Kliknij [?], aby wyświetlić szczegółowe informacje na temat każdej opcji. 

6 Po zakończeniu ustawiania opcji PDF kliknij przycisk OK. 

7 Aby przypisać inny układ strony do arkusza, wybierz układ strony z listy dla 

arkusza. Aby zmienić ustawienia strony, wykonaj następujące czynności: 

• Wybierz arkusz i kliknij przycisk Zmień. Możesz także kliknąć arkusz dwukrotnie. 

• Wybierz konfigurację strony, którą chcesz zmienić, a następnie kliknij przycisk 

Modyfikuj. 

• Dokonaj wyboru, a następnie kliknij przycisk OK. 

• Kliknij przycisk Zamknij. 

8 Sprawdź status każdego arkusza na liście: 

• Brak błędów - arkusz jest gotowy do publikacji. 

• Layout Not Initialized (Układ niezainicjowany) - do układu arkusza nie 

przypisano prawidłowej drukarki. Jeśli arkusz ma przypisaną konfigurację 

strony, wybierz Plik > Konfiguracja strony i określ prawidłową drukarkę dla 

konfiguracji strony. Jeśli nie przypisano konfiguracji strony, otwórz źródłowy 

plik rysunku, kliknij kartę Model lub Układ, wybierz Plik > Drukuj, określ 

drukarkę, a następnie kliknij Zastosuj do układu. 

9 Aby opublikować arkusz przy użyciu określonego stanu warstwy, wybierz stan 

warstwy dla arkusza w kolumnie Stan warstwy. Lista wyświetla wszystkie stany 

warstw utworzone dla rysunku. 

10 Kliknij przycisk Publikuj. 
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A Kliknij, aby otworzyć listę arkuszy. 

B Wybierz listę arkuszy do opublikowania. 

C Wybierz opcję opublikuj do PDF. Kliknij przycisk 
Setas Default (Ustaw jako domyślne), aby 
wprowadzić ustawienia domyślne przy każdym 
otwarciu okna dialogowego. 

D Wyświetla arkusze do opublikowania z 
ustawieniami każdego arkusza. 

E Wyświetla szczegóły dotyczące aktualnie wybranego arkusza. 

F Kliknij, aby ustawić opcje publikowania w formacie PDF. 

G Kliknij, aby zmienić ustawienia strony dla 
aktualnie wybranego arkusza. 

H Wyświetla szczegóły dotyczące aktualnie 
wybranych ustawień PDF. 
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Publikowanie listy arkuszy do formatu DWF lub DWFx 

Opublikowanie listy arkuszy w formacie DWF lub DWFx powoduje jednoczesne 

wydrukowanie wszystkich arkuszy, do których istnieją odniesienia, do pliku .dwf 

lub .dwfx, w zależności od wybranego formatu. Pliki DWF i DWFx umożliwiają 

dystrybucję rysunku do innych osób w celu przeglądania, recenzowania i 

edytowania online. 

Jeśli kolumna Ustawienia strony wskazuje Brak dla arkusza, arkusz jest 

publikowany przy użyciu opcji drukowania określonych dla układu. 
 

Aby opublikować listę arkuszy w formacie DWF lub DWFx 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Publikuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz kolejno opcje 

Publikuj > Publikuj lub Wyjście > Publikuj. 

• W menu wybierz Plik > Publikuj. 

• Na pasku narzędzi Standard kliknij narzędzie Publikuj. 

• Wpisz publish i naciśnij Enter. 

2 Otwórz żądaną listę arkuszy: 

• Kliknij przycisk Załaduj. 

• Zlokalizuj i wybierz plik .dsd do opublikowania. 

• Kliknij przycisk Otwórz. 

Szczegółowe informacje na temat tworzenia listy arkuszy zawiera sekcja 

"Tworzenie listy arkuszy do opublikowania" na stronie 563 w tym rozdziale. 

3 W opcji Publikuj do wybierz DWF lub DWFx. 

4 Jeśli regularnie publikujesz w formacie DWF lub DWFx zamiast w innych 

formatach, opcjonalnie kliknij opcję Ustaw jako domyślny. 

5 Kliknij Publish Options i wybierz opcje dla publikowanego pliku .dwf lub 

.dwfx. Kliknij [?], aby zobaczyć szczegóły dotyczące każdej opcji. 

6 Po zakończeniu ustawiania opcji publikacji kliknij przycisk OK. 

7 Aby przypisać inny układ strony do arkusza, wybierz układ strony z listy dla 

arkusza. Aby zmienić ustawienia strony, wykonaj następujące czynności: 

• Wybierz arkusz i kliknij przycisk Zmień. Możesz także kliknąć arkusz dwukrotnie. 

• Wybierz konfigurację strony, którą chcesz zmienić, a następnie kliknij przycisk 

Modyfikuj. 

• Dokonaj wyboru, a następnie kliknij przycisk OK. 

• Kliknij przycisk Zamknij. 
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8 Sprawdź status każdego arkusza na liście: 

• Brak błędów - arkusz jest gotowy do publikacji. 

• Layout Not Initialized (Układ niezainicjowany) - do układu arkusza nie 

przypisano prawidłowej drukarki. Jeśli arkusz ma przypisaną konfigurację 

strony, wybierz Plik > Konfiguracja strony i określ prawidłową drukarkę dla 

konfiguracji strony. Jeśli nie przypisano konfiguracji strony, otwórz źródłowy 

plik rysunku, kliknij kartę Model lub Układ, wybierz Plik > Drukuj, określ 

drukarkę, a następnie kliknij Zastosuj do układu. 

9 Aby opublikować arkusz przy użyciu określonego stanu warstwy, wybierz stan 

warstwy dla arkusza w kolumnie Stan warstwy. Lista wyświetla wszystkie stany 

warstw utworzone dla rysunku. 

10 Kliknij przycisk Opublikuj. 
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A Kliknij, aby otworzyć listę arkuszy. 

B Wybierz listę arkuszy do opublikowania. 

C Wybierz publikację w formacie DWF lub 
DWFx. Kliknij przycisk Ustaw jako domyślne, 
aby ustawić to ustawienie jako domyślne przy 
każdym otwarciu okna dialogowego. 

D Wyświetla arkusze do opublikowania z 
ustawieniami każdego arkusza. 

E Wyświetla szczegóły dotyczące aktualnie wybranego arkusza. 

F Kliknij, aby ustawić opcje publikowania do DWF/DWFx. 

G Kliknij, aby zmienić ustawienia strony dla 
aktualnie wybranego arkusza. 

H Wyświetla szczegóły dotyczące aktualnie 
wybranych ustawień DWF/ DWFx. 
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Automatyczne publikowanie 

Rysunki mogą być automatycznie publikowane za każdym razem, gdy są 

zapisywane lub zamykane, z monitem lub bez. Podczas automatycznego 

publikowania, pliki .dwf, dwfx lub .pdf są zapisywane zgodnie z predefiniowanymi 

opcjami określonymi przez użytkownika. Domyślnie automatyczne publikowanie 

jest wyłączone, więc nie zapomnij go włączyć po skonfigurowaniu. 
 

Aby skonfigurować automatyczne publikowanie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Auto Publish (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz polecenie 

Publikuj > Automatycznie publikuj. 

• W menu wybierz polecenie Plik > Automatyczne publikowanie. 

• Wpisz autopublish i naciśnij Enter. 

2 Wybierz opcje. 

3 Dokonaj wyboru, a następnie kliknij przycisk OK. 

4 Aby opublikować, na przykład testowo, nowe ustawienia, naciśnij Enter. Aby nie 

publikować, naciśnij Esc. 
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B 
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A Wybierz, kiedy ma nastąpić automatyczna 
publikacja: po zapisaniu lub zamknięciu pliku oraz 
z monitem lub bez. 

B Wybierz, czy opublikowane pliki mają być 
zapisywane w tym samym folderze co rysunek, 
w podfolderze folderu rysunku, czy w innym 
folderze. 

C Wybierz folder, w którym chcesz zapisać 
opublikowane pliki. (Opcja dostępna tylko wtedy, 
gdy w polu Lokalizacja wybrano opcję 
Lokalizacja użytkownika). 

D Wybierz, czy model, układy bez modelu i 
układy mają zostać opublikowane. 

E Wybierz, czy rysunek ma zostać opublikowany w formacie .dwf, 
.dwfx lub .pdf. 

F Wybierz, czy chcesz opublikować wszystkie 
arkusze w jednym pliku, czy każdy arkusz w 
osobnym pliku. 

G Wybierz, czy chcesz dołączyć informacje o warstwie. 

H Wybierz, czy nakładające się linie mają 
obejmować tylko ostatnią linię, czy też mają być 
łączone. 
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Aby włączyć automatyczne publikowanie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 W polu Domyślne urządzenie wyjściowe wybierz drukarkę, która zostanie przypisana do 

nowych rysunków. 

3 Po zakończeniu kliknij przycisk OK. 
 

4 

5 Wpisz automaticpub i naciśnij Enter. 

6 Wpisz 1, a następnie naciśnij Enter. 
 

Wyłącz automatyczne publikowanie za pomocą tej samej zmiennej systemowej 
AUTOMATICPUB. 

Ustaw AUTOMATICPUB na 0, aby wyłączyć automatyczne publikowanie. 
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Rysunki papierowe zazwyczaj przedstawiają dwuwymiarowe widoki 

trójwymiarowych obiektów. Dzięki ALCAD można tworzyć trójwymiarowe 

modele trójwymiarowych obiektów. 

W tej sekcji wyjaśniono, jak 

• Wyświetlanie podmiotów w trzech wymiarach. 

• Tworzenie trójwymiarowych jednostek. 

• Edycja podmiotów w przestrzeni trójwymiarowej. 

• Edycja trójwymiarowych brył. 

• Wyświetlanie ukrytych linii, cieniowanych i renderowanych widoków obiektów 

trójwymiarowych. 

Narzędzia i polecenia dla wielu funkcji opisanych w tej sekcji pojawiają się 

odpowiednio na pasku narzędzi Rysuj 3D i w menu Wstaw po ustawieniu programu 

na poziom zaawansowany. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tematy w tym rozdziale 

Wyświetlanie jednostek w trzech wymiarach  ................................................... 576 

Tworzenie jednostek trójwymiarowych  ............................................................ 586 

Edycja w trzech wymiarach  ............................................................................. 622 

Edycja trójwymiarowych brył  ........................................................................... 629 

Ukrywanie, cieniowanie i renderowanie  .......................................................... 640 

15  
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Wyświetlanie jednostek w trzech wymiarach 
 

Rysunek ALCAD można przeglądać z dowolnej pozycji w przestrzeni 

trójwymiarowej. Z dowolnej wybranej pozycji wyświetlania można dodawać nowe 

elementy i modyfikować istniejące. Możesz także generować widoki ukrytych linii i 

cieni z dowolnej pozycji. 

Rysunki trójwymiarowe są wyświetlane po ustawieniu kierunku wyświetlania. Kierunek 

wyświetlania określa pozycję wyświetlania, współrzędną kartezjańską 

odpowiadającą punktowi widzenia patrzącemu wstecz na punkt początkowy, 

współrzędną 0,0,0. Gdy rysunek jest wyświetlany z domyślnego punktu widzenia 

(0,0,1), widoczny jest jego widok z góry. 

 

Przełączanie na zaprogramowany kierunek wyświetlania 

Korzystając ze wstępnie ustawionych widoków, można szybko zmienić kierunek 

wyświetlania, aby spojrzeć na rysunek z innego punktu widzenia lub pracować nad 

trójwymiarowym modelem z innej orientacji. 
 

Aby przełączyć na zaprogramowany kierunek wyświetlania 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce przejdź do obszaru Widoki na karcie Widok. 

• W menu wybierz Widok > Widoki 3D. 

• Przejdź do paska narzędzi Widok. 

• Widok typu. 

2 Wybierz lub wpisz nazwę jednego z poniższych elementów: 

• Góra, przód, prawa strona, lewa strona, tył, dół 

• Antena, lewy przód; antena, prawy przód; antena, prawy tył; antena, lewy tył 

• Poniżej, lewy przód; Poniżej, prawy przód; Poniżej, prawy tył; Poniżej, lewy tył 

Aby przełączyć się na zaprogramowany kierunek wyświetlania za pomocą polecenia 
Preset Viewpoints 

1 Wykonaj jedną z poniższych czynności, aby wybrać zaprogramowane punkty widzenia (  

): 

• Na wstążce wybierz polecenie Widok > Wstępnie ustawione punkty widzenia (w 

obszarze Widoki). 

• W menu wybierz Widok > Wstępnie ustawione punkty widzenia. 

• Na pasku narzędzi Widok kliknij narzędzie Wstępnie ustawione punkty widzenia. 

• Wpisz setvpoint i naciśnij Enter. 

2 Kliknij wstępnie ustawiony widok, którego chcesz użyć. 
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A Kliknij, aby wybrać izometryczny punkt widzenia. B Kliknij, aby wybrać ortograficzny punkt widzenia. 

 

Tworzenie i przełączanie na widoki nazwane 

Podczas pracy nad rysunkiem może się okazać, że często przełączasz się między 

różnymi jego częściami. Na przykład, jeśli rysujesz plan piętra domu, możesz 

powiększyć poszczególne pokoje w domu, a następnie pomniejszyć, aby wyświetlić 

cały dom. Chociaż w tym celu można powtarzać polecenia przesuwania i 

powiększania, znacznie łatwiej jest zapisać różne widoki rysunku. Następnie można 

szybko przełączać się między tymi widokami. 

Te niestandardowe widoki, które tworzysz, zwane widokami nazwanymi, mogą 

kontrolować więcej ustawień niż tylko kierunek i lokalizację widoku - mogą 

również obejmować styl wizualny, UCS, tło, perspektywę i długość obiektywu, 

przycinanie itp. 

 

Tworzenie widoku nazwanego 

Nazwane widoki mogą być zapisywane i wyświetlane w bieżącym oknie. 
 

Aby utworzyć nazwany widok dla bieżącego widoku na rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• Wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• W elemencie Widok Eksploratora ALCAD kliknij narzędzie Menedżer widoków. 

• Wpisz view i naciśnij Enter. 

2 Kliknij przycisk Nowy. 

3 W polu Nazwa wpisz nazwę widoku. 
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4 Wybierz żądane opcje. Jeśli zmiany mają być widoczne bezpośrednio na rysunku, 

zaznacz opcję Aktualizuj wyświetlanie rysunku. 

5 Po zakończeniu kliknij przycisk OK. 

 

 
 

 

 

 

 

 

 

 
A 

 
 
 

 
B 
C 

D 

E 

F 

 

 
A Wyświetla bieżący widok, widoki modelu (nazwane 

widoki i kamery) oraz widoki wstępnie ustawione. 

B Wprowadź współrzędne x, y i z lokalizacji 
docelowej wybranego widoku, względem której 
widok jest zorientowany. 

C Zaznaczanie danych na wyświetlaczu 
automatycznie po zmianie ustawień. 

D Kliknij, aby utworzyć nowy widok. 

E Kliknij, aby usunąć wybrany widok. 

F Kliknij, aby wybrać granice widoku bezpośrednio 
na rysunku. 

G Wprowadź przednią i tylną odległość płaszczyzn 
przycinania wybranego widoku lub przesuń 
suwak. Dostępne tylko wtedy, gdy funkcja 
przycinania jest włączona przy odpowiednim 
ustawieniu. 

H Wprowadź długość obiektywu (w milimetrach) 
wybranego widoku lub przesuń suwak. 
Dostępne tylko po włączeniu opcji 
Perspektywa. 

I Wprowadź kąt skręcenia dla wybranego widoku. 

S 
R 

Q 

P 

O 

N 
M 

L 

K 

J 

I 

H 

 
 

G 

 
 
 
 

J Wprowadź wysokość wybranego widoku. 

K Wprowadź szerokość wybranego widoku. 

L Wprowadź współrzędne x i y punktu 
środkowego wybranego widoku. 

M Wprowadź współrzędne x, y i z położenia 
kamery wybranego widoku, z którego widok 
jest zorientowany. 

N Wybierz układ współrzędnych użytkownika dla 
wybranego widoku. 

O Wybierz lokalizację przycinania granic 
wybranego widoku. 

P Wybierz opcjęOff(ortograficzny) 
lubOn(perspektywa) dla wybranego widoku. 
(Następnie określ długość obiektywu). 

Q Wybierz tło dla wybranego widoku. R 

Wybierz styl wizualny dla wybranego 

widoku. S Wprowadź nową nazwę dla 

wybranego widoku. 
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Aby utworzyć nazwany widok dla części bieżącego widoku na rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• Wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• W elemencie Widok Eksploratora ALCAD kliknij narzędzie Menedżer widoków. 

• Wpisz view i naciśnij Enter. 

2 Kliknij przycisk Nowy. 

3 W polu Nazwa wpisz nazwę widoku. 

4 Wprowadź dodatkowe zmiany w widoku. Jeśli chcesz zobaczyć zmiany 

bezpośrednio na rysunku, zaznacz opcję Aktualizuj wyświetlanie rysunku. 

5 Po zakończeniu kliknij przycisk OK. 
 

Aby utworzyć nazwany widok z istniejącego widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• Wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• W elemencie Widok Eksploratora ALCAD kliknij narzędzie Menedżer widoków. 

• Wpisz view i naciśnij Enter. 

2 Z listy widoków wybierz widok z ustawieniami, których chcesz użyć jako 

podstawy dla nowego widoku. 

3 Kliknij przycisk Nowy. 

4 W polu Nazwa wpisz nazwę nowego widoku. 

5 Wprowadź dodatkowe zmiany w widoku. Jeśli chcesz zobaczyć zmiany 

bezpośrednio na rysunku, zaznacz opcję Aktualizuj wyświetlanie rysunku. 

6 Po zakończeniu kliknij przycisk OK. 

 

View Manager nie jest poleceniem transparentnym. 

Na przykład nie można używać Menedżera widoku podczas poleceń Ustaw punkty 

widzenia lub Zdefiniuj widok, a także podczas powiększania lub przesuwania 

rysunku. 
 

 
Ustawianie tła dla nazwanego widoku 
Dla każdego utworzonego nazwanego widoku można przypisać tło w jednolitym 

kolorze, gradient lub obraz. Przy każdym przełączeniu do tego widoku wyświetlane 

jest tło, jeśli widok ma również przypisany dowolny styl wizualny inny niż 2D 

Wireframe. 



580 C H A P T E R 1 5 

 

Aby ustawić tło dla nazwanego widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• W menu wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• Wpisz view i naciśnij Enter. 

• W elemencie Widok Eksploratora ALCAD kliknij narzędzie Menedżer widoków. 

2 Wybierz widok modelu, dla którego chcesz ustawić tło. 

3 W obszarze Styl wizualny wybierz opcję Koncepcyjny, Ukryty lub Realistyczny. 

4 W tle wybierz jedną z poniższych opcji: 

• Solidny 

• Gradient 

• Obraz 

5 W oknie dialogowym Tło dokonaj wyboru. Kliknij [?], aby wyświetlić 

szczegółowe informacje na temat każdej opcji. 

6 Kliknij przycisk OK. 
 

Polecenie Tło służy do ustawiania tła dla bieżącego widoku. 

Aby określić jednolity kolor, gradient lub tło obrazu dla bieżącego widoku, wpisz 

tło i dokonaj wyboru. 
 

 
Przełączanie do widoku nazwanego 
Po zapisaniu jednego lub więcej nazwanych widoków można przywrócić dowolny 

z tych widoków w bieżącym oknie za pomocą polecenia Widok lub Eksploratora 

ALCAD. 
 

Aby przełączyć na widok nazwany 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• W menu wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• Wpisz view i naciśnij Enter. 

2 Wybierz widok, na który chcesz się przełączyć. 

3 Kliknij przycisk OK. 
 

Możesz także przełączać się między nazwanymi widokami za pomocą ALCAD Explorer. 

Wybierz Narzędzia > Eksploruj widoki (w Eksploratorze), a następnie kliknij 

dwukrotnie żądany widok. 
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Modyfikowanie nazwanych widoków 
Po utworzeniu widoku nazwanego można zmodyfikować dowolne jego ustawienia 

lub po prostu dostosować go podczas wprowadzania zmian. Tylko utworzone 

widoki nazwane mogą być zmieniane; widoki predefiniowane nie mogą być 

modyfikowane. 

Aby zmienić ustawienia nazwanego widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• Wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• W elemencie Widok Eksploratora ALCAD kliknij narzędzie Menedżer widoków. 

• Wpisz view i naciśnij Enter. 

2 Aby zobaczyć wprowadzone zmiany bezpośrednio na rysunku, zaznacz 

opcję Aktualizuj wyświetlanie rysunku. 

3 Zmień żądane ustawienia. 

4 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie punktu widzenia 

Można dynamicznie obracać punkt widzenia w płaszczyźnie xy i względem 

płaszczyzny xy, a także przesuwać i powiększać rysunek. Podczas zmiany ustawień 

punktu widzenia wyświetlany rysunek jest automatycznie aktualizowany. 
 

Aby dynamicznie ustawić kierunek widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Dynamic View Control (  ): 

• Na wstążce wybierz polecenie Widok > Dynamiczna kontrola widoku (w obszarze 

Widoki). 

• W menu wybierz Widok > Dynamiczna kontrola widoku. 

• Na pasku narzędzi Widok kliknij narzędzie Dynamiczna kontrola widoku. 

• Wpisz viewctl i naciśnij Enter. 

2 Dokonaj wyboru, aby zmienić punkt widzenia. 

3 Aby zakończyć polecenie, kliknij przycisk OK. 
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A Wybierz, czy kierunek wyświetlania ma być 
względem światowego układu 
współrzędnych, czy układu współrzędnych 
użytkownika. 

B Wyświetla bieżące ustawienia kierunku 
wyświetlania. 

Kliknij, aby wybrać nowy kierunek 
wyświetlania. 

C Wprowadź kąt względem osi x. 

D Kliknij, aby ustawić kierunek wyświetlania na 
widok planu. 

E Wprowadź kąt względem płaszczyzny xy. 

F Kliknij, aby otworzyć okno dialogowe 
Wstępnie ustawione punkty widzenia i 
ustawić kierunek wyświetlania przy użyciu 
wstępnie zdefiniowanych ustawień. 

G Kliknij okno dialogoweViewControl i ustaw 
kierunek wyświetlania interaktywnie z 
rysunkiem. 

H Wskazuje bieżący punkt widzenia. 

Aby interaktywnie ustawić kierunek widoku na rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Dynamic View Control (  ): 

• Na wstążce wybierz polecenie Widok > Dynamiczna kontrola widoku (w obszarze 

Widoki). 

• W menu wybierz Widok > Dynamiczna kontrola widoku. 

• Na pasku narzędzi Widok kliknij narzędzie Dynamiczna kontrola widoku. 

• Wpisz viewctl i naciśnij Enter. 

2 Kliknij przycisk Dostosuj. 

3 Dokonaj wyboru, aby zmienić kierunek wyświetlania 3D na rysunku. 

4 Kliknij przycisk OK. 

5 Aby zakończyć polecenie, kliknij przycisk OK. 
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A Wskazuje bieżący punkt 
widzenia. 

B Kliknij, aby przesunąć 
rysunek. 

C Kliknij, aby powiększyć 
zakres. 

D Kliknij, aby pomniejszyć. 

E Kliknij, aby powiększyć. 

F Pokazuje bieżącą orientację punktu widzenia. 

G Kliknij, aby obrócić widok wokół predefiniowanej osi. 

H Wpisz lub wybierz przyrost kąta obrotu. 

 

 

Używanie kamery do wyświetlania rysunku 

Kamery definiują ustawienia dla widoków 3D rysunków zgodnie z lokalizacją i 

celem. Można także określić wysokość kamery, granice przycinania widoku i inne 

opcje. 

Aby zmodyfikować kamerę, wybierz ją na rysunku i przesuń jej uchwyty lub zmień 

jej właściwości w panelu Właściwości. Kamery są nazwanymi widokami, które można 

również zmieniać za pomocą Menedżera widoków. Więcej informacji na temat 

panelu Właściwości znajduje się w sekcji "Modyfikowanie właściwości elementów" 

na stronie 343. Więcej informacji na temat Menedżera widoku można znaleźć w 

sekcji "Praca z nazwanymi widokami" na stronie 284. 
 

Aby utworzyć kamerę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Utwórz kamerę (  ): 

• Na wstążce wybierz polecenie Widok > Utwórz kamerę (w widoku). 

• W menu wybierz Widok > Utwórz kamerę. 

• Na pasku narzędzi Widok kliknij narzędzie Utwórz kamerę. 

• Wpisz camera i naciśnij Enter. 

2 Określ lokalizację kamery. 

3 Określ punkt docelowy widoku. 
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4 Wybierz jedną z poniższych opcji, aby określić więcej opcji: 

• Nazwa Wprowadź nową nazwę kamery, a następnie naciśnij przycisk Enter. 

• Lokalizacja Określ nową lokalizację kamery, a następnie naciśnij przycisk Enter. 

• Wysokość Określ wysokość kamery, a następnie naciśnij przycisk Enter. 

• Target Określ nowy punkt docelowy dla widoku z kamery, a następnie 

naciśnij przycisk Enter. Lokalizacją docelową jest środek widoku. 

• Obiektyw Wprowadź długość obiektywu. Im większa wartość, tym węższy 

widok. Wartość musi wynosić 600 lub mniej milimetrów. 

• Przycinanie Istnieją dwie płaszczyzny przycinania, które pomagają 

zdefiniować widok. Wszystko pomiędzy kamerą a przednią płaszczyzną 

przycinania jest ukryte, a wszystko pomiędzy tylną płaszczyzną przycinania a 

celem jest ukryte. Wybierz opcję Tak, aby określić przednią (lub tylną) 

płaszczyznę przycinania, wprowadź odległość, a następnie naciśnij klawisz 

Enter. Wybierz opcję Nie, aby wyłączyć płaszczyznę przycinania. 

• Widok Wybierz Tak, aby przełączyć bieżący widok na ustawienia kamery 

po jej utworzeniu. Wybierz opcję Nie, aby bieżący widok pozostał taki 

sam po utworzeniu kamery. 

5 Po zakończeniu naciśnij klawisz Enter. 
 

Aby przełączyć na widok z kamery 

1 Wykonaj jedną z poniższych czynności, aby wybrać View Manager (  ): 

• Na wstążce wybierz polecenie Widok > Menedżer widoków (w obszarze Widoki). 

• W menu wybierz Widok > Menedżer widoków. 

• Na pasku narzędzi Widok kliknij narzędzie Menedżer widoku. 

• Wpisz view i naciśnij Enter. 

2 Wybierz widok z kamery. 

3 Kliknij przycisk OK. 
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Wyświetlanie widoku planu bieżącego rysunku 

Bieżący kierunek wyświetlania można ustawić na widok planu bieżącego układu 

współrzędnych użytkownika (UCS), wcześniej zapisanego układu UCS lub światowego 

układu współrzędnych (WCS). 
 

Aby wyświetlić widok planu bieżącego rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać widok planu (  ): 

• Na wstążce wybierz polecenie Widok > Widok planu (w obszarze Widoki). 

• W menu wybierz Widok > Widok planu. 

• Na pasku narzędzi Widok kliknij narzędzie Widok planu. 

• Wpisz plan, a następnie naciśnij Enter. 

2 W oknie zachęty wybierz jedną z poniższych opcji: 

• Current wyświetla widok planu bieżącego systemu UCS. 

• UCS wyświetla widok planu zapisanego układu UCS. Program wyświetli 

monit o podanie nazwy układu UCS. 

• World wyświetla widok planu WCS. 
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Tworzenie trójwymiarowych jednostek 
 

ALCAD obsługuje następujące typy modeli trójwymiarowych: 

• Modele szkieletowe, które składają się z linii i krzywych definiujących 

krawędzie trójwymiarowej jednostki. Model szkieletowy można utworzyć, 

rysując linie, łuki, polilinie i inne dwuwymiarowe obiekty w dowolnym miejscu 

w przestrzeni trójwymiarowej. Modele szkieletowe nie mają powierzchni; 

zawsze pojawiają się jako kontury. Ze względu na konieczność indywidualnego 

rysowania i pozycjonowania każdej jednostki tworzącej model szkieletowy, jego 

tworzenie może być wymagające i czasochłonne. 

• Modele powierzchniowe, które składają się zarówno z krawędzi, jak i 

powierzchni między tymi krawędziami. Model powierzchniowy można utworzyć 

poprzez zastosowanie wysokości i grubości do dwuwymiarowych elementów 

płaskich lub za pomocą określonych poleceń tworzenia elementów 

trójwymiarowych. Modele powierzchniowe składają się z pojedynczych 

płaszczyzn tworzących fasetową, wielokątną siatkę. 

• Siatki modelu fasetowego, które są inteligentnymi jednostkami modelu 

powierzchni, które można łączyć w siatki kompozytowe i renderować bardziej 

jak bryły. 

• Bryły 3D, które są trójwymiarowymi jednostkami ACIS składającymi się z 

powierzchni i krawędzi. Bryły 3D wydają się mieć objętość i są łatwiejsze w 

obróbce niż modele szkieletowe i powierzchniowe. ALCAD obsługuje 

przeglądanie i ograniczoną edycję brył 3D, w tym przenoszenie, obracanie i 

skalowanie. Dodatkowo, niektóre wersje ALCAD pozwalają na tworzenie i 

pełniejszą edycję brył 3D. 

 

Zastosowanie wysokości i grubości 

Domyślnie program tworzy nowe dwuwymiarowe obiekty z zerową wysokością i 

grubością. Najprostszym sposobem na utworzenie trójwymiarowej jednostki jest 

zmiana właściwości wysokości lub grubości istniejącej dwuwymiarowej jednostki. 

Wysokość encji to jej pozycja współrzędnej z w stosunku do płaszczyzny xy, na 

której encja jest rysowana. Wysokość 0 wskazuje, że encja jest rysowana na 

płaszczyźnie xy bieżącego UCS. Dodatnie elewacje znajdują się powyżej tej 

płaszczyzny; ujemne elewacje znajdują się poniżej niej. 
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Grubość jednostki to odległość, na jaką jest ona wyciągnięta powyżej lub poniżej 

swojej wysokości. Grubość dodatnia powoduje wyciągnięcie bryły w górę w dodatnim kierunku z bryły; 

grubość ujemna powoduje jej wyciągnięcie w dół w ujemnym kierunku z. Grubość 

jest stosowana równomiernie do całej bryły. Dowolną dwuwymiarową bryłę można 

przekształcić w bryłę trójwymiarową, zmieniając grubość bryły na wartość 

niezerową. Na przykład, okrąg staje się cylindrem, linia staje się trójwymiarową 

płaszczyzną, a prostokąt staje się pudełkiem. 
 

P o d m i o t y  dwuwymiarowe. Podmioty dwuwymiarowe z dodaną grubością. 
 

Jednostki trójwymiarowe można tworzyć przy użyciu dowolnej z poniższych metod: 

• Rysowanie dwuwymiarowych obiektów w trójwymiarowej przestrzeni. 

• Konwertuje dwuwymiarowe obiekty płaskie na trójwymiarowe poprzez zastosowanie 

wysokości i grubości. 

• Przekształca dwuwymiarowe obiekty płaskie w trójwymiarowe poprzez obracanie lub 

wytłaczanie. 

• Tworzenie trójwymiarowych obiektów, takich jak pudełka, cylindry, stożki, 

kopuły, kule i kliny. 

 

Trójwymiarowe bryły są rysowane jako prawdziwe bryły w wersjach programu ALCAD 

obsługujących trójwymiarowe bryły ACIS. 

Trójwymiarowe bryły, które można tworzyć to: pudełko, stożek, cylinder, talerz, 

kopuła, piramida, kula, torus i klin. 
 

Można zmienić domyślne wartości wysokości i grubości, aby utworzyć nowe 

jednostki z już zastosowaną wysokością i grubością. 
 

Aby ustawić bieżącą wysokość 

1 Wykonaj jedną z poniższych czynności, aby wybrać Elevation (  ): 

• Na wstążce wybierz Rysuj > Elewacja (w Ustawieniach). 

• W menu wybierz Format > Elevation. 

• Na pasku narzędzi Format kliknij narzędzie Elewacja. 

• Wpisz elev i naciśnij Enter. 

2 Określ nową bieżącą wartość wysokości, a następnie naciśnij klawisz Enter. 
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Aby ustawić bieżącą grubość 

1 Wykonaj jedną z poniższych czynności, aby wybrać Grubość (  ): 

• Na wstążce wybierz Rysuj > Grubość (w Ustawieniach). 

• W menu wybierz Format > Grubość. 

• Na pasku narzędzi Format kliknij narzędzie Grubość. 

• Wpisz grubość i naciśnij Enter. 

2 Określ nową bieżącą wartość grubości, a następnie naciśnij klawisz Enter. 
 

Aby ustawić bieżącą wysokość i grubość za pomocą okna dialogowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia rysowania (  ): 

• Na wstążce wybierz przycisk Aplikacja > Narzędzia do rysowania; Strona 

główna > Ustawienia rysowania (w Narzędziach); lub Narzędzia > 

Ustawienia rysowania (w Zarządzaniu). 

• W menu wybierz Narzędzia > Ustawienia rysowania. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Ustawienia rysowania. 

• Wpisz dsettings i naciśnij Enter. 

2 Kliknij kartę Ustawienia 3D. 

3 Kliknij kartę Powierzchnie. 

4 Aby zmienić bieżącą grubość, w polu Bieżąca grubość 3D wpisz nową 

wartość grubości lub kliknij strzałki, aby wybrać nową grubość. 

5 Aby zmienić bieżącą wysokość, w polu Current 3D Elevation wpisz nową 

wartość wysokości lub kliknij strzałki, aby wybrać nową wysokość. 

6 Kliknij przycisk OK. 
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A Wpisz lub wybierz bieżącą grubość 
trójwymiarową. 

B Wpisz lub wybierz bieżącą trójwymiarową wysokość. 

 
 

Aby zmienić grubość i wysokość istniejącej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Właściwości (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Modyfikuj > Właściwości. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Właściwości. 

• Wpisz entprop i naciśnij Enter. 

2 Wybierz podmiot, a następnie naciśnij klawisz Enter. 

ALCAD wyświetla paletę Właściwości (jej dokładny wygląd zależy od typu 

wybranej jednostki). 

3 Aby zmienić grubość, w polu Grubość wpisz nową wartość grubości lub kliknij 

strzałki, aby wybrać nową grubość. 

4 Aby zmienić wysokość, w polu współrzędnych Z (lub w niektórych jednostkach 

w polu wysokości) wpisz nową wartość wysokości lub kliknij strzałki, aby wybrać 

nowy element. 

5 Kliknij przycisk OK. 
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Zmiana grubości jednostki nie powoduje zmiany jej typu. 

W celu wyciągnięcia bryły i przekonwertowania jej na bryłę trójwymiarową należy 

użyć polecenia Wyciągnięcie. Jeśli chcesz pogrubić powierzchnię lub element siatki i 

przekonwertować go na trójwymiarową bryłę, użyj polecenia Pogrubienie. 
 

 

 

 

 

 

 

 

 

 

 
A 

 

 
B 

 
 
 
 
 

A Wpisz lub wybierz nową grubość. B Wpisz lub wybierz nową wysokość. 
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Tworzenie trójwymiarowych twarzy 

Można utworzyć trójwymiarową powierzchnię, która składa się z przekroju 

płaszczyzny w przestrzeni trójwymiarowej. Trójwymiarową ścianę definiuje się 

poprzez określenie współrzędnych x,y,z trzech lub więcej narożników. Po 

określeniu czwartego punktu, program kontynuuje monitowanie o dodatkowe 

powierzchnie, naprzemiennie prosząc o trzeci i czwarty punkt, aby umożliwić 

zbudowanie złożonej trójwymiarowej bryły. Każda trój- lub czterostronna 

płaszczyzna jest tworzona jako oddzielna trójwymiarowa bryła. 
 

Aby utworzyć trójwymiarową twarz 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Twarz ( ): 

• Na wstążce wybierz Rysuj 3D > Twarz 3D (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Twarz. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Twarz. 

• Wpisz face i naciśnij Enter. 

2 Określa pierwszy punkt trójwymiarowej powierzchni. 

3 Określ drugi, trzeci i czwarty punkt. 

4 Określ trzeci i czwarty punkt dla dodatkowych powierzchni. 

5 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 

Każda lub wszystkie krawędzie trójwymiarowej powierzchni mogą być niewidoczne, 

aby umożliwić dokładniejsze modelowanie jednostek z otworami. 

Gdy program wyświetli monit o punkty narożne, w oknie zachęty wybierz Invisi- 

ble Edge, aby następna krawędź była niewidoczna. Lub po narysowaniu powierzchni 

3D użyj polecenia Krawędź. Szczegółowe informacje na temat polecenia Krawędź, 

 

Przykład trójwymiarowego modelu utworzonego przy użyciu trójwymiarowych powierzchni. 



592 C H A P T E R 1 5 

 

Tworzenie siatek prostokątnych 

Można utworzyć trójwymiarową prostokątną siatkę składającą się z czterobocznych 

wielokątów. Rozmiar siatki określa się, podając liczbę wierzchołków wzdłuż 

głównej (kierunek M) i pomocniczej (kierunek N) osi siatki, a następnie podając 

współrzędne każdego wierzchołka. 
 

Aby utworzyć prostokątną siatkę 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Mesh (  ): 

• Na wstążce wybierz Rysuj 3D > Siatki (w oknie Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Siatka. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Siatka. 

• Wpisz mesh i naciśnij Enter. 

2 Określa liczbę wierzchołków wzdłuż głównej osi siatki. 

3 Określa liczbę wierzchołków wzdłuż dodatkowej osi siatki. 

4 Określ współrzędne dla każdego wierzchołka. 

Określenie współrzędnych ostatniego wierzchołka kończy tworzenie siatki i 

kończy polecenie. 
 

Chociaż ręczne tworzenie prostokątnych siatek może być wymagające, są one przydatne do 

reprezentowania złożonych powierzchni, takich jak trójwymiarowe modele terenu. 

Narzędzie Mesh jest najbardziej przydatne w połączeniu ze skryptami lub programami LISP, 
które 

matematycznie obliczyć współrzędne wierzchołków. 
 

 

Przykład trójwymiarowego modelu terenu utworzonego przy użyciu prostokątnych siatek. 
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Tworzenie siatek poliface 

Można utworzyć siatkę wielokąta składającą się ze ścian łączących trzy lub więcej 

wierzchołków. Najpierw należy określić współrzędne każdego wierzchołka, a 

następnie zdefiniować każdą ścianę, wprowadzając numery wierzchołków dla wszystkich 

wierzchołków tej ściany. Podczas tworzenia każdej ściany można kontrolować 

widoczność i kolor każdej krawędzi oraz przypisać każdą krawędź do określonych 

warstw. 
 

Aby utworzyć siatkę powierzchni 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polyface Mesh (  ): 

• Na wstążce wybierz polecenie Draw 3D > Polyface Mesh (w oknie Draw 3D Meshes). 

• W menu wybierz polecenie Draw > 3D Meshes > Polyface Mesh. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Siatka polifazowa. 

• Wpisz pface, a następnie naciśnij Enter. 

2 Określ współrzędne każdego wierzchołka. 

Po każdym określonym wierzchołku wyświetlany jest kolejny numer 

wierzchołka i wyświetlany jest monit o podanie współrzędnych wierzchołka. Podaj 

współrzędne, a następnie naciśnij klawisz Enter. Kontynuuj podawanie 

współrzędnych dla każdego ponumerowanego wierzchołka. 

3 Aby zakończyć określanie współrzędnych wierzchołków, naciśnij Enter. 

4 Określa numery wierzchołków definiujących pierwszą ścianę. 

Ścianę określa się, wprowadzając numery wierzchołków, które zostały 

zdefiniowane podczas określania współrzędnych w kroku 2. Każda ściana może 

składać się z trzech lub więcej ponumerowanych wierzchołków. 

5 Aby zakończyć definiowanie pierwszej twarzy, naciśnij Enter. 

6 Określ następną ścianę, wprowadzając numery jej wierzchołków. 

7 Aby zakończyć polecenie, naciśnij klawisz Enter. 

 

Krawędzie mogą być niewidoczne. 

Wpisz numer wierzchołka jako wartość ujemną. 
 

 
Tworzenie siatek powierzchni rządzonych 

Można utworzyć powierzchnię rządzoną, która jest trójwymiarową siatką 

wielokątów przybliżającą powierzchnię między dwoma istniejącymi obiektami. W 

tym celu należy wybrać dwie jednostki, które definiują tworzoną powierzchnię. 

Elementy te mogą być łukami, okręgami, liniami, punktami lub poliliniami. 
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Aby utworzyć siatkę powierzchni rządzonej 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Ruled Surface (  ): 

• Na wstążce wybierz polecenie Draw 3D > Ruled Surface (w oknie Draw 3D Meshes). 

• W menu wybierz Rysuj > Siatki 3D > Powierzchnia liniowa. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Powierzchnia regularna. 

• Wpisz rulesurf i naciśnij Enter. 

2 Wybierz pierwszą definiującą jednostkę. 

3 Wybierz drugą definiującą jednostkę. 
 

Wybierz pierwszy (A) i drugi (B) element definiujący. Wynikowa siatka powierzchni rządzonej. 
 

Wartość Number of M-Direction Surfaces kontroluje gęstość siatki. Wybierz kolejno 

Narzędzia > Ustawienia rysowania, kliknij kartę Ustawienia 3D. Kliknij kartę 

Powierzchnie, a następnie w sekcji Ustawienia powierzchni zmień wartość Liczba 

powierzchni M-kierunkowych. 
 

 
Tworzenie siatek wytłaczanych 

Można utworzyć siatkę wytłaczaną, która jest trójwymiarową siatką wielokątów, 

która przybliża powierzchnię wygenerowaną przez wytłaczanie krzywej ścieżki 

wzdłuż wektora kierunku. Wybierane są dwa elementy, które definiują krzywą 

ścieżki i wektor kierunku. Długość wektora kierunku określa odległość, na jaką 

krzywa ścieżki jest przesuwana wzdłuż wektora kierunku. Elementem wyciągniętym 

może być łuk, okrąg, linia lub polilinia. Jako wektor kierunku można wybrać linię 

lub otwartą polilinię. Wynikowa siatka składa się z szeregu równoległych 

wielokątnych płaszczyzn biegnących wzdłuż określonej ścieżki. 

Można tworzyć dwa rodzaje siatek wytłaczanych: 

• Siatki modelu fasetowego to inteligentne siatki, które można modyfikować za 

pomocą zaawansowanych funkcji, takich jak operacje boole'owskie. Są one 

podobne do brył, ale są lżejsze i nie mają właściwości masy. 

• Siatki powierzchniowe są siatkami prostymi. 
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Aby utworzyć wytłaczaną siatkę modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extrude (  ): 

• Na wstążce wybierz Draw 3D > Extrude (w Facet Model Meshes). 

• Z menu wybierz Rysuj > Siatki modelu fasety > Wytłaczane. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Extrude. 

• Wpisz fmextrude i naciśnij Enter. 

2 Wybierz jednostkę do wyciągnięcia. 

3 Wybierz ścieżkę wytłaczania, określ kierunek lub wysokość. 
 

Aby utworzyć siatkę wytłaczanej powierzchni 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extruded Surface (  ): 

• Na wstążce wybierz polecenie Draw 3D > Extruded Surface (w oknie Draw 3D Meshes). 

• W menu wybierz polecenie Draw > 3D Meshes > Extruded Surface. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Wyciągnięta powierzchnia. 

• Wpisz ai_tabsurf i naciśnij Enter. 

2 Wybierz jednostkę do wyciągnięcia. 

3 Wybierz ścieżkę wytłaczania. 
 

 
Wybierz jednostkę do wyciągnięcia (A) i 
wytłoczenie 
ścieżka (B). 

Wynikowy wytłaczany 
siatka powierzchniowa. 

 
 

 

Wartość Liczba powierzchni M-kierunkowych kontroluje gęstość siatki. Wybierz 

kolejno Narzędzia > Ustawienia rysowania, kliknij kartę Ustawienia 3D, kliknij 

kartę Powierzchnie, a następnie w sekcji Ustawienia powierzchni zmień wartość 

Liczba powierzchni M-kierunkowych. 

 
Wytłaczana siatka różni się od wytłaczanej bryły. 

W celu wyciągnięcia bryły i przekonwertowania jej na bryłę trójwymiarową 

należy użyć polecenia Wyciągnięcie. 
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Tworzenie siatek obrotowych 

Można utworzyć siatkę obrotową, która jest trójwymiarową siatką wielokątów, która 

przybliża powierzchnię generowaną przez obracanie dwuwymiarowego profilu 

wokół osi. Użytkownik wybiera dwie jednostki, które definiują profil i oś. Określany 

jest również kąt początkowy i liczba stopni obrotu profilu. 

Obrócenie profilu o 360 stopni tworzy zamkniętą trójwymiarową siatkę. 

Można tworzyć dwa rodzaje siatek obrotowych: 

• Siatki modelu fasetowego to inteligentne siatki, które można modyfikować za pomocą 

zaawansowanych funkcji 

takich jak operacje logiczne. Są podobne do ciał stałych, ale są lżejsze i nie 

mają właściwości masy. 

• Siatki powierzchni są siatkami prostymi. Zwróć uwagę, że wartość Number Of 

M-Direction Sur- faces określa gęstość siatki (liczbę segmentów siatki) w kierunku M 

(wokół osi obrotu). Wartość N-Direction Mesh Density określa gęstość siatki 

(liczbę segmentów siatki) w kierunku N (wzdłuż osi obrotu). 

Aby utworzyć obrotową siatkę modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Revolve (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Obróć (w Siatki modelu fasety). 

• W menu wybierz polecenie Draw > Facet Model Meshes > Revolve. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Revolve. 

• Wpisz fmrevolve i naciśnij Enter. 

2 Wybierz jednostkę do obrócenia. 

3 Wykonaj jedną z poniższych czynności, aby zdefiniować oś obrotu: 

• Określ punkt początkowy i końcowy. 

• Wybierz Entity i naciśnij Enter, aby wybrać jednostkę, która określa oś. 

• Wybierz Xaxis, aby wybrać oś x. 

• Wybierz Oś Y, aby wybrać oś. 

4 Określa kąt obrotu. 
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Aby utworzyć siatkę powierzchni obrotowej 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Revolved Surface (  ): 

• Na wstążce wybierz Rysuj 3D > Powierzchnia obrócona (w Rysuj siatki 3D). 

• W menu wybierz polecenie Draw > 3D Meshes > Revolved Surface. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Powierzchnia obrócona. 

• Wpisz revsurf i naciśnij Enter. 

2 Wybierz jednostkę do obrócenia. 

3 Wybierz jednostkę, która będzie używana jako oś obrotu. 

4 Określ kąt początkowy. 

5 Określa liczbę stopni obrotu jednostki. 
 

 
Wybierz jednostkę, która ma zostać 
obrócona (A) oraz 
oś obrotu (B). 

Wynikowa obrócona powierzchnia 
siatka. 

 
 

 

Wartości NumberofM-Direction Surfaces i N-DirectionMesh Density kontrolują 

gęstość siatki. 

Wybierz Narzędzia > Ustawienia rysowania, kliknij kartę Ustawienia 3D, kliknij kartę 
Powierzchnie, 

następnie w sekcji Ustawienia powierzchni zmień wartości Liczba powierzchni w 

kierunku M i Gęstość siatki w kierunku N. 
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Tworzenie zdefiniowanych na krawędziach siatek Coons surface 
patch 

Można utworzyć powierzchnię o nazwie Coons surface patch, siatkę łączącą cztery 

krawędzie. Użytkownik wybiera elementy definiujące krawędzie. Elementami 

krawędzi mogą być łuki, linie lub polilinie. Cztery elementy krawędzi muszą 

tworzyć zamkniętą pętlę i mieć wspólne punkty końcowe. Patch jest powierzchnią 

bicubic (jedna krzywa rozciąga się w kierunku M, a druga w kierunku N) 

interpolowaną pomiędzy czterema sąsiadującymi krawędziami. Krawędzie można 

wybierać w dowolnej kolejności. Pierwsza wybrana krawędź określa kierunek M 

siatki. 
 

Aby utworzyć zdefiniowaną na krawędziach siatkę Coons surface patch 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Coons Surface (  ): 

• Na wstążce wybierz Draw 3D > Coons Surface (w oknie Draw 3D Meshes). 

• W menu wybierz Draw > 3D Meshes > Coons Surface. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Powierzchnia Coons. 

• Wpisz edgesurf i naciśnij Enter. 

2 Wybierz pierwszą krawędź. 

3 Wybierz drugą, trzecią i czwartą krawędź. 
 

 
Wybierz jednostki, które będą używane jako 
cztery 
krawędzie (A, B, C i D). 

Wynikowa siatka łat powierzchniowych Coonsa. 

 
 

 

Wartości NumberofM-Direction Surfaces i N-DirectionMesh Density kontrolują 

gęstość siatki. 

Wybierz Narzędzia > Ustawienia rysowania, kliknij kartę Ustawienia 3D, kliknij kartę 
Powierzchnie. 

następnie w sekcji Ustawienia powierzchni zmień wartości Liczba powierzchni w 

kierunku M i Gęstość siatki w kierunku N. 
 

 
Tworzenie skrzynek 

Można tworzyć prostokątne pudełka lub sześciany. Pudełko składa się z sześciu 

prostokątnych płaszczyzn powierzchni. Podstawa pudełka jest zawsze równoległa do 

płaszczyzny xy bieżącego układu UCS. Ramkę można pozycjonować, określając 

narożnik lub środek ramki. Rozmiar pudełka określa się, podając drugi narożnik i 

wysokość; definiując pudełko jako sześcian, a następnie podając jego długość; lub 

określając długość, szerokość i wysokość. 
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Aby utworzyć skrzynkę jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Box (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Ramka (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Ramka. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Ramka. 

• Wpisz pole i naciśnij Enter. 

2 Określ pierwszy narożnik podstawy. 

3 Określ przeciwległy narożnik podstawy. 

4 Określ wysokość. 
 

Aby utworzyć ramkę jako siatkę modelu Facet 

1 Wykonaj jedną z poniższych czynności, aby wybrać Box (  ): 

• Na wstążce wybierz Rysuj 3D > Ramka (w Siatki modelu fasety). 

• W menu wybierz polecenie Draw > Facet Model Meshes > Box. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Box. 

• Wpisz fmbox i naciśnij Enter. 

2 Określ pierwszy narożnik podstawy. 

3 Określ przeciwległy narożnik podstawy. 

4 Określ wysokość. 
 

Aby utworzyć pudełko jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Box (  ): 

• Na wstążce wybierz Rysuj 3D > Ramka (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Ramka. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Ramka. 

• Wpisz ai_box i naciśnij enter. 

2 Określ pierwszy narożnik podstawy. 

3 Określ przeciwległy narożnik podstawy. 

4 Określ wysokość. 
 

Pierwszy róg podstawy (A), przeciwległy róg podstawy (B) i wysokość (C). 
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Tworzenie klinów 

Można tworzyć trójwymiarowe kliny składające się z pięciu płaszczyzn 

powierzchni. Podstawa klina jest zawsze równoległa do płaszczyzny xy bieżącego układu UCS z 

nachyloną powierzchnią naprzeciwko pierwszego narożnika. Wysokość jest zawsze 

równoległa do osi z. Pozycjonowanie klina odbywa się poprzez określenie narożnika lub środka klina. Rozmiar klina 

określa się, podając drugi narożnik i wysokość, definiując klin na podstawie 

sześcianu o danej długości lub podając długość, szerokość i wysokość. 
 

Aby utworzyć klin jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać klin (  ): 

• Na wstążce wybierz Rysuj 3D > Klin (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Klin. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Klin. 

• Wpisz wedge i naciśnij Enter. 

2 Określ pierwszy narożnik podstawy. 

3 Określ przeciwległy narożnik podstawy. 

4 Określ wysokość. 
 

Aby utworzyć klin jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać klin (  ): 

• Na wstążce wybierz Rysuj 3D > Klin (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Klin. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Klin. 

• Wpisz ai_wedge i naciśnij Enter. 

2 Określ pierwszy narożnik podstawy. 

3 Określ przeciwległy narożnik podstawy. 

4 Określ wysokość. 
 

Pierwszy róg podstawy (A), przeciwległy róg podstawy (B) i wysokość (C). 
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Tworzenie stożków 

Można tworzyć trójwymiarowe stożki zdefiniowane przez okrągłą podstawę i 

zwężające się do punktu prostopadłego do podstawy. Podstawa stożka jest zawsze 

równoległa do płaszczyzny xy bieżącego układu UCS; wysokość stożka jest zawsze 

równoległa do osi z. Pozycjonowanie stożka odbywa się poprzez określenie środka 

podstawy. Rozmiar stożka określa się poprzez podanie promienia lub średnicy 

podstawy i wysokości. 
 

Aby utworzyć stożek jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cone (  ): 

• Na wstążce wybierz Rysuj 3D > Stożek (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Stożek. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Stożek. 

• Wpisz cone i naciśnij Enter. 

2 Określ środek podstawy stożka. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
 

Aby utworzyć stożek jako siatkę Facet Model 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cone (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Stożek (w Siatki modelu fasety). 

• W menu wybierz Rysuj > Siatki modelu fasety > Stożek. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Stożek. 

• Wpisz fmcone i naciśnij Enter. 

2 Określ środek podstawy stożka. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
 

Aby utworzyć stożek jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cone (  ): 

• Na wstążce wybierz Rysuj 3D > Stożek (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Stożek. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Stożek. 

• Wpisz ai_cone, a następnie naciśnij Enter. 

2 Określ środek podstawy stożka. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
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Środek podstawy (A), promień podstawy (B) i wysokość (C). 

 

Tworzenie piramid 

Można tworzyć czworościany (ostrosłupy trójboczne) lub ostrosłupy czteroboczne. 

Boki powstałego ostrosłupa mogą spotykać się w punkcie (wierzchołku) lub tworzyć 

wierzchołek o trzech lub czterech krawędziach. Ściany boczne ostrosłupa 

czworokątnego mogą również stykać się wzdłuż grzbietu wyznaczonego przez dwa 

punkty. Podstawa piramidy jest zawsze równoległa do płaszczyzny xy bieżącego 

układu UCS. Piramidę ustawia się, określając narożnik podstawy. Rozmiar 

ostrosłupa określa się, podając punkty podstawy i wierzchołek, narożniki górnej 

powierzchni lub punkty końcowe grzbietu. 
 

Aby utworzyć czworościan foremny jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Piramidę (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Piramida (w oknie Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Piramida. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Piramida. 

• Wpisz pyramid, a następnie naciśnij Enter. 

2 Określ pierwszy punkt podstawy piramidy. 

3 Określ drugi i trzeci punkt. 

4 W oknie dialogowym wybierz Tetrahedron. 

5 Określ wierzchołek czworościanu foremnego. 
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Aby utworzyć czworościan jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Piramidę (  ): 

• Na wstążce wybierz Rysuj 3D > Piramida (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Piramida. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Piramida. 

• Wpisz ai_pyramid i naciśnij Enter. 

2 Określ pierwszy punkt podstawy piramidy. 

3 Określ drugi i trzeci punkt. 

4 W oknie dialogowym wybierz Tetrahedron. 

5 Określ wierzchołek czworościanu foremnego. 
 

Pierwszy punkt (A), drugi punkt (B) i trzeci punkt (C) podstawy oraz wierzchołek (D). 

Aby utworzyć piramidę jako siatkę Facet Model 

1 Wykonaj jedną z poniższych czynności, aby wybrać Piramidę (  ): 

• Na wstążce wybierz Draw 3D > Pyramid (w Facet Model Meshes). 

• W menu wybierz polecenie Draw > Facet Model > Pyramid. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Pyramid. 

• Wpisz fmpyramid i naciśnij Enter. 

2 Określ punkt środkowy podstawy piramidy. 

3 Określ promień podstawy piramidy. 

4 Określ wysokość. 
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Aby utworzyć piramidę z płaskim wierzchołkiem jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Piramidę (  ): 

• Na wstążce wybierz Rysuj 3D > Piramida (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Piramida. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Piramida. 

• Wpisz pyramid, a następnie naciśnij Enter. 

2 Określ pierwszy punkt podstawy piramidy. 

3 Określ drugi, trzeci i czwarty punkt. 

4 W oknie dialogowym wybierz Top Surface. 

5 Określ pierwszy punkt na górnej powierzchni piramidy. 

6 Określ drugi, trzeci i czwarty punkt. 
 

Aby utworzyć piramidę z płaskim wierzchołkiem jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Piramidę (  ): 

• Na wstążce wybierz Rysuj 3D > Piramida (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Piramida. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Piramida. 

• Wpisz ai_pyramid i naciśnij Enter. 

2 Określ pierwszy punkt podstawy piramidy. 

3 Określ drugi, trzeci i czwarty punkt. 

4 W oknie dialogowym wybierz Top Surface. 

5 Określ pierwszy punkt na górnej powierzchni piramidy. 

6 Określ drugi, trzeci i czwarty punkt. 
. 

Pierwszy punkt (A), drugi punkt (B), trzeci punkt (C) i czwarty punkt (D) podstawy oraz pierwszy 
punkt (E), drugi punkt (F), trzeci punkt (G) i czwarty punkt (H) górnej powierzchni. 
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Tworzenie cylindrów 

Można tworzyć cylindry zdefiniowane przez okrągłą podstawę. Podstawa cylindra 

jest zawsze równoległa do płaszczyzny xy bieżącego UCS; wysokość cylindra jest 

zawsze równoległa do osi z. Cylinder jest pozycjonowany poprzez określenie środka 

podstawy. Rozmiar cylindra określa się poprzez podanie promienia lub średnicy 

podstawy i wysokości. 
 

Aby utworzyć cylinder jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cylinder (  ): 

• Na wstążce wybierz Rysuj 3D > Cylinder (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Cylinder. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Walec. 

• Wpisz cylinder i naciśnij Enter. 

2 Określ środek podstawy cylindra. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
 

Aby utworzyć cylinder jako siatkę Facet Model 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cylinder (  ): 

• Na wstążce wybierz Rysuj 3D > Cylinder (w Siatki modelu fasety). 

• W menu wybierz polecenie Draw > Facet Model > Cylinder. 

• Na pasku narzędzi Rysuj model fasety kliknij narzędzie Cylinder. 

• Wpisz fmcylinder i naciśnij Enter. 

2 Określ środek podstawy cylindra. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
 

Aby utworzyć cylinder jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Cylinder (  ): 

• Na wstążce wybierz Rysuj 3D > Cylinder (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Cylinder. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Cylinder. 

• Wpisz ai_cylinder i naciśnij Enter. 

2 Określ środek podstawy cylindra. 

3 Określ promień lub średnicę. 

4 Określ wysokość. 
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Środek podstawy (A), promień podstawy (B) i wysokość (C). 
 

Tworzenie sfer 

Można tworzyć sfery. Linie szerokości geograficznej sfery są zawsze równoległe do 

płaszczyzny xy bieżącego UCS; oś centralna jest zawsze równoległa do osi z. Sferę 

ustawia się, określając jej punkt środkowy. Rozmiar kuli określa się, podając jej promień 

lub średnicę. 
 

Aby utworzyć kulę jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Sferę (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Kula (w oknie Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Sfera. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Kula. 

• Wpisz sphere i naciśnij Enter. 

2 Określa środek kuli. 

3 Określ promień lub średnicę. 
 

Aby utworzyć kulę jako siatkę modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Sferę (  ): 

• Na wstążce wybierz Draw 3D > Sphere (w Facet Model Meshes). 

• W menu wybierz polecenie Draw > Facet Model > Sphere. 

• Na pasku narzędzi Rysuj model fasety kliknij narzędzie Sfera. 

• Wpisz fmsphere, a następnie naciśnij Enter. 

2 Określa środek kuli. 

3 Określ promień lub średnicę. 
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Aby utworzyć kulę jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Sferę (  ): 

• Na wstążce wybierz Rysuj 3D > Kula (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Sfera. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Sfera. 

• Wpisz ai_sphere i naciśnij Enter. 

2 Określa środek kuli. 

3 Określ promień lub średnicę. 

4 Określa liczbę przekrojów wzdłużnych, które są prostopadłe do płaszczyzny xy. 

5 Określa liczbę przekrojów równoległych do płaszczyzny xy. 
 

Środek (A) i promień (B) kuli. Wynikowa kula. 
 

Tworzenie potraw 

Można utworzyć naczynie trójwymiarowe. Linie szerokości geograficznej talerza są 

zawsze równoległe do płaszczyzny xy bieżącego układu UCS; oś centralna jest 

zawsze równoległa do osi z. Pozycjonowanie talerza odbywa się poprzez określenie 

jego punktu środkowego. Rozmiar talerza określa się, podając jego promień lub 

średnicę. 
 

Aby utworzyć danie jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dish (  ): 

• Na wstążce wybierz Rysuj 3D > Naczynie (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Naczynie. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Naczynie. 

• Wpisz dish i naciśnij Enter. 

2 Określ środek naczynia. 

3 Określ promień lub średnicę. 
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Aby utworzyć naczynie jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dish (  ): 

• Na wstążce wybierz Rysuj 3D > Naczynie (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Naczynie. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Klosz. 

• Wpisz ai_dish i naciśnij Enter. 

2 Określ środek naczynia. 

3 Określ promień lub średnicę. 
. 

Środek (A) i promień (B) naczynia. 
 

Tworzenie kopuł 

Można utworzyć trójwymiarową kopułę. Linie szerokości geograficznej kopuły są 

zawsze równoległe do płaszczyzny xy bieżącego UCS; oś centralna jest zawsze 

równoległa do osi z. Pozycjonowanie kopuły odbywa się poprzez określenie jej 

punktu środkowego. Rozmiar kopuły określa się, podając jej promień lub średnicę. 
 

Aby utworzyć kopułę jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dome (  ): 

• Na wstążce wybierz Rysuj 3D > Kopuła (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Kopuła. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Kopuła. 

• Wpisz dome i naciśnij Enter. 

2 Określ środek kopuły. 

3 Określ promień lub średnicę. 



D R A W I N G W S Z Y S T K I C H D Y M E N S A C H 609 

 
 

Aby utworzyć kopułę jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dome (  ): 

• Na wstążce wybierz Rysuj 3D > Kopuła (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Kopuła. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Kopuła. 

• Wpisz ai_dome i naciśnij Enter. 

2 Określ środek kopuły. 

3 Określ promień lub średnicę. 
 

Środek (A) i promień (B) kopuły. 
 

Tworzenie tori 

Można utworzyć trójwymiarowy pączek lub pierścień znany jako torus. Średnica 

pierścienia jest zawsze równoległa do płaszczyzny xy bieżącego układu UCS. Torus 

jest tworzony przez obrót okręgu wokół linii narysowanej w płaszczyźnie okręgu i 

równoległej do osi z bieżącego układu UCS. Torus jest pozycjonowany poprzez 

określenie jego punktu środkowego. Rozmiar torusa określa się, podając jego 

całkowitą średnicę lub promień oraz średnicę lub promień tuby (obracanego okręgu). 
 

Aby utworzyć torus jako bryłę ACIS 

1 Wykonaj jedną z poniższych czynności, aby wybrać Torus (  ): 

• Na wstążce wybierz Rysuj 3D > Torus (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Torus. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Torus. 

• Wpisz torus i naciśnij Enter. 

2 Określa środek całego torusa. 

3 Określa promień lub średnicę całego torusa. 

4 Określa promień lub średnicę korpusu torusa. 
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Aby utworzyć torus jako siatkę Facet Model 

1 Wykonaj jedną z poniższych czynności, aby wybrać Torus (  ): 

• Na wstążce wybierz Draw 3D > Torus (w Facet Model Meshes). 

• Z menu wybierz Draw > Facet Model Meshes > Torus. 

• Na pasku narzędzi Rysuj model fasety kliknij narzędzie Torus. 

• Wpisz fmtorus i naciśnij Enter. 

2 Określa środek całego torusa. 

3 Określa promień lub średnicę całego torusa. 

4 Określa promień lub średnicę korpusu torusa. 
 

Aby utworzyć torus jako siatkę 3D 

1 Wykonaj jedną z poniższych czynności, aby wybrać Torus (  ): 

• Na wstążce wybierz Rysuj 3D > Torus (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Torus. 

• Na pasku narzędzi Rysuj siatki 3D kliknij narzędzie Torus. 

• Wpisz ai_torus i naciśnij Enter. 

2 Określa środek całego torusa. 

3 Określa promień lub średnicę całego torusa. 

4 Określa promień lub średnicę korpusu torusa. 

5 Określa liczbę przekrojów wzdłużnych, które są prostopadłe do płaszczyzny xy. 

6 Określa liczbę przekrojów równoległych do płaszczyzny xy. 
 

Środek (A) i promień całego torusa (B) oraz promień korpusu (C). 
 

Tworzenie regionów 

Zamkniętą jednostkę można przekształcić w region dwuwymiarowy. Po utworzeniu 

regionu można go zmodyfikować za pomocą różnych narzędzi trójwymiarowych. 

Można na przykład utworzyć region z kwadratu, a następnie wyciągnąć kwadrat, aby 

utworzyć trójwymiarowy sześcian. 
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Regiony można tworzyć z zamkniętych jednostek, takich jak polilinie, wielokąty, 

okręgi, elipsy, zamknięte splajny i pączki. 

Tworzenie regionów zazwyczaj nie ma widocznego wpływu na rysunek. Jeśli jednak 

oryginalna jednostka miała szerokość lub grubość linii, informacje te zostaną 

utracone podczas tworzenia regionu. 
 

Aby utworzyć region 

1 Wykonaj jedną z poniższych czynności, aby wybrać region (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Region (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Region. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Region. 

• Wpisz region i naciśnij Enter. 

2 Wybierz jednostki, aby utworzyć region. 

3 Naciśnij Enter. 

Pasek poleceń wyświetla komunikat opisujący liczbę utworzonych regionów. 

 

Tworzenie wytłaczanych brył 

Trójwymiarowe bryły można tworzyć poprzez wyciągnięcie zamkniętych 

elementów, takich jak polilinie, wielokąty, okręgi, elipsy, zamknięte splajny, pączki 

i regiony. Bryłę można wytłaczać wzdłuż wybranej ścieżki lub określić jej wysokość 

i kąt zwężenia. 
 

Aby utworzyć wytłaczaną bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extrude (  ): 

• Na wstążce wybierz polecenie Draw 3D > Extrude (w oknie Draw 3D Solids). 

• W menu wybierz Rysuj > Bryły 3D > Wyciągnięcie. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Wyciągnięcie. 

• Wpisz extrude i naciśnij Enter. 

2 Wybierz jednostkę do wyciągnięcia. 

3 Wybierz ścieżkę wytłaczania lub określ wysokość. 
 

 
Wybierz jednostkę do wyciągnięcia (A) i 
wytłoczenie 
ścieżka (B). 

Wynikowy wytłaczany 
solidne. 
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Tworzenie brył obrotowych 

Trójwymiarowe bryły można tworzyć poprzez obracanie zamkniętych elementów, 

takich jak polilinie, wielokąty, okręgi, elipsy i regiony. Bryłę można obracać wokół 

zdefiniowanej osi, linii, polilinii lub dwóch punktów. 
 

Aby utworzyć bryłę obrotową 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Revolve (  ): 

• Na wstążce wybierz Rysuj 3D > Obróć (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Obróć. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Obrót. 

• Wpisz revolve i naciśnij Enter. 

2 Wybierz jednostkę do obrócenia. 

3 Wykonaj jedną z poniższych czynności, aby zdefiniować oś obrotu: 

• Określ punkt początkowy i końcowy. 

• Wpisz e i naciśnij Enter, aby wybrać jednostkę określającą oś. 

• Wpisz x i naciśnij Enter, aby wybrać oś x. 

• Wpisz y i naciśnij Enter, aby wybrać oś y. 

4 Określa kąt obrotu. 
 

 
Wybierz jednostkę, która ma zostać 
obrócona (A) i ikonę 
oś (B), wokół której ma się 
obracać, a następnie kąt obrotu. 

Wynikowy obrócony 
solidny. 

 

Tworzenie uniesionych brył i powierzchni 

Tworzy trójwymiarową bryłę lub powierzchnię pomiędzy dwoma lub więcej 

przekrojami. Przekroje mogą być otwarte lub zamknięte. Przekroje otwarte tworzą 

trójwymiarowe powierzchnie. Przekroje zamknięte tworzą trójwymiarowe bryły lub 

powierzchnie, w zależności od określonego trybu. 
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Przekroje mogą być poliliniami 2D, liniami, łukami, okręgami, elipsami, łukami 

eliptycznymi, splajnami 2D, spiralami, śladami, krawędziami elementów, 

powierzchniami bryły lub powierzchni, punktami pierwszego lub ostatniego 

przekroju, regionami i bryłami 2D. 

Prowadnice mogą być poliliniami 2D z pojedynczym segmentem, poliliniami 3D, 

liniami, łukami, łukami eliptycznymi, splajnami 2D i 3D oraz krawędziami 

elementów. 

Ścieżki mogą być poliliniami 2D i 3D, liniami, łukami, okręgami, elipsami, łukami 

eliptycznymi, splajnami 2D i 3D, spiralami i krawędziami obiektów. 
 

Aby utworzyć podniesioną bryłę lub powierzchnię 

1 Wykonaj jedną z poniższych czynności, aby wybrać Loft ( ):  

• Na wstążce wybierz Rysuj 3D > Loft (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Loft. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Wyciągnięcie. 

• Wpisz loft i naciśnij Enter. 

2 Wybierz przekroje poprzeczne w kolejności, w jakiej mają być opuszczane. 

Należy wybrać co najmniej dwa przekroje. 

3 W razie potrzeby wybierz opcję Punkt, aby zwęzić jednostkę loftu. Wybierz 

punkt zwężenia na przekroju, a następnie naciśnij klawisz Enter. 

4 W razie potrzeby wybierz opcję Połącz wiele krawędzi, aby utworzyć przekrój z 

krawędzi. Wybierz krawędzie, które muszą mieć wspólny punkt początkowy i 

końcowy, aby mogły zostać uznane za przekrój. Po zakończeniu wybierania 

krawędzi naciśnij klawisz Enter. 

5 W razie potrzeby wybierz opcję Tryb, aby zmienić, czy tworzona jest trójwymiarowa 

bryła czy powierzchnia, a następnie naciśnij klawisz Enter. 

6 Naciśnij Enter, aby kontynuować. 

7 Wybierz jedną z poniższych opcji: 

• Prowadnice - tworzy encję poddasza przy użyciu krzywych prowadzących, 

które pomagają w kształtowaniu encji. Wybierz krzywe prowadzące dla encji 

poddasza. Krzywe prowadzące muszą przecinać każdy przekrój i zaczynać się i 

kończyć na pierwszym i ostatnim przekroju. Można również połączyć wiele 

krawędzi, aby utworzyć prowadnicę. 

• Ścieżka - tworzy jednostkę loftu wzdłuż ścieżki. Wybierz ścieżkę dla 

wyciągniętej jednostki. Ścieżka musi przecinać bryłę lub powierzchnię we 

wszystkich płaszczyznach. 

• Tylko przekroje - tworzy element poddasza między przekrojami bez użycia 

prowadnic lub ścieżek. 

• Ustawienia - otwiera okno dialogowe Ustawienia Loft, umożliwiające określenie różnych 

ustawień. 
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Tworzenie zamiatanych brył i powierzchni 

Trójwymiarowe bryły lub powierzchnie można tworzyć, przesuwając jednostkę 

wzdłuż ścieżki. 

Jednostki, które można zamiatać, obejmują polilinie 2D, linie, łuki, okręgi, elipsy, 

łuki eliptyczne, splajny 2D i 3D, powierzchnie brył 3D i bryły 2D. 

Jednostki, które mogą być ścieżką obejmują polilinie 2D i 3D, linie, łuki, okręgi, 

elipsy, łuki eliptyczne, splajny 2D i 3D, spirale i krawędzie brył, powierzchni lub 

siatek. 
 

Aby utworzyć zamiataną bryłę lub powierzchnię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Sweep ( ):  

• Na wstążce wybierz polecenie Draw 3D > Sweep (w oknie Draw 3D Solids). 

• W menu wybierz Rysuj > Bryły 3D > Zamiatanie. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Zamiatanie. 

• Wpisz sweep i naciśnij Enter. 

2 Wybierz jedną lub więcej jednostek do przeczesania. 

Możesz wybrać Tryb, aby zmienić, czy tworzona jest trójwymiarowa bryła czy 

powierzchnia. 

3 Wybierz ścieżkę. 

4 W razie potrzeby wybierz jedną z poniższych opcji: 

• Wyrównanie - Wyrównuje jednostkę zamiatania tak, aby była 

prostopadła (normalna) do stycznego kierunku ścieżki zamiatania. 

• Punkt bazowy - określa punkt bazowy przemiatanej jednostki. 

• Scale (Skala) - określa współczynnik skali dla jednostki przemiatania. Jeśli 

istnieje wiele jednostek zamiatania, współczynnik skali jest stosowany do każdej 

jednostki. Można również wybrać opcję Odniesienie, aby wybrać punkty 

odniesienia na rysunku do skalowania. 

• Twist - określa, o ile stopni ma zostać obrócona jednostka zamiatania wzdłuż 

ścieżki. Jeśli istnieje wiele jednostek zamiatania, kąt skręcenia jest stosowany do 

każdej jednostki. Można również wybrać opcję Bank, aby określić, czy 

zamiatana jednostka obraca się wzdłuż ścieżki 3D, takiej jak polilinia 3D, 

splajn lub helisa. 
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Tworzenie polisolidów 

Trójwymiarowe bryły o prostokątnym profilu można tworzyć z nowej narysowanej 

polilinii lub z istniejącej linii, łuku, polilinii lub okręgu. 
 

Aby utworzyć bryłę bez konwertowania jakichkolwiek elementów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polysolid (  ): 

• Na wstążce wybierz polecenie Draw 3D > Polysolid (w Rysuj bryły 3D). 

• W menu wybierz polecenie Rysuj > Bryły 3D > Polisolid. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Polysolid. 

• Wpisz polysolid i naciśnij Enter. 

2 Wybierz punkt początkowy bryły wielobryłowej. 

3 Kontynuuj wybieranie punktów. Możesz wybrać Arc, aby utworzyć odcinek 

łuku. Możesz także wybrać Undo, aby usunąć poprzedni punkt. 

4 Wybierz Wysokość i określ wysokość bryły. Domyślna wysokość jest określona przez 

zmienną systemową PSOLHEIGHT. 

5 Wybierz szerokość i określ szerokość bryły. Domyślna wysokość jest określona przez 

zmienną systemową PSOLWIDTH. 

6 Wybierz opcję Justify (Wyjustuj), aby określić, czy szerokość i wysokość mają 

być wyjustowane do lewej, środka czy prawej strony. Orientacja justowania jest 

określana zgodnie z kierunkiem pierwszego segmentu profilu. 
 

Aby utworzyć bryłę polisolid z istniejącej jednostki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Polysolid (  ): 

• Na wstążce wybierz polecenie Draw 3D > Polysolid (w oknie Draw 3D Solids). 

• W menu wybierz polecenie Rysuj > Bryły 3D > Polisolid. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Polysolid. 

• Wpisz polysolid i naciśnij Enter. 

2 Wybierz opcję Podmiot, a następnie naciśnij klawisz Enter. 

3 Wybierz element, który chcesz przekonwertować na bryłę wieloboczną. 

Możesz wybrać linię, łuk, polilinię lub okrąg. 

4 Wybierz Wysokość i określ wysokość bryły. Domyślna wysokość jest określona przez 

zmienną systemową PSOLHEIGHT. 

5 Wybierz szerokość i określ szerokość bryły. Domyślna wysokość jest określona przez 

zmienną systemową PSOLWIDTH. 

6 Wybierz opcję Justify, aby określić, czy szerokość i wysokość mają być 

wyrównane do lewej, środka lub prawej strony. Justowanie jest określane 

zgodnie z kierunkiem pierwszego segmentu profilu. 
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Tworzenie złożonych jednostek trójwymiarowych 

Złożone trójwymiarowe siatki modelu fasetowego można tworzyć poprzez łączenie, 

podcięcie i znalezienie przecięcia dwóch lub więcej siatek modelu fasetowego. 

Złożone trójwymiarowe jednostki mogą być również tworzone przy użyciu brył 3D. 

 
Łączenie trójwymiarowych jednostek 
Połącz dwie lub więcej siatek modelu fasetowego, aby utworzyć jedną 

siatkę modelu fasetowego. Można również połączyć dwie lub więcej brył 

3D. 

Aby połączyć siatki modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Unię (  ): 

• Na wstążce wybierz polecenie Draw 3D > Union (w Facet Model Meshes). 

• Z menu wybierz polecenie Rysuj > Siatki modelu fasety > Złącz. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Union. 

• Wpisz fmunion i naciśnij Enter. 

2 Wybierz siatki modelu fasetowego do połączenia. 

 
Aby połączyć ciała stałe 

1 Wykonaj jedną z poniższych czynności, aby wybrać Unię (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Złącz (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Złącz. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Złączka. 

• Wpisz union i naciśnij Enter. 

2 Wybierz bryły 3D do połączenia. 
 

Wybierz podmioty do połączenia (A i B). Wynikowy połączony 
podmiot. 

Odejmowanie jednostek trójwymiarowych 
Odejmij dwie lub więcej siatek modelu fasetowego, aby utworzyć jedną 

siatkę modelu fasetowego. Można również odjąć dwie lub więcej brył 3D. 
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Aby odjąć siatki modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Odejmij (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Odejmij (w siatkach modelu fasety). 

• Z menu wybierz Rysuj > Siatki modelu fasety > Odejmij. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Subtract. 

• Wpisz fmsubtract i naciśnij Enter. 

2 Wybierz siatki modelu fasetowego, które mają zostać od siebie odjęte. 
 

Aby odjąć ciała stałe 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Odejmij (  ): 

• Na wstążce wybierz Rysuj 3D > Odejmij (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Odejmij. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Odejmowanie. 

• Wpisz subtract i naciśnij Enter. 

2 Wybierz bryły 3D, które mają zostać od siebie odjęte. 
 

Wybierz jednostki do odjęcia (A i B). Jednostka wynikowa. 
 

Przecinające się trójwymiarowe jednostki 
Tworzy złożoną trójwymiarową jednostkę z przecięcia dwóch lub więcej siatek 

modelu fasetowego. Obszary poza przecięciem są usuwane. 

Można także przecinać dwie lub więcej brył 3D. 
 

Aby przeciąć siatki modelu fasetowego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Intersect (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Przecinaj (w siatkach modelu fasety). 

• Z menu wybierz Rysuj > Siatki modelu fasety > Przecinaj. 

• Na pasku narzędzi Facet Model Meshes kliknij narzędzie Intersect. 

• Wpisz fmintersect i naciśnij Enter. 

2 Wybierz siatki modelu fasetowego do przecięcia. 
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Przecinanie brył 

1 Wykonaj jedną z poniższych czynności, aby wybrać Intersect (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Przecinaj (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Przecinaj. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Przecięcie. 

• Wpisz intersect i naciśnij Enter. 

2 Wybierz bryły 3D do przecięcia. 
 

Wybierz jednostki do połączenia (A i B). Wynikowa kombinacja 
podmiot. 
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Konwersja jednostek trójwymiarowych 
 

Różne typy jednostek trójwymiarowych mogą być konwertowane na inne typy jednostek: 

• Konwertuj na powierzchnie 3D - Wybierz zamknięte obiekty 2D, bryły 3D, 

regiony, linie, łuki i otwarte polilinie o grubości, obiekty siatki i powierzchnie 

3D do konwersji na powierzchnie 3D. 

• Konwertuj na siatki 3D - Wybierz bryły 3D, powierzchnie 3D, siatki 

wielopłaszczyznowe i wieloboki, regiony i zamknięte polilinie do konwersji na 

siatki 3D. 

• Konwertuj na siatki polifazowe - Wybierz bryły 3D do konwersji na siatki polifazowe. 

• Konwersja na bryły 3D - Wybierz różne typy jednostek i przekonwertuj je na bryły 3D. 

 
Konwersja jednostek trójwymiarowych na powierzchnie 

Na trójwymiarowe powierzchnie można konwertować następujące obiekty: 

zamknięte obiekty 2D, bryły 3D, regiony, linie, łuki i otwarte polilinie o grubości, 

elementy siatki i powierzchnie 3D. 
 

Aby przekonwertować trójwymiarową jednostkę na powierzchnię 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Konwertuj na powierzchnię (  

): 

• Na wstążce wybierz polecenie Draw 3D > Convert to Surface (w Konwertuj). 

• W menu wybierz polecenie Modyfikuj > Konwertuj 3D > Konwertuj na powierzchnię. 

• Wpisz convtosurface i naciśnij Enter. 

2 Wybierz jednostki, które chcesz przekonwertować, a następnie naciśnij Enter po 

zakończeniu. 

 
Konwersja jednostek trójwymiarowych na siatki 

Na trójwymiarowe powierzchnie można konwertować następujące elementy: Bryły 

3D, powierzchnie 3D, siatki polifazowe i siatki wielokątów, regiony i zamknięte 

polilinie. 
 

Aby przekonwertować trójwymiarową jednostkę na siatkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Konwertuj na siatkę (  ): 

• Na wstążce wybierz polecenie Draw 3D > Convert to Mesh (Konwertuj). 

• W menu wybierz Modyfikuj > Konwertuj 3D > Konwertuj na siatkę. 

• Wpisz convtomesh i naciśnij Enter. 

2 Wybierz Ustawienia, aby wyświetlić lub zmienić ustawienia konwersji: 

• Pokaż krawędzie Kliknij to pole wyboru, aby wyświetlić krawędzie tworzące siatkę. 

• Subdivide Level Wprowadź wartość od 0 do 3, aby określić poziom 

szczegółowości. Im wyższa liczba, tym większa szczegółowość zastosowana 

do przekonwertowanej siatki. 

3 Kliknij przycisk OK. 

4 Wybierz jednostki, które chcesz przekonwertować, a następnie naciśnij Enter po 

zakończeniu. 
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Konwersja brył na siatki polifazowe 

Trójwymiarowe bryły można konwertować na siatki polifazowe za pomocą 

polecenia Konwertuj 3D. 
 

Aby przekonwertować bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Konwersja 3D (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Konwertuj 3D (w obszarze Konwertuj). 

• W menu wybierz kolejno opcje Modyfikuj > Konwersja 3D > Konwersja 3D. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Konwertowanie 3D. 

• Wpisz 3dconvert i naciśnij Enter. 

2 Wybierz jednostki, które chcesz przekonwertować. 

 
Konwersja jednostek na ciała stałe 

Polecenie Konwertuj na bryłę konwertuje kilka typów jednostek na bryły: 

zamknięte jednostki siatki, zamknięte powierzchnie 3D oraz zamknięte okręgi i 

polilinie o grubości. 

Grubość można również zastosować do elementów powierzchni i siatki oraz 

przekonwertować je na trójwymiarowe bryły za pomocą polecenia Grubość. 
 

Aby przekonwertować zamknięte jednostki na bryłę przy użyciu opcji Konwertuj na 
bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Konwertuj na bryłę (  ): 

• Na wstążce wybierz Rysuj 3D > Konwertuj na bryłę (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Konwertuj na bryłę. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Konwertuj na bryłę. 

• Wpisz convtosolid i naciśnij Enter. 

2 Wybierz jednostki, które chcesz przekonwertować na bryły, które mogą obejmować: 

• Zamknięte oczka 

• Zamknięte powierzchnie 3D 

• Okręgi o grubości 

• Zamknięte polilinie o grubości i niezmiennej szerokości 

3 Po zakończeniu wybierania podmiotów naciśnij klawisz Enter. 
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Aby przekonwertować powierzchnię lub siatkę na bryłę przy użyciu funkcji 
Zagęszczenie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Zagęść (  ): 

• Na wstążce wybierz Rysuj 3D > Pogrubienie (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Zagęszczanie. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Zagęszczanie. 

• Wpisz thicken i naciśnij Enter. 

2 Wybierz jednostkę powierzchni lub siatki, którą chcesz przekonwertować i zastosować do 

niej grubość. 

3 Wprowadź wartość grubości. 
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Edycja w trzech wymiarach 
 

Można kopiować, przenosić, obracać, układać, odbijać i wyrównywać 

dwuwymiarowe i trójwymiarowe obiekty zarówno w przestrzeni dwuwymiarowej, 

jak i trójwymiarowej. Możesz także zmieniać i edytować właściwości 

trójwymiarowych jednostek w podobny sposób, jak zmieniasz i edytujesz 

właściwości jednostek dwuwymiarowych. Podczas modyfikowania jednostek 

trójwymiarowych w przestrzeni dwuwymiarowej, jednostka jest modyfikowana w 

odniesieniu do bieżącego UCS. 

 

Obracanie w trzech wymiarach 

Wybrane obiekty można obracać wokół określonej osi w przestrzeni 

trójwymiarowej. Użytkownik wybiera elementy do obrócenia, a następnie definiuje 

oś obrotu, określając dwa punkty, wybierając istniejący element, wyrównując oś z osią x, y 

lub z bieżącego UCS lub wyrównując oś z bieżącym widokiem. 
 

Aby obrócić jednostkę wokół osi w trzech wymiarach 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obrót 3D (  ): 

• Na wstążce wybierz polecenie Edycja > Obrót 3D (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Obrót 3D. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Obrót 3D. 

• Wpisz rotate3D i naciśnij Enter. 

2 Wybierz jednostki do obrócenia, a następnie naciśnij Enter. 

3 Wybierz jedną z następujących opcji: Entity, Last, View, Xaxis, Yaxis, 

Zaxis. 

4 Określa kąt obrotu. 

5 Określ kąt odniesienia. 
 

 
Wybierz elementy do obrócenia (A), określ 
punkty końcowe osi obrotu (B i C), a następnie 
określ kąt obrotu (D). 

Wynik po obróceniu jednostek. 
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Układanie w trzech wymiarach 

Można kopiować wybrane elementy i układać je w trójwymiarowy wzór 

prostokątny lub biegunowy (kołowy). W przypadku tablicy prostokątnej liczbę 

kopii w tablicy można kontrolować, określając liczbę wierszy i kolumn oraz liczbę 

poziomów. Określa się także odległość między nimi. W przypadku macierzy 

biegunowej określa się oś, wokół której mają być ułożone jednostki, liczbę kopii 

jednostek do utworzenia oraz kąt odejmowany przez wynikową macierz. 
 

Aby utworzyć trójwymiarową tablicę prostokątną 

1 Wykonaj jedną z poniższych czynności, aby wybrać 3D Array: 

• Na wstążce wybierz polecenie Edycja > Szyk 3D (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Szyk 3D. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Szyk 3D. 

• Wpisz 3Darray i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 W oknie dialogowym wybierz opcję Prostokąt. 

4 Wpisz liczbę wierszy w tablicy. 

5 Wpisz liczbę kolumn. 

6 Wpisz liczbę poziomów. 

7 Określa pionową odległość między wierszami. 

8 Określa poziomą odległość między kolumnami. 

9 Określ głębokość między poziomami. 
 

Aby utworzyć trójwymiarową tablicę prostokątną, wybierz jednostkę do skopiowania (A), wpisz liczbę 
wierszy, kolumn i poziomów, a następnie określ odległość między każdym wierszem (B), kolumną (C) 
i poziomem (D). 
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Aby utworzyć trójwymiarowy układ biegunowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję 3D Array (  ): 

• Na wstążce wybierz polecenie Edycja > Szyk 3D (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Szyk 3D. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Szyk 3D. 

• Wpisz 3Darray i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 W oknie dialogowym wybierz opcję Polar. 

4 Wpisz liczbę kopii do wykonania, łącznie z oryginalnym zestawem wyboru. 

5 Określa kąt wypełnienia tablicy, od 0 do 360 stopni. 

Domyślnym ustawieniem kąta jest 360 stopni. Wartości dodatnie tworzą tablicę 

w kierunku przeciwnym do ruchu wskazówek zegara; wartości ujemne tworzą 

tablicę w kierunku zgodnym z ruchem wskazówek zegara. 

6 W oknie zachęty wybierz jedną z poniższych opcji: 

• Yes-Rotate Entities, aby obracać jednostki, gdy są ułożone w tablicy. 

• Nie - nie obracaj, aby zachować oryginalną orientację każdej kopii w układzie. 

7 Określa punkt środkowy tablicy. 

8 Określa drugi punkt wzdłuż centralnej osi tablicy. 
 

Aby utworzyć trójwymiarową macierz biegunową, wybierz jednostkę do skopiowania (A), wpisz liczbę 
kopii do wykonania, określ kąt, który macierz ma wypełnić (B), a następnie określ punkt środkowy 
macierzy (C) i drugi punkt wzdłuż osi środkowej macierzy (D). 
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Odbicie lustrzane w trzech wymiarach 

Można utworzyć lustrzane odbicie wybranych jednostek w przestrzeni 

trójwymiarowej. Odbicie lustrzane jednostek jest tworzone wokół płaszczyzny 

lustrzanej, którą definiuje się, określając trzy punkty; wybierając istniejącą 

dwuwymiarową jednostkę płaską; wyrównując płaszczyznę równolegle do 

płaszczyzny xy, yz lub xz bieżącego UCS; lub wyrównując płaszczyznę do bieżącego 

widoku. Oryginalne jednostki można usunąć lub zachować. 
 

Odbicie lustrzane jednostki w płaszczyźnie trójwymiarowej 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Lustro 3D (  ): 

• Na wstążce wybierz polecenie Edycja > Lustro 3D (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Lustro 3D. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Lustro 3D. 

• Wpisz mirror3D i naciśnij Enter. 

2 Wybierz podmioty, a następnie naciśnij klawisz Enter. 

3 W oknie zachęty wybierz 3 punkty lub naciśnij Enter, aby wybrać ustawienie domyślne. 

4 Określ pierwszy punkt na płaszczyźnie lustra. 

5 Określ drugi i trzeci punkt na płaszczyźnie. 

6 W oknie zachęty wybierz jedną z poniższych opcji: 

• Yes-Delete Entities, aby usunąć oryginalne podmioty. 

• No-Keep Entities, aby zachować oryginalne podmioty. 
 

 
Wybierz jednostkę do odbicia lustrzanego 
(A), a następnie określ 
pierwszy punkt (B), drugi punkt (C) i trzeci 
punkt (D) definiujące płaszczyznę lustra. 

 

Wyrównanie w trzech 
wymiarach 

Wynikowa jednostka lustrzana. 

 

Można wyrównać jeden lub więcej wybranych obiektów z innymi obiektami w 

przestrzeni trójwymiarowej. Najpierw należy zaznaczyć obiekty, które mają zostać 

przesunięte i wyrównane, a następnie określić pary punktów do przesunięcia i 

wyrównania wybranych obiektów: 

• Jedna para punktów - przenosi wybrane elementy. 
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• Dwie pary punktów - przesuwa, a następnie obraca wybrane elementy. Druga 

para punktów może również określać skalę przenoszonych elementów (skalowanie 

jest dostępne tylko w przypadku korzystania z dwóch par punktów). 

• Trzy pary punktów - przesuwa, obraca, a następnie ponownie obraca wybrane elementy. 

Aby wyrównać jednostki, przesuwając je 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyrównaj (  ): 

• Na wstążce wybierz polecenie Edycja > Wyrównaj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Wyrównaj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Wyrównaj. 

• Wpisz align, a następnie naciśnij Enter. 

2 Wybierz jednostki, które zostaną przeniesione, a następnie naciśnij klawisz 

Enter. W zestawie wyboru nie należy uwzględniać jednostek docelowych. 

3 Określ pierwszy punkt źródłowy. 

4 Określ pierwszy punkt docelowy, a następnie naciśnij Enter. 
 

 
Wybierz jedną lub więcej jednostek do 
przeniesienia, a następnie określ 
pierwszy punkt źródłowy (A) i pierwszy 
punkt docelowy (B). 

Powstałe w ten sposób podmioty. 
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Wyrównywanie podmiotów poprzez ich przesuwanie i obracanie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyrównaj (  ): 

• Na wstążce wybierz polecenie Edycja > Wyrównaj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Wyrównaj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Wyrównaj. 

• Wpisz align, a następnie naciśnij Enter. 

2 Wybierz jednostki, które zostaną przeniesione i obrócone, a następnie naciśnij 

klawisz Enter. W zestawie wyboru nie należy uwzględniać jednostek 

docelowych. 

3 Określ pierwszy punkt źródłowy, a następnie pierwszy punkt docelowy. 

4 Określ drugi punkt źródłowy, a następnie drugi punkt docelowy i naciśnij 

Enter. 

5 W razie potrzeby wybierz opcję Tak, aby przeskalować przeniesione obiekty. W 

przeciwnym razie wybierz opcję Nie. W przypadku skalowania wybrane obiekty 

są skalowane proporcjonalnie, tak aby odległość między dwoma punktami 

źródłowymi była taka sama jak odległość między dwoma punktami docelowymi. 

Opcja skalowania jest dostępna tylko w przypadku wybrania dwóch par punktów. 
 

 
Wybierz jedną lub więcej jednostek do 
przesuwania i obracania, a następnie 
określ pierwszy punkt źródłowy (A), 
pierwszy punkt docelowy (B), drugi 
punkt źródłowy (C) i drugi punkt 
docelowy (D). 

Wynikowe jednostki, bez skalowania. 
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Aby wyrównać jednostki, przesuń je, a następnie obróć dwukrotnie 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyrównaj (  ): 

• Na wstążce wybierz polecenie Edycja > Wyrównaj (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Wyrównaj. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Wyrównaj. 

• Wpisz align, a następnie naciśnij Enter. 

2 Wybierz jednostki, które zostaną przeniesione i obrócone, a następnie naciśnij 

klawisz Enter. W zestawie wyboru nie należy uwzględniać jednostek 

docelowych. 

3 Określ pierwszy punkt źródłowy, a następnie pierwszy punkt docelowy. 

4 Określ drugi punkt źródłowy, a następnie drugi punkt docelowy. 

5 Określ trzeci punkt źródłowy, a następnie trzeci punkt docelowy i naciśnij Enter. 
 

 
Wybierz jedną lub więcej jednostek do 
przeniesienia i 
obracać, a następnie określić pierwszy 
punkt źródłowy (A), pierwszy punkt 
docelowy (B), drugi punkt źródłowy 
(C), drugi punkt docelowy (D), trzeci punkt 
źródłowy (E) i trzeci punkt docelowy (F). 

Powstałe w ten sposób podmioty. 



 

Edycja trójwymiarowych brył 
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Trójwymiarowe bryły można edytować na kilka unikalnych sposobów, w tym: 

fazowanie, wypełnianie, przekrój i wycinanie. Można również modyfikować poszczególne 

powierzchnie i krawędzie brył, a także odciski, separacje, powłoki i sprawdzanie 

brył. 

Możesz edytować trójwymiarowe bryły ACIS, w tym: pudełka, stożki, cylindry, 

naczynia, kopuły, piramidy, kule, tori i kliny. 

 

Fazowanie i filetowanie ciał stałych 

Trójwymiarową bryłę można sfazować lub zaokrąglić podobnie jak dwuwymiarową 

bryłę. 
 

Aby sfazować bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Fazowanie (  ): 

• Na wstążce wybierz polecenie Edycja > Fazowanie (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Fazowanie. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Fazowanie. 

• Wpisz chamfer i naciśnij Enter. 

2 Wybierz krawędź powierzchni bazowej do sfazowania. (Jedna z dwóch 

powierzchni sąsiadujących z wybraną krawędzią zostanie podświetlona). 

3 Wykonaj jedną z poniższych czynności: 

• Aby wybrać inną powierzchnię, wpisz n i naciśnij Enter. 

• Aby użyć bieżącej powierzchni, naciśnij Enter. 

4 Określ odległość powierzchni bazowej (mierzoną od wybranej krawędzi do 

powierzchni bazowej). 

5 Określ odległość sąsiedniej powierzchni (mierzoną od wybranej krawędzi do 

sąsiedniej powierzchni). 

6 Wykonaj jedną z poniższych czynności: 

• Określ krawędzie do fazowania. 

• Aby zaznaczyć wszystkie krawędzie wokół powierzchni bazowej, wpisz l i naciśnij Enter. 
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Aby filetować bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać filet (  ): 

• Na wstążce wybierz polecenie Edycja > Wypełnienie (w obszarze Modyfikuj). 

• W menu wybierz opcję Modyfikuj > Filet. 

• Na pasku narzędzi Modyfikuj kliknij narzędzie Zaokrąglenie. 

• Wpisz filet i naciśnij Enter. 

2 Wybierz krawędź bryły do zaokrąglenia. 

3 Określ promień zaokrąglenia. 

4 Wybierz dodatkowe krawędzie do zaokrąglenia i naciśnij Enter, aby je zaokrąglić. 

 
Przekrawanie i cięcie ciał stałych 

Trójwymiarową bryłę, region lub ciało (zazwyczaj arkusz) można podzielić na sekcje lub 

przekroje. 

Po przekroju bryły uzyskuje się "widok wewnętrzny", tworząc przekrój przez bryłę 

jako region lub blok. Po przekroju regionu lub bryły, wynikowymi przecięciami są krzywe. 

Po przecięciu bryły, regionu lub ciała tworzona jest nowa jednostka poprzez 

wycięcie pierwotnej jednostki i usunięcie określonego boku. 
 

Aby wydzielić podmiot 

1 Wykonaj jedną z poniższych czynności, aby wybrać sekcję (  ): 

• Na wstążce wybierz Rysuj 3D > Przekrój (w Rysuj bryły 3D). 

• W menu wybierz Rysuj > Bryły 3D > Przekrój. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Przekrój. 

• Wpisz section i naciśnij Enter. 

2 Wybierz jednostki do przekroju. 

3 Wykonaj jedną z poniższych czynności: 

• Określ trzy punkty, aby zdefiniować płaszczyznę przekroju. (Pierwszy punkt 

definiuje początek, drugi punkt definiuje oś x, a trzeci punkt definiuje oś y). 

• Wpisz o i naciśnij Enter, aby wybrać jednostkę definiującą płaszczyznę przekroju. 

• Określ oś, wpisując odpowiednią literę i naciskając Enter. 
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Aby wyciąć jednostkę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Slice (  ): 

• Na wstążce wybierz polecenie Draw 3D > Slice (w oknie Draw 3D Solids). 

• W menu wybierz Rysuj > Bryły 3D > Przekrój. 

• Na pasku narzędzi Rysuj bryły 3D kliknij narzędzie Przekrój. 

• Wpisz slice, a następnie naciśnij Enter. 

2 Wybierz jednostki do wycięcia. 

3 Wykonaj jedną z poniższych czynności: 

• Określ trzy punkty, aby zdefiniować płaszczyznę przekroju. (Pierwszy punkt 

definiuje początek, drugi punkt definiuje oś x, a trzeci punkt definiuje oś y). 

• Wpisz o i naciśnij Enter, aby wybrać jednostkę definiującą płaszczyznę przekroju. 

• Określ oś, wpisując odpowiednią literę i naciskając Enter. 

4 Określ, która strona ma zostać zachowana, lub wpisz b, aby zachować obie strony. 

 

Modyfikowanie twarzy 

Trójwymiarowe bryły można edytować poprzez wyciągnięcie, przesunięcie, obrót, 

przesunięcie, zwężenie, usunięcie lub skopiowanie poszczególnych powierzchni. Można 

także zmieniać kolor poszczególnych powierzchni. 

 

Wytłaczanie powierzchni pełnych 

Aby wyciąć bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Extrude Face (  ): 

• Na wstążce wybierz Draw 3D > Extrude Face (w edycji brył). 

• Z menu wybierz polecenie Modyfikuj > Edycja brył > Wyciągnięcie powierzchni. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Wyciągnięcie powierzchni. 

2 Wybierz jednostkę ze ścianą, którą chcesz wyciąć. 

3 Wybierz ściany do wyciągnięcia i naciśnij Enter. 

4 Wykonaj jedną z poniższych czynności: 

• Określa wysokość wytłaczania. 

• Wpisz p i naciśnij Enter, aby wybrać ścieżkę do wytłaczania. 

5 Jeśli określono wysokość, należy określić kąt stożka. 
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Wybierz element, który ma być wytłaczany, 
a następnie określ 
powierzchnia(e) do wyciągnięcia (A) 
oraz wysokość wyciągnięcia lub ścieżka. 

 

Przesuwanie powierzchni brył 

Aby przesunąć bryłę 

Wynikowa jednostka z powierzchnią wyciągniętą do 
pozycja (B). 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Przesuń twarz (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Przesuń twarz (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Przesuń twarz. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Przesuń lico. 

2 Wybierz jednostkę z twarzą, którą chcesz przenieść. 

3 Wybierz twarz(e) do przeniesienia i naciśnij Enter. 

4 Określ punkt bazowy. 

5 Określ punkt końcowy. 
 

 
Wybierz jednostkę, a następnie 
określ ściany do przesunięcia (A), 
punkt bazowy (B) i punkt końcowy 
(C). 

Wynikowa jednostka z twarzą zostanie 
przeniesiona do nowej pozycji. 
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Obracanie powierzchni brył 

Aby obrócić bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Obróć twarz (  ): 

• Na wstążce wybierz Rysuj 3D > Obróć twarz (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Obróć twarz. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Obróć powierzchnię. 

2 Wybierz jednostkę z twarzą, którą chcesz obrócić. 

3 Wybierz twarz(e) do obrócenia i naciśnij Enter. 

4 Określ punkt bazowy. 

5 Określenie innego punktu na osi obrotu. 

6 Określa kąt obrotu. 
 

 
Wybierz jednostkę, a następnie określ 
twarz(e) do 
obrót (A), punkt bazowy (B), drugi punkt na 
osi obrotu (C) i kąt obrotu. 

 

Przesunięcie powierzchni brył 

Aby zrównoważyć solidną 
powierzchnię 

Wynikowa jednostka z twarzą obróconą do pozycji 
(D). 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Offset Face (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Przesunięcie powierzchni (w edycji brył). 

• W menu wybierz polecenie Modyfikuj > Edycja brył > Przesunięcie powierzchni. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Odsunięcie powierzchni. 

2 Wybierz jednostkę ze ścianą, którą chcesz przesunąć. 

3 Wybierz twarz(e) do przesunięcia i naciśnij Enter. 

4 Określa odległość przesunięcia. 
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Wybierz jednostkę, a następnie określ 
twarz(e) do 
przesunięcie (A) i odległość do przesunięcia. 

 

Zwężające się powierzchnie 
czołowe 

Aby zwęzić litą powierzchnię 

Wynikowa jednostka z przesunięciem twarzy do pozycji 
(B). 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Taper Face (  ): 

• Na wstążce wybierz Draw 3D > Taper Face (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Powierzchnie stożkowe. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Stożkowa powierzchnia. 

2 Wybierz jednostkę z powierzchnią, którą chcesz zwęzić. 

3 Wybierz twarz(e) do zwężenia i naciśnij Enter. 

4 Określ punkt bazowy. 

5 Określ inny punkt wzdłuż osi. 

6 Określ kąt stożka. 
 

 
Wybierz jednostkę, a następnie określ 
twarz(e) do 
stożka (A), punkt bazowy, drugi punkt wzdłuż 
osi stożka oraz kąt stożka. 

Powstała w ten sposób jednostka o zwężonej pozycji 
(D). 



D R A W I E N I E W S Z Y S T K I C H D Y M E N S A C H 635 

 
 

Usuwanie jednolitych powierzchni 

Aby usunąć bryłę 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Usuń twarz (  ): 

• Na wstążce wybierz polecenie Draw 3D > Delete Face (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Usuń twarz. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Usuń powierzchnię. 

2 Wybierz jednostkę z twarzą, którą chcesz usunąć. 

3 Wybierz twarz(e) do usunięcia i naciśnij Enter. 
 

 
Wybierz jednostkę, a następnie określ 
twarz(e) do 
usunąć (A). 

 

Kopiowanie powierzchni brył 

Aby skopiować bryłę 

Wynikowa jednostka z usuniętą twarzą. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj twarz (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Kopiuj lico (w edycji brył). 

• W menu wybierz polecenie Modyfikuj > Edycja brył > Kopiuj lico. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Kopiuj powierzchnię. 

2 Wybierz jednostkę z twarzą, którą chcesz skopiować. 

3 Wybierz twarz(e) do skopiowania i naciśnij Enter. 

4 Określ punkt bazowy. 

5 Określ punkt końcowy. 
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Wybierz jednostkę, a następnie określ 
twarz(e) do 
kopia (A), punkt bazowy (B) i punkt końcowy 
(C). 

 

Kolorowanie powierzchni brył 

Aby pokolorować twarz 

Wynikowa jednostka ze skopiowaną twarzą. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kolor twarzy (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Kolor twarzy (w edycji brył). 

• W menu wybierz polecenie Modyfikuj > Edycja brył > Twarz koloru. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Kolor twarzy. 

2 Wybierz jednostkę z twarzą, którą chcesz pokolorować. 

3 Wybierz twarz(e) do pokolorowania i naciśnij Enter. 

4 Określ kolor. 
 

 
Wybierz jednostkę, a następnie określ 
twarz(e) do 
kolor (A). 

Wynikowa jednostka z pokolorowaną twarzą. 
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Modyfikowanie krawędzi 

Oprócz modyfikowania powierzchni brył można także modyfikować poszczególne 

krawędzie. Można kopiować poszczególne krawędzie lub zmieniać ich kolor. 
 

Aby skopiować krawędź 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Kopiuj krawędź (  ): 

• Na wstążce wybierz Rysuj 3D > Kopiuj krawędź (w edycji brył). 

• W menu wybierz polecenie Modyfikuj > Edycja brył > Kopiuj krawędź. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Kopiuj krawędź. 

2 Wybierz jednostkę z krawędzią, którą chcesz skopiować. 

3 Wybierz krawędzie do skopiowania i naciśnij Enter. 

4 Określ punkt bazowy. 

5 Określ punkt końcowy. 
 

 
Wybierz podmiot, a następnie określ krawędź 
(krawędzie) do 
kopia (A), punkt bazowy (B) i punkt końcowy 
(C). 

Aby pokolorować krawędź 

Jednostka wynikowa ze skopiowaną krawędzią. 

 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Color Edge (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Kolor krawędzi (w edycji brył). 

• Z menu wybierz polecenie Modyfikuj > Edycja brył > Kolor krawędzi. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Kolor krawędzi. 

2 Wybierz jednostkę z krawędzią, którą chcesz pokolorować. 

3 Wybierz krawędzie do pokolorowania i naciśnij Enter. 

4 Określ kolor. 
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Odciskanie ciał stałych 

Powierzchnię bryły można zmodyfikować poprzez nadrukowanie na niej innego 

elementu. Na przykład, można nadrukować linię, łuk lub polilinię na lico pudełka. 
 

Aby odcisnąć solidną całość 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Odcisk (  ): 

• Na wstążce wybierz Rysuj 3D > Odcisk (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Odcisk. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Odcisk. 

2 Wybierz bryłę, którą chcesz nadrukować. 

3 Wybierz jednostkę, którą chcesz nadrukować na bryle. 

 
Oddzielanie ciał stałych 

Można rozdzielić ciała stałe, które zostały połączone. Po rozdzieleniu są one rozdzielane 

na poszczególne ciała stałe. 
 

Oddzielanie ciał stałych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Separate (  ): 

• Na wstążce wybierz polecenie Rysuj 3D > Oddziel (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Oddziel. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Oddziel. 

2 Wybierz bryłę, którą chcesz oddzielić. 

 
Łuskanie ciał stałych 

Z bryły 3D można utworzyć powłokę lub wydrążoną cienką ścianę. ALCAD 

przesuwa istniejące powierzchnie, aby utworzyć nowe. 
 

Aby pokryć ciało stałe 

1 Wykonaj jedną z poniższych czynności, aby wybrać Shell (  ): 

• Na wstążce wybierz Rysuj 3D > Powłoka (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Powłoka. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Powłoka. 

2 Wybierz jednostkę, którą chcesz powlekać. 

3 Usuń wszystkie twarze, których nie chcesz uwzględniać. 

4 Określa odległość przesunięcia. 
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Wybierz jednostkę, a następnie wybierz 
ściany do usunięcia (A) i (B), a 
następnie określ odległość 
przesunięcia. 

 

Czyszczenie ciał 
stałych 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Powstała w ten sposób powłoka. 

 

Z brył można usuwać zbędne krawędzie lub wierzchołki, jeśli nie są one potrzebne. 
 

Aby wyczyścić ciało stałe 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Wyczyść (  ): 

• Na wstążce wybierz Rysuj 3D > Wyczyść (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Wyczyść. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Wyczyść. 

2 Wybierz jednostkę, którą chcesz wyczyścić. 

 
Sprawdzanie ciał stałych 

Można sprawdzić, czy wybrana jednostka jest prawidłową trójwymiarową bryłą 

ACIS. Jeśli jest to prawidłowa bryła 3D, można ją modyfikować za pomocą poleceń 

edycji bryły 3D; jeśli nie, nie można edytować bryły za pomocą tych poleceń. 
 

Aby sprawdzić stałą 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Sprawdź (  ): 

• Na wstążce wybierz Rysuj 3D > Zaznacz (w edycji brył). 

• W menu wybierz Modyfikuj > Edycja brył > Sprawdź. 

• Na pasku narzędzi Edycja brył kliknij narzędzie Zaznaczanie. 

2 Wybierz podmioty do sprawdzenia. 
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Ukrywanie, cieniowanie i renderowanie 
 

Podczas tworzenia trójwymiarowych obiektów program wyświetla zarówno modele 

szkieletowe, jak i powierzchniowe w widoku szkieletowym, co utrudnia 

wizualizację trójwymiarowych modeli. Aby lepiej zwizualizować model, można 

usunąć wszystkie linie, które są ukryte za innymi obiektami lub powierzchniami 

widzianymi z bieżącego punktu widzenia. 

Cieniowanie idzie o krok dalej, usuwając ukryte linie, a następnie przypisując 

płaskie kolory do widocznych powierzchni, dzięki czemu wydają się one solidne. 

Cieniowane obrazy są przydatne, gdy chcesz szybko zwizualizować swój model 

jako bryłę, choć brakuje im głębi i definicji. 

Renderowanie zapewnia jeszcze bardziej realistyczny obraz modelu, wraz ze 

źródłami światła, cieniami, właściwościami materiałów powierzchniowych i 

odbiciami, nadając modelowi fotorealistyczny wygląd. Jak pokazano na poniższych 

ilustracjach, podczas renderowania modelu program usuwa ukryte linie, a następnie 

cieniuje powierzchnie tak, jakby były oświetlone przez wyimaginowane źródła 

światła. 
 

Model szkieletowy. Obraz z ukrytą linią. Obraz cieniowany. Obraz renderowany. 

 

Zrozumienie dynamicznego i statycznego ukrywania, cieniowania i 

renderowania ALCAD zawiera dwa sposoby ukrywania, cieniowania i 

renderowania rysunków, z których każdy ma swoje zalety: 

• Dynamiczne style wizualne - rysunki wyświetlają widok ukrytej linii, 

cieniowany lub renderowany w czasie rzeczywistym podczas rysowania i edycji. 

Do rysunku można dodawać materiały, światła i tło, a ich efekty są również 

wyświetlane dynamicznie. Style wizualne są oparte na urządzeniach graficznych 

OpenGL i OpenGL ES. 

• Obrazy statyczne - dla bieżącego widoku tworzone są statyczne obrazy z ukrytą 

linią, cieniem i renderowane. Chociaż nie są one dynamiczne, można tworzyć 

obrazy statyczne przy użyciu większej liczby opcji niż style wizualne, takich jak 

cienie słoneczne, odbicia, refaktoryzacja i możliwość edycji materiałów. Obrazy 

statyczne są oparte na renderowaniu DaVinci. 

 

Używanie dynamicznych stylów wizualnych do ukrywania, 

cieniowania i renderowania Style wizualne mogą zmieniać sposób 

wyświetlania rysunku w czasie rzeczywistym podczas rysowania i edytowania 

rysunku. Podczas pracy można również dodawać materiały do obiektów, 

oświetlenie do sceny i tło do bieżącego widoku, a wszystkie te elementy są 

wyświetlane za pomocą stylów wizualnych obsługujących renderowanie, takich jak 



Realistic i Shaded. 
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Wyświetlanie rysunku ze stylem wizualnym 
Możesz wybierać spośród różnych stylów w zależności od potrzeb. Na przykład, jeśli 

dopiero zaczynasz nowy rysunek, możesz chcieć wyświetlić go w trybie 

szkieletowym, który wygląda podobnie do modelu wykonanego z drutu i wyświetla 

się szybciej niż bardziej złożone style wizualne. Następnie, w miarę postępów w 

rysowaniu, można przełączyć się na bardziej szczegółowy styl wizualny. 

Dostępne są następujące style wizualne: 

• 2D Wireframe - rysunek wyświetlany w dwóch wymiarach ze wszystkimi 

liniami narysowanymi na krawędziach obiektów. 

• Koncepcyjne - rysunki wyświetlane w trzech wymiarach z powierzchniami 

cieniowanymi w rzeczywistych kolorach. 

• Ukryte - rysunek jest wyświetlany w trzech wymiarach, a wszystkie linie są 

rysowane na krawędziach obiektów, z wyjątkiem tych znajdujących się za 

powierzchniami. 

• Realistyczny - rysunek wyświetlany w trzech wymiarach z 

powierzchniami wypełnionymi przypisanymi materiałami. 

• Cieniowane - rysunek jest wyświetlany w trzech wymiarach z cieniowanymi 

powierzchniami. 

• Cieniowane z krawędziami - rysunek jest wyświetlany w trzech wymiarach z 

cieniowanymi powierzchniami i liniami rysowanymi na krawędziach 

powierzchni. 

• Shades of Gray - Rysowanie wyświetlaczy w trzech wymiarach z 

powierzchniami cieniowanymi w monochromatycznych odcieniach szarości. 

• Sketchy - wyświetlanie rysunków w dwóch i trzech wymiarach z efektem 

odręcznego szkicu. 

• Wireframe - rysunek wyświetlany w trzech wymiarach ze wszystkimi liniami 

narysowanymi na krawędziach elementów. 

• X-ray - Rysowanie wyświetla w trzech wymiarach z częściowo przezroczystymi 

powierzchniami. Im więcej szczegółów jest wyświetlanych na ekranie, tym większy 

wpływ na wydajność. 

Aby zmienić styl wizualny 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Widok i w sekcji Style wizualne dokonaj wyboru. 

• W menu wybierz Widok > Style wizualne, a następnie dokonaj wyboru. 

• Na pasku narzędzi Widok kliknij zaznaczenie. 

• Wpisz vscurrent, naciśnij Enter, a następnie dokonaj wyboru. 

 
Dodawanie materiałów wyświetlanych za pomocą stylów wizualnych 
Materiałami wyświetlanymi za pomocą stylów wizualnych zarządza się za pomocą 

polecenia Eksploruj materiały. Po zaimportowaniu materiałów do rysunku można 

przypisać je do jednostek i warstw, a ich efekty są widoczne przy użyciu stylu 

wizualnego Realistyczny. 

Użyj realistycznego stylu wizualnego do wyświetlania materiałów przypisanych do podmiotów. 
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Więcej informacji na temat korzystania z Eksploratora materiałów można znaleźć w 

sekcji "Praca z materiałami" na stronie 306. 

 

Dodawanie efektów świetlnych wyświetlanych wraz ze stylami wizualnymi 
ALCAD stosuje domyślne oświetlenie do wszystkich modeli, gdy rysunek jest 

wyświetlany przy użyciu stylów wizualnych Realistic, Shaded, Shaded with Edges 

i Shades of Gray. 

Jeśli chcesz utworzyć określoną scenę oświetlenia, możesz dodać własne światła, 

które określają rozmieszczenie świateł, kolor światła i intensywność światła, aby określić 

sposób oświetlenia rysunku lub sceny. Światła mogą być umieszczone poza polem 

widzenia lub wewnątrz, aby oświetlić różne obszary sceny. 

Istnieje kilka sposobów na dodanie niestandardowego oświetlenia do rysunku: 

• Polecenie światła punktowego Światło punktowe emituje światło ze swojej 

lokalizacji we wszystkich kierunkach. Światła punktowe są elementami rysunku, 

a ich efekty pojawiają się dla cieniowanych lub czerwonych stylów wizualnych 

w ALCAD i oprogramowaniu innych firm, takim jak Artisan Ren- derer. 

• Polecenie światła punktowego Światło punktowe rzuca światło w kształcie 

stożka z jego lokalizacji w kierunku określonym przez użytkownika. Światła punktowe 

są elementami na rysunkach, a ich efekty pojawiają się dla cieniowanych lub 

renderowanych stylów wizualnych w ALCAD i oprogramowaniu innych firm, 

takim jak Artisan Renderer. 

Aby utworzyć światło punktowe 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Światło punktowe (  ): 

• Na wstążce wybierz polecenie Widok > Światło punktowe (w obszarze Światła). 

• W menu wybierz Widok > Światła > Światło punktowe. 

• Wpisz pointlight i naciśnij Enter. 

2 Jeśli domyślne oświetlenie jest obecnie włączone, ALCAD wyświetli monit o 

jego wyłączenie, aby można było zobaczyć efekt nowych świateł. Kliknij Tak, 

aby wyłączyć domyślne oświetlenie. 

3 Wprowadź współrzędne x, y i z miejsca umieszczenia światła punktowego lub 

kliknij lokalizację na rysunku. 
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Aby utworzyć światło punktowe 

1 Wykonaj jedną z poniższych czynności, aby wybrać oświetlenie punktowe (  ): 

• Na wstążce wybierz polecenie Widok > Światło punktowe (w obszarze Światła). 

• W menu wybierz Widok > Światła > Światło punktowe. 

• Wpisz spotlight i naciśnij Enter. 

2 Jeśli domyślne oświetlenie jest obecnie włączone, ALCAD wyświetli monit o 

jego wyłączenie, aby można było zobaczyć efekt nowych świateł. Kliknij Tak, 

aby wyłączyć domyślne oświetlenie. 

3 Wprowadź współrzędne x, y i z miejsca umieszczenia światła punktowego 

lub kliknij lokalizację na rysunku. 

4 Następnie wprowadź współrzędne x, y i z miejsca, które ma zostać oświetlone, 

lub kliknij miejsce na rysunku. 
 

Edytuj światła punktowe i punktowe. 

Światła punktowe i punktowe można przenosić i kopiować na rysunku, tak jak każdą 

inną jednostkę. Aby określić ustawienia światła punktowego lub punktowego, takie 

jak kolor i tłumienie, kliknij prawym przyciskiem myszy światło punktowe, wybierz 

Właściwości i dokonaj wyboru w panelu Właściwości. Po wybraniu światła 

punktowego wyświetlane są uchwyty umożliwiające zmianę lokalizacji światła i celu, 

rozmiaru stożka i rozmiaru spadku. 
 

 
Dodawanie tła wyświetlanego ze stylami wizualnymi 

Tła są wyświetlane dla bieżącego widoku podczas korzystania z dowolnego stylu 

wizualnego z wyjątkiem 2D Wireframe. Można wybrać tło w jednolitym kolorze, 

gradientowe lub graficzne. 

Tła mogą być również przypisywane do nazwanych widoków i wyświetlane z tymi 

samymi stylami wizualnymi. Więcej informacji można znaleźć w sekcji 

"Ustawianie tła dla nazwanego widoku" na stronie 579 w tym rozdziale. 
 

Aby ustawić tło dla bieżącego widoku 

1 Wykonaj jedną z poniższych czynności, aby wybrać tło (  ): 

• Na wstążce wybierz Widok > Tło (w widokach). 

• W menu wybierz Widok > Tło. 

• Wpisz background i naciśnij Enter. 

2 Wybierz jedną z poniższych opcji: 

• Solidny 

• Gradient 

• Obraz 

3 W oknie dialogowym Tło dokonaj wyboru. Kliknij [?], aby wyświetlić 

szczegółowe informacje na temat każdej opcji. 

4 Kliknij przycisk OK. 



644 C H A P T E R 1 5 

 

Tworzenie statycznych obrazów z ukrytą linią, cieniowanych i 
renderowanych 

 
Tworzenie obrazów z ukrytą linią 
Utworzenie obrazu rysunku z ukrytymi liniami usuwa wszystkie linie, które są 

ukryte za innymi powierzchniami widzianymi z punktu obserwacyjnego. Po 

usunięciu ukrytych linii lub zacieniowaniu modelu program traktuje obiekty w różny 

sposób, w zależności od sposobu ich utworzenia. Modele szkieletowe są zawsze 

przezroczyste, ponieważ nie mają powierzchni. Modele powierzchniowe wydają się 

wypełnione, z powierzchniami zastosowanymi do wszystkich widocznych boków. 

Widok ukrytych linii można także kontrolować indywidualnie dla każdej 

jednostki, pokazując i ukrywając krawędzie wybranych powierzchni 3D, siatek i 

siatek wielopowierzchniowych. 
 

Aby utworzyć obraz ukrytej linii 

• Wpisz hide i naciśnij Enter. 
 

Użyj stylu wizualnego. 

Wybranie opcji Widok > Style wizualne > Ukryty jest podobne do użycia polecenia 

Ukryj. Więcej informacji można znaleźć w sekcji "Wyświetlanie rysunku ze stylem 

wizualnym" na stronie 641. 
 

 

Przed utworzeniem obrazu z ukrytymi liniami. Po usunięciu ukrytych linii. 

Ukryte krawędzie powierzchni 3D, siatek i siatek wielopowierzchniowych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Ukryj krawędzie (  ): 

• Na wstążce wybierz Rysuj 3D > Ukryj krawędzie (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Ukryj krawędzie. 

• Wpisz hideedges i naciśnij Enter. 

2 Wybierz jednostki z krawędziami, które chcesz ukryć, a następnie naciśnij Enter po 

zakończeniu. 

 

Poszczególne krawędzie mogą być ukryte w przypadku twarzy 3D. 

Polecenie Ukryj krawędzie ukrywa wszystkie krawędzie wybranych obiektów, ale 

jeśli pracujesz z powierzchniami 3D, możesz także użyć polecenia Krawędź, aby 

ukryć poszczególne krawędzie. 
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Wyświetlanie krawędzi powierzchni 3D, siatek i siatek wielopowierzchniowych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Pokaż krawędzie (  ): 

• Na wstążce wybierz Rysuj 3D > Pokaż krawędzie (w Rysuj siatki 3D). 

• W menu wybierz Rysuj > Siatki 3D > Pokaż krawędzie. 

• Wpisz showges i naciśnij Enter. 

2 Wybierz jednostki z krawędziami, które chcesz wyświetlić, a następnie naciśnij Enter po 

zakończeniu. 

 

Poszczególne krawędzie mogą być wyświetlane dla powierzchni 3D. 

Polecenie Pokaż krawędzie wyświetla wszystkie krawędzie wybranych obiektów, ale 

jeśli pracujesz z powierzchniami 3D, możesz także użyć polecenia Krawędź, aby 

wyświetlić poszczególne krawędzie. 
 

 
Tworzenie cieniowanych obrazów 
Tworzenie cieniowanego obrazu rysunku usuwa ukryte linie, a następnie stosuje 

cieniowanie do widocznych powierzchni w oparciu o ich kolor jednostki. Ponieważ 

mają one zapewnić szybką wizualizację, cieniowane obrazy nie mają źródła światła i 

używają ciągłych kolorów na powierzchniach, przez co wydają się płaskie i 

nierealistyczne. 
 

Aby utworzyć zacieniony obraz 

• Wpisz shade i naciśnij Enter. 

Aby kontrolować wygląd cieniowanego obrazu, wybierz polecenie Narzędzia > 

Ustawienia rysowania, a następnie kliknij kartę Ustawienia 3D i wybierz 

odpowiednie opcje. Powierzchnie i krawędzie modelu można cieniować na cztery 

sposoby: 

• Twarze zacienione; krawędzie nie wyróżnione. 

• Twarze zacienione; krawędzie podświetlone w kolorze tła. 

• Twarze wypełnione kolorem tła; krawędzie narysowane przy użyciu koloru 

jednostki (podobnie jak w widoku ukrytej linii). 

• Powierzchnie wypełnione kolorem jednostki; krawędzie podświetlone kolorem tła. 

 

Użyj stylu wizualnego. 

Wybór cieniowanego stylu wizualnego (Widok > Style wizualne) jest podobny do 

użycia polecenia Cień. Więcej informacji można znaleźć w sekcji "Wyświetlanie 

rysunku ze stylem wizualnym" na stronie 641. 
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Tworzenie fotorealistycznych renderowanych obrazów 
Tworzenie renderowanego obrazu rysunku usuwa ukryte linie, a następnie cieniuje 

powierzchnię tak, jakby była oświetlona z wielu źródeł światła. 

Pełny rendering tworzy fotorealistyczny obraz modelu wraz ze źródłami światła, 

cieniami, właściwościami materiałów powierzchniowych i odbiciami. Obraz można 

oświetlić reflektorami punktowymi, odległym oświetleniem symulującym promienie 

słoneczne oraz światłem otoczenia. Jeśli nie zdecydujesz się na dostosowanie źródeł 

światła, program wygeneruje dla Ciebie domyślne źródła światła. 

Promienie z tych wyimaginowanych źródeł światła są śledzone, gdy odbijają się i 

załamują przez powierzchnie modelu, w procesie zwanym ray tracing. Śledzenie 

promieni określa, gdzie padają cienie i jak wyglądają odbicia na błyszczących 

materiałach, takich jak metal i szkło. Możesz modyfikować właściwości 

odblaskowe materiałów tworzących model, aby kontrolować sposób, w jaki 

promienie światła odbijają się od jego powierzchni. 

Pełne renderowanie automatycznie tworzy podstawę, na której wyświetlany jest 

model, jeśli jeszcze jej nie ma, dzięki czemu nie wydaje się on zawieszony w 

przestrzeni. Tło jest również automatycznie dodawane do obrazu. Tło, takie jak 

zachmurzone niebo lub zaimportowana grafika rastrowa, taka jak kamienna ściana, 

może być również dodana za obrazem, czyniąc go jeszcze bardziej realistycznym. 
 

Aby utworzyć szybko renderowany obraz 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Renderuj (  ): 

• Na wstążce wybierz Widok > Ustawienia renderowania (w Renderowanie). 

• W menu wybierz Widok > Renderowanie > Renderuj. 

• Na pasku narzędzi Renderowanie kliknij narzędzie Renderuj. 

• Wpisz render i naciśnij Enter. 

Aby utworzyć w pełni renderowany obraz 

Wykonaj jedną z poniższych czynności, aby wybrać opcję Full Render (  ): 

• Na wstążce wybierz Widok > Ustawienia renderowania (w Renderowanie). 

• W menu wybierz Widok > Renderowanie > Renderowanie pełne. 

• Na pasku narzędzi Renderowanie kliknij narzędzie Renderowanie pełne. 

• Wpisz fullrender i naciśnij Enter. 



D R A W I E N I E W R Ó Ż N Y C H D Y M E N S A C H 647 

 

 

W pełni wyrenderowany obraz. 
 

Użyj stylu wizualnego. 

Wybór realistycznego stylu wizualnego (Widok > Style wizualne) jest podobny do 

korzystania z poleceń ren- der. Więcej informacji można znaleźć w sekcji 

"Wyświetlanie rysunku ze stylem wizualnym" na stronie 641. 
 

 
Tworzenie niestandardowych renderowanych obrazów 

Przed użyciem polecenia Pełne renderowanie w celu utworzenia wyrenderowanego 

obrazu rysunku można zastosować materiały, tło i oświetlenie (w tym cienie) w celu 

dostosowania rysunku: 

• Materiały Określ materiały dla różnych powierzchni i zdefiniuj sposób 

mapowania materiałów na te powierzchnie. Predefiniowane materiały są 

dostępne w bibliotece materiałów, którą można dalej dostosowywać za pomocą 

wbudowanego edytora. Można wybrać użycie materiałów proceduralnych lub 

bitmapowych. 

• Tła Określa tło dla renderowanego obrazu. Dostępnych jest kilka 

predefiniowanych teł. Domyślnie tło nie jest używane i jest wyświetlane w 

kolorze czarnym. Tło jest nieskończoną, płaską powierzchnią i odbija się od 

wszelkich odblaskowych powierzchni w modelu. Na tło nie ma jednak wpływu 

oświetlenie, więc nie widać na nim cieni ani świateł. 
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• Oświetlenie Określ rozmieszczenie świateł, kolor światła i intensywność 

światła, aby określić sposób oświetlenia rysunku lub sceny, w tym cieni i odbić 

w scenie. Światła mogą być umieszczone poza polem widzenia lub wewnątrz, 

aby oświetlić różne obszary sceny. Dostępnych jest kilka predefiniowanych 

elementów sterujących oświetleniem, w tym oświetlenie otoczenia, oświetlenie 

rozproszone, odbicia zwierciadlane, wysokie światła zwierciadlane i 

przezroczystość. 
 

Stosowanie materiałów, tła i oświetlenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać materiały (  ), 

tła (  ) lub oświetlenie (  ): 

• Na wstążce wybierz Widok > Materiały, Tła lub Oświetlenie (w 

Renderingu). 

• W menu wybierz Widok > Renderowanie, a następnie wybierz 

Materiały, Tła lub Oświetlenie. 

• Na pasku narzędzi Renderowanie kliknij narzędzie Materiały, Tła lub Oświetlenie. 

• Wpisz materiały, tła lub oświetlenie, a następnie naciśnij klawisz Enter. 

2 Dokonaj wyboru. 
 

Można określić dodatkowe opcje renderowania. 

Wybierz polecenie Widok > Renderowanie > Ustawienia renderowania. Aby 

uzyskać więcej informacji na temat tworzenia niestandardowych renderowanych 

obrazów, kliknij przycisk Pomoc w dowolnym oknie dialogowym renderowania. 
 

 
Zapisywanie wyrenderowanego obrazu 

Wyrenderowany obraz można zapisać w innym formacie - bitmapy (.bmp), JPEG 

(.jpg), TIFF (.tif), TrueVision TGA (.tga) lub Portable Network Graphic (.png). Jeśli 

chcesz wydrukować wyrenderowany obraz, możesz wydrukować zapisany obraz z innego 

programu graficznego. 

Aby zapisać wyrenderowany obraz rysunku 

1 Utwórz renderowany obraz rysunku. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Ustawienia renderowania (  ): 

• Na wstążce wybierz Widok > Ustawienia renderowania (w Renderowanie). 

• W menu wybierz Widok > Renderowanie > Ustawienia renderowania. 

• Na pasku narzędzi Renderowanie kliknij narzędzie Ustawienia renderowania. 

• Wpisz setrender i naciśnij Enter. 

3 Na karcie Renderowanie kliknij przycisk Zapisz ostatni obraz. 

4 Wprowadź nazwę pliku i ścieżkę dostępu. 

5 W polu Zapisz jako typ wybierz format pliku. 

6 Kliknij przycisk Zapisz. 
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Renderowanie w programie Artisan Renderer 

Podobnie jak polecenie Full Render w ALCAD, Artisan Renderer pozwala na 

stworzenie fotorealistycznego obrazu modelu. Jednak wielu użytkowników woli 

korzystać z Artisan Renderer, aby przyspieszyć proces projektowania dzięki dostępowi do 

szerokiej gamy wstępnie ustawionych materiałów i konfiguracji oświetlenia, a także 

możliwości tworzenia niestandardowych realistycznych materiałów. 

Aby uzyskać więcej informacji na temat Artisan Renderer, wybierz Pomoc > Pomoc w Artisan 

Renderer. 
 

Aby utworzyć renderowany obraz w Artisan Renderer 

1 Zapisz rysunek. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Artisan Render (  ): 

• Na wstążce wybierz Widok > Artisan (w Renderowanie). 

• W menu wybierz Widok > Renderowanie > Artisan. 

• Na pasku narzędzi Artisan Rendering kliknij narzędzie Artisan. 

• Wpisz artisan, a następnie naciśnij Enter. 

3 Jeśli wyświetlone zostanie okno dialogowe Artisan Settings, wybierz jedną z poniższych 

opcji: 

• Jednostki Wybierz jednostki. 

• Język Wybierz język. Aby użyć języka systemu operacyjnego, wybierz 

opcję Use System Locale. 

• Rozdzielczość faset Ustaw rozdzielczość cieniowanych trójwymiarowych 

elementów i faset podczas eksportowania do Artisan Renderer. 

• Kąt wygładzania Ustawienie kąta wygładzania krawędzi zagnieceń 

podczas eksportowania do programu Artisan Renderer. 

• Pokaż przy uruchamianiu Wybierz, aby wyświetlić okno dialogowe 

Ustawienia Artisan za każdym razem, gdy używasz polecenia Artisan lub 

Artisan Sync w programie ALCAD. 

4 Kliknij przycisk OK. 

Artisan Renderer otwiera i wyświetla model w celu dodania materiałów i innych 

efektów. Aby uzyskać więcej informacji na temat korzystania z aplikacji Artisan 

Renderer, wybierz polecenie Pomoc > Pomoc w aplikacji Artisan Renderer. 
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Aby zsynchronizować najnowszy model z Artisan Renderer 

1 Zapisz rysunek. 

2 Wykonaj jedną z poniższych czynności, aby wybrać Artisan Sync (  ): 

• Na wstążce wybierz polecenie Widok > Synchronizacja Artisan (w Renderowanie). 

• W menu wybierz Widok > Renderowanie > Artisan Sync. 

• Na pasku narzędzi Artisan Rendering kliknij narzędzie Artisan Sync. 

• Wpisz artisan-sync i naciśnij Enter. 

Artisan Renderer jest aktualizowany o najnowszy model z ALCAD, co jest 

pomocne, jeśli pracujesz w ALCAD i Artisan Renderer w tym samym czasie i 

zmienisz model w ALCAD. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
ALCAD oferuje dużą elastyczność w zakresie możliwości wykorzystania z innymi 

programami. Możesz dołączyć rysunek ALCAD do dokumentu Microsoft® Word lub 

wstawić arkusz kalkulacyjny Microsoft® Excel zawierający listę części do rysunku 

ALCAD. Aby dołączyć rysunki ALCAD do innych programów i dokumentów z 

innych programów do rysunków ALCAD, należy je połączyć lub osadzić. Możesz 

także zapisywać rysunki Intelli-CAD w innych formatach plików, które mogą być 

używane bezpośrednio z innymi programami lub wysyłać rysunki ALCAD do 

współpracowników za pośrednictwem poczty elektronicznej. 

W tej sekcji wyjaśniono, jak 

• Zapisywanie i wyświetlanie migawek. 

• Używaj łączenia i osadzania obiektów. 

• Eksport rysunków ALCAD do innych formatów plików. 

• Konwersja jednego lub więcej rysunków do innych formatów plików. 

• Używanie danych ALCAD na innych komputerach. 

• Używanie ALCAD z Internetem. 

 

 

 

 

 

 
Tematy w tym rozdziale 

Zapisywanie i wyświetlanie migawek  .............................................................. 652 

Używanie danych z innych programów w rysunkach ALCAD .......................... 653 

Korzystanie z danych ALCAD w innych programach  ...................................... 662 

Korzystanie z danych ALCAD na innych komputerach  ................................... 672 

Korzystanie z ALCAD z Internetem  ................................................................ 679 

Praca z podpisami cyfrowymi........................................................................... 682 
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Zapisywanie i wyświetlanie migawek 
 

Można zapisywać migawki rysunku do późniejszego wyświetlenia. Migawka 

zapisuje bieżący rysunek w formacie *.emf, *.wmf lub *.sld dokładnie tak, jak 

wygląda on na ekranie. Migawka nie jest plikiem rysunku. Nie można edytować ani 

drukować migawki; można ją tylko przeglądać. 

Migawek można używać na następujące sposoby: 

• Twórz prezentacje, pokazując migawki swoich rysunków. 

• Odniesienie do migawki rysunku podczas pracy nad innym rysunkiem. 

• Prezentowanie wielu migawek w formie pokazu slajdów przy użyciu skryptów. 

Podczas wyświetlania migawka tymczasowo zastępuje bieżący rysunek. Po 

odświeżeniu wyświetlania bieżącego rysunku (przez przerysowanie, przesuwanie, 

powiększanie, minimalizowanie, maksymalizowanie lub kafelkowanie) obraz migawki znika 

i następuje powrót do bieżącego rysunku. 

 

Tworzenie migawek 

Migawkę tworzy się poprzez zapisanie bieżącego widoku jako migawki. Migawka 

nie zawiera żadnych elementów na warstwach, które nie są aktualnie widoczne. 

Zawartość migawki zależy również od bieżącej przestrzeni rysowania. W przestrzeni 

modelu migawka pokazuje tylko bieżącą rzutnię. W przestrzeni papieru migawka 

zawiera wszystkie widoczne rzutnie. 
 

Aby utworzyć migawkę 

1 Wyświetl rysunek dokładnie tak, jak chcesz go uchwycić jako migawkę. 

2 Wykonaj jedną z poniższych czynności, aby wybrać opcję Utwórz migawkę (  ): 

• Na wstążce wybierz Narzędzia > Utwórz migawkę (w Zarządzaj). 

• W menu wybierz Narzędzia > Utwórz migawkę. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Utwórz migawkę. 

• Wpisz msnapshot, a następnie naciśnij Enter. 

3 W oknie dialogowym Utwórz migawkę określ nazwę pliku migawki, który 

chcesz utworzyć. 

4 Z listy typów plików wybierz *.emf, *.wmf lub *.sld. 

5 Kliknij przycisk Zapisz. 
 

Bieżący rysunek pozostaje na ekranie, a migawka jest zapisywana we wskazanym 

katalogu. 
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Wyświetlanie migawek 

Można przeglądać wcześniej zapisane migawki, a także migawki utworzone za 

pomocą programu AutoCAD. 
 

Aby wyświetlić migawkę 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Wyświetl migawkę (w Zarządzaj). 

• Wybierz Narzędzia > Wyświetl migawkę. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Wyświetl migawkę (  ). 

• Wpisz vsnapshot, a następnie naciśnij Enter. 

2 W oknie dialogowym Wyświetl migawkę określ nazwę pliku migawki, który 

chcesz wyświetlić. 

3 Kliknij przycisk Otwórz. 

ALCAD wyświetla migawkę w bieżącym oknie rysunku. 

 

 
 

Używanie danych z innych programów w rysunkach ALCAD 
 

Dane z innych programów można dołączać do rysunków ALCAD za pomocą 

osadzania lub łączenia. Wybrana metoda zależy od typu obiektu lub pliku, który 

chcesz dołączyć do rysunku ALCAD i tego, co chcesz z nim zrobić po jego 

umieszczeniu. 

 

Osadzanie obiektów na rysunkach 

Osadź obiekt w rysunku ALCAD, jeśli chcesz zachować wszystkie dane, z którymi 

pracujesz w jednym pliku lub jeśli chcesz przenieść plik na inne komputery. Możesz 

osadzać dane z programów, które obsługują łączenie i osadzanie obiektów. 

Na przykład, jeśli chcesz rozpowszechniać dane o sprzęcie komputerowym działu 

wraz z rysunkiem ALCAD planu piętra działu, możesz osadzić arkusz kalkulacyjny 
Microsoft® Excel na planie piętra. 

Po osadzeniu danych z innego programu, ALCAD staje się kontenerem dla tych 

danych. Obiekt osadzony na rysunku ALCAD staje się częścią pliku ALCAD. 

Podczas edycji danych otwierany jest program z poziomu rysunku ALCAD. 

Wszelkie zmiany wprowadzone w osadzonych danych istnieją tylko w rysunku 

ALCAD, więc nie jest konieczne przechowywanie tych danych w oddzielnym pliku. Jeśli 

dane istnieją w oddzielnym pliku, oryginalny plik nie zmienia się podczas 

modyfikowania osadzonego obiektu w programie ALCAD. Ponadto zmiany w 

oryginalnym pliku nie mają wpływu na osadzony obiekt na rysunku ALCAD. 
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Aby osadzić obiekt innego programu w rysunku ALCAD 

1 Otwórz plik zawierający żądane dane. 

2 W pliku wybierz dane, które chcesz osadzić na rysunku ALCAD. 

3 Wybierz polecenie tego programu, aby umieścić dane w 

schowku. Zazwyczaj wybiera się polecenie Edycja > Kopiuj. 

4 W oknie ALCAD wyświetl rysunek, w którym chcesz osadzić obiekt. 

5 Wykonaj jedną z poniższych czynności, aby wybrać Wklej (  ): 

• Na wstążce wybierz Start > Wklej (w Schowku) lub wybierz Edycja > Wklej 

(w Modyfikuj) 

• W menu wybierz polecenie Edycja > Wklej. 

• Na pasku narzędzi Standard kliknij narzędzie Wklej. 

• Wpisz wklej i naciśnij Enter. 

Dane ze schowka są wklejane do rysunku jako obiekt osadzony. Obiekt pojawia 

się na środku widoku, ale można go wybrać i przenieść, przesuwając kursor. 
 

Aby osadzić obiekt z istniejącego pliku w ALCAD 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Obiekt (w danych). 

• W menu wybierz Wstaw > Obiekt. 

• Wpisz insertobj i naciśnij Enter. 

2 W oknie dialogowym Wstaw obiekt kliknij przycisk Utwórz z pliku. 

3 Określ plik, wykonując jedną z poniższych czynności: 

• Wpisz ścieżkę i nazwę pliku w polu Plik. 

• Kliknij przycisk Przeglądaj, aby wybrać plik. 

4 Wybierz opcję Wyświetl jako ikonę, jeśli chcesz, aby ikona programu pojawiła 

się na rysunku zamiast danych. 

5 Kliknij przycisk OK. 

Pierwsza strona pliku pojawia się na rysunku ALCAD, chyba że wybrano 

wyświetlanie jej jako ikony. Możesz wybrać obiekt i przeciągnąć go, aby 

zmienić jego położenie. 
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Aby utworzyć nowy obiekt osadzony z poziomu programu ALCAD 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Obiekt (w danych). 

• W menu wybierz Wstaw > Obiekt. 

• Wpisz insertobj i naciśnij Enter. 

2 W oknie dialogowym Wstaw obiekt kliknij przycisk Utwórz nowy. 

3 Z listy Typ obiektu wybierz typ obiektu, który chcesz utworzyć, a następnie 

kliknij przycisk OK. 

Program do tworzenia tego obiektu otwiera się w ALCAD. Jeśli program 

jest kompatybilny z ActiveX, otwiera się w miejscu (w innym programie) na 

rysunku ALCAD; w przeciwnym razie program otwiera się w pełnym oknie. 

4 Utwórz obiekt w drugim programie. 

5 Jeśli program jest uruchomiony w innym dokumencie (w miejscu), kliknij w 

dowolnym miejscu poza osadzonym obiektem, aby zamknąć program. 

Jeśli program jest uruchomiony w pełnym oknie, wybierz Plik > Wyjdź. 

 
Łączenie obiektów z rysunkami 

Jeśli inny program obsługuje ActiveX, można połączyć jego dane z rysunkami 

ALCAD. Użyj linkowania, gdy chcesz dołączyć te same dane do wielu plików. Po 

aktualizacji danych wszystkie łącza do innych plików odzwierciedlają zmiany. 

Na przykład, jeśli utworzyłeś logo swojej firmy w programie do rysowania 

kompatybilnym z ActiveX i chcesz umieścić je w bloku tytułowym każdego 

rysunku utworzonego za pomocą ALCAD, możesz połączyć je z każdym 

rysunkiem ALCAD. Po zmianie oryginalnego logo w programie do rysowania, 

rysunek ALCAD zostanie automatycznie zaktualizowany. 

Gdy łączysz dane z innego programu, rysunek ALCAD przechowuje tylko 

odniesienie do lokalizacji pliku, w którym utworzyłeś dane. Łączysz dane z 

zapisanego pliku, aby ALCAD mógł je znaleźć i wyświetlić. 

Ponieważ linkowanie dodaje tylko odniesienie do pliku, dane nie zwiększają 

znacząco rozmiaru pliku rysunku ALCAD. Łącza wymagają jednak pewnej 

konserwacji. Jeśli przeniesiesz którykolwiek z połączonych plików, musisz 

zaktualizować linki. Ponadto, jeśli chcesz przetransportować połączone dane, musisz 

dołączyć wszystkie połączone pliki. 

Połączony obiekt może być aktualizowany automatycznie przy każdym otwarciu 

rysunku lub tylko wtedy, gdy zostanie to określone. Za każdym razem, gdy łącze jest 

aktualizowane, zmiany wprowadzone w obiekcie w jego oryginalnym pliku 

pojawiają się również na rysunku ALCAD, a zmiany pojawiają się również w 

oryginalnym pliku, jeśli zostały wprowadzone za pośrednictwem ALCAD. 
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Aby połączyć plik z rysunkiem ALCAD 

1 Zapisz oryginalny plik. 

Ponieważ łącze składa się z odniesienia do oryginalnego pliku, należy zapisać 

plik, zanim będzie można utworzyć do niego łącze. 

2 W oryginalnym pliku wybierz dane, które chcesz umieścić na rysunku ALCAD. 

3 Wybierz polecenie tego programu, aby umieścić dane w 

schowku. Zazwyczaj wybiera się polecenie Edycja > Kopiuj. 

4 Wyświetl rysunek ALCAD, z którym chcesz połączyć plik. 

5 W programie ALCAD wybierz Edycja > Wklej specjalnie. 

6 W oknie dialogowym Wklej specjalnie wybierz Wklej łącze. 

7 Kliknij przycisk OK. 
 

Aby utworzyć połączony obiekt z poziomu ALCAD 

1 Wyświetl rysunek ALCAD, w którym chcesz wyświetlić połączony obiekt. 

2 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Obiekt (w danych). 

• W menu wybierz Wstaw > Obiekt 

• Wpisz insertobj i naciśnij Enter. 

3 W oknie dialogowym Wstaw obiekt kliknij przycisk Utwórz z pliku. 

4 Określ plik, wykonując jedną z poniższych czynności: 

• Wpisz ścieżkę i nazwę pliku w polu Plik. 

• Kliknij przycisk Przeglądaj, aby wybrać plik w oknie dialogowym pliku. 

5 Zaznacz pole wyboru Link. 

6 Wybierz opcję Wyświetl jako ikonę, jeśli chcesz, aby ikona programu pojawiła 

się na rysunku zamiast danych. 

7 Kliknij przycisk OK. 

Pierwsza strona pojawia się na rysunku ALCAD, chyba że wybrano 

wyświetlanie jej jako ikony. Aby zmienić położenie obiektu, wybierz go i 

przeciągnij. 

 

Edycja osadzonego lub połączonego obiektu z poziomu 

ALCAD Możesz modyfikować osadzony lub połączony obiekt w jego oryginalnym 

programie z poziomu ALCAD. Modyfikując obiekt osadzony, zmieniasz go tylko 

w programie ALCAD, a nie w oryginalnym pliku (jeśli wkleiłeś obiekt z 

istniejącego pliku). Modyfikując połączony plik, otwierasz i zmieniasz oryginalny 

plik. 
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Większość programów zawiera podmenu czynności, które można wykonać na 

osadzonym lub połączonym obiekcie ActiveX. Zazwyczaj polecenia do edycji 

obiektów ActiveX to Edytuj i Otwórz. Jeśli obiekt jest osadzony, a jego program 

obsługuje edycję w miejscu, polecenie Edytuj otwiera obiekt w miejscu. Polecenie 

Otwórz otwiera obiekt w pełnym oknie programu. W ALCAD polecenie to pojawia 

się w dolnej części menu Edycja. 
 

Aby edytować obiekt osadzony lub połączony 

• Na rysunku ALCAD kliknij dwukrotnie obiekt. 

Jeśli obiekt jest osadzony, a program, w którym został utworzony, obsługuje 

edycję w miejscu, obiekt zostanie otwarty w miejscu. 

Jeśli obiekt jest połączony lub jeśli program nie obsługuje edycji w miejscu, drugi 

program otwiera się w pełnym oknie i wyświetla obiekt. 

 

Importowanie plików utworzonych w innych formatach 

Można importować pliki w następujących formatach: 

• Autodesk format - Autodesk Drawing Exchange Format to opis 

ASCII pliku rysunku z rozszerzeniem .dxf. 

• Autodesk format - Autodesk Drawing Exchange Format to binarny 

opis pliku rysunku z rozszerzeniem .dxb. 

• Format Autodesk - Autodesk Design Web (używany z 

plikami .dwf) służy do rozpowszechniania rysunku, aby inni mogli go 

przeglądać w przeglądarce internetowej, przeglądać i edytować. Format DWF 

wykorzystuje rozszerzenie pliku .dwf. 

• Format DWT - szablony rysunków zawierają predefiniowane ustawienia, które 

można ponownie wykorzystać podczas tworzenia nowych rysunków. Szablony 

rysunków używają rozszerzenia pliku .dwt. 

• Format DGN - pliki rysunkowe używane z 

DGN wykorzystuje rozszerzenie pliku .dgn. 

• Spatial Technologies ACIS format - Trójwymiarowe bryły ACIS zapisane jako 

.sat. 

• Format DAE - pliki Collada są interaktywnym trójwymiarowym plikiem 

graficznym używanym przez aplikacje graficzne 3D (eksportowane są 

trójwymiarowe jednostki, w tym jednostki ACIS). Pliki Collada używają 

rozszerzenia .dae. 

• Format IGES - dane modelu w formacie IGES (Initial Graphics Exchange 

Specification) jako plik .iges lub .igs. 

• Format STEP - dane modelu w formacie STEP (Standard for the Exchange of 

Product) jako plik .step, .ste lub .stp. 

• Format OBJ - dane modelu w formacie OBJ (obiekt Wavefront Technologies) jako 

.obj. 

• Format STL - dane modelu w formacie STL (Stereolithography) jako plik .stl, 

który jest powszechny podczas pracy z drukarkami 3D. 
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• Format IFC - pliki rysunków w formacie IFC (Industry Foundation Classes) 

używane do danych budowlanych. 

• Format Autodesk RVT i RFA - pliki rysunków w formatach RVT i RFA 

używane do danych budowlanych. 

 
Importowanie pliku w formacie DXF, DWF, DWT, DGN lub DAE 
Importowanie plików .dxf, dwuwymiarowych plików .dwf, .dwt, .dae i .dgn jest 

podobne do otwierania standardowego pliku rysunku. 
 

Aby zaimportować plik w formacie DXF, DWF, DWT, DGN lub DAE 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Importuj (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie Importuj lub wybierz 

Wstaw > Importuj. 

• W menu wybierz Plik > Importuj. 

• Na pasku narzędzi Standard kliknij narzędzie Otwórz. 

• Wpisz import i naciśnij Enter. 

2 Wybierz folder zawierający rysunek. 

3 W polu Pliki typu wybierz typ rysunku, który chcesz zaimportować. 

4 Wybierz plik, który chcesz otworzyć. 

5 Kliknij przycisk Otwórz. 

 
Importowanie pliku w formacie DXB 
Plik w formacie DXB jest plikiem rysunkowym używanym do danych budowlanych. 

 

Aby zaimportować plik w formacie DXB 

1 Wykonaj jedną z poniższych czynności: 

• Wpisz dxbin i naciśnij Enter. 

2 Wybierz plik, który chcesz otworzyć. 

3 Kliknij przycisk Otwórz. 
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Importowanie pliku w formacie IFC, RVT lub RFA 
Plik w formacie IFC, RVT lub RFA zazwyczaj zawiera model 3D budynku, który 

może być używany do wizualizacji, projektowania, analizy i generowania 

dokumentacji budowlanej budynku. 

Import pliku .ifc, .rvt lub .rfa tworzy oddzielne jednostki dla każdego elementu w 

pliku i konwertuje te elementy na jednostki AEC tam, gdzie to możliwe. 
 

Aby zaimportować plik w formacie IFC, RVT lub .RFA 

1 Wykonaj jedną z poniższych czynności, aby wybrać BIM IN: 

• Na wstążce Przycisk aplikacji wybierz Import > BIM In (  ). 

• Wpisz bimimport i naciśnij Enter. 

2 Wybierz plik, który chcesz otworzyć. 

3 Kliknij przycisk Otwórz. 

 
Importowanie pliku w formacie ACIS 
Plik w formacie ACIS zawiera trójwymiarowe bryły, regiony lub ciała, które są 

zapisywane jako plik ASCII .sat. 

 

Aby zaimportować plik w formacie ACIS 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce Przycisk aplikacji wybierz Import > ACIS In. 

• W menu wybierz Plik > ACIS In lub Wstaw > Plik ACIS. 

• Wpisz acisin, a następnie naciśnij Enter. 

2 Wybierz katalog zawierający plik .sat. 

3 Wybierz plik .sat, który chcesz otworzyć. 

4 Kliknij przycisk Otwórz. 
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Importowanie pliku w formacie IGES 
Format IGES (Initial Graphics Exchange Specification) to format wymiany, który 

zazwyczaj zawiera powierzchnie 3D zapisane w pliku .iges lub .igs. Dane IGES są 

importowane jako trójwymiarowe bryły. 

 

Aby zaimportować plik w formacie IGES 

1 Wykonaj jedną z poniższych czynności, aby wybrać IGES In (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Import > IGES In. 

• W menu wybierz Plik > Importuj. 

• Wpisz igesimport, a następnie naciśnij Enter. 

2 Wybierz plik .iges lub .igs, który chcesz zaimportować. 

3 Kliknij przycisk Otwórz. 

Rozpocznie się przetwarzanie. Gdy wybrany plik jest gotowy do 

zaimportowania, na pasku stanu wyświetlany jest komunikat w postaci dymku. 

4 Kliknij nazwę pliku w dymku, aby zakończyć import. 

5 Powiększ do ekstentów, aby zobaczyć zaimportowane jednostki. 

 
Importowanie pliku w formacie STEP 
STEP (Standard for the Exchange of Product) to standardowy format wymiany 

ISO, który zazwyczaj zawiera obiekty 3D zapisane w pliku .step, .ste lub .stp. Dane 

STEP są importowane jako trójwymiarowe bryły. 

 

Aby zaimportować plik w formacie STEP 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję STEP In (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz opcję Import > STEP In. 

• W menu wybierz Plik > Importuj. 

• Wpisz stepimport i naciśnij Enter. 

2 Wybierz plik .step, .ste lub .stp, który chcesz zaimportować. 

3 Kliknij przycisk Otwórz. 

Rozpocznie się przetwarzanie. Gdy wybrany plik jest gotowy do 

zaimportowania, na pasku stanu wyświetlany jest komunikat w postaci dymku. 

4 Kliknij nazwę pliku w dymku, aby zakończyć import. 

5 Powiększ do ekstentów, aby zobaczyć zaimportowane jednostki. 
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Importowanie pliku w formacie OBJ 
OBJ (obiekt Wavefront Technologies) to format, który zazwyczaj zawiera obiekty 

3D, w tym kolory i tekstury, zapisane w pliku .obj. Dane modelu OBJ są 

importowane jako jednostki siatki. 

 

Aby zaimportować plik w formacie OBJ 

1 Wykonaj jedną z poniższych czynności, aby wybrać OBJ In (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Import > OBJ In. 

• W menu wybierz Plik > Importuj. 

• Wpisz objin, a następnie naciśnij Enter. 

2 Wybierz plik .obj, który chcesz zaimportować. 

3 Kliknij przycisk 

Otwórz. 

Rozpocznie się 

przetwarzanie. 

4 Powiększ do ekstentów, aby zobaczyć zaimportowane jednostki. 

 
Importowanie pliku w formacie STL 
Format STL (Stereolithography) zazwyczaj zawiera bryły 3D i siatki do pracy z 

drukarkami 3D. Pliki w formacie STL są zapisywane w plikach .stl. 

 

Aby zaimportować plik w formacie STL 

1 Wykonaj jedną z poniższych czynności, aby wybrać STL In (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Import > STL In. 

• W menu wybierz Plik > Importuj. 

• Wpisz stlin i naciśnij Enter. 

2 Wybierz plik .stl, który chcesz zaimportować. 

3 Kliknij przycisk 

Otwórz. 

Rozpocznie się 

przetwarzanie. 

4 Powiększ do ekstentów, aby zobaczyć zaimportowane jednostki. 
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Korzystanie z danych ALCAD w innych programach 
 

Możesz użyć dowolnej z poniższych metod, aby dołączyć dane ALCAD do 

dokumentu utworzonego w innym programie: 

• Osadzanie 

• Łączenie 

• Przeciąganie 

• Eksport 

• Wysyłanie wiadomości e-mail 

Wybrana metoda zależy od możliwości innego programu i sposobu pracy z danymi 

ALCAD po umieszczeniu ich w innym dokumencie. 

 

Każda metoda z wyjątkiem eksportu wykorzystuje ActiveX do integracji danych z 

różnych programów. Dzięki ActiveX można otwierać rysunki ALCAD z poziomu 

innego programu, aby modyfikować rysunki ALCAD. 
 

 
Osadzanie rysunków 

Po osadzeniu rysunku ALCAD staje się on częścią pliku dokumentu innego 

programu. Podczas edycji rysunku edytowana jest tylko wersja osadzona w innym 

dokumencie. 

Osadzanie jest przydatne, gdy nie chcesz utrzymywać łącza do rysunku ALCAD dla 

danych zawartych w innym dokumencie. Edycje dokonane na nowym rysunku nie 

mają wpływu na oryginalny rysunek. Aby przenieść plik na inne komputery, można 

przenieść wszystkie dane w jednym pliku, ale osadzone obiekty zwiększają rozmiar 

pliku. 

Z poziomu dokumentu w programie obsługującym ActiveX, takim jak Microsoft® Word, 

można utworzyć nowy osadzony rysunek ALCAD lub osadzić istniejący rysunek 

ALCAD. 
 

Aby utworzyć rysunekALCAD w innym dokumencie 

1 W dokumencie wybierz polecenie Wstaw > Obiekt (lub jego odpowiednik 

w danym programie). 

2 W oknie dialogowym kliknij opcje tworzenia nowego pliku. 

3 W sekcji Typ obiektu wybierz Rysunek ALCAD, a następnie kliknij OK. 

4 Utwórz rysunek ALCAD. 

5 Jeśli ALCAD jest uruchomiony we własnym oknie, wybierz Plik > Wyjdź. 

Jeśli ALCAD jest uruchomiony w innym dokumencie (w miejscu), kliknij gdzieś 

w dokumencie poza rysunkiem ALCAD, aby zamknąć ALCAD. 
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6 Aby edytować rysunek ALCAD z poziomu dokumentu, kliknij go 

dwukrotnie. 

 

Można również osadzić istniejący rysunek ALCAD z innego dokumentu. Postępuj 

zgodnie z krokiem 1 w poprzedniej procedurze, a następnie kliknij opcję tworzenia 

obiektu z istniejącego pliku. 
 

 
Aby osadzić wybrane jednostki ALCAD 

1 W programie ALCAD wybierz jednostki, które chcesz osadzić. 

2 Wybierz Edycja > Kopiuj (lub naciśnij Ctrl+C). 

3 Otwórz dokument, w którym chcesz osadzić jednostki. 

4 Wybierz polecenie Edycja > Wklej (lub jego odpowiednik). 
 

Aby osadzić cały rysunek ALCAD 

1 Otwórz dokument, w którym chcesz osadzić rysunek. 

2 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz polecenie Wstaw > Obiekt (w danych). 

• W menu wybierz Wstaw > Obiekt 

• Wpisz insertobj i naciśnij Enter. 

3 Kliknij przycisk Utwórz z pliku. 

4 Kliknij przycisk Przeglądaj, a następnie wybierz plik, który chcesz osadzić. 

5 Kliknij przycisk Wstaw, a następnie kliknij przycisk OK. 

 
Edycja osadzonego obiektu ALCAD w miejscu 

W wielu programach kompatybilnych z ActiveX można edytować osadzony obiekt 

ALCAD bez opuszczania programu (lub aplikacji kontenerowej). Nazywa się to 

edycją na miejscu. Inny zestaw menu i pasków narzędzi ALCAD tymczasowo 

zastępuje większość menu i elementów sterujących w aktywnym oknie podczas 

edycji obiektu ALCAD. 
 

Aby edytować osadzony obiekt ALCAD w miejscu 

1 W aplikacji kontenera kliknij dwukrotnie osadzony obiekt ALCAD. 

Pojawi się inny zestaw menu i elementów sterujących ALCAD. 

2 Edytuj rysunek ALCAD. 

3 Kliknij w dowolnym miejscu poza oknem rysunku, aby zamknąć elementy sterujące edycji w 

miejscu. 

 
Łączenie rysunków 

Kiedy łączysz rysunek ALCAD z innym dokumentem, inny dokument zawiera tylko 

odniesienie do pliku rysunku ALCAD, a nie rzeczywisty rysunek. Łączysz dane w 

zapisanym pliku ALCAD, aby inny program mógł je znaleźć i wyświetlić. 



Pojawienie się kursora Działanie 
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Łączenie działa dobrze, gdy chcesz dołączyć te same dane ALCAD do więcej niż 

jednego dokumentu. Gdy aktualizujesz dane, musisz zaktualizować je tylko w 

jednej lokalizacji. Wersje powiązane z innymi dokumentami automatycznie 

odzwierciedlają zmiany. 

Łączenie pliku ALCAD z innym dokumentem nie zwiększa rozmiaru pliku w taki 

sposób, jak osadzanie obiektu ALCAD. Linki wymagają jednak więcej 

konserwacji. Aby przetransportować dane, należy przenieść wszystkie połączone 

pliki na inny komputer. 
 

Aby połączyć plik ALCAD z innym dokumentem 

1 Otwórz rysunek, który chcesz połączyć. 
 

Ponieważ link jest odwołaniem do pliku, plik z odwołaniem musi być zapisany 

na dysku lokalnym lub zdalnym. 

Jeśli nie zapisałeś rysunku, który chcesz połączyć, wybierz Plik > Zapisz. 
 

2 W drugim programie otwórz dokument, w którym chcesz umieścić 

rysunek ALCAD. 

3 Wybierz polecenie tego programu do wstawiania obiektów. 

W programach pakietu Microsoft® Office wybierz polecenie Wstaw > Obiekt. W 

oknie dialogowym Obiekt kliknij kartę Utwórz z pliku. Określ nazwę pliku 

rysunku, który chcesz połączyć. Zaznacz pole wyboru Połącz z plikiem, a 

następnie kliknij przycisk OK. 

Rysunek pojawi się w dokumencie wraz z linkiem do oryginalnego pliku ALCAD. 

 
Przeciąganie rysunków ALCAD do innych programów 

Jeśli inny program, w którym chcesz umieścić rysunki ALCAD, jest kompatybilny 

z ActiveX, alternatywą dla wklejania rysunków za pomocą poleceń menu jest 

przeciągnięcie ikon plików rysunków z Eksploratora Windows do innego 

dokumentu. Przeciąganie i upuszczanie rysunków nie korzysta ze schowka, więc 

nie ma to wpływu na dane w schowku. 

Przeciągając plik rysunku ALCAD z Eksploratora Windows, łączysz lub osadzasz 

cały rysunek w innym dokumencie. Podczas przeciągania pliku kursor zmienia się w 

odpowiedzi na podjętą akcję. 

 
Jak zmienia się kursor 

 

Przeciągnij, aby osadzić wybrany plik w innym 
dokumencie. 

 
Nie można upuścić rysunków w tym dokumencie. 

 



Format Rozszerzenie pliku Szczegóły 
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Aby ułatwić przeciąganie i upuszczanie, ustaw okna aplikacji obok siebie. 

Przed przeciągnięciem rysunku ustaw okno Eksploratora Windows i okno innego 

programu tak, aby widzieć ikonę pliku i dokument, w którym chcesz go upuścić. 
 

 
Aby przeciągnąć i osadzić rysunki w innym dokumencie 

• Wybierz ikonę pliku rysunku, a następnie przeciągnij rysunek do dokumentu. 

 
Eksportowanie rysunków 

Rysunki ALCAD można zapisywać lub eksportować w wielu różnych formatach do 

użytku z innymi programami. Po zapisaniu rysunku w innym formacie program 

zapisuje wszystkie elementy rysunku w nowym pliku. Możesz też wybrać, które 

jednostki zostaną uwzględnione w nowym pliku. 

 

Formaty plików, które można eksportować 
W poniższej tabeli opisano formaty plików, które można eksportować. 

 
Formaty eksportu 

 

Bitmap .bmp Plik graficzny 

Ulepszony plik metadanych systemu  Windows . emf Plik graficzny 

Plik metadanych systemu Windows .wmf Plik graficzny 

Przenośny format dokumentu .pdf Rozpowszechnianie rysunku w 2D lub 3D wśród innych 
osób 

do użytku z programami Adobe® Acrobat® Reader® i 
Adobe® Acrobat 

Rysunek projektowy .dgn Dystrybucja rysunku do innych użytkowników 
inne programy CAD, takie jak narzędzia do 
rysowania do przeglądania, edycji i 
oznaczania przy użyciu innych programów 
CAD, takich jak Bentley® Microstation® 

Design Web Format .dwf Rozpowszechnianie rysunku wśród innych osób w celu użycia 
z 

Oprogramowanie i narzędzia Autodesk 

Skalowalna grafika wektorowa .svg Plik graficzny i język programowania stron  

  internetowych  

Stereolitografia .stl Plik graficzny używany do  

  prototypowania trzech- 
modele wymiarowe 

Wspólne działanie 
projektowe (Collada) 

.dae Format pliku interaktywnej grafiki 
trójwymiarowej używany przez aplikacje 
3Dgraphics (eksportowane są 
trójwymiarowe jednostki, w tym 
jednostki ACIS). 

 
 

 

Można również eksportować bryły, regiony i powierzchnie ACIS do pliku ASCII 

(*.sat), który można wykorzystać w innych programach. 
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Eksport do pliku w formacie BMP, EMF, WMF, DAE lub SVG 
Eksportowanie do pliku jest podobne do zapisywania standardowego pliku. 

 

Aby wyeksportować rysunek do pliku .bmp, .emf, .wmf, .dae lub .svg 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz przycisk Aplikacja, a następnie Eksportuj lub wybierz 

kolejno Wyjście > Eksportuj. 

• W menu wybierz Plik > Eksportuj. 

• Wpisz export i naciśnij Enter. 

2 W oknie dialogowym Eksportuj rysunek jako plik, w obszarze Zapisz jako typ 

wybierz format pliku. 

3 Podaj nazwę pliku, który chcesz utworzyć. 

4 Kliknij przycisk Zapisz. 

5 Jeśli wyświetlone zostanie okno wyboru, wybierz metodę wyboru encji, a 

następnie utwórz zestaw wyboru. 

6 Po zakończeniu wybierania podmiotów naciśnij klawisz Enter. 

 
Eksport do pliku w formacie STL 

Trójwymiarowe bryły można eksportować do pliku STL (Stereolitografia) za pomocą narzędzia 

.stl. Format STL jest powszechnie używany podczas pracy z drukarkami 3D. 

 
Aby wyeksportować do pliku w formacie STL 

1 Wykonaj jedną z poniższych czynności, aby wybrać STL Out (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie Eksport > STL Out lub 

Wyjście > STL Out (w Eksport. 

• W menu wybierz Plik > Eksportuj. 

• Wpisz stlout i naciśnij Enter. 

2 Podaj nazwę pliku, który chcesz utworzyć. 

3 Kliknij przycisk Zapisz. 

4 Wybierz metodę wyboru encji, a następnie utwórz zestaw selekcji zawierający 

encje, które chcesz wyeksportować. 

5 Wybierz Tak, aby eksportować do binarnego pliku .stl. Wybierz opcję Nie, 

aby wyeksportować do pliku ASCII .stl. 

6 Powiększ do ekstentów, aby zobaczyć zaimportowane jednostki. 
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Eksportowanie do pliku w formacie PDF 
Pliki w formacie PDF umożliwiają dystrybucję rysunku do innych osób w celu 

przeglądania w programie Adobe® Acrobat® Reader®, który jest bezpłatnym 

oprogramowaniem do pobrania przez użytkowników. Pliki PDF można również 

przeglądać, sprawdzać i edytować w programie Adobe® Acrobat. 

Rysunki można eksportować do dwuwymiarowych i trójwymiarowych plików PDF. 
 

Aby wyeksportować rysunek do pliku .pdf 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz przycisk Aplikacja, a następnie Eksportuj lub wybierz 

kolejno Wyjście > Eksportuj. 

• W menu wybierz Plik > Eksportuj. 

• Wpisz export i naciśnij Enter. 

2 W polu Zapisz jako typ wybierz Portable Document Format (pdf). 

3 Podaj nazwę pliku, który chcesz utworzyć. 

4 Kliknij przycisk Zapisz. 

5 Wybierz metodę wyboru encji, a następnie utwórz zestaw selekcji zawierający 

encje, które chcesz wyeksportować. 

6 Po zakończeniu wybierania podmiotów naciśnij klawisz Enter. 

7 Aby utworzyć plik .pdf 3D zamiast 2D, zaznacz opcję Włącz obsługę warstw, a 

następnie zaznacz opcję Eksport 3D PDF. 

8 Wybierz dodatkowe opcje eksportu do pliku .pdf. Kliknij [?], aby zobaczyć 

szczegóły dotyczące każdej opcji. 

9 Kliknij przycisk Eksportuj. 
 

Można również drukować i publikować pliki .pdf. 

Jeśli zamiast eksportu konieczne jest drukowanie do pliku .pdf, można drukować lub 

publikować bezpośrednio do pliku .pdf. Aby uzyskać szczegółowe informacje na 

temat drukowania do pliku .pdf, patrz "Wybór drukarki lub plotera" na stronie 537. 

Aby uzyskać szczegółowe informacje na temat publikowania w formacie .pdf, patrz 

"Publikowanie listy arkuszy w formacie .pdf" na stronie 537. 

drukarka nazwana w ustawieniach strony" na stronie 565. 
 

 
Eksport do pliku w formacie DWF 

Pliki w formacie DWF umożliwiają publikowanie rysunków, dzięki czemu można 

je przeglądać w Internecie za pomocą przeglądarki internetowej. ALCAD 

eksportuje rysunek do pliku Design Web Format (.dwf), który można przeglądać w 

przeglądarce internetowej, jeśli na komputerze jest również zainstalowany 

Autodesk Design Review. Design Review jest darmowym narzędziem firmy 

Autodesk. 

Rysunek można wyeksportować do pliku 2D .dwf lub 3D .dwf. Pliki 2D .dwf mają 

mniejsze rozmiary, ale nie można ich wyświetlać w trzech wymiarach. Pliki 3D .dwf 

mogą być przeglądane w trzech wymiarach za pomocą Autodesk® Design Review, ale 

mają większe rozmiary. 



668 C H A P T E R 1 6 

 

Aby wyeksportować rysunek do pliku .dwf 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz przycisk Aplikacja, a następnie Eksportuj lub wybierz 

kolejno Wyjście > Eksportuj. 

• W menu wybierz Plik > Eksportuj. 

• Wpisz export i naciśnij Enter. 

2 W polu Zapisz jako typ wybierz Design Web Format (dwf). 

3 Podaj nazwę pliku, który chcesz utworzyć. 

4 Kliknij przycisk Zapisz. 

5 Wybierz metodę wyboru encji, a następnie utwórz zestaw selekcji zawierający 

encje, które chcesz wyeksportować. 

6 Wybierz sposób eksportu: 

• Wersja pliku DWF - Wybierz żądaną wersję pliku. Wersja 4.2 może 

eksportować elementy tylko na karcie Model (bez układów). Wersja 5.5 może 

eksportować tylko bieżący układ. Wersja 6.0 może eksportować bieżący układ 

lub wszystkie układy. 

• Format pliku DWF - Wybierz żądany format pliku. Skompresowane pliki 

binarne mają mniejszy rozmiar niż nieskompresowane pliki binarne (oba są 

plikami 2D .dwf). Pliki ASCII mają największy rozmiar w przypadku plików 

2D .dwf, ale pliki 3D .dwf mają większy rozmiar i można je oglądać w trzech 

wymiarach. 

• Układ do eksportu - Wybierz, czy eksportować tylko bieżący układ, czy 

wszystkie układy na rysunku. 

7 Kliknij przycisk OK. 

8 Po zakończeniu wybierania podmiotów naciśnij klawisz Enter. 
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Eksport do pliku w formacie DGN 
Pliki w formacie DGN umożliwiają dystrybucję rysunku do innych osób w celu 

przeglądu, edycji i oznaczania przy użyciu innych programów CAD, takich jak 
Bentley® Microstation®. Pliki są eksportowane do plików DGN w wersji 8. 

Aby wyeksportować rysunek do pliku .dgn 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Wyjście > DGN Out (w Eksport). 

• Wpisz dgnexport i naciśnij Enter. 

2 Podaj nazwę pliku, który chcesz utworzyć. 

3 Kliknij przycisk Zapisz. 

4 Po wyświetleniu monitu wybierz jednostkę główną dla pliku .dgn, taką jak kilometry lub 

stopy. 

5 Po wyświetleniu monitu wybierz podjednostkę dla pliku .dgn, taką jak 

cale lub mils. Rysunek zostanie wyeksportowany. 

Eksport do pliku w formacie ACIS 
Można eksportować jednostki ACIS, takie jak powierzchnie, regiony i bryły do pliku 

w formacie ACIS w formacie ASCII (SAT). 
 

Aby wyeksportować plik w formacie ACIS 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz przycisk Aplikacja, a następnie Eksportuj lub wybierz 

kolejno Wyjście > Eksportuj. 

• W menu wybierz Plik > ACIS Out. 

• Wpisz acisout i naciśnij Enter. 

2 Wybierz jednostki ACIS, które chcesz zapisać. 

3 Podaj nazwę pliku, który chcesz utworzyć. 

4 Kliknij przycisk Zapisz. 

 
Konwertowanie rysunków do innych wersji i formatów 

plików Kilka typów rysunków można konwertować do innych wersji i 

formatów plików. Można konwertować partię rysunków w folderze lub określić 

pojedynczy rysunek do konwersji. 

Następujące formaty mogą być konwertowane z i do: 

• Autodesk format - Autodesk Drawing Format to rysunek z rozszerzeniem 

.dwg. 

• Autodesk format - Autodesk Drawing Exchange Format to opis 

ASCII pliku rysunku z rozszerzeniem .dxf. 

• Format DGN - pliki rysunkowe używane z 

DGN wykorzystuje rozszerzenie pliku .dgn. 
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Aby przekonwertować pojedynczy rysunek 

1 Wykonaj jedną z poniższych czynności, aby wybrać ALCAD Converter (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Narzędzia do 

rysowania > Konwerter ALCAD lub wybierz Narzędzia > Konwerter 

ALCAD (w Zarządzaniu). 

• W menu wybierz Plik > Konwerter ALCAD. 

• Wpisz intelliconvert i naciśnij Enter. 

2 Wybierz Pojedynczy plik, a następnie kliknij Dalej. 

3 Wybierz plik wejściowy. Kliknij [...], aby przejść do lokalizacji. 

4 Nazwij plik wyjściowy. Kliknij [...], aby przejść do lokalizacji. 

5 W opcji Konwertuj na wersję wybierz format pliku i wersję pliku wyjściowego. 

6 Jeśli konwertujesz do pliku .dgn, wybierz jedną z poniższych opcji: 

• Jednostka główna - przypisuje wybraną jednostkę główną do wyjściowego pliku .dgn. 

• Jednostka podrzędna - przypisuje wybraną jednostkę podrzędną do wyjściowego pliku 

.dgn. 

• Powiąż odniesienia zewnętrzne, jeśli to możliwe - powoduje, że 

odniesienia zewnętrzne stają się stałą częścią pliku .dgn, podobnie jak 

blok, jeśli w rysunku wejściowym zostaną znalezione odniesienia zewnętrzne. 

7 Jeśli masz więcej plików do przekonwertowania, zaznacz opcję Konwertuj więcej plików. 

8 Kliknij przycisk Zakończ. 
 

Plik dziennika jest tworzony automatycznie w przypadku konwersji do pliku .dgn i wystąpienia 
błędów. 

Plik <output_dgnfilename>.log jest zapisywany w tym samym folderze, w którym 

tworzony jest wyjściowy plik .dgn. 
 

 
Aby przekonwertować partię rysunków 

1 Wykonaj jedną z poniższych czynności, aby wybrać ALCAD Converter (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Narzędzia do 

rysowania > Konwerter ALCAD lub wybierz Narzędzia > Konwerter 

ALCAD (w Zarządzaniu). 

• W menu wybierz Plik > Konwerter ALCAD. 

• Wpisz intelliconvert i naciśnij Enter. 
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2 Wybierz opcję Wiele plików, a następnie kliknij przycisk Dalej. 

3 Określ pliki wejściowe, wykonując następujące czynności: 

• Wprowadź folder wejściowy. Kliknij [ ], aby przejść do lokalizacji. 

• Aby uwzględnić pliki znajdujące się w podfolderach w folderze 

wejściowym, zaznacz opcję Przetwarzaj podfoldery. 

• Wybierz, które pliki mają zostać dołączone: .dwg, .dxf i .dgn. 

4 Kliknij przycisk Dalej. 

5 Przejrzyj listę znalezionych plików, a następnie kliknij przycisk Dalej, aby 

kontynuować korzystanie ze wszystkich nazwanych plików. Możesz także 

kliknąć Wstecz, aby określić inne pliki. 

6 Wprowadź folder wyjściowy. Kliknij [ ], aby przejść do lokalizacji. 

7 Zaznacz Konwertuj, a następnie wybierz format wyjściowy i wersję pliku. 

8 Aby przeprowadzić audyt i naprawić pliki podczas konwersji, zaznacz opcję 

Audytuj pliki i napraw błędy. Można również wybrać opcję zapisywania plików dziennika 

audytu, które będą również zapisywane w folderze wyjściowym. 

9 Wybierz, co zrobić, jeśli podczas przetwarzania w folderze wyjściowym 

zostaną znalezione pliki o tej samej nazwie: 

• Zastąp istniejące - zastępuje istniejące pliki nowymi plikami. Aby 

utworzyć kopię zapasową istniejącego pliku przed jego nadpisaniem, 

zaznacz opcję Utwórz pliki kopii zapasowej (*.bak), a pliki kopii zapasowej 

zostaną utworzone w tym samym folderze wyjściowym. 

• Pomiń istniejące - pomija dodawanie nowego pliku, jeśli znaleziony zostanie 

istniejący plik o tej samej nazwie. 

• Dodaj przyrostek do plików wyjściowych - dodaje określony przyrostek do 

wszystkich nowych plików utworzonych w folderze wyjściowym. 

10 Jeśli konwertujesz do pliku .dgn, wybierz jedną z poniższych opcji: 

• Jednostka główna - przypisuje wybraną jednostkę główną do wyjściowego pliku .dgn. 

• Jednostka podrzędna - przypisuje wybraną jednostkę podrzędną do wyjściowego pliku 

.dgn. 

• Powiąż odniesienia zewnętrzne, jeśli to możliwe - powoduje, że 

odniesienia zewnętrzne stają się stałą częścią pliku .dgn, podobnie jak 

blok, jeśli odniesienia zewnętrzne zostaną znalezione na rysunku wejściowym. 

11 Kliknij przycisk Dalej. 

Nowe pliki są generowane na podstawie specyfikacji użytkownika. 
 

Plik dziennika jest tworzony automatycznie w przypadku konwersji do pliku .dgn i wystąpienia 
błędów. 

Plik <output_dgnfilename>.log jest zapisywany w folderze wyjściowym określonym 

dla konwersji plików wsadowych. 
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Korzystanie z danych ALCAD na innych komputerach 
 

W programie ALCAD istnieją dwa sposoby przenoszenia rysunków i powiązanych 

plików na inny komputer: 

• Utwórz pakiet zawierający wszystkie powiązane rysunki i pliki. Ta opcja 

wykorzystuje polecenie eTransmit i jest najlepsza w przypadku przenoszenia 

wielu rysunków lub rysunków zawierających pliki pomocnicze, takie jak 

zewnętrzne pliki referencyjne i pliki czcionek. 

• Wyślij rysunek przez e-mail z ALCAD. Ta opcja wykorzystuje polecenie 

Wyślij pocztę i jest najlepsza do przenoszenia pojedynczych rysunków. 

 

Pakowanie rysunków i plików do użycia na innym 

komputerze Polecenie eTransmit służy do pakowania rysunków i powiązanych 

z nimi plików, takich jak odniesienia zewnętrzne, materiały z Eksploruj materiały i 

czcionki. Wynik- 

Pakiet ing może być samorozpakowującym się plikiem .exe, plikiem .zip lub oddzielnym 
folderem zawierającym plik .zip. 

przechowuje pliki. 

Polecenie eTransmit używa ustawień transmisji do definiowania sposobu tworzenia 

pakietów, z opcjami nazewnictwa plików, kontroli haseł, dołączania czcionek i 

innych. Domyślna konfiguracja przesyłania ma nazwę Standard, którą można 

modyfikować. Można też utworzyć nowe ustawienia przesyłania. 

 

Tworzenie pakietu zawierającego rysunki i powiązane pliki 

Pakowanie rysunków i powiązanych z nimi plików 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję eTransmit ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie Publikuj > 

eTransmit lub wybierz Wyjście > eTransmit (w Eksport). 

• W menu wybierz Plik > eTransmit. 

• Wpisz etransmit i naciśnij Enter. 

2 Przejrzyj dostępne pliki na liście. Pliki wyświetlane są w formacie 

hierarchicznym (kliknij kartę Drzewo plików) lub w tabeli (kliknij kartę Tabela 

plików). 

3 Zaznacz pliki, które mają zostać dołączone do pakietu; odznacz pliki, które 

mają zostać wykluczone z pakietu. 

4 Aby dołączyć pliki, których nie ma na liście, kliknij Dodaj pliki, przejdź do 

żądanych plików i wybierz je, a następnie kliknij Otwórz. 

5 W polu Wybierz konfigurację przekazu wybierz konfigurację przekazu, która 

definiuje sposób utworzenia pakietu. Konfiguracja przesyłania określa typ 

pliku pakietu (.exe, .zip lub folder), nazwę pliku i inne elementy. 

6 Aby wyświetlić lub utworzyć konfigurację przekazu, kliknij Ustawienia 

przekazu. Więcej informacji można znaleźć w sekcji "Praca z konfiguracjami 

przekazów" na stronie 674 w tym rozdziale. 
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7 Opcjonalnie wprowadź notatki do uwzględnienia w raporcie transmisji. 

8 Kliknij przycisk OK. 

Pakiet zostanie utworzony. 

 

 

 

A 
B 

 

J 

 

 
C 

 

I 

 

H 
 

D 

 

E G 

 

 

F 

A Kliknij, aby wyświetlić pliki w hierarchii. 

B Kliknij, aby wyświetlić pliki w tabeli. 

C Zaznacz pliki, które mają zostać dołączone do 
pakietu; odznacz pliki, które mają zostać 
wykluczone. 

D Kliknij, aby dodać pliki do listy. 

E Wprowadź szczegóły do uwzględnienia w 
raporcie pakietu. 

F Kliknij, aby wyświetlić raport, który zostanie 
dołączony do pakietu. 

 

 
G Wyświetla podgląd pliku wybranego na liście. 

H Kliknij, aby wyświetlić, utworzyć i zmodyfikować ustawienia 
transmisji. 

I Wyświetla opis wybranej konfiguracji transmisji. 

J Wybierz konfigurację przesyłania, która definiuje 
opcje, których chcesz użyć podczas tworzenia 
pakietu. 
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Praca z ustawieniami transmisji 
Za każdym razem, gdy tworzysz pakiet za pomocą polecenia eTransmit, wybierasz 

konfigurację przesyłania, aby zdefiniować sposób tworzenia pakietu. Każda 

konfiguracja przesyłania definiuje typ pakietu, który zostanie utworzony (.exe, .zip 

lub folder), nazwę pliku, kontrolę hasła, czy dołączyć pliki czcionek i inne. 

Konfiguracje przesyłania można tworzyć, modyfikować i usuwać. Tworzenie więcej 

niż jednej konfiguracji przesyłania jest szczególnie przydatne, jeśli często trzeba 

pakować pliki dla różnych odbiorców o różnych wymaganiach. 
 

Aby utworzyć lub zmodyfikować konfigurację przekazu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję eTransmit ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie Publikuj > 

eTransmit lub wybierz Wyjście > eTransmit (w Eksport). 

• W menu wybierz Plik > eTransmit. 

• Wpisz etransmit i naciśnij Enter. 

2 Kliknij Transmittal Setups. 

3 Wykonaj jedną z poniższych czynności: 

• Aby utworzyć konfigurację przekazu, kliknij przycisk Nowy, wprowadź 

nazwę, w obszarze Na podstawie wybierz konfigurację przekazu, która ma 

ustawienia najbardziej zbliżone do tej, którą chcesz utworzyć, a następnie 

kliknij przycisk Kontynuuj. 

• Aby zmodyfikować istniejącą konfigurację przekazu, wybierz ją z listy, a 

następnie kliknij przycisk Modyfikuj. Wyświetlone zostanie okno dialogowe 

Modyfikuj ustawienia przekazu. 

4 W polu Typ pakietu przekazu wybierz typ pakietu, który ma zostać utworzony 

podczas korzystania z tej konfiguracji przekazu. Wszystkie pliki mogą 

znajdować się w nowym folderze, samorozpakowującym się pliku .exe lub pliku 

.zip. 

5 W polu Format pliku wybierz format pliku dla plików spakowanych z tą 

konfiguracją przekazu. Pliki w pakiecie mogą zachować swój istniejący format 

lub wszystkie mogą zostać zweryfikowane do tego samego formatu. 

6 W polu Folder pliku przekazu wprowadź domyślną lokalizację, w której ta 

konfiguracja przekazu będzie zapisywać pakiety po ich utworzeniu. Możesz 

wpisać lokalizację, wybrać ostatnią lokalizację z listy lub kliknąć [...], aby 

wybrać folder. 

7 W polu Nazwa pliku przekazu wybierz sposób nazywania pakietów .exe i .zip 

tworzonych przy użyciu tej konfiguracji przekazu. (Dostępne dla pakietów typu EXE i 

ZIP.) Dostępne są następujące opcje: 

• Monituj o nazwę pliku - umożliwia wprowadzenie nazwy pliku za każdym 

razem, gdy tworzony jest pakiet przy użyciu tej konfiguracji przekazu. Monit 

jest wyświetlany po kliknięciu przycisku OK w oknie dialogowym Utwórz 

przekaz. 

• Nadpisz w razie potrzeby - używa tej samej nazwy pliku, którą wprowadzasz 

za każdym razem, gdy tworzysz pakiet przy użyciu tej konfiguracji przekazu, 

i zastępuje istniejące pliki o tej samej nazwie. Wprowadź nazwę pliku w polu, 

które stanie się dostępne. 



P R A C A Z I N N Y M I P R O G R A M A M I I K O M P U T E R A M I 675 

 

• Zwiększ nazwę pliku w razie potrzeby - używa tej samej nazwy pliku, którą 

wprowadzasz za każdym razem, gdy tworzysz pakiet przy użyciu tej 

konfiguracji przekazu, i zwiększa nazwę pliku, jeśli istnieje istniejący plik o 

tej samej nazwie. Wprowadź nazwę pliku w polu, które stanie się dostępne. 

8 W Opcjach ścieżki wybierz jedną z poniższych opcji: 

• Umieść wszystkie pliki w jednym folderze - zapisuje wszystkie pliki 

w jednym folderze po ich rozpakowaniu. 

• Keep files and folders as is - zapisuje wszystkie pliki w oryginalnej 

strukturze folderów, która jest odtwarzana na komputerze docelowym po 

rozpakowaniu plików. Może to pomóc w łączeniu plików, gdy są one 

używane na innym komputerze. 

9 Użyj dowolnej z poniższych opcji, aby dokładniej zdefiniować ustawienia konfiguracji 

transmisji: 

• Opis ustawień przekazu - Wprowadź opcjonalny opis ustawień przekazu. 

Opis zostanie wyświetlony po wybraniu tej konfiguracji przekazu w oknie 

dialogowym Utwórz przekaz. 

• Send E-Mail with Transmittal - Wybierz, aby wysłać pakiet jako załącznik 

wiadomości e-mail; po utworzeniu pakietu zostanie otwarta domyślna 

aplikacja poczty e-mail. 

• Set Print Options to Default - Wybierz, aby usunąć ustawienia drukarki 

lokalnej z pakietu, jeśli nie będą one stosowane w innych systemach. 

• Powiąż odniesienia zewnętrzne - Wybierz, aby powiązać lub wstawić 

wszystkie odniesienia zewnętrzne pliku .dwg w pakiecie. Powiązanie 

powoduje, że odniesienia zewnętrzne stają się stałą częścią oryginalnego pliku 

rysunku, podobnie jak blok. 

• Prompt for Password (Pytaj o hasło) - Wybierz, aby pytać o hasło podczas 

tworzenia i rozpakowywania pakietu. 

• Purge Drawings (Usuń rysunki) - Wybierz, aby usunąć wszystkie rysunki po utworzeniu 

pakietu. 

• Dołącz czcionki - Wybierz, aby dodać powiązane pliki czcionek (na przykład 

TTF, SHX) do pakietu. 

• Include Unloaded File References (Uwzględnij odniesienia do 

niezaładowanych plików) - Wybierz, aby uwzględnić w pakiecie wszelkie 

niezaładowane odniesienia zewnętrzne, w tym obrazy i podkłady; 

niezaładowane pliki są wymienione w oknie dialogowym Create Transmittal 

(Utwórz przekaz). 
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A Wybierz typ pakietu, który zostanie utworzony 

przez konfigurację przekazu. 

B Wybierz opcję formatu pliku. 

C Określ domyślną lokalizację folderu, w którym 
mają być zapisywane pakiety. Wprowadź 
lokalizację, wybierz ją lub kliknij [...]. 

D Wybierz sposób łączenia pakietów. (Dostępne 
dla typów pakietów EXE i ZIP). 

E Wybór opcji folderów do użycia podczas 
rozpakowywania plików. 

F Wprowadź opis konfiguracji przekazu. 

G Wybierz, aby dołączyć do pakietu wszelkie 
niezaładowane odniesienia zewnętrzne. 

H Wybierz, aby dołączyć pliki czcionek do pakietu. 

I Wybierz, aby usunąć wszystkie rysunki po 
utworzeniu pakietu. 

J Wybierz, aby zabezpieczyć pakiet hasłem. 

K Wybierz, aby powiązać lub wstawić 
wszystkie zewnętrzne odniesienia do 
plików .dwg w pakiecie. 

L Wybierz opcję przywrócenia lokalnych 
ustawień drukarki z pakietu. 

M Wybierz, aby wysłać pakiet jako załącznik wiadomości e-mail. 

A 
M 

L 

B   K 

C   J 

I 

D   

E 
   

H 

  G 

F 
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Aby zmienić nazwę konfiguracji przekazu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję eTransmit ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie Publikuj > 

eTransmit lub wybierz Wyjście > eTransmit (w Eksport). 

• W menu wybierz Plik > eTransmit. 

• Wpisz etransmit i naciśnij Enter. 

2 Kliknij Ustawienia transmisji. 

3 Wybierz konfigurację transmisji, której nazwę chcesz zmienić. 

4 Kliknij przycisk Zmień nazwę. 

5 Wprowadź nową nazwę, a następnie naciśnij Enter. 
 

Aby usunąć konfigurację przekazu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję eTransmit ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie Publikuj > 

eTransmit lub wybierz Wyjście > eTransmit (w Eksport). 

• W menu wybierz Plik > eTransmit. 

• Wpisz etransmit i naciśnij Enter. 

2 Kliknij Transmittal Setups. 

3 Wybierz konfigurację transmisji, którą chcesz usunąć. 

4 Kliknij przycisk Usuń, a następnie potwierdź usunięcie. 
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Wysyłanie rysunku przez e-mail 

Możesz wysłać rysunek ALCAD do innego użytkownika za pośrednictwem poczty 

elektronicznej. ALCAD jest kompatybilny z programami e-mail, które obsługują 

protokół Messaging Application Program Inter- face (MAPI). 
 

Aby dołączyć plik rysunku do wiadomości e-mail 

1 Gdy plik rysunku jest otwarty, wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz przycisk Aplikacja, a następnie Publikuj > Wyślij pocztę. 

• W menu wybierz Plik > Wyślij pocztę. 

• Wpisz mail i naciśnij Enter. 

Jeśli program pocztowy nie jest jeszcze uruchomiony, uruchomi się; pojawi się 

nowa wiadomość e-mail zawierająca ikonę ALCAD i nazwę pliku. 

2 Zaadresuj wiadomość e-mail, wpisz wiadomość i wyślij ją tak, jak każdą inną 

wiadomość. 

Aby wyświetlić plik ALCAD wysłany pocztą e-mail 

• Otwórz wiadomość e-mail, a następnie kliknij dwukrotnie ikonę ALCAD. 

Oprogramowanie ALCAD musi być zainstalowane na komputerze 

używanym do otwierania rysunków z poczty elektronicznej. 
 

Użyj polecenia eTransmit dla wiadomości e-mail, jeśli rysunek zawiera pliki pomocnicze. 

Jeśli rysunek jest zależny od plików, takich jak odniesienia zewnętrzne lub pliki 

czcionek, należy użyć polecenia eTransmit, aby połączyć pliki w jeden pakiet i wysłać 

go pocztą e-mail. Podczas tworzenia pakietu należy użyć konfiguracji przesyłania z 

włączoną opcją Wyślij pocztę z opcją przesyłania. Aby uzyskać więcej informacji, 

patrz "Pakowanie rysunków i plików do użycia na innym komputerze" na stronie 672 

w tym rozdziale. . 
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Korzystanie z ALCAD z Internetem 
 

Możesz użyć ALCAD, aby uzyskać dostęp do Internetu i wymieniać informacje o 

rysunkach oraz wykonywać inne zadania, w tym: 

• Dodawanie hiperłączy do rysunku. 

• Publikowanie rysunków w Internecie. 

• Przeciągnij rysunki (pliki .dwg) bezpośrednio ze strony internetowej do programu ALCAD. 

• Dostęp do Internetu podczas sesji rysowania. 

 

Do korzystania z hiperłączy potrzebna jest przeglądarka internetowa. 

Aby w pełni korzystać z tych funkcji, wymagany jest dostęp do Internetu przez 

przeglądarkę Internet Explorer w wersji 5.0 lub nowszej. 
 

 
Dodawanie hiperłączy do rysunku 

W rysunkach ALCAD można umieszczać hiperłącza, które są wskaźnikami 

przenoszącymi do innej lokalizacji, takiej jak adres internetowy lub plik na 

określonym komputerze. Hiperłącze można dołączyć do dowolnej jednostki na rysunku. 

Następnie, po wybraniu tej jednostki, można otworzyć łącze i przejść do 

określonego adresu internetowego lub lokalizacji pliku. Można tworzyć hiperłącza 

bezwzględne, które przechowują pełną ścieżkę do pliku, lub hiperłącza względne, 

które przechowują częściową ścieżkę względem folderu podstawowego lub adresu 

URL (Uniform Resource Locator). 

 

Zmienna systemowa PICKFIRST musi być ustawiona na on. 

Pliki powiązane z hiperłączami można otwierać tylko wtedy, gdy włączona jest 

opcja systemowa PICKFIRST. 
 

 
Aby utworzyć hiperłącze 

1 Wpisz hiperłącze i naciśnij Enter. 

2 Wybierz jednostkę lub jednostki, które chcesz powiązać z hiperłączem, a 

następnie naciśnij klawisz Enter, aby wyświetlić okno dialogowe Edytuj 

hiperłącze. 

3 Wykonaj jedną z poniższych czynności: 

• Kliknij przycisk Przeglądaj, aby określić plik. 

• W polu Link do pliku lub URL wpisz adres internetowy. 

4 Jeśli chcesz użyć wspólnej ścieżki dla wszystkich hiperłączy na rysunku, zaznacz 

pole wyboru Użyj ścieżki względnej dla hiperłączy. Ścieżki względne 

zapewniają elastyczność w przypadku przenoszenia plików do innego folderu, 

ponieważ można zmienić wiele ścieżek hiperłączy jednocześnie, zamiast 

zmieniać je wszystkie pojedynczo. 

5 Kliknij OK, aby zamknąć okno dialogowe Edytuj hiperłącze. 
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Zmienna systemowaHYPERLINKBASE definiuje ścieżkę względną używaną dla 

wszystkich hiperłączy w bieżącym rysunku. 

Aby użyć domyślnej ścieżki rysowania, pozostaw wartość pustą, wprowadzając kropkę ("."). 
 

 
Aby usunąć hiperłącze 

1 Wpisz hiperłącze i naciśnij Enter. 

2 Wybierz jednostkę lub jednostki z hiperłączem, a następnie naciśnij klawisz 

Enter, aby wyświetlić okno dialogowe Edytuj hiperłącze. 

3 Kliknij przycisk Usuń łącze. 

4 Kliknij OK, aby zamknąć okno dialogowe Edytuj hiperłącze. 
 

Aby uzyskać dostęp do hiperłącza 

1 Wybierz podmiot z hiperłączem. 

2 Kliknij prawym przyciskiem myszy w dowolnym miejscu obszaru rysowania. 

3 W menu podręcznym wybierz opcję Otwórz łącze. 

 
Publikowanie rysunków w Internecie 

Możesz publikować swoje rysunki, aby można je było przeglądać w Internecie za 

pomocą przeglądarki internetowej. ALCAD eksportuje rysunek do pliku Design Web 

Format (.dwf), który można przeglądać w przeglądarce internetowej, jeśli na 

komputerze jest również zainstalowany Design Review. 

Design Review to bezpłatne narzędzie firmy Autodesk®. 

Szczegółowe informacje na temat tworzenia pliku DWF zawiera sekcja "Kliknij 

Eksportuj." na stronie 667 w tym rozdziale. 
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Wstawianie rysunków z witryny internetowej 

Niektóre strony internetowe są skonfigurowane tak, aby umożliwić przeciąganie 

rysunków ze strony internetowej bezpośrednio do rysunku. Rysunki można 

przeciągać i upuszczać z dowolnej witryny internetowej obsługującej technologię 
Autodesk®  

 

Aby wstawić rysunek z witryny internetowej 

1 Otwórz przeglądarkę internetową. 

2 Przejdź do strony internetowej obsługującej Autodesk® i-drop. 

3 Ustaw przeglądarkę internetową i okna ALCAD tak, aby były widoczne. 

4 Kliknij rysunek w przeglądarce internetowej i przeciągnij go do rysunku w 

programie ALCAD. Plik rysunku zostanie pobrany i wstawiony do rysunku w 

programie ALCAD. 

 

Dostęp do strony internetowej ALCAD podczas sesji rysowania 

Oprócz korzystania z hiperłączy w celu uzyskania dostępu do Internetu, można w 

dowolnym momencie uzyskać dostęp do strony internetowej firmy. Na stronie 

internetowej można uzyskać informacje o firmie, a także informacje o produktach i 

wiadomości. 
 

Aby uzyskać dostęp do strony internetowej ALCAD 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Pomoc > ALCAD w sieci. 

• W menu wybierz Pomoc > ALCAD w sieci. 

• Wpisz onweb i naciśnij Enter. 

2 Przejdź do wybranej sekcji na stronie internetowej ALCAD. 
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Praca z podpisami cyfrowymi 
 

Dołączenie podpisu cyfrowego do rysunku umożliwia podpisanie rysunku i 

uwierzytelnienie podpisu. Najpierw należy uzyskać certyfikat cyfrowy od 

zewnętrznego dostawcy lub samodzielnie podpisany certyfikat cyfrowy, a następnie 

po prostu dołączyć go do rysunku. 

Dodatkowo, jeśli pracujesz z rysunkiem, który ma podpis cyfrowy innej osoby, 

możesz zweryfikować podpis. 

 

Dołączanie podpisów cyfrowych 

Przed cyfrowym podpisaniem rysunku należy uzyskać certyfikat cyfrowy od 

zewnętrznego dostawcy lub wygenerować samodzielnie podpisany certyfikat 

cyfrowy, a następnie zaimportować go do komputera. 

Po zainstalowaniu podpisu cyfrowego możesz dołączyć go do jednego lub więcej 

rysunków. 
 

Aby dołączyć podpis cyfrowy do bieżącego rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dodaj podpis cyfrowy ( ):  

• Na wstążce wybierz przycisk Aplikacja, a następnie Narzędzia do 

rysowania > Dodaj podpis cyfrowy. 

• W menu wybierz Plik > Dodaj podpisy cyfrowe. 

• Wpisz digitalsign i naciśnij Enter. 

2 Wybierz opcję Dołącz podpis cyfrowy po zapisaniu rysunku. 

3 Wybierz podpis cyfrowy z listy podpisów cyfrowych dostępnych na 

komputerze. 

4 W polu Komentarz dodaj w razie potrzeby informacje o wybranym certyfikacie cyfrowym. 

5 W polu Znacznik czasu wybierz serwer czasu, aby dodać znacznik czasu do rysunku. 

6 Kliknij przycisk OK. 
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Aby dołączyć podpis cyfrowy do wielu rysunków 

1 Z menu Start systemu Windows wybierz folder programu, w którym 

zainstalowany jest ALCAD, a następnie wybierz opcję Dołącz podpisy 

cyfrowe. 

2 Wybierz podpis cyfrowy z listy podpisów cyfrowych dostępnych na 

komputerze. 

3 Dodaj pliki rysunków do podpisu cyfrowego, wykonując dowolną z poniższych czynności: 

• Kliknij Dodaj plik, wybierz pliki rysunków, które chcesz podpisać cyfrowo, 

a następnie kliknij Otwórz. 

• Kliknij Dodaj folder, wybierz folder zawierający pliki rysunków, które chcesz 

podpisać cyfrowo, a następnie kliknij OK. Wszystkie rysunki w folderze 

zostaną dodane do listy. 

4 W polu Komentarz dodaj w razie potrzeby informacje o wybranym certyfikacie cyfrowym. 

5 W polu Znacznik czasu wybierz serwer czasu, aby dodać znacznik czasu do rysunków. 

6 Kliknij przycisk Załącz. 

 
Weryfikacja podpisu cyfrowego 

Jeśli pracujesz z rysunkiem, który ma podpis cyfrowy innej osoby, możesz 

zweryfikować podpis. 
 

Aby zweryfikować podpis cyfrowy otwartego rysunku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Validate Digital Signatures (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie Narzędzia do rysowania 

> Zatwierdź podpisy cyfrowe. 

• W menu wybierz Plik > Zatwierdź podpisy cyfrowe. 

• Wpisz digvalidate, a następnie naciśnij Enter. 

2 Sprawdź status podpisu cyfrowego: 

• Ważny - podpis cyfrowy został zweryfikowany przez urząd certyfikacji i 

nie wprowadzono żadnych zmian w rysunku od czasu jego cyfrowego 

podpisania. 

• Nieprawidłowy - bieżący rysunek został zmodyfikowany od czasu jego 

cyfrowego podpisania, certyfikat został unieważniony przez urząd certyfikacji 

lub rysunek został uszkodzony. 

• Nie znaleziono - podpis cyfrowy nie został dołączony do bieżącego rysunku. 

3 Kliknij Wyświetl podpis podstawowy, aby wyświetlić szczegółowe informacje o 

podpisie cyfrowym dołączonym do rysunku. (Niedostępne, jeśli nie dołączono 

podpisu cyfrowego). 
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4 Jeśli do rysunku dołączone są odniesienia zewnętrzne, wykonaj jedną z poniższych 

czynności: 

• Zaznacz opcję Wyświetl rysunki Xref, aby wyświetlić listę wszystkich 

zewnętrznych odniesień dołączonych do bieżącego rysunku. 

• Wybierz odniesienie zewnętrzne i kliknij View Xref Signature, aby 

wyświetlić szczegółowe informacje o jego podpisie cyfrowym. 

(Niedostępne, jeśli do wybranego odnośnika zewnętrznego nie dołączono 

podpisu cyfrowego). 

5 Kliknij przycisk OK. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ALCAD można dostosować na wiele sposobów. Na przykład można zmienić 

wygląd wielu aspektów programu i zmodyfikować istniejące menu i paski 

narzędzi lub utworzyć nowe. W tej sekcji wyjaśniono, jak 

• Ustaw preferencje programu. 

• Dostosowywanie interfejsu użytkownika, w tym palet narzędzi, menu i pasków narzędzi. 

• Dostosowywanie klawiatury. 

• Tworzenie aliasów dla często używanych poleceń. 

• Dostosowywanie podmiotów. 

• Tworzenie i używanie skryptów. 

• Używaj dodatkowych programów z ALCAD. 

• Używaj tabletu digitizer do wyboru menu i kalibrowanego rysowania. 

 

 

 

 

 
 

Tematy w tym rozdziale 

Ustawianie i zmienianie opcji  .......................................................................... 686 

Dostosowywanie palet narzędzi  ...................................................................... 723 
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Tworzenie i odtwarzanie skryptów  .................................................................. 786 

Programowanie ALCAD  .................................................................................. 789 

Korzystanie z tabletu z digitizerem  ................................................................. 796 
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Ustawianie i zmienianie opcji 
 

Możesz zmienić wiele opcji, które kontrolują zachowanie i wygląd programu, takie jak 

ustawienie poziomu doświadczenia, określenie ścieżek plików i plików domyślnych, 

skonfigurowanie funkcji wyświetlania i skonfigurowanie sposobu działania 

niektórych funkcji. 

 

Zmiana opcji na karcie Ogólne 

W oknie dialogowym Opcje zakładka Ogólne zawiera ustawienia poziomu 

doświadczenia i opcji zapisu. Można także ustawić zabezpieczenia VBA. 

 

 

 

 
L 

 
 AK 

J 

 
B 

 
C 

D 

 
E 

 
F I 

 
G 

 
H 

 
 
 

A Kliknij, aby włączyć funkcję AutoSave. 

B Wybór domyślnego formatu pliku 
wyświetlanego podczas zapisywania 
rysunków za pomocą okna dialogowego 
Zapisz jako. 

C Wybierz opcję sprawdzania wszystkich 
rysunków dla błędów podczas korzystania z 
polecenia Open i w razie potrzeby spróbuj je 
przywrócić. 

D Wybierz, aby ukryć komunikaty ostrzegawcze 
podczas otwierania rysunków, jeśli 
zaznaczone jest pole wyboru Otwórz rysunki 
przy użyciu odzyskiwania. 

E Wyświetla nazwę bieżącego profilu 
wybranego na karcie Profile. 

F Kliknij, aby wyłączyć raportowanie błędów w 
przypadku wystąpienia awarii podczas 
uruchamiania programu ALCAD. 

G Kliknij, aby wyłączyć makra VBA CommonProject 
podczas uruchamiania. (Dostępne, jeśli jest 
obsługiwane przez twoją wersję ALCAD). 

H Kliknij, aby wybrać typy plików powiązane 
z programem ALCAD. 

I Kliknij, aby wysłać pełny raport z danymi 
dotyczącymi awarii. (Dostępne, jeśli 
raportowanie błędów jest włączone). 

J Wpisz rozszerzenie pliku dla plików AutoSaved. 

K Wprowadź częstotliwość automatycznego zapisywania w 
minutach. 

L Wybierz poziom doświadczenia. 
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Ustawianie poziomu doświadczenia 
Możesz kontrolować, które menu i narzędzia są dostępne, ustawiając poziom 

doświadczenia. Do wyboru są następujące poziomy doświadczenia: 

• Początkujący Menu i paski narzędzi wyświetlają tylko podstawowe polecenia. 

• Menu pośrednie i paski narzędzi wyświetlają większość dwuwymiarowych 

poleceń tworzenia i modyfikacji jednostek. 

• Zaawansowane menu i paski narzędzi wyświetlają wszystkie dostępne polecenia. 

Aby ustawić poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ogólne. 

3 W sekcji Poziom doświadczenia wybierz opcję Początkujący, Średnio zaawansowany lub 

Zaawansowany. 

4 Po zakończeniu kliknij przycisk OK. 

 
Automatyczne zapisywanie rysunków 

Aby uniknąć utraty danych w przypadku awarii zasilania lub innego błędu 

systemu, należy często zapisywać pliki rysunków. Program można skonfigurować tak, 

aby okresowo zapisywał rysunki automatycznie. Ustawienie Minuty określa interwał 

pomiędzy automatycznymi zapisami. Program uruchamia licznik czasu po każdym 

zapisaniu pliku rysunku. 

Gdy funkcja AutoSave jest włączona, program tworzy kopię rysunku. Plik jest 

zapisywany w folderze określonym w Opcje > Ścieżki/Pliki dla plików tymczasowych, z 

rozszerzeniem określonym w polu Rozszerzenie rysunku Autozapisu (domyślnie 

.SV$). 
 

Aby ustawić sposób automatycznego zapisywania rysunków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ogólne. 

3 W sekcji Automatyczne zapisywanie zaznacz pole wyboru, aby włączyć 

funkcję automatycznego zapisywania, i wybierz częstotliwość. 

Jeśli chcesz zmienić domyślne rozszerzenie przypisane do plików AutoSave, 

wpisz nowe rozszerzenie w AutoSave Drawing Extension. 

4 Po zakończeniu kliknij przycisk OK. 
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Ustawienie domyślnego formatu Zapisz jako 
Można kontrolować domyślny format pliku, który ma być wyświetlany w oknie 

dialogowym Zapisz rysunek jako. Na przykład, jeśli używasz polecenia Zapisz jako 

do zapisywania większości rysunków w starszym formacie pliku, możesz wybrać 

ten format pliku jako domyślny, aby nie trzeba było go wybierać za każdym razem, 

gdy zapisujesz rysunek za pomocą polecenia Zapisz jako. 

To ustawienie nie ma wpływu na zapisywanie istniejących lub nowych rysunków za 

pomocą poleceń innych niż Zapisz jako - ALCAD zawsze zapisuje istniejące 

rysunki w ich bieżącym formacie pliku i zapisuje nowe rysunki w najbardziej 

aktualnym formacie pliku. 
 

Aby ustawić domyślny format Zapisz jako 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ogólne. 

3 W obszarze Zapisz jako wybierz domyślny format rysunku wyświetlany 

podczas korzystania z polecenia Zapisz jako. Zawsze można określić inny 

format w oknie dialogowym Zapisz rysunek jako. 

4 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie sposobu otwierania rysunków 
Istnieje kilka opcji, które określają sposób otwierania rysunków w ALCAD. 

Możesz określić, które rozszerzenia plików są powiązane z ALCAD, umożliwiając 

automatyczne otwieranie plików takich jak .dwg za pomocą ALCAD. 

Dodatkowo można skonfigurować ALCAD do automatycznego otwierania 

rysunków za pomocą polecenia Recover, na przykład, jeśli jesteś nowym 

użytkownikiem ALCAD, a oryginalne rysunki zostały utworzone przy użyciu 

innego oprogramowania CAD i rysunki te regularnie zawierają błędy lub 

uszkodzone dane. Opcja Otwórz rysunki za pomocą odzyskiwania automatycznie sprawdza 

wszystkie rysunki pod kątem błędów podczas korzystania z polecenia Otwórz i w 

razie potrzeby próbuje je odzyskać. Wyświetlanie komunikatów ostrzegawczych 

podczas otwierania rysunków pozwala dowiedzieć się, które pliki są naprawiane przez 

ALCAD i jakie błędy wystąpiły; można jednak również ukryć ostrzeżenia. 
 

Aby ustawić sposób otwierania rysunków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ogólne. 
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3 Aby określić typy plików, które otwierają się automatycznie za pomocą 

ALCAD, kliknij Set Files Association i dokonaj wyboru. 

4 Jeśli chcesz automatycznie używać polecenia Odzyskaj za każdym razem, 

gdy używasz polecenia Otwórz, zaznacz pole wyboru Otwórz rysunki przy 

użyciu Odzyskaj. 

5 Jeśli chcesz ukryć ostrzeżenia w przypadku znalezienia błędów w rysunku, 

zaznacz pole wyboru Ukryj ostrzeżenia podczas otwierania rysunków za 

pomocą funkcji odzyskiwania. Błędy będą nadal rejestrowane w pliku ASCII z 

rozszerzeniem .adt. 

6 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie opcji raportowania błędów 

Raportowanie błędów pojawia się, gdy ALCAD napotka awarię. Można określić, czy 

wystąpi raportowanie błędów i czy zostanie wygenerowany pełny raport. Zaleca się 

generowanie pełnego raportu tylko wtedy, gdy jest to wymagane do celów 

rozwiązywania problemów. Pełny raport danych awarii może mieć rozmiar do 100 

MB i chociaż zawiera pomocne informacje do rozwiązywania problemów, jest bardziej 

prawdopodobne, że zawiedzie podczas transmisji ze względu na rozmiar pliku. 
 

Aby zmienić opcje na karcie Ogólne 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ogólne. 

3 Jeśli chcesz wyłączyć raportowanie błędów, zaznacz pole wyboru Wyłącz 

raportowanie błędów. 

4 Jeśli chcesz wygenerować pełny raport, gdy raportowanie błędów jest 

włączone, zaznacz pole wyboru Generuj pełny raport. 

5 Po zakończeniu kliknij przycisk OK. 

 
Wyłączanie makr VBA CommonProject 
Przy każdym uruchomieniu ALCAD makra są automatycznie ładowane dla 

CommonProject aplikacji Visual Basic (VBA). Jeśli nie planujesz używać VBA, 

wyłączenie makr może poprawić wydajność. Ponadto wyłączenie makr może 

zwiększyć bezpieczeństwo, jeśli program ALCAD jest uruchomiony na niskim 

poziomie bezpieczeństwa. 
 

Aby zmienić opcje na karcie Ogólne 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 
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2 Kliknij kartę Ogólne. 

3 Jeśli nie chcesz, aby makra CommonProject były ładowane po uruchomieniu 

Intelli-CAD, w sekcji VBA Security kliknij pole wyboru Disable VBA 

CommonProject Macros On Startup. 

4 Po zakończeniu kliknij przycisk OK. 

 
Zmiana opcji na karcie Ścieżki/Pliki 

Lokalizacje dla różnych typów plików, takich jak te używane dla rysunków, 

czcionek i menu, można określić w oknie dialogowym Opcje na karcie Ścieżki/Pliki. 

Można nawet określić wiele ścieżek dla tego samego typu plików. Ponadto można 

zmienić nazwy domyślnych plików systemowych, które są używane do takich 

funkcji jak mapowanie czcionek i rejestrowanie błędów. 

 

Określanie ścieżek użytkownika 
Możesz wprowadzić ścieżki do katalogów ALCAD, wybierając je w oknie 

dialogowym Opcje. Funkcja ta obejmuje katalogi rysunków, czcionek, pomocy, 

odnośników zewnętrznych, menu, palet narzędzi, wzorów kreskowania, bloków, 

tabel stylów drukowania, plików wyjściowych drukowania, plików tymczasowych, 

szablonów i książek kolorów. ALCAD przeszukuje katalogi w poszukiwaniu plików 

pomocniczych w następującej kolejności: 

• Katalog programu ALCAD. 

• Bieżący katalog rysowania. 

• Ścieżka wyszukiwania w systemie Windows. 

• Ścieżka wyszukiwania określona w oknie dialogowym Opcje. 

 

Dla każdego elementu można wprowadzić wiele ścieżek. 

Jeśli na przykład element Drawings ma więcej niż jeden powiązany z nim katalog, 

kliknij przycisk Add, aby określić dodatkowe ścieżki. Możesz także oddzielić wiele 

ścieżek średnikiem podczas ich wpisywania. ALCAD przeszukuje katalogi w 

kolejności, w jakiej są wymienione. 
 

 
Aby określić ścieżkę użytkownika 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ścieżki/Pliki. 
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3 W górnej części okna dialogowego wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy i wybierz jedną z opcji z menu skrótów. 

• Kliknij kategorię, aby wyświetlić jej ścieżki wyszukiwania, a następnie 

kliknij pojedynczo ścieżkę, którą chcesz zmodyfikować, i wpisz ścieżkę. 

Jeśli nie znasz ścieżki lub nazwy katalogu, kliknij przycisk Przeglądaj, a 

następnie przejdź do lokalizacji wybranego katalogu. 

4 Po zakończeniu kliknij przycisk OK. 

 
Zmiana domyślnych plików systemowych 
Można zmienić domyślne pliki systemowe, w tym plik dziennika, domyślny szablon, 

zmienioną czcionkę i plik mapowania czcionek. 
 

Aby zmienić domyślny plik systemowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Ścieżki/Pliki. 

3 W dolnej części okna dialogowego, w sekcji Program Files, wykonaj jedną z poniższych 

czynności: 

• Kliknij prawym przyciskiem myszy i wybierz jedną z opcji z menu skrótów. 

• Kliknij nazwę pliku domyślnego pliku systemowego, który chcesz zmienić, 

i wpisz nową nazwę pliku. 

Jeśli nie znasz nazwy pliku, kliknij przycisk Przeglądaj, a następnie przejdź do 

lokalizacji żądanego pliku. 

4 Po zakończeniu kliknij przycisk OK. 
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A Kliknij, aby wyświetlić domyślne ścieżki. Kliknij 

lub naciśnij klawisz F2, aby zmodyfikować 
wybraną ścieżkę. Kliknij dwukrotnie ścieżkę, 
aby otworzyć ścieżkę w Eksploratorze 
Windows. 

B Kliknij lub naciśnij klawisz Insert, aby dodać 
nową ścieżkę dla bieżącej kategorii. 

C Kliknij lub naciśnij klawisz Delete, aby 
usunąć wybraną ścieżkę. 

D Wybierz domyślny plik do zmiany. 

E Kliknij, aby zlokalizować i określić nowy plik domyślny. 

F Kliknij, aby przesunąć wybraną ścieżkę o 
jedną pozycję w górę w kolejności 
wyszukiwania. 

G Kliknij, aby przesunąć wybraną ścieżkę o 
jedną pozycję w dół w kolejności 
wyszukiwania. 

H Kliknij, aby usunąć niestandardowe 
ścieżki i użyć domyślnych ścieżek dla 
wybranej kategorii. 

I Kliknij, aby zlokalizować i określić nową ścieżkę. 

 

Zmiana opcji na karcie Wyświetlanie 

W oknie dialogowym Opcje, zakładka Wyświetlanie zawiera ustawienia 

wyświetlania paska poleceń, okna ALCAD, menu, akcji myszy i języka programu. 
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A Wpisz lub wybierz maksymalną 

liczbę wierszy poleceń do śledzenia. 

B Wybierz, aby używać strzałek w górę i w dół 
do przewijania historii poleceń zamiast 
przesuwania. 

C Wybierz, aby automatycznie sugerować 
nazwy poleceń podczas wpisywania ich na 
pasku poleceń. 

D Wybierz, aby wyświetlić lub ukryć arkusz 
papieru w obszarze papieru na 
kartach układu. 

E Wybierz, aby przewijać zakładki wstążki, gdy 
mysz znajduje się nad wstążką i kręcisz 
kółkiem myszy. (Dostępne dla wersji 
ALCAD ze wstążką). 

F Wybierz pomniejszanie przy obracaniu 
kółka myszy do przodu i powiększanie przy 
obracaniu kółka myszy do tyłu. 

G Kliknij, aby wyświetlić lub ukryć karty Model i 
Układ. 

H Kliknij, aby wyświetlić lub ukryć paski 
przewijania. 

I Kliknij, aby wyświetlić lub ukryć okna 
podpowiedzi. 

J Kliknij, aby wyświetlić lub ukryć menu 
uchwytów. 

K Wyświetla język używany do wyświetlania 
opcji w całym programie. Kliknij przycisk Ustaw 
język, aby wybrać ustawienia języka. 

L Wybierz, aby wyświetlić lokalizację dysku i 
folderu rysunku na pasku tytułu rysunku 
oprócz nazwy pliku. 

 
M Kliknij, aby aktywować wszystkie komunikaty, 

które zostały wcześniej ustawione jako 
niewyświetlane ponownie. 

N Kliknij, aby określić opcje zakładek plików, 
które mogą być wyświetlane dla każdego 
rysunku w oknie głównym. 

O Wybierz wygląd dla wszystkich 
okien ALCAD. 

P Wpisz lub wybierz wartość procentową 
przezroczystości, która ma być stosowana do 
wyświetlanych okienek zachęty. 

Q Wpisz lub wybierz liczbę ostatnio 
używanych rysunków do wyświetlenia w 
menu Plik. 

R Kliknij, aby ustawić urządzenie 
graficzne i inne ustawienia wydajności. 

S Kliknij, aby ustawić procent zanikania dla 
odniesień zewnętrznych, jednostek na 
zablokowanych warstwach i edycji odniesień w 
miejscu. 

T Kliknij, aby wybrać akcję, która ma zostać 
wykonana po kliknięciu prawym przyciskiem 
myszy. 

U Kliknij, aby przypisać kolory do różnych 
części okna rysunku. 

V Kliknij, aby określić sposób wyświetlania wskaźnika. 

W Kliknij, aby określić sposób sugerowania 
nazw poleceń podczas wpisywania ich na 
pasku poleceń. 

X Wprowadź rozmiar czcionki paska poleceń. 

U 
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Ustawianie sposobu działania paska poleceń 
Pasek poleceń to dokowane okno, w którym można wpisywać polecenia ALCAD i 

wyświetlać monity i inne komunikaty programu. Aby wyświetlić pasek poleceń, 

wybierz Widok > Wyświetlacz > Pasek poleceń. Aby dostosować sposób działania 

paska poleceń, zmień opcje na karcie Wyświetlanie. 
 

Aby ustawić sposób działania paska poleceń 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 W polu Linie poleceń do śledzenia wprowadź żądaną liczbę poprzednich 

poleceń i monitów poleceń, które są śledzone na pasku poleceń. Wartość 

domyślna to 256. Polecenia można również wyświetlić w oknie Prompt History, 

naciskając klawisz F2. Aby zamknąć okno, należy ponownie nacisnąć klawisz 

F2. 

4 W polu Rozmiar czcionki wprowadź żądany rozmiar czcionki. Domyślnie jest to 16. 

5 Zaznacz pole wyboru Use Up/Down Arrows for Command History Navigation, 

jeśli chcesz przewijać tekst historii poleceń za pomocą strzałek w górę i w dół na 

klawiaturze. Może to być wygodny sposób przeglądania, a nawet powtarzania 

poprzednich poleceń. Jeśli pole nie jest zaznaczone, użycie strzałek na 

klawiaturze spowoduje przesunięcie widoku rysunku. 
 

Używaj alternatywnych skrótów klawiaturowych. 

Do przesuwania można użyć klawiszy Alt+strzałka. Do przewijania historii 

poleceń można użyć klawiszy Ctrl+K i Ctrl+L. 

6 Zaznacz pole wyboru Włącz autouzupełnianie, aby korzystać z funkcji 

autouzupełniania podczas wpisywania poleceń na pasku poleceń. Więcej 

informacji na temat funkcji Autouzupełnianie można znaleźć w sekcji 

"Dostosowywanie sposobu wyświetlania sugestii na pasku poleceń" na stronie 

695 w tym rozdziale. 

7 Po zakończeniu kliknij przycisk OK. 
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Dostosowywanie sposobu wyświetlania sugestii na pasku poleceń 
Podczas wpisywania na pasku poleceń ALCAD sugeruje nazwy pasujących 

poleceń. Sugerowane nazwy pojawiają się w oknie Autouzupełniania, które 

otwiera się automatycznie podczas pisania i zamyka po aktywacji polecenia. 

Korzystanie z Autouzupełniania to skuteczny sposób wybierania poleceń, a także 

wygodny sposób wyświetlania listy powiązanych poleceń. Na przykład, jeśli wpiszesz 

"LA" na pasku poleceń, aby pracować z warstwami, wszystkie polecenia związane 

z warstwami, które zaczynają się od "LA", zostaną wyświetlone w oknie 

Autouzupełniania. 

Oprócz nazw poleceń, sugestie mogą zawierać nazwy zewnętrznych poleceń, 

zmiennych systemowych, aliasów i funkcji LISP. Każda nazwa jest wyświetlana z 

kolorową ikoną, która wskazuje jej typ: 

• Czerwony - polecenie ALCAD 

• Zielony - polecenie zewnętrzne 

• Żółty - zmienna systemowa 

• Niebieski - funkcja LISP 

Aby dostosować sposób wyświetlania sugestii na pasku poleceń 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Zaznacz pole wyboru Włącz autouzupełnianie, aby włączyć automatyczne 

podpowiadanie nazw podczas wpisywania na pasku poleceń. 

4 Kliknij Opcje autouzupełniania. 
 

Użyj skrótu. 

Wpisz INPUTSEARCHOPTIONS, a następnie naciśnij enter, aby uzyskać 

dostęp do opcji autouzupełniania bezpośrednio z paska poleceń. 

5 W polu Limit czasu autouzupełniania wprowadź liczbę milisekund oczekiwania 

między naciśnięciami klawiszy przed wyświetleniem okna autouzupełniania. Im 

wyższa liczba, tym dłuższe dopuszczalne opóźnienie między naciśnięciami 

klawiszy (okno Autouzupełniania będzie wyświetlane rzadziej). 
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Osoby szybko piszące na klawiaturze zazwyczaj zwiększają ustawienie limitu czasu. 

Jeśli okno Autouzupełniania często koliduje z wpisywaniem tekstu na pasku 

poleceń, spróbuj ustawić liczbę milisekund na 1000 lub więcej. 
 

6 W polu Minimalna długość tekstu wprowadź liczbę liter, które należy wpisać 

na pasku poleceń przed wyświetleniem okna autouzupełniania. 

7 W polu Przezroczystość wprowadź wartość procentową przezroczystości (od 0 

do 50), w jakiej ma być wyświetlane okno Autouzupełniania. Im wyższa liczba, 

tym bardziej przezroczyste jest okno. Aby okno było nieprzezroczyste, 

wprowadź zero. 

8 Określ, jak działa selekcja: 

• Zaznacz opcję Użyj ostatnich poleceń, aby wyszukać i automatycznie 

wybrać ostatnio używane polecenie, jeśli to możliwe. 

• Zaznacz opcję Pokaż sugestie w wierszu poleceń, aby wstępnie wypełnić 

wiersz poleceń nazwą podczas przewijania listy. Jeśli opcja ta jest wyłączona, 

nazwa nie jest wstępnie wypełniana w wierszu poleceń, jednak nadal można 

wybrać żądaną nazwę w oknie AutoCom- plete, klikając ją lub naciskając 

klawisze CTRL + Enter. 

• Zaznacz opcję Wybór cykliczny, jeśli chcesz zezwolić na przewijanie listy od 

końca do początku (i odwrotnie) za pomocą klawisza strzałki. 

• Zaznacz opcję Mouse-Over Selection, aby umożliwić wybór poprzez 

najechanie myszą, a nie kliknięcie, na wybraną nazwę. 

9 Zaznacz opcję Pokaż ikony poleceń, aby wyświetlić ikony, jeśli są dostępne, dla 

każdego polecenia na liście. 

10 Zaznacz opcję Użyj kolorów wiersza poleceń, aby wyświetlić okno 

Autouzupełniania przy użyciu tych samych kolorów tła i tekstu, które zostały 

wybrane dla paska poleceń. Więcej informacji na temat wybierania kolorów 

paska poleceń można znaleźć w sekcji "Ustawianie kolorów głównego okna" na 

stronie 699 w tym rozdziale. 

11 Zaznacz, które elementy mają zostać uwzględnione na liście sugerowanych 

nazw: aliasy, polecenia zewnętrzne, zmienne systemowe i/lub funkcje LISP. W 

przypadku wybrania tej opcji funkcje LISP będą wyświetlane po wprowadzeniu 

nawiasu "(" podczas pierwszego wpisywania. 

12 Kliknij przycisk OK. 

13 Kliknij przycisk OK. 
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A Wprowadź liczbę milisekund 
oczekiwania między naciśnięciami 
klawiszy przed wyświetleniem okna 
autouzupełniania. 

B Wprowadź minimalną liczbę liter do wpisania 
przed wyświetleniem okna autouzupełniania. 

C Wprowadź procent przezroczystości, w jakim ma 
być wyświetlane okno autouzupełniania. 

D Kliknij, aby wyszukać i automatycznie 
wybrać ostatnio używane polecenie. 

E Kliknij, aby wstępnie wypełnić wiersz 
poleceń pełną nazwą podczas przewijania 
listy. 

F Kliknij, aby umożliwić przewijanie za pomocą 
klawisza strzałki od końca listy do jej 
początku (i odwrotnie). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

G Kliknij, aby umożliwić wybór poprzez 
najechanie kursorem myszy na wybraną 
nazwę. 

H Kliknij, aby wyświetlić lub ukryć ikony poleceń. 

I Kliknij, aby użyć tych samych kolorów 
w oknie autouzupełniania, które zostały 
określone dla paska poleceń. 

J Kliknij, aby dołączyć nazwy funkcji LISP. 

K Kliknij, aby dołączyć nazwy zmiennych systemowych. 

L Kliknij, aby dołączyć zewnętrzne nazwy poleceń. 

M Kliknij, aby dołączyć nazwy aliasów. 

A 

B 

C 

D  

E 

F 

G 

H 

I 

M 

L 

K 

   J 
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Ustawianie opcji okna głównego 
Główne okno ALCAD można dostosować na wiele sposobów, aby jak najlepiej 

dostosować je do swojego stylu pracy. Na przykład ukrywanie elementów okna, 

jeśli ich nie używasz, może pomóc zwiększyć przestrzeń do rysowania w oknie 

ALCAD. 

Aby ustawić opcje okna głównego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Zaznacz pole wyboru Show Paper Sheet in Paper Space, jeśli chcesz wyświetlać 

ograniczony arkusz papieru dla zakładek układu. Gdy pole nie jest zaznaczone, 

arkusz papieru nie jest wyświetlany. 

4 Zaznacz pole wyboru Pokaż karty modelu i układu, jeśli chcesz wyświetlać 

karty modelu i układu w oknie głównym. Gdy pole nie jest zaznaczone, karty 

nie są wyświetlane, co może być przydatne, jeśli pracujesz tylko na karcie 

Model lub jeśli używasz paska poleceń i paska stanu do przełączania się między 

kartami. 

5 Zaznacz pole wyboru Pokaż paski przewijania, jeśli chcesz wyświetlić paski 

przewijania po prawej stronie i na dole okna ALCAD lub rzutni. Gdy pole nie 

jest zaznaczone, paski przewijania nie są wyświetlane, co może poprawić 

wydajność i może być również pomocne, jeśli do przewijania rysunków używane 

jest tylko polecenie Przesuń. 

6 Kliknij Opcje kursora, aby określić sposób wyświetlania wskaźnika: 

• Kliknij to pole wyboru, aby wskaźnik był zawsze wyświetlany jako krzyżyk 

(zamiast domyślnego kursora strzałki z polem wyboru). Należy pamiętać, że 

jeśli to pole wyboru nie jest zaznaczone, wszystkie kolejne opcje są 

niedostępne. 

• Rozmiar krzyżyka Wprowadź liczbę określającą procent ekranu, który ma 

być używany przez kursor krzyżyka, lub użyj strzałek w górę i w dół, aby 

przewinąć do liczby. Należy pamiętać, że w zależności od urządzenia 

graficznego, duży procent może negatywnie wpłynąć na wydajność 

wyświetlania. 

• Krzyżyk celowniczy Kliknij to pole wyboru, aby wyświetlić wskaźnik jako 

krzyżyk celowniczy zamiast zwykłego krzyżyka. Opcję tę można również 

kontrolować, klikając przycisk Włącz/wyłącz krzyż celowniczy na pasku 

stanu. 

• Krzyżyk Użyj XOR Odwróć kolory Kliknij to pole wyboru, aby włączyć 

użycie logicznego XOR dla koloru kursora, który zmienia kolor kursora, gdy 

przesuwa się nad jednolitymi kolorami na rysunku, tak aby kursor był nadal 

widoczny. Opcję tę można również kontrolować, klikając przycisk 

Włącz/wyłącz kursor XOR na pasku stanu. 
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7 Kliknij przycisk Kontrola zanikania, aby określić procent zanikania dla jednostek i plików: 

• Xref Display Wprowadź wartość lub przesuń suwak, aby określić procent 

wygaszania stosowany do zewnętrznych odniesień pliku .dwg. 

• Jednostki na zablokowanych warstwach Wprowadź wartość lub przesuń 

suwak, aby określić procent wygaszania stosowany do jednostek 

znajdujących się na zablokowanych warstwach. 

• Edycja w miejscu i reprezentacje adnotacji Wprowadź wartość lub przesuń 

suwak, aby określić procent zanikania stosowany podczas edycji 

zewnętrznego odniesienia w miejscu. Zanikanie jest stosowane do jednostek 

odniesienia zewnętrznego, które nie są aktualnie edytowane. 

8 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie kolorów okna głównego 
Możesz kontrolować kolor wielu aspektów głównego okna rysowania, takich jak 

kolor tła, kolor krzyżyka i inne. 
 

Aby ustawić kolory głównego okna rysowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij opcję Schemat kolorów. 

4 W obszarze Kontekst wybierz obszar zawierający elementy, dla których chcesz 

określić kolumny. 

5 W obszarze Elementy wybierz element, dla którego chcesz określić kolor. 

6 W obszarze Kolory wybierz kolor lub wybierz opcję Wybierz kolor, aby uzyskać więcej 

opcji. 

7 Kliknij Włącz/Wyłącz, aby wyświetlić lub ukryć element (dostępne tylko 

wtedy, gdy wybrany element można wyłączyć). 

8 Po zakończeniu kliknij przycisk Zastosuj i zamknij. 
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A J 
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A Wybierz obszar okna rysowania. 

B Wybierz element, dla którego chcesz zmienić 
kolor. 

C Wyświetla przykład aktualnie 
wybranych kolorów. 

D Kliknij, aby zapisać bieżące ustawienia 
kolorów w pliku schematu kolorów. 

E Kliknij, aby wybrać plik schematu kolorów i 
załadować go. 

F Kliknij, aby przywrócić domyślne kolory dla 
wszystkich kontekstów i elementów. 

G Kliknij, aby przywrócić domyślne kolory dla 
aktualnie wybranego kontekstu. 

H Kliknij, aby przywrócić domyślny kolor dla 
aktualnie wybranego elementu. 

I Kliknij, aby wyświetlić lub ukryć wybrany 
element (dostępne tylko wtedy, gdy element 
można wyłączyć). 

J Wybierz kolor dla aktualnie wybranego 
elementu. Wybierz opcję Wybierz kolor, 
aby uzyskać więcej opcji kolorów. 
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Aby zapisywać i otwierać schematy kolorów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij opcję Schemat kolorów. 

4 Przed zapisaniem ustawień należy wprowadzić wszelkie poprawki. 

5 Kliknij przycisk Zapisz, aby zapisać bieżący wybór kolorów jako plik schematu kolorów. 

6 Kliknij przycisk Załaduj, aby wybrać schemat kolorów (plik .xml lub .clr) i załadować go. 

7 Kliknij przycisk Zastosuj i zamknij. 
 

Schematy kolorów to łatwy sposób na ponowne wykorzystanie ulubionych ustawień kolorów. 

Jeśli pracujesz na więcej niż jednym komputerze, zapisz schemat kolorów w pliku i 

załaduj go na innym komputerze. 
 

 
Aby przywrócić domyślne ustawienia kolorów 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij opcję Schemat kolorów. 

4 Wykonaj jedną z poniższych czynności: 

• Resetowanie pojedynczego elementu - wybierz element, któremu chcesz 

przywrócić domyślny kolor, a następnie kliknij opcję Bieżący element. 

• Resetowanie wszystkich elementów w kontekście - Wybierz kontekst, a 

następnie kliknij opcję Bieżący kontekst. Wszystkim elementom w 

bieżącym kontekście zostaną przywrócone domyślne kolory. 

• Zresetuj wszystkie kolory - kliknij Wszystkie kolory. Wszystkim elementom 

we wszystkich kontekstach zostaną przywrócone domyślne kolory. 

5 Kliknij przycisk Zastosuj i zamknij. 
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Ustawianie opcji myszy 
Działania myszy można dostosować do własnego stylu pracy. Na przykład, jeśli nie 

używasz menu skrótów, możesz preferować powtarzanie ostatniego polecenia po 

kliknięciu prawym przyciskiem myszy. 

Aby ustawić opcje myszy 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Zaznacz pole wyboru Użyj kółka myszy do przewijania kart wstążki, jeśli chcesz 

mieć możliwość przewijania kart wstążki za pomocą kółka myszy, gdy mysz zatrzyma 

się nad wstążką. 

4 Zaznacz pole wyboru Odwróć kierunek zoomu kółka myszy, jeśli chcesz 

odwrócić kierunek zoomu kółka myszy, tj. obrócić kółko do przodu, aby 

pomniejszyć i obrócić je do tyłu, aby powiększyć, Może to być szczególnie 

przydatne, jeśli używasz myszy lewą ręką. Gdy pole nie jest zaznaczone 

(ustawienie domyślne), kółko myszy obraca się do przodu w celu przybliżenia i 

do tyłu w celu oddalenia. 

5 Aby ustawić akcję podejmowaną po kliknięciu prawym przyciskiem myszy na 

rysunku, kliknij opcję Akcja po kliknięciu prawym przyciskiem myszy i wybierz 

jedną z poniższych opcji: 

• No Selection (Brak zaznaczenia) - aby powtórzyć poprzednio użyte 

polecenie w przypadku kliknięcia prawym przyciskiem myszy, gdy podmioty nie są 

zaznaczone, wybierz opcję Repeat Last Command (Powtórz ostatnie polecenie). 

Aby wyświetlić menu skrótów po kliknięciu prawym przyciskiem myszy, 

gdy podmioty nie są zaznaczone, wybierz opcję Pokaż menu skrótów. 

• Podmioty są zaznaczone - aby powtórzyć poprzednio użyte polecenie po 

kliknięciu prawym przyciskiem myszy, gdy zaznaczone są podmioty, wybierz opcję 

Powtórz ostatnie polecenie. Aby wyświetlić menu skrótów, które wyświetla 

opcje specyficzne dla wybranych elementów po kliknięciu prawym przyciskiem 

myszy, wybierz opcję Pokaż menu skrótów. Kliknięcie prawym przyciskiem 

myszy w dowolnym miejscu rysunku z zaznaczonymi elementami spowoduje 

wyświetlenie menu skrótów dla wybranych elementów. 

6 Po zakończeniu kliknij przycisk OK. 
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Ustawianie sposobu wyświetlania menu 
Wyświetlanie menu można dostosować, w tym czy wyświetlane są menu 

podpowiedzi i menu skrótów po kliknięciu prawym przyciskiem myszy, czy menu 

ładują się automatycznie oraz liczbę plików rysunków wyświetlanych w menu Plik. 

Aby ustawić sposób wyświetlania menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Zaznacz pole wyboru Wyświetlaj okna podpowiedzi, jeśli chcesz wyświetlać 

okna podpowiedzi, które wyświetlają te same opcje poleceń, które są 

wyświetlane na pasku stanu i pasku poleceń. Wyłączenie okien podpowiedzi 

może zaoszczędzić miejsce na ekranie i zminimalizować liczbę kliknięć myszą. 

4 Zaznacz pole wyboru Wyświetl menu uchwytów, jeśli chcesz, aby menu 

uchwytów były wyświetlane po zatrzymaniu myszy nad uchwytem, który ma 

powiązane menu. Na przykład uchwyty polilinii mają menu. 

5 W polu Rozmiar listy ostatnio otwieranych rysunków wprowadź liczbę ostatnio 

otwieranych rysunków wyświetlanych w menu Plik. 

6 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie opcji interfejsu użytkownika 
Opcje interfejsu użytkownika obejmują sposób wyświetlania nazw plików na pasku 

tytułu, motywy wpływające na wygląd okien ALCAD oraz język używany do 

wyświetlania opcji w całym programie ALCAD. 

Lista dostępnych języków zależy od tego, jakie języki zostały zainstalowane na 

komputerze. Jeśli żądany język nie pojawia się na liście, należy naprawić lub 

ponownie zainstalować aplikację z ustawieniami dostosowanymi do żądanego 

języka. 
 

Aby ustawić opcje interfejsu użytkownika 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 
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3 Kliknij przycisk Ustaw język, a następnie w polu Metoda wyboru języka wybierz 

jedną z poniższych opcji: 

• Wybór ręczny - używa języka wybranego na liście Zainstalowane języki. 

• Automatycznie dopasuj ustawienia regionalne - dopasowuje język 

ustawiony dla regionu geograficznego. 

• Automatycznie dopasuj ustawienia regionalne systemu - 

dopasowuje język ustawiony dla systemu operacyjnego. 

4 Kliknij przycisk OK. 

5 Zaznacz pole wyboru Pokaż pełną ścieżkę rysunku na pasku tytułu, jeśli chcesz 

wyświetlać lokalizację dysku i folderu rysunku na pasku tytułu rysunku oprócz 

nazwy pliku. Gdy pole nie jest zaznaczone (domyślnie), na pasku tytułu rysunku 

wyświetlana jest tylko nazwa pliku. 

6 W Theme, wybierz wygląd, który chcesz dla wszystkich okien ALCAD. 

7 Kliknij File Tab Options i wybierz opcje wyświetlania rysunków na kartach w 

oknie głównym: 

• Enable File Tabs - Wybierz, aby wyświetlić każdy rysunek jako 

własną kartę w oknie ALCAD. Jeśli opcja ta jest wyłączona, rysunki 

będą wyświetlane jako osobne okna. 

• Styl zakładek - wybór stylu wyświetlania zakładek. 

• Przycisk zamykania zakładki - Wybierz, aby wyświetlić [X] dla przycisku 

zamykania na aktywnej zakładce. Jeśli opcja ta jest wyłączona, przyciski 

zamykania nie będą wyświetlane na kartach rysowania. 

• Pokaż ikony - Wybierz, aby na każdej karcie wyświetlana była ikona 

wskazująca typ pliku rysunku. Jeśli opcja ta jest wyłączona, ikony nie będą 

wyświetlane na kartach rysunków. 

• Top Location - Wybierz, aby umieścić zakładki na górze rysunków. Jeśli 

opcja ta jest wyłączona, zakładki są umieszczane na dole rysunków. 

8 Kliknij przycisk OK. 

9 Po zakończeniu kliknij przycisk OK. 
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A Wyświetla język ustawiony dla regionu 
geograficznego. 

B Wyświetla zestaw języków dla systemu 
operacyjnego. 

C Wybierz żądany język z listy 
zainstalowanych języków. 

D Wybierz, aby automatycznie dopasować język 
ustawiony dla regionu geograficznego. 

E Wybierz, aby automatycznie dopasować język 
ustawiony dla systemu operacyjnego. 

F Wyświetla listę języków zainstalowanych 
dla 
ALCAD.Clickthedesiredlanguageinthelist; 
dostępne tylko wtedy, gdy wybrano metodę 
ręcznego wyboru. 

G Kliknij, aby otworzyć okno dialogowe 
systemu operacyjnego służące do 
ustawiania opcji językowych. 
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Dostosowywanie opcji urządzenia graficznego pod kątem wydajności wyświetlania 
W zależności od komputera i dostępnych urządzeń graficznych, ALCAD 

automatycznie określa najlepsze ustawienia wyświetlania i renderowania 

rysunków. W niektórych przypadkach użytkownicy mogą jednak chcieć 

samodzielnie dostosować niektóre ustawienia. Na przykład przełączanie między 

urządzeniami graficznymi może czasami rozwiązać problemy z wydajnością 

podczas korzystania z określonych kart graficznych. 
 

Aby ustawić opcje urządzenia graficznego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Wyświetlanie. 

3 Kliknij Wydajność grafiki. 
 

Użyj skrótu. 

Na pasku stanu kliknij prawym przyciskiem myszy opcję Przełącz urządzenie 

graficzne i wybierz Ustawienia, aby otworzyć okno dialogowe Wydajność grafiki. 
 

4 W polu Graphics Device (Urządzenie graficzne) wybierz urządzenie graficzne, które ma być 

używane: 

• Zaawansowane (OpenGL ES) Wybierz dla wysokiej klasy kart graficznych. 

• Intermediate (OpenGL) Wybierz dla kart graficznych średniego poziomu. 

• Podstawowa (oprogramowanie) Wybierz dla podstawowych kart graficznych. 
 

Użyj skrótu. 

Na pasku stanu kliknij przycisk Przełącz urządzenie graficzne, aby przełączyć 

się na następne urządzenie graficzne na liście. 
 

5 Aby włączyć antyaliasing dla dwuwymiarowych obiektów w stylach 

wizualnych 2D wireframe, zaznacz opcję Antyaliasing 2D. 

6 Aby włączyć antyaliasing z wielopróbkowaniem do wyświetlania elementów 

trójwymiarowych, zaznacz opcję Antyaliasing 3D. 

7 Kliknij przycisk OK. 
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Dostosowywanie opcji wyświetlania dla monitorów o wysokiej 
rozdzielczości lub do przełączania między monitorami 
ALCAD został zaprojektowany tak, aby działał w odpowiednim rozmiarze na 

różnych monitorach o różnych rozdzielczościach. Jeśli jednak przełączasz się między 

monitorami o różnych rozdzielczościach lub używasz monitora o rozdzielczości 4K 

lub wyższej, może być konieczne ręczne ustawienie niektórych opcji. 

Te niestandardowe opcje są zmiennymi systemowymi dostępnymi w wierszu 

polecenia, a nie w oknie dialogowym Opcje. 
 

Aby ustawić opcje wyświetlania dla monitorów 4K lub przełączania między monitorami 

1 Wpisz dowolną z poniższych nazw zmiennych systemowych i zmień ich ustawienia: 

• 3DORBITCTRSPHERESIZE - kontroluje rozmiar małej sfery orbity 

wyświetlanej w punkcie obrotu podczas korzystania z poleceń Constrained 

Orbit (3DORBIT), Continuous Orbit (3DCORBIT) i Free Orbit (3DFORBIT). 

Wprowadź liczbę z zakresu od 1 do 20. 

• APERTURE - kontroluje obszar wyboru przyciągania jednostki w pikselach. 

Wprowadź liczbę od 1 do 10. 

• BLIPSIZE - kontroluje rozmiar znacznika blip w pikselach. Blip to znak plus 

(+), który pojawia się tymczasowo po określeniu punktu na ekranie. Wprowadź 

liczbę z zakresu od 1 do 255. 

• GRIPSIZE - kontroluje rozmiar pola (w pikselach) używanego do 

wyświetlania uchwytów. Wprowadź liczbę od 1 do 255. 

• PDSIZE - kontroluje rozmiar wyświetlanego punktu. Wartość domyślna (0) 

określa rozmiar punktu równy 5% rozmiaru ekranu. Wartość większa niż 0 

określa rozmiar bezwzględny, a wartość mniejsza niż 0 określa rozmiar 

procentowy. 

• PICKBOX - kontroluje docelową wysokość wyboru jednostki w pikselach. 

Wprowadź liczbę z zakresu od 0 do 50. 

• SNAPSIZE - kontroluje rozmiar znacznika przyciągania encji w pikselach. 

Znacznik przyciągania encji jest tymczasowym glifem, który pojawia się 

podczas korzystania z przyciągania encji i wskazuje bieżącą lokalizację 

przyciągania. Wprowadź liczbę od 1 do 20. 
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Zmiana opcji na karcie Profile 

ALCAD pozwala dostosować ustawienia, które kontrolują środowisko rysowania, a 

następnie zapisać i przywrócić te ustawienia w profilu. Na przykład, jeśli wolisz 

pracować z niestandardowymi menu i paskami narzędzi, możesz zapisać te ustawienia jako 

własny profil. 

Profile mogą być pomocne, jeśli masz wielu użytkowników o różnych preferencjach 

lub jeśli jesteś jednym użytkownikiem, który pracuje nad różnymi projektami 

wymagającymi unikalnych ustawień. Możesz nawet wyeksportować swój profil i 

zabrać go ze sobą, gdy pracujesz na innym komputerze. 

 

Zrozumienie ustawień zapisanych w profilach 
Profile zapisują wiele ustawień, które kontrolują środowisko rysowania. Po 

rozpoczęciu korzystania z profilu automatycznie śledzi on i zapisuje zmiany wprowadzone w 

środowisku rysowania. 

Niektóre ustawienia są zapisywane natychmiast, ale niektóre wymagają wyjścia z 

ALCAD, a następnie ponownego uruchomienia ALCAD. Dzieje się tak, ponieważ 

profile zapisują ustawienia z rejestru komputera, a niektóre ustawienia są zapisywane 

w rejestrze tylko po zamknięciu programu Intelli- CAD. 

 
Ustawienia zapisane w profilach 

 

Ustawienie Lokalizacja Po zapisaniu 

Ustawienia paska 
narzędzi 

Narzędzia > Dostosuj, zakładka 
Paski narzędzi 

Wyjście i ponowne uruchomienie 
ALCAD 

Ustawienia menu Narzędzia > Dostosuj, zakładka 
Menu 

Natychmiast 

Ustawienia klawiatury Narzędzia > Dostosuj,  karta 

Klawiatura Natychmiast  Ustawienia aliasuNarzędzia > Dostosuj, karta 

Aliasy Natychmiast 

Stan 
włączenia/wyłączenia 
elementów okna i ich 
różne ustawienia 

Widok > Wyświetlanie > Pasek 
poleceń Widok > 
Wyświetlanie > Karty 
modelu i układu 
Widok > Wyświetlanie > Okno 
historii komunikatów 
Widok > Wyświetlacz > Paski 
przewijania Widok > Pasek 
stanu 

Wyjście i ponowne uruchomienie ALCAD 

 

Konfiguracje tabletu Narzędzia >Tablet

 Natychmiastowe ścieżki użytkownika

 Narzędzia >Opcje, zakładka Ścieżki/Pliki

 Natychmiast 

Zmienne systemowe Wpisywane na pasku poleceń Różne - niektóre zapisywane natychmiast 
a niektóre po wyjściu i ponownym 
uruchomieniu ALCAD 
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Tworzenie profili 
Utwórz profile, jeśli chcesz zapisać niestandardowe ustawienia środowiska 

rysowania. Może to być przydatne, jeśli masz dwa lub więcej środowisk rysowania, 

których używasz regularnie. 

Podczas tworzenia nowego profilu bieżące ustawienia środowiska rysowania są 

automatycznie zapisywane wraz z nowym profilem. 
 

Aby utworzyć profil 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Kliknij przycisk Utwórz. 

4 Wprowadź nazwę, opis (opcjonalnie), a następnie kliknij przycisk OK. 

5 W oknie dialogowym Opcje kliknij przycisk OK. 

6 Wprowadź zmiany w środowisku rysowania. 

ALCAD automatycznie zapisuje ustawienia w nowym profilu. 
 

Niektóre przypadki wymagają wyjścia i ponownego uruchomienia programu ALCAD 

przed zapisaniem ustawień w profilu. 

Wynika to z faktu, że profile zapisują ustawienia z rejestru komputera i niektórych ustawień. 

Ustawienia, takie jak ustawienia paska narzędzi, są zapisywane w rejestrze 

dopiero po zamknięciu programu Intelli-CAD. 
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A 

B 

 
 
 
 
 
 
 
 

C 

 
 
 
 
 
 
 

A Wyświetla nazwę aktualnie załadowanego 
profilu. 

B Wybierz profil, aby go załadować lub 
zmodyfikować. 

C Wyświetla opis profilu. 

D Kliknij przycisk , aby przywrócić wybrane 
ustawienia domyślne systemu. 

E Kliknij, aby otworzyć profil zapisany w pliku 
.arg. 

F Kliknij, aby zapisać wybrany profil w pliku.arg. 

 

Ładowanie profilu 

K 

 
 

J 

I 

H 

G 

F 

E 

 

D 

 
 
 
 
 
 
 
 

G Kliknij, aby usunąć wybrany profil. 

H Kliknij, aby zmienić nazwę wybranego profilu. 

I Kliknij, aby utworzyć kopię wybranego profilu. 

J Kliknij, aby załadować wybrany profil i 
uczynić go aktywnym. 

K Kliknij, aby utworzyć nowy profil. 

 

Podczas pracy w ALCAD można załadować niestandardowe ustawienia dowolnego 

profilu. Bieżący profil po wyjściu z ALCAD jest automatycznie ładowany po 

ponownym uruchomieniu ALCAD. 
 

Aby załadować profil 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz żądany profil. 
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4 Kliknij przycisk Ustaw bieżący. 

 
Przywracanie ustawień domyślnych 
W dowolnym momencie można powrócić do domyślnych ustawień środowiska 

rysowania, które zostały zainstalowane wraz z programem ALCAD. 

Jeśli profil domyślny pozostał niezmieniony, wystarczy go wczytać, aby przywrócić 

ustawienia domyślne. Jeśli profil domyślny został usunięty lub zmieniony, należy 

zresetować istniejący profil (taki, który nie jest już potrzebny), aby zastąpić jego 

zawartość ustawieniami domyślnymi. 
 

Aby przywrócić ustawienia domyślne przy użyciu niezmienionego profilu domyślnego 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil domyślny. 

4 Kliknij przycisk Ustaw bieżący. 
 

Aby przywrócić ustawienia domyślne bez korzystania z profilu domyślnego 
 

Zresetowanie profilu powoduje usunięcie wszystkich jego ustawień niestandardowych. 

Zrób to tylko wtedy, gdy jesteś pewien, że nie potrzebujesz już wybranego profilu. 
 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil, którego już nie potrzebujesz; wszystkie jego ustawienia 

niestandardowe zostaną usunięte. W razie potrzeby utwórz lub skopiuj profil w 

celu przywrócenia ustawień domyślnych. 

4 Kliknij przycisk Resetuj. 
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Zarządzanie profilami 
Po rozpoczęciu korzystania z profili może zajść potrzeba zmiany ich nazwy, 

skopiowania lub usunięcia. Kopiowanie profilu to szybki sposób na utworzenie 

nowego profilu na podstawie już istniejącego. 
 

Aby zmienić nazwę profilu 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil, którego nazwę chcesz zmienić. 

4 Kliknij przycisk Zmień nazwę. 

5 Wprowadź niezbędne zmiany w nazwie lub opisie, a następnie kliknij przycisk OK. 
 

Aby skopiować profil 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil, który chcesz skopiować. 

4 Kliknij przycisk Kopiuj. 

5 Wprowadź nową nazwę, opis (opcjonalnie), a następnie kliknij OK. 
 

Aby usunąć profil 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil, który chcesz usunąć. 

4 Kliknij przycisk Usuń. 
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Praca z profilami na wielu komputerach 
Jeśli korzystasz z wielu komputerów i lubisz pracować z własnymi ustawieniami 

środowiska rysowania, oszczędzaj czas, zabierając swój profil ze sobą. 

Na komputerze wyeksportuj swój profil do pliku .arg. Przenieś plik na inny 

komputer za pomocą dysku, poczty e-mail, sieci lub w inny sposób. Po rozpoczęciu 

pracy na innym komputerze wystarczy otworzyć i załadować profil zamiast 

odtwarzać preferowane środowisko rysowania. 
 

Aby wyeksportować profil do pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Wybierz profil do wyeksportowania. 

4 Kliknij przycisk Eksportuj. 

5 Określ lokalizację i nazwę wyeksportowanego pliku, a następnie kliknij przycisk Zapisz. 
 

Aby otworzyć profil z pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Profile. 

3 Kliknij przycisk Importuj. 

4 Zlokalizuj i wybierz profil (plik .arg), a następnie kliknij przycisk Otwórz. 

5 Wprowadź niezbędne zmiany w nazwie lub opisie, a następnie kliknij przycisk OK. 

6 (Opcjonalnie) Aby załadować zaimportowany profil, wybierz go, a następnie kliknij 

przycisk Ustaw bieżący. 
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Zmiana opcji na karcie Drukowanie 

W oknie dialogowym Opcje na karcie Drukowanie można określić kilka ustawień 

drukowania, w tym domyślną drukarkę, nagłówki, stopki, pliki konfiguracyjne 

drukarki (pliki PC3) i style drukowania, które zmieniają wygląd drukowanego 

rysunku bez modyfikowania rzeczywistych elementów rysunku. 

 

 

 

 

 
 

A 

 

F 
B 

E 
C 

D 

 
 
 
 
 
 
 
 
 
 
 
 

A Wybór domyślnej drukarki do 
przypisania do nowych rysunków. 

B Kliknij, aby określić ustawienia używane 
podczas automatycznego publikowania 
rysunków. 

C Wybierz, które rysunki mają być 
automatycznie publikowane po ich zapisaniu 
lub zamknięciu. 

D Kliknij, aby określić ustawienia plików 
konfiguracyjnych drukarki (pliki PC3). 

E Kliknij, aby określić nagłówek lub stopkę 
dla drukowanych rysunków. 

F Kliknij, aby określić ustawienia tabel stylu 
wydruku dla nowych rysunków utworzonych 
bez szablonu lub starszych rysunków. 
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Ustawianie drukarki domyślnej 
Domyślna drukarka lub urządzenie wyjściowe jest przypisywane do wszystkich 

nowych rysunków. Należy wybrać urządzenie najczęściej używane do drukowania 

rysunków. Później, w razie potrzeby, można przypisać inną drukarkę do dowolnego 

istniejącego rysunku. 

Aby ustawić drukarkę domyślną 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 W polu Domyślne urządzenie wyjściowe wybierz drukarkę, która zostanie przypisana do 

nowych rysunków. 

3 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie opcji automatycznego publikowania 
Domyślna drukarka lub urządzenie wyjściowe jest przypisywane do wszystkich 

nowych rysunków. Należy wybrać urządzenie najczęściej używane do drukowania 

rysunków. Później, w razie potrzeby, można przypisać inną drukarkę do istniejącego 

rysunku. 
 

Aby ustawić opcje automatycznego publikowania 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 Kliknij opcję Ustawienia automatycznego publikowania, aby określić ustawienia 

używane podczas automatycznego publikowania rysunków. Więcej informacji na temat 

tych ustawień można znaleźć w sekcji "Automatyczne publikowanie" na stronie 

572. 

3 Aby włączyć automatyczne publikowanie podczas zapisywania lub 

zamykania rysunków, zaznacz opcję Auto- matic Publish on Save or Close. 

4 Po zakończeniu kliknij przycisk OK. 

 

Można również skonfigurować opcje automatycznego publikowania za pomocą polecenia Auto 
Publish. 

Więcej informacji można znaleźć w sekcji "Automatyczne publikowanie" na stronie 572. 
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Ustawianie domyślnych stylów drukowania 
Domyślne ustawienia stylu wydruku mają wpływ tylko na określone rysunki: nowe 

rysunki utworzone bez szablonu i starsze rysunki po otwarciu (starsze rysunki, które 

zostały utworzone przed udostępnieniem stylów wydruku, na przykład przed 

AutoCAD 2000). Nie ma to wpływu na aktualnie otwarte rysunki. 

Więcej informacji na temat stylów wydruku i tabel stylów wydruku można znaleźć 

w sekcji "Korzystanie ze stylów wydruku" na stronie 546. 
 

Aby skonfigurować domyślne ustawienia stylu wydruku dla nowych rysunków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 Kliknij opcję Ustawienia stylu drukowania. 

3 Wybierz, czy dla nowych rysunków utworzonych bez szablonu mają być 

używane tabele stylów wydruku zależne od koloru lub nazwane. 

4 Wybór domyślnej tabeli stylów wydruku do użycia z nowymi rysunkami. 

5 W przypadku nazwanych tabel stylów wydruku należy wybrać zarówno styl 

wydruku do przypisania do warstwy zerowej, jak i do nowych jednostek. W 

przypadku tabel zależnych od koloru styl wydruku to BYCOLOR i nie można go 

wybrać. 

6 Kliknij przycisk OK. 

7 Po zakończeniu kliknij przycisk OK. 
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Określanie nagłówka i stopki 
Można dołączyć informacje takie jak data i godzina, imię i nazwisko, nazwa firmy 

lub inne informacje, które mają być wyświetlane na górze lub na dole rysunków 

podczas ich drukowania. 

Ustawienia nagłówka i stopki są ustawiane globalnie dla wszystkich rysunków, choć 

nie muszą być dołączane do każdego drukowanego rysunku. Podczas drukowania w 

oknie dialogowym Drukuj należy odpowiednio zaznaczyć lub odznaczyć opcję 

Drukuj stempel włączony. 
 

Aby określić nagłówek i stopkę dla wszystkich rysunków 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 Kliknij Ustawienia stempla druku. 

3 Wpisz zawartość nagłówka i stopki lub wybierz opcjonalne pole 

automatyczne z list. 

Aby wyrównać tekst do lewej, środka lub prawej strony w nagłówku lub stopce, 

oddziel tekst przecinkami. 

4 Kliknij przycisk Zaawansowane. 

5 Dostosuj ustawienia dla dowolnej z poniższych opcji: 

• Orientacja Wybierz Pozioma, aby umieścić nagłówek i stopkę na górze i na 

dole rysunku. Wybierz opcję Pionowo, aby obrócić nagłówek i stopkę o 90 

stopni po lewej i prawej stronie rysunku. 

• X Offset Wprowadź odległość przesunięcia nagłówka i stopki od krawędzi 

obszaru wydruku w kierunku x. 

• Y Offset Wprowadź odległość przesunięcia nagłówka i stopki od krawędzi 

obszaru wydruku w kierunku y. 

• Offset Relative To Wybierz, czy przesunięcie ma być mierzone od 

krawędzi papieru, czy od obszaru drukowania. 

• Czcionka Wybierz czcionkę dla tekstu nagłówka i stopki. 

• Wysokość Wybierz wysokość tekstu nagłówka i stopki. 

• Jednostki Wybierz cale lub milimetry jako jednostkę miary dla przesunięcia 

X, przesunięcia Y i wysokości stempla drukującego. 

• Add Print Event into Log File (Dodaj zdarzenie drukowania do pliku 

dziennika) Wybierz, aby dołączyć informacje o znaczniku drukowania do 

pliku dziennika drukowania. 

6 Kliknij przycisk OK. 

7 Po zakończeniu kliknij przycisk OK. 
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Konfigurowanie plików konfiguracyjnych drukarki 
Pliki konfiguracji drukarki (pliki PC3) przechowują informacje o drukarce 

używane dla określonych rysunków lub układów. Pliki PC3 można dodawać, 

modyfikować i usuwać. 

Więcej informacji na temat plików konfiguracyjnych drukarki można znaleźć w 

sekcji "Dostosowywanie i ponowne wykorzystywanie ustawień drukowania" na 

stronie 530. 
 

Aby skonfigurować pliki konfiguracyjne drukarki 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje, a następnie kliknij kartę 

Drukowanie lub wybierz Plik > Opcje drukarki. 

• Wpisz config, naciśnij Enter, a następnie kliknij kartę Drukowanie. 

2 Kliknij Dodaj lub Konfiguruj drukarki. 

3 Aby utworzyć nowy plik PC3, wykonaj następujące czynności: 

• Kliknij przycisk Dodaj. 

• W oknie dialogowym Dodaj plik konfiguracji drukarki wybierz żądaną 

drukarkę dla nowego pliku PC3. 

• Kliknij przycisk Kontynuuj. 

• Wybierz żądane opcje dla pliku PC3. Jeśli nie wybierzesz żadnych 

niestandardowych opcji, plik PC3 nie zostanie utworzony. 

• Kliknij przycisk OK. 

4 Aby zmodyfikować plik PC3, wykonaj następujące czynności: 

• Wybierz żądany plik z listy. 

• Kliknij przycisk Modyfikuj. 

• Wybierz żądane opcje dla pliku PC3. 

• Kliknij przycisk OK. 

5 Aby usunąć plik PC3, wybierz żądany plik z listy i kliknij przycisk Usuń. 

6 Kliknij przycisk OK. 

7 Po zakończeniu kliknij przycisk OK. 
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Zmiana opcji na karcie Przyciąganie 

W oknie dialogowym Opcje, na karcie Przyciąganie, można kontrolować sposób 

działania przyciągania encji, w tym przyciągania przelotowego. Przyciąganie 

przelotowe to pomoc wizualna, która pomaga zobaczyć i efektywniej 

wykorzystywać przyciąganie encji. 

Aby zmienić opcje na karcie Przyciąganie 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Przyciąganie. 

3 Wybierz żądane opcje. 

4 Po zakończeniu kliknij przycisk OK. 
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A Wybierz, aby wyświetlić dodatkową ikonę na 
kursorze w celu wskazania, które przyciąganie 
jednostki jest aktywne. (Dostępne nawet jeśli 
przyciąganie przelotowe jest wyłączone). 

B Wybierz, aby włączyć przyciąganie do 
przelotu. 

C Wybierz, aby włączyć podpowiedzi 
narzędzia, które wskazują typ przyciągania 
użyty do wybrania zaznaczonej lokalizacji. 

D Wybierz, aby włączyć pole przysłony 
migawki. 
Jednostki znajdujące się w polu przysłony są 
dostępne do wyboru, co ułatwia znajdowanie 
i wybieranie punktów przyciągania jednostek. 

E Wpisz lub przewiń do rozmiaru tolerancji 
dla pola przysłony. Wyższe liczby 
zwiększają odległość od kursora, w której 
znajdowane są jednostki. 

F Kliknij, aby włączyć przyciąganie jednostek 
do włazów. 

G Kliknij, aby włączyć przyciąganie jednostek 
do jednostek o ujemnej wartości z podczas 
korzystania z dynamicznego UCS. 

H Wybierz, czy pliki dołączone do rysunków 
jako podkłady nie są przyciągane, 
przyciąganie jest włączone dla wszystkich 
podkładów lub przyciąganie jest włączone, 
ale różni się w zależności od typu pliku. 

I Kliknij, aby włączyć przyciąganie encji do 
plików .pdf, które są dołączone do rysunków. 
(Dostępne tylko wtedy, gdy przyciąganie do 
podkładów jest włączone na VARY). 

J Kliknij, aby włączyć przyciąganie encji do 
plików .dwf, które są dołączone do 
rysunków. (Dostępne tylko wtedy, gdy 
przyciąganie do podkładów jest włączone na 
VARY). 

K Kliknij, aby włączyć przyciąganie encji do 
plików .dgn dołączonych do rysunków. 
(Dostępne tylko wtedy, gdy przyciąganie do 
podkładów jest włączone na VARY). 

L Kliknij, aby włączyć przyciąganie encji do 
plików .ifc, które są dołączone do rysunków. 
(Dostępne tylko wtedy, gdy przyciąganie do 
podkładów jest włączone na VARY). 

M Kliknij, aby włączyć przyciąganie encji do 
plików .rvt i .rfa, które są dołączone do 
rysunków.(Dostępne tylko wtedy, gdy 
opcja przyciągania do elementów jest 
ustawiona na RÓŻNE). 

N Włącza przyciąganie jednostek do linii rozszerzeń 
wymiarów. 

O Wpisz lub przewiń do grubości 
znacznika zatrzasku przelotu. 

P Wpisz lub przewiń do rozmiaru 
znacznika przyciągania. 

Q Kliknij, aby wybrać kolor znacznika 
najazdu. 

R Wybierz, aby włączyć wyświetlanie 
znaczników przyciągania w locie we 
wszystkich widokach, gdy używasz więcej 
niż jednej rzutni. 

S Wybierz, aby włączyć znaczniki 
przyciągania, które oznaczają punkty 



przyciągania na jednostkach. 
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Zmiana opcji na karcie Schowek 

Możesz kontrolować, jakie formaty są obsługiwane podczas kopiowania zawartości 

do schowka z ALCAD. 

Kopiowanie wszystkich obsługiwanych formatów do schowka wpływa na 

wydajność - najlepiej wybrać tylko niezbędne formaty. 
 

Aby zmienić opcje na karcie Schowek 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Schowek. 

3 Wybierz żądane opcje. 

4 Po zakończeniu kliknij przycisk OK. 

 

 

 

 

 

 

 
A 

 
 
 

 
B 

 

 
C 

 
 
 
 
 
 
 

 
A Wybierz wersję formatu DWG, którą chcesz 

skopiować do schowka. 

B Wybierz opcję automatycznego 
kopiowania formatów zainstalowanych 
wersji. 

 
C Wybierz, aby skopiować formaty EMF, BMP, 

obiekt osadzony i obiekt połączony do 
schowka. 
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Zmiana opcji na karcie Selection Cycling (Kolarstwo wyboru) 

Zaznaczanie cykliczne umożliwia przechodzenie przez nakładające się jednostki 

pod kursorem. Karta Cykl zaznaczania pozwala określić sposób działania cyklu 

zaznaczania. 
 

Aby zmienić opcje na karcie Selection Cycling 

1 Wykonaj jedną z poniższych czynności, aby wybrać Opcje (  ): 

• Na wstążce wybierz przycisk Aplikacja, a następnie wybierz Opcje lub 

wybierz Narzędzia > Opcje (w Zarządzaniu). 

• W menu wybierz Narzędzia > Opcje. 

• Wpisz config i naciśnij Enter. 

2 Kliknij kartę Selection Cycling. 

3 Wybierz żądane opcje. 

4 Po zakończeniu kliknij przycisk OK. 

 

 

 

 

 
 

A 

 
 
 

B 

C 

D 

 
 
 
 
 
 
 
 
 
 

 

A Wybierz, aby przełączać się między 
nakładającymi się jednostkami, naciskając 
klawisz Ctrl z kliknięciem myszą, wielokrotnym 
kliknięciem myszą lub naciskając klawisze 
Shift + Spacja. 

B Wybierz, aby włączyć pomoce wizualne 
podczas wybierania jednostek, które się 
nakładają. 

C Wybierz opcję wyświetlania ikony przy 
kursorze po najechaniu kursorem na 
nakładające się jednostki. 

D Wybierz, aby wyświetlić listęSelection 
Cyclinglist po wybraniu nakładających się 
jednostek. 



 

Dostosowywanie palet 
narzędzi 
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Palety narzędzi zawierają polecenia i bloki, które są zorganizowane tak, aby były 

dostępne podczas pracy z rysunkami. Każdą paletę narzędzi można dostosować do 

własnych potrzeb: dodawać nowe palety, usuwać istniejące palety i zmieniać 

kolejność ich wyświetlania w panelu. Można również kontrolować przezroczystość 

stosowaną do wyświetlania dowolnej palety, co jest przydatne, jeśli chcesz 

zobaczyć części rysunku, które w przeciwnym razie byłyby ukryte przez 

nieprzezroczyste palety narzędzi. 

Szczegółowe informacje na temat wyświetlania i pozycjonowania palet narzędzi 

można znaleźć w sekcji "Wyświetlanie i ukrywanie panelu Palety narzędzi" na 

stronie 23. 

 

Tworzenie palet narzędzi oraz dodawanie poleceń i bloków 

Każda utworzona paleta narzędzi może zawierać dowolną kombinację narzędzi, 

które uruchamiają polecenie lub wstawiają blok. 
 

Aby utworzyć nową paletę narzędzi 

1 Kliknij prawym przyciskiem myszy nazwę istniejącej palety narzędzi. 

2 Wybierz opcję Nowa paleta. 

3 Wpisz nazwę nowej palety, a następnie naciśnij klawisz Enter. 
 

Aby dodać polecenie do palety narzędzi 

1 Na palecie narzędzi kliknij prawym przyciskiem myszy istniejące narzędzie poleceń i 

wybierz polecenie Kopiuj. 

2 Kliknij prawym przyciskiem myszy obszar narzędzi wybranej palety i wybierz polecenie 

Wklej. 

3 Kliknij prawym przyciskiem myszy wklejone polecenie i wybierz Właściwości, aby zmienić 

jego ustawienia: 

• Nazwa Wprowadź nazwę polecenia. Nazwa ta jest wyświetlana na palecie narzędzi. 

• Opis Wpisz jednozdaniowy opis narzędzia. 

• Command Name Wprowadź polecenie wykonywane po wybraniu narzędzia, 

które może zawierać makro (jedno lub więcej poleceń i ich opcji), np: 

^C^C^CZOOM;E;MSNAPSHOT 

• Ogólne Wybierz kolor, warstwę, rodzaj linii, skalę rodzaju linii, grubość 

linii, styl tekstu i styl wymiaru, które zostaną zastosowane podczas 

korzystania z polecenia. Wybierz opcję Użyj bieżącego, aby użyć bieżącej 

właściwości. 

4 Kliknij przycisk OK. 
 

Polecenia można również dodać później. 

Kliknij prawym przyciskiem myszy paletę narzędzi i wybierz polecenie Dostosuj 

polecenia. Następnie przeciągnij i upuść polecenia z listy poleceń na paletę 

narzędzi. 
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Aby dodać blok do palety narzędzi 

1 Otwórz rysunek zawierający bloki lub w razie potrzeby utwórz i wstaw blok. 

Szczegółowe informacje zawiera sekcja "Praca z blokami" na stronie 468. 

2 Zapisz rysunek. Szczegółowe informacje zawiera sekcja "Zapisywanie rysunku" na stronie 

99. 

3 Zaznacz blok na rysunku i przeciągnij go do wybranej palety narzędzi. 

 
Modyfikowanie palet narzędzi 

Panel Palety narzędzi może zawierać wiele palet. Można zmieniać nazwy, kolejność 

i usuwać palety narzędzi, a także zmieniać przezroczystość ich wyświetlania. 
 

Aby zmienić nazwę palety narzędzi 

1 Kliknij prawym przyciskiem myszy nazwę palety narzędzi, której nazwę chcesz zmienić. 

2 Wybierz opcję Zmień nazwę palety. 

3 Wpisz nową nazwę, a następnie naciśnij klawisz Enter. 
 

Aby zmienić kolejność wyświetlania palet narzędzi 

1 Kliknij prawym przyciskiem myszy nazwę palety narzędzi. 

2 Wybierz opcję Przenieś w górę lub Przenieś w dół. 
 

Aby usunąć paletę narzędzi 

1 Kliknij prawym przyciskiem myszy nazwę palety narzędzi, którą chcesz usunąć. 

2 Wybierz opcję Usuń paletę. 

3 Kliknij Tak, aby potwierdzić usunięcie lub Nie, aby anulować. 
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Aby zmienić przezroczystość palet narzędzi 

1 Kliknij prawym przyciskiem myszy pasek tytułu panelu palety narzędzi. 

2 Wybierz opcję Przejrzystość. 

3 Wybierz żądane opcje: 

• Ogólne Przesuń suwak, aby określić przezroczystość paneli wyświetlanych 

w programie. Im niższa wartość, tym bardziej przezroczysty jest panel. 

• Rollover Przesuń suwak, aby określić przezroczystość, z jaką wyświetlane są 

panele po najechaniu na nie myszą. Im niższa liczba, tym bardziej 

przezroczysty jest panel. Przezroczystość dla najechania myszą nie może być 

mniejsza niż przezroczystość ogólna. 

• Podgląd Kliknij, aby wyświetlić podgląd przezroczystości rolki myszy w 

programie. Może być konieczne przesunięcie okna dialogowego 

Przezroczystość, aby wyświetlić okienko. 

• Zastosuj ustawienia do wszystkich paneli Zaznacz to pole wyboru, aby 

zastosować wybrane opcje przezroczystości do wyświetlania wszystkich 

paneli w programie, w tym paneli niestandardowych. 

• Wyłącz przezroczystość dla wszystkich palet Zaznacz to pole wyboru, 

aby wyłączyć opcje przezroczystości dla wszystkich paneli w programie, 

w tym paneli niestandardowych. 

4 Kliknij przycisk OK. 

 
Modyfikowanie narzędzi na palecie narzędzi 

Poszczególne narzędzia na palecie narzędzi można modyfikować na kilka sposobów: 

zmieniać kolejność wyświetlania narzędzi, zmieniać obraz wyświetlany dla 

dowolnego narzędzia, a także ustawienia, takie jak nazwa, komenda lub blok, który 

jest przypisany, i inne. Można także usuwać narzędzia z dowolnej palety. 
 

Aby zmienić nazwę narzędzia 

1 Kliknij prawym przyciskiem myszy narzędzie, którego nazwę chcesz zmienić, a następnie 

wybierz opcję Zmień nazwę. 

2 Wpisz nową nazwę, a następnie naciśnij klawisz Enter. 
 

Aby zmienić kolejność narzędzi na palecie narzędzi 

1 Kliknij i przeciągnij narzędzie, aby przesunąć je w górę lub w dół. 
 

Aby dodać nowe narzędzie do palety narzędzi 

1 Wykonaj jedną z poniższych czynności: 

• Kliknij prawym przyciskiem myszy paletę narzędzi, a następnie wybierz polecenie 

Dostosuj polecenia. 

• Wpisz quickcui, a następnie naciśnij Enter. 

2 Z listy poleceń przeciągnij i upuść polecenie na paletę narzędzi. 

3 Po zakończeniu kliknij przycisk OK. 
 

Aby usunąć narzędzie z palety narzędzi 

1 Kliknij prawym przyciskiem myszy narzędzie, które chcesz usunąć, a następnie wybierz 

polecenie Usuń. 
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Aby określić obraz do wyświetlenia dla narzędzia 

1 Kliknij narzędzie prawym przyciskiem myszy, a następnie wybierz opcję Obraz. 

2 Wybierz obraz, który ma być wyświetlany na palecie narzędzi dla danego narzędzia. 

3 Wykonaj jedną z poniższych czynności: 

• Wybierz żądany obraz. 

• Kliknij przycisk Przeglądaj, aby załadować plik zasobów zewnętrznych .dll 

zawierający zasoby bitmapowe, plik .bmp lub .png. Załadowane obrazy 

muszą mieć rozmiar 32x32 piksele. 

4 Po zakończeniu kliknij przycisk OK. 
 

Aby zmienić ustawienia narzędzia na palecie narzędzi 

1 Kliknij narzędzie prawym przyciskiem myszy i wybierz opcję Właściwości. 

2 Dostosuj nazwę i opis narzędzia: 

• Nazwa Wprowadź nazwę narzędzia. Nazwa ta będzie wyświetlana na palecie narzędzi. 

• Opis Wpisz jednozdaniowy opis narzędzia. 

3 Jeśli narzędzie jest poleceniem, można dostosować te opcje: 

• Command Name Wprowadź polecenie wykonywane po wybraniu narzędzia, 

które może zawierać makro (jedno lub więcej poleceń i ich opcji), np: 

^C^C^CZOOM;E;MSNAPSHOT 

• Ogólne Wybierz kolor, warstwę, rodzaj linii, skalę rodzaju linii, grubość 

linii, styl tekstu i styl wymiaru, które zostaną zastosowane podczas 

korzystania z polecenia. Wybierz opcję Użyj bieżącego, aby użyć bieżącej 

właściwości. 

Jeśli narzędzie jest blokiem, można dostosować te opcje: 

• Nazwa Wprowadź nazwę bloku do wstawienia podczas korzystania z tego narzędzia. 

• Plik źródłowy Wprowadź nazwę i ścieżkę rysunku zawierającego blok 

źródłowy. 

• Skala Wprowadź skalę x, y i z bloku. 

• Obrót Wprowadź obrót bloku. 

• Prompt Rotation Wybierz Yes (Tak), aby wyświetlić monit o wartość 

obrotu bloku podczas wstawiania bloku za pomocą tego narzędzia, lub 

wybierz No (Nie). 

• Rozbij Wybierz Tak, aby umożliwić rozbijanie bloków wstawionych za 

pomocą tego narzędzia, lub wybierz Nie. 

• Ogólne Wybierz kolor, warstwę, rodzaj linii, skalę rodzaju linii, grubość 

linii, styl tekstu i styl wymiaru do zastosowania podczas wstawiania bloku. 

Wybierz opcję Użyj bieżącego, aby użyć bieżącej właściwości. 

4 Kliknij przycisk OK. 
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Praca z grupami palet narzędzi 

W panelu Palety narzędzi wyświetlana jest jednocześnie jedna grupa palet. Jeśli nie 

zostaną utworzone grupy palet, w panelu będą wyświetlane wszystkie palety. Jeśli 

palety zostaną podzielone na grupy, można łatwo przełączać palety wyświetlane w 

panelu Palety narzędzi - wystarczy ustawić grupę jako bieżącą, aby wyświetlić jej 

palety w panelu Palety narzędzi. 

Palety można organizować w grupy, co pozwala na szybkie przełączanie się 

między grupami palet. 

 

Praca z plikami palet narzędzi 

Palety narzędzi mogą być wymieniane między komputerami Palety narzędzi mogą 

być importowane i eksportowane jako pliki .xtp. Grupy palet narzędzi mogą być 

importowane i eksportowane jako pliki .xpg. 
 

Aby wyeksportować paletę narzędzi do pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj: 

• Wpisz customize, a następnie naciśnij Enter. 

• Kliknij prawym przyciskiem myszy w dowolnym miejscu palety narzędzi i wybierz opcję 

Dostosuj palety. 

2 Kliknij prawym przyciskiem myszy paletę, którą chcesz zapisać. 

3 Wybierz opcję Eksportuj. 

4 Wprowadź nazwę pliku palety narzędzi (plik .xtp), a następnie kliknij przycisk Zapisz. 
 

Aby wyeksportować wszystkie palety narzędzi do pliku 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj: 

• Wpisz customize, a następnie naciśnij Enter. 

• Kliknij prawym przyciskiem myszy w dowolnym miejscu palety narzędzi i wybierz opcję 

Dostosuj palety. 

2 Kliknij prawym przyciskiem myszy grupę palet. 

3 Wybierz opcję Eksportuj wszystko. 

4 Wprowadź nazwę pliku grupy palet narzędzi (plik .xpg), a następnie kliknij przycisk Zapisz. 
 

Aby zaimportować plik palety narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj: 

• Wpisz customize, a następnie naciśnij Enter. 

• Kliknij prawym przyciskiem myszy w dowolnym miejscu palety narzędzi i wybierz opcję 

Dostosuj palety. 

2 Kliknij prawym przyciskiem myszy paletę lub grupę palet. 

3 Wybierz opcję Importuj. 

4 Wybierz plik palety narzędzi (plik .xtp) lub plik grupy palet narzędzi (plik 

.xpg) do wczytania, a następnie kliknij przycisk Otwórz. 
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Dostosowywanie menu 
 

Można dostosować bieżące menu i zapisać zmiany w pliku. Pliki menu można 

również wczytać. Wczytywane formaty plików menu mogą być dowolne z 

poniższych: ALCAD (pliki *.icm), Customizations (pliki *.cui) i AutoCAD (pliki 

*.mnu, *.mns). 

 

Zrozumienie kompatybilności menu 

Pliki menu w formacie CUI są tworzone przez nowsze wersje programu AutoCAD. 

Pliki w formacie MNU to pliki menu utworzone przez wszystkie wersje programu 

AutoCAD, a pliki w formacie MNS są zawarte w wersjach 13, 14 i 2000 programu 

AutoCAD. ALCAD odczytuje wszystkie formaty plików, nawet jeśli makra menu 

zawierają kod AutoLISP. Funkcja ta pozwala na dalsze korzystanie z istniejących 

menu AutoCAD. 

ALCAD obsługuje wszystkie sekcje plików w formacie CUI wymagane do 

dostosowania. Kompatybilność plików w formatach MNU i MNS znajduje się 

w poniższej tabeli. 

Obsługa przez ALCAD określonych sekcji w plikach formatu AutoCAD MNU i MNS 
 

Sekcja menu Definicja Obsługa ALCAD 

***POP0 Menu kursora Obsługiwane 

***POPn Menu rozwijane Obsługiwane 

***AUXn Menu pomocnicze Nieobsługiwane 

***BUTTONn Menu przycisków Obsługiwane 

***ICON Menu ikon Nieobsługiwane 

***SCREEN Menu ekranowe Nieobsługiwane 

***TABLETn Menu tabletu Obsługiwane 

 
Aby zobaczyć, jak ALCAD odczytuje pliki źródłowe menu AutoCAD 

1 Wpisz menu i naciśnij Enter. 

2 W sekcji Pliki typu wybierz Plik menu AutoCAD (mnu). 

3 W oknie dialogowym Otwórz menu przejdź do folderu AutoCAD Support i 

wybierz plik Acad.mnu (lub Acad.mns dla wersji 13, 14 i 2000). 

4 Aby załadować plik menu AutoCAD do ALCAD, kliknij Otwórz. 

Pasek menu ALCAD wygląda teraz identycznie jak pasek menu AutoCAD. 

5 Aby zobaczyć, jak to działa, wybierz kilka poleceń z paska menu, takich jak 

Plik > Otwórz lub Rysuj > Linia. 

6 Aby przywrócić ALCAD do domyślnego interfejsu użytkownika, wybierz 

Narzędzia > Opcje, kliknij zakładkę Profile, a następnie kliknij Resetuj. 
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Tworzenie nowych menu i dodawanie poleceń 

Nowe menu można utworzyć, wstawiając pozycję menu na najwyższym poziomie 

listy menu. Następnie można dodać polecenia do nowej pozycji menu. Można także 

dodawać podmenu i modyfikować istniejące nazwy menu i polecenia, dodając je, 

usuwając i zmieniając ich kolejność. 

 

Kolory punktorów wskazują, czy polecenie jest dostępne na bieżącym poziomie 

doświadczenia. Zielony punktor przed pozycją menu lub poleceniem oznacza, że dana 

pozycja menu lub polecenie są dostępne; czerwony punktor przed pozycją menu lub 

poleceniem oznacza, że dana pozycja menu lub polecenie nie są dostępne na 

ustawionym poziomie doświadczenia. Aby zmienić poziom doświadczenia dla 

elementu, użyj właściwości Widoczność w obszarze Właściwości. Aby zmienić poziom 

doświadczenia dla interfejsu użytkownika, wybierz opcję 

Narzędzia > Opcje, a następnie zakładka Ogólne. 
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A Kliknij, aby wyświetlić lub ukryć obszar personalizacji. 

B Wybór menu, podmenu lub polecenia menu. 

C Kliknij, aby wyświetlić lub ukryć obszar listy 

poleceń. D Kliknij, aby wyszukać wpisaną 

nazwę polecenia. E Wpisz nazwę polecenia 

do wyszukania. 

F Wybierz polecenie z listy. Przeciągnij i upuść na listę w 
Customization lub zmień obrazy przycisków wButtonImage i 
właściwości w Properties. 

G Wyświetla właściwości przypisane do wybranej pozycji 
menu w Customization dla wybranego polecenia i listy 
poleceń. Wprowadź nową wartość lub kliknij[...], aby wybrać 
więcej opcji dla danej właściwości. 

H Kliknij, aby wyświetlić lub ukryć obszar Właściwości. 

I Kliknij, aby wybrać plik obrazu lub .dll, który zawiera obraz do 
przypisania do aktualnie wybranego przycisku. Jeśli załadujesz 
plik obrazu lub plik .dll, możesz kliknąć Default, aby zresetować 
obrazy wyświetlane w Bitmap Images do obrazów 
zainstalowanych w ALCAD. 

J Wybierz czarno-biały lub kolorowy obraz przycisku dla 
wybranego małego lub dużego przycisku. 

K Wyświetla pełną ścieżkę i nazwę pliku .dll, .bmp lub .png, który 
został załadowany po kliknięciu przycisku Przeglądaj. 

L Kliknij, aby wyświetlić lub ukryć obszar obrazu przycisku. 

M Wybierz przycisk, który chcesz dostosować. 
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Aby utworzyć nowe menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń menu na liście. Menu wyświetlane na 

pasku menu w interfejsie użytkownika są wyświetlane na liście ze znakiem 

plus (+) obok każdej nazwy. 

4 Kliknij prawym przyciskiem myszy nazwę menu znajdującą się poniżej lokalizacji nowego 

menu. 

5 Wybierz opcję Wstaw element menu. 

6 Wpisz nazwę nowego menu rozwijanego, a następnie naciśnij klawisz Enter. 

7 Dodaj polecenie do menu (patrz obok). Aby wyświetlić nowe menu, należy 

dodać do niego polecenie. 

8 Kliknij przycisk OK. 
 

Aby dodać polecenie i dostosować menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń menu na liście. 

4 Rozwiń nazwę menu, aby wyświetlić podpozycje menu i polecenia wyświetlane 

w każdym menu. 

5 Z listy poleceń przeciągnij polecenie do miejsca, w którym chcesz je 

umieścić na liście dostosowywania. 

6 Aby dodatkowo dostosować menu, kliknij prawym przyciskiem myszy pozycję 

znajdującą się poniżej miejsca, w którym chcesz dodać nową pozycję, i wybierz 

jedną z poniższych opcji: 

• Wstaw pozycję menu Wstawia polecenie nad zaznaczeniem. Wprowadź 

nazwę, która ma być wyświetlana w menu w interfejsach użytkownika, a 

następnie naciśnij klawisz Enter. We Właściwościach wprowadź nazwę 

polecenia dla pozycji menu w polu Nazwa polecenia. 

• Wstaw podpozycję menu Wstawia podmenu nad zaznaczeniem. Wprowadź 

nazwę podmenu, która ma być wyświetlana w interfejsie użytkownika, a 

następnie naciśnij klawisz Enter. 
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• Insert Spacer Wstawia linię nad zaznaczeniem, która wizualnie oddziela 

grupy poleceń w menu. 

• Wstaw menu kontekstowe Wstawia menu, które pojawia się po kliknięciu 

prawym przyciskiem myszy w interfejsie użytkownika. 

• Insert Context Menu Sub-Item Wstawia podmenu do wybranego menu 

kontekstowego. Wprowadź nazwę podmenu, która ma być wyświetlana w 

interfejsie użytkownika, a następnie naciśnij klawisz Enter. 

7 Kliknij OK. 

 
Ustawianie niestandardowych obrazów dla poleceń w menu 

Można dostosować obraz wyświetlany dla każdego polecenia w menu. 

Ponieważ menu można skonfigurować tak, aby wyświetlało duże lub małe obrazy 

oraz wyświetlało je w kolorze lub monochromatycznie, należy utworzyć cztery różne 

obrazy dla każdego menu. Utwórz niestandardowe obrazy przy użyciu 

następujących wymiarów: 

• Małe obrazy: 16 x 16 pikseli. 

• Duże obrazy: 32 x 32 piksele. 

Aby uzyskać najlepsze wyniki, obrazy powinny być w 32-bitowym formacie 

ARGB z przezroczystym tłem alfa. 

 

Obrazy, które nie pasują do tych wymiarów, są rozciągane lub zmniejszane przez 

program w celu dopasowania do określonego rozmiaru. 

Wynikowe obrazy mogą nie wyglądać tak, jak pierwotnie zamierzano. 
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Aby dostosować obrazy dla poleceń w menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń menu na liście. 

4 Rozwiń nazwę menu, aby wyświetlić podpozycje menu i polecenia wyświetlane 

w każdym menu, a następnie wybierz polecenie. 

5 W obszarze Button Image, w Button Bitmaps, kliknij obraz przycisku, który 

chcesz zmienić: Mały kolor, Duży kolor, Mały czarno-biały, Duży czarno-biały. 

6 Wykonaj jedną z poniższych czynności: 

• W obszarze Obrazy bitmapowe wybierz żądany obraz z listy dostępnych obrazów. 

• Kliknij przycisk Przeglądaj, aby załadować plik zasobów zewnętrznych .dll 

zawierający zasoby bitmapowe, plik .bmp lub .png. Załadowane obrazy 

muszą mieć rozmiar 16x16 pikseli dla małych ikon i 32x32 pikseli dla dużych 

ikon. 

7 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie właściwości pozycji menu 

Można określić właściwości każdej pozycji w menu, w tym nazwę wyświetlaną w 

menu, widoczność i inne. 
 

Aby dostosować właściwości pozycji menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń menu na liście. 

4 Rozwiń nazwę menu, aby wyświetlić podpozycje menu i polecenia wyświetlane 

w każdym menu, a następnie wybierz pozycję menu. 
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Właściwości dostępne do dostosowania różnią się w zależności od wybranej pozycji 

menu. Obszar Właściwości okna dialogowego Dostosuj interfejs użytkownika 

wyświetla tylko te właściwości, które są odpowiednie dla wybranej pozycji menu. 

Na przykład ustawienia widoczności są dostępne dla poleceń, a nie nazw menu. 
 

5 W polu Nazwa wprowadź nazwę, która ma być wyświetlana w interfejsie użytkownika. 

Klucz dostępu można określić, dodając znak ampersand (&) bezpośrednio przed 

literą, która ma zostać użyta jako klucz dostępu. Należy pamiętać, aby nie 

przypisywać tego samego klawisza dostępu do więcej niż jednego menu lub polecenia 

w menu. Na przykład, jeśli do menu Wstaw zostanie dodane polecenie o nazwie 

Szybka linia, umieszczenie znaku ampersand bezpośrednio przed literą Q 

spowoduje podkreślenie tej litery w menu. Następnie można wybrać to polecenie, 

wyświetlając menu i naciskając klawisze Alt+Q. 

6 W polu Command Name wprowadź nazwę polecenia, które ma zostać 

wykonane po wybraniu pozycji menu w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

7 W polu Opis wpisz jednozdaniowy opis pozycji. Ciąg ten jest wyświetlany w 

wierszu stanu pozycji menu. 

8 W obszarze Widoczność kliknij przycisk [...], aby dokonać wyboru pozycji menu: 

• Poziom doświadczenia Wybierz poziom użytkownika, dla którego element 

będzie widoczny: Początkujący, Średniozaawansowany lub Zaawansowany. 

Elementy pojawiają się tylko na określonym poziomie doświadczenia. Na 

przykład, jeśli wybierzesz Zaawansowany, element nie pojawi się, jeśli użytkownik 

wybierze poziom Początkujący lub Średniozaawansowany za pomocą 

polecenia Narzędzia > Opcje; ale jeśli wybierzesz Średniozaawansowany bez 

wybierania Zaawansowanego, element pojawi się tylko wtedy, gdy ustawisz 

poziom doświadczenia na Średniozaawansowany. Wybranie wszystkich 

trzech opcji powoduje wyświetlanie elementu na wszystkich poziomach 

użytkownika. 

• Okno MDI Wybierz liczbę okien rysowania, które muszą być otwarte, aby ten 

element był wyświetlany. Jeśli element ma być wyświetlany tylko wtedy, gdy 

otwarte jest co najmniej jedno okno, wybierz opcję Co najmniej jedno otwarte. 

Jeśli element ma być wyświetlany, gdy żadne okno nie jest otwarte, wybierz 

opcję Brak otwartych okien. Zaznaczenie obu opcji oznacza, że element 

będzie wyświetlany zawsze. 
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• ActiveX In-Place Activation Wybierz typ edycji ActiveX, z którą element ma 

być wyświetlany. Jeśli element ma być wyświetlany podczas edycji na 

wbudowanym serwerze, wybierz opcję Server, Embedded. Jeśli element ma 

być wyświetlany podczas edycji w miejscu na serwerze, wybierz opcję Serwer, W 

miejscu. Jeśli element wstążki ma być wyświetlany podczas edycji kontenera, 

wybierz opcję Kontener. 

• Wyłącznie menu kontekstowe Wybierz, aby element menu był 

wyświetlany tylko w menu kontekstowym. 

• Tymczasowe wyskakujące okienko Wybierz, aby udostępnić element w 

tymczasowym wyskakującym okienku, jeśli użytkownik naciśnie klawisz 

SHIFT i jednocześnie kliknie prawym przyciskiem myszy, gdy polecenie jest 

aktywne. (Dostępne tylko dla pozycji menu). 

• Ukryj Wybierz, aby ukryć element. 

9 W obszarze Zawartość jednostek kliknij przycisk [ ], aby określić, czy pozycja menu ma 

być wyświetlana w polu 

menu kontekstowego jednostki. Wybierz jedną z następujących opcji: 

• Menu kontekstowe można dostosowywać dla poszczególnych jednostek, 

zaznaczając je lub odznaczając. Zaznaczenie pola obok jednostki powoduje, 

że wybrana pozycja menu pojawia się w menu kontekstowym dla tej 

konkretnej jednostki. 

• Jeśli nie chcesz, aby pozycja menu pojawiała się w menu kontekstowym, gdy 

wybrana jest tylko jedna jednostka, wybierz opcję Exclude if Single Entity is 

Selected. 

• Jeśli nie chcesz, aby pozycja menu pojawiała się w menu kontekstowym, gdy 

zaznaczona jest więcej niż jedna jednostka, wybierz opcję Wyklucz, jeśli 

zaznaczono wiele jednostek. 

10 Jeśli widoczność pozycji menu może być kontrolowana przez zmienną 

systemową, należy określić jedną z poniższych opcji: 

• Zmienna stanu wyszarzonego Wprowadź nazwę i wartość zmiennej 

systemowej, która kontroluje, czy to polecenie jest wyświetlane w interfejsie 

użytkownika jako wyszarzone. Gdy określona zmienna systemowa jest 

wyłączona, przycisk jest wyszarzony lub wyświetlany jako wyłączony. Na 

przykład wyszarzona zmienna stanu polecenia Powiększ to VIEWMODE = 

1 (widok perspektywiczny = włączony). 

• Checked-State Variable Wprowadź nazwę i wartość zmiennej systemowej, 

która kontroluje, czy to polecenie jest wyświetlane w interfejsie użytkownika 

jako wciśnięte. Gdy określona zmienna systemowa jest włączona, przycisk 

polecenia jest wyświetlany jako wciśnięty. Na przykład zmienną stanu 

wciśnięcia polecenia Set Center Snap jest OSMODE = 4 (center snap = on). 

• Hidden-State Variable Wprowadź nazwę zmiennej systemowej, która 

kontroluje, czy to polecenie jest ukryte w interfejsie użytkownika. Gdy 

określona zmienna systemowa jest włączona, element jest ukryty. Na 

przykład niektóre polecenia wymagające dodatkowej licencji mają zmienną 

stanu ukrytego. 

Wprowadź nazwę zmiennej systemowej, znak ampersand, a następnie wartość, 

bez spacji. Na przykład: "OSMODE&4". 



11 Po zakończeniu kliknij przycisk OK. 
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Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Zmiana nazwy pozycji menu 

Aby zmienić nazwę pozycji menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy pozycję menu, której nazwę 

chcesz zmienić. 

4 Wybierz Zmień nazwę. 

5 Wpisz nową nazwę pozycji menu, wpisując ją nad podświetloną nazwą, a 

następnie naciśnij klawisz Enter. 

6 Kliknij przycisk OK. 

 
Kopiowanie i wklejanie elementów menu 

Aby skopiować i wkleić pozycję menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Customization kliknij prawym przyciskiem myszy pozycję menu, którą chcesz 

skopiować. 

4 Wybierz Kopiuj. 

5 Kliknij prawym przyciskiem myszy pozycję menu znajdującą się powyżej 

miejsca, w którym chcesz umieścić kopię, a następnie kliknij Wklej. 

6 Kliknij przycisk OK. 
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Usuwanie pozycji menu 

Aby usunąć pozycję menu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Customization kliknij prawym przyciskiem myszy pozycję menu, którą chcesz 

usunąć. 

4 Wybierz Usuń. 

5 W oknie dialogowym potwierdzenia kliknij przycisk Tak, aby usunąć pozycję menu. 

6 Kliknij przycisk OK. 

 

Niektóre pozycje menu mają pod sobą pozycje podrzędne. 

Usunięcie pozycji menu, która ma pod sobą pozycje podrzędne w drzewie menu, 

powoduje również usunięcie wszystkich tych pozycji podrzędnych. 
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Dostosowywanie wstążki 
 

W wersjach ALCAD, które zawierają wstążkę, kilka obszarów zawiera polecenia: 

• Przycisk aplikacji - znajduje się w lewym górnym rogu i zawiera polecenia 

związane z plikami, takie jak Nowy, Otwórz, Importuj, Eksportuj i inne. 

• Pasek narzędzi szybkiego dostępu - znajduje się po prawej stronie przycisku 

aplikacji i zawiera typowe polecenia. 

• Wstążka - znajduje się poniżej przycisku aplikacji i biegnie poziomo w górnej 

części okna rysowania. Główna wstążka składa się z kart, które zawierają 

powiązane polecenia zgrupowane razem, na przykład na kartach o nazwach 

Strona główna, Edytuj, Rysuj itp. Każda karta ma panele, które zawierają 

podkategorie poleceń w ramach karty, na przykład Rysuj, Modyfikuj i Warstwy 

na karcie Narzędzia główne. 

• Kontekstowe stany wstążki - są tymczasowo umieszczane podczas pracy z 

określonymi elementami: tekstem wielowierszowym, obrazami rastrowymi i 

odniesieniami zewnętrznymi. 

Wszystkie te obszary można dostosować, z wyjątkiem kontekstowych stanów 

wstążki, które są wbudowane w ALCAD. 

Ustawienia wstążki są zapisywane automatycznie w pliku .cui. Format CUI jest 

najnowszym formatem interfejsu użytkownika i obsługuje również wszystkie starsze 

elementy interfejsu użytkownika, takie jak menu, paski narzędzi, tablet itp. Format 

CUI jest jedynym formatem menu, który obsługuje interfejs wstążki, więc jeśli 

tworzysz plik menu, który będzie obsługiwał wstążkę, użyj formatu CUI. 

 

Tworzenie i dostosowywanie kart wstążki i paneli podrzędnych 

Nową kartę wstążki można utworzyć, wstawiając kartę na najwyższym poziomie 

listy Wstążka. Następnie można dodać panele lub grupy do nowej karty wstążki i 

dodać polecenia. Można także modyfikować istniejące nazwy i polecenia, dodając 

je, usuwając i zmieniając ich kolejność. 

 

Kolory punktorów wskazują, czy polecenie jest dostępne na bieżącym poziomie 

doświadczenia. Zielony punktor przed elementem wstążki lub poleceniem wskazuje, 

że element jest dostępny; czerwony punktor wskazuje, że element nie jest dostępny do 

użycia na ustawionym poziomie doświadczenia. Aby zmienić poziom doświadczenia 

dla elementu, należy użyć właściwości Widoczność w obszarze Właściwości. Aby 

zmienić poziom doświadczenia dla interfejsu użytkownika, użyj polecenia Opcje w 

menu Narzędzia. 
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A Kliknij, aby wyświetlić lub ukryć obszar personalizacji. 

B Wybierz kartę wstążki, panel lub polecenie wstążki. 

C Kliknij, aby wyświetlić lub ukryć obszar listy 

poleceń. D Kliknij, aby wyszukać wpisaną 

nazwę polecenia. E Wpisz nazwę polecenia 

do wyszukania. 

F Wybierz polecenie z listy. Przeciągnij i upuść na listę w 
Customization lub zmień obrazy przycisków wButtonImage i 
właściwości w Properties. 

G Wyświetla właściwości przypisane do wybranego elementu 
wstążki w obszarze Dostosowywanie dla wybranego 
polecenia na liście poleceń. Wprowadź nową wartość lub kliknij 
przycisk[...], aby wybrać więcej opcji dla danej właściwości. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

H Kliknij, aby wyświetlić lub ukryć obszar Właściwości. 

I Kliknij, aby wybrać plik obrazu lub .dll, który zawiera obraz do 
przypisania do aktualnie wybranego przycisku. Jeśli załadujesz 
plik obrazu lub plik .dll, możesz kliknąć Default, aby zresetować 
obrazy wyświetlane w Bitmap Images do obrazów 
zainstalowanych w ALCAD. 

J Wybierz czarno-biały lub kolorowy obraz przycisku dla 
wybranego małego lub dużego przycisku. 

K Wyświetla pełną ścieżkę i nazwę pliku .dll, .bmp lub .png, który 
został załadowany po kliknięciu przycisku Przeglądaj. 

L Kliknij, aby wyświetlić lub ukryć obszar obrazu przycisku. 

M Wybierz przycisk, który chcesz dostosować. 

A 
M 

L 

K 

B 

J 

C 

D 
E 

   I 

H 

F G 
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Aby utworzyć nową kartę wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Wstążkę na liście. Karty wyświetlane 

na wstążce w interfejsie użytkownika są wyświetlane na liście ze znakiem plus (+) 

obok każdej nazwy. 

3 Kliknij prawym przyciskiem myszy nazwę zakładki wstążki znajdującą się poniżej lokalizacji 

nowej zakładki wstążki. 

4 Wybierz kartę Wstaw. 

5 Wpisz nazwę nowej karty, a następnie naciśnij klawisz Enter. 

6 Dodaj panel i polecenie do karty wstążki (patrz obok). Aby wyświetlić nową 

kartę wstążki, należy dodać do niej panel i polecenie. 

7 Kliknij przycisk OK. 
 

Aby dostosować kartę wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Wstążkę na liście. 

4 Rozwiń kartę wstążki, a następnie jej panele, aby wyświetlić polecenia 

wyświetlane na każdej karcie wstążki. 

5 Z listy poleceń przeciągnij polecenie do miejsca, w którym ma się znajdować 

na liście dostosowywania. 
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6 Aby dodatkowo dostosować kartę wstążki, kliknij prawym przyciskiem myszy 

element znajdujący się poniżej miejsca, w którym chcesz dodać nowy 

element, i wybierz jedną z poniższych opcji: 

• Wstaw kartę Wstawia nową kartę dla wstążki. Wprowadź nazwę karty, a 

następnie naciśnij klawisz Enter. Karta zostanie wstawiona na liście powyżej 

zaznaczenia. 

• Wstaw panel i Wstaw panel podrzędny Wstawia obszar na karcie wstążki 

służący do grupowania powiązanych poleceń. Wprowadź nazwę panelu 

wyświetlanego poniżej grupy poleceń na karcie, a następnie naciśnij klawisz 

Enter. Panel jest wstawiany na liście nad zaznaczeniem lub, w przypadku 

paneli podrzędnych, zagnieżdżany na liście pod zaznaczeniem na liście. 

• Wstaw wiersz i Wstaw wiersz podrzędny Wstawia wiersz do panelu. Każdy 

panel może mieć jeden lub więcej wierszy, czyli grupę przycisków 

wyrównanych poziomo. Wiersz jest wstawiany na liście powyżej zaznaczenia lub, 

w przypadku wierszy podrzędnych, zagnieżdżany na liście poniżej 

zaznaczenia. Należy pamiętać, że zestaw wierszy panelu można podzielić na 

dwie części (widoczną i zwiniętą) za pomocą elementu <PanelBreaker> 

(kliknij prawym przyciskiem myszy i wybierz polecenie Insert Panel 

Breaker). 

• Wstaw przycisk polecenia i Wstaw podrzędny przycisk polecenia Wstawia 

przycisk polecenia, który uruchamia polecenie po kliknięciu w interfejsie 

użytkownika. Przycisk polecenia jest wstawiany na liście powyżej zaznaczenia 

lub, w przypadku podrzędnych przycisków poleceń, zagnieżdżany na liście 

poniżej zaznaczenia. 

• Wstaw przycisk menu i Wstaw przycisk menu podrzędnego Wstawia 

nazwę menu, które po kliknięciu na wstążce wyświetla dodatkowe przyciski 

poleceń. Menu jest wstawiane na liście powyżej zaznaczenia lub, w 

przypadku przycisków menu podrzędnych, zagnieżdżane na liście poniżej 

zaznaczenia. 

• Wstaw panel wierszy i wstaw panel wierszy podrzędnych Wstawia grupę 

wierszy wyświetlanych na panelu. Panel wierszy jest wstawiany na liście 

powyżej zaznaczenia lub, w przypadku podrzędnych paneli wierszy, 

zagnieżdżany na liście poniżej zaznaczenia. 

• Wstaw kontrolkę i Wstaw kontrolkę podrzędną Wstawia standardową 

kontrolkę do wybierania warstw, kolorów, typów linii, grubości linii, stylów 

wymiarów, stylów tekstu i stylów wydruku. Formant jest wstawiany na liście 

powyżej zaznaczenia lub, w przypadku formantów podrzędnych, 

zagnieżdżany na liście poniżej zaznaczenia. 

• Wstaw separator i Wstaw separator podrzędny Wstawia linię, która 

pojawia się pionowo na wstążce w celu oddzielenia grup poleceń. Separator 

jest wstawiany na liście powyżej zaznaczenia lub, w przypadku separatorów 

podrzędnych, zagnieżdżony na liście poniżej zaznaczenia. 

• Wstaw przycisk podziału i Wstaw podrzędny przycisk podziału Wstawia 

przycisk, który po kliknięciu na wstążce wyświetla dodatkowe przyciski 

poleceń. Na przykład polecenia Array i 3D Array mogą być zgrupowane na 

przycisku podziału. Przycisk polecenia wyświetlany domyślnie na wstążce jest 

ostatnim używanym przyciskiem. Przycisk podziału jest wstawiany na liście 



powyżej zaznaczenia lub, w przypadku przycisków podrzędnych, 

zagnieżdżany na liście poniżej zaznaczenia. 

7 Kliknij przycisk OK. 
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Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Tworzenie i dostosowywanie pasków narzędzi szybkiego dostępu 

Nową kartę wstążki można utworzyć, wstawiając kartę na najwyższym poziomie 

listy Wstążka. Następnie można dodać panele lub grupy do nowej karty wstążki i 

dodać polecenia. Można także modyfikować istniejące nazwy i polecenia, dodając 

je, usuwając i zmieniając ich kolejność. 
 

Aby utworzyć nowy pasek narzędzi szybkiego dostępu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń paski narzędzi szybkiego dostępu na 

liście. Karty wyświetlane na wstążce w interfejsie użytkownika są wyświetlane na liście 

ze znakiem plus (+) obok każdej nazwy. 

3 Kliknij prawym przyciskiem myszy nazwę paska narzędzi szybkiego dostępu, a 

następnie wybierz polecenie Wstaw pasek narzędzi szybkiego dostępu. Nowy 

pasek narzędzi szybkiego dostępu zostanie wstawiony nad wybraną pozycją na 

liście. 

4 Wpisz nazwę nowego paska narzędzi szybkiego dostępu, a następnie naciśnij klawisz Enter. 

5 Dodaj polecenie do paska narzędzi szybkiego dostępu (patrz obok). Aby 

wyświetlić nowy pasek narzędzi szybkiego dostępu, należy dodać do niego 

polecenie. 

6 Kliknij przycisk OK. 
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Aby dostosować pasek narzędzi szybkiego dostępu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń paski narzędzi szybkiego dostępu na 

liście. 

4 Rozwiń pasek narzędzi szybkiego dostępu, aby wyświetlić wyświetlane na nim polecenia. 

5 Wykonaj jedną z poniższych czynności, aby dodać polecenie do paska narzędzi szybkiego 

dostępu: 

• Z listy poleceń przeciągnij polecenie do miejsca, w którym chcesz je 

umieścić na liście dostosowywania. 

• Kliknij prawym przyciskiem myszy polecenie na liście paska narzędzi 

szybkiego dostępu i wybierz polecenie Wstaw przycisk polecenia. Wpisz 

nazwę i naciśnij klawisz Enter. Następnie we Właściwościach wprowadź 

nazwę polecenia dla elementu w polu Nazwa polecenia. 

6 Kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Tworzenie i dostosowywanie przycisków aplikacji 

Można utworzyć nowy przycisk aplikacji i zmodyfikować istniejący. Można także 

modyfikować istniejące nazwy i polecenia, dodając je, usuwając i zmieniając ich 

kolejność. 
 

Aby utworzyć nowy przycisk aplikacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Przyciski aplikacji na liście. 

3 Kliknij prawym przyciskiem myszy przycisk aplikacji na liście, a następnie 

wybierz polecenie Wstaw przycisk aplikacji. Nowy przycisk aplikacji zostanie 

wstawiony nad wybraną pozycją na liście. 

4 Wpisz nazwę przycisku aplikacji, a następnie naciśnij klawisz Enter 

5 Dodaj polecenie do przycisku aplikacji (patrz dalej). Aby wyświetlić nowy 

przycisk aplikacji, należy dodać do niego polecenie. 



6 Kliknij przycisk OK. 
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Aby dostosować przycisk aplikacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Przyciski aplikacji na liście. 

4 Rozwiń przycisk aplikacji, aby wyświetlić wyświetlane przez niego polecenia. 

5 Z listy poleceń przeciągnij polecenie do miejsca, w którym chcesz je 

umieścić na liście dostosowywania. 

6 Aby dodatkowo dostosować przycisk aplikacji, kliknij prawym przyciskiem 

myszy element znajdujący się poniżej miejsca, w którym chcesz dodać 

nowy element, i wybierz jedną z poniższych opcji: 

• Przycisk Wstaw polecenie Wstawia element, który uruchamia polecenie po 

kliknięciu w interfejsie użytkownika. Polecenie jest wstawiane na liście 

powyżej zaznaczenia. 

• Przycisk Wstaw menu Wstawia element menu, który otwiera podmenu po 

kliknięciu w interfejsie użytkownika. Menu jest wstawiane na liście powyżej 

dokonanego wyboru. 

• Wstaw separator Wstawia linię w interfejsie użytkownika, która wizualnie 

oddziela grupy poleceń. 

• Przycisk Wstaw polecenie podrzędne Wstawia element, który uruchamia 

polecenie po kliknięciu w interfejsie użytkownika. Polecenie jest 

zagnieżdżone pod zaznaczeniem na liście. Ta opcja jest wyświetlana dla 

przycisków menu (nie przycisków poleceń). 

• Wstaw separator podrzędny Wstawia linię w interfejsie użytkownika, która 

wizualnie oddziela grupy poleceń. Separator jest zagnieżdżony pod 

zaznaczeniem na liście. Ta opcja jest wyświetlana dla przycisków menu (nie 

przycisków poleceń). 

7 Kliknij przycisk OK. 

 
Ustawianie niestandardowych obrazów dla poleceń na wstążce 

Można dostosować obraz wyświetlany dla każdego polecenia na wstążce. 

Ponieważ wstążkę można skonfigurować tak, aby wyświetlała duże lub małe 

obrazy oraz wyświetlała je w kolorze lub monochromatycznie, należy utworzyć 

cztery różne obrazy dla każdego zestawu. Obrazy niestandardowe można utworzyć 

przy użyciu następujących wymiarów: 

• Małe obrazy: 16 x 16 pikseli. 

• Duże obrazy: 32 x 32 piksele. 

Aby uzyskać najlepsze wyniki, obrazy powinny być w 32-bitowym formacie 

ARGB z przezroczystym tłem alfa. 
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Obrazy, które nie pasują do tych wymiarów, są rozciągane lub zmniejszane przez 

program w celu dopasowania do określonego rozmiaru. 

Wynikowe obrazy mogą nie wyglądać tak, jak pierwotnie zamierzano. 
 

 
Aby dostosować obrazy poleceń na wstążce 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Wstążkę na liście. 

4 Rozwiń nazwę karty wstążki i nazwy paneli, aby wyświetlić polecenia 

wyświetlane na każdej karcie wstążki, a następnie wybierz polecenie. 

5 W obszarze Button Image, w Button Bitmaps, kliknij obraz przycisku, który 

chcesz zmienić: Mały kolor, Duży kolor, Mały czarno-biały, Duży czarno-biały. 

6 Wykonaj jedną z poniższych czynności: 

• W obszarze Obrazy bitmapowe wybierz żądany obraz z listy dostępnych obrazów. 

• Kliknij przycisk Przeglądaj, aby załadować plik zasobów zewnętrznych .dll 

zawierający zasoby bitmapowe, plik .bmp lub .png. Załadowane obrazy 

muszą mieć rozmiar 16x16 pikseli dla małych ikon i 32x32 pikseli dla dużych 

ikon. 

7 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie właściwości elementów wstążki 

Można określić właściwości każdego elementu na wstążce, w tym jego nazwę 

wyświetlaną na wstążce, widoczność i inne. 
 

Aby dostosować właściwości elementów wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Wstążkę na liście. 

4 Rozwiń nazwę karty wstążki i nazwę panelu, aby wyświetlić polecenia 

wyświetlane na każdej karcie wstążki, a następnie wybierz element wstążki. 
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Właściwości dostępne do dostosowania różnią się w zależności od wybranego 

elementu wstążki. 

Obszar Właściwości okna dialogowego Dostosuj interfejs użytkownika wyświetla tylko 

te właściwości, które są odpowiednie dla wybranego elementu wstążki. Na 

przykład ustawienia widoczności są dostępne dla poleceń, a nie dla nazw paneli 

wstążki. 
 

5 W polu Nazwa wprowadź nazwę, która ma być wyświetlana na wstążce. 

6 W polu Command Name wprowadź nazwę polecenia, które ma zostać wykonane 

po wybraniu elementu wstążki w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

7 W polu Opis wpisz jednozdaniowy opis elementu. Ciąg ten jest wyświetlany w 

wierszu stanu elementów wstążki. 

8 W obszarze Widoczność kliknij przycisk [...], aby dokonać wyboru elementu wstążki: 

• Poziom doświadczenia Wybierz poziom użytkownika, dla którego element 

będzie widoczny: Początkujący, Średniozaawansowany lub Zaawansowany. 

Elementy pojawiają się tylko na określonym poziomie doświadczenia. Na 

przykład, jeśli wybierzesz Zaawansowany, element nie pojawi się, jeśli użytkownik 

wybierze poziom Początkujący lub Średniozaawansowany za pomocą 

polecenia Narzędzia > Opcje; ale jeśli wybierzesz Średniozaawansowany bez 

wybierania Zaawansowanego, element pojawi się tylko wtedy, gdy ustawisz 

poziom doświadczenia na Średniozaawansowany. Wybranie wszystkich 

trzech opcji powoduje wyświetlanie elementu na wszystkich poziomach 

użytkownika. 

• Okno MDI Wybierz liczbę okien rysowania, które muszą być otwarte, aby ten 

element był wyświetlany. Jeśli element ma być wyświetlany tylko wtedy, gdy 

otwarte jest co najmniej jedno okno, wybierz opcję Co najmniej jedno otwarte. 

Jeśli element ma być wyświetlany, gdy żadne okno nie jest otwarte, wybierz 

opcję Brak otwartych okien. Zaznaczenie obu opcji oznacza, że element 

będzie wyświetlany zawsze. 

• ActiveX In-Place Activation Wybierz typ edycji ActiveX, z którą element ma 

być wyświetlany. Jeśli element ma być wyświetlany podczas edycji na 

wbudowanym serwerze, wybierz opcję Server, Embedded. Jeśli element ma 

być wyświetlany podczas edycji w miejscu na serwerze, wybierz opcję Server, In-

place. Jeśli element ma być wyświetlany podczas edycji kontenera, wybierz 

opcję Kontener. 

• Wyłącznie menu kontekstowe Wybierz, aby element był wyświetlany 

tylko w menu kontekstowym. 

• Tymczasowe wyskakujące okienko (dostępne tylko dla pozycji menu) 

Wybierz, aby udostępnić pozycję w tymczasowym wyskakującym okienku, 

jeśli użytkownik naciśnie klawisz SHIFT i jednocześnie kliknie prawym 

przyciskiem myszy, gdy polecenie jest aktywne. 

• Ukryj Wybierz, aby ukryć element. 
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9 W obszarze Zawartość elementów kliknij przycisk [ ], aby określić, czy element wstążki ma 

być wyświetlany w widoku 

menu kontekstowego jednostki. Wybierz jedną z następujących opcji: 

• Menu kontekstowe można dostosowywać dla poszczególnych jednostek, 

zaznaczając je lub odznaczając. Zaznaczenie pola obok podmiotu powoduje, 

że wybrany element wstążki pojawia się w menu kontekstowym dla tego 

konkretnego podmiotu. 

• Jeśli nie chcesz, aby element wstążki pojawiał się w menu kontekstowym, 

gdy wybrana jest tylko jedna jednostka, wybierz opcję Wyklucz, jeśli 

wybrana jest pojedyncza jednostka. 

• Jeśli nie chcesz, aby element wstążki pojawiał się w menu kontekstowym, gdy 

zaznaczona jest więcej niż jedna jednostka, wybierz opcję Wyklucz, jeśli 

zaznaczono wiele jednostek. 

10 Jeśli widoczność elementu wstążki może być kontrolowana przez zmienną 

systemową, należy określić jedną z poniższych opcji: 

• Zmienna stanu wyszarzonego Wprowadź nazwę i wartość zmiennej 

systemowej, która kontroluje, czy to polecenie jest wyświetlane w interfejsie 

użytkownika jako wyszarzone. Gdy określona zmienna systemowa jest 

wyłączona, przycisk jest wyszarzony lub wyświetlany jako wyłączony. Na 

przykład wyszarzona zmienna stanu polecenia Powiększ to VIEWMODE = 

1 (widok perspektywiczny = włączony). 

• Checked-State Variable Wprowadź nazwę i wartość zmiennej systemowej, 

która kontroluje, czy to polecenie jest wyświetlane w interfejsie użytkownika 

jako wciśnięte. Gdy określona zmienna systemowa jest włączona, przycisk 

polecenia jest wyświetlany jako wciśnięty. Na przykład zmienną stanu 

wciśnięcia polecenia Set Center Snap jest OSMODE = 4 (center snap = on). 

• Hidden-State Variable Wprowadź nazwę zmiennej systemowej, która 

kontroluje, czy to polecenie jest ukryte w interfejsie użytkownika. Gdy 

określona zmienna systemowa jest włączona, element jest ukryty. Na 

przykład niektóre polecenia wymagające dodatkowej licencji mają zmienną 

stanu ukrytego. 

Wprowadź nazwę zmiennej systemowej, znak ampersand, a następnie wartość, 

bez spacji. Na przykład: "OSMODE&4". 

11 Po zakończeniu kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
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Zmiana nazwy elementów wstążki 

Aby zmienić nazwę elementu wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element wstążki, którego 

nazwę chcesz zmienić. 

4 Wybierz Zmień nazwę. 

5 Wpisz nową nazwę elementu wstążki, wpisując ją nad podświetloną nazwą, a 

następnie naciśnij klawisz Enter. 

6 Kliknij przycisk OK. 

 
Kopiowanie i wklejanie elementów wstążki 

Aby skopiować i wkleić element wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element wstążki, który chcesz 

skopiować. 

4 Wybierz Kopiuj. 

5 Kliknij prawym przyciskiem myszy element wstążki znajdujący się powyżej miejsca, w 

którym chcesz zlokalizować kopię. 

6 Wybierz Wklej. 

7 Kliknij przycisk OK. 
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Usuwanie elementów wstążki 

Aby usunąć element wstążki 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element wstążki, który chcesz 

usunąć. 

4 Wybierz Usuń. 

5 W oknie dialogowym potwierdzenia kliknij przycisk Tak, aby usunąć element wstążki. 

6 Kliknij przycisk OK. 

 

Niektóre elementy wstążki mają pod sobą elementy podrzędne. 

Usunięcie elementu wstążki, pod którym znajdują się elementy podrzędne, powoduje również 

usunięcie wszystkich tych elementów podrzędnych. 
 

 

 

 

Dostosowywanie pasków narzędzi 
 

ALCAD zapewnia paski narzędzi, dzięki czemu można uzyskać dostęp do często 

używanych poleceń. Gdy pasek narzędzi jest włączony, jest zawsze dostępny lub 

znajduje się na górze i w tej samej lokalizacji, dzięki czemu można go łatwo znaleźć i 

używać. Jednak paski narzędzi zajmują przestrzeń wyświetlania rysunku i 

zmniejszają obszar dostępny do pracy na rysunkach. 

Paski narzędzi można dostosowywać, dodając lub usuwając narzędzia, a także 

zmieniając ich organizację. Można także tworzyć własne paski narzędzi. 

 

Tworzenie i dostosowywanie pasków narzędzi 

Za pomocą polecenia Customize UI można utworzyć nowy pasek narzędzi, a 

następnie dodać do niego narzędzia. Można także dodawać, usuwać lub 

modyfikować narzędzia na dowolnym istniejącym pasku narzędzi. 
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A Kliknij, aby wyświetlić lub ukryć obszar personalizacji. 

B Wybierz pasek narzędzi lub polecenie paska narzędzi. 

C Kliknij, aby wyświetlić lub ukryć obszar listy 

poleceń. D Kliknij, aby wyszukać wpisaną 

nazwę polecenia. E Wpisz nazwę polecenia 

do wyszukania. 

F Wybierz polecenie z listy. Przeciągnij i upuść na listę w 
Customization lub zmień obrazy przycisków wButtonImage i 
właściwości w Properties. 

G Wyświetla właściwości przypisane do wybranego elementu 
paska narzędzi w obszarze Personalizacja dla wybranego 
polecenia na liście poleceń. Wprowadź nową wartość lub kliknij 
przycisk[...], aby wybrać więcej opcji dla danej właściwości. 

H Kliknij, aby wyświetlić lub ukryć obszar Właściwości. 

I Kliknij, aby wybrać plik obrazu lub .dll, który zawiera obraz do 
przypisania do aktualnie wybranego przycisku. Jeśli załadujesz 
plik obrazu lub plik .dll, możesz kliknąć Default, aby zresetować 
obrazy wyświetlane w Bitmap Images do obrazów 
zainstalowanych w ALCAD. 

J Wybierz czarno-biały lub kolorowy obraz przycisku dla 
wybranego małego lub dużego przycisku. 

K Wyświetla pełną ścieżkę i nazwę pliku .dll, .bmp lub .png, który 
został załadowany po kliknięciu przycisku Przeglądaj. 

L Kliknij, aby wyświetlić lub ukryć obszar obrazu przycisku. 

M Wybierz przycisk, który chcesz dostosować. 
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Aby utworzyć nowy pasek narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Paski narzędzi na liście. Paski narzędzi 

są wyświetlane na liście ze znakiem plus (+) obok każdej nazwy. 

4 Kliknij prawym przyciskiem myszy nazwę paska narzędzi znajdującego się poniżej 

lokalizacji nowego paska narzędzi. 

5 Wybierz Wstaw pasek narzędzi. 

6 Wpisz nazwę nowego paska narzędzi, a następnie naciśnij klawisz Enter. 

7 Dodaj polecenie do paska narzędzi (patrz dalej). Aby zobaczyć nowy pasek 

narzędzi w interfejsie użytkownika, należy dodać do niego polecenie. 

8 Kliknij przycisk OK. 
 

Aby dodać polecenie do paska narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Paski narzędzi na liście. 

4 Rozwiń nazwę paska narzędzi, aby wyświetlić wyświetlane na nim polecenia. 

5 Z listy poleceń przeciągnij polecenie do miejsca, w którym ma się znajdować 

na liście dostosowywania. 

6 Aby dodatkowo dostosować pasek narzędzi, kliknij prawym przyciskiem myszy 

element znajdujący się poniżej miejsca, w którym chcesz dodać nowy element, i 

wybierz jedną z poniższych opcji: 

• Wstaw przycisk Wstawia przycisk paska narzędzi, który uruchamia 

polecenie po kliknięciu w interfejsie użytkownika. Przycisk paska narzędzi 

jest wstawiany na liście powyżej zaznaczenia. 

• Wstaw element podrzędny Wstawia przycisk paska narzędzi, jeśli nazwa 

paska narzędzi została kliknięta prawym przyciskiem myszy na liście. 

Kliknięcie prawym przyciskiem myszy elementu na liście znajdującego się na 

pasku narzędzi powoduje wstawienie przycisku paska narzędzi 

zagnieżdżonego na liście pod zaznaczeniem, a zaznaczenie staje się 

poleceniem nadrzędnym na wysuwanym menu. 

 
Wysuwane paski narzędzi to sposób na uporządkowanie powiązanych narzędzi i 

zaoszczędzenie miejsca na pasku narzędzi. 
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paski narzędzi. Wylot jest oznaczony małym trójkątem w prawym dolnym 

rogu narzędzia. Kliknięcie wysuwanego narzędzia powoduje wyświetlenie 

zestawu dodatkowych narzędzi. Wybrane narzędzie wysuwane staje się 

domyślnym narzędziem na pasku narzędzi. 

• Wstaw separator Wstawia linię, która pojawia się pionowo na pasku 

narzędzi w celu oddzielenia grup poleceń. Separator jest wstawiany na liście 

powyżej zaznaczenia. 

7 Kliknij OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Ustawianie niestandardowych obrazów dla poleceń na pasku narzędzi 

Można dostosować obraz wyświetlany dla każdego polecenia na pasku narzędzi. 

Ponieważ paski narzędzi można skonfigurować tak, aby wyświetlały duże lub małe 

narzędzia i wyświetlały narzędzia kolorowe lub monochromatyczne, należy utworzyć 

cztery różne obrazy dla każdego narzędzia. Utwórz niestandardowe obrazy przy 

użyciu następujących wymiarów: 

• Małe obrazy: 16 x 16 pikseli. 

• Duże obrazy: 32 x 32 piksele. 

Aby uzyskać najlepsze wyniki, obrazy powinny być w 32-bitowym formacie 

ARGB z przezroczystym tłem alfa. 

 

Obrazy, które nie pasują do tych wymiarów, są rozciągane lub zmniejszane przez 

program w celu dopasowania do określonego rozmiaru. 

Wynikowe narzędzia mogą nie wyglądać tak, jak pierwotnie zamierzano. 
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Aby dostosować obrazy poleceń na pasku narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Paski narzędzi na liście. 

4 Rozwiń nazwę paska narzędzi, aby wyświetlić wyświetlane na nim polecenia, a 

następnie wybierz polecenie. 

5 W obszarze Button Image, w Button Bitmaps, kliknij obraz przycisku, który 

chcesz zmienić: Mały kolor, Duży kolor, Mały czarno-biały, Duży czarno-biały. 

Należy pamiętać, że czarno-białe ikony są używane dla wysokiego kontrastu, 

który jest używany przez użytkowników niewidomych na kolory lub inne osoby 

z wadami wzroku. Zobacz zgodność z sekcją 508. 

6 Wykonaj jedną z poniższych czynności: 

• W obszarze Obrazy bitmapowe wybierz żądany obraz z listy dostępnych obrazów. 

• Kliknij przycisk Przeglądaj, aby załadować plik zasobów zewnętrznych .dll 

zawierający zasoby bitmapowe, plik .bmp lub .png. Załadowane obrazy 

muszą mieć rozmiar 16x16 pikseli dla małych ikon i 32x32 pikseli dla dużych 

ikon. 

7 Po zakończeniu kliknij przycisk OK. 

 
Ustawianie właściwości elementów paska narzędzi 

Można określić właściwości dla każdego elementu na pasku narzędzi, w tym 

nazwę wyświetlaną na etykiecie narzędzia, widoczność narzędzia i inne. 
 

Aby dostosować właściwości elementów paska narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Paski narzędzi na liście. 

4 Rozwiń nazwę paska narzędzi, aby wyświetlić polecenia wyświetlane na 

każdym pasku narzędzi, a następnie wybierz element paska narzędzi. 
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Właściwości dostępne do dostosowania różnią się w zależności od wybranego 

elementu paska narzędzi. 

Obszar Właściwości okna dialogowego Dostosuj interfejs użytkownika wyświetla tylko 

te właściwości, które są odpowiednie dla wybranego elementu paska narzędzi. Na 

przykład ustawienia widoczności są dostępne dla poleceń, a nie nazw pasków 

narzędzi. 
 

5 W polu Nazwa wprowadź nazwę, która ma być wyświetlana po najechaniu kursorem na 

pasek narzędzi. 

6 W polu Command Name wprowadź nazwę polecenia, które ma zostać wykonane 

po wybraniu elementu paska narzędzi w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

7 W polu Opis wpisz jednozdaniowy opis elementu. Ciąg ten jest wyświetlany w 

wierszu stanu elementów paska narzędzi. 

8 W obszarze Widoczność kliknij przycisk [...], aby dokonać wyboru elementu paska narzędzi: 

• Poziom doświadczenia Wybierz poziom użytkownika, dla którego element 

będzie widoczny: Początkujący, Średniozaawansowany i/lub Zaawansowany. 

Elementy pojawiają się tylko na określonym poziomie doświadczenia. Na 

przykład, jeśli wybierzesz Zaawansowany, element nie pojawi się, jeśli użytkownik 

wybierze poziom Początkujący lub Średniozaawansowany za pomocą 

polecenia Narzędzia > Opcje; ale jeśli wybierzesz Średniozaawansowany bez 

wybierania Zaawansowanego, element pojawi się tylko wtedy, gdy ustawisz 

poziom doświadczenia na Średniozaawansowany. Wybranie wszystkich 

trzech opcji powoduje wyświetlanie elementu na wszystkich poziomach 

użytkownika. 

• Okno MDI Wybierz liczbę okien rysowania, które muszą być otwarte, aby ten 

element był wyświetlany. Jeśli element ma być wyświetlany tylko wtedy, gdy 

otwarte jest co najmniej jedno okno, wybierz opcję Co najmniej jedno otwarte. 

Jeśli element ma być wyświetlany, gdy żadne okno nie jest otwarte, wybierz 

opcję Brak otwartych okien. Zaznaczenie obu opcji oznacza, że element 

będzie wyświetlany zawsze. 

• ActiveX In-Place Activation Wybierz typ edycji ActiveX, z którą element ma 

być wyświetlany. Jeśli element ma być wyświetlany podczas edycji na 

wbudowanym serwerze, wybierz opcję Server, Embedded. Jeśli element ma 

być wyświetlany podczas edycji w miejscu na serwerze, wybierz opcję Server, In-

place. Jeśli element ma być wyświetlany podczas edycji kontenera, wybierz 

opcję Kontener. 

• Wyłącznie menu kontekstowe Wybierz, aby element był wyświetlany 

tylko w menu kontekstowym. 
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• Tymczasowe wyskakujące okienko (dostępne tylko dla pozycji menu) 

Wybierz, aby udostępnić pozycję w tymczasowym wyskakującym okienku, 

jeśli użytkownik naciśnie klawisz SHIFT i jednocześnie kliknie prawym 

przyciskiem myszy, gdy polecenie jest aktywne. 

• Ukryj Wybierz, aby ukryć element. 

9 W obszarze Zawartość jednostek kliknij przycisk [ ], aby określić, czy element paska 

narzędzi ma być wyświetlany w obszarze 

menu kontekstowego jednostki. Wybierz jedną z następujących opcji: 

• Menu kontekstowe można dostosowywać dla poszczególnych jednostek, 

zaznaczając je lub odznaczając. Zaznaczenie pola obok jednostki powoduje, 

że wybrany element paska narzędzi pojawi się w menu kontekstowym dla tej 

konkretnej jednostki. 

• Jeśli nie chcesz, aby element paska narzędzi pojawiał się w menu 

kontekstowym, gdy wybrana jest tylko jedna jednostka, wybierz opcję Wyklucz, 

jeśli wybrana jest pojedyncza jednostka. 

• Jeśli nie chcesz, aby element paska narzędzi pojawiał się w menu 

kontekstowym, gdy zaznaczona jest więcej niż jedna jednostka, wybierz 

opcję Wyklucz, jeśli zaznaczono wiele jednostek. 

10 Jeśli widoczność elementu paska narzędzi może być kontrolowana przez 

zmienną systemową, należy określić jedną z poniższych opcji: 

• Zmienna stanu wyszarzonego Wprowadź nazwę i wartość zmiennej 

systemowej, która kontroluje, czy to polecenie jest wyświetlane w interfejsie 

użytkownika jako wyszarzone. Gdy określona zmienna systemowa jest 

wyłączona, przycisk jest wyszarzony lub wyświetlany jako wyłączony. Na 

przykład wyszarzona zmienna stanu polecenia Powiększ to VIEWMODE = 

1 (widok perspektywiczny = włączony). 

• Checked-State Variable Wprowadź nazwę i wartość zmiennej systemowej, 

która kontroluje, czy to polecenie jest wyświetlane w interfejsie użytkownika 

jako wciśnięte. Gdy określona zmienna systemowa jest włączona, przycisk 

polecenia jest wyświetlany jako wciśnięty. Na przykład zmienną stanu 

wciśnięcia polecenia Set Center Snap jest OSMODE = 4 (center snap = on). 

• Hidden-State Variable Wprowadź nazwę zmiennej systemowej, która 

kontroluje, czy to polecenie jest ukryte w interfejsie użytkownika. Gdy 

określona zmienna systemowa jest włączona, element jest ukryty. Na 

przykład niektóre polecenia wymagające dodatkowej licencji mają zmienną 

stanu ukrytego. 

Wprowadź nazwę zmiennej systemowej, znak ampersand, a następnie wartość, 

bez spacji. Na przykład: "OSMODE&4". 

11 Po zakończeniu kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
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Zmiana nazwy elementów paska narzędzi 

Aby zmienić nazwę elementu paska narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element paska narzędzi, 

którego nazwę chcesz zmienić. 

4 Wybierz Zmień nazwę. 

5 Wpisz nową nazwę elementu paska narzędzi, wpisując ją nad podświetloną 

nazwą, a następnie naciśnij klawisz Enter. 

6 Kliknij przycisk OK. 

 

Możesz także zmienić nazwy pasków narzędzi za pomocą polecenia Paski narzędzi. 

Wybierz polecenie Widok > Paski narzędzi, aby otworzyć okno dialogowe Wybierz 

paski narzędzi. Zaznacz pasek narzędzi, którego nazwę chcesz zmienić, a następnie kliknij 

przycisk Zmień nazwę i wpisz nową nazwę. 
 

 
Kopiowanie i wklejanie elementów paska narzędzi 

Aby skopiować i wkleić element paska narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element paska narzędzi, który 

chcesz skopiować. 

4 Wybierz Kopiuj. 

5 Kliknij prawym przyciskiem myszy element paska narzędzi znajdujący się powyżej miejsca, 

w którym chcesz zlokalizować kopię. 

6 Wybierz Wklej. 

7 Kliknij przycisk OK. 
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Usuwanie elementów paska narzędzi 

Aby usunąć element paska narzędzi 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy element paska narzędzi, który 

chcesz usunąć. 

4 Wybierz Usuń. 

5 W oknie dialogowym potwierdzenia kliknij przycisk Tak, aby usunąć element paska 

narzędzi. 

6 Kliknij przycisk OK. 

 

 
 

Dostosowywanie klawiatury 
 

ALCAD zapewnia skróty klawiaturowe, dzięki czemu można uzyskać dostęp do 

często używanych poleceń. Możesz dostosować te skróty i dodać nowe skróty za 

pomocą polecenia Custom- ize UI. 

 

Tworzenie i dostosowywanie skrótów klawiaturowych 

Makra można przypisywać do klawiszy specjalnych i określonych kombinacji 

klawiszy w celu utworzenia skrótu klawiaturowego. Makro składa się z jednego lub 

więcej poleceń, które są wyświetlane na pasku stanu w następujący sposób: 

• Pojedyncze polecenie, takie jak QSAVE. 

• Polecenie z opcjami, takimi jak ARC;\A;\\. 

• Więcej niż jedno polecenie, takie jak ^C^C^CZOOM;E;QSAVE;QPRINT. 

Skróty klawiaturowe mają większe możliwości niż aliasy. Alias pozwala skrócić 

pojedynczą nazwę polecenia; skrót klawiaturowy zawiera jedno lub więcej makr. Aby 

aktywować makro, należy nacisnąć klawisz skrótu; nie trzeba naciskać klawisza 

Enter, jak w przypadku aliasu. Skrót składa się z następujących klawiszy: 

• Klawisze funkcyjne i sterowania kursorem, a także klawisze alfanumeryczne 

naciskane w połączeniu z klawiszami Ctrl, Alt i Shift. Klawisz Shift musi być używany 

w połączeniu z klawiszami Ctrl, Alt i/lub klawiszami funkcyjnymi. 

• Klawisze alfanumeryczne to te oznaczone literami od A do Z oraz od 1 do 0. 

• Przyciski kursora to strzałki w górę, w dół, w lewo i w prawo oraz przyciski 

Page Up, Page Down, Home, End, Insert i Delete. 

• Przyciski funkcyjne są oznaczone od F1 do F12. 
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A 

 

H 

 
 
 

 
B 

 
 
 
 

 
C 

D 

E 

 
 
 

 
F 

 
 
 
 
 
 
 

 
A Kliknij, aby wyświetlić lub ukryć obszar 

personalizacji. 

B Wybierz skrót klawiaturowy. 

C Kliknij, aby wyświetlić lub ukryć obszar listy 

poleceń. D Kliknij, aby wyszukać wpisaną 

nazwę polecenia. E Wpisz nazwę polecenia 

do wyszukania. 

 
G 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F Wyświetla listę poleceń. Obrazy przycisków poleceń można 
zmieniać w opcji Obraz przycisku, a właściwości w opcji 
Właściwości. 

G Wyświetla właściwości przypisane do wybranych skrótów 
klawiaturowych w sekcji Personalizacja dla wybranego 
polecenia na liście poleceń. Wprowadź nową wartość lub kliknij 
przycisk [...], jeśli jest dostępny, aby wybrać więcej opcji dla 
każdej właściwości. 

H Kliknij, aby wyświetlić lub ukryć obszar Właściwości. 
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Aby utworzyć skrót klawiaturowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Skróty klawiaturowe na liście. 

4 Kliknij prawym przyciskiem myszy nazwę skrótu znajdującą się powyżej 

miejsca, w którym chcesz dodać nowy skrót klawiaturowy do listy. 

5 Wybierz Insert Accelerator. 

6 W oknie dialogowym Klawisze skrótów klawiaturowych naciśnij kombinację 

klawiszy, którą chcesz dodać, na przykład naciśnij Alt+A. 

7 Kliknij przycisk OK. 

8 W polu Command Name (Nazwa polecenia) wprowadź nazwę polecenia, które 

ma zostać wykonane po naciśnięciu kombinacji klawiszy i klawiatury w 

interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

9 W polu Opis wpisz jednozdaniowy opis przedmiotu. 

10 Aby zapisać zmiany i zamknąć okno dialogowe, kliknij przycisk OK. 
 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Ustawianie właściwości skrótów klawiaturowych 

Dla każdego skrótu klawiaturowego można określić właściwości, w tym powiązany 

symbol, opis i kombinację klawiszy. 
 

Aby dostosować właściwości skrótów klawiaturowych 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Customize UI (  ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 
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2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Skróty klawiaturowe na liście. 

4 Wybierz skrót klawiaturowy. 

5 W polu Command Name wprowadź nazwę polecenia, które ma zostać 

wykonane po naciśnięciu skrótu klawiaturowego w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

6 W polu Opis wpisz jednozdaniowy opis przedmiotu. 

7 Aby określić nową kombinację klawiszy, wykonaj następujące czynności; 

• W Klucz(e) naciśnij przycisk [...]. 

• Naciśnij nową kombinację klawiszy. 

• Kliknij przycisk OK. 

8 Po zakończeniu kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Kopiowanie i wklejanie skrótów klawiaturowych 

Aby skopiować i wkleić skrót klawiaturowy 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Dostosowywanie kliknij prawym przyciskiem myszy skrót klawiaturowy, który 

chcesz skopiować. 

4 Wybierz Kopiuj. 

5 Kliknij prawym przyciskiem myszy skrót klawiaturowy znajdujący się 

powyżej miejsca, w którym chcesz zlokalizować kopię. 

6 Wybierz Wklej. 

7 Kliknij przycisk OK. 
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Usuwanie skrótów klawiaturowych 

Todeleteakeyboardshortcutitem 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście dostosowań kliknij prawym przyciskiem myszy skrót klawiaturowy, który chcesz 

usunąć. 

4 Wybierz Usuń. 

5 W oknie dialogowym potwierdzenia kliknij przycisk Tak, aby usunąć skrót klawiaturowy. 

6 Kliknij przycisk OK. 

 

 

Tworzenie aliasów 
 

ALCAD zapewnia aliasy dla wielu poleceń. Aliasów można używać do wydawania 

często używanych poleceń, wprowadzając jedną lub dwie litery zamiast całej nazwy 

polecenia. 

Program używa również aliasów, aby zachować zgodność nazw poleceń z 

programem AutoCAD. Można używać tych samych aliasów i skrótów 

klawiaturowych, co w programie AutoCAD. Ponadto ALCAD ulepszył kilka 

poleceń AutoCAD. Na przykład ALCAD dodał dwie przydatne opcje do polecenia 

prostokąta: można narysować prostokąt jako kwadrat i można obrócić prostokąt pod 

kątem. 

Aliasy można dostosowywać i dodawać nowe. Aliasy można dostosowywać za 

pomocą polecenia Customize UI. 

 

Tworzenie aliasów 

Aby utworzyć nowy alias polecenia, należy najpierw zdefiniować alias, a następnie 

przypisać go do jednego z dostępnych poleceń ALCAD. 
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A 

H 

 
 

G 
 

B 

 
 
 
 
 

C 

D 
E 

 
 
 

 
F 

 
 
 
 
 
 
 
 

A Kliknij, aby wyświetlić lub ukryć obszar 
personalizacji. 

B Wybierz alias. 

C Kliknij, aby wyświetlić lub ukryć obszar listy 

poleceń. D Kliknij, aby wyszukać wpisaną 

nazwę polecenia. E Wpisz nazwę polecenia 

do wyszukania. 

F Wyświetla listę poleceń. Obrazy przycisków poleceń można 
zmieniać w opcji Obraz przycisku, a właściwości w opcji 
Właściwości. 

G Wyświetla właściwości przypisane do wybranego aliasu w 
Customization lub wybranego polecenia w Command List. 
Wprowadź nową wartość lub kliknij przycisk [...], jeśli jest 
dostępny, aby wybrać więcej opcji dla każdej właściwości. 

H Kliknij, aby wyświetlić lub ukryć obszar Właściwości. 
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Aby utworzyć nowy alias 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Aliasy na liście. 

4 Kliknij prawym przyciskiem myszy nazwę aliasu znajdującą się poniżej 

miejsca, w którym chcesz dodać nowy alias do listy. 

5 Wybierz Wstaw alias. 

6 Wpisz nowy alias, a następnie naciśnij klawisz Enter. 

7 W polu Command Name wprowadź nazwę polecenia, które ma zostać wykonane 

po wprowadzeniu aliasu w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

8 W polu Opis wpisz jednozdaniowy opis przedmiotu. 

9 Aby zapisać zmiany i zamknąć okno dialogowe, kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Ustawianie właściwości aliasów 

Dla każdego aliasu można określić właściwości, w tym powiązane polecenie i opis. 
 

Aby dostosować właściwości aliasów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 W obszarze dostosowywania wybierz obszar roboczy lub plik dostosowywania 

(na przykład ICAD), a następnie rozwiń Aliasy na liście. 
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4 Wybierz alias. 

5 W polu Nazwa wprowadź nową nazwę aliasu. 

6 W polu Command Name wprowadź nazwę polecenia, które ma zostać 

wykonane po wprowadzeniu nazwy aliasu w interfejsie użytkownika. 

Nazwa polecenia może zawierać makro (jedno lub więcej poleceń i ich opcje), np: 

^C^C^CZOOM;E;MSNAPSHOT 

Dodanie trzech znaków ^C (Ctrl+C) przed poleceniem anuluje wszystkie 

aktywne polecenia lub okna dialogowe. 

7 W polu Opis wpisz jednozdaniowy opis przedmiotu. 

8 Po zakończeniu kliknij przycisk OK. 

 

Można zresetować interfejs użytkownika, aby był taki sam, jak podczas pierwszej instalacji 
programu. 

Użyj polecenia Opcje, kliknij kartę Profile, a następnie kliknij przycisk Resetuj. 
 

 
Kopiowanie i wklejanie elementu aliasu 

Aby skopiować i wkleić element aliasu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Customization kliknij prawym przyciskiem myszy alias, który chcesz skopiować. 

4 Wybierz Kopiuj. 

5 Kliknij prawym przyciskiem myszy alias znajdujący się powyżej miejsca, w którym chcesz 

zlokalizować kopię. 

6 Wybierz Wklej. 

7 Kliknij przycisk OK. 
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Usuwanie elementu aliasu 

Aby usunąć istniejący element aliasu 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Na liście Customization kliknij prawym przyciskiem myszy alias, który chcesz usunąć. 

4 Wybierz Usuń. 

5 W oknie dialogowym potwierdzenia kliknij przycisk Tak, aby usunąć alias. 

6 Kliknij przycisk OK. 
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Praca z plikami dostosowywania interfejsu użytkownika 
 

Wielu użytkowników dostosowuje obszary głównego okna ALCAD, takie jak 

menu i paski narzędzi za pomocą polecenia Customize UI (CUI). Ustawienia te są 

zapisywane w pliku .cui, który jest plikiem w formacie XML, zawierającym 

ustawienia dla następujących elementów: 

• Wstążka 

• Przestrzenie robocze 

• Menu 

• Paski narzędzi 

• Akceleratory klawiatury 

• Pseudonimy 

• Akcje dwukrotnego kliknięcia 

Można zapisywać i wczytywać pliki .cui/.cuix, przywracać je, kopiować ustawienia 

między plikami .cui, a nawet ręcznie edytować plik .cui/.cuix. 

ALCAD współpracuje również z innymi typami plików, które są używane do 

dostosowywania interfejsu użytkownika. Można również załadować menu i paski 

narzędzi AutoCAD (*.mnu, *.mns), menu i paski narzędzi ALCAD (*.icm), aliasy 

ALCAD (*.ica), aliasy AutoCAD (*.pgp) i skróty klawiaturowe ALCAD (*.ick). 

Palety narzędzi są częścią interfejsu użytkownika i również można je 

dostosowywać, ale nie są one zapisywane w plikach dostosowywania. Aby 

dostosować palety narzędzi, patrz "Dostosowywanie palet narzędzi" na stronie 723 

w tym rozdziale. 

 

Zapisywanie plików personalizacji 

ALCAD automatycznie zapisuje wszelkie dokonane dostosowania do następujących 

elementów: 

• Wstążka 

• Przestrzenie robocze 

• Menu 

• Paski narzędzi 

• Akceleratory klawiatury 

• Pseudonimy 

• Akcje dwukrotnego kliknięcia 

Zmiany są zapisywane automatycznie w pliku .cui/.cuix. W razie potrzeby można 

zapisać ustawienia w nowym pliku .cui/.cuix. 
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Aby zapisać ustawienia personalizacji w nowym pliku personalizacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Transfer. 

3 Po prawej stronie kliknij Zapisz jako. 

4 Wprowadź nazwę pliku .cui/.cuix. 

5 Kliknij przycisk Zapisz. 

6 Kliknij przycisk OK. 

 
Ładowanie plików personalizacji 

Można zastąpić bieżący plik dostosowywania innym lub rozszerzyć bieżący plik 

dostosowywania o dodatkowe elementy, takie jak niestandardowe menu. Program 

ładuje pełne dostosowania (*.cui, *.cuix), menu AutoCAD i paski narzędzi (*.mnu, 

*.mns), menu i paski narzędzi ALCAD (*.icm), aliasy ALCAD (*.ica), aliasy 

AutoCAD (*.pgp) i skróty klawiaturowe ALCAD (*.ick). 

Wczytanie pliku menu, aliasu lub skrótu klawiaturowego zastępuje tylko te 

elementy w interfejsie użytkownika. 

Ustawienia personalizacji można również przywrócić, ładując domyślny plik 

personalizacji z momentu instalacji programu lub ładując zapasowy plik 

personalizacji. 
 

Aby załadować plik personalizacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Transfer. 

3 Po lewej stronie kliknij przycisk Otwórz. 

4 Z listy Pliki typu wybierz typ pliku, który chcesz załadować. 

5 Wybierz żądany plik. 

6 Kliknij przycisk Otwórz. 

7 Kliknij przycisk OK. 
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Aby przywrócić domyślny plik personalizacji 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Kliknij podwójną strzałkę dla Current Customization. 

4 Wybierz Reset from Default (Przywróć ustawienia domyślne). 

5 Kliknij Tak, aby przywrócić domyślny plik personalizacji lub Nie, aby anulować. 

6 Kliknij przycisk OK. 

 

Można również zresetować dostosowanie interfejsu użytkownika CUI z poziomu wiersza poleceń. 

Wpisz resetui, aby uruchomić polecenie resetowania interfejsu użytkownika. 
 

 
Aby przywrócić plik personalizacji z kopii zapasowej 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Dostosuj. 

3 Kliknij podwójną strzałkę dla Current Customization. 

4 Wybierz Przywróć kopię zapasową, a następnie wybierz Codzienna, Tygodniowa, 

Miesięczna lub Roczna. 

5 Kliknij Tak, aby przywrócić plik personalizacji z kopii zapasowej lub Nie, aby anulować. 

6 Kliknij przycisk OK. 
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Tworzenie nowego pliku .cui i kopiowanie ustawień 

Polecenie Customize UI pozwala szybko utworzyć nowy plik .cui/.cuix i skopiować 

ustawienia z jednego pliku dostosowywania do innego. Możesz wybrać, które 

ustawienia mają zostać skopiowane, od pojedynczego polecenia do wszystkich 

ustawień w pliku. 
 

Aby utworzyć nowy plik .cui/.cuix i skopiować ustawienia 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Transfer. 

3 Po prawej stronie kliknij przycisk Nowy. 

4 Po lewej stronie kliknij Otwórz i wybierz plik personalizacji zawierający 

ustawienia, które chcesz skopiować. 

5 Przeciągnij i upuść ustawienia między dwoma plikami. 

6 Po zakończeniu kliknij przycisk OK. 

 
Dostosowywanie pliku .cui za pomocą edytora 

Plik .cui to format pliku XML, który można edytować za pomocą dowolnego 

edytora tekstu ASCII lub Unicode. Jednak najlepiej jest edytować pliki .cui za 

pomocą edytora XML, takiego jak Visual Studio lub Notepad++. Jeśli 

programujesz z ALCAD, masz już Visual Studio. 

Zachowaj ostrożność podczas ręcznej edycji pliku .cui i skorzystaj z poniższych 

wskazówek dotyczących formatu pliku: 

• W zawartości plików .cui/.cuix rozróżniana jest wielkość liter. Na przykład 

poniższa treść jest poprawna; nie zostaną wyświetlone żadne błędy, ale atrybut 

ID zostanie zignorowany: 

<ToolTip id="123">Pomoc</ToolTip>. 

Następujące rozwiązanie jest również poprawne: ID będzie równe 123: 

<ToolTip ID="123">Pomoc</ToolTip>. 

• Zawartość plików .cui zawiera specjalne symbole, podobne do plików .xml: & 

(amper- sand), ' (quote) i inne. Należy zastąpić te symbole specjalne 

odpowiednimi sekwencjami ucieczki lub zamiast tego użyć struktury XML 

CDATA. Na przykład, poniższe nie jest poprawne: 

<ToolTip id="123">&Help</ToolTip>. 

Prawidłowo: 

<ToolTip ID="123">&amp;Help</ToolTip>. 

Nieprawidłowo: 

<Command>'_HELP</Command> 
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Prawidłowo: 

<Command><![CDATA['_HELP]]></Command>. 

• Właściwości kilku typów encji mogą być opisane zarówno w stylu węzła, jak i 

atrybutu. Na przykład poniższe dwa przyciski paska narzędzi są takie same: 

<ToolbarButton UID="unique-id" IsSeparator="true 

Visibility="CUI_LEV_ALL,CUI_MDI_OPN,CUI_OLE_SEM" 

EntityVisibility="RCM_ENT_ACS,RCM_ENT_MUL"/> 

 

<ToolbarButton UID="unique-id">. 

<IsSeparator>true</IsSeparator>. 

<Widoczność>CUI_LEV_ALL,CUI_MDI_OPN,CUI_OLE_SEM</Widoczność> 

<EntityVisibility>RCM_ENT_ACS,RCM_ENT_MUL</EntityVisibility> 

</ToolbarButton> 

 

Aby dostosować plik .cui/.cuix za pomocą edytora 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui, a następnie naciśnij Enter. 

2 Kliknij kartę Menu, a następnie kliknij przycisk Eksportuj. 

3 Określ katalog i nazwę pliku, które mają zostać użyte do zapisania pliku menu. 

4 W polu Zapisz jako typ wybierz plik CUI Customizations (.cui). 

5 Kliknij przycisk Zapisz, a następnie Zamknij. 

6 W dowolnym edytorze tekstu ASCII lub Unicode otwórz plik .cui i wprowadź 

zmiany zgodnie z poniższym formatem. 

Istnieje wiele edytorów, ale jeśli programujesz z ALCAD, masz już Visual 

Studio, który jest dobrym edytorem XML dla plików .cui. 
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Zrozumienie wersjonowania pliku .cui 

Każdy plik .cui ma węzeł, który kontroluje wersjonowanie: 

<FileVersion MajorVersion="1" MinorVersion="2" UserVersion="0" 

IncrementalVersion="91"/> 

• IncrementalVersion Musi być zwiększana przy każdej zmianie w pliku Icad.cui. 

• UserVersion Zwiększana automatycznie, gdy użytkownik dostosowuje 

ALCAD. W domyślnym pliku Icad.cui musi być zawsze równa 0 i nigdy nie 

może być edytowana ręcznie. 

• MinorVersion Musi być zwiększana wraz ze zmianą lub utworzeniem 

wersjonowanej jednostki (PopMenu, Toolbar, MenuMacro->Macro, ). 

• MajorVersion musi zostać zwiększona o następujące wartości: 

• Zmiana schematu pliku Icad.cui (na przykład dodanie/usunięcie sekcji lub 

dodanie nowego typu podmiotów). 

• Usunięcie wersji podmiotu. 

• Zmiana atrybutu UID istniejącej wersji encji lub zmiana atrybutu Name w 

przypadku encji Workspace. 

Jeśli MajorVersion zostanie zwiększona, plik .cui użytkownika zostanie 

zastąpiony zaktualizowanym plikiem .cui. 

Plik .cui zawiera również wersjonowane encje: Workspace, MenuMacro->Macro, 

Pop- Menu, Toolbar, AppButton, QuickAccessToolbar, RibbonPanelSource i 

RibbonTabSource. Każda jednostka wersjonowana ma również węzeł: 

<ModifiedRev MinorVersion="2"/> 

Po zmodyfikowaniu lub utworzeniu wersjonowanej encji, FileVersion-

>MinorVersion musi zostać zwiększona, a następnie wynik musi zostać przypisany 

do ModifiedRev->MinorVersion zmodyfikowanej encji. 

 

Zrozumienie formatu pliku .cui 

Plik .cui może zawierać ustawienia dla następujących obszarów głównego okna ALCAD: 

• Wstążka 

• Przestrzenie robocze 

• Menu 

• Paski narzędzi 

• Akceleratory klawiatury 

• Aliasy poleceń 



Wartości 
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Format pliku CUI 
 

FileVersion 

MajorVersion 4-bajtowa liczbacałkowita Yes Główna wersja pliku .cui. Aby uzyskać szczegółowe 
informacje, zobacz "Zrozumienie 

wersjonowanie pliku .cui" na stronie 771 w tym rozdziale. 

MinorVersion 4-bajtowa liczba całkowita Yes Mniejsza wersja pliku .cui. Aby uzyskać szczegółowe  

     informacje, zobacz "Zrozumienie 
wersjonowanie pliku .cui" na stronie 771 w tym rozdziale. 

IncrementalVersion 4-bajtowa liczba całkowita Tak Wersja przyrostowa pliku .cui. Aby uzyskać szczegółowe  

     informacje, zobacz "Zrozumienie 
wersjonowanie pliku .cui" na stronie 771 w tym rozdziale. 

UserVersion 4-bajtowa liczba całkowita Yes Wersja użytkownika pliku .cui. Aby uzyskać szczegółowe 
informacje, patrz "Zrozumienie 

wersjonowanie pliku .cui" na stronie 771 w tym rozdziale. 

AppButton   Przycisk aplikacji. 

UID Text Yes Identyfikator przycisku AppButton. Unikalny wśród wszystkich  

   identyfikatorów UID. 

LargeImage Text("0") No Identyfikator zasobu obrazu ikony AppButton lub ścieżka do lokalnego  

   pliku obrazu. 

LargeImageHighContrast Text("0") No Identyfikator zasobu obrazu ikony AppButton o wysokim kontraście lub  

   ścieżka do 
plik lokalny. 

Nazwa Text("") No Nazwa lub etykietka przycisku AppButton. 

AppButtonItem Zwykły przycisk polecenia lub linia rozdzielająca. 

UID Text Yes Identyfikator elementu AppButtonItem. Unikalny wśród wszystkich  

   identyfikatorów UID. 

MenuMacroID Text Yes/No Identyfikator przywoływanego MenuMacro. Niewymagane w przypadku 
separatora 

Przycisk. Wymagane we wszystkich innych przypadkach. 

IsSeparator true/false(false) Nie Określa, czy element jest linią separatora, czy zwykłym 
przyciskiem poleceń. 

AppButtonPopItem Podmenu zawierające zestaw elementów AppButtonItem. 

UID Text Yes Identyfikator elementu AppButtonPopItem. Unikalny wśród wszystkich 
identyfikatorów UID. 

LargeImage Text("0") No Identyfikator zasobu obrazu ikony AppButtonPopItem lub ścieżki lokalnej 
plik graficzny. 

LargeImageHighContrast Text("0") No Identyfikator zasobu obrazu ikony AppButtonPopItem o wysokim kontraście 
lub 

ścieżka do lokalnego pliku obrazu. 

Nazwa Text("") No Nazwa lub etykietka narzędzia elementu AppButtonPopItem. 

QuickAccessToolbar Pasek narzędzi szybkiego dostępu. 

UID Text Yes Identyfikator paska narzędzi szybkiego dostępu. Unikalny wśród 
wszystkich identyfikatorów UID. 

QuickAccessToolbarStandardItem Zwykły przycisk polecenia. 



UID Text Yes Identyfikator elementu QuickAccessToolbarStandardItem. 
Unikalny wśród wszystkich identyfikatorów UID. 

MenuMacroID Text Yes Identyfikator przywoływanego MenuMacro. 

Obszar roboczy Składa się z następujących sekcji: WSPopRoot, WSToolbarRoot i 
WSRibbonRoot. 

DefaultWorkspace true/false (fałsz) Nie Określa, czy obszar roboczy jest wybrany domyślnie. 

Nazwa Text Yes Nazwa obszaru roboczego. 



Wartości 
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Format pliku CUI 
 

WSPop Deklaracja menu podręcznego w przestrzeni roboczej. 

Wyświetlacz 0/1 (0) No Czy wyświetlać (1) lub nie wyświetlać (0) menu podręczne 
w MenuBar. 

pUID Text Yes Identyfikator UID menu podręcznego. Unikalny wśród wszystkich 
identyfikatorów UID. 

WSToolbar Deklaracja paska narzędzi w przestrzeni roboczej. 

Wyświetlacz 0/1 (0) Nie Określa, czy pasek narzędzi ma być wyświetlany (1), czy nie (0). 

pUID Text Yes UID określonego paska narzędzi. Unikalny wśród wszystkich identyfikatorów UID. 

ToolbarOrient
 góra/lewo/dół/pr
awo (float) 

Nie Orientacja paska narzędzi. 

 

rzędy 4-bajtowa liczba całkowita (1) Nie Liczba wierszy przycisków dla paska narzędzi. 

xval 4-bajtowa liczba całkowita (0) Nie Współrzędna X paska narzędzi (względna względem zadokowanego 
paska narzędzi). 

yval 4-bajtowa liczba całkowita (0) Nie Współrzędna Y paska narzędzi (względna w stosunku do 
zadokowanego paska narzędzi). 

WSRibbonTabSourceReference Deklaracja zakładki wstążki w przestrzeni roboczej. Składa się z zestawu 

 
 
 
 
 
 
 
 
 

RibbonSplitButton Przycisk wstążki z elementami podrzędnymi. Składa się z 
elementów RibbonCommandButton. 

UID Text Yes Identyfikator przycisku RibbonSplitButton. Unikalny wśród wszystkich 
identyfikatorów UID. 

ButtonStyle LargeWithText 
(Duży z tekstem) 
/ 
SmallWithoutText 
(Mały bez tekstu) 
/ SmallWithText 
(Mały bez tekstu) 

 NieStyle przycisku. 

 

RibbonCommandButton Zwykły przycisk polecenia. 

UID Text Yes Identyfikator przycisku RibbonCommandButton. Unikalny wśród wszystkich 
identyfikatorów UID. 

MenuMacroID Text Yes Identyfikator przywoływanego MenuMacro. 
 

   WSRibbonPanelSourceReference items. 

Pokaż prawda/fałsz 
(false) 

Nie Pokazuje lub nie pokazuje zakładki wstążki. 

TabId 

WSRibbonPanelSourceReference 

Tekst Tak UID zakładki wstążki, do której jest odwołanie. 

Deklaracja panelu wstążki w przestrzeni roboczej. 

Pokaż prawda/fałsz 
(false) 

Nie Określa, czy panel wstążki ma być wyświetlany, czy nie. 

PanelId 

RibbonPanelSource 

Tekst Tak UID panelu wstążki, do którego jest odwołanie. 

Definicja panelu wstążki. Składa się z zestawu 
RibbonRowitems. 

    

UID Tekst Tak Identyfikator źródła RibbonPanelSource. Unikalny wśród 
wszystkich identyfikatorów UID. 

Nazwa Tekst Tak Nazwa źródła RibbonPanelSource. 

 



ButtonStyle LargeWithText 
(Duży z tekstem) 
/ 
SmallWithoutText 
(Mały bez tekstu) 
/ SmallWithText 
(Mały bez tekstu) 

 NieStyle przycisku. 
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RibbonSeparator Element rozdzielający wstążki. 

UID Text Yes Identyfikator separatora wstążki. Unikalny wśród wszystkich 
identyfikatorów UID. 

SeparatorStyle Line/Spacer 
(Odstęp) 

Nie Styl separatora może być linią lub odstępem. 

 

RibbonControl Może to być jeden z następujących predefiniowanych 
typów: kolor, typ linii, grubość linii, warstwa, styl wydruku, styl 
tekstu lub styl wymiaru. 

UID rbnctrl-layer/ 
rbnctrl-color/ 
rbnctrl-linetype/ 
rbnctrl-lineweight/ 
rbnctrl-printstyle/ 
rbnctrl-textstyle/ 
rbnctrl-dimstyle 

Tak Unikalny wśród wszystkich identyfikatorów UID. Jakikolwiek inny 
identyfikator UID jest niedozwolony. 

 

RibbonTabSource Definicja zakładki wstążki. Składa się z 
zestawu elementów 
RibbonPanelSourceReferenceitems. 

UID Text Yes Identyfikator źródła RibbonTabSource. Unikalny wśród wszystkich 
identyfikatorów UID. 

Nazwa Text Yes Nazwa źródła RibbonTabSource. 

MenuAccelerator 

UID TextYes Identyfikator akceleratora MenuAccelerator. Unikalny wśród wszystkich identyfikatorów 
UID. 

MenuAccelerator.Accelerator 

KeyCombo.AccelChar Tekst ("") Tak Kod klawisza wirtualnego. Użyj liter, cyfr ("A", "B", "C", ... , "1", "2", "3", 
... , "0"), kody klawiszy funkcyjnych ("F1", "F2", "F3", ..., "F16"), Num- 
kody klawiatury ("NUM1", "NUM2", "NUM3", ..., "NUM0", "NUM*", 
"NUM+", "NUM-", "NUMDEL", "NUM/"), niektóre inne kody 
("BACKSPACE", "PAUSE", "PAGEUP", "PAGEDOWN", 
"LEFTARROW", "UPARROW", "RIGHTARROW", 
"DOWNARROW", "INS", "DEL", "END", "HOME"). 

KeyCombo.accKeys Text ("") Tak, 
jeśli 
poprzed
nia to 
litera lub 
cyfra 

Modyfikator przyspieszenia. Dozwolone są następujące 
kombinacje: "CTRL", "ALT", "SHIFT", "CTRL+ALT", 
"ALT+CTRL", "SHIFT+CTRL", "CTRL+SHIFT", "ALT+SHIFT", 
"SHIFT+ALT", "CTRL+ALT+SHIFT", "CTRL+SHIFT+ALT", 
"ALT+SHIFT+CTRL", "ALT+CTRL+SHIFT", "SHIFT+CTRL+ALT", 
"SHIFT+ALT+CTRL". 

 

MenuItem.MacroRef.MenuMacroID Text ("") No Identyfikator makra, które ma być powiązane z tym akceleratorem 

MenuAlias 

UID Text Yes Identyfikator aliasu menu. Unikalny wśród wszystkich identyfikatorów UID. 

Nazwa Text Yes Nazwa aliasu. 

Polecenie Text Yes Polecenie, które ma zostać wywołane dla aliasu. 

MenuGroup 

Nazwa Tekst ("ICAD")  NoName grupy użytkowników. 



MenuMacro 

UID  TextYes Identyfikator MenuMacro. Unikalny wśród wszystkich identyfikatorów UID. 



Wartości 
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Macro.Name.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego nazwy makra. Służy do 
wyodrębniania zlokalizowanego tekstu. 

Macro.Name Text ("") No Domyślna nazwa makra. 

Macro.ToolTip.ID 4 byte  integerNo Identyfikator zasobu tekstowego podpowiedzi makra. Służy do 
wyodrębniania zlokalizowanego tekstu. 

Macro.ToolTip Text Yes Domyślna etykietka makra. 

Macro.HelpString.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego łańcucha pomocy makra. 
Używany do wyodrębnienia zlokalizowanego 

tekst. 

Macro.HelpString Text Yes Domyślny ciąg pomocy makra. 

Macro.Command Text Yes Polecenie makra. 

Macro.SmallImage 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu małej ikony lub ścieżka do lokalnego 
pliku obrazu. 

Macro.LargeImage 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu dużej ikony lub ścieżka do lokalnego 
pliku obrazu. 

Macro.SmallImageHighContrast 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu małej ikony o wysokim 
kontraście lub ścieżka do lokalnej ikony 

plik graficzny. 

Macro.LargeImageHighContrast 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu dużej ikony o wysokim  

kontraście lub ścieżka do lokalnej ikony     plik graficzny. 

Macro.AcadToolbarConversion Text ("") No Służy do wyodrębniania ikony MenuMacro. 
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Makro.Widoczność Tekst 

(CUI_DEFAULT) 

Nie Określa widoczność MenuMacro, skonstruowanego jako przecinek- 
oddzielona konkatenacja następujących wartości, obliczona za 
pomocą logicznego OR zastosowanego do wszystkich 
wartości: 
Widoczność Wartość Opis 

CUI_DOC_DWG .dwg dokument 

CUI_DOC_DGN .dgn dokument 

CUI_DOC_ALL Wszystkie typy dokumentów 

CUI_LEV_BEG Poziom użytkownika: 

Początkujący CUI_LEV_INT Poziom 

użytkownika: Średnio zaawansowany 

CUI_LEV_EXP Poziom użytkownika: 

Ekspert CUI_LEV_ALL Poziom użytkownika: 

Dowolny CUI_MDI_OPN Okno MDI: Co najmniej 

jedno otwarte CUI_MDI_CLS Okno MDI: 

Brak okien MDI CUI_MDI_ALL Okno MDI: 

Dowolny stan MDI CUI_OLE_SEM 

 OLE: Serwer, wbudowany 

CUI_OLE_SIPOLE : Serwer, na miejscu 

CUI_OLE_CLI OLE: Klient 

CUI_OLE_ALL OLE: Dowolny stan OLE 

CUI_VIS_ALLCUI_LEV_ALL , CUI_MDI_ALL, CUI_OLE_ALL 

CUI_SPL_RCM Tylko menu kontekstowe 

(prawy przycisk myszy) CUI_SPL_HIDE

 Ukryj to menu lub przycisk 

CUI_SPL_OSNAP Tymczasowy tryb osnap (kliknięcie prawym 

przyciskiem myszy, gdy polecenie jest aktywne) 

CUI_SPL_CTRL Przycisk jest kontrolką] 

CUI_SPL_NOENT Ignorowanie wszystkich flag 

widoczności encji] CUI_DEFAULT

 Domyślna widoczność: 

 
CUI_LEV_ALL, CUI_MDI_OPN, CUI_MDI_CLS, 

CUI_OLE_CLI 
 

 

Poz
ycja 

Wartości 
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Macro.EntityVisibility 

Należy pamiętać, że ten element 
kontroluje widoczność menu po 
kliknięciu prawym przyciskiem 
myszy, które są przeznaczone do 
wyświetlania tylko wtedy, gdy 
określone jednostki znajdują się w 
zestawie wyboru po kliknięciu 
prawym przyciskiem myszy. Ten 
element jest używany tylko 
wtedy, gdy Macro.Visibility 
zawiera CUI.SPL.RCM. 

Tekst 
(RCM_ENT_ALL) 

 

 
Nie Określa widoczność encji Menu.Macro, skonstruowanej jako 

oddzielona przecinkami konkatenacja następujących 
wartości, obliczona za pomocą logicznego OR 
zastosowanego do wszystkich wartości: 
Widoczność jednostki 
Wartość Opis 

RCM_ENT_PNT Punkt 

RCM_ENT_LIN Linia 

RCM_ENT_RAY Promień 

RCM_ENT_XLN XLine 

RCM_ENT_ARC Arc 

RCM_ENT_CIR Okrąg 

RCM_ENT_ELL Ellipse 

RCM_ENT_SHP Shape 

RCM_ENT_TRC Trace 

RCM_ENT_SLD Solid 

RCM_ENT_3DF 3D Face 

RCM_ENT_3DS 3D Solid 

RCM_ENT_2DP 2D Polyline 

RCM_ENT_3DP 3D Polyline 

RCM_ENT_PFM Polyface Mesh 

RCM_ENT_3DM 3D Mesh 

RCM_ENT_PLN Wszystkie typy polilinii: 

RCM_ENT_2DP, 

RCM_ENT_3DP, 

RCM_ENT_PFM, 

RCM_ENT_3DM 

RCM_ENT_TXT Tekst 

RCM_ENT_INS Wstaw 

RCM_ENT_ATD AttDef 

RCM_ENT_DIM Dimension 

RCM_ENT_LDR Leader 

RCM_ENT_TOL Tolerance 

RCM_ENT_SPL Spline 

RCM_ENT_MTX Mtext 

RCM_ENT_MLN Mline 

RCM_ENT_GRP Group 

RCM_ENT_IMG Image 

RCM_ENT_VPT Viewport 

RCM_ENT_HAT Hatch 

RCM_ENT_RGN Region 

RCM_ENT_BDY Body 

RCM_ENT_XRF Xreferences 

RCM_ENT_IFC Podkład IFC 

RCM_ENT_GMI GeoMap Image 

RCM_ENT_ACS Wszystkie 

jednostki ACIS: 

RCM_ENT_3DS, RCM_ENT_RGN, 

RCM_ENT_BDY 

RCM_ENT_ALL Dowolny podmiot 

RCM_ENT_MUL Ukryj ten element, jeśli wybrano wiele podmiotów 
 

 

Wartości 
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Macro.CheckedExpression Text ("") No Kontroluje, czy przycisk lub element menu jest zaznaczony. 
na podstawie wartości zmiennej systemowej. 

Macro.GreyedOutExpression Text ("") No Kontroluje, czy przycisk lub element menu jest wyszarzony (wyłączony). 
na podstawie wartości zmiennej systemowej. 

Macro.HideExpression Text ("") No Kontroluje, czy przycisk lub element menu jest widoczny na podstawie 
wartość zmiennej systemowej. 

DoubleClickAction 

UID Text Yes Identyfikator akcji DoubleClickAction. Unikalny wśród wszystkich  

   identyfikatorów UID. 

DxfName Text Yes Nazwa DXF typu encji, która ma zostać powiązana z tą akcją dwukrotnego  

   kliknięcia. 

MenuItem.MacroRef.MenuMacroID Text ("") No Identyfikator makra, które ma zostać powiązane z tą akcją dwukrotnego  

   kliknięcia. 

PopMenu 

UID Text Yes Identyfikator PopMenu. Unikalny wśród wszystkich identyfikatorów UID. 

Alias Text Yes  Nazwa odrywania niezależna od języka, zwykle "POPNN", 
gdzie NN jest liczbą. 

Name.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego nazwy menu  

     podręcznego. Używany do wyodrębnienia  

     zlokalizowanej nazwy menu. 

Nazwa Text Yes Domyślna nazwa menu podręcznego. 

PopMenuItem 

IsSeparator prawda/fałsz (false) Nie Określa, czy element menu jest separatorem. 

NameRef.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego nazwy pozycji menu. Używany do  

     wyodrębniania zlokalizowanych 
nazwa pozycji menu. 

NameRef Text ("") NoDefault nazwa pozycji menu. 

MenuItem.MacroRef.MenuMacroID Text ("") No Identyfikator makra, które ma być powiązane z tą pozycją menu. 

PopMenuRef 

pUID Text Yes Identyfikator menu podręcznego, które zostanie powiązane z tą pozycją 
menu jako podmenu. 

Unikalny wśród wszystkich identyfikatorów UID. 

ToolTip.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego podpowiedzi 
pozycji menu. Używany do wyodrębnienia zlokalizowanego 
tekstu. 

ToolTip TextYesDefault menu itemtooltip. 

HelpString.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego ciągu pomocy pozycji menu. 
Służy do wyodrębniania 

zlokalizowany tekst. 

HelpString Text Yes Domyślny ciąg pomocy pozycji menu. 

Widoczność Tekst 
(CUI_DEFAULT) 

Nie Określa widoczność PopMenuRef, skonstruowaną jako 
oddzielona przecinkami konkatenacja wartości, obliczona za 



pomocą logicznego OR 
zastosowanego do wszystkich 
wartości. Szczegółowe informacje 

na temat dostępnych wartości znajdują się w sekcji 
"VisibilityValueDescription" na stronie 776 w tym rozdziale. 
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EntityVisibility Tekst 
(RCM_ENT_ALL) 

Nie Określa widoczność encji PopMenuRef, skonstruowaną jako 
oddzielona przecinkami konkatenacja wartości i obliczona za 
pomocą logicznego OR zastosowanego do wszystkich 
wartości. Aby uzyskać szczegółowe informacje na temat 
dostępnych wartości, patrz "Opis wartości widoczności encji" na 
stronie 777 w tym rozdziale. 

CheckedExpression Text ("") No Kontroluje, czy przycisk lub element menu jest w stanie zaznaczenia 
na podstawie wartości zmiennej systemowej. 

GreyedOutExpression Text ("") No Kontroluje, czy przycisk lub element menu jest wyszarzony (wyłączony). 

na podstawie wartości zmiennej systemowej. 

HideExpression Text ("") No Kontroluje, czy przycisk lub element menu jest widoczny na podstawie 
wartość zmiennej systemowej. 

Pasek narzędzi 

UID Text Yes Identyfikator paska narzędzi. Unikalny wśród wszystkich identyfikatorów 
UID. 

ToolbarOrient float/top/left/right/ 
bottom 
(zmiennoprzec
inkowy) 

Nie Określa orientację paska narzędzi. 

 

ToolbarVisible ukryj/pokaż (hide) Nie Określa, czy pasek narzędzi ma być wyświetlany czy ukrywany. 

rzędy 4-bajtowa liczba całkowita (1) Nie Liczba wierszy przycisków dla paska narzędzi. 

xval 4-bajtowa liczba całkowita (0) Nie Współrzędna X pływającego paska narzędzi i 
zerowy indeks pozycji zadokowanego paska narzędzi. 

yval 4-bajtowa liczba całkowita (0) Nie Współrzędna Y pływającego paska narzędzi i 
zerowy indeks pozycji wiersza dokowania dla zadokowanego 
paska narzędzi. 

Nazwa Text Yes Nazwa paska narzędzi. 

UseOwnIcon prawda/fałsz (false) Nie Określa, czy używać pojedynczej ikony, gdy pasek narzędzi jest używany 
jako 

wylot. 

ToolbarButton 

UID Text Yes Identyfikator przycisku ToolbarButton. Unikalny wśród wszystkich 
identyfikatorów UID. 

IsSeparator prawda/fałsz (false) Nie Określa, czy przycisk jest separatorem. 

NameRef.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego nazwy przycisku. Służy do 
wyodrębniania zlokalizowanego przycisku 

tooltip. 

NameRef Text ("") No Domyślna nazwa przycisku i podpowiedź. 

MenuItem.MacroRef.MenuMacroID Text ("") No Identyfikator makra, które ma być powiązane z tym przyciskiem. 

ToolbarFlyout 

pTargetId 8-bajtowa liczba  całkowitaYes Identyfikator menu podręcznego, które ma być powiązane z tym 
elementem jako wysuwane. 

ToolTip.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego końcówki narzędzia. Używany do 
wyodrębnienia zlokalizowanego tekstu. 

ToolTip Tak Domyślna wysuwana etykietka narzędzia. 

Wartości 



HelpString.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego ciągu pomocy. Służy do 
wyodrębniania zlokalizowanego tekstu. 

HelpString Text Yes Domyślny wysuwany ciąg pomocy. 

SmallImage 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu małej ikony lub ścieżka do 

lokalnego pliku obrazu. 
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LargeImage 4-bajtowa liczba całkowita (0) Identyfikator zasobu  NoImage  dużej 

ikony. SmallImageHighContrast 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu obrazu 

małej ikony o wysokim kontraście. LargeImageHighContrast 4-bajtowa liczba całkowita (0) Nie

 Identyfikator zasobu obrazu dużej ikony o wysokim kontraście. 

AcadToolbarConversion Tekst ("") Nie Służy do wyodrębniania wysuwanej 

ikony. 

Widoczność Tekst 
(CUI_DEFAULT) 

 

 
EntityVisibility Tekst 

(RCM_ENT_ALL) 

Nie Określa widoczność wysuwanego elementu, skonstruowanego 
jako rozdzielona przecinkami konkatenacja wartości, obliczona 
za pomocą logicznego OR zastosowanego do wszystkich 
wartości. Aby uzyskać szczegółowe informacje na temat 
dostępnych wartości, zobacz "Opis wartości 
widoczności" na stronie 776 w tym rozdziale. 

Nie Określa widoczność jednostki dla wylotu, skonstruowana 
jako oddzielona przecinkami konkatenacja wartości i obliczona za 
pomocą logicznego LUB zastosowanego do wszystkich 
wartości. Aby uzyskać szczegółowe informacje na temat 
dostępnych wartości, patrz "Opis wartości widoczności 
podmiotu" na stronie 777 w tym rozdziale. 

CheckedExpression Text ("") No Kontroluje, czy przycisk lub element menu jest w stanie zaznaczenia. 
na podstawie wartości zmiennej systemowej. 

GreyedOutExpression Text ("") No Kontroluje, czy przycisk lub element menu jest wyszarzony (wyłączony). 
na podstawie wartości zmiennej systemowej. 

HideExpression Text ("") No Kontroluje, czy przycisk lub element menu jest widoczny na podstawie 
wartość zmiennej systemowej. 

ToolbarControl 

UID tlbctrl-color/ 
tlbctrl-linetype/ 
tlbctrl-lineweight/ 
tlbctrl-printstyle/ 
tlbctrl-textstyle/ 
tlbctrl- 
dimensionstyle 

 

 
Tak Identyfikator przycisku AppButton. Unikalny wśród wszystkich 

identyfikatorów UID. Każdy inny identyfikator UID jest 
niedozwolony. 

 

HelpString.ID 4-bajtowa liczba całkowita (0) Nie Identyfikator zasobu tekstowego ciągu pomocy. Służy do 
wyodrębniania zlokalizowanego tekstu. 

HelpString Text Yes Domyślny ciąg pomocy sterowania. 

Widoczność Tekst 
(CUI_DEFAULT) 

Nie Określa widoczność paska narzędzi, skonstruowanego jako 
rozdzielona przecinkami konkatenacja wartości, obliczona za 
pomocą logicznego OR zastosowanego do wszystkich 
wartości. Szczegółowe informacje na temat dostępnych 
wartości znajdują się w sekcji "Opis wartości widoczności" 
na stronie 776 w tym rozdziale. 
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Ręczne tworzenie niestandardowych plików paska narzędzi 

W programie ALCAD najłatwiejszym sposobem udostępniania pasków narzędzi 

jest utworzenie nowego pliku .cui za pomocą polecenia Dostosuj interfejs 

użytkownika i udostępnienie tego pliku innym użytkownikom programu ALCAD. 

Aby uzyskać więcej informacji, zobacz "Tworzenie nowego pliku .cui i kopiowanie 

ustawień" na stronie 769 w tym rozdziale. 

Można również ręcznie tworzyć paski narzędzi, które można udostępniać, tworząc lub 

modyfikując plik 

.mnu ręcznie. 
 

Aby ręcznie utworzyć pasek narzędzi, który można udostępniać 

1 Otwórz dowolny edytor tekstu ASCII lub Unicode. 

2 Użyj następującej składni paska narzędzi, aby wpisać definicje paska narzędzi: 

***MENUGROUP=nazwa_grupy 

 
***PASKI NARZĘDZI 

**toolbar_name 

ID_toolbar_name [_Toolbar ("toolbar_name", orient, visible, xval, yval, 

rows)] 

ID_button_name [_Button ("button_name", id_small, id_large)]command 

 
***HELPSTRINGS 

ID_button_name [help_string] 

Składnia i objaśnienia paska narzędzi 
 

group_name Nazwa grupy menu. 

toolbar_name Nazwa paska narzędzi. 

orientacja Orientacja. Wybierz opcję Pływające, Góra, Dół, Lewo i Prawo 
(wielkość liter nie ma znaczenia). 

widoczny Widoczność. Wybierz opcję Pokaż lub Ukryj (wielkość liter nie ma znaczenia). 

xval Współrzędna x, określona w pikselach od lewej krawędzi ekranu. 
Sugerowana wartość: 200. 

yval Współrzędna y, określona w pikselach od górnej krawędzi ekranu. 
Sugerowana wartość: 200. 

wiersze Liczba wierszy 

button_name Nazwa narzędzia. Pojawia się jako ToolTip, gdy użytkownik umieści kursor nad 
przyciskiem. 

id_small Nazwa małego (16 x 16 pikseli) pliku bitmapy ikony (BMP). Plik ten 
musi znajdować się w folderze ALCAD określonym w Narzędzia > 
Opcje > Ścieżki. 

id_large Nazwa dużego (32 x 32 piksele) pliku bitmapy ikony (BMP). Plik ten 
musi znajdować się w folderze ALCAD określonym w Narzędzia > 
Opcje > Ścieżki. 

polecenie Ciąg polecenia (przykład: ̂ Ĉ C_LINE). 

help_string Ciąg pomocy. Pojawia się na pasku stanu po najechaniu kursorem na przycisk. 

 

3 Zapisz plik w folderze ALCAD z rozszerzeniem *.mnu. 
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Przykładowa zawartość pliku paska narzędzi 

***MENUGROUP=przykład 

 
***PASKI NARZĘDZI 

**NewDraw 

ID_ NewDraw [ _Toolbar("NewDraw ", _Bottom, _Show, 200, 200, 1)] 

ID_Line_0 [_Button("Line", Iline.bmp, IL_line.bmp)]^C^C_line 

ID_Hatch [_Button("Hatch", Ihatch.bmp, IL_hatch.bmp)]^C^C_hatch 

ID_Dtext [_Button("Dtext", Idtext.bmp, IL_dtext.bmp)]^C^C_dtext ID 0 

[_Button("Circle Rad", Icirad.bmp, IL_cirad.bmp)]^C^Ccircle; 

ID_Erase [_Button("Erase", Ierase.bmp, IL_erase.bmp)]^C^Cerase; 

 
***HELPSTRINGS 

ID_Line_0 [Tworzy segmenty linii prostej] 

ID_Hatch [Wypełnia zamknięty obszar nieasocjacyjnym wzorem kreskowania] 

ID_Dtext [Wyświetla tekst na ekranie podczas jego wprowadzania] 

ID 0 [Pozwala użytkownikowi narysować okrąg o wartości 

promienia] ID_Erase [Usuwa obiekty z rysunku] 

 

Aby otworzyć plik na innym komputerze 

1 Skopiuj plik paska narzędzi (.mnu) i wszystkie powiązane niestandardowe 

pliki bitmap (*.bmp) do folderu ALCAD na drugim komputerze. 

2 Otwórz ALCAD. 

3 Wykonaj jedną z poniższych czynności, aby wybrać opcję Dostosuj interfejs użytkownika (

 ): 

• Na wstążce wybierz Narzędzia > Dostosuj interfejs użytkownika (w Zarządzaj). 

• W menu wybierz Narzędzia > Dostosuj interfejs użytkownika. 

• Wpisz cui i naciśnij Enter. 

4 Kliknij kartę Transfer. 

5 Po lewej stronie kliknij przycisk Otwórz. 

6 Wybierz nowy plik paska narzędzi, a następnie kliknij Otwórz. 

7 Kliknij przycisk OK. 



 

Dostosowywanie 
podmiotów 

K U S T O M I Z Y K A I N T E L I K A D 783 

 

ALCAD zapewnia sposoby dostosowywania jednostek poza typowymi formatami, 

wymiarami i warstwami. Dalsze dostosowywanie obejmuje korzystanie z 

niestandardowych notatek dźwiękowych i niestandardowych plików kształtów. 

 

Praca z notatkami audio 

W ALCAD można nagrywać i dołączać notatki dźwiękowe, które są klipami 

dźwiękowymi dołączonymi do jednostek i dostępnymi do odtwarzania w dowolnym 

momencie. Na przykład notatki dźwiękowe na planie piętra fabryki mogą opisywać 

czynności konserwacyjne dla określonych obszarów fabryki, a pracownicy mogą 

odtwarzać notatki dźwiękowe, aby usłyszeć instrukcje. 

Gdy do rysunku dołączane są notatki dźwiękowe, są one zapisywane w pliku 

rysunku, a nie w osobnym pliku audio. Należy pamiętać, że może to zwiększyć 

rozmiar pliku rysunku. Notatki dźwiękowe utworzone z istniejącego pliku *.wav są 

również zapisywane w pliku rysunku, a oddzielny plik *.wav pozostaje 

niezmieniony. 

Notatki audio można odtwarzać tylko w programie ALCAD. 

 
Dołączanie notatek dźwiękowych 

Notatki audio można tworzyć z istniejących plików *.wav. Notatkę audio można 

także nagrać przy użyciu dowolnego mikrofonu współpracującego z komputerem. 

Wiele komputerów ma wbudowany mikrofon. Jeśli nie masz mikrofonu i 

nagrywasz notatkę audio, nie będzie ona zawierać dźwięku. 

Ikona notatki dźwiękowej jest wyświetlana na podmiotach, które mają dołączone 

notatki dźwiękowe. Ikona służy wyłącznie do wyświetlania i nie można jej wybrać. 
 

Aby nagrać i dołączyć notatkę dźwiękową do podmiotów 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Audio Note( ):  

• Na wstążce wybierz polecenie Narzędzia > Notatka dźwiękowa (w Zarządzaj). 

• W menu wybierz kolejno Narzędzia > Notatka dźwiękowa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Notatka dźwiękowa. 

• Wpisz audionote i naciśnij Enter. 

2 Wybierz żądane jednostki, a następnie naciśnij Enter. 

3 Wybierz Rekord. 

4 Kliknij przycisk Nagraj, aby rozpocząć notatkę audio, a następnie mów do mikrofonu. 

5 Kliknij Stop, aby zakończyć notatkę audio. 

6 Aby przetestować notatkę dźwiękową, kliknij przycisk Test, a następnie użyj 

opcji Pauza i Stop w obszarze Testuj notatkę dźwiękową. 

7 W razie potrzeby można ponownie nagrać notatkę dźwiękową. Spowoduje to 

zastąpienie poprzedniej notatki dźwiękowej dla podmiotów wybranych w 

kroku 2. 

8 Kliknij przycisk Załącz. 
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Notatkę dźwiękową można zmodyfikować po dołączeniu jej do podmiotu. 

Wybierz podmiot i ponownie nagraj notatkę audio, wykonując poprzednie kroki. 
 

 
Aby dołączyć notatkę dźwiękową do podmiotów przy użyciu pliku .wav 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Audio Note (  ): 

• Na wstążce wybierz polecenie Narzędzia > Notatka dźwiękowa (w Zarządzaj). 

• W menu wybierz kolejno Narzędzia > Notatka dźwiękowa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Notatka dźwiękowa. 

• Wpisz audionote i naciśnij Enter. 

2 Wybierz żądane jednostki, a następnie naciśnij Enter. 

3 Wybierz opcję Dołącz. 

4 Wybierz żądany plik *.wav, a następnie kliknij Otwórz. 

 
Wybieranie notatek audio 
Nie można wybierać samych notatek dźwiękowych. Zamiast tego należy wybrać 

jednostkę, która odpowiada żądanej nucie dźwiękowej. 

Ikona notatki dźwiękowej jest wyświetlana na podmiotach, które mają dołączone 

notatki dźwiękowe. Ikona służy wyłącznie do wyświetlania i nie można jej wybrać. 

 

Na jednostce wyświetlana jest ikona notatki dźwiękowej, oznaczająca, 
że do jednostki dołączona jest notatka dźwiękowa. 

Aby wybrać notatki audio 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Audio Note (  ): 

• Na wstążce wybierz polecenie Narzędzia > Notatka dźwiękowa (w Zarządzaj). 

• W menu wybierz kolejno Narzędzia > Notatka dźwiękowa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Notatka dźwiękowa. 

• Wpisz audionote i naciśnij Enter. 

2 Wybierz podmiot, który jest dołączony do żądanej notatki dźwiękowej, a 

następnie naciśnij klawisz Enter. Nie można wybrać ikony notatki dźwiękowej 

wyświetlanej na jednostce. 

3 Wybierz opcję, aby kontynuować pracę z notatkami audio. 
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Użyj zmiennych systemowych. 

Wygląd ikon notatek audio można zmienić za pomocą zmiennych systemowych 

AUDIOICON, AUDIO- ICONCOLOR i AUDIOICONSCALE. 
 

 
Odtwarzanie notatek audio 

Aby odtwarzać notatki audio 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Audio Note (  ): 

• Na wstążce wybierz polecenie Narzędzia > Notatka dźwiękowa (w Zarządzaj). 

• W menu wybierz kolejno Narzędzia > Notatka dźwiękowa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Notatka dźwiękowa. 

• Wpisz audionote i naciśnij Enter. 

2 Wybierz jednostkę zawierającą nutę audio, którą chcesz odtworzyć, a następnie naciśnij 

klawisz Enter. 

3 Wybierz opcję Odtwarzanie. 

4 W oknie dialogowym Odtwarzanie wykonaj następujące czynności: 

• Kliknij przycisk Odtwórz, aby rozpocząć odtwarzanie. 

• Aby tymczasowo wstrzymać odtwarzanie notatki dźwiękowej, kliknij 

przycisk Pauza, a następnie kliknij przycisk Wznów, aby kontynuować. 

• Kliknij Stop, aby zakończyć odtwarzanie. 

5 Kliknij przycisk OK. 

 
Usuwanie notatek audio 
Można usunąć notatki dźwiękowe z wybranych podmiotów. W niektórych 

przypadkach może być konieczne usunięcie dodatkowych notatek dźwiękowych w 

celu zmniejszenia rozmiaru pliku rysunku. 

Po usunięciu notatki dźwiękowej z jednostki, jest ona usuwana na stałe i nie 

można jej odzyskać. Jeśli jednak notatka dźwiękowa została utworzona przy 

użyciu istniejącego pliku *.wav, plik ten nie zostanie usunięty. 
 

Aby usunąć notatki audio 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Audio Note (  ): 

• Na wstążce wybierz polecenie Narzędzia > Notatka dźwiękowa (w Zarządzaj). 

• W menu wybierz kolejno Narzędzia > Notatka dźwiękowa. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Notatka dźwiękowa. 

• Wpisz audionote i naciśnij Enter. 

2 Wybierz jednostki zawierające notatki dźwiękowe, które chcesz usunąć, a następnie naciśnij 

klawisz Enter. 

3 Wybierz Usuń. 
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Korzystanie z plików kształtów 

Kształty to elementy definiowane do użycia jako symbole rysunkowe i czcionki 

tekstowe. Podczas dodawania każdego kształtu można określić jego skalę i obrót. 

Aby użyć plików kształtów, należy najpierw załadować skompilowany plik kształtu, 

który definiuje kształt. Następnie należy wstawić kształty z pliku do rysunku. 
 

Aby załadować plik kształtu 

1 Wpisz load i naciśnij Enter. 

2 W oknie dialogowym Wczytaj plik kształtu wybierz plik kształtu. 

3 Kliknij OK, aby zamknąć okno dialogowe Wczytaj plik kształtu. 
 

Aby użyć pliku kształtu 

1 Wpisz shape i naciśnij Enter. 

2 Wpisz nazwę kształtu i naciśnij Enter. 

3 Określ punkt wstawienia. 

4 Określ wysokość. 

5 Określenie kąta obrotu. 

 

 
 

Tworzenie i odtwarzanie skryptów 
 

ALCAD może rejestrować wszystko, co wpisujesz na klawiaturze i wszystkie 

punkty wybrane na rysunku. Wszystkie te działania można zapisać w pliku skryptu 

(z rozszerzeniem *.scr), a następnie powtórzyć je, odtwarzając skrypt. Skryptów 

można używać do skutecznego powtarzania poleceń, wyświetlania migawek w 

pokazie slajdów lub drukowania wsadowego. Można także ładować i uruchamiać 

pliki skryptów utworzone do użytku z programem AutoCAD. 

 

Zrozumienie skryptów 

ALCAD obsługuje większość plików dostosowywania AutoCAD, w tym menu, 

pliki skryptów i procedury LISP. ALCAD używa kompatybilnych typów linii, 

wzorów kreskowania, translacji jednostek i aliasów poleceń, ale można również 

zastąpić je własnymi plikami. Funkcja ta pozwala na kontynuowanie pracy z 

ulubionym, dostosowanym środowiskiem kreślarskim. 

Skrypt jest formą pliku tekstowego. Plik skryptu zawiera jeden wiersz tekstu lub 

innych danych dla każdej akcji. Na przykład po wpisaniu polecenia i naciśnięciu 

klawisza Enter jest ono zapisywane w jednym wierszu w pliku skryptu. Po wybraniu 

punktu na rysunku współrzędna tego punktu jest zapisywana w wierszu pliku 

skryptu. Pliki skryptów można również tworzyć poza programem ALCAD za 

pomocą edytora tekstu (takiego jak Microsoft® Notepad lub Microsoft® WordPad) lub 

programu do edycji tekstu (takiego jak Microsoft® Word), który zapisuje plik w 

formacie ASCII. Typ i rozszerzenie pliku musi być .scr. 
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Pliki skryptów mogą zawierać komentarze. Każda linia rozpoczynająca się 

średnikiem jest uważana za komentarz. Program ignoruje te linie podczas odtwarzania 

skryptu. Funkcja Cofnij powoduje cofnięcie ostatniego polecenia wykonanego 

przez skrypt. 

ALCAD ulepsza skrypty, AutoLISP i ADS, zapewniając dodatkowe funkcje. W 

przypadku skryptów ALCAD zawiera rejestrator skryptów, który rejestruje zarówno 

wpisy w wierszu poleceń, jak i ruchy na ekranie wykonywane za pomocą myszy. 

 

Nagrywanie skryptów 

Po aktywowaniu rejestratora skryptów, każde wprowadzone z klawiatury polecenie 

i wszystkie punkty wybrane na rysunku są rejestrowane do momentu zatrzymania 

rejestratora skryptów. Skrypt można odtworzyć w dowolnym momencie. 

 

UWAGA 

Rejestrator skryptów nie rejestruje korzystania z pasków narzędzi, menu ani okien 

dialogowych. Korzystanie z tych elementów podczas nagrywania skryptu powoduje 

nieprzewidywalne rezultaty. 
 

 
Aby nagrać skrypt 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Nagraj skrypt (  ): 

• Na wstążce wybierz Narzędzia > Nagraj skrypt (w Aplikacjach). 

• W menu wybierz Narzędzia > Nagraj akcje > Nagraj skrypt. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Nagraj skrypt. 

• Wpisz recscript i naciśnij Enter. 

2 Podaj nazwę pliku skryptu, który chcesz utworzyć. 

3 Kliknij przycisk Zapisz. 

4 Wpisywanie poleceń na klawiaturze. 

Rejestrator skryptów rejestruje wszystkie polecenia wprowadzane z klawiatury i 

wszystkie punkty wybrane na rysunku, zapisując wszystko w pliku skryptu. 
 

Aby zatrzymać nagrywanie 

1 Wykonaj jedną z poniższych czynności, aby zatrzymać nagrywanie (  ): 

• Na wstążce wybierz Narzędzia > Zatrzymaj nagrywanie (w Aplikacjach). 

• W menu wybierz kolejno Narzędzia > Czynności nagrywania > Zatrzymaj nagrywanie. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Zatrzymaj nagrywanie. 

• Wpisz stopcript i naciśnij Enter. 
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Odtwarzanie skryptów 

Aby odtworzyć skrypt 

1 Wykonaj jedną z poniższych czynności, aby wybrać (  ): 

• Na wstążce wybierz Narzędzia > Uruchom skrypt (w Aplikacjach). 

• W menu wybierz Narzędzia > Nagraj akcje > Uruchom skrypt. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Uruchom skrypt. 

• Wpisz script i naciśnij Enter. 

2 W oknie dialogowym Uruchom skrypt podaj nazwę pliku skryptu, który chcesz uruchomić. 

3 Kliknij przycisk Otwórz. 

Program natychmiast uruchamia skrypt, wykonując wszystkie pierwotnie 

zarejestrowane czynności. 
 

Kliknij dwukrotnie plik skryptu. 

Aby automatycznie wywołać skrypt po załadowaniu programu ALCAD, w 

Eksploratorze Windows kliknij dwukrotnie plik skryptu. 
 

 
Modyfikowanie skryptów 

Aby dołączyć do ascript 

1 Wykonaj jedną z poniższych czynności, aby wybrać opcję Nagraj skrypt (  ): 

• Na wstążce wybierz Narzędzia > Nagraj skrypt (w Aplikacjach). 

• W menu wybierz Narzędzia > Nagraj akcje > Nagraj skrypt. 

• Na pasku narzędzi Narzędzia kliknij narzędzie Nagraj skrypt. 

• Wpisz rescript i naciśnij Enter. 

2 W oknie dialogowym Record Script zaznacz pole wyboru Append To Script. 

3 Wybierz istniejący plik skryptu do dodania. 

4 Kliknij przycisk Zapisz. 

5 Kliknij przycisk Yes (Tak) w odpowiedzi na pytanie, czy chcesz zastąpić istniejący skrypt. 

6 Powtórz tę procedurę, aby wprowadzić dodatkowe polecenia i kroki. 



 

Programowanie 
ALCAD 
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Innym sposobem dostosowania ALCAD jest dodanie niestandardowych programów 

napisanych w dowolnym z kilku języków programowania, które działają w 

ALCAD, w tym następujących: TX, .NET, LISP, SDS, DCL, VBA i DIESEL. 

W ALCAD można uruchamiać wiele programów pierwotnie stworzonych do 

użytku z AutoCAD. W szczególności można używać programów napisanych w 

całości w AutoLISP bez żadnych modyfikacji. Ponadto można uruchamiać wiele 

programów ADS napisanych pierwotnie do użytku w programie AutoCAD po 

uprzednim przekompilowaniu ich przy użyciu bibliotek run-time programu 

ALCAD. Wiele programów AutoCAD innych producentów jest kompatybilnych z 

ALCAD. 

 

Skorzystaj z pomocy online. 

Aby uzyskać informacje na temat programowania dla ALCAD, zobacz pomoc online 

dla ALCAD Developer's Reference. 
 

 
Korzystanie z TX 

Interfejs TX jest dostępny dla programistów do tworzenia niestandardowych 

jednostek i aplikacji. 
 

Aby załadować niestandardową aplikację TX/IRX 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Załaduj aplikację (w Aplikacje). 

• W menu wybierz Narzędzia > Załaduj aplikację. 

• Wpisz appload i naciśnij Enter. 

• Przeciągnij i upuść plik TX lub IRX do programu ALCAD. 

2 W oknie dialogowym Wczytaj pliki aplikacji kliknij przycisk Dodaj plik. 

3 Wybierz plik TX lub IRX, który chcesz załadować, a następnie kliknij Otwórz. 

4 Kliknij przycisk OK. 
 

Aby uruchomić niestandardową aplikację TX/IRX 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Załaduj aplikację (w Aplikacje). 

• W menu wybierz Narzędzia > Załaduj aplikację. 

• Wpisz appload i naciśnij Enter. 

2 W oknie dialogowym Load Application Files wybierz procedurę, którą 

chcesz uruchomić (upewnij się, że jest to jedyna wybrana procedura), a 

następnie kliknij przycisk Load. 
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Więcej informacji 

• Zobacz przykładowe aplikacje TX i IRX. 

• Zapoznaj się z dokumentacją online dla TX i IRX, dostępną w Odniesieniach dla 

programistów w Pomocy ALCAD. 

 
Korzystanie z aplikacji .NET 

ALCAD obsługuje język programowania .NET na dwa sposoby: 

• .NET Classic - Bardziej zbliżony do interfejsu .NET używanego przez AutoCAD. 

• .NET oparty na COM - Początkowy interfejs .NET obsługiwany przez ALCAD. 

Aby przygotować niestandardową aplikację .NET 

1 W aplikacji .NET odziedzicz interfejs IICadPlugin, który jest zdefiniowany w 

Intelli- CAD jako: 

Interfejs publiczny IIcadPlugin 

{ 

void PluginLoaded(object sender, EventArgs e); 

void PluginUnLoading(object sender, EventArgs e); 

} 

Gdzie PluginLoaded() jest wywoływana przy ładowaniu wtyczki, 

argumentem nadawcy jest klasa modelu COM Interop ALCAD.Application 

do pracy z nią (przechowywanie jej jako członka klasy), a 

PluginUnLoading() jest wywoływana tuż przed rozładowaniem wtyczki. 
 

Aby załadować niestandardową aplikację .NET Classic 

1 Wykonaj jedną z poniższych czynności: 

• W menu wybierz Narzędzia > Załaduj klasyczną aplikację .NET. 

• Wpisz netload i naciśnij Enter. 

2 W oknie dialogowym Open an Assembly wybierz plik .NET .dll, który chcesz 

załadować, a następnie kliknij przycisk Open. 

Aby automatycznie załadować niestandardową aplikację .NET Classic podczas 
uruchamiania programu ALCAD 

1 Utwórz plik ASCII o nazwie ICAD.NET, który zawiera ścieżkę do pliku 

wtyczki .NET w każdym wierszu pliku. 

2 Umieść ICAD.NET w tym samym folderze co ICAD.EXE. 

3 Uruchom ALCAD. 

 
Korzystanie z procedur LISP 

ALCAD obsługuje język programowania LISP i jest kompatybilny z AutoLISP, 

implementacją języka LISP w AutoCAD. Oznacza to, że można załadować i 

uruchomić dowolny program AutoLISP napisany do użytku z AutoCAD. 
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Aby załadować procedurę LISP 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Załaduj aplikację (w Aplikacje). 

• W menu wybierz Narzędzia > Załaduj aplikację. 

• Wpisz appload i naciśnij Enter. 

• Przeciągnij i upuść plik LISP do ALCAD. 

2 W oknie dialogowym Wczytaj pliki aplikacji kliknij przycisk Dodaj plik. 

3 Wybierz plik LISP, który chcesz załadować, a następnie kliknij Otwórz. 

4 Kliknij przycisk OK. 
 

Ładowanie procedur LISP z paska poleceń. 

W pasku poleceń wpisz (load "d:/path/routine.lsp"), pamiętając o uwzględnieniu 

nawiasów i cudzysłowów, gdzie d:/path to dysk i ścieżka, na której znajduje się 

procedura LISP na komputerze, a routine.lsp to nazwa pliku procedury LISP. 
 

 
Aby uruchomić procedurę LISP 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Załaduj aplikację (w Aplikacje). 

• W menu wybierz Narzędzia > Załaduj aplikację. 

• Wpisz appload i naciśnij Enter. 

2 W oknie dialogowym Wczytaj pliki aplikacji wybierz procedurę, którą 

chcesz uruchomić (upewnij się, że jest to jedyna wybrana procedura), a 

następnie kliknij przycisk Wczytaj. 

Niektóre procedury LISP są tworzone w taki sposób, że można je uruchomić, 

wpisując nazwę procedury lub słowo kluczowe bezpośrednio na pasku poleceń. Jeśli 

nic się nie dzieje, gdy próbujesz uruchomić procedurę LISP z poziomu okna 

dialogowego Wczytaj pliki aplikacji, włącz wyświetlanie paska poleceń lub okna 

historii wierszy, wybierając Widok > Wyświetlanie > Pasek poleceń lub Widok > 

Wyświetlanie > Okno historii wierszy i poszukaj wpisu podobnego do poniższego: 

Ładowanie 

D:\path\routine.lsp 

C:KEYWORD 

gdzie D:\path\routine.lsp to pełny dysk, ścieżka i nazwa pliku procedury LISP. Konieczne 

może być przewinięcie kilku wierszy w pasku poleceń lub oknie historii wiersza 

polecenia, aby znaleźć wiersze wskazujące miejsce załadowania procedury LISP. 

Procedurę LISP można uruchomić, wpisując nazwę procedury lub słowo kluczowe 

pojawiające się po oznaczeniu dysku C. 
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Na przykład, jeśli załadowano procedurę LISP o nazwie drawbox.lsp i na pasku 

poleceń lub w oknie historii wiersza polecenia widoczny jest identyfikator 

C:DRAWBOX, można uruchomić procedurę LISP, wpisując drawbox na pasku 

poleceń. 

 

Korzystanie z aplikacji SDS 

Do pisania aplikacji AutoCAD w języku C lub C++, Autodesk® używa ADS (AutoCAD 

Development System). Jest to API (interfejs programowania aplikacji), który 

zapewnia bibliotekę dostępu do funkcji i danych rysunkowych specyficznych dla 

AutoCAD. 

Odpowiednik w ALCAD nosi nazwę SDS™, czyli Solutions Development 

System™. SDS jest interfejsem języka C/C++ kompatybilnym z interfejsem ADS w 

AutoCAD. Podobnie jak skrypty i AutoLISP, można uruchamiać istniejące 

aplikacje ADS w ALCAD. Wystarczy przekompilować kod źródłowy przy użyciu 

bibliotek SDS dostarczonych na płycie CD-ROM ALCAD lub, jeśli używasz 

programu AutoCAD napisanego przez innego dostawcę, skontaktuj się z nim, aby 

uzyskać wersję ALCAD. 

ALCAD udostępnia plik Sds.H, który redefiniuje nazwy funkcji ADS na ich 

odpowiedniki SDS. SDS obsługuje język sterowania dialogami AutoCAD (DCL), 

który jest używany przez ADS do definiowania wyglądu okna dialogowego. 

Można używać wszystkich plików DCL niezmodyfikowanych w SDS. 

 

Zrozumienie zgodności z SDS 

Podstawową różnicą między ADS i SDS jest to, że wszystkie funkcje SDS mają 

prefiks sds_, a funkcje ADS mają różne prefiksy, takie jak ads_, acad_ i acrx_. 

Wyjątkiem są funkcje SDS związane z oknami dialogowymi, które mają prefiks 

dlg_. ALCAD akceptuje każdy z tych prefiksów. Inne różnice obejmują dodatkowe 

funkcje SDS wymienione w poniższej tabeli. 

 
Funkcje SDS bez odpowiednika ADS 

 

sds_grclear Czyści całą grafikę z okna rysowania; podobne do funkcji LISP 
(grclear). 

sds_name_clear Czyści nazwę podmiotu lub zestaw wyboru. 

sds_name_equal Sprawdza, czy dwie nazwy encji lub zestawy selekcji są równe. 

sds_name_nil Sprawdza, czy nazwa podmiotu lub zestaw wyboru 
zostały wyczyszczone. 

sds_name_set Kopiuje jedną nazwę podmiotu lub zestaw wyboru do innego rysunku. 

sds_pmtssget Podobna do funkcji ads_ssget, ale umożliwia wyświetlenie 
monitu odpowiedniego dla konkretnego polecenia, a nie 
ogólnego monitu "Wybierz obiekt". 

sds_point_set Kopiuje punkt z jednej zmiennej do drugiej. 

sds_progresspercent Wyświetla procent wykonania na pasku 

postępu. sds_progressstart Uruchamia pasek postępu. 

sds_progressstop Kończy działanie paska postępu. 
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Funkcje SDS bez odpowiednika ADS 
 

sds_readaliasfile Wczytuje plik PGP do ALCAD. 

sds_sendmessage Wysyła wiadomość do wiersza poleceń ALCAD. 

sds_swapscreen Przerzuca kontekst urządzenia poza ekran na 

wyświetlacz. 

 

Niektóre funkcje ADS nie są obsługiwane w SDS, w tym: ads_arxload, 

ads_arxloaded, ads_arxunload, ads_ssgetx, ads_ssGetKwordCallbackPtr, 

ads_ssGetOtherCallbackPtr, adsw_acadMainWnd i adsw_acadDocWnd. 
 

Więcej informacji 

• Zapoznaj się z dokumentacją online funkcji SDS. 

• Zobacz folder \ALCAD\Api\Sds, który zawiera pliki SDS include, 

nagłówkowe i biblioteczne. 

• Zobacz folder \ALCAD\Api\Dcl, który zawiera podstawowe pliki DCL. 
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Korzystanie z aplikacji DDE 

ALCAD obsługuje interfejs API DDE, który umożliwia wykonywanie poleceń 

ALCAD w wierszu poleceń z zewnętrznej aplikacji. ALCAD zawiera przykładową 

aplikację wiersza poleceń, która odczytuje plik skryptu i wysyła go do ALCAD w 

celu wykonania krok po kroku. 
 

Aby zobaczyć przykład wykonania skryptu DDE 

1 Skompiluj kod źródłowy projektu DDESample. Przykładowa aplikacja 

znajduje się pod adresem: 

Źródło\ALCAD\api\DDE\Próbki\DDESample 

2 Uruchom ALCAD. 

3 Uruchom aplikację DDESample z przykładowym plikiem skryptu dołączonym 

do projektu VC. 

ALCAD pokazuje wyniki. 

 
Używanie DCL z ALCAD 

ALCAD w pełni obsługuje AutoCAD DCL (język sterowania oknami 

dialogowymi). DCL jest używany przez funkcje AutoLISP do definiowania wyglądu 

okien dialogowych. Możesz używać wszystkich plików DCL bez modyfikacji w 

ALCAD. 

 

Korzystanie z VBA 

ALCAD można dostosować za pomocą Visual Basic for Applications (VBA) 

poprzez zintegrowany interfejs, dostępny z menu ALCAD Tools. ALCAD oferuje 

szeroką gamę obiektów, dając możliwość pisania własnych aplikacji, które mogą 

być uruchamiane w ALCAD. 
 

Aby załadować projekt VBA 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Załaduj projekt VBA (w Aplikacjach). 

• W menu wybierz Narzędzia > Visual Basic > Załaduj projekt VBA. 

• Wpisz vbiload i naciśnij Enter. 

2 Zlokalizuj i wybierz plik projektu Visual Basic (plik .vbi) do załadowania, a następnie 

kliknij Otwórz. 
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Aby uruchomić makro VBA 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Makra (w Aplikacjach). 

• W menu wybierz Narzędzia > Visual Basic > Makra. 

• Wpisz vbarun i naciśnij Enter. 

2 W oknie dialogowym Uruchom makro ALCAD VBA wprowadź nazwę 

istniejącego makra VBA, a następnie kliknij Uruchom. 

Z poziomu tego okna dialogowego można także tworzyć, usuwać i edytować makra VBA. 
 

Aby edytować makro VBA 

Zaawansowany poziom doświadczenia 

1 Wykonaj jedną z poniższych czynności: 

• Na wstążce wybierz Narzędzia > Edytor Visual Basic (w Aplikacje). 

• W menu wybierz Narzędzia > Visual Basic > Edytor Visual Basic. 

• Wpisz vba i naciśnij Enter. 

2 Użyj edytora Visual Basic do pisania lub debugowania makr VBA. 
 

Więcej informacji 

• Zapoznaj się z dokumentacją online dla VBA, dostępną z menu Pomoc edytora i 

menu Pomoc ALCAD. 

• Dostępnych jest wiele publikacji wyjaśniających, jak programować w VBA. 

 
Używanie DIESEL z ALCAD 

ALCAD obsługuje AutoCAD DIESEL (Direct Interactively Evaluated String 

Expression Language). DIESEL to oddzielny interpretowany język programowania, 

który umożliwia dostosowanie następujących elementów: 

• Pasek stanu 

• Menu 

• Funkcje LISP 

Więcej informacji 

• Przeczytaj dokumentację online dla DIESEL, dostępną w pomocy ALCAD. 

• W Internecie dostępnych jest kilka publikacji i samouczków wyjaśniających, 

jak korzystać z DIESEL. 
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Korzystanie z tabletu z digitizerem 
 

ALCAD obsługuje tablety zgodne ze sterownikiem TabletWorks i posiada własną 

nakładkę na tablet. Instrukcje dotyczące instalacji sterownika tabletu i korzystania z 

przycisków na urządzeniu wskazującym można znaleźć w dokumentacji sprzętu. 

W przypadku polecenia Tablet dostępne są trzy opcje: 

• Konfiguracja Mapy nakładki tabletu na sam tablet. Skonfiguruj tablet, jeśli 

planujesz wybrać narzędzia ALCAD z nakładki tabletu. 

• Kalibracja Mapuj punkty na tablecie we współrzędnych bezwzględnych z 

punktami na rysunku. Tablet należy skalibrować w celu digitalizacji punktów. 

Proces ten jest wygodny w przypadku śledzenia rysunków na papierze. 

• Włącza lub wyłącza kalibrację tabletu (tryb digitizera). Służy do przełączania 

między wyborem narzędzia a wprowadzaniem danych przez digitizer. Aby 

użyć tabletu do wyboru narzędzia, tryb tabletu musi być wyłączony. 

 

Konfiguracja tabletu 

Przed rozpoczęciem konfigurowania tabletu należy wsunąć nakładkę na tablet pod 

plastikową pokrywę karty i wyrównać ją zgodnie z instrukcjami dla danego 

tabletu. Jeśli tablet nie jest wyposażony w plastikową pokrywę, należy wyrównać 

otwory nakładki z kołkami w tablecie. 

ALCAD zapewnia domyślną konfigurację dla tabletów o wymiarach 12" na 12". 

Jeśli zdecydujesz się zaakceptować ustawienia domyślne, upewnij się, że polecenia 

w siatce są wykonywane prawidłowo. Jeśli domyślne wyrównanie nie działa w przypadku 

tabletu, konieczne będzie ponowne rozpoczęcie procesu konfiguracji i samodzielne 

wyrównanie tabletu. 
 

Aby skonfigurować tablet do wprowadzania menu 

1 Wykonaj jedną z poniższych czynności: 

• W menu wybierz kolejno Narzędzia > Tablet > Konfiguruj. 

• Wpisz tablet, wybierz Configure, a następnie naciśnij Enter. 

2 W odpowiedzi na monit o wyrównanie tabletu wykonaj jedną z poniższych czynności: 

• Jeśli tablet ma wymiary 12" na 12", wybierz opcję Nie, aby 

zaakceptować domyślne wyrównanie i zakończyć proces konfiguracji. 

• Aby samodzielnie wyrównać tablet, wybierz opcję Tak, a następnie przejdź do kroku 3. 

3 Kliknij wskaźnikiem tabletu lewy górny punkt wyrównania nakładki   

4 Kliknij wskaźnikiem tabletu lewy dolny punkt wyrównania nakładki   

5 Kliknij wskaźnik tabletu w prawym dolnym punkcie wyrównania nakładki   

6 Kliknij wskaźnik tabletu w lewym dolnym punkcie wyrównania obszaru obszaru 

roboczego nakładki   



K U S T O M I Z Y K A I N T E L I K A D 797 

 
 

7 Kliknij wskaźnik tabletu w prawym górnym rogu obszaru obszaru roboczego 

nakładki   
 

Klikaj punkty w pokazanej kolejności, aby skonfigurować tablet do wprowadzania menu. 

 
Aby włączyć lub wyłączyć tryb tabletu 

1 Wykonaj jedną z poniższych czynności: 

• Wybierz kolejno Narzędzia > Tablet > Tablet włączony (lub Tablet wyłączony). 

• Wpisz tablet, wybierz opcję Wł. lub Wył., a następnie naciśnij klawisz Enter. 

• Naciśnij klawisz F4, aby włączyć lub wyłączyć tryb tabletu. 

• Na pasku stanu kliknij dwukrotnie TABLET, aby włączyć lub wyłączyć tryb tabletu. 

 

Kalibracja tabletu 

Do kalibracji tabletu należy określić co najmniej dwa punkty. Jednak im więcej 

punktów zostanie określonych, tym dokładniejsza będzie transformacja między tabletem a 

punktami na ekranie. Określenie dodatkowych punktów jest szczególnie przydatne 

w przypadku planowania śledzenia rysunku na papierze, który nie jest ortogonalny, 

np. zdjęcia lotniczego. 

 

Zrozumienie typów transformacji 

W zależności od liczby określonych punktów, masz wybór typów transformacji do 

użycia, wraz z typem zalecanym dla ALCAD. 

Transformacja odnosi się do obliczania punktów na ekranie, które odpowiadają 

punktom zdigitalizowanym na tablecie. 

• Ortogonalne Zachowuje wszystkie kąty między liniami, zachowuje wszystkie 

względne odległości i ogólnie zachowuje kształty. W przypadku określenia 

tylko dwóch punktów automatycznie generowane jest przekształcenie 

ortogonalne. Typ przekształcenia ortogonalnego zapewnia najdokładniejsze 

odwzorowanie pomiędzy zdigitalizowanymi punktami na tablecie i 

odpowiadającymi im punktami na ekranie. 
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• Affine Zachowuje linie równoległe, ale niekoniecznie kąty między 

przecinającymi się liniami. Jeśli określono trzy punkty, ALCAD nie może już 

reprezentować tego mapowania jako dokładnej transformacji ortogonalnej. 

Dlatego masz do wyboru dokładną transformację afiniczną lub "najlepiej 

dopasowaną" transformację ortogonalną. 

• Rzutowanie Nie zachowuje linii równoległych ani kątów. Jeśli określisz 

dokładnie cztery punkty, masz do wyboru dokładną transformację rzutową lub 

"najlepiej dopasowaną" transformację ortogonalną lub afiniczną. 

 
Zalecane i "najlepiej dopasowane" typy transformacji 

 
 zalecany  

2 Ortogonalny Brak 

3 Affine Ortogonalny 

4 Projekcyjny Ortogonalne, afiniczne 

5-10 Brak Ortogonalne, afiniczne 

 
Wybierz zalecany typ, chyba że wiesz, że nie będzie on odpowiedni do digitalizacji. 

Najodpowiedniejszym typem nie zawsze jest ten z najmniejszym błędem; na 

przykład można zdigitalizować trzy punkty i wybrać transformację ortogonalną, mimo że 

transformacja afiniczna zapewniłaby bliższe odwzorowanie wpisów kalibracyjnych. 
 

Digitalizacja poprzez wybranie punktów (1, 2, 3 i 4) na tablecie.  Odpowiednie współrzędne ekranu: 

1 Specyfikacja współrzędnych X0, Y0, Z0 

2 Specyfikacja współrzędnych X0, Y5, Z0 

3 Specyfikacja współrzędnych X5, Y5, Z0 

4 Specyfikacja współrzędnych X5, Y0, Z0 
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Ekranowy wynik transformacji ortogonalnej po 
obrysowaniu polilinii na tablecie. 

 
 

Ekranowy wynik transformacji 
afinicznej po prześledzeniu polilinii 
na tablecie. 

 
 

Ekranowy wynik transformacji projekcyjnej po 
prześledzeniu polilinii na tablecie. 

 
 

Aby skalibrować tablet do digitalizacji punktów 

1 Wykonaj jedną z poniższych czynności: 

• Wybierz kolejno Narzędzia > Tablet > Kalibruj. 

• Wpisz tablet, wybierz opcję Kalibruj, a następnie naciśnij klawisz Enter. 

2 Kliknij punkt na tablecie, aby zdefiniować go jako pierwszy punkt kalibracji. 

3 Określ punkt w oknie rysowania programu ALCAD odpowiadający punktowi 

zdigitalizowanemu na tablecie lub wprowadź wartości współrzędnych na 

pasku poleceń. 

4 Kliknij punkt na tablecie, który ma zostać zdefiniowany jako drugi punkt kalibracji. 

Określ punkt w oknie rysunku programu ALCAD odpowiadający punktowi 

zdigitalizowanemu na tablecie lub wprowadź wartości współrzędnych na pasku 

poleceń. Aby określić więcej niż dwa wymagane punkty, kliknij punkt na 

tablecie, aby zdefiniować go jako trzeci punkt kalibracji. Można wprowadzić do 

10 punktów. 

5 Wybierz typ transformacji, a następnie naciśnij klawisz Enter. 

 
Dostosowywanie interfejsu tabletu 

Interfejs tabletu digitizera można dostosować za pomocą poleceń LISP 

zintegrowanych z programem ALCAD, nawet jeśli użytkownik nie jest 

zaznajomiony z LISP. Instrukcje można znaleźć w sekcji "Dostosowywanie 

interfejsu tabletu" w pomocy online programu ALCAD. 
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ALCAD został zaprojektowany tak, aby współpracować z AutoCAD tak płynnie, jak 

to tylko możliwe. Istnieją jednak pewne różnice, do których osoby przyzwyczajone 

do pracy w programie AutoCAD mogą potrzebować się dostosować. Niniejszy 

dodatek zawiera informacje przeznaczone specjalnie dla tych osób. 
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Ulepszony 

802 A P E N D I X 

 

Korzystanie z rozszerzonych poleceń AutoCAD w ALCAD 
 

ALCAD ulepsza kilka poleceń AutoCAD, zapewniając więcej opcji. Na przykład, 

jeśli przytrzymasz klawisz Shift, ALCAD zostanie tymczasowo umieszczony w 

trybie ortogonalnym, co okaże się przydatną funkcją do rysowania pod kątem 

prostym. Poniższa tabela zawiera przykłady innych poleceń z rozszerzonymi 

opcjami. 

 
Ulepszone polecenia ALCAD 

 

 circleArc Konwertuje łuk na okrąg. 

 donut2point Określa średnicę zewnętrzną pączka według 
dwóch punktów. 

 donut3point Określa średnicę zewnętrzną pączka według 
trzech punktów. 

pączek RadTanTan Określa średnicę zewnętrzną pączka za 
pomocą punktów stycznych. 

 lineAngle Rysuje linię według kąta, po którym następuje długość. 

 lineLength Rysuje linię o określonej długości, po której następuje 
kąt. 

msnapshot (mslide) i 
vsnapshot (vslide) 

msnapshot (mslide) i 
vsnapshot (vslide) 

EMF Zapisuje i wyświetla obrazy ekranu w 
rozszerzonym formacie metapliku. 

WMF Zapisuje i wyświetla obrazy ekranu w 
formacie metapliku Windows. 

 

parallel (offset) Bothsides Kopiuje element równolegle po obu 

stronach. plane (solid) Rectangle Rysuje prostokątną bryłę pod 

dowolnym kątem . plane (solid) SquareRysuje  kwadratową bryłę 

pod dowolnym kątem. plane (solid) Triangle Rysuje nierównoległą 

bryłę pod dowolnym kątem.  rectangleSquare Rysuje kwadratowy prostokąt. 

 rectangleRotated Rysuje obrócony prostokąt. 



 

Korzystanie z dodatkowych 
zestawów wyboru 
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ALCAD posiada dodatkowe opcje zestawu wyboru, których nie ma w AutoCAD. W 

szczególności, w zestawie wyboru okręgu, opcje Okrąg przecinający (CC), Okrąg 

zewnętrzny (OC) i Okrąg wygrywający (WC) wybierają wszystkie obiekty w tej 

samej odległości (promieniu) od centralnego punktu wyboru. 

Poniższa tabela zawiera listę i opis dodatkowych zestawów wyboru w ALCAD. 

 
Dodatkowe opcje zestawu wyboru 

Tryb wyboru Opis  

CC Przekraczanie okręgu: Zaznacza wszystkie podmioty znajdujące się w 

okrągłym obszarze i przecinające go. D Metoda zaznaczania: Wyświetla 

okno dialogowe Ustawienia rysowania. 

O Poza oknem: Zaznacza wszystkie jednostki poza prostokątnym 
obszarem; jest to odwrotność opcji Przekraczanie okręgu. 

OC Poza okręgiem: Wybiera wszystkie jednostki poza okrągłym obszarem. 

OP Poza wielokątem: Wybiera wszystkie jednostki poza obszarem wielokąta; 
jest to odwrotność opcji CP (Przekraczanie wielokąta) i WP (Okno 
wielokąta). 

PRO Właściwości: Wybiera wszystkie jednostki o określonych właściwościach, 
takich jak obszar, kolor i warstwa. 

WC Okrąg okna: Zaznacza wszystkie podmioty w okrągłym obszarze. 
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Korzystanie z dodatkowych poleceń ALCAD 
 

Chociaż w programie ALCAD można używać struktury poleceń AutoCAD, 

program ten ma własny zestaw poleceń. ALCAD ma wiele nazw poleceń, których 

nie ma w AutoCAD, chociaż wiele z tych poleceń ma równoważną funkcję w 

AutoCAD. Po wpisaniu odpowiednika AutoCAD, system aliasów ALCAD 

aktywuje prawidłowe polecenie. 

Na przykład polecenie przesunięcia AutoCAD jest mapowane na polecenie 

równoległe ALCAD. Możesz wpisać przesunięcie lub równoległość na pasku 

poleceń lub wybrać opcję Modyfikuj > Równoległość. 

Poniższa tabela zawiera listę opcjonalnych nazw poleceń ALCAD, których można 

użyć zamiast nazw poleceń AutoCAD, aby wykonać równoważną funkcję 

AutoCAD. 

 
Różnice w poleceniach w ALCAD 

 

Polecenie ALCAD Polecenie AutoCAD 2007 Polecenie AutoCAD 2000/R14 Działanie w ALCAD 

audionote Brak odpowiednika Brak odpowiednika Tworzy i odtwarza notatki 
dźwiękowe dołączone do 
podmiotów. 

cmdbar Brak odpowiednika Brak odpowiednika Pozycjonuje okno 
poleceń. 

współrzędna Ctrl+D lub F6 Ctrl+D lub F6 Zmienia sposób wyświetlania 
współrzędnych na linii statusu. 

copyedata Brak odpowiednika Brak odpowiednika Kopiuje rozszerzone dane 
podmiotu z jednego 
podmiotu do drugiego. 

dostosować pasek narzędzi pasek narzędzi Wyświetla okno dialogowe 
Dostosuj. 

deledata Brak odpowiednika Brak odpowiednika Usuwa rozszerzone dane 
podmiotu z podmiotu. 

usunąć kasowanie kasowanie Usuwa jednostki z 
rysunku. 

wymiar przyciemniony przyciemniony Przełącza do trybu 
wymiarowania. 

editedata Brak odpowiednika Brak odpowiednika Edytuje rozszerzone 
dane podmiotu 
znalezione w podmiocie. 

editlen wydłużać się wydłużać się Zmienia długość otwartych 
jednostek. 

editpline pedit pedit Edytuje polilinie i 
polimezę. 

entprop ddmodify i ddchprop ddmodify i ddchprop Wyświetla okno dialogowe 
Właściwości jednostki. 

esnap -osnap -osnap Ustawia migawki encji z wiersza 
poleceń. 

expblocks ddinsert ddinsert Wyświetla 
Eksplorator 
ALCAD - Bloki. 
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Różnice w poleceniach w ALCAD (ciąg dalszy) 
 

Polecenie ALCAD Polecenie AutoCAD 2007 Polecenie AutoCAD 2000/R14 Działanie w ALCAD 

expdimstyles ddim ddim Wyświetla Eksplorator 
ALCAD - Style wymiarów. 

expfonts styl styl Wyświetla 
Eksplorator 
ALCAD - Style. 

eksplozje warstwa warstwa Wyświetla 
Eksplorator 
ALCAD - Warstwy. 

odkrywca ddrename ddrename Wyświetla ALCAD 
Explorer. 

expltypes typ linii typ linii Wyświetla ALCAD Explorer 
- Typy linii. 

wykłady dducs dducs Wyświetla ALCAD 
Explorer - UCS. 

expviews ddview ddview Wyświetla 
Eksplorator 
ALCAD - Widoki. 

twarz 3dface 3dface Rysuje trójwymiarowe ściany z 
trzema lub czterema 
wierzchołkami. 

spłaszczyć Brak odpowiednika Brak odpowiednika Ustawia grubość na zero na 
wysokości określonej przez 
użytkownika. 

czcionka -styl -styl Wyświetla okno dialogowe Styl 
tekstu. 

odręcznie szkic szkic Umożliwia szkicowanie 
odręczne. 

idpoint id id Zwraca współrzędne x, y i z 
wybranego punktu. 

inflina xline xline Rysuje linię o nieskończonej 
długości. 

dołączyć pedit join pedit join Łączy linie i łuki. 

siatka 3dmesh 3dmesh Rysuje siatkę powierzchni. 

moveedata Brak odpowiednika Brak odpowiednika Przenosi rozszerzone dane 
podmiotu z jednego 
podmiotu do drugiego. 

msnapshot mslide mslide Tworzy plik SLD, EMF lub 
WMF bieżącego widoku. 

ortogonalny orto orto Przełącza tryb ortogonalny. 

równoległy offset offset Kopiuje jednostkę przez 
równoległe przesunięcie 
odległości. 

samolot solidny solidny Rysuje dwuwymiarową 
płaszczyznę bryłową. 

pmthist F2 F2 Przełącza między oknem 
historii komunikatów a 
ekranem graficznym. 

polilinia linia linia Rysuje polilinię. 

ppreview podgląd podgląd Wyświetla podgląd wydruku. 

druk działka działka Drukuje rysunek. 
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Różnice w poleceniach w ALCAD (ciąg dalszy) 

 
Printstyle plotstyle printstyle (nie ma 

zastosowania przed AutoCAD 
2000) 

Przypisuje styl drukowania.

 
psetup Brak odpowiednika Brak odpowiednika Wyświetla okno dialogowe ustawień drukowania 

pudełko. 
qprint Brak odpowiednika Brak odpowiednika Szybko drukuje bieżącą wartość 

rzutnia (okno) bez 
żadnych opcji. 

reassocapp Brak odpowiednika Brak odpowiednika Ponownie przypisuje rozszerzony podmiot 
dane z aplikacją. 

recscript Brak odpowiednika Brak  odpowiednikaUruchamia 

   rejestrator skryptów.  

rtrot3 dorbit  Brak odpowiednika Obraca  

    widok podmiotów. 

                    rtrotx                      Brakodpowiednika                      Brakodpowiednika  Obraca widok podmiotów  
    zachowując oś x. 

       rtroty        Brak odpowiednika         Brak odpowiednika  Obraca widok podmiotów 
przy zachowaniu osi y. 

rtrotz 3dorbit Brak odpowiednika Obraca  widok podmiotów, 
zachowując oś z. 

saveall Brak odpowiednika Brak odpowiednika Zapisuje wszystkie aktualnie otwarte 
rysunki. 

Setcolor colord dcolor Wyświetla okno dialogowe Kolor. 
Setdim ddim ddim Wyświetla okno dialogowe 

Style wymiarów. 
Setesnapo snapo snap Wyświetla okno dialogowe 

Ustawienia rysowania z 
wyświetloną kartą 
Wprowadzanie 
współrzędnych. 

Setlayerai _molcai _molc Ustawia bieżącą warstwę na 
podstawie warstwy wybranej 
jednostki. 

ustawienia Brak  odpowiednikaBrak odpowiednika Wyświetla DrawingSettings 
okno dialogowe. 

 setucsdducsdducs Wyświetla okno dialogowe  Układy współrzędnych 
użytkownika. 

setvpoint Brak odpowiednika Brak odpowiednika Wyświetla wstępnie ustawione punkty widzenia 
okno dialogowe. 

stopcript Brak odpowiednika Brak odpowiednika Zatrzymuje działanie  

   skryptu.  

tipofday Brak odpowiednika Brak odpowiednika Wyświetla wskazówkę dnia. 

Undelete oops oops Przywraca ostatnio  

   usunięty skrypt. podmiot. 
Vba vbaide vbaide Otwiera edytor 

aplikacji Visual Basic. 

 Polecenie ALCADPolecenie AutoCAD 2007Polecenie  AutoCAD 2000/R14 Akcja w 
programie ALCAD 
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Różnice w poleceniach w ALCAD (ciąg dalszy) 
 

Polecenie ALCAD Polecenie AutoCAD 2007 Polecenie AutoCAD 2000/R14 Działanie w ALCAD 

viewctl ddvpoint ddvpoint Ustawia trójwymiarowy 
kierunek wyświetlania za 
pomocą interaktywnego 
okna dialogowego. 

punkt widzenia vpoint vpoint Ustawia trójwymiarowy 
kierunek wyświetlania za 
pomocą wiersza 
poleceń. 

vsnapshot vslide vslide Wyświetla plik SLD, EMF 
lub WMF w bieżącej 
rzutni. 

 
 
 

Rozpoznawanie subtelnych różnic w poleceniach 
 

Wymienione poniżej polecenia działają nieco inaczej w ALCAD niż w Auto- 

CAD. 

 
Różnice w funkcjach poleceń 

 
 

 

 

 
 

 

kal kal Wyświetla kalkulator Windows. 

patelnia -pan Wykonuje panoramowanie wektorowe zamiast 
panoramowania w czasie rzeczywistym. 

zoom -zoom Wykonuje zoom stopniowy zamiast zoomu w czasie 
rzeczywistym. 
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Identyfikacja nieobsługiwanych poleceń i funkcji 
 

Kilka poleceń i funkcji AutoCAD nie jest obsługiwanych w tej wersji Intelli-CAD, 

jak pokazano w poniższej tabeli. 

 
Polecenia AutoCAD nieobsługiwane przez ALCAD 

2008 Cechy: Centrum informacyjne 
 

Polecenia: annoupdate, attipedit, dataextraction, datalink, 
datalinkupdate, dimbreak, diminspect, dimspace, dwflayers, freeweb, 
freespot, +layer, recoverall, renderexposure, targetpoint 

2007 Cechy: Właściwości cienia 
 

Polecenia: planar 

2005 Funkcje: Powiększenie do wyboru, tabele, luki przycinania i 
menedżer zestawów arkuszy 

 

Polecenia: archive, assistclose, markup, newsheetset, 
opendwfmarkup, sheetset, table i -table, tableedit, tableexport, 
tablestyle, taskbar, tinsert, updatefield, viewplotdetails 

2004 Funkcje: Ctrl + O Czysty ekran, Raportowanie błędów, 
Menedżer odniesień, Drukowanie w tle i Różne funkcje stylów 
drukowania (Dithering, Skala szarości, Ekranowanie, Adaptacyjne, 
Style końca linii, Style łączenia linii, Style wypełnienia). 

 

Polecenia: 3dorbitctl, jpgout, pngout, tifout 

2002 Funkcje: Okno na dziś 
 

Polecenia: attext i eattext 

2000 Funkcje: Parallel Entity Snap, Viewports z ustawieniami UCS i 
Elevation, AutoTrack, True Color Raster Output 

 

Polecenia: 3dclip, 3ddistance, 3dswivel, 3dzoom, blockicon, 
camera, dbclose, dbconnect, adcclose, adcenter, adcnavigate, 
layoutwizard, model, olescale, partialload, partialopen, pasteorig, 
pcinwizard, plottermanager, psetupin, qleader, shademode, ucsman, 
vbaman, vlisp, and whohas 

R14 Funkcje: Śledzenie punktów i otwieranie plików na pasku 
poleceń 

 

Polecenia: xbind, rectang i qdim 

R13 Polecenia: arx, dsviewer, dxbin, edge, mledit, treestat i 
wmfopts 

Zaawans
owane 
moduły 
AutoCAD 

Polecenia ACIS (modelowanie brył): ameconvert, soldraw, solprof, 
solview 

 
Polecenia ASE (rozszerzenie AutoCAD SQL): aseadmin, 
aseexport, aselinks, aserows, aseselect i asesqled 

Polecenia internetowe: listurl, openurl, saveurl i selecturl 



Polecenia krajobrazu: lsedit, lslib i lsnew 

Polecenia PostScript: psdrag, psfill, psin i psout 

 
showmat, statystyki, przezroczystość, 3dsin i 3dsout 

Obiekt AutoCAD Opis 
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Polecenia AutoCAD nieobsługiwane przez ALCAD 

 
 

Identyfikacja tego, co nie jest wyświetlane 
 

Gdy rysunek zawierający jednostki proxy AutoCAD jest ładowany do ALCAD, 

program wyświetla następujący komunikat: "Ten rysunek zawiera jeden lub więcej 

elementów, które nie będą wyświetlane. Jednostki te zostaną zapisane z powrotem w 

rysunku." 

Poniższa tabela określa, które obiekty AutoCAD nie są wyświetlane w ALCAD. 

 
Obiekty AutoCAD nie są wyświetlane w ALCAD 

 

Tekst wyrównany do  łukuTekst wyrównany wzdłuż krzywej łuku. 

Kamera Punkt, w którym kamera jest wstawiana do 

rysunku. 

Światło Punkt, w którym światło jest wstawiane do rysunku. 

Readtext Dynamicznie połączony tekst, który jest wyświetlany na rysunku, 
ale znajduje się w pliku zewnętrznym. 

Tabele Tabele są wyświetlane jako anonimowe bloki, ale nie można ich edytować. 

 
 

Zaznacz wszystkie proxy na rysunku. 

Wpisz select, wybierz Filter, a następnie wybierz Proxy. 
 



Rozszerzenie pliku Opis 
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Obsługa dostosowywania programu AutoCAD 
 

W poniższej tabeli wymieniono i opisano sposoby obsługi plików 

dostosowywania programu AutoCAD przez ALCAD. 

 
Wsparcie ALCAD dla plików dostosowywania AutoCAD 

 

LIN Obsługiwane: Linetypes i złożone linetypes z tekstem i 

kształtami. MNU i MNS Obsługiwane: Makra paska narzędzi i menu. 
Obsługiwane: ***POP0, ***POPn i ***TOOLBAR. 
Nieobsługiwane: Sekcje ***TABLET, ***BUTTONS, ***SCREEN, ***AUX i 
***ICON. 

MIN Nieobsługiwane: Plik definicji wielowierszowej jest używany przez AutoCAD mline 
polecenie. 

PAT Obsługiwane: Wzory kreskowania. 

PGP Obsługiwane: Aliasy poleceń. 
Nieobsługiwane: Polecenia zewnętrzne. 

PSF Nieobsługiwane: Plik wzoru wypełnienia PostScript jest używany przez program 
AutoCAD psfill 

polecenie. 

SHP i SHX Obsługiwane: 

Textfontsandshapes. SLD Obsługiwane: 

Pliki slajdów. 

UNT Obsługiwane: Plik tłumaczenia jednostek używany przez funkcje 
LISP(cvunit) i SDS sds_cvunit do tłumaczenia wartości z jednej 

jednostki miary na inną. 

 
 
 

Zrozumienie kompatybilności menu 
 

Pliki MNU są plikami menu utworzonymi przez wszystkie wersje AutoCAD, a pliki 

MNS są zawarte w wersjach AutoCAD 13, 14 i 2000. ALCAD odczytuje oba 

formaty plików, nawet jeśli makra menu zawierają kod AutoLISP. Ta funkcja 

umożliwia dalsze korzystanie z istniejących menu AutoCAD 

 
Wsparcie ALCAD dla określonych sekcji w plikach AutoCAD MNU i MNS 

 

Sekcja menu Definicja Obsługa ALCAD 

***POP0 Menu kursora Obsługiwane 

***POPn Menu rozwijane Obsługiwane 

***AUXn Menu pomocnicze Nieobsługiwane 

***BUTTONn Menu przycisków Nieobsługiwane 

***ICON Menu ikon Nieobsługiwane 

***SCREEN Menu ekranowe Nieobsługiwane 

***TABLETn Menu tabletu Nieobsługiwane 



 

Importowanie i eksportowanie plików 
personalizacji 
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Można nadal używać aliasów i plików menu z programu AutoCAD, importując 

odpowiedni plik. Za pomocą okna dialogowego Dostosuj można importować pliki 

dostosowywania programu AutoCAD i eksportować formaty programu ALCAD. 

Wszystkie pliki wymienione w poniższej tabeli są w formacie ASCII, co oznacza, że 

można je przeglądać i edytować za pomocą edytora tekstu, takiego jak Notatnik. 

Dostosowywanie plików 

Aliasy PGP: aliasy AutoCAD 
ICA: aliasy ALCAD 
ICA: aliasy ALCAD 

PGP: aliasy AutoCAD 

Klawiatura ICK: Klawiatura ALCAD ICK: Klawiatura ALCAD 

Menu MNU: Wszystkie menu 
programu AutoCAD 

MNS: AutoCAD R13, R14 i 2000 
menu 
ICM: Menu ALCAD 

ICM: Menu ALCAD 

 

Paski narzędzi MNU: Wszystkie menu AutoCAD Brak 

 
 

WSKAZÓWKA Można ręcznie dodać dostosowania paska narzędzi do pliku MNU. 

Więcej informacji można znaleźć w sekcji "Dostosowywanie pasków narzędzi" na stronie 749. 
 

 PersonalizacjaImport formatów plików Eksportuj formaty 
plików 



Interfejs programowania AutoCAD Obsługa programu ALCAD 

Unikalna funkcja LISP Definicja 
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Programowanie ALCAD 
 

ALCAD obsługuje więcej interfejsów programowania aplikacji (API) AutoCAD niż 

jakiekolwiek inne oprogramowanie, ale nie wszystkie interfejsy API AutoCAD są 

dostępne w ALCAD. Poniższa tabela podsumowuje interfejsy API AutoCAD 

obsługiwane przez ALCAD. 

 
Wsparcie ALCAD dla interfejsu programowania AutoCAD 

 

Skrypty (pliki SCR) Obsługiwane 

AutoLISP (pliki LSP) Obsługiwane 

Dialog Control Language (pliki DCL) Obsługiwane 

AutoCAD Development System (ADS) Obsługiwane; kod źródłowy 
musi zostać ponownie 
skompilowany 

 Obsługiwane aplikacje Visual Basic 
(VBA) , w zależności od wersji 
programu ALCAD 

Bezpośredni interaktywnie oceniany język 
StringExpression (Diesel) 

Obsługiwane 

 

AutoCAD SQLInterface (ASI) Nieobsługiwane 

Autodesk® Threaded Language Application System 
Toolkit (Atlast) 

Niepotrzebne 

 

Rozszerzenie środowiska uruchomieniowego programu AutoCAD (ARx) Nieobsługiwane 

 

Zrozumienie kompatybilności z AutoLISP 

ALCAD dodaje funkcjonalność LISP, która okaże się przydatna. Poniższa tabela 

zawiera listę funkcji, które są unikalne dla ALCAD LISP. 

 
Dodatkowe funkcje ALCAD LISP 

 

(log10) Zwraca logarytm o podstawie 10. 

(lpad) Wypełnia ciąg tekstowy spacjami z lewej strony. 

(rpad) Wypełnia ciąg tekstowy spacjami z prawej strony. 

(tan) Zwraca tangens. 

(trim) Przycina spacje z ciągu znaków. 



Funkcja LISP Opis 
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Nie wszystkie funkcje ALCAD LISP są całkowicie kompatybilne z funkcjami 

AutoLISP. Poniższa tabela identyfikuje funkcje ALCAD LISP, które są 

częściowo kompatybilne z funkcjami AutoLISP. 

 
Częściowo kompatybilne funkcje LISP 

 

(menucmd)  Obsługuje P0 (menu kursora), P1 do P16 (menu rozwijane) i M 
(wyrażenia diesla), ale nie obsługuje A (menu pomocnicze), B 

(menu przycisków), I (menu ikon), S (menu ekranowe) lub T (menu tabletu). 

(print1) Nie obsługuje znaków Unicode, takich jak \ U+00B0 (symbol 
stopnia) i M+Nxxxx (wielobajtowe sekwencje Unicode). 

(ssget) i (ssadd) Obsługuje dodatkowe tryby wyboru: 
CC = Przekraczanie 
okręgu O = Na 
zewnątrz 
OC = okrąg 
zewnętrzny OP = 
wielokąt zewnętrzny 
PO = punkt POint 
PRO = Właściwości 

 
Ponadto ALCAD LISP nie obsługuje wszystkich funkcji AutoLISP. Następujące 

obszary nie są obsługiwane przez ALCAD LISP: 

• (acdimenableupdate), (acet-attsync), (acet-layerpmode), (acet-layerp-mark), 

(acet-laytrans), (acet-ms-to-ps), (acet-ps-to-ms), (defun-q), (defun-q-list-ref), 

(defun-q-list-set), (entmakex), (initdia), (namedobjdict), (ssnamex) i (tablet). 

• Funkcje związane z ARX, które uruchamiają aplikacje ARX 

• Funkcje związane z (dict) 

• Funkcje związane z SQL, które łączą encje AutoCAD z rekordami zewnętrznej 

bazy danych. Funkcje te zaczynają się od ase_, na przykład (ase_lsunite) i 

(ase_docmp) 



Termin ALCAD Znaczenie dla użytkowników AutoCAD 
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Lista terminów ALCAD i AutoCAD 

 

Lista terminów 
 

pasek poleceń obszar wiersza polecenia 

edit  lengthlengthen 

 entityobject 

entity  snapobject snap 

Precyzja przyciągania jednostki przysłona 

atrybut stały atrybut stały 

 followcontinue 

 freehandsketch 

atrybut ukryty niewidoczny atrybut 

 infinitelineXLine 

 insertdraw 

 ortogonalortho 

 przesunięcie równoległe 

płaszczyzna bryła (2D) 

Atrybut predefiniowany atrybut predefiniowany 

 printplot 

print  styleplot style 

okno zachętymenu  kontekstowe 

Okno historii monitów ekran tekstowy 

siatka odniesienia siatka 

przyciągnięcie punktu przyciąganie węzła 

migawka slajd (SLD) 

walidacja atrybutu zweryfikować atrybut 



 
 
 
 
 
 
 
 
 
 
 
 
 

 

3D Trójwymiarowe lokalizacje zdefiniowane przez współrzędne x, y i z. 

Bryły 3D Trójwymiarowa jednostka ACIS. 

 
Współrzędne bezwzględne Współrzędne zdefiniowane w odniesieniu do punktu 

początkowego bieżącego układu współrzędnych użytkownika. Patrz także: układ 

współrzędnych, współrzędne, początek, współrzędne względne, układ 

współrzędnych użytkownika i światowy układ współrzędnych. 

ActiveX Mechanizm wymiany informacji między różnymi programami, w którym 

kopia dokumentu źródłowego jest osadzona lub wskaźnik do dokumentu źródłowego 

jest połączony z dokumentem docelowym. Zobacz także embed i link. 

Kąty ostre Kąty mniejsze niż 90 stopni. 

alias Skrót lub alternatywne słowo dla polecenia ALCAD. 

Wymiar wyrównany Wymiar wyrównany równolegle do jednostki lub mierzący 

odległość między dwoma punktami pod dowolnym kątem. 

Kąt Różnica kierunku między dwiema nierównoległymi jednostkami liniowymi, 

mierzona w stopniach lub radianach. 

Wymiar kątowy Wymiar mierzący kąt między dwiema liniami lub punktami 

wyznaczonymi przez łuk. 

Jednostka kątowa Jednostka miary kątów. Jednostki kątowe mogą być mierzone w 

stopniach dziesiętnych, stopniach/minutach/sekundach, gradach i radianach. 

adnotacja Dowolny tekst, wymiary, tolerancje lub notatki dodane do rysunku. 

ANSI Skrót od American National Standards Institute (Amerykański Narodowy 

Instytut Standardów). W kontekście tekstu, standardowy zestaw znaków 

zdefiniowany przez ANSI używany w komputerowym wspomaganiu 

projektowania. 

Łuk Odcinek okręgu lub elipsy. 

area Pomiar płaskiego obszaru lub obliczonej przestrzeni w jednostce. 

tablica Wiele kopii wybranych elementów w układzie kołowym lub prostokątnym. 

Skrót ASCII oznacza American Standard Code for Information Interchange, 

powszechnie stosowany system przypisywania numerów do znaków 

alfanumerycznych, interpunkcyjnych i symboli. 

 Słowniczek  

2D Dwuwymiarowe lokalizacje zdefiniowane przez 
współrzędne x i y. 
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Atrybut Składnik bloku zawierający określone informacje tekstowe lub liczbowe. 

Informacje zawarte w atrybucie można skopiować z rysunku do zewnętrznej bazy 

danych. 

definicja atrybutu Jednostka składająca się z nazwy, monitu o informacje, 

charakterystyki wyświetlania i tekstu domyślnego, która po włączeniu do bloku 

tworzy atrybut, gdy blok jest wstawiany do rysunku. 

attribute name Tekst identyfikujący atrybut w bloku. 

tekst atrybutu Tekst zawierający informacje o atrybucie w bloku. 

 
Krzywa B-splajn Patrz splajn. 

punkt bazowy Punkt na jednostce, który służy jako jej punkt odniesienia lub punkt 

wstawienia. Punkt odniesienia przy określaniu odległości względnych. 

Linia bazowa Linia, na której znajdują się znaki tekstowe. Dolne krawędzie 

poszczególnych znaków spadają poniżej linii bazowej. 

wymiar linii bazowej Wiele równoległych wymiarów mierzonych od tego samego 

początku linii bazowej. 

bind Aby przekonwertować rysunek z odniesieniem zewnętrznym na standardową definicję 

bloku. 

Tymczasowe znaczniki ekranowe wyświetlane na rysunku po wybraniu punktu. 

Nazywane również znacznikami blip. 

blok Jeden lub więcej podmiotów zgrupowanych w celu utworzenia pojedynczego podmiotu. 

Zobacz także 

zagnieżdżony blok. 

definicja bloku Nazwa, punkt bazowy i jednostki zgrupowane razem podczas 

tworzenia bloku. 

polilinia graniczna Wybrany obszar ograniczony pojedynczą zamkniętą jednostką 

lub wieloma jednostkami, które się przecinają. 

BYBLOCK Właściwość, dzięki której jednostka dziedziczy kolor, typ linii, grubość 

linii lub styl wydruku dowolnego bloku, który ją zawiera. 

BYLAYER Właściwość, dzięki której jednostka dziedziczy kolor, typ linii, grubość 

linii lub styl wydruku powiązanej z nią warstwy. 

 
Skrót CAD oznacza projektowanie wspomagane komputerowo. 

Współrzędne kartezjańskie Współrzędne zdefiniowane przy użyciu trzech 

prostopadłych osi (x, y i z) w celu określenia lokalizacji w przestrzeni 

trójwymiarowej. Zobacz także współrzędne cylindryczne, współrzędne 

biegunowe i współrzędne sferyczne. 

Linia środkowa Linia używana do wskazania środka okręgu lub łuku, zwykle 

składająca się ze znaku środkowego i linii rozciągających się nieco poza średnicę 

okręgu lub łuku. 

Znak środka Krzyżyk oznaczający środek okręgu lub łuku. 
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Faza Fazowana krawędź między dwiema liniami. 

cięciwa Linia łącząca dwa punkty na okręgu lub łuku. 

obwód Pomiar odległości wokół okręgu. 

zamknięty Stan, w którym punkt początkowy i końcowy jednostki są takie same. 

tabela stylów wydruku zależnych od koloru Zbiór stylów wydruku, które 

określają sposób drukowania elementów w zależności od przypisanego im koloru. 

Zobacz tabelę stylów wydruku. 

rozdzielane przecinkami Dane, które są oddzielone przecinkiem, aby reprezentować koniec 

pola. 

pasek poleceń Okno dokowalne, w którym można wpisywać polecenia ALCAD 

oraz wyświetlać monity i inne komunikaty programu. 

Stożek Trójwymiarowa jednostka, w której wierzchołek znajduje się powyżej lub 

poniżej okrągłego kształtu i w której zastosowano powierzchnię między 

wierzchołkiem a okrągłym kształtem. 

ciągły Połączony, nieprzerwany lub nieprzerwany. Podmioty, które mają ten sam 

punkt końcowy. 

Wymiar kontynuowany Wymiar mierzony od poprzedniej linii przedłużenia 

istniejącego wymiaru, w wyniku czego dwa lub więcej wymiarów jest 

umieszczonych koniec do końca. 

punkt kontrolny Punkt używany do definiowania splajnu. 

Coons patch Powierzchnia interpolowana pomiędzy trzema lub czterema krzywymi 

granicznymi. 

filtr współrzędnych Funkcja, która wyodrębnia poszczególne wartości 

współrzędnych x, y i z z różnych punktów w celu utworzenia nowego punktu 

złożonego. 

Układ współrzędnych Układ punktów, który reprezentuje przestrzeń rysunkową w 

odniesieniu do początku (0,0,0) i zestawu osi, które przecinają się w początku. W 

dwóch wymiarach osie x i y reprezentują odpowiednio kierunek poziomy i pionowy. 

W trzech wymiarach oś z reprezentuje lokalizacje powyżej i poniżej 

dwuwymiarowej płaszczyzny xy. Lokalizacje na rysunku można przedstawić za 

pomocą dwuwymiarowych i trójwymiarowych współrzędnych prostokątnych 

(kartezjańskich), dwuwymiarowych współrzędnych biegunowych, trójwymiarowych 

współrzędnych biegunowych (cylindrycznych) i trójwymiarowych współrzędnych 

sferycznych. Zobacz także współrzędne biegunowe, współrzędne względne, 

współrzędne sferyczne, układ współrzędnych użytkownika i światowy układ 

współrzędnych. 

Współrzędne Zestaw wartości określających położenie w przestrzeni 

dwuwymiarowej lub trójwymiarowej. Patrz także współrzędne bezwzględne, 

współrzędne kartezjańskie, współrzędne biegunowe, współrzędne względne i 

współrzędne sferyczne. 

współpłaszczyznowy Leżący w tej samej płaszczyźnie. 

krzyżyk Kursor składający się z dwóch lub trzech linii, które przecinają się w 

miejscu kursora. 



Kreskowanie Wypełnienie obszaru wzorem równomiernie rozmieszczonych 

prostopadłych linii. Zobacz także kreskowanie. 
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crossing circle Metoda wyboru encji, która wybiera encje znajdujące się 

wewnątrz lub przekraczające granicę okrągłego okna wyboru. 

przekraczanie wielokąta Metoda wyboru encji, która wybiera encje znajdujące się 

wewnątrz lub przekraczające granicę okna wyboru wielokąta. 

crossing window Metoda wyboru encji, która wybiera encje znajdujące się 

wewnątrz lub przekraczające granicę prostokątnego okna wyboru. 

sześcian Pudełkowy, trójwymiarowy, geometryczny kształt, w którym długość, 

szerokość i wysokość są równe. 

kursor Symbol punktu wstawiania na ekranie. Wygląd kursora zmienia się w 

zależności od bieżącego zadania. 

Krzywa Gładka, ciągła ścieżka złożona z segmentów liniowych i łukowych. Typy 

krzywych obejmują łuki, splajny, okręgi i elipsy. 

Współrzędne cylindryczne Współrzędne opisujące punkt w przestrzeni 

trójwymiarowej na podstawie jego odległości od początku, kąta w płaszczyźnie xy i 

wartości współrzędnej z. Zobacz także współrzędne biegunowe i współrzędne 

sferyczne. 

 
wymiarowanie linii odniesienia Patrz wymiar rzędnej. 

default Początkowe lub predefiniowane ustawienie. 

detach Aby usunąć odniesienie zewnętrzne z rysunku. Zobacz także odniesienie 

zewnętrzne. 

Średnica Odległość na okręgu lub kuli. 

Tablet digitizer Sprzętowe urządzenie wejściowe, które zawiera elektroniczną 

podkładkę i ręczny wskaźnik podobny do myszy. Tablet digitizer służy dwóm 

celom: (1) Możesz wybierać narzędzia z papierowych reprezentacji dołączonych do 

podkładki (zwanych nakładką), zapewniając dostęp do wszystkich narzędzi 

jednocześnie, zwalniając miejsce na ekranie; oraz (2) możesz wprowadzać cyfrowe 

punkty do komputera, które odpowiadają punktom na papierowym rysunku, 

fotografii lub planie dołączonym do podkładki. 

wymiar Wymiar, jak wysokość lub szerokość. W kontekście kreślenia, zestaw linii, 

grotów strzałek i tekstu używanych do wskazania wymiaru. 

Styl wymiaru Nazwana grupa ustawień zmiennych wymiaru, która określa wygląd 

wymiaru. Można zapisać wiele stylów wymiaru do ponownego użycia. 

dimension text Wartość pomiaru. Tekst wymiaru może zawierać przedrostki, 

poprawki, tolerancje i inne adnotacje. 

dimension text rotation Kąt w stopniach między osią x a linią bazową tekstu 

wymiaru. 

tolerancja wymiaru Wartość określająca dopuszczalne odchylenie wymiaru (+ lub 

- n). 

naczynie Dolna połowa kuli. Zobacz także kopuła. 
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punkt przemieszczenia Punkt, do którego punkt bazowy lub referencyjny zostanie 

przeniesiony podczas przenoszenia lub kopiowania jednostek. 

odległość Miara przestrzeni między dwoma punktami. 

dock Umożliwia umieszczenie paska narzędzi lub paska poleceń na krawędzi okna 

rysunku, gdzie zostanie zablokowany. Zobacz także float. 

kopuła Górna połowa kuli. Wypełniony okrąg lub 

płaski pierścień utworzony jako polilinia. extents 

drawing Patrz extents. 

limity losowania Patrz limity. 

Jednostka rysunkowa Liniowy system miar używany na rysunku. Użytkownik 

określa, co reprezentuje jednostka rysunkowa, na przykład jeden cal, jeden 

centymetr, jedna stopa lub jeden metr. 

DWF 

dwuwymiarowych lub trójwymiarowych rysunków w przeglądarce internetowej i 

dystrybucji do przeglądu przy użyciu bezpłatnego oprogramowania i narzędzi 
Autodesk®. 

.dwg Standardowe rozszerzenie pliku używane przez programy CAD do 

przechowywania plików rysunków w formacie DWG. 

.dwt Standardowy format używany przez programy CAD do przechowywania 

szablonów rysunków, czyli rysunków zawierających predefiniowane ustawienia, 

których można użyć podczas tworzenia nowego rysunku. Zobacz także szablon. 

DXF Skrót od Drawing Exchange Format, standardowy format ASCII lub binarny 

do importowania i eksportowania plików między większością programów CAD. 

 
Wysokość Wartość z mierzona od płaszczyzny xy. Wartości dodatnie znajdują się 

powyżej płaszczyzny xy; wartości ujemne znajdują się poniżej płaszczyzny xy. 

embed Technika wymiany informacji między różnymi programami, w której 

kopia dokumentu źródłowego jest przechowywana w dokumencie docelowym. 

Zobacz także ActiveX i link. 

EMF to skrót od Enhanced Metafile, formatu pliku o typie i rozszerzeniu 

.emf. Jest to natywny wewnętrzny format plików systemu Windows 98. EMF 

obsługuje zarówno informacje rastrowe, jak i wektorowe oraz 24-bitowe kolory 

RGB. Większość programów opartych na systemie Windows obsługuje ten format. 

Punkt końcowy Punkt, w którym kończy się linia lub krzywa. 

encja Dowolny pojedynczy element podstawowy w rysunku. Elementy obejmują 

łuki, atrybuty, bloki, okręgi, wymiary, elipsy, łuki eliptyczne, linie nieskończone, 

linie, polilinie, promienie i tekst. 

Dane encji Dowolna z różnych dodatkowych informacji, takich jak tekst, liczby i 

odległości, które można dołączyć do encji rysunkowych. 
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entity snap Technika dokładnego lokalizowania i określania kluczowych punktów 

geometrycznych na encjach, takich jak punkty końcowe i środkowe linii oraz punkty 

środkowe i styczne łuków i okręgów. 

entity snap override Aby wyłączyć lub zmienić tryb przyciągania jednostki dla pojedynczego 

wejścia. 

Zobacz także entity snap i running entity snap. 

Esnap See entity snap. 

explode Konwersja złożonej jednostki na jej podstawowe jednostki. 

Linie przedłużające Linie rozciągające się od wymiarowanej jednostki, dzięki 

czemu można umieścić linię wymiarową z dala od jednostki. Nazywane również 

liniami rzutowania. 

extents Najmniejszy prostokąt, który może zawierać wszystkie elementy rysunku. 

Nieskończone linie i promienie nie mają wpływu na zakres rysunku. Zobacz także 

limity. 

odniesienie zewnętrzne Rysunek powiązany z innym rysunkiem. 

extrude Proces przekształcania dwuwymiarowej jednostki w trójwymiarową 

jednostkę poprzez rozciąganie (wytłaczanie) dwuwymiarowej jednostki wzdłuż 

prostej ścieżki. Zmiana grubości dwuwymiarowej bryły powoduje jej rozciągnięcie 

wzdłuż osi z. Patrz także powierzchnia tabelaryczna. 

 
Powierzchnia płaska zdefiniowana przez trzy lub cztery punkty. 

fence Metoda wyboru jednostek, która wybiera jednostki przecinające linię 

wielosegmentową. 

zaokrąglenie Łuk, który płynnie łączy koniec jednej linii z drugą. 

float Umożliwia umieszczenie paska narzędzi lub paska poleceń z dala od 

krawędzi okna rysunku, gdzie można go przesuwać niezależnie. Zobacz także 

dokowanie. 

freeze Aby pominąć wyświetlanie i zignorować jednostki na określonej warstwie 

podczas regeneracji rysunku, przyspieszając w ten sposób wyświetlanie rysunku. 

Zobacz także rozmrażanie. 

 
siatka Regulowany, regularnie rozmieszczony wzór kropek na ekranie, używany 

jako pomoc w rysowaniu i wyrównywaniu elementów. Siatka nie jest drukowana. 

uchwyt Mały kwadrat wyświetlany w kluczowych miejscach jednostki po jej 

wybraniu, który może być użyty do modyfikacji jednostki poprzez kliknięcie i 

przeciągnięcie. 

 
połowa szerokości Odległość od środka szerokiej polilinii do jej krawędzi. 

kreskowanie Wypełnienie wybranego obszaru liniami, kreskowaniem lub wzorem 

kreskowania. Zobacz także kreskowanie. 

Wzór kreskowania Wzór, często reprezentujący materiał taki jak stal, drewno lub 

piasek, służący do wypełniania wybranych obszarów. 
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usuwanie ukrytych linii Technika wizualizacji, w której wszystkie linie ukryte za 

innymi jednostkami lub powierzchniami z punktu widzenia użytkownika są 

przycinane lub usuwane, nadając obrazowi wygląd bryły. 

Wymiar poziomy Wymiar liniowy mierzący odległość poziomą. 

 
Linia nieskończona Linia rozciągająca się nieskończenie w obu kierunkach. 

Punkt wstawienia Punkt, w którym jednostka jest umieszczana w określonej 

przestrzeni. Punkt odniesienia, za pomocą którego element jest wstawiany do 

rysunku. 

Przecięcie Punkt, w którym dwie jednostki spotykają się lub przecinają. 

Rysunek izometryczny Rysunek wyrównany do płaszczyzny izometrycznej. 

Płaszczyzna izometryczna Jedna z trzech płaszczyzn reprezentujących lewą, 

prawą lub górną stronę domniemanej trójwymiarowej, ortogonalnej bryły. Punkty 

przyciągania i siatki są wyrównane z płaszczyzną w celu ograniczenia rysunków. 

 
Warstwa Komputerowy odpowiednik nakładek używanych w kreśleniu ręcznym. 

Narzędzie, za pomocą którego komponenty rysunku można zorganizować w 

powiązane zestawy, takie jak instalacje wodno-kanalizacyjne, szkieletowe i 

elektryczne domu, z których każdy jest rysowany na własnej warstwie. 

Układ Podobnie jak w przypadku arkusza papieru, reprezentacja tego, jak rysunek 

będzie wyglądał po wydrukowaniu. 

rzutnia układu Okno na karcie Układ (przestrzeń papieru), które wyświetla 

wszystkie lub część elementów przestrzeni modelu rysunku. Zobacz także 

przestrzeń papieru i przestrzeń modelu. 

Lider Linia prowadząca od elementu rysunku do adnotacji. 

granice Zdefiniowana przez użytkownika granica rysunku, określona przez 

współrzędne lewego dolnego i prawego górnego rogu. Zobacz także ekstenty. 

limits tolerance Tekst wymiaru, w którym zmierzony wymiar jest zastępowany 

przez największy i najmniejszy dozwolony wymiar, przy czym górny limit jest 

wyświetlany powyżej dolnego limitu. Patrz także tolerancja i tolerancja 

wariancji. 

linetype Wygląd linii, zdefiniowany jako linia ciągła lub jako wzór kresek, kropek i 

spacji. 

lineweight Szerokość linii, określona w milimetrach lub calach. 

Link Technika wymiany informacji między różnymi programami, w której 

dokument docelowy utrzymuje wskaźnik do oryginalnego dokumentu źródłowego. 

Wszelkie zmiany w dokumencie źródłowym są odzwierciedlane we wszystkich 

dokumentach docelowych zawierających łącza do źródła. Zobacz także ActiveX i 

embed. 

LISP Skrót od List Processing Language, języka komputerowego wymyślonego 

pod koniec lat 50. przez Johna McCarthy'ego do użytku w sztucznej inteligencji. 

Ponieważ jest on raczej interpre- towany niż kompilowany i jest stosunkowo 

prosty, jest wygodnym językiem dla użytkowników do pisania procedur 

rozszerzających zestaw poleceń i funkcjonalności ALCAD. 
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lock Zapobiega nieautoryzowanemu dostępowi do warstw rysunku. 

 
Kierunek M W siatce wielokąta, kierunek od pierwszego do drugiego rzędu. 

Zobacz także kierunek N. 

makro W menu i paskach narzędzi kilka poleceń zgrupowanych jako jedno. 

Również kod Visual Basic for Applications. 

oś główna Najdłuższa odległość w poprzek elipsy, od jednego końca do 

drugiego. Patrz także oś pomocnicza. 

Tymczasowe znaczniki ekranowe wyświetlane na rysunku po wybraniu punktu. 

Nazywane również blipami. 

Skrót MDI oznacza interfejs wielu dokumentów. Zobacz interfejs wielu dokumentów. 

mesh Zbiór połączonych powierzchni wielokątów aproksymujących zakrzywioną 

powierzchnię. 

oś pomocnicza Najmniejsza odległość w poprzek elipsy, z jednej strony na 

drugą. Patrz także oś główna. 

mirror Aby utworzyć kopię odwrotnego obrazu wybranych elementów, odbijając je 

symetrycznie względem linii lub płaszczyzny. 

przestrzeń modelu Podstawowy obszar rysowania, w którym tworzone są 

jednostki. Zobacz także przestrzeń papieru. 

Interfejs wielu dokumentów Możliwość jednoczesnego przeglądania i pracy z 

różnymi rysunkami. 

 
N direction W siatce wielokąta, kierunek od pierwszej do drugiej kolumny. 

Zobacz także kierunek M. 

nazwana tabela stylów wydruku Zbiór stylów wydruku, które określają 

sposób drukowania jednostek zgodnie ze stylami wydruku utworzonymi i 

przypisanymi do jednostek i warstw. Zobacz tabelę stylów wydruku. 

Nazwany widok Zapisany widok, który można przywołać w późniejszym czasie, określając 

jego nazwę. 

zagnieżdżony blok Blok zawarty jako część definicji innego bloku. Zobacz także 

blok. 

luk nieasocjacyjny Luk, który nie jest powiązany z podmiotem ani z nim powiązany. 

 
ukośne Linie lub płaszczyzny geometryczne, które nie są równoległe lub prostopadłe. 

przesunięcie Patrz równoległe. 

OLE Skrót od Object Linking and Embedding (łączenie i osadzanie obiektów). Zobacz 

ActiveX. 

Wymiar rzędnej Pomiar odległości poziomej (współrzędna x) lub pionowej 

(współrzędna y) od ustalonego referencyjnego punktu bazowego lub układu 

odniesienia. 
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początek Punkt przecięcia osi układu współrzędnych. W kartezjańskim układzie 

współrzędnych punktem początkowym jest punkt przecięcia osi x, y i z 

(współrzędna 0,0,0). 

ortogonalne Posiadające prostopadłe nachylenia lub styczne w punkcie przecięcia. 

Tryb ortogonalny (ortho) Tryb rysowania, w którym tworzenie encji odbywa się 

równolegle do osi poziomej i pionowej względem bieżącego kąta przyciągania. 

rzut ortograficzny Technika kreślarska, za pomocą której trójwymiarowy 

przedmiot jest opisywany w dwóch wymiarach poprzez pokazanie go z różnych 

kierunków, najczęściej z przodu, z góry i z boku. 

outside circle Metoda wyboru encji, która wybiera encje znajdujące się 

całkowicie poza okrągłym oknem wyboru. 

outside polygon Metoda wyboru encji, która wybiera encje znajdujące się 

całkowicie poza oknem wyboru wielokąta. 

outside window Metoda wyboru encji, która wybiera encje znajdujące się 

całkowicie poza prostokątnym oknem wyboru. 

 
pan Aby przesunąć wyświetlany widok rysunku bez zmiany powiększenia. 

Zobacz także zoom. 

przestrzeń papieru Dwuwymiarowy obszar roboczy podobny do kartki papieru, w 

którym można rozmieścić różne widoki modelu jako rzutnie układu. Zobacz także 

przestrzeń modelu. 

równoległy Dwie lub więcej współpłaszczyznowych linii, które nigdy się nie przecinają. 

wymiar równoległy Patrz wymiar bazowy. 

PDF - skrót od Portable Document Format. Pliki PDF można przeglądać za 

pomocą programu Adobe® Acrobat Reader, który jest bezpłatnym 

oprogramowaniem do pobrania; można je również przeglądać, sprawdzać i 

edytować za pomocą programu Adobe® Acrobat. 

perimeter Odległość wokół granicy jednostki. 

Jednostki prostopadłe do siebie pod kątem prostym. 

planarne Jednostki, których zasięg znajduje się w całości na płaszczyźnie. 

płaszczyzna Dwuwymiarowa powierzchnia. 

widok z góry Widok rysunku z góry, patrząc w dół osi z prostopadłej do 

płaszczyzny xy bieżącego układu UCS. 

Punkt Lokalizacja w przestrzeni określona przez współrzędne x, y i z. Jednostka 

rysunkowa składająca się z pojedynczej lokalizacji o współrzędnych x, y, z i 

reprezentowana przez jeden z kilku symboli. 

filtr punktów Patrz filtr współrzędnych. 

tablica biegunowa Wiele kopii wybranych jednostek w układzie kołowym. 
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Współrzędne biegunowe Współrzędne opisujące dwuwymiarowy punkt na 

dwuwymiarowej płaszczyźnie w oparciu o odległość punktu od początku i jego kąt 

na płaszczyźnie. Patrz także współrzędne kartezjańskie, współrzędne, 

współrzędne cylindryczne, współrzędne względne i współrzędne sferyczne. 

wielokąt Zamknięta pojedyncza jednostka o trzech lub więcej bokach. 

polilinia Jednostka rysunkowa składająca się z jednego lub więcej połączonych 

segmentów linii lub łuków traktowanych jako pojedyncza jednostka. 

styl wydruku Zbiór ustawień, w tym kolor, szerokość pióra, typ linii i grubość 

linii, które określają wygląd rysunku po wydrukowaniu. Zobacz tabelę stylów 

wydruku. 

tabela stylów wydruku Zbiór stylów wydruku, które można przypisać do karty 

Model lub karty Układ. Tabele stylów wydruku zmieniają wygląd rysunku podczas 

drukowania bez modyfikowania rzeczywistych elementów. Zobacz styl wydruku. 

profil Plik zawierający preferowane ustawienia środowiska rysowania. 

Linie projekcyjne Patrz linie przedłużające. 

lista opcji wyświetlana, gdy polecenie lub narzędzie udostępnia kilka opcji do 

wyboru. 

Okno historii monitów Okno zawierające historię ostatnich poleceń i monitów 

wydanych od momentu uruchomienia bieżącej sesji ALCAD. 

 
kwadrant Jedna czwarta okręgu, łuku lub elipsy. W kontekście przyciągania encji 

opcja, która przyciąga do punktów na okręgu, łuku lub elipsie w każdym 

kwadrancie. 

 
Wymiar promieniowy Wymiar mierzący promień okręgu lub łuku. 

radian Jednostka miary kątowej; 360 stopni równa się 6,283185 lub 2pi radianów. 

Promień Odległość od środka okręgu lub kuli do jej obwodu. 

Promień Linia rozpoczynająca się w określonym punkcie i biegnąca w nieskończoność. 

ray tracing Technika wizualizacji, w której promienie z wyimaginowanych źródeł 

światła są śledzone, gdy załamują się na powierzchniach modelu, określając, gdzie 

padają cienie i jak wyglądają odbicia na błyszczących materiałach, takich jak metal i 

szkło. 

Prostokąt Czterokątna, zamknięta bryła, której przeciwległe boki są równej długości. 

tablica prostokątna Wiele kopii wybranych elementów w prostokątnym wzorze 

składającym się z określonej liczby kolumn i wierszy. 

redo Aby odwrócić efekt poprzednich poleceń cofnięcia. Zobacz także cofnij. 

redraw Szybka aktualizacja lub odświeżenie ekranu rysowania. Zobacz także 

regeneracja. 

regenerate Aby zaktualizować lub odświeżyć ekran rysunku poprzez ponowne 

obliczenie rysunku z jego bazy danych. Zobacz także redraw. 
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region Dwuwymiarowa, zamknięta, płaska granica. 

Współrzędne względne Współrzędne wyrażone w odniesieniu do poprzedniej współrzędnej. 

Zobacz także współrzędne bezwzględne. 

renderowanie Technika wizualizacji, w której wszystkie powierzchnie modelu są 

cieniowane tak, jakby były oświetlone z wyimaginowanego źródła światła 

znajdującego się za tobą, gdy patrzysz na ekran. Renderowane obrazy są 

fotorealistyczne, mają głębię, cień, odbicie i teksturę. 

revolve Tworzenie trójwymiarowej jednostki powierzchni poprzez obracanie 

dwuwymiarowego profilu wokół osi. 

reguła prawej ręki Wizualna pomoc w zapamiętywaniu względnych kierunków 

dodatnich osi x, y i z kartezjańskiego układu współrzędnych oraz dodatniego 

kierunku obrotu wokół osi. 

rotate Zmiana orientacji jednostki, bez jej modyfikacji, poprzez zmianę jej 

położenia w równej odległości od punktu lub osi, ale pod nowym kątem w stosunku 

do nich. 

Kąt obrotu Kąt, o który jednostka zostaje przesunięta względem swojego 

pierwotnego położenia podczas obracania jej wokół punktu lub osi. 

Linia gumowa Linia obrazu, która rozciąga się dynamicznie na ekranie wraz z 

ruchem kursora. Linia rozciąga się między stałym punktem a pozycją kursora, 

zapewniając dynamiczne sprzężenie zwrotne. 

powierzchnia rządzona Trójwymiarowa siatka wielokątów, która aproksymuje 

gładką powierzchnię między dwoma obiektami. 

running entity snap Ustawienie przyciągania encji tak, aby było kontynuowane dla 

kolejnych selekcji. Zobacz także: entity snap i entity snap override. 

 
scale Zmiana rozmiaru elementu. Rysowanie zgodnie z proporcjami jednostki. 

script Zestaw poleceń zapisanych w pliku skryptu ASCII i odtwarzanych 

sekwencyjnie przez uruchomienie skryptu. 

SDS to skrót od Solutions Development System, interfejsu programowania C do 

tworzenia specjalistycznych programów do uruchamiania wewnątrz ALCAD. 

segment Dowolna część jednostki ograniczona dwoma punktami. 

zestaw wyboru Wybrano jedną lub więcej jednostek rysunkowych, na których 

można działać jako pojedyncza jednostka. 

odcień Wypełnianie płaskich obiektów jednolitymi kolorami w celu łatwiejszej wizualizacji. 

kąt przyciągania Kąt, wokół którego obracana jest siatka przyciągania. 

Siatka przyciągania Niewidoczna siatka, która blokuje tworzenie jednostek do 

określonego wyrównania i przyrostu przyciągania, gdy włączona jest funkcja 

przyciągania. 

Rozdzielczość przyciągania Odstęp między punktami na siatce przyciągania. 
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snapshot Reprezentacja rastrowa bieżącego widoku rysunku. 

Współrzędne sferyczne Współrzędne opisujące punkt w przestrzeni 

trójwymiarowej na podstawie jego odległości od początku, kąta w płaszczyźnie xy i 

kąta w górę od płaszczyzny xy. Zobacz także współrzędne kartezjańskie, 

współrzędne, współrzędne cylindryczne i współrzędne biegunowe. 

splajn Krzywa wygenerowana wzdłuż ścieżki trzech lub więcej punktów 

kontrolnych. Krzywa przechodzi przez punkt początkowy i końcowy, ale 

niekoniecznie przez pośrednie punkty kontrolne. 

pasek stanu Pasek na dole okna ALCAD, który wyświetla informacje o wybranym 

poleceniu lub narzędziu, a także współrzędne kursora, nazwę bieżącej warstwy, 

ustawienia trybu i inne informacje o ustawieniach rysowania. 

Model powierzchniowy Trójwymiarowy model składający się zarówno z 

krawędzi, jak i powierzchni między tymi krawędziami. Zobacz także model 

szkieletowy. 

powierzchnia obrotu Trójwymiarowa siatka wielokątów, która przybliża 

powierzchnię generowaną przez obrót dwuwymiarowego profilu wokół osi. 

SVG Skrót od Scalable Vector Graphic, który jest formatem plików do pracy z 

interaktywną grafiką, w tym językiem programowania stron internetowych. 

zmienna systemowa Ustawienie lub wartość przechowująca informacje o 

środowisku operacyjnym i poleceniach (takie jak limity rysowania lub globalny 

współczynnik skali typu linii). 

 
powierzchnia tabelaryczna Trójwymiarowa siatka wielokątów, która przybliża 

powierzchnię wygenerowaną przez wyciągnięcie krzywej wzdłuż wektora. 

Zobacz także extrude. 

styczna Linia przechodząca przez pojedynczy punkt na krzywej. 

szablon Rysunek ze wstępnie ustawionymi warstwami, typami linii i innymi 

ustawieniami (i elementami), który może być użyty jako podstawa do utworzenia 

nowego rysunku. Szablony są zapisywane z rozszerzeniem 

Rozszerzenie pliku .dwt. 

styl tekstu Nazwany, zapisany zbiór ustawień formatu, który określa wygląd 

tekstu. 

thaw Aby ponownie wyświetlić warstwę, która została zamrożona. Zobacz także zamrażanie. 

thickness Głębokość jednostki, mierzona wzdłuż jej osi z. Odległość, na jaką 

jednostka jest wyciągnięta powyżej lub poniżej jej elewacji. Zobacz także elewacja 

i wyciągnięcie. 

Podczas tworzenia równoległej jednostki, punkt, przez który przechodzi nowa 

jednostka. 

tolerancja Tekst wymiaru wskazujący, jak bardzo rzeczywisty wymiar wyprodukowanego 

komponentu może różnić się od określonego wymiaru. Patrz także tolerancja 

graniczna i tolerancja wariancji. 

Polecenie tolerancji Polecenie, które tworzy ramkę kontrolną elementu używaną 

w mechanicznym wymiarowaniu geometrycznym i tolerowaniu. 
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pasek narzędzi Zbiór narzędzi rozmieszczonych na palecie, które można 

przesuwać i zmieniać ich rozmiar w dowolnym miejscu na ekranie. 

torus Trójwymiarowa jednostka w kształcie pączka. 

Polecenie transparentne Polecenie uruchamiane, gdy inne polecenie jest już 

aktywne. Polecenia można użyć w sposób przezroczysty, poprzedzając je 

apostrofem. 

true color Kolory zdefiniowane przy użyciu 24-bitowego koloru. Do wyboru 

jest ponad 16 milionów rzeczywistych kolorów. 

 
Skrót UCS oznacza układ współrzędnych użytkownika. Patrz układ współrzędnych 

użytkownika. 

Ikona UCS Ikona układu współrzędnych użytkownika, która pokazuje orientację osi 

współrzędnych, lokalizację początku układu współrzędnych i kierunek wyświetlania 

względem płaszczyzny xy. 

undo Aby odwrócić efekt poprzednich poleceń. Zobacz także redo. 

jednostka Patrz jednostka rysunkowa. 

Odblokuj Swobodny dostęp do warstw rysunku, które w przeciwnym razie byłyby 

zablokowane, co uniemożliwiłoby ich przeglądanie lub edycję przez innego 

użytkownika. 

Układ współrzędnych użytkownika Kartezjański układ współrzędnych z 

początkiem i kierunkiem zdefiniowanymi przez użytkownika. Zobacz także Światowy 

układ współrzędnych. 

 
Tolerancja wariancji Tekst wymiarowy, w którym do określonego wymiaru 

dołączana jest wartość plus/minus w celu wskazania, jak bardzo rzeczywisty wymiar 

wyprodukowanego elementu może różnić się od określonego wymiaru. Patrz także 

limity tolerancji i tolerancja. 

VBA to skrót od Visual Basic for Applications, języka programowania makr 

osadzonego w programach, który umożliwia użytkownikowi dostosowanie 

programu. 

Wektor Środek opisu przemieszczenia przy użyciu wielkości i orientacji. Na 

przykład można utworzyć jednostkę liniową lub przesunąć jednostkę, określając 

punkt początkowy, kierunek i odległość. 

Punkt przecięcia boków kąta. Punkty początkowe lub końcowe linii lub łuku w 

polilinii. 

wymiar pionowy Wymiar liniowy mierzący odległość w pionie. 

Widok Reprezentacja rysunku lub części rysunku z określonego punktu widzenia 

w przestrzeni trójwymiarowej. 

Punkt widzenia Miejsce w przestrzeni trójwymiarowej służące do podglądu własnego szkicu. 

rzutnia Okno, które wyświetla wszystkie lub część elementów przestrzeni modelu 

rysunku w przestrzeni modelu na karcie Model. Zobacz także przestrzeń modelu i 

przestrzeń papieru. 

konfiguracja rzutni Nazwany układ okien, który można zapisać i przywrócić. 
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Skrót WCS oznacza światowy układ współrzędnych. Patrz światowy system współrzędnych. 

klin Trójwymiarowa jednostka, która przypomina pudełko podzielone wzdłuż 

jednego boku od jednego rogu do przeciwległego rogu; na przykład ogranicznik 

drzwi lub rampa. 

window circle Metoda wyboru encji, która wybiera encje znajdujące się w całości 

w okrągłym oknie wyboru. 

window inside Metoda wyboru encji, która wybiera encje znajdujące się w całości 

w prostokątnym oknie wyboru. 

window polygon Metoda wyboru encji, która wybiera encje zawarte w całości w 

oknie wyboru wielokąta. 

wipeout Jednostka, która wyświetla się z bieżącym kolorem tła, więc szczegóły za 

nią nie są wyświetlane ani drukowane. 

Model szkieletowy Trójwymiarowy model składający się z linii i krzywych, które 

definiują krawędzie trójwymiarowej jednostki. Zobacz także model 

powierzchniowy. 

WMF Skrót od Windows metafile, format zawierający informacje o wektorach i kolorach 

do renderowania jednostek. 

Światowy układ współrzędnych Stały kartezjański układ współrzędnych używany 

jako podstawa do definiowania innych układów współrzędnych. Zobacz także układ 

współrzędnych użytkownika. 

 
xref Patrz odniesienie zewnętrzne. 

 
zoom Zwiększanie lub zmniejszanie powiększenia wyświetlanego rysunku. Zobacz także 

patelnia. 

 


